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1
About this manual

Ö Please note that this manual often refers to right-clicking, e.g. to open context menus, etc. If you are using a Mac
with a single-button mouse, hold down [Ctrl] and click.

Welcome!
This is the Operation Manual for Steinberg’s Nuendo.
Here you will find detailed information about all the features and functions in the program.

About the program versions
The documentation covers two different operating systems or “platforms”; Windows and Mac OS X.
Some features and settings are specific to one of the platforms, Windows or Mac OS X. This is clearly stated in the
applicable cases. In other words:
Ö If nothing else is said, all descriptions and procedures
in the documentation are valid for both Windows and Mac
OS X.
The screenshots are taken from the Windows version of Nuendo.

About the Nuendo Expansion Kit
The Nuendo Expansion Kit adds a number of music composition functions from Steinberg’s Cubase (the “Cubase
Music Tools”) to the standard Nuendo application. The
Nuendo Expansion Kit (NEK) is a separate product and
can be purchased through your Steinberg dealer.
Whenever procedures in this manual use functions available only when the NEK is installed, this is indicated in the
text by “Nuendo Expansion Kit only”.

Key command conventions
Many of the default key commands in Nuendo use modifier keys, some of which are different depending on the
operating system. For example, the default key command
for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z]
under Mac OS X.
When key commands with modifier keys are described in
this manual, they are shown with the Windows modifier
key first, in the following way:
[Win modifier key]/[Mac modifier key]-[key]
For example, [Ctrl]/[Command]-[Z] means “press [Ctrl]
under Windows or [Command] under Mac OS X, then
press [Z]”.
Similarly, [Alt]/[Option]-[X] means “press [Alt] under Windows or [Option] under Mac OS X, then press [X]”.
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2
VST Connections: Setting up input and
output busses

About this chapter

Here’s an example:
Let’s say you are using audio hardware with eight analog
inputs and outputs and digital stereo connections (10 inputs and outputs all in all). Furthermore, you work with a
surround setup in 5.1 format. Here’s a list of busses you
may wish to add:

Nuendo uses a system of input and output busses to transfer audio between the program and the audio hardware.
• Input busses let you route audio from the inputs on your audio
hardware into the program. This means that when you record
audio, you will always do this through one or several input
busses.
• Output busses let you route audio from the program to the
outputs on your audio hardware. When you play back audio,
you will always do this through one or several output busses.

Input busses
• Most likely you need at least one stereo input bus assigned to
an analog input pair. This would let you record stereo material.
If you want to be able to record in stereo from other analog input pairs as well, you could add stereo input busses for these
too.
• Although you can record mono tracks from one side of a stereo input, it may be a good idea to add a dedicated mono input bus. This could be assigned to an analog input to which
you have connected a dedicated microphone pre-amp for example. Again, you can have several different mono busses.
• You probably want a dedicated stereo input bus assigned to
the digital stereo input, for digital transfers.
• If you want to transfer surround material directly to a surround
track, e.g. from surround-configured location recording equipment, you need an input bus in that surround format – in this
example, this would be a 5.1 input bus.

As you can see, the input and output busses are vital when
you work with Nuendo. This is why you find this chapter in
the beginning of the Operation Manual – once you understand the bus system and set up the busses properly, it will
be easy to go on with recording, playing back, mixing and
doing surround work.

Setting up busses
Strategies
You can create any number of busses in Nuendo, in virtually any channel configuration – mono, stereo or a number
of surround formats.

Output busses

Ö The bus configuration is saved with the projects –
therefore it’s a good idea to add and set up the busses
you need and save these in a template project (see “Save
as Template” on page 488).

• You will need one or several stereo output busses for routing
stereo mixes to master recorders or other destinations.
• For digital transfers, you need a stereo bus assigned to a digital stereo output as well.
• You need a surround bus in the format of your speaker configuration (in this example, 5.1) assigned to the correct outputs
(which in turn are connected to the correct speakers).
• You may want additional surround busses if you tend to work
in different surround formats.

When you start working on new projects, you start from this template.
That way you get your standard bus configuration without having to make
new bus settings for each new project. If you need to work with different
bus configurations in different projects, you can either create several different templates or store your configurations as presets (see “Other bus
operations” on page 14). The templates can of course also contain other
settings that you regularly use – sample rate, record format, a basic track
layout, etc.

So, which type of busses do you need? This depends on
your audio hardware, your general audio setup (e.g. surround speaker setup) and what kind of projects you work
with.
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Preparations

The VST Connections window

Before you set up busses, you should name the inputs
and outputs on your audio hardware. For example, if you
are using a 5.1 surround speaker setup, you should name
the outputs according to which speaker they are connected to (Left, Right, Center and so on).

You add and set up busses in the VST Connections window, opened from the Devices menu.

The reason for this is compatibility – it makes it easier to
transfer projects between different computers and setups.
For example, if you move your project to another studio,
the audio hardware may be of a different model. But if
both you and the other studio owner have given your inputs and outputs names according to the surround setup
(rather than names based on the audio hardware model),
Nuendo will automatically find the correct inputs and outputs for your busses and you will be able to play and
record without having to change the settings.

This window contains the following tabs:
• The Inputs and Outputs tabs are for viewing input busses or
output busses, respectively.
• The Group/FX tab allows you to create Group and FX channels/tracks and to make output assignments for these. See
“Setting up Groups and FX channels” on page 17.
• The External FX tab allows you to create effect send/return
busses for connecting external effects which can then be selected via the effect pop-up menus from inside the program.
See “External instruments/effects” on page 17 and “Using external effects” on page 182 for further information.
• The External Instruments tab allows you to create input/output
busses for connecting external instruments. See “External instruments/effects” on page 17 and the chapter “VST Instruments and Instrument tracks” on page 189 for further
information.
• The Studio tab is where you enable and configure the Control
Room. See the chapter “Control Room” on page 151.

Use the Device Setup dialog to assign names to the inputs and outputs of your audio hardware:
1. Open the Device Setup dialog from the Devices menu.
2. Make sure that the correct driver for your audio hardware is selected on the VST Audio System page, so that
the audio card is listed in the Devices list.
3. Select your audio card in the list.
The available input and output ports on your audio hardware are listed on
the right.

4. To rename a port, click its name in the “Show as” column and enter a new name.
• If needed, you can also disable ports by deactivating
them in the “Visible” column.
Disabled ports won’t show up in the VST Connections window when you
are making bus settings. If you attempt to disable a port that is used by a
bus, you will be asked whether this is really what you want – note that
this will remove the port from the bus!

For the time being, we shall focus on how to set up input
and output busses.

5. Click OK to close the Device Setup dialog.
Ö If you open a project created on another computer and
the port names don’t match (or the port configuration isn’t
the same – e.g. the project is created on a system with
multi-channel i/o and you open it on a stereo in/out system), the Pending Connections dialog will appear.
This allows you to manually re-route ports used in the project to ports
available in your system.
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Depending on which tab you have selected, Inputs or Outputs, the window lists the current input or output busses,
with the following columns:
Column

Description

Bus Name

Lists the busses. You can select busses and rename
them by clicking on them in this column.

Speakers

Indicates the speaker configuration (mono, stereo, surround formats) of each bus.

Audio Device

This shows the currently selected ASIO driver.

Device Port

When you have “opened” a bus (by clicking its + button in
the Bus Name column) this column shows which physical
input/output on your audio hardware is used by the bus.

Click

Adding a child bus
A surround bus is essentially a set of mono channels – 6
channels in the case of 5.1 format. If you have a mono
track in the project, you can route it to a separate speaker
channel in the bus (or route it to the whole surround bus
and use the surround panner to position it in the surround
image). But what if you have a stereo track that you simply
want to route to a stereo channel pair within the bus (Left
and Right or Left Surround and Right Surround for example)? For this you need to create a child bus.
1. Select the surround bus in the list and right-click on it.
A pop-up menu appears.

You can route the click to a specific output bus, regardless of the actual Control Room output, or indeed when
the Control Room is disabled.

Adding a bus
1. Click the Inputs or Outputs tab depending on which
you want to add.
2. Click the Add Bus button.
A dialog appears.

2. Select a channel configuration from the “Add Child
Bus” submenu.
As you can see, you can create stereo child busses (routed to various
speaker channel pairs in the surround bus) or other surround bus formats
(with fewer channels than the “parent bus”).

The child bus you created will be available for direct routing in the mixer. It’s a part of the parent surround bus,
which means there will be no separate channel strip for it.

3. Select the desired (channel) configuration.
The pop-up menu contains Mono and Stereo options as well as several
surround formats. To select another surround format, use the “More…”
submenu.

Although child busses are probably most useful in output
busses, you can also create child busses within a surround input bus – for example if you want to record a stereo channel pair (e.g. front left-right) in the surround bus
to a separate stereo track.

• Alternatively you can right-click in the VST Connections
window and add a bus in the desired format directly from
the context menu that appears.
The new bus appears with the ports visible.

4. Click in the Device Port column to select an input/output port for a channel in the bus.
The pop-up menu that appears lists the ports with the names you have assigned in the Device Setup dialog. Repeat this for all channels in the bus.
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Using the busses

Setting the Main Mix bus (the default output bus)
The Main Mix is the output bus that each new channel in
the mixer will be assigned to when it is created.

This section describes briefly how to use the input and output busses you have created. For details refer to the chapters “Recording” on page 64 and “The mixer” on page 122.

Any one of the output busses in the VST Connections
window can be the default output bus. By right-clicking on
the name of an output bus, you can set this bus as the
Main Mix bus.

Routing
When you play back an audio track (or any other audio
channel in the mixer – VST Instrument channels, ReWire
channels, etc.), you route it to an output bus. In the same
way, when you record on an audio track you select from
which input bus the audio should be sent.
• You can select input and output busses in the Inspector, using the Input and Output Routing pop-up menus.

Setting the default output bus in the VST Connections window.

When creating new audio, group or FX channels in the
mixer, they will automatically be routed to the default bus.
!

The default bus is indicated by an orange colored
speaker icon next to its name in the VST Connections window.

Other bus operations
• To change the port assignment for a bus, you proceed
as when you added it – make sure the channels are visible
(by clicking the “+” button next to the bus, or by clicking
the “+ All” button at the top of the window) and click in the
Device Port column to select ports.
• To remove a bus you don’t need, select it in the list,
right-click and select “Remove Bus” from the pop-up
menu, or press [Backspace].

For audio-related channel types other than audio track
channels (i.e. VST Instrument channels, ReWire channels,
Group channels and FX channels), only the Output Routing pop-up menu is available. Select one of its subtracks
in the Track list to open it.

• You can store and recall bus presets with the pop-up
menu at the top of the window.

• You can also select busses in the Routing panel at the
top of each channel strip in the mixer.
Again, for VST Instrument channels, ReWire channels, Group channels
and FX channels you will only be able to select output busses.

To store the current configuration as a preset, click the Store “+” button
and enter a name for the preset. You can then select the stored configuration directly from the Presets pop-up menu at any time. To remove a
stored preset, select it and click the “-” button.
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• If you press [Alt]/[Option] and select an input or output
bus in the Mixer Routing View, it will be chosen for all selected channels.

• Surround tracks can also be routed to output busses, provided
that these have the same input configuration or will not lead to
feedback.

This makes it easy to quickly set several channels to use the same input
or output. Similarly, if you press [Shift] and select a bus, the following selected channels will be set to use incrementing busses – the second selected channel will use the second bus, the third will use the third bus
and so on.

For output busses any assignment is possible.
!

Ö If the Routing panel isn’t shown, click the Show Routing button in the extended common panel or open the
Mixer context menu and select “Show Routing View” from
the Window submenu.

Assignments that will lead to feedback are not available in the pop-up menu. This is also indicated by a
one-way symbol.

To disconnect input or output busses, select “No Bus”
from the corresponding pop-up menu.

Viewing the busses in the mixer
In the mixer, busses are represented by input and output
channels (shown in separate panes to the left and right in
the window). You can show or hide these independently
by clicking the Hide Input Channels and Hide Output
Channels buttons in the common panel:

The “Show Routing” button in the extended common panel of the Mixer.

When selecting an input bus for a track you can only select busses that correspond to the track’s channel configuration. Here are the details for input busses:
• Mono tracks can be routed to mono input busses or individual
channels within a stereo or surround input bus.
• Mono tracks can be routed to External Inputs that are configured in the Studio tab of the VST Connections window. These
can be mono or individual channels within a stereo or surround
input bus. They can also be routed to the Talkback input.
• Mono tracks can also be routed to mono output busses, mono
group output busses or mono fx channel output busses, provided that these will not lead to feedback.
• Stereo tracks can be routed to mono input busses, stereo input busses or stereo child busses within a surround bus.
• Stereo tracks can be routed to External Inputs that are configured in the Studio tab of the VST Connections window. These
can be mono input busses or stereo input busses. They can
also be routed to the Talkback input.
• Stereo tracks can also be routed to mono or stereo output
busses, mono or stereo group output busses and mono or
stereo fx channel output busses, provided that these will not
lead to feedback.
• Surround tracks can be routed to surround input busses.
• Surround tracks can be routed to External Inputs that are configured in the Studio tab of the VST Connections window, provided that these have the same input configuration.

Hide Input Channels

Hide Output Channels
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Input channels

Output channels

The input channels are shown to the left in the mixer. As
you can see, each input channel resembles a regular mixer
channel strip. Here you can do the following:

The output channels are shown to the right in the mixer.
Here you can do the following:
• Adjust the output level for the busses with the faders.

• Check and adjust the recording level using the Input
Gain knobs and/or the level fader.

• Add effects or EQ.
These will affect the whole bus. Examples of effects you may want to add
here include compressors, limiters and dithering. See the chapter “Audio
effects” on page 168.

See “Setting input levels” on page 69.

• Change the phase of the input signal.
This is done by clicking the Input Phase button next to the Input Gain
control.

• Using Sends, send varying amounts of one output bus
to any other output bus that is to the right of the selected
output bus in the mixer.

• Add effects or EQ to the input bus.
See “Recording with effects” on page 76 for an example of how to add
effects to your recording at the input bus stage.
!

The settings you make in the input channel strip will
be a permanent part of the recorded audio file!
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Setting up Groups and FX channels

About monitoring

The Group/FX tab in the VST Connections window shows
all Group channels and FX channels in your project. You
can create new Group or FX channels by clicking the corresponding Add button. This is the same as creating
Group channel tracks or FX channel tracks in the Project
window (see “Using group channels” on page 142 and
the chapter “Audio effects” on page 168).

By default, monitoring is done via the Control Room (see
the chapter “Control Room” on page 151). When the
Control Room is disabled on the Studio tab of the VST
Connections window, the Main Mix bus (see “Setting the
Main Mix bus (the default output bus)” on page 14) will be
used for monitoring.
Setting the monitoring level

However, the VST Connections window also allows you to
create child busses for Groups and FX Channels. This is
useful e.g. if you have Groups or FX Channels in surround
format and want to route stereo channels to specific channel pairs in these.

When you are using the Control Room for monitoring, this
is set in the Control Room Mixer, see the chapter “Control
Room” on page 151. When you are monitoring via the
Main Mix bus, you can adjust the monitoring level in the
regular Project Mixer.

To create a child bus for a Group channel or FX channel in
surround format, proceed as follows:

When auditioning or scrubbing in the Sample Editor, you
can also set the monitoring level using the small fader on
the Sample editor toolbar.

1. Open the VST Connection window and select the
Groups/FX tab.
2. Select the Group or FX channel in the list and rightclick it.

External instruments/effects

3. Select a channel configuration from the “Add Child
Bus” submenu.

Nuendo supports the integration of external effect devices
and external instruments, e.g. hardware synthesizers, into
the sequencer signal flow.

The child bus you created will be available for direct routing in the mixer. It’s a part of the parent Group or FX channel, which means there will be no separate channel strip
for it.

You can use the External Instruments tab and the External
FX tab in the VST Connections window to define the
necessary send and return ports and access the instruments/effects through the VST Instruments window.
!

External Instruments and effects are indicated by an
“x” icon in the list next to their names in the respective pop-up menus.

Requirements
• To use external effects, you need audio hardware with
multiple inputs and outputs. To use external instruments, a
MIDI interface must be connected to your computer.
An external effect will require at least one input and one output (or input/
output pairs for stereo effects) – in addition to the input/output ports you
use for recording and monitoring.

• As always, audio hardware with low-latency drivers is a
good thing to have.
Nuendo will compensate for the input/output latency and ensure that the
audio processed through external effects isn’t shifted in time.
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Connecting the external effect/instrument

3. In the dialog that appears, enter a name for the external effect and specify the Send and Return configurations.
If you want to set up a MIDI device corresponding to the
external effect, click the “Associate MIDI Device” button.

To set up an external effect or instrument, proceed as follows:
1. Connect an unused output pair on your audio hardware to the input pair on your external hardware device.

Depending on the type of effect, you can specify mono, stereo or surround
configurations. When clicking “Associate MIDI Device”, you can use the
MIDI Device Manager functions to create a new MIDI device for the effect.
Note that delay compensation will only be applied for the effect when you
use MIDI devices. For information about the MIDI Device Manager and
user device panels see the separate PDF document “MIDI Devices”.

In this example, we assume that the hardware device has stereo inputs
and outputs.

2. Connect an unused input pair on your audio hardware
to the output pair on your hardware device.
!

4. Click OK. This adds a new External FX bus.

Please note that it is possible to select input/output
ports for external effects/instruments that are already
used (i.e. that have been selected as inputs/outputs
in the VST Connections window). If you select a
used port for an external effect/instrument, the existing port assignment will be broken. Note that you will
not get a warning message!

5. Click in the Device Port column for the Send Bus
“Left” and “Right” ports and select the outputs on your audio hardware that you connected in step 1 above.
6. Click in the Device Port column for the Return Bus
“Left” and “Right” ports and select the inputs on your audio hardware that you connected in step 2 above.

Once the external device is connected to the audio hardware of your computer, you have to set up the input/output busses in Nuendo

7. If you like, make additional settings for the bus.

Setting up external effects

Setting

Description

1. Open the VST Connections window from the Devices
menu.

Delay

If your hardware effect device has an inherent delay (latency), you should enter this value here, as it allows Nuendo to compensate for that delay during playback. You
can also let the delay value be determined by the program by right-clicking in the Delay column for the effect
and selecting “Check User Delay”. Note that you don’t
have to take the latency of the audio hardware into account – this is handled automatically by the program.

Send Gain

Allows you to adjust the level of the signal being sent to
the external effect.

Return Gain

Allows you to adjust the level of the signal coming in from
the external effect.
Note however that excessive output levels from an external
effect device may cause clipping in the audio hardware.
The Return gain setting cannot be used to compensate for
this – you have to lower the output level on the effect device instead.

MIDI Device

When you click in this column, a pop-up menu opens
where you can either disconnect the effect from the associated MIDI device, select a MIDI device, create a new
device or open the MIDI Device Manager in Nuendo to
edit the MIDI device.
When Studio Manager 2 is installed, you may also select
an OPT editor to access your external effect.

Used

Whenever you insert an external effect into an audio
track, this column shows a check mark (“x”) to indicate
that the effect is being used.

These are found in the columns to the right. Note however that you can
adjust these while actually using the external effect – which may be easier as you can hear the result. You have the following options:

2. Open the External FX tab and click “Add External FX”.
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Setting up external instruments

8. When you are done, close the VST Connections window.

1. Open the VST Connections window from the Devices
menu.

Ö Note that external device ports are exclusive, see
“Connecting the external effect/instrument” on page 18.

2. Open the External Instrument tab and click “Add External Instrument”.

How to use the external effect
If you now click an insert effect slot for any channel and
look at the effect pop-up menu, you will find the new external FX bus listed on the “External Plug-ins” submenu.
When you select it, the following happens:
• The external FX bus is loaded into the effect slot just like a
regular effect plug-in.
• The audio signal from the channel will be sent to the outputs
on the audio hardware, through your external effect device and
back to the program via the inputs on the audio hardware.
• A parameter window appears, showing the Delay, Send Gain
and Return Gain settings for the external FX bus. You can adjust these as necessary while playing back. The parameter
window also provides the “Measure Effect’s Loop Delay for
Delay Compensation” button. This is the same function as the
“Check User Delay” option in the VST Connections window. It
provides Nuendo with a Delay value to be used for delay compensation. When you have defined a MIDI device for the effect, the corresponding Device window will be opened. When
Studio Manager 2 is installed, and you have set up a corresponding OPT editor, this OPT editor will be displayed.

3. In the dialog that appears, enter a name for the external instrument and specify the number of required mono
and/or stereo returns. If you want to set up a MIDI device
corresponding to the external instrument, click the Associate MIDI Device button.
Depending on the type of instrument, a specific number of mono and/or
stereo return channels is required. When clicking “Associate MIDI Device”, you can use the MIDI Device Manager functions to create a new
MIDI device. For information about the MIDI Device Manager and user
device panels see the separate PDF document “MIDI Devices”.

4. Click OK. This adds a new external instrument bus.
5. Click in the Device Port column for the Return Bus
“Left” and “Right” ports and select the inputs on your audio
hardware to which you connected the external instrument.
6. If you like, make additional settings for the bus.
These are found in the columns to the right. Note however that you can
adjust these while actually using the external instrument – which may be
easier as you can hear the result. You have the following options:

The default parameter window for an external effect

Setting

Description

Like any effect, you can use the external FX bus as an insert effect or as a send effect (an insert effect on an FX
channel track). You can deactivate or bypass the external
effect with the usual controls.

Delay

If your hardware device has an inherent delay (latency),
you should enter this value here. This allows Nuendo to
compensate for that delay during playback. Note that you
don’t have to take the latency of the audio hardware into
account – this is handled automatically by the program.

Return Gain

Allows you to adjust the level of the signal coming in from
the external instrument.
Note however that excessive output levels from an external device may cause clipping in the audio hardware. The
Return gain setting cannot be used to compensate for
this – you have to lower the output level on the device instead.
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Setting

Description

MIDI Device

When you click in this column, a pop-up menu opens
where you can either disconnect the instrument from the
associated MIDI device, select a MIDI device, create a
new device or open the MIDI Device Manager in Nuendo
to edit the MIDI device.
When Studio Manager 2 is installed, you may also select
an OPT editor to access your external instrument.

Used

Whenever you insert the external instrument into a VST
Instrument slot, this column shows a chicanery (“x”) to indicate that the instrument is being used.

• To send MIDI notes to the external instrument, open the output pop-up menu in the Inspector for the corresponding MIDI
track and select the MIDI device to which the external instrument is connected. This ensures use of delay compensation.
The instrument will now play any MIDI notes it receives from
this track and return them to Nuendo through the return channel(s) you have set up.
The external instrument will behave like any other VST Instrument in Nuendo.

7. When you are done, close the VST Connections window.

About the Favorites buttons
In the VST Connections window, both the External FX tab
and the External Instruments tab feature a Favorites button.

Ö Note that external device ports are exclusive, see
“Connecting the external effect/instrument” on page 18.
How to use the external instrument
Once you have set up the external instrument in the VST
Connections window, you can use it as a VST Instrument.
Open the VST Instruments window and click on an empty
instrument slot. In the instrument pop-up menu, your external instrument is listed on the External Instruments submenu:

The Favorites button on the External FX tab

Favorites are device configurations that you can recall at
any time, like a library of external devices that are not constantly connected to your computer. They also allow you
to save different configurations for the same device, e.g. a
multi-effect board or an effect that provides both a mono
and a stereo mode.
To save a device configuration as a favorite, proceed as
follows:
• When you have added a new device in the VST Connections window, select it in the Bus Name column and
click the Favorites button.
A context menu is displayed showing an option to add the selected effect or instrument to the Favorites.

When you select the external instrument in the VST Instruments window, the following happens:

• You can recall the stored configuration at any time by
clicking the Favorites button and selecting the device
name from the context menu.

• A parameter window for the external device is opened automatically. This may either be the Device window, allowing you
to create a generic device panel, an OPT editor window or a
default editor. For information about the Device window, the
MIDI Device Manager and User device panels, see the separate PDF document “MIDI Devices”.
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About the “plug-in could not be found”
message

• Use the arrow buttons next to the Tail Size value field to
set the desired Tail length, i.e. the range after the part
boundary that should also be included for the freeze. You
can also click directly in the value field and enter the desired value manually (the maximum value being 60 s).

When you open a project that uses an external effect/instrument, you may get a “plug-in could not be found” message. This will happen when you remove an external
device from the VST Connections window although it is
used in a saved project, or when transferring a project to
another computer on which the external device is not defined. You may also see this message when opening a
project last saved with version 3.0 of Nuendo.

• When the Tail Size is set to 0s (default), the freezing will
only take into account the data within the Part boundaries.

In the VST Connections window, the broken connection
to the external device is indicated by an icon in the Bus
Name column.
To reestablish the broken connection to the external device, simply right-click the entry for the device in the Bus
Name column and select “Connect External Effect”. The
icon is removed, and you can use the external device
within your project as before.
!

Note that busses set up for external effects or external instruments are saved “globally”, i.e. for your particular computer setup.

Freezing external effects/instruments
Just as when working with regular VST instruments and
effects, you can also choose to freeze external effects and
instruments. The general procedure is described in detail
in the chapters “Audio effects” on page 168 and “VST Instruments and Instrument tracks” on page 189.
!

Note that you have to perform Freeze in realtime. Otherwise external effects will not be taken into account.

When freezing external instruments or effects, you can adjust the corresponding tail value in the Freeze Channel
Options dialog:
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3
The Project window

Background

Track type

Description

MIDI

For recording and playing back MIDI parts. Each MIDI
track has a corresponding MIDI channel strip in the mixer.
It’s possible to edit MIDI tracks directly in the Project window, using the Edit In-Place function (see “Edit In-Place”
on page 381).
A MIDI track can have any number of automation “subtracks” for automating mixer channel parameters, insert
and send effect settings etc.

Marker

The Marker track displays markers which can be moved
and renamed directly in the Project window (see “Using
the Marker track” on page 111). A project can have only
one marker track.

Arranger

The Arranger track is used for arranging your project, by
marking out sections in the project and determining in
which order they should be played back. See “The Arranger track” on page 98.

Ruler

Ruler tracks contain additional rulers, displaying the timeline from left to right. You can use any number of ruler
tracks, each with a different display format if you wish.
See “The ruler” on page 31 for more information about
the ruler and the display formats.

Transpose

The Transpose track allows you to set global key
changes. A project can only have one transpose track.
See “The Transpose functions” on page 114.

Video

For playing back video events. A project can only have
one video track.

The Project window is the main window in Nuendo. This
provides you with an overview of the project, allowing you
to navigate and perform large scale editing. Each project
has one Project window.

About tracks
The Project window is divided vertically into tracks, with a
timeline running horizontally from left to right. The following track types are available:
Track type

Description

Audio

For recording and playing back audio events and audio
parts. Each audio track has a corresponding audio channel in the mixer.
An audio track can have any number of automation “subtracks” for automating mixer channel parameters, insert
effect settings etc.

Folder

Folder tracks function as containers for other tracks,
making it easier to organize and manage the track structure. They also allow you to edit several tracks at the
same time. See “Folder tracks” on page 105.

FX Channel

FX channel tracks are used for adding send effects. Each
FX channel can contain up to eight effect processors –
by routing effect sends from an audio channel to an FX
channel, you send audio from the audio channel to the effect(s) on the FX channel. Each FX channel has a corresponding channel strip in the mixer – in essence an effect
return channel. See the chapter “Audio effects” on page
168.
An FX channel can also have any number of automation
subtracks for automating mixer channel parameters, effect settings etc. All FX channel tracks are automatically
placed in a special FX channel folder in the Track list, for
easy management.

About parts and events
Events are the basic building blocks in Nuendo. Different
event types are handled differently in the Project window:
• Video events and automation events (curve points) are always
viewed and rearranged directly in the Project window.
• MIDI events are always gathered in MIDI parts, containers for
one or more MIDI events. MIDI parts are rearranged and manipulated in the Project window. To edit the individual MIDI
events in a part, you have to open the part in a MIDI editor (see
“About editing MIDI” on page 364).
• Audio events can be displayed and edited directly in the Project
window, but you can also work with audio parts containing several events. This is useful if you have a number of events which
you want to treat as one unit in the project. Audio parts also
contain information about the time position in the project.

Group Channel By routing several audio channels to a Group channel,
you can submix them, apply the same effects to them,
etc. (see “Using group channels” on page 142).
A Group channel track contains no events as such, but
displays settings and automation curves for the corresponding Group channel. Each Group channel track has
a corresponding channel strip in the mixer. In the Project
window, Group channels are organized as subtracks in a
special Group Tracks folder.
Instrument

This allows you to create a track for a dedicated instrument, making e.g. VST instrument handling easier and
more intuitive. Instrument tracks have a corresponding
channel strip in the mixer. Each instrument track can have
any number of automation subtracks in the Project window. However, Volume and Pan are automated from
within the mixer. It is possible to edit Instrument tracks directly in the Project window, using the Edit In-Place function (see “Edit In-Place” on page 381). For more
information on instrument tracks, see “VST Instruments
and Instrument tracks” on page 189.

An audio event and an audio part.
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Audio handling
When you work with audio files, it is crucial to understand
how audio is handled in Nuendo:
When you edit or process audio in the project window,
you always work with an audio clip that is automatically
created on import or when you record audio. This audio
clip refers to the audio file on the hard disk that remains
untouched. This means, that audio editing and processing
is “non-destructive”, in the sense that you can always
undo changes or revert to the original versions.
The audio clip does not necessarily refer to just one original audio file! If you apply e.g. some processing to a section of an audio clip, this will actually create a new audio
file that contains only the section in question. The processing will then be applied to the new audio file only,
leaving the original audio file unchanged. Finally, the audio
clip is automatically adjusted, so that it refers both to the
original file and to the new, processed file. During playback, the program will switch between the original file and
the processed file at the correct positions. You will hear
this as a single recording, with processing applied to one
section only. This feature makes it possible to undo processing at a later stage, and to apply different processing
to different audio clips that refer to the same original file.
The audio event is the object that you place on a time position in Nuendo. If you make copies of an audio event and
move them to different positions in the project, they will
still all refer to the same audio clip. Furthermore, each audio event has an Offset value and a Length value. These
determine at which positions in the clip the event will start
and end, i.e. which section of the audio clip will be played
back by the audio event. For example, if you resize the audio event, you will just change its start and/or end position
in the audio clip – the clip itself will not be affected.
An audio region is a section within a clip with a length
value, a start time, and a snap point. Audio regions are
shown in the pool and are best created and edited in the
Sample Editor.
Ö If you want to use one audio file in different contexts, or
if you want to create several loops from one audio file, you
should convert the corresponding regions of the audio clip
to events and bounce them into separate audio files. This is
necessary since different events that refer to the same clip
access the same clip information.
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Window Overview
The info line

The Inspector

The toolbar

The Project overview

The ruler

The Track list with
various track types

The event display, showing audio parts and
events, MIDI parts, automation, markers, etc.

The Track list

• The Track list area for an audio track:

The Track list displays all the tracks used in a project. It
contains name fields and settings for the tracks. Different
track types have different controls in the Track list. To see
all the controls you may have to resize the track in the Track
list (see “Resizing tracks in the Track list” on page 35).

Automation Read/Write buttons
Mute & Solo

Show/hide
automation

Track name

Edit channel settings

Record Enable
Monitor buttons

Musical/Linear
time base
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Track activity
indicator

Lane DisLock track
play Type
button

Indicates whether effect sends, EQ or insert
effects are activated for the track. Click to bypass.

The Project window

Freeze Audio
Track

• The Track list area for an automation subtrack (opened
by clicking the Show/Hide Automation button on a track):
Append automation track

Mute

Automation Read/Write buttons

Lock track
button

Automation parameter
(click to select parameter)

• The Track list area for a MIDI track:
Drum map (Nuendo Expansion Kit only), Effect sends and insert effects
Lock track and Lane display type
indicators and bypass
Track name

• You can also use key commands to show different Inspector sections.

Record Enable & Read/Write
Monitor buttons buttons

Mute & Solo

Edit In-Place

These are set up in the Key Commands dialog, see “Setting up key commands” on page 518.

Ö Hiding a section does not affect its functionality.
Bank

Patch

MIDI channel

In other words, if you have set up a track parameter or activated an effect
for example, your settings will still be active even if you hide the respective Inspector section.

MIDI Output

Edit channel settings

Track activity
indicator

Which sections are available in the Inspector depends on
the selected track.

The Inspector

Ö Please note that not all Inspector tabs are shown by
default. You can show/hide Inspector sections by rightclicking on an Inspector tab and activating/deactivating
the desired option(s).

The area to the left of the Track list is called the Inspector.
This shows additional controls and parameters for the track
you have selected in the Track list. If several tracks are selected (see “Handling tracks” on page 38), the Inspector
shows the setting for the first (topmost) selected track.

Make sure you right-click on an inspector tab and not on the empty area
below the Inspector, as this will open the Quick context menu instead.

To hide or show the Inspector, click the Inspector icon in
the toolbar.

The Inspector icon.

• For most track classes, the Inspector is divided into a
number of sections, each containing different controls for
the track. You can hide or show sections by clicking on
their respective names.
Clicking the name for a hidden section brings it into view and hides the
other sections. [Ctrl]/[Command]-clicking the section name allows you
to hide or show a section without affecting the other sections. Finally,
[Alt]/[Option]-clicking a section name shows or hides all sections in the
Inspector.

The Inspector Setup context menu.
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Sections

Parameter

Description

Delay

This adjusts the playback timing of the audio track. Positive values delay the playback while negative values
cause the track to play earlier. The values are set in milliseconds.

Input Routing

This lets you specify which Input bus or MIDI input the
track should use (see “Setting up busses” on page 11 for
information about Input busses).

Output Routing Here you decide to which output the track should be
routed. For audio tracks you select an output bus (see
“Setting up busses” on page 11) or Group channel, for
MIDI tracks you select a MIDI output.
Inserts section

Allows you to add insert effects to the track, see the
chapter “Audio effects” on page 168. The Edit button at
the top of the section opens the control panels for the
added insert effects.

Equalizers
section

Lets you adjust the EQs for the track. You can have up to
four bands of EQ for each track, see “Making EQ settings” on page 138. The Edit button at the top of the section opens the Channel Settings window for the track.

Equalizer Curve Lets you adjust the EQs for the track graphically, by clicksection
ing and dragging points in a curve display.

The Inspector contains the controls that can be found on
the Track list, plus some additional buttons and parameters. In the table below, these additional settings and the
available sections are listed. Which sections are available
for which track type is described in the following sections.
Parameter

Volume

Use this to adjust the level for the track. Changing this
setting will move the track’s fader in the mixer window,
and vice versa. See “Setting volume in the mixer” on page
132 to learn more about setting levels.

Pan

Studio Sends

The Studio Sends are used to route cue mixes to Control
Room Studios. For a detailed description of Studios and
Studio Sends, see the chapter “Control Room” on page
151.

Surround Pan

When the Surround Panner is used for a track, this is also
available in the Inspector. For further information, see
“Using the Surround Panner” on page 208.

Notepad section This is a standard text notepad, allowing you to jot down
notes about the track.
If you have entered any notes about a track, the icon next
to the “Notepad” heading will light up to indicate this.
Moving the pointer over the icon will display the Notepad
text in a tool tip.

Auto Fades
Opens a dialog in which you can make separate Auto
Settings button Fade settings for the track. See “Making Auto Fade settings for a separate track” on page 97.
Opens the Channel Settings window for the track, allowing you to view and adjust effect and EQ settings, etc.
See “Using Channel Settings” on page 137.

Allows you to route an audio track to one or several FX
channels (up to eight), see the chapter “Audio effects” on
page 168. For MIDI tracks, this is where you assign MIDI
send effects. The Edit button at the top of the section
opens the control panel for the first effect in each FX
channel.

Channel section Shows a duplicate of the corresponding mixer channel
strip. The channel overview strip to the left lets you activate and deactivate insert effects, EQs and sends.

Description

Edit Channel
settings

Sends section

Use this to adjust the panning of the track. As with the
Volume setting, this corresponds to the Pan setting in the
mixer.

Network
section

This contains controls related to the Network functions of
the program. For further information, see the separate
PDF document “Networking”.

User Panel

Here you can display device panels, e.g. for external MIDI
devices, audio track panels or VST insert effect panels.
For information on how to create or import MIDI device
setups, see the separate PDF document “MIDI Devices”.

Quick Controls Here you can configure quick controls, e.g. to use remote
devices. See the chapter “Track Quick Controls” on
page 338.
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Audio tracks

Once panels have been created, they are available from
the User Panel section of the Inspector. Click on the arrow
button at the top right of the User Panel section to view
the available panels.

For audio tracks, all settings and sections listed above are
available.
• User Panels for audio tracks can display panels for
channel controls (such as input phase or the linked panner
option) or for VST effects currently inserted in the channel.
• User Panels for audio tracks are accessed by clicking
the Open Device Panels button (found in the topmost Inspector section, next to the Read/Write buttons).
This opens up a menu listing all the device panels available for the audio
track. If panels have not been created yet, you will see “Setup” panels in
the menu. Double-cicking on one of these will open the Device window
for that audio track. Here you will be able to create user panels for any
parameter of the audio track, including VST effects that have been inserted. For more information on how to create device and user panels,
see the separate PDF document “MIDI Devices”.

The User Panel menu in the Inspector
!

The Inspector can only display inspector sized user
panels. Panels of larger sizes will not be available in
the Inspector.

MIDI tracks
When a MIDI track is selected, the Inspector contains a
number of additional sections and parameters, affecting the
MIDI events in real time (e.g. on playback). Which sections
are available for MIDI tracks is described in the chapter
“MIDI realtime parameters and effects” on page 342.
Marker tracks
When the marker track is selected, the Inspector shows
the marker list. See “The Marker window” on page 110.
The device panel browser.

Video tracks
When a video track is selected, the Inspector contains a
lock button for locking the track (see “Locking events” on
page 50), a Mute button for interrupting video playback
and two settings for how the video thumbnails are shown:
Show Frame Numbers and Snap Thumbnails (see
“Playing back a video file” on page 472).
Video tracks make use of the Notepad and Network Inspector tabs.
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Folder tracks

shown in the folder to have the Inspector show the settings for that FX channel – this way you don’t have to
“open” a folder track to access the settings for the FX
channels in it.

When a folder track is selected, the Inspector shows the
folder and its underlying tracks, much like a folder structure in the Windows Explorer or Mac OS X Finder.

Group channel tracks

Ö You can click one of the tracks shown under the folder
in the Inspector to have the Inspector show the settings
for that track.

When a Group channel track is selected, the following
controls and sections are available:

This way, you don’t have to “open” a folder track to make settings for
tracks within it.

•
•
•
•
•
•
•
•
•
•
•
•

Here, an audio track within the folder is selected.

Group channel folder tracks

FX channel tracks

Just like FX channel tracks, all Group channel tracks are
placed in a separate folder – when this is selected, the Inspector shows the folder and the Group channels it contains. You can click one of the Group channels shown in
the folder to have the Inspector show the settings for that
Group channel – this way, you don’t have to “open” a folder
track to access the settings for the Group channels in it.

When an FX channel track is selected, the following controls and sections are available:
•
•
•
•
•
•
•
•
•
•
•
•

Edit button.
Volume control.
Pan control.
Output routing pop-up menu.
Inserts section.
Equalizers section.
Equalizer Curve section.
Sends section.
Studio Sends section.
Surround Pan section.
Channel section.
Notepad section.

Edit button.
Volume control.
Pan control.
Output routing pop-up menu.
Inserts section.
Equalizers section.
Equalizer Curve section.
Sends section.
Studio Sends section.
Surround Pan section.
Channel section.
Notepad section.

Ruler tracks
For ruler tracks, the Inspector isn’t used.
Transpose track
When the transpose track is selected, the following controls and sections are available:
•
•
•
•
•
•

FX channel folder tracks
FX channel tracks are automatically placed in a special
folder, for easier management. When this folder track is
selected, the Inspector shows the folder and the FX channels it contains. You can click one of the FX channels

Mute button.
Keep Transpose in Octave range.
Toggle Timebase button.
Lock button.
Notepad section.
Network section.

The Transpose track controls are described in detail in the
chapter “The Transpose functions” on page 114.
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The toolbar

The info line

The toolbar contains tools and shortcuts for opening other
windows and various project settings and functions:
The info line shows information about the currently selected event or part in the Project window. You can edit almost all values on the info line using regular value editing.
Length and position values are displayed in the format currently selected for the ruler (see “The ruler” on page 31).

Constrain delay compensation (see the chapter “VST
Instruments and Instrument tracks” on page 189).
Show/hide Show/hide
info line
Overview

Automation mode

• To hide or show the info line, click the Show Event Infoline button on the toolbar.
Active project
indicator

Show/hide
Inspector

Open Mixer

The following elements can be selected for display and
editing on the info line:

Open Pool

•
•
•
•
•
•
•
•

Project window tools

Transport controls
(Previous/Next Marker, Cycle, Stop, Play, and Record)
Project
Root key

Snap
on/off

Grid popup menu

Autoscroll Snap mode
on/off

Quantize
value

Snap to Zero
Crossings

Audio events.
Audio parts.
MIDI parts.
Video events.
Markers.
Automation curve points.
Transpose events.
Arranger events.

When several elements are selected
• If you have several elements selected, the info line will
show information about the first item in the selection. The
values will be shown in yellow to indicate that several elements are selected.

Color popup menu

• If you edit a value on the info line, the value change is
applied to all selected elements, relatively to the current
values.

Ö In addition to these, the toolbar can contain a number
of other tools and shortcuts, not visible by default. How to
set up the toolbar and specify which tools should be displayed or hidden is described in the section “The Setup
dialogs” on page 506.

If you have two audio events selected and the first is one bar long and
the other two bars long, the info line shows the length of the first event
(one bar). If you now edit this value to 3 bars in the info line, the other
event will be resized by the same amount – and will thus be 4 bars long.

• If you press [Ctrl]/[Command] and edit on the info line,
the values will be absolute instead. In our example above,
both events would be resized to 3 bars. Note that [Ctrl]/
[Command] is the default modifier key for this – you can
change this in the Preferences (Editing–Tool Modifiers
page, under the Info Line category).
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The ruler

Editing Transpose and Velocity for MIDI parts
When one or several MIDI parts are selected, the info line
contains Transpose and Velocity fields.
• Adjusting the Transpose field transposes the selected
parts in semitone steps.

The ruler at the top of the event display shows the timeline. Initially, the Project window ruler uses the display format specified in the Project Setup dialog (see “The
Project Setup dialog” on page 33), as do all other rulers
and position displays in the project. However, you can select an independent display format for the ruler by clicking
the arrow button to the right of it and selecting an option
from the pop-up menu that appears (you can also bring up
this pop-up menu by right-clicking anywhere in the ruler).

Note that this transposition doesn’t change the actual notes in the part –
it’s just a “play parameter”, affecting the notes on playback. The transposition you specify for a part on the info line is added to the transposition
set for the whole track. For more information on transposing, see the
chapter “The Transpose functions” on page 114.

• Adjusting the Velocity field shifts the velocity for the selected parts – the value you specify is added to the velocities of the notes in the parts.
Again, this velocity shift only affects the notes on playback, and again,
the value you specify is added to the Vel.Shift. value set for the whole
MIDI track in the Inspector.
!

Audio events can also be transposed – see “Realtime pitch-shifting of audio events” on page 288.

Getting on-the-fly info with the Arrow tool
If the option “Select Tool: Show Extra Info” is activated in
the Preferences (Editing–Tools page), a tool tip will be
shown for the Arrow tool, displaying information depending on where you point it. For example, in the Project window event display, the tool will show the current pointer
position and the name of the track and event you’re pointing at.

Option

Positions and lengths displayed as

Bars+Beats

Bars, beats, sixteenth notes and ticks. By default there
are 120 ticks per sixteenth note but you can adjust this
with the “MIDI Display Resolution” setting in the Preferences (MIDI page).

Seconds

Hours, minutes, seconds and milliseconds.

Timecode

This format displays hours, minutes, seconds and frames.
The number of frames per second (fps) is set in the
Project Setup dialog (see “The Project Setup dialog” on
page 33). You can choose between 24, 25, 29.97 and
30 fps or 29.97 and 30 dfps (“drop frame”).

Feet+Frames
16mm

Feet and frames, with 40 frames per foot.

Feet+Frames
35mm

Feet, frames and 1/4 frames, with 16 frames per foot.

Samples

Samples.

User

Hours, minutes, seconds and frames, with a user definable number of frames per second. You set the desired
number of fps in the Preferences (Transport page).

Time Linear

When this is selected, the ruler will be linear relative to
time. This means that if there are tempo changes on the
Tempo track, the distance between the bars will vary in
Bars+Beats mode.

Bars+Beats
Linear

When this is selected, the ruler will be linear relative to
the meter position – bars and beats. This means that if
there are tempo changes on the Tempo track, there still
will be the same distance between bars in Bars+Beats
mode. If the ruler is set to a time-based mode, the distance between seconds will vary depending on the
tempo changes.

• The selection you make here affects the ruler, the info
line and tool tip position values (which appear when you
drag an event in the Project window).
You can also select independent formats for other rulers and position
displays.
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• To set the display format globally (for all windows), use
the primary display format pop-up on the Transport panel,
or hold down [Ctrl]/[Command] and select a display format in any ruler.

You can add any number of ruler tracks to a project, and
position them as needed by dragging them up or down in
the list. Each of the rulers can show a separate display format:

• If you use the “Timecode” or “User” options and the option “Show Timecode Subframes” is activated in the Preferences (Transport page), the frames will also display
subframes.

• To select a display format for a ruler track, click on its
name in the track list and select an option from the pop-up
menu.
The different display formats are described above.

There are 80 subframes per frame.

• For the “Feet+Frames” settings, there is an option in the
Preferences (Transport page) called “Feet’n’Frames
Count from Project Start”.
When this is activated, time displays and rulers in Feet+Frames format
will always start with 0’00 at the beginning of the project – regardless of
any Start offset settings in the Project Setup dialog.

Using multiple rulers – ruler tracks
As described above, the Nuendo Project window contains
a main ruler at the top of the event display, displaying the
timeline from left to right.

Note that ruler tracks are completely independent from the
main event display ruler, as well as rulers and position displays in other windows. This means that:

If needed, you can have several rulers in the Project window, by adding ruler tracks to the project. Each ruler track
contains an additional ruler.

• Ruler tracks can all have independent display formats.
• Ruler tracks are not affected by the display format setting in
the Project Setup dialog (see “The Project Setup dialog” on
page 33).
• Ruler tracks are not affected if you set the display format globally with the primary time display in the Transport panel.

• To add a ruler track, select “Add Track” from the Project
menu and from the submenu that appears, select “Ruler”.
A ruler track showing an additional ruler is added to the Track list.

Ö Ruler tracks are affected by the option “Show Timecode Subframes” in the Preferences (see above).
A ruler track set to the display format “Seconds”.
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Operations

The following settings are available in the Project Setup
dialog:

Creating a new project

Setting

Description

You create a new project in the following way:

Start

The start time of the project. Allows you to have the
project start at another time than zero. Also used for setting the sync start position when synchronizing Nuendo
to external devices (see “Setting up Nuendo for external
sync to timecode” on page 451). The format of this value
is always in timecode. When you change this setting you
will be asked whether you want to keep the project content at its timecode positions. “Yes” means that all events
will stay at their original timecode positions – i.e. they will
be moved in relation to the start of the project. “No”
means that all events keep their position relative to the
project start. See also the note on Feet+Frames in the
section “The ruler” on page 31.

Length

The length of the project. Nuendo is capable of having
longer lengths than 24 hours since the timecode includes
a “day” field. This can be handy when creating projects
that use “time of day” timecode and cross over the 24
hour mark. The maximum project length is 10 days.

Frame Rate

Used when synchronizing Nuendo with external equipment. If Nuendo is slave, this value is automatically set to
the frame rate of the incoming sync signal. If Nuendo is
the master, this determines the frame rate of the sent
sync signal. See “Setting the Frame Rate” on page 448.

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any
custom templates you may have created (see “Save as Template” on
page 488).

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project
folder. This will contain all files related to the project.

3. Select an existing folder or type the name of a new
one. Click OK.
A Project window appears. The new project will be based on the selected
template, and include tracks, events and settings from the template.

The Project Setup dialog
General settings for the project are made in the Project
Setup dialog. This is opened by selecting “Project
Setup…” from the Project menu.

Display Format This is the global display format used for all rulers and
position displays in the program, except ruler tracks (see
“Ruler tracks” on page 29). However, you can make independent display format selections for the individual rulers
and displays if you like.
For descriptions of the different display format options,
see “The ruler” on page 31.
Display Offset

Offsets the time positions displayed in the ruler etc., allowing you to compensate for the Start position setting.
Typically, if you synchronize Nuendo to an external
source starting at a frame other than zero, you set the
Start position to this value. However, if you still want the
display in Nuendo to start at zero, set the Display Offset
to the same value too.

Bar Offset

This works just like “Display Offset” described above, in
that it offsets the time positions in the ruler by a number
of bars, allowing you to compensate for the Start position
setting. The difference is that Bar Offset is only used
when the “Bars+Beats” display format is selected (see
“The ruler” on page 31).

Sample Rate

The sample rate at which Nuendo records and plays audio.

Pull-up/Pulldown

When working with film transfers, this option is used to
synchronize sound and images correctly. This is described
in detail in the section “Working with film transfers” on
page 476.

Record Format/ When you record audio in Nuendo, the files that are creFile Type
ated will be of this resolution and file type. See “Selecting
a recording file format” on page 67.
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Setting

Description

Stereo Pan Law Decides whether panning should use power compensation or not (see “About the “Stereo Pan Law” Preference
(audio channels only)” on page 136).

!

While most Project Setup settings can be changed at
any time, you should select a sample rate once and for
all when starting with a new project! All audio files
must be of this sample rate to play back correctly.

Option

Description

Zoom In
Tracks

Zooms in on the selected track(s) one step vertically.

Zoom Out
Tracks

Zooms out the selected track(s) one step vertically.

Zoom Selected This zooms in vertically on the selected track(s) and minTracks
imizes the height of all other tracks.
Undo/Redo
Zoom

These options allow you to undo/redo the last zoom operation.

• If the option “Zoom while Locating in Time Scale” is activated in the Preferences (Transport page), you can also
zoom by clicking in the main ruler and dragging up or
down with the mouse button pressed.

Zoom and view options
Zooming in the Project window is done according to the
standard zoom techniques, with the following special
notes:

Drag up to zoom out; drag down to zoom in.

• When you are using the Zoom tool (magnifying glass),
the result depends on the option “Zoom Tool Standard
Mode: Horizontal Zooming Only” in the Preferences (Editing–Tools page).

• You can zoom the contents of parts and events vertically, using the waveform zoom slider in the top right corner of the event display.
This is useful when viewing quiet audio passages.

If this is activated and you drag a selection rectangle with the Zoom tool,
the window will only be zoomed horizontally (track height will not change).
If the option is off, the window will be zoomed both horizontally and vertically.

• When using the vertical zoom sliders, the tracks are
scaled relatively.
In other words, if you have made any individual track height adjustments
(see below), the relative height differences are maintained.

!

You find the following options are available on the Zoom
submenu on the Edit menu:
Option

Description

Zoom In

Zooms in one step, centering on the project cursor.

Zoom Out

Zooms out one step, centering on the project cursor.

Zoom Full

Zooms out so that the whole project is visible. “The whole
project” means the timeline from the project start to the
length set in the Project Setup dialog (see above).

Zoom to
Selection

Zooms in horizontally and vertically so that the current selection fills the screen.

Zoom to
Selection
(Horiz)

Zooms in horizontally so that the current selection fills the
screen.

Zoom to Event

This option is available only in the Sample Editor (see
“Zooming” on page 265).

Zoom In
Vertical

Zooms in one step vertically.

Zoom Out
Vertical

Zooms out one step vertically.

To get an approximate reading on the level of the audio events by viewing the waveforms, make sure this
slider is all the way down. Otherwise, zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences (Editing page), the contents of parts and events will
not be continuously redrawn when you zoom manually.
Instead, the contents are redrawn once you have stopped changing the
zoom – activate this if screen redraws are slow on your system.
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Resizing tracks in the Track list

The Enlarge Selected Track option

• You can change the height of an individual track by
clicking on its lower border in the Track list and dragging
up or down.

When this option is activated on the Edit menu (or in the
Preferences, Editing–Project & Mixer page), the selected
track is enlarged automatically. This is useful if you are
stepping through the tracks in the track list, to check or
edit the settings. The tracks will revert to the size they had
before when they are deselected. You can adjust the size
directly in the Track list if the default enlargement factor
does not suit you.

To change the height of all tracks simultaneously, hold down [Ctrl]/
[Command] and resize one of the tracks in this way. If “Snap Track
Heights” is activated on the Track scale pop-up (see below), the track
height will change in fixed increments when you resize it.
!

This behavior is different when “Enlarge Selected
Track” is activated on the Edit menu (see below).

• By default, the controls shown for tracks in the Track list
will adapt to the track size. This means that when resizing
a track’s height or width the controls will be placed where
they best “fit in”.

While this is the program behavior you will want in most
cases, it may be a disadvantage when changing the track
height you started out with for one or more tracks (i.e. their
“original” height, before "Enlarge Selected Track" was activated). As soon as you try to resize a track, it is selected
and automatically enlarged. Instead of turning off “Enlarge
Selected Track”, resizing the desired track(s) and the activating “Enlarge Selected Track” again, you can resize a
track in the Track list without selecting it.

If you prefer to have the controls in fixed positions, you can deactivate the
option “Wrap Controls” in the Track Controls settings dialog (see “Customizing track controls” on page 507).

1. Move the mouse pointer over the lower border of the
(unselected) track you want to resize.

• You can also change the width of the Track list area, by
dragging the border between the Track list and the event
display.

The mouse pointer turns into a divider symbol.

• You can decide for each track type what controls
should be shown in the Track list – see “Customizing
track controls” on page 507.

2. Hold down [Alt]/[Option] and drag the lower border of
the track until it reaches the desired height.
Now, when you select this track, (and “Enlarge Selected Track” is activated), it will be enlarged. It will revert to the changed size, when you select a different track.

• You can use the Track scale pop-up (opened by clicking
the arrow button above the vertical zoom control) to set the
number of tracks to view in the current Project window.
The track height will be adjusted to show only the number of tracks specified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up
you can manually set the number of tracks to fit in the current Project window.

• Tracks can also be divided vertically in lanes – see
“Editing in Lane Display mode” on page 51.
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Zoom presets and Cycle markers

• If you want to rename a preset, select “Organize…”
from the pop-up menu.

The pop-up menu to the left of the horizontal zoom control
allows you to select, create and organize zoom presets.
These are useful if you want to toggle between different
zoom settings (e.g. one where the whole project is displayed in the project window and another with a high
zoom factor for detailed editing). With this pop-up menu,
you can also zoom in on the area between cycle markers
in the project.

In the dialog that appears, select the desired preset in the list and click
the Rename button. A second dialog opens, allowing you to type in a
new name for the preset. Click OK to close the dialogs.
!

Zoom presets are global for all projects, i.e. they are
available in all projects you open or create.

The middle part of the pop-up lists any cycle markers you
have added in the project:
• If you select a cycle marker from this menu, the event
display is zoomed in to encompass the marker area (see
“Zooming to cycle markers” on page 112).
• You cannot edit the cycle markers in this pop-up menu.
For information on editing markers, see “The Marker window” on page 110.
!

Only the cycle markers you create in the current
project are available on the menu.

The Zoom history

Click here…

Nuendo maintains a history of recent zoom stages, allowing you to undo and redo zoom operations. This way you
can zoom in several steps and then easily go back to the
zoom stage at which you started.

…to open the context menu.

The upper part of the menu lists the zoom presets:

There are two ways to invoke Undo Zoom and Redo
Zoom:

• To store the current zoom setting as a preset, select
Add from the pop-up menu.

• Use the items on the Zoom submenu on the Edit menu.

A dialog appears, allowing you to type in a name for the preset.

You can also assign key commands for these.

• To select and apply a preset, select it from the pop-up
menu.

• Double-click with the Zoom tool (magnifying glass) to
Undo Zoom.

• The “Zoom Full” preset is always available. Selecting
this option zooms out so that the whole project is visible.
“The whole project” means the timeline from the project
start to the length set in the Project Setup dialog (see
“The Project Setup dialog” on page 33).

Press [Alt]/[Option] and double-click to Redo Zoom.

• If you want to delete a preset, select “Organize…” from
the pop-up menu.
In the dialog that appears, select the preset in the list and click the Delete button. The preset is removed from the list.
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Adjusting how parts and events are shown

Option

Description

The Preferences on the File menu (the Nuendo menu, under Mac OS X) contains several settings for customizing
the display in the Project window.

Thick Fade
Lines

If this option is activated, the fade lines and volume
curves are thicker, increasing their visibility.

Show
Waveforms

Determines whether audio waveforms should be shown
at all.

The Event Display page contains common settings for all
track types:

Background
Color
Modulation

When this is activated, the backgrounds of audio waveforms are displayed in a different way, reflecting the waveform dynamics. This is especially useful to get an overview
when working with small track heights.

Option

Description

Colorize Event Determines whether the backgrounds or “contents” (waveBackground forms, etc.) of parts and events will be colorized. See
“Handling tracks” on page 38.
Show Event
Names
Transparent
Events

The Event Display–MIDI page contains settings for MIDI
parts:

Determines whether the names of parts and events should
be shown in the Project window.

Option

Description

When this is activated, events and parts will be transparent,
showing the waveforms and MIDI events only.

Default Edit
Action

Determines which editor should be opened when you
double-click a MIDI part or select it and press [Ctrl]/
[Command]-[E]: the Key or List editor.

Part Data
Mode

Determines if and how events in MIDI parts should be
shown in the Project window: as score notes, as drum
notes (Nuendo Expansion Kit only) or as lines. If “No
Data” is selected, events will not be shown at all. Nuendo
Expansion Kit only: Note that this setting is overridden for
tracks with drum maps if the option “Edit as Drums when
Drum Map is assigned” (see below) is activated.

Show
Controllers

Governs whether non-note events (controllers, etc.)
should be shown in MIDI parts in the Project window.

Edit as Drums
when Drum Map
is assigned
(Nuendo Expansion Kit only)

If this is activated, parts on MIDI tracks with drum maps
assigned will be shown with drum note symbols in the
Project window. Also, the parts will automatically open in
the Drum editor when double-clicked (overriding the Default Edit Action setting above).

Note Name
Style

Determines how MIDI note names (pitches) should be
displayed in editors, etc.

Show Data on If this is activated, the contents of events and parts will be
shown, even if the height of a track is very small.
Small Track
Heights

The Event Display–Video page contains settings for video
events:
Option

Description

Show Video
Thumbnails

When this is activated, thumbnail frames of the video
contents are shown on the Video track.

Video Cache
Size

This determines how much memory is available for video
thumbnails. If you have long video clips and/or work with
a large zoom factor (so that a lot of frames are shown in
the thumbnails), you may have to raise this value.

The Event Display–Audio page contains settings for audio
events:
Option

Description

Interpolate
Audio Images

If the option is deactivated, single sample values are
drawn as “steps”. If the option is activated they are interpolated to form “curves”.

Wave Image
Style

Determines whether audio waveforms should be displayed as solid images, frames or “inverted” images
(solid+frame). This selection affects all waveform images
in the Project window, Sample Editor and Audio Part Editor.
Note that the “Framed” and “Solid and Framed” styles
are more demanding for the computer. If the system feels
slower in these modes, please switch back to “Solid”
wave image style.

Show Event
If this is activated the “volume curves” created with the
Volume Curves volume and fade handles are always shown – if not, the
Always
curves are only shown for selected events.
Fade Handles
always on top

When this option is activated, the fade handles stay at
the top of the event, and vertical help lines indicate the
exact end or start points of fades.
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Zooming and navigating in the overview line

Handling tracks

By clicking the Show Overview button on the toolbar, an
extra pane appears under the toolbar; the project overview
line.

To add a track to the project, select “Add Track” from the
Project menu and select a track type from the submenu
that appears. The new track is added below the currently
selected track in the Track list.
• The items on the “Add Track” submenu are also available on the Quick menu.
This is accessed by right-clicking in the Track list.

Show Overview button

In the overview line, events and parts on all tracks are displayed as boxes. You can use the overview line to zoom in
or out, and for navigating to other sections of the project.
This is done by moving and resizing the track view rectangle in the overview line:

The track view rectangle

• The track view rectangle indicates the section of the
project currently displayed in the event display.

• If you select Audio, MIDI, Group Channel or Instrument
from the Add Track submenu, a dialog opens, allowing
you to insert several tracks in one go.

• You zoom in or out horizontally by resizing the rectangle.
Resize it by dragging the edges of the rectangle.

Just enter the desired number of tracks in the value field.

• For audio and group channel tracks, the channel configuration – mono, stereo or a surround configuration – can
be set in the Configuration pop-up.
• You can drag the track view rectangle to view other
sections of the project.

• The Browse Sounds option in the Add Track dialog is
described in the chapter “Track Presets” on page 327.

This can also be done by clicking anywhere in the upper part of the overview – the track view rectangle will be moved to where you clicked. The
number of tracks shown will not change.

• In the Preferences (Editing–Project & Mixer page, you
can find the option “Auto Track Color Mode”.
This offers you several options for automatically assigning colors to
tracks that are added to the project.

Once you have created tracks, you can manipulate and rearrange them in various ways:
• To rename a track, double-click in the name field and
type in a new name.
If you hold down any modifier key when pressing [Return] to close the
name field, all events on the track will get the name you entered.
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• To select a track, click on it in the Track list.

Disabling tracks

A selected track is indicated by a light gray color in the Track list.

It is possible to select several tracks, by pressing [Ctrl]/[Command] and
clicking them. To select a continuous range of tracks, use [Shift]-clicking.

Tracks can be disabled by selecting “Disable Track” from
the Track list context menu. Disabling a track is similar to
muting it (see “Muting events” on page 50), since a disabled track will not be played back. However, disabling a
track not only “zeroes” the output volume from the track,
but actually shuts down all disk activity for it. See “About
track disable/enable” on page 62 for more information.

• To move a track, click and drag it up or down in the list.

Track folding

• To duplicate a track, complete with all contents and
channel settings, right-click in the Track list and select
“Duplicate tracks” from the context menu, or select “Duplicate tracks” from the Project menu.

On the Project menu you will find the Track Folding submenu, allowing you to quickly show, hide or invert what is
displayed in the Project window event display. This enables you for example to divide the project into several
parts (by creating several folder tracks for the different
project elements) and showing/hiding their contents by
selecting a menu function (or using a key command). You
can also fold in automation subtracks this way. The following options are available:

This track is selected.

The duplicated track will appear below the original track.

• You can select a default color for a track by activating
“Show Track Colors” above the Track list and selecting a
color from the Color pop-up menu on the toolbar. This
color will be used for all events on the track and will also
be shown in the Mixer. You can override the default track
color for individual events and parts by using the Color
tool or the Color Selector pop-up menu.

• Toggle Selected Track
When you select this menu option, the fold state of the selected track is
reversed, i.e. if the track was folded in (its elements (subtracks) were hidden), it is now unfolded (all subtracks displayed) and vice versa.

The option “Colorize Event Background” in the Preferences dialog (Event
Display page) determines whether the backgrounds or waveforms of
events will be colorized.

• Fold Tracks
Select this menu option to fold in all open folder tracks in the Project window. Please note that the exact behavior of this function depends on the
“Deep Track Folding” setting in the Preferences, see below.

• To remove a track, right-click on it in the Track list and
select “Remove Selected Tracks” from the context menu.
You can also remove multiple selected tracks, by selecting “Remove Selected Tracks” either from the Project menu or from the context menu.
Furthermore, you can remove all tracks not containing any events by selecting “Remove Empty Tracks” from the Project menu.

• Unfold Tracks

• To change the track height of an individual track, click
on its lower border in the Track list and drag up or down,
see “Resizing tracks in the Track list” on page 35.

• Flip Fold States

Select this menu option to unfold all folder tracks in the Project window.
Please note that the exact behavior of this function depends on the
“Deep Track Folding” setting in the Preferences, see below.
Select this menu option to flip the fold states of the tracks in the Project
window. This means that all tracks that were folded in will be unfolded
and all unfolded tracks will be folded in, respectively.

Ö Note that you can also automatically enlarge the selected track, see “The Enlarge Selected Track option” on
page 35.

Ö You can assign key commands for these menu options
in the Key Commands dialog (Project category).
In the Preferences (Editing–Project & Mixer page), you can
find the following option affecting the track folding behavior:
• Deep Track Folding
When this is activated, any folding settings you make in the Track Folding submenu of the Project menu also affect the sub-elements of the
tracks, i.e. if you fold in a folder track which contains 10 audio tracks 5 of
which have several automation subtracks open, all these audio tracks
within the folder track will be folded in as well.
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Dividing the Track list

Switching between musical and linear time base

It is possible to divide the Track list into two parts. Both
sections will have independent zoom and scroll controls (if
needed), but resizing the window vertically will affect the
lower section only (if possible). This is useful if you’re
working with a video track along with multi-track audio for
example. This way, you can place the video track in the
upper Track list, letting you scroll the audio tracks separately in the lower Track list, referencing them against the
video track.

Tracks can be either musical (tempo) or linear (time) based.
• On a track using linear time base, the events will be positioned on specific time positions – changing the playback tempo will not affect the time position of events.
• On a track using musical time base, the positions of
events are represented as meter values (bars, beats, 1/16th
notes and ticks, with 120 ticks per 1/16th note). If you
change the playback tempo, the events will play back at an
earlier or later time.

• To divide the Track list, click the “Divide Track List” button in the top right corner of the Track list.

• In the Preferences (Editing page), you can find the option “Default Track Time Type”.
This allows you to specify the default track time type for new tracks (Audio, Group/FX, MIDI and Marker tracks). When you change this setting,
all new tracks will use the selected time type. You can choose between
“Musical”, “Time Linear” and “Follow Transport Main Display”. Selecting
“Musical” will cause all added tracks to be set to musical time type.
When you select “Time Linear”, all new tracks will use linear time base.
The third option uses the primary time format setting on the Transport
panel. When this is set to “Bars+Beats”, tracks with musical time base
will be added. When this is set to any of the other options (Seconds,
Timecode, Samples, etc.), all new tracks will use linear time base.

The “Divide Track List” button.

• To revert to a single Track list, click the button again.
When the Track list is divided into two parts, the following
applies:

Whether to use musical or linear time base depends on
the type of project and recording situation. You can always
change this setting individually for each track, by clicking
the musical/linear time base button in the Inspector or
Track list. Musical time base is indicated by a note symbol,
while linear time base is indicated by a clock symbol.

• If you add tracks from the Add Track submenu of the
Project menu, Video tracks, Marker tracks and Arranger
tracks will automatically be placed in the upper part of the
Track list.
If the Track list already contains tracks of the type Video, Marker or Arranger, these will automatically be moved to the upper part when you divide the Track list. All other types of tracks will be placed in the lower part.

Linear time base selected

• If you add tracks from the context menu invoked by
right-clicking in the Track list, tracks will be added to the
part of the Track list in which you click.
Musical time base selected

• You can move any type of track from the lower Track list
to the upper and vice versa by right-clicking it in the Track
list and selecting “Toggle Track List” from the context menu.

!

• You can resize the upper part by clicking and dragging
the divider between the Track lists.

Internally, events on musical time based tracks use the
same high precision for positioning (64 bit floating
point values) as linear time based events. However,
switching between linear and musical time base results in a very small loss of precision (introduced by
the mathematical operations used for scaling values in
the two different formats). Therefore you should avoid
switching repeatedly between the two modes.

For more information about tempo changes, see “Background” on page 415.
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Adding events to a track
There are a number of ways to add events to a track:
• By recording (see “Basic recording methods” on page
65).
This is possible for audio and MIDI tracks.

While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box. See also “By using
drag and drop” on page 302.

• By selecting “Audio File…” or “Video File…” from the
Import submenu on the File menu.

Audio file import options

This opens a file dialog, allowing you to locate the file you wish to import.
When you import a file this way, a clip is created for the file and an event
that plays the whole clip is inserted on the selected track, at the position
of the project cursor.
You can also import MIDI files by using the Import submenu, but this
works in a slightly different way (see “Exporting and importing standard
MIDI files” on page 498).

When you are importing audio files there are a number of
options concerning how the files should be treated by Nuendo:
• You can choose to copy the file into the audio folder of the
project and have the project make reference to the copied file
rather than the original file. This helps you keep your project
“self-contained”.
• You can choose to split stereo and multi-channel files into a
number of mono files.
• Furthermore, you may want all files in the project to have the
same sample rate and sample size (resolution).

• By grabbing audio CD tracks and converting them to audio files (see “Importing audio CD tracks” on page 491).
• By importing only the audio portion of a video file and
converting it to an audio file (see “Extracting audio from a
video file” on page 472).
• By using Copy and Paste on the Edit menu.

The Preferences (Editing–Audio page) contains a setting
that lets you decide which options, if any, to use. Select
the desired option on the “On Import Audio Files” pop-up:

This allows you to copy all kinds of events between projects. You can
also copy events within the project, from the Audio Part Editor or Sample
Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn directly into the Project window. For audio and MIDI tracks, you can draw
parts (see “Creating parts” on page 42).

• By dragging files and dropping them on the track at the
desired position.
You can create events by dragging and dropping from the following locations:

•
•
•
•
•
•
•
•

• Open Options Dialog.

The desktop.
The MediaBay.
The Pool.
A library (a Pool file that is not attached to a project).
The “Find media” dialog.
The Project window of another open project.
The Audio Part Editor of any open project.
The Sample Editor of any open project – press [Ctrl]/[Command] and drag to create an event of the current selection, or
click in the left column of the region list and drag to create an
event from a region.

An Options dialog appears when you import, allowing you to select
whether you want to copy the files to the Audio folder and/or convert them
to the project settings. Note:
– When importing a single file of a format other than the project settings,
you can specify which properties (sample rate and/or resolution) should be
changed.
– When importing multiple files at the same time, you can select to convert
the imported files automatically if necessary, i.e. if the sample rate is different than the project’s or the resolution is lower than the project setting.
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Auditioning audio parts and events

• Use Settings.
No Options dialog will appear when you import. Instead, you can choose
to make any of the options below the pop-up the standard action(s). Activate any number of the following options to have them performed automatically each time you import audio files:
Option

Description

Copy Files to
Working
Directory

If files are not already in the project’s audio folder they are
copied there before being imported.

Audio parts and events can be auditioned in the Project
window with the Speaker tool:
!

Convert and
If files are not already in the project’s audio folder they are
Copy to Project copied there before being imported. Furthermore, if the
If Needed
files have a different sample rate or a lower resolution
than the project settings, they are automatically converted.
Split multi
channel files

When auditioning, audio will be routed directly to the
Control Room, if the Control Room is activated.
When the Control Room is deactivated, the audio
will be routed to the default output bus, bypassing
the audio channel’s settings, effects and EQs.

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same tool button. If
the tool icon on the toolbar doesn’t show a speaker symbol, first click on
the icon to select it, then click again and select “Play” from the pop-up
menu that appears.

If you import a multi-channel audio file (including twochannel stereo files), it will be split into a number of mono
files – one for each channel – which are placed on separate, automatically created mono tracks.

Creating parts
Parts are containers for MIDI or audio events. If you record
MIDI, a MIDI part is automatically created, containing the
recorded events. You can also create empty audio or MIDI
parts and later add events to them. There are two ways to
do this:

2. Click where you want playback to start, and keep the
mouse button pressed.

• Draw a part on a MIDI or audio track with the Pencil tool.

3. Release the mouse button to stop playback.

Only the track on which you click is played back, starting at the click position.

You can also draw parts by pressing [Alt]/[Option] and using the Arrow
tool.

Scrubbing

• Double-click with the Arrow tool on a MIDI or audio
track, between the left and right locator.

The Scrub tool allows you to locate positions in the audio
by playing back, forwards or backwards, at any speed:
1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same tool button. If
the tool icon on the toolbar doesn’t show a “scrub symbol”, first click on
the icon to select it, then click again and select “Scrub” from the pop-up
menu that appears.

To add events to a MIDI part, you use the tools and functions in a MIDI editor (see “The Key Editor – Overview” on
page 366). Adding events to audio parts is done in the
Audio Part Editor (see “Window overview” on page 291)
by pasting or by using drag and drop.
• You can also gather existing audio events into a part, by
using the “Events to Part” function on the Audio menu.

2. Click at the desired position and keep the mouse button pressed.

This creates an audio part containing all selected audio events on the
same track. To remove the part and make the events appear as independent objects on the track again, select the part and use the “Dissolve
Part” function on the Audio menu.

The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back.
The speed and pitch of the playback depend on how fast you move the
pointer.
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You can adjust the responsiveness of the Scrub function
in the Preferences (Transport–Scrub page).
Ö It is also possible to “scrub” the whole project with the
Jog wheel on the Transport panel.
See “Project scrubbing – the Jog Wheel” on page 62.

• Note that scrubbing can be quite a burden on your system. To avoid playback problems, you will find the “CPU
Saving Scrub Mode” option in the Preferences (Transport–Scrub page).
When you activate this option, scrubbing will be less demanding on the
processor. This can be very useful when scrubbing in a large project,
where the “normal” scrub behavior leads to processing overloads. When
“CPU Saving Scrub Mode” is activated, the effects are disabled for
scrubbing and the resampling quality is lower.

Option

Description

From Cursor
to End

Selects all events that end to the right of the project
cursor.

Equal Pitch

These are available in the MIDI Editors (see “Selecting notes” on page 372).

Select Controllers
in Note Range

This is available in the MIDI Editors (see “Selecting
controllers within the note range” on page 372).

All on Selected
Tracks

Selects all events on the selected track.

Select Event

This is available in the Sample Editor (see “Window
overview” on page 260).

Left/Right Selection These two functions are only used for range selection
Side to Cursor
editing (see “Creating a selection range” on page 52).

!

Editing parts and events
This section describes techniques for editing in the Project
window. If not explicitly stated, all descriptions apply to both
events and parts, even though we use the term “event” for
convenience.

Note that these functions work differently when the
Range Selection tool is selected (see “Creating a
selection range” on page 52).

• Select all events on a track by right-clicking in its Track
list and selecting “Select All Events” from the pop-up
menu that appears.
• You can also use the arrow keys on the computer keyboard to select the closest event to the left, right, above or
below.

Ö When you are using the tools for editing, you can in
many cases get additional functions by pressing modifier
keys (e.g. pressing [Alt]/[Option] and dragging with the
Arrow tool creates a copy of the dragged event).

If you press [Shift] and use the arrow keys, the current selection will be
kept, allowing you to select several events.

On the following pages, the default modifier keys are described – you
can customize these in the Preferences (Editing–Tool Modifiers page),
see “Setting up tool modifier keys” on page 524.

Selecting events

• If the option “Auto Select Events under Cursor” is activated in the Preferences (Editing page), all events on the
selected track(s) that are “touched” by the project cursor
are automatically selected.

Selecting events is done using any of the following
methods:

This can be helpful when rearranging your project, since it allows you to
select whole sections (on all tracks) by selecting all tracks and moving
the project cursor.

• It is also possible to select ranges, regardless of the
event and track boundaries.

• Use the Arrow tool.
The standard selection techniques apply.

This is done using the Range Selection tool (see “Range editing” on page
52).

• Use the Select submenu on the Edit menu.
The options are:
Option

Description

All

Selects all events in the Project window.

None

Deselects all events.

Invert

Inverts the selection – all selected events are deselected and all events that were not selected are selected instead.

In Loop

Selects all events that are partly or wholly between
the left and right locator.

From Start
to Cursor

Selects all events that begin to the left of the project
cursor.

43
The Project window

• Note that in the Preferences (Editing page), you can
find the option “Use Up/Down Navigation Commands for
selecting Tracks only”.

Moving events
To move events in the Project window, use the following
methods:

By default, tracks are selected with the up/down arrow keys on the computer keyboard. However, these are also used for selecting events (see
above) which can lead to confusing results in some cases. Since track selection is a most vital operation in both editing and mixing, you have the option to use the navigation controls for track selection only. The following
applies:

• Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. You
can only drag events to tracks of the same type. If Snap is activated, this
determines to which positions you can move the events (see “Snap” on
page 55).
Note also that you can restrict movement to be either horizontal or vertical
only, by holding down [Ctrl]/[Command] while dragging.

• When this option is deactivated and no event/part is selected
in the Project window, the up/down arrow keys on the computer keyboard are used to step through the tracks in the
Track list – just as you would expect this to work.
• When this option is deactivated and an event/part is selected in
the Project window, the up/down arrow keys still step through
the tracks in the Track list – but on the currently selected track,
the first event/part will automatically be selected as well. If this
is not the desired behavior, you have to activate “Use Up/Down
Navigation Commands for selecting Tracks only”.
• When this option is activated, the up/down arrow keys are
only used to change the track selection – the current event/
part selection in the Project window will not be altered.

!

You will note that there is a slightly delayed response
when you move an event by dragging. This helps you
avoid accidentally moving events when you click on
them in the Project window. You can adjust this delay with the Drag Delay setting in the Preferences
(Editing page).

• Select the event and edit the Start position in the info line.
• Use the “Move to” functions on the Edit menu.
The following functions are available:
Function

• Also in the Preferences (Editing–Tools page), you can
find the Cross Hair Cursor options section.

Description

Move to Cursor Moves the selected event to the project cursor position. If
there are several selected events on the same track, the
first event will start at the cursor, and the following will be
lined up end-to-start after the first one.

This allows you to display a cross hair cursor when working in the Project
window and editors, facilitating navigation and editing, especially when
arranging in large projects. You can set up the colors for the line and the
mask of the cross hair cursor, and define its width. The cross hair cursor
works as follows:

Move to Origin Moves the selected events to their original positions, i.e.
the positions at which they were originally recorded.
Move to Front,
Move to Back

• When the Selection tool (or one of its subtools) is selected,
the cross hair cursor appears when you start moving/copying
a part/event, or when using the event trim handles.
• When the Pencil tool, the Scissors tool or any other tool that
makes use of this function is selected, the cross hair cursor appears as soon as you move the mouse over the event display.
• The cross hair cursor is only available for tools where such a
function is of any use. The Mute tool for example does not use
a cross hair cursor, as you have to click directly on an event to
mute it.
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This function doesn’t actually change the position of the
events, but moves the selected events to the front or
back, respectively. This is useful if you have overlapping
events, and want to see one that is partially obscured.
For audio events, this is an extra important feature, since
only the visible sections of events will be played back.
Moving an obscured audio event to front (or moving the
obscuring event to back) will allow you to hear the whole
event on playback (see also “Overlapping events” on
page 292).
Note that it is also possible to use the “To Front” function
on the event context menu for this (although this works in
a different way, see “Create Events mode (Preferences)”
on page 74).

• Use the Nudge buttons in the toolbar.

2. With the range selection tool selected, point on an audio event or part, press one of the modifiers listed in the
table below and click.

These move the selected events to the left or right. The amount of movement depends on the selected display format (see “The Project Setup dialog” on page 33) and the value set on the Grid pop-up menu.

The mouse pointer will change its shape and the audio event or part will
be aligned to the selected range.
!

Note that the functions depend on where you point
with the mouse.

In both cases, the following modifiers are available:
Modifier

Pointer Description

[Ctrl]/[Command]

This aligns the start of the audio event/part
to the start of the selected event, part or
range. This function is available when you
move the mouse on the beginning of the
non-selected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns
its start to the start of the selected event,
part or range. This function is available when
you move the mouse on the beginning of the
non-selected event.

You can decide which items should be visible by right-clicking in the
toolbar and checking them in the pop-up menu that appears. See “The
Setup dialogs” on page 506 for more information.

[Ctrl]/[Command]

This aligns the end of the audio event/part to
the start of the selected event, part or range.
This function is available when you move the
mouse on the end of the non-selected event.

Aligning events

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns
its end to the start of the selected event, part
or range. This function is available when you
move the mouse on the end of the non-selected event.

[Ctrl]/[Command]
+[Shift]

This aligns the start of the audio event/part
to the end of the selected event, part or
range. This function is available when you
move the mouse on the beginning of the
non-selected event.

[Ctrl]/[Command]
+[Shift]
+[Alt]/[Option]

This copies the audio event/part and aligns
its start to the end of the selected event, part
or range. This function is available when you
move the mouse on the beginning of the
non-selected event.

[Ctrl]/[Command]
+[Shift]

This aligns the end of the audio event/part to
the end of the selected event, part or range.
This function is available when you move the
mouse on the end of the non-selected event.

[Ctrl]/[Command]
+[Shift]
+[Alt]/[Option]

This copies the audio event/part and aligns its
end to the end of the selected event, part or
range. This function is available when you
move the mouse on the end of the non-selected event.

Here, clicking this button will move the event 2 frames to the right.
!

When the Range Selection tool is used, the Nudge
buttons move the selection range (see “Moving and
duplicating” on page 54).

Ö The Nudge buttons are not visible in the toolbar by default.

Nuendo provides shortcuts to quickly align audio events
and parts in the project window. You can align to selected
parts, events or ranges or to the cursor.
!

When the snap point is set, it will be used as a reference when you align events.

To align audio events or parts to selected parts or events,
proceed as follows:
1. Select an event or part of any type on any track.
This will be taken as a reference for aligning.

2. With the arrow tool selected, point on the audio event
or part you want to move, press one of the modifiers listed
in the table below and click.
The mouse pointer will change its shape and the audio event or part will
be aligned to the selected part or event.

To align audio events or parts to selection ranges, proceed as follows:
1. Make a selection range on any track.
This will be taken as a reference for aligning.
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You can also align audio events or parts to the project
cursor. This is done in the following way:

Duplicating events
Events can be duplicated in the following ways:

1. Set the cursor to the position where you want to move
the audio part or event.

• Hold down [Alt]/[Option] and drag the event to a new
position.

This will be taken as a reference for aligning.

If Snap is activated, this determines to which positions you can copy the
events (see “Snap” on page 55).

2. Make sure that nothing is selected in your project.
3. With the arrow tool selected, point on the audio event
or part you want to move, press one of the modifiers listed
in the table below and click.

!

The mouse pointer will change its shape and the audio event or part will
be aligned to the cursor.

• Audio and MIDI parts can also be duplicated by pressing [Alt]/[Option] + [Shift] and dragging.

For aligning audio events or parts to the cursor, the following modifiers are available:
Modifier

Icon

This aligns the start of the audio event/part to
the cursor. This function is available when you
move the mouse on the beginning of the nonselected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This copies the audio event/part and aligns its
start to the cursor. This function is available
when you move the mouse on the beginning of
the non-selected event.

[Ctrl]/[Command]

This aligns the end of the audio event/part to
the cursor. This function is available when you
move the mouse on the end of the non-selected event.

[Ctrl]/[Command]
+[Alt]/[Option]

This creates a shared copy of the part. If you edit the contents of a
shared copy, all other shared copies of the same part are automatically
edited in the same way.

Description

[Ctrl]/[Command]

If you hold down [Ctrl]/[Command] as well, movement direction is restricted to either horizontal or vertical. That means if you drag an event vertically it can
not be moved horizontally at the same time.

Shared copies are indicated by an icon in the right corner of the part.

Note:
• When you duplicate audio events, the copies are always shared. This means that shared copies of audio
events always refer to the same audio clip (see “Audio
processing” on page 239).

This copies the audio event/part and aligns its
end to the cursor. This function is available
when you move the mouse on the end of the
non-selected event.

• You can convert a shared copy to a real copy by selecting “Convert to Real Copy” from the Edit menu. This creates a new version of the clip (that can be edited
independently) and adds this to the Pool. Note that no new
files are created by this operation – for that you need to use
the “Bounce Selection” function from the Audio menu (see
“Exporting regions as audio files” on page 308).

Ö You can change the modifiers in the Preferences dialog (Editing–Tool Modifiers page).

• Selecting “Duplicate” from the Edit menu creates a
copy of the selected event and places it directly after the
original.
If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.

• Selecting “Repeat…” from the Edit menu opens a dialog, allowing you to create a number of copies (regular or
shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the number of copies.
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• You can also perform the Repeat function by dragging:
Select the event(s) to repeat, press [Alt]/[Option], click the
handle in the lower right corner of the last selected event
and drag to the right.

Renaming events
By default, audio events show the name of their clip, but
you can enter a separate descriptive name for separate
events if you like. This is done by selecting the event and
typing in a new name in the “Description” field in the info
line, or by using the Rename Object command from the
Edit menu.

The longer to the right you drag, the more copies are created (as shown
by the tooltip).

• You can also give all events on a track the same name
as the track by changing the track name, holding down a
modifier key and pressing [Return].
See “Handling tracks” on page 38.

• Selecting “Fill Loop” from the Edit menu creates a number of copies starting at the left locator and ending at the
right locator.

• The Rename Objects command is useful when renaming
multiple events at the same time. Select one or more
events. Then choose “Rename…” from the Edit menu. You
have several options for renaming events automatically using sequential numbers, timestamps and more (see “Renaming clips or regions in the Pool” on page 300).

The last copy is automatically shortened to end at the right locator position.

Splitting events
You can split events in the Project window in the following
ways:
Using Cut, Copy and Paste

• Click with the Scissors tool on the event you want to
split.

You can cut or copy selected events, and paste them in
again, using the functions on the Edit menu.

If Snap is activated, this determines the exact split position (see “Snap”
on page 55). You can also split events by pressing [Alt]/[Option] and
clicking with the Arrow tool.

• When you paste an event it is inserted on the selected
track, positioned so that its snap point is aligned with the
cursor position.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no
events are selected, all events (on all tracks) that are intersected by the
project cursor will be split.

If the selected track is of the wrong type, the event will be inserted on its
original track. See “Snap” on page 55 for information about the snap point.

• If you use the “Paste at Origin” function, the event is
pasted at its original position (the position from which you
cut or copied it).

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

Ö If you split a MIDI part so that the split position intersects one or several MIDI notes, the result depends on the
option “Split MIDI Events” in the Preferences (Editing–
MIDI page).

Using Cut Head and Cut Tail
You can cut everything to the left or right of the cursor or a
selected range:

If the option is activated, the intersected notes will be split (creating new
notes at the beginning of the second part). If it is deactivated, the notes
will remain in the first part, but “stick out” after the end of the part.

• If you use “Cut Head”, everything to the left of the cursor/selection range will be deleted. No data will be kept in
the clipboard.
• If you use “Cut Tail”, everything to the right of the cursor/selection range will be deleted. No data will be kept in
the clipboard.
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Gluing events together

The actual resizing is done by clicking and dragging the
lower left or right corner of the event. If Snap is activated,
the Snap value determines the resulting length (see
“Snap” on page 55).

You can glue events together using the Glue Tube tool.
There are three possibilities:
• Clicking on an event with the Glue Tube tool glues it together with the next event on the track. The events do not
have to touch one another.
The result is a part containing the two events, with one exception: If you
first split an event and then glue the two sections together again (without
moving or editing them first), they become a single event again.

• You can select several events on the same track and
click on one of them with the Glue Tube tool.
A single part is created.

• When you hold down [Alt]/[Option] while clicking on an
event with the Glue Tube tool, this event will be glued together with all following events on this track.
Normal sizing.

You can change the default key command for this in the Preferences
(Editing–Tool Modifiers page).

Resizing events
Resizing events means to move their start or end positions
individually. In Nuendo, there are three types of resizing:
Resizing type Description
Normal Sizing

The contents of the event stay fixed, and the start or end
point of the event is moved to “reveal” more or less of the
contents.

Sizing Moves
Contents

The contents follow the moved start or end of the event
(see the figure below).

Sizing Applies
Time Stretch

The contents will be time stretched to fit the new event
length (see the separate description on “Resizing events
using time stretch” on page 49).

Sizing moves contents.

• If several events are selected, all will be resized in the
same way.

To select one of the resizing modes, select the Arrow tool
and then click again on the Arrow tool icon on the toolbar.
This opens a pop-up menu from which you can select one
of the resizing mode options.

• You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the
audio under the pointer is played back (scrubbed) while you drag.

The icon on the toolbar will change, indicating the selected resizing mode.
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• It is also possible to resize events by using the Trim buttons (located in the Nudge palette) on the toolbar.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

This will move the start or end position of the selected Event(s) by the
amount set on the Grid pop-up menu. The sizing type currently selected
applies to this method too, with the exception of “Sizing Applies Time
Stretch” which is not possible with this method. You can also use key
commands for this (by default, press [Ctrl]/[Command] and use the left
and right arrow key).

• For MIDI parts, this means that the note events are
stretched (moved and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved,
and that the referenced audio files are time stretched to fit
the new length.
A dialog box shows the progress of the time stretch operation.

Ö You can adjust which algorithm should be used for the
time stretch algorithm in the Preferences (Editing–Audio
page).
For more information about time stretch, see “Time Stretch” on page 248.

Sliding the contents of an event or part
You can move the contents of an event or part without
changing its position in the Project window. By default, this
is done by pressing [Alt]/[Option]+[Shift], clicking in the
event or part and dragging to the left or right.

Ö Note that the Nudge palette is not visible in the toolbar
by default. See “The Setup dialogs” on page 506 for instructions on how to show and hide items in the toolbar.

!

Resizing events using time stretch
If you want to resize a part and make its contents “fit” the
new size, you should use this option. Proceed as follows:

When sliding the contents of an audio event, you
cannot slide past the start or end of the actual audio
clip. If the event plays the whole clip, you cannot
slide the audio at all.

Grouping Events
Sometimes it is useful to treat several events as one unit.
This can be done by grouping them: Select the events (on
the same or different Tracks) and select “Group” from the
Edit menu.

1. Click the Arrow icon on the toolbar and select the “Sizing Applies Time Stretch” option from the pop-up menu.
2. Point close to the end point of the part you want to
stretch.
3. Click and drag left or right.
When you move the mouse, a tooltip shows the current mouse position
and length of the part. Note that the snap value applies, as with any part
operation.

Grouped events are indicated by a group icon in the right corner.

If you edit one of the grouped events in the Project window,
all other events in the same group are affected too (if applicable).
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Group editing operations include:
•
•
•
•
•
•
•
•

• You can adjust the lock options for a locked event by
selecting it and selecting “Lock…” from the Edit menu
again.

Selecting events.
Moving and duplicating events.
Resizing events.
Adjusting fade-in and fade-out (audio events only, see “Creating fades” on page 87).
Splitting events (splitting one event will automatically split any
other grouped events that are intersected by the split position).
Locking events.
Muting events (see below).
Deleting events.

This opens a dialog in which you can activate or deactivate the desired
lock options.

• To unlock an event (turn off all lock options), select it
and select “Unlock” from the Edit menu.
• It is also possible to lock a whole track, by clicking the
padlock symbol in the Track list or in the Inspector.
This disables all editing of all events on the track.

Muting events
Locking events

To mute individual events in the Project window, proceed
as follows:

If you want to make sure you don’t edit or move an event
by accident, you can lock it. Locking can affect one (or any
combination) of the following properties:

• To mute or unmute a single event, click on it with the
Mute tool.

Lock Options Description
Position

If this is locked, the event cannot be moved.

Size

If this is locked, the event cannot be resized.

Other

If this is locked, all other editing of the event is disabled.
This includes adjusting the fades and event volume, processing, etc.

• To mute or unmute several events, select them – either
by using the standard selection techniques, or by using
one of the options on the Select submenu on the Edit
menu – and click on one of the selected events with the
Mute tool.

• To specify which of these properties should be affected
by the Lock function, use the “Lock Event Attributes” popup menu in the Preferences (Editing page).

All selected events will be muted.

• You can also click in an empty area with the Mute tool
and drag a selection rectangle around several events you
want to mute or unmute, and then click on one of them
with the Mute tool.
• You can mute events by selecting them and selecting
“Mute” from the Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute”
from the Edit menu.

• To lock events, select them and select “Lock…” from
the Edit menu.

• You can also change the mute status of selected events
on the info line.

The events will be locked according to the options specified in the Preferences.

Muted events can be edited as usual (with the exception
of adjusting fades), but are not played back.

The padlock symbol indicates that
one or more of the lock options
are activated for the event.

Muted events are “grayed out”.
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• You can also mute whole tracks by clicking the Mute
(“M”) button in the Track list, the Inspector or the mixer.

You can also apply the Bounce Selection function to an
audio part. In that case, the audio from all events in the
part will be combined into a single audio file. If you choose
“Replace” when asked, the part will be replaced with a
single audio event playing a clip of the new file.

Clicking the Solo (“S”) button for a track mutes all other tracks. Note that
there are two modes for the track solo function:
If the option “Enable Solo on Selected Track” is activated in the Preferences (Editing–Project & Mixer page) and you have soloed a track, selecting another track in the track list will automatically solo that track
instead – the solo state “moves” with the track selection.
If the option isn’t activated, the track you solo stays soloed, regardless of
the selection.

Editing in Lane Display mode
When you are recording in Stacked cycle recording
mode, each take ends up on a separate lane on the track,
see “Recording audio in Stacked mode” on page 75 and
“Cycle Record mode: Stacked/Stacked 2 (No Mute)” on
page 80. However, you can also select this lane mode
manually for individual tracks, and use it when editing in
the Project window. This makes it easier to view and handle overlapping events and parts.

Removing events
To remove an event from the Project window, use any of
the following methods:
• Click on the event with the Eraser tool.
Note that if you press [Alt]/[Option] while you click, all following events
on the same track will be deleted, but not the event you clicked and all
events before it.

Audio tracks

• Select the event(s) and press [Backspace], or select
“Delete” from the Edit menu.

1. In the Track list or in the Inspector for the selected
track, click the Lane Display Type button and select “Lanes
Fixed” from the pop-up menu.

Creating new files from events

The audio track is divided vertically into two lanes. By default, all audio
events end up in the first (top) lane.

An audio event plays a section of an audio clip, which in
turn refers to one or more audio files on the hard disk.
However, in some situations you may want to create a new
file that consists only of the section played by the event.
This is done with the function “Bounce Selection” on the
Audio menu:
1. Select one or several audio events.

2. Now you can move events or parts between lanes, either by dragging or by using the “Move to Next Lane/Previous Lane” commands on the Edit menu or Quick menu.

2. Set up fade in, fade out and event volume (on the info
line or using the volume handle) as desired.
These settings will be applied to the new file. For details on fades and
event volume, see “Creating fades” on page 87.

Note that if there are overlapping audio events, the audio on the lowest
lane has playback priority – moving events between lanes affects what
will be heard!

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing
only the audio in the original event. A clip for the new file is
added to the Pool, and the original event is replaced by a
new event playing the new clip.
• If you click “No”, a new file is created and a clip for the
new file is added to the Pool.

If the vertical zoom factor is sufficiently high, the sections that will be
heard on playback are indicated in green.

The original event is not replaced.
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• Note that there will always be an extra, empty lane at the
bottom of the track – moving an event there always will
add another lane.

3. You can edit the overlapping parts as usual – by cutting, deleting or muting sections in the Project window or
by opening them in a MIDI editor.

Depending on the number of lanes used, you may want to adjust the vertical zoom for the track – simply drag the track edges in the track list.

In an editor, parts on different lanes will be treated just like parts on different tracks – you can use the part list pop-up menu to select an active
part for editing, etc.
Note that there is no playback priority between lanes on a MIDI track – all
unmuted parts will be heard during playback.

3. After rearranging the overlapping events so that you
hear what you want, you can select all events and select
“Delete Overlaps” from the Advanced submenu on the
Audio menu.

4. To merge all overlapping parts into one, make sure the
MIDI track is selected, position the left and right locator
around the parts and select “Merge MIDI in Loop” from
the MIDI menu.

This puts all events in the top lane and resizes events so that overlapping
sections are removed.

4. To turn off Lanes mode, select “Lanes Off” from the
Lane Display Type pop-up menu.

In the dialog that appears, activate the Erase Destination option and click
OK. This merges all unmuted MIDI between the locators to a single part.

If you do this without using the “Delete Overlaps” function, all overlapping
sections will be kept. However, the sections that were green will now be
the sections visible (“on top”) and thus the sections that will be heard.

5. To turn off Lanes mode, select “Lanes Off” from the
Lane Display Type pop-up menu.

MIDI tracks

Range editing

1. In the Track list or in the Inspector for the selected
track, click the Lane Display Type button and select “Lanes
Auto” or “Lanes Fixed”.

Editing in the Project window isn’t necessarily restricted
to handling whole events and parts. You can also work
with selection ranges, which are independent from the
event/part and track boundaries.
Creating a selection range
To make a selection range, drag with the Range Selection
tool.

2. Click the Lane Display Type button and select “Lanes
Auto” or “Lanes Fixed”.
• In Lanes Auto mode, extra lanes will automatically be
added where necessary – if two MIDI parts overlap, they
will automatically be put on separate lanes.

When the Range Selection tool is selected, the Select
submenu on the Edit menu has the following items for
making selection ranges:

• In Lanes Fixed mode, you have to move MIDI parts between lanes manually (by dragging them or by using the
“Move to Next Lane/Previous Lane” commands on the
Edit menu or Quick menu).

Option

Description

All

Makes a selection that covers all tracks, from the start of
the project to the end (as defined by the Length setting in
the Project Setup dialog).

In this mode, there will always be an extra, empty lane at the bottom of
the track – if you move a part there, another lane will be added and so on.

None

Removes the current selection range.

Invert

Only used for event selection (see “Selecting events” on
page 43).

In Loop

Makes a selection between the left and right locator, on
all tracks.

From Start
to Cursor

Makes a selection on all tracks, from the start of the
project to the project cursor.

From Cursor
to End

Makes a selection on all tracks, from the project cursor to
the end of the project.
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Option

• By using the Trim buttons on the toolbar.

Description

The left Trim buttons will move the start of the selection range and the
right buttons will move the end. The edges will be moved by the amount
specified on the Grid pop-up.

All on Selected Only used for event selection (see “Selecting events” on
Tracks
page 43).
Select Event

This is available in the Sample Editor (see “Using the Select menu” on page 267).

Left Selection
Side to Cursor

Moves the left side of the current selection range to the
project cursor position.

Right Selection Moves the right side of the current selection range to the
Side to Cursor project cursor position.
Range to Next
Event

Moves the selection range to the next event head or tail
on the selected track(s) and turns it to a zero selection
Clicking this Trim button…

Range to Previ- Moves the selection range to the previous event head or
ous Event
tail on the selected track(s) and turns it to a zero selection.
Enlarge Range
to Next Event

Moves the right side of the current selection range to the
next event head or tail on the selected track(s).

Enlarge Range
to Previous
Event

Moves the left side of the current selection range to the
previous event head or tail on the selected track(s).

• Double-clicking on an event with the Range Selection
tool creates a selection range encompassing the event.

…will move the start of the selection range to the right by 1beat.

• By using the Nudge buttons on the toolbar.

If you hold down [Shift] you can double-click several events in a row, and
the selection range will expand to encompass them all. Double-clicking a
second time on an event opens it for editing in the Sample Editor.

These will move the whole selection range to the left or the right. The
amount of movement depends on the selected display format (see “The
Project Setup dialog” on page 33) and the value specified on the Grid
pop-up menu.

Adjusting the size of the selection range
You can adjust the size of a selection range in the following ways:

!

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an
edge of the selection range.

Note that the contents of the selection are not
moved – using the Nudge buttons is the same as adjusting the start and end of the selection range at the
same time, by the same amount.

Ö The Trim buttons and the Nudge buttons are located
in the Nudge palette, which is not visible in the toolbar by
default.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which
you clicked.

See “The Setup dialogs” on page 506 for instructions on how to show
and hide items in the toolbar.

• By adjusting the selection range start or end position on
the info line.
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Making selection ranges for several non-contiguous
tracks

Using Cut, Copy and Paste
When working with selection ranges, you can either use
Cut, Copy and Paste on the Edit menu, or use the functions “Cut Time” and “Paste Time” on the Range submenu
on the Edit menu. These work differently to their related
functions on the Edit menu:

You can create selection ranges that cover several tracks
by pressing [Alt]/[Option]+[Shift]. However, it is also possible to exclude tracks from a selection range:
1. Create a selection range from the first to the last desired track.
2. Press [Alt]/[Option] and click in the selection range on
the tracks you want to exclude from the selection.

Function

Description

Cut

Cuts out the data in the selection range and moves it to
the clipboard. The selection range is replaced by empty
track space in the Project window, meaning that events
to the right of the range keep their positions.

Copy

Copies the data in the selection range to the clipboard.

Paste

Pastes the clipboard data at the start position and track
of the current selection. Existing events are not moved to
make room for the pasted data.

Paste at Origin Pastes the clipboard data back at its original position. Existing events are not moved to make room for the pasted
data.
Cut Time

Cuts out the selection range and moves it to the clipboard. Events to the right of the removed range are
moved to the left to fill out the gap.

Paste Time

Pastes the clipboard data at the start position and track
of the current selection. Existing events are moved to
make room for the pasted data.

Paste Time at
Origin

Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.

Deleting selection ranges
Again, you can either use “regular” Delete or “Delete Time”:
• If you use the Delete function on the Edit menu (or press
[Backspace]), the data within the selection range is replaced by empty track space.

3. In the same manner, you can add a track to the selection range by [Alt]/[Option]-clicking in the selection range
area on the track.

Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range submenu, the selection range is removed and events to the
right are moved to the left to close up the gap.

Moving and duplicating
• To move a selection range, click and drag it to a new
position.
This will move the contents of the selection range to the new position. If
the range intersected events or parts, these will be split before moving,
so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option]
and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as
when duplicating events (see “Aligning events” on page 45).
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Other functions

Options

On the Range submenu on the Edit menu, you will find
three more range editing functions:

Snap

Function

Description

Split

Splits any events or parts that are intersected by the selection range, at the positions of the selection range edges.

Crop

All events or parts that are partially within the selection
range are cropped, that is, sections outside the selection
range are removed. Events that are fully inside or outside
the selection range are not affected.

Insert Silence

Inserts empty track space from the start of the selection
range. The length of the silence equals the length of the
selection range. Events to the right of the selection range
start are moved to the right to “make room”. Events that
are intersected by the selection range start are split, and
the right section is moved to the right.

The Snap function helps you to find exact positions when
editing in the Project window. It does this by restricting
horizontal movement and positioning to certain positions.
Operations affected by Snap include moving, copying,
drawing, sizing, splitting, range selection, etc.
• You turn Snap on or off by clicking the Snap icon in the
toolbar.

Snap activated.

Ö When you are moving audio events with Snap activated, it isn’t necessarily the beginning of the event that is
used as Snap position reference. Instead, each audio
event has a snap point, which you can set to a relevant position in the audio (such as a downbeat, etc.).

Region operations
Regions are sections within a clip, with various uses.
While regions are perhaps best created and edited in the
Sample Editor (see “Working with regions” on page 269),
the following region functions are available in the –Advanced submenu of the Audio menu:
Function

The snap point is preferably set in the Sample Editor since it allows for a
higher degree of precision (see “Adjusting the snap point” on page 266).
You can however also set the snap point directly in the Project window,
in the following way:

Description

Event or Range This function is available when one or several audio
as Region
events or selection ranges are selected. It creates a region in the corresponding clip, with the start and end position of the region determined by the start and end
position of the event or selection range within the clip.
Events from
Regions

1. Select an event.
2. Place the project cursor at the desired position within
the selected audio event.

This function is available if you have selected an audio
event whose clip contains regions within the boundaries
of the event. The function will remove the original event
and replace it with event(s) positioned and sized according to the Region(s).

3. Pull down the Audio menu and select “Snap Point To
Cursor”.
The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project
window.
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Exactly how Snap works depends on which mode is selected on the Snap mode pop-up menu.

Events
In this mode, the start and end positions of other events and
parts become “magnetic”. This means that if you drag an
event to a position near the start or end of another event, it
is automatically aligned with the start or end of the other
event. For audio events, the position of the snap point is
also magnetic (see “Adjusting the snap point” on page
266).
• Note that this includes marker events on the marker track.
This allows you to snap events to marker positions, and vice versa.

The following sections describe the different Snap modes:

Shuffle

Grid

Shuffle mode is useful when you want to change the order
of adjacent events. If you have two adjacent events and
drag the first one to the right, past the second event, the
two events will change places.

In this mode, the Snap positions are set with the Grid
pop-up menu to the right. The options depend on the display format selected for the ruler. For example, if the ruler
is set to show bars and beats, the grid can be set to bars,
beats or the quantize value set with the next pop-up menu
to the right. If a time or frame-based ruler format is selected, the grid pop-up menu will contain time or framebased grid options, etc.

The same principle works when changing the order of
more than two events:

When Seconds is selected as ruler format, the grid pop-up menu contains time-based grid options.

Grid Relative
When you move events and parts in this mode they will not
be “magnetic” to the grid. Rather, the grid determines the
step size for moving the events. This means that a moved
event will keep its original position relative to the grid.

1

2

3

4

5

2

5

Dragging event 2 past event 4…

For example, if an event starts at the position 3.04.01 (one
beat before bar 4), Snap is set to Grid Relative and the
Grid pop-up is set to “Bar”, you can move the event in
steps of one bar – to the positions 4.04.01, 5.04.01 and
so on. The event will keep its relative position to the grid,
i.e. stay one beat before the bar lines.

1

3

4

…changes the order of events 2, 3 and 4.

Magnetic Cursor
When this mode is selected, the project cursor becomes
“magnetic”. Dragging an event near the cursor causes the
event to be aligned with the cursor position.

• This only applies when dragging existing events or parts
– when you create new events or parts this mode works
like the Grid mode.
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Grid + Cursor
This is a combination of the “Grid” and “Magnetic Cursor”
modes.
Events + Cursor
This is a combination of the “Events” and “Magnetic Cursor” modes.
Events + Grid + Cursor
This is a combination of the “Events”, “Grid” and “Magnetic Cursor” modes.

Snap to Zero Crossing
When this option is activated in the Preferences (Editing–
Audio page), splitting and sizing of audio events is done at
zero crossings (positions in the audio where the amplitude
is zero). This helps you avoid pops and clicks which might
otherwise be caused by sudden amplitude changes.
!

This setting affects all windows in all open projects –
with the exception of the Sample Editor (which has
its own “Use Snap” button for this).

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will
scroll during playback, keeping the project cursor visible
in the window.
• If the option “Stationary Cursors” is activated in the
Preferences (Transport page), the project cursor will be
positioned in the middle of the screen (if possible).

57
The Project window

4
Playback and the Transport panel

Background

Active Arranger
chain

This chapter describes the various methods available for
controlling Playback and Transport functions in Nuendo.

Current Arranger
item

Arranger Selector

Activate Arranger
Mode

The Transport panel
Below you can find a brief description of each item on the
Transport panel.

Previous/Next Arranger items

The pictures below show the Transport panel with all controls visible and in their default position. The Transport
panel is divided into sections, from left to right.

Metronome click on/off

CPU load and Disk Cache meters

First/Last repeat of current Arranger item
Precount on/off

Show Markers (opens
Marker window)

Tempo track
on/off

Record mode pop-up menu

Cycle Record mode
pop-up menu
Synchronization
on/off

Activates Auto Quantize

Jump to Marker

Output Level Control (for the Control Room channel, if the Control
Room is enabled, or for the Main Mix output bus, see below).

Preroll setting and on/off switch
Left locator: record start point, punch
in point and beginning of Cycle

The tempo and time
signature display

MIDI In Activity
(left meter)/
MIDI Out activity

Nudge +/- 1 Frame

Activates
punch in

Shuttle
speed

Activates
punch out

Audio output activity and Clipping
indicator (top)

Audio input activity and Clipping indicator (Default Input channel)

Right locator: punch out
point and end of Cycle
Nudge position
right/left
Position
slider

Postroll setting
and on/off switch

Ö Note that the Output Activity and Clipping indicator as
well as the Output Level Control refer to the Control
Room channel if the Control Room is activated. If the Control Room is disabled, these controls refer to the Main Mix
Output bus as defined on the Outputs tab in the VST
Connections window. For information on the Control
Room, see the chapter “Control Room” on page 151.

Jog Wheel
(project scrubbing)

Exchange time formats
Primary Time Display
and format pop-up

Secondary Time Display
and format pop-up

• The main Transport functions (Cycle/Stop/Play/Record)
can also be shown on the toolbar.

Go to previous
marker or
project start
Rewind

Go to next
marker or
project end
Fast forward

Stop

Play

In addition, various play options are available on the Transport menu.

Record
Cycle on/off
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Operations

Hiding and showing the Transport Panel
The Transport panel is shown by default when you launch
a new project. To hide or show it, select “Transport Panel”
on the Transport menu (or use a key command – by default [F2]).

Setting the project cursor position
There are several ways to move the project cursor position:

About Preroll and Postroll

• By using Fast Forward and Rewind.

These items are described in the chapter “Recording”,
see “About Preroll and Postroll” on page 83.

• By using the Jog/Shuttle/Nudge control on the Transport panel (see “The Shuttle Speed control” on page 62).

Changing the Transport panel setup

• By dragging the project cursor in the lower part of the
ruler.

You can customize the appearance of the Transport panel
by right-clicking anywhere on the panel and selecting/deselecting the desired options on the pop-up menu that appears.

• By clicking in the ruler.
Double-clicking in the ruler moves the cursor and starts/stops playback.

This is described in detail in the section “Customizing via
the setup context menus” on page 506.

• If the option “Locate when Clicked in Empty Space” is
activated in the Preferences (Transport page) you can
click anywhere in an empty section of the Project window
to move the cursor position.

The numeric keypad

• By changing the value in any of the position displays.

In the default Key Command settings, various Transport
panel operations are assigned to the numeric keypad on
the computer keyboard. The keypads are slightly different
on PC and Macintosh computers:

• By using the position slider above the transport buttons
in the Transport panel.

Numeric Key

Function

[Enter]

Play

[+]

Fast Forward

[-]

Rewind

The range of the slider relates to the Length setting in the Project Setup
dialog. Hence, moving the slider all the way to the right will take you to
the end of the project.

• By using markers (see “About markers” on page 110).
• By using playback options (see “Playback functions” on
page 63).

[*]

Record

[÷] (Win)/[/] (Mac)

Cycle On/Off

• By using the Arranger function (see “The Arranger
track” on page 98).

[,]

Return to Zero

• By using functions on the Transport menu.

[0]

Stop

[1]

Go to Left Locator

[2]

Go to Right Locator

[3-9]

The following functions are available:
Function

Description

Locate Selection/ Moves the project cursor to the beginning or end of the
Locate Selection current selection. For this to be available, you must
End
have selected one or more events or parts, or made a
selection range.

Go to marker 3 to 9

Locate Next/
Previous Marker

This moves the project cursor to the closest marker to
the right or left (see “About markers” on page 110).

Locate Next/
Previous Event

This moves the project cursor forwards or backwards
respectively, to the closest beginning or end of any
event on the selected track(s).
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Ö If Snap is activated when dragging the project cursor,
the Snap value is taken into account. This is helpful for
finding exact positions quickly.

• The secondary time display is completely independent,
and the display format is set on the pop-up menu to the
right in the secondary time display.

Ö There are also numerous key commands available for
moving the project cursor (in the Transport category in the
Key Commands dialog).

• You can swap time formats between the primary and
secondary time displays by clicking the double arrow symbol between them.

For example, you can assign key commands to the “Step Bar” and “Step
Back Bar” functions, allowing you to move the project cursor in steps of
one bar, backwards and forwards.

The left and right locators
The left and right locators are a pair of position markers
used for specifying punch-in and punch-out positions during recording, and as boundaries for cycle playback and
recording.

About the Transport panel display formats

Ö When cycle mode is activated on the Transport panel,
the area between the left and right locator will be repeated
(cycled) on playback.

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from
the time unit shown in the main time display on the Transport panel. This means that you can display timecode in
the transport position display and bars and beats in the
ruler, for example. In addition, there is a secondary time
display to the right of the primary time display which is
also independent, giving you three different time units
shown at the same time (in the Project window, you can
also create additional ruler tracks – see “Using multiple
rulers – ruler tracks” on page 32).

However, if the right locator is positioned before the left, this will work as
a “jump” or “skip mode” – when the project cursor reaches the right locator it will immediately jump to the left locator position and continue
playback from there.

There are several ways to set locator positions:
• To set the left locator, press [Ctrl]/[Command] and click
at the desired position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can also drag the locator “handles” directly in the ruler.

The following rules apply:
• If you change the time format of the primary time display
on the Transport panel, the time format of the ruler will be
changed as well.

The locators are indicated by the “flags” in the ruler. The area between
the locators is highlighted in the ruler and in the Project window (see
“Appearance” on page 511). Note that if the right locator is before the
left locator, the color of the ruler between the locators will change (from
blue to red).

This is the same as changing the display format in the Project Setup.
Therefore, to have different display formats in the ruler and the main time
display you should change the format in the ruler.

• Click and drag in the upper half of the ruler to “draw” a
locator range.

• The primary time display format is set on the pop-up
menu to the right in the main position display.

If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on
the numeric keypad sets the left or right locator to the
project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/
[Command]) to set the project cursor position to the left or right locator
position. Note that these are default key commands – you can change
these if you like.

• By creating cycle markers you can store any number of
left and right locator positions, which can be recalled by
simply double-clicking on the corresponding marker (see
“About cycle markers” on page 111).

• This setting also determines the time format displayed
for the left and right locators on the Transport panel.
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• The “Locators to Selection” item on the Transport menu
(default key command [P]) sets the locators to encompass
the current selection.

• If you click the jog wheel during playback, playback will
automatically stop.

This is available if you have selected one or several events or made a selection range.

The nudge position buttons
The + and – buttons in the middle of the Shuttle/Jog section allow you to nudge the project cursor position to the
right or left, respectively. Each time you click a nudge button, the project cursor is moved by one frame.

• You can also adjust the locators numerically on the
Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will
move the project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R button, the corresponding locator will be set to
the current project cursor position.

Options and Settings

The Shuttle Speed control

The “Return to Start Position on Stop”
preference
This setting is found on the Transport page in the Preferences (found on the File menu under Windows, or on the
Nuendo menu under Mac OS X).

The shuttle speed control (the outer wheel on the Transport panel) allows you to play the project at any playback
speed, forwards or backwards. This provides a quick way
to locate or “cue” to any position in the project.

• If “Return to Start Position on Stop” is activated when
you stop playback, the project cursor will automatically return to the position where recording or playback last
started.

• Turn the shuttle speed wheel to the right to start playback.

• If “Return to Start Position on Stop” is deactivated, the
project cursor will remain at the position where you stop
playback.

The further to the right you move the wheel, the faster the playback
speed.

Pressing Stop again will return the project cursor to the position where
recording or playback last started.

• If you turn the wheel to the left instead, the project will
play backwards.

About track disable/enable

Similarly, the playback speed depends on how far to the left you turn the
wheel.

For audio tracks, the track context menu contains an item
named “Disable Track”. This shuts down all disk activity
for the track, as opposed to using Mute, which merely
turns down the output volume for a track. For example, if
you often record “alternative takes” you can easily build up
a large number of takes on different tracks. Even though
these tracks are muted, they are actually still “playing
back” from the hard disk during playback. This puts an unnecessary load on your disk system, so using “Disable
Track” is recommended for such situations.

Project scrubbing – the Jog Wheel

The middle wheel on the Transport panel serves as a jog
wheel. By clicking and dragging it to the right or left you
will move the playback position manually forwards or
backwards – much like scrubbing on a tape deck. This
helps you pinpoint exact locations in the project.

• Select “Disable Track” for tracks that you want to keep in
the project for later use (but don’t want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled
tracks.

• Note that the jog wheel is an “endless dial” – you can
turn it as many times as needed to move to the desired
location.
The faster you turn the wheel, the faster the playback speed.
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Playback functions

At the beginning of the first chorus you have another program change event which makes the same synth switch to
a string sound.

Apart from the standard transport controls on the Transport panel, you can also find a number of functions that
can be used to control playback on the Transport menu.
The items have the following functionality:
Option

Description

Postroll from
Selection Start/End

Starts playback from the beginning or end of the
currently selected range and stops after the time
set in the Postroll field on the Transport panel.

Preroll to Selection
Start/End

Starts playback from a position before the start or
end of the currently selected range and stops at
the selection start or end, respectively. The playback start position is set in the Preroll field on the
Transport panel.

Play from Selection
Start/End

Activates playback from the beginning or end of
the current selection.

Play until Selection
Start/End

Activates playback two seconds before the start or
end of the current selection and stops at the selection start or end, respectively.

You now play back the song. It begins with the piano
sound and then switches to the string sound. In the middle
of the chorus you stop and rewind to some point between
the beginning and the second program change. The synth
will now still play the string sound although in this section
it really should be a piano!
The Chase function takes care of that. If program change
events are set to be chased, Nuendo will track the music
back to the beginning, find the first program change and
transmit it to your synth, setting it to the correct sound.
The same thing can apply to other event types as well. The
Chase Events settings in the Preferences (MIDI page) determine which event types will be chased when you locate
to a new position and start playback.

Play until Next Marker This activates playback from the project cursor and
stops at the next marker.
Play Selection Range This activates playback from the start of the current
selection and stops at the selection end.
Loop Selection

!

This activates playback from the start of the current
selection and keeps starting over again when
reaching the selection end.

The functions listed above (except “Play until Next
Marker”) are only available if you have selected one
or more events or made a selection range.

Ö In the Preferences dialog (Editing–Audio page) you
will find the option “Treat Muted Audio Events like Deleted”. When you activate this option, any events overlapped by a muted event will become audible.

Ö Event types for which the checkbox is activated here
will be chased.
• In the Chase Events section of the Preferences (MIDI
page), you will find the option “Chase not limited to Part
Boundaries”.

About Chase

When you activate this option, MIDI controllers are also chased outside
the part boundaries, i.e. the Chase will be performed on the part touched
by the cursor as well as on all the parts to the left of it. Please note that
this option should be deactivated for very large projects, as it considerably slows down operations such as positioning and soloing. When you
deactivate this option, the MIDI controllers are only chased within the
parts under the position cursor.

Chase is a function that makes sure your MIDI instruments
sound as they should when you locate to a new position
and start playback. This is accomplished by the program
transmitting a number of MIDI messages to your instruments each time you move to a new position in the
project, making sure all MIDI devices are set up correctly
with regard to program change, controller messages
(such as MIDI Volume), etc.
For example, let’s say you have a MIDI track with a program change event inserted at the beginning. This event
makes a synth switch to a piano sound.
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Recording

Background
This chapter describes the various recording methods
that you can use in Nuendo. As it is possible to record
both audio and MIDI tracks, both recording methods are
covered in this chapter.

Before you start
This chapter assumes that you are reasonably familiar with
certain basic recording concepts, and that the following
initial preparations have been made:
• You have properly set up, connected and calibrated
your audio hardware.
• You have opened a project and set the project setup
parameters to your specifications.

Record Enable in the Inspector, Track list and mixer.

Project setup parameters determine the record format, sample rate,
project length etc. that affect the audio recordings you make during the
course of the project. See “The Project Setup dialog” on page 33.

Ö If the option “Enable Record on Selected Track” is activated in the Preferences (Editing–Project & Mixer page),
tracks are automatically record-enabled when you select
them in the Track list.

• If you plan to record MIDI, your MIDI equipment should
be set up and connected correctly.

Ö The exact number of audio tracks you can record simultaneously depends on your computer CPU and hard
disk performance.

Basic recording methods

In the Preferences (VST page), you can find the option “Warn on Processing Overloads”. When this is activated, a warning message will be
displayed as soon as the CPU clip indicator (on the Transport panel)
lights up during recording.

This section describes the general methods used for recording. However, there are additional preparations and
procedures that are specific to audio and MIDI recording
respectively. Make sure to read these sections before you
start recording (see “Audio recording specifics” on page
67 and “MIDI recording specifics” on page 77).

Manually activating recording
You activate recording by clicking the Record button on
the Transport panel or toolbar or by using the corresponding key command (by default [*] on the numeric keypad).

Record-enabling a track
Nuendo can record on a single track or on several tracks
(audio and/or MIDI) simultaneously. To make a track ready
for recording, click the Record Enable button for the track in
the Track list, in the Inspector or in the mixer. When activated, the button(s) turn red, indicating record ready mode.

Recording can be activated in Stop mode (from the current
cursor position or from the left locator) or during playback:
• If you activate recording in Stop mode, and the option
“Start Record at Left Locator” is activated on the Transport menu, recording will start from the left locator.
The preroll setting or the metronome count-in will be applied (see “About
Preroll and Postroll” on page 83).

• If you activate recording in Stop mode, and “Start Record
at Left Locator” is deactivated, recording will start from the
current project cursor position.
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• If you activate recording during playback, Nuendo will
immediately enter Record mode and start recording from
the current project cursor position.

• If the Punch Out button is activated on the Transport
panel, recording will be deactivated when the project cursor reaches the right locator.

This is known as “manual punch in”.

This is known as “automatic punch out”. By combining this with automatic punch in, you can set up a specific section to record – again very
useful if you want to replace a certain part of a recording. See also “Stop
after Automatic Punch Out” on page 83.

Activating recording in Sync mode
If you are synchronizing the Nuendo transport to external
equipment (Sync is activated on the Transport panel) and
you activate recording, the program will go into “record
ready” mode (the record button on the Transport panel
will light up). Recording then starts when a valid timecode
signal is received (or when you click the Play button). See
the chapter “Synchronization” on page 445 for more information.

Punch In and Out activated.

Cycle recording
Nuendo can record and play back in a cycle – a loop. You
specify where the cycle starts and ends by setting the left
and right locators. When the cycle is active, the selected
section is seamlessly repeated until you hit Stop or deactivate cycle mode.

Automatically activating recording
Nuendo can automatically switch from playback to recording at a given position. This is known as “automatic punch
in”. A typical use for this would be if you need to replace a
section of a recording, and want to listen to what is already recorded, up to the recording start position.

• To activate cycle mode, click the cycle button on the
Transport panel.

1. Set the left locator to the position where you want recording to start.

If you now start playback, the section between the left and right locator is
repeated indefinitely until you stop.

2. Activate the Punch In button on the Transport panel.

Cycle activated
Punch In activated.

3. Activate playback from some position before the left
locator.

• To record in cycle mode, you can start recording from
the left locator, from before the locators or from within the
cycle, in Stop mode or during playback.

When the project cursor reaches the left locator, recording is automatically activated.

As soon as the project cursor reaches the right locator, it will jump back
to the left locator and continue recording a new lap.

• The results of cycle recording depend on the selected
cycle record mode and are different for audio (see “Recording audio in cycle mode” on page 73) and MIDI (see
“Recording MIDI in cycle mode” on page 80).

Stopping recording
Again, this can be done automatically or manually:
• If you click the Stop button on the Transport panel (or
use the corresponding key command, by default [0] on the
numeric keypad), recording is deactivated and Nuendo
goes into Stop mode.
• If you click the Record button (or use the key command
for recording, by default [*]), recording is deactivated but
playback continues.
This is known as “manual punch out”.
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Audio recording specifics

Audio pre-record
This feature allows you to capture up to 1 minute of any incoming audio you play in Stop mode or during playback,
“after the fact”. This is possible because Nuendo can capture audio input in buffer memory, even when not recording.

Selecting a recording file format
The format for recorded files is set in the Project Setup dialog on the Project menu. There are three settings: sample
rate, record format (bit depth) and record file type. While
the sample rate is set once and for all when you start working on a new project, the bit depth and file type can be
changed at any time.

Proceed as follows:
1. Open the Preferences (Record-Audio page).
2. Specify a time (up to 60 seconds) in the “Audio PreRecord Seconds” field.
This activates the buffering of audio input, making Pre-Record possible.

Record file type

3. Make sure an audio track is record-enabled and receives audio from the signal source.

The Record File Type setting determines which type of
files will be created when you record:

4. When you have played some audio material you want
to capture (either in Stop mode or during playback), click
the Record button.

File type

Description

Wave File

Wave files have the extension “.wav” and are a common
file format on the PC platform.

Wave 64 File

Wave64 is a proprietary format developed by Sonic
Foundry Inc. Audio-wise it is identical to the Wave format,
but the internal file structure makes much larger file sizes
possible. This is useful e.g. for long live recordings in surround format, where the audio files can become huge.

Broadcast
Wave File

In terms of audio content, the same as regular Wave files,
but with embedded text strings for supplying additional
information about the file (see below).

AIFF File

Audio Interchange File Format, a standard defined by Apple Computer Inc. AIFF files have the extension “.aif” and
are used on most computer platforms. Like Broadcast
Wave files, AIFF files can contain embedded text strings
(see below).

5. After a few seconds stop the recording.
An audio event is created, starting at where the cursor position was
when you activated recording. This means that if you were in stop mode,
and the cursor was at the beginning of the project, you may have to move
the event to the right in the next step. If you were playing along to a
project you should leave the event where it is.

6. Select the Arrow tool and place the cursor on the bottom left edge of the event so that a double arrow appears,
then click and drag to the left.
Now the event is extended and the audio you played before activating
record is inserted – this means that if you played along during playback,
the captured notes will end up exactly where you played them in relation
to the project.

• If you select Broadcast Wave File or AIFF format, you
can specify Author, Description and Reference text strings
that will be embedded in the recorded file.
This is done on the Record–Audio–Broadcast Wave page in the Preferences.

Record format (bit depth)
The available options are 16 bit, 24 bit and 32 bit float.
Use the following guidelines:

The recording was activated at the start of bar 9. This is indicated by a
blue line in the audio event.

• Normally, select the record format according to the bit
depth delivered by your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs),
you may want to record at 24 bit resolution to capture the full bit depth.
On the other hand, if your hardware has 16 bit inputs, it’s pointless to
record with a higher bit depth – this will only make the audio files larger,
with no difference in audio quality. The exception is if you record with effects – see “Recording with effects” on page 76.
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• The higher the bit depth, the larger the files and the
more strain is put on the disk system.

Selecting an input bus for a track
Here we assume that you have added and set up the required input busses (see “Setting up busses” on page 11).
Before you record, you need to specify from which input
bus the track should record. You can do this in the Inspector or in the mixer:

If this is an issue, you may want to lower the record format setting.
!

For further information on the options in the Project
Setup dialog, see “The Project Setup dialog” on
page 33.

• In the Inspector, you select an input bus on the Input
Routing pop-up menu in the top section.

Setting up the track

As described in the section “The Inspector” on page 26, the Inspector by
shows the settings for the selected track. You show or hide the Inspector
clicking the “Show/Hide Inspector” button on the Project window toolbar.

Creating a track and selecting the channel configuration
Audio tracks can be configured as mono, stereo or surround tracks, with almost any combination of channels
(CRS, 5.1, 7.1, 10.2, etc). This allows you to record or import a file containing multiple channels and treat it as one
entity, with no need to split it up into several mono files
etc. The signal path for an audio track maintains its channel configuration all the way from the input bus, via EQ,
level and other mixer settings to the output bus.

Click here to show/hide the Inspector.

You specify the channel configuration for a track when you
create it:
1. Select “Add Audio Track” from the Track list context
menu or the Project menu (or double-click in an empty
area of the Track list when an audio track is selected –
when a MIDI track is selected, double-clicking in the Track
list creates a new MIDI track).
A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
The most common formats are listed directly on the pop-up menu, with
the remaining surround formats listed on the “More…” submenu. For a
list of the available surround formats, see “Output bus configuration” on
page 205.

• The Browse item in this dialog allows you to browse
your disk(s) for created Track Presets, which can be used
as a basis (or template) for tracks.

Click here to select an input bus for the track.

This is described in detail in the chapter “Track Presets” on page 327.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer,
a corresponding channel strip appears. You cannot change the channel
configuration for a track.
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• In the mixer, you select an input bus on the Input Routing
pop-up menu at the top of the track’s channel strip.

Selecting a folder for the recorded audio files
Each Nuendo project has a project folder containing
(among other things) an “Audio” folder. By default, this is
where recorded audio files are stored. However, you can
select record folders independently for each audio track if
needed:

If this pop-up menu isn’t shown, you need to open the Mixer Routing View
by clicking the “Show Routing” button in the extended Mixer common
panel or by selecting “Show Routing View” from the Window submenu on
the Mixer context menu. See “Configuring the mixer” on page 126 for more
information about the mixer.
Click here to show or hide the
input and output settings.

1. To select the same record folder for several audio
tracks, select them by pressing [Shift] or [Ctrl]/[Command]
and clicking on them in the Track list.

Click here to select an input
bus for the track.

2. Right-click in the Track list for one of the tracks to
bring up the track context menu.
3. Select “Set Record Folder”.
4. Use the file dialog that appears to navigate to the desired folder (or create a new folder with the Create button).
Tip: if you want to have separate folders for different types of material
(speech, ambient sounds, music, etc.), you can create subfolders within
the Project’s “Audio” folder and assign different tracks to different subfolders. This way, all audio files will still reside within the project folder,
which will make managing the Project easier.

Recording from busses
You can also select an output bus, a group bus or an FX
channel bus as an Input for your recording.

• It’s possible to have different tracks record to totally different locations, even on different disks. However, if you
need to move or archive the project, there is a risk of missing some files. The solution is to use the “Prepare Archive”
function in the Pool to gather all external files into the
project folder first, see “Prepare Archive” on page 309.

Let’s assume you want to create a downmix of separate
tracks, e.g. bass drum, hihats, snare etc.
Proceed as follows:
1. Set up your separate tracks as desired and add a
group track.

Setting input levels

2. For each of the drum tracks, open the Output Routing
pop-up menu and select the Group track as output.

When recording digital sound, it’s important to set the input levels correctly – loud enough to ensure low noise and
high audio quality, but not so loud that clipping (digital distortion) occurs.

3. Create a new audio track, open the Output Routing
pop-up menu for it and select the Group track as input for
this audio track.

Clipping typically occurs in the audio hardware when a
too loud analog signal is converted to digital in the hardware’s A/D converters.

4. Record enable this audio track and start recording.
Now, the output of the group track will be recorded on the
new track and you will get a mix of your separate tracks.

• It is also possible to get clipping when the signal from
the input bus is written to a file on your hard disk.

Note that you can also select an FX channel as recording
source. In this case, only the output of the FX channel will
be recorded.

This is because in Nuendo, you can make settings for the input bus, adding EQ, effects, etc. to the signal as it is being recorded. This may raise
the level of the signal, causing clipping in the recorded audio file.

For more information about the routing possibilites, see
“Routing” on page 14.
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To check the level of the “unprocessed” signal coming into
the audio hardware, you need to switch the level meters to
“Meter Input”. In this mode, the input channel level meters
will show the level of the signal at the input of the bus, before any adjustments such as input gain, EQ, effects, level
or pan:

The next step is to check the level of the audio being written to a file on your hard disk. This is only necessary if you
have made any adjustments to the input channel (level
settings, EQ, insert effects, etc.). Note also:
• If you record in 32 bit float format, the bit depth will not
be reduced – which means there’s no risk of clipping at
this stage.

1. Right-click in the Mixer window.
The Mixer context menu appears.

Also, this preserves the signal quality perfectly. Therefore, you should
consider using 32 bit float format when you are recording with effects
(see “Recording with effects” on page 76).

2. Select the Global Meter Settings submenu and make
sure “Meter Input” is activated.

• If you record in 16 or 24 bit format, the available headroom is lower, which means clipping can occur if the signal is too loud. To avoid this, set the signal level in the
following way:

3. Play back the audio and check the level meter for the
input channel.
The signal should be as loud as possible without exceeding 0 dB (the
Clipping indicator for the input bus should not light up).

1. Bring up the mixer context menu and select “Meter
Post-Fader” from the Global Meter Settings submenu.
2. Set up the input channel, by adding EQ and/or effects
as desired.
With some effects you may want to adjust the level of the signal going
into the effect – use the Input Gain knob for this. Note that you need to
press [Shift] or [Alt]/[Option] to adjust the Input Gain.
The Clipping indicator.

4. If necessary, adjust the input level in one of the following ways:
• Adjust the output level of the sound source or external
mixer.
• Use the audio hardware’s own application program to
set the input levels (if possible).

3. Play back the audio and check the level meter of the
input channel.

See the documentation for the audio hardware.

The signal should be reasonably loud but should not reach 0 dB (the
Clipping indicator for the input bus should not light up).

• If your audio hardware supports the ASIO Control Panel
function, it may be possible to make input level settings.

4. If necessary, use the input channel fader to adjust the
signal level.

To open the ASIO control panel, open the Device Setup dialog via the Devices menu and, in the list to the left (below "VST Audio System”), select
your audio card. When this is selected, you can open the Control Panel by
clicking on the Control Panel button in the settings section to the right.
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Monitoring

• Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in
Stop mode and during recording, but not during playback.

In this context, “monitoring” means listening to the input
signal during recording. There are three fundamentally different ways to do this: via Nuendo, externally (by listening
to the signal before it reaches Nuendo), or by using ASIO
Direct Monitoring (which is a combination of both other
methods – see below).

• In the Preferences (VST–Metering page) you can find the
option “Map Input Bus Metering to Audio Track (in Direct
Monitoring)”.
When Direct Monitoring is activated in the Device Setup dialog, this option allows you to map the input bus metering to monitor-enabled audio
tracks. This gives you the opportunity to watch the input levels of your
audio tracks when working in the Project window.

Monitoring via Nuendo
If you monitor via Nuendo, the input signal is mixed in with
the audio playback. The advantage of this is that you can
adjust the monitoring level and panning in the mixer, and
add effects and EQ to the monitor signal just as during
playback (using the track’s channel strip – not the input
bus!).

When Direct Monitoring is activated in the Device Setup
dialog, this function works as follows:
• When “Map Input Bus Metering to Audio Track (in Direct
Monitoring)” is activated, audio tracks show the metering signal from the input bus they are routed to as soon as the track
is record-enabled.
Note that the tracks are mirroring the input bus signal, i.e. you
will see the same signal in both places. When using mapped
metering, any functions (e.g. trimming) you apply to the audio
track are not reflected in its meters.
• When “Map Input Bus Metering to Audio Track (in Direct
Monitoring)” is not activated, metering works as usual.

The disadvantage of monitoring via Nuendo is that the monitored signal will be delayed according to the latency value
(which depends on your audio hardware and drivers).
Therefore, monitoring via Nuendo requires an audio hardware configuration with a low latency value. You can check
the latency of your hardware in the Device Setup dialog
(VST Audio System page).

External monitoring

Ö If you are using plug-in effects with large inherent delays, the automatic delay compensation function in Nuendo
will increase the latency.

External monitoring (listening to the input signal before it
goes into Nuendo) requires some sort of external mixer for
mixing the audio playback with the input signal. This can
be a stand-alone physical mixer or a mixer application for
your audio hardware, if this has a mode in which the input
audio is sent back out again (usually called “Thru”, “Direct
Thru” or similar).

If this is a problem, you can use the Constrain Delay Compensation function while recording, see “VST Instruments and Instrument tracks” on
page 189.

When monitoring via Nuendo, you can select one of four
Auto Monitoring modes in the Preferences (VST page):

When using external monitoring, you cannot control the
level of the monitor signal from within Nuendo or add VST
effects or EQ to the monitor signal. The latency value of
the audio hardware configuration does not affect the monitor signal in this mode.
Ö If you want to use external monitoring, you need to make
sure that monitoring via Nuendo isn’t activated as well.
Select the “Manual” monitoring mode in the Preferences (VST page) and
don’t activate the Monitor buttons.

• Manual.
This option allows you to turn input monitoring on or off by clicking the
Monitor button in the Inspector, the Track list or in the mixer.

• While Record Enabled.
With this option, you will hear the audio source connected to the channel
input whenever the track is record enabled.

• While Record Running.
This option switches to input monitoring only during recording.
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ASIO Direct Monitoring

Recording

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring. In this mode, the actual monitoring is done in the audio hardware by sending the input
signal back out again. However, monitoring is controlled
from Nuendo. This means that the audio hardware’s direct
monitoring feature can be turned on or off automatically by
Nuendo, just as when using internal monitoring.

Recording is done using any of the general recording
methods (see “Basic recording methods” on page 65).
When you finish recording, an audio file is created in the
Audio folder within the project folder. In the Pool, an audio
clip is created for the audio file, and an audio event that
plays the whole clip appears on the recording track. Finally, a waveform image is calculated for the audio event. If
the recording was very long, this may take a while.

Ö If you are using RME Audio Hammerfall DSP audio
hardware, make sure that the pan law is set to -3dB in the
card’s preferences.

Ö If the option “Create Audio Images During Record” is
activated in the Preferences (Record-Audio page), the
waveform image will be calculated and displayed during
the actual recording process.

• To activate ASIO Direct Monitoring, open the Device
Setup dialog on the Devices menu and activate the Direct
Monitoring checkbox on the page for your audio hardware.

This real-time calculation uses some processing power – if your processor is slow or you are working on a CPU-intensive project, you should
consider turning this option off.

If the checkbox is grayed out, your audio hardware (or its driver) doesn’t
support ASIO Direct Monitoring. Consult the audio hardware manufacturer for details.

Undoing recording

• When ASIO Direct Monitoring is activated, you can select a monitoring mode in the Preferences (VST page), as
when monitoring via Nuendo (see “Monitoring via Nuendo”
on page 71).

If you decide that you don’t like what you just recorded,
you can delete it by selecting Undo from the Edit menu.
The following will happen:
• The event(s) you just created will be removed from the Project
window.
• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard
disk.

• Depending on the audio hardware, it may also be possible to adjust monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor
signal in this mode, since the monitor signal doesn’t pass
through Nuendo.

However, since their corresponding clips are moved to
the Trash folder, you can delete the files by opening the
Pool and selecting “Empty Trash” from the Media menu,
see “Deleting from the hard disk” on page 302.

• Depending on the audio hardware, there may be special
restrictions as to which audio outputs can be used for direct monitoring.
For details on the routing of the audio hardware, see its documentation.

• The latency value of the audio hardware configuration
does not affect the monitor signal when using ASIO Direct
Monitoring.
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Recording overlapping events

Recording audio in cycle mode

The basic rule for audio tracks is that each track can play
back a single audio event at a time. This means that if two
or more events are overlapping, only one of them will be
heard at any given time.

If you are recording audio in cycle mode, the result depends
on two factors:
• The “Cycle Record Mode” setting on the Transport panel.
• The “Audio Cycle Record Mode” setting in the Preferences (Record-Audio page).

What happens when you record overlapping events
(record in an area where there are already events on the
track) depends on the Linear Record Mode setting on the
Transport panel:

Cycle Record Modes on the Transport panel

• In “Normal” or “Merge” mode, recording where something has already been recorded creates a new audio
event that overlaps the previous one(s).

There are five different modes on the Transport panel, but
the first two modes only apply to MIDI recording. For audio cycle recording, the following applies:

When you record audio, there is no difference between “Normal” and
“Merge” mode – the difference only applies to MIDI recording (see
“About overlap and the Record Mode setting” on page 79).

• If “Keep Last” is selected, the last complete “take” (the
last completely recorded lap) is kept as an audio event.

• In “Replace” mode, existing events (or portions of
events) that are overlapped by the new recording will be
removed.

In reality, all laps you recorded are saved in one audio file divided into regions – one region for each take. You can easily select a previous take
for playback – this is done as when recording in “Create Regions” mode
(see “Create Regions mode (Preferences)” on page 74).

This means that if you record a section in the middle of a longer existing
recording, that original event will be cut into two events with a gap for the
new event.

• If “Stacked” is selected, each take will appear as an
event on a separate “lane” on the track.
This is useful when you want to view and edit the different takes and
eventually combine them to one recording. In this mode, the Audio Cycle
Record Mode preference doesn’t matter. Stacked 2 (No Mute) is the
same as Stacked, except that all the takes will be audible. See “Recording audio in Stacked mode” on page 75.

• If any of the other cycle recording modes is selected,
the result depends entirely on the “Audio Cycle Record
Mode” setting in the Preferences (Record-Audio page).

Which event will be heard?
If two or more events are overlapping, you will only hear
the events (or portions of events) that are actually visible.
Overlapped (hidden) events or sections are not played
back.

These options are described below.

• The functions “Move to Front” and “Move to Back” on
the Edit menu (see “Moving events” on page 44) are useful for managing overlapping events, as is the “To Front”
function (see below).
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Create Events mode (Preferences)

This method allows you to quickly combine the best parts
of each take, in the following way:
1. Use the Scissors tool to split the events in several sections, one for each part of the take.
For example, if you recorded four lines of vocals (in each take), you can
split the events so that each line gets a separate event.

When “Audio Cycle Record Mode” is set to “Create
Events” in the Preferences (Record-Audio page), the following will happen when you record audio in cycle mode:

The events after splitting. Note that since the original take events overlap
each other, clicking with the Scissors tool will split all takes at the same
position.

• One continuous audio file is created during the entire
recording process.

2. For each section of the take, use the “To Front” function to bring the best take to the front.

• For each recorded lap of the cycle, one audio event is
created.

This way, you can quickly combine the best sections of each take, using
the first vocal line from one take, the second line from another take and
so on.

The events will have the name of the audio file plus the text “Take *”,
where “*” indicates the number of the take.

You can also compile a “perfect” take in the Audio Part
Editor, see “Assembling a “perfect take”” on page 294.

• The last take (the last recorded lap) will be on top (and
will thus be the one you hear when you activate playback).

Create Regions mode (Preferences)

To select another take for playback, proceed a follows:

When Audio Cycle Record Mode is set to “Create Regions” in the Preferences (Record-Audio page), the following will happen when you record audio in cycle mode:

1. Right-click the event and select “To Front” from the
pop-up menu that appears.
A submenu appears, listing all the other (obscured) events.

• One continuous audio file is created during the entire
recording process.
• The audio event in the Project window shows the name
of the audio file plus the text “Take *” (with “*” being the
number of the last completed cycle lap).
• If you play back the recorded event, you will only hear
what was recorded during the last lap of the cycle recording.

2. Select the desired take.
The corresponding event is brought to front.

The previous “takes” recorded in the cycle are still available, however.

• The audio clip is divided into regions (called takes), one
for each lap of the cycle that was recorded.
If you locate the audio file you just recorded in the Pool, and click on the
plus sign beside it, you can see the regions that have been created, one
for each lap of the cycle that was completed during recording.
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Recording audio in Stacked mode
When you record audio in cycle mode and the “Stacked”
Cycle Record Mode is selected on the Transport panel,
the following happens:
• Each complete recorded cycle lap is turned into a separate
audio event.
• The track is divided into “lanes”, one for each cycle lap.
• The events are stacked above each other, each on a different
lane.

“Take” regions in the Pool window.

To play back the different “takes”, proceed as follows:
1. In the Project window, right-click the event that was
created during cycle recording.
The Quick menu appears.

2. Select the “Set To Region” menu item.
A submenu appears with the takes you recorded during cycle record.

3. Now you can select any of the takes from the submenu
and it will replace the previous take event in the Project
window.

This makes it easy to create a “perfect take” by combining
the best parts from the different cycle laps:
1. Zoom in so you can work comfortably with the stacked
events.
If you play back the recorded section, only the lowest
(last) take will be heard.
2. To audition another take, either mute the lower take(s)
with the Mute tool or move the takes between the lanes.
This can be done by dragging or by using the functions Move to Next
Lane/Previous Lane on the Quick menu or the Edit menu.

3. Edit the takes so that only the parts you want to keep
can be heard.
You can cut events with the Scissors tool, resize them, mute them or delete them.

Use this method to listen through the various takes. Select
the best single take, or compile a “perfect” take by cutting
out the best bits from each take and putting them together
(see “Assembling a “perfect take”” on page 294).
Create Events + Regions mode (Preferences)
In this mode, both events and regions are created. If you
work with the takes as events in this mode, you can edit
the events freely (e.g. splitting them), see “Create Events
mode (Preferences)” on page 74. However, in case you
want to go back to the original takes, they are still available
as regions (on the “Set To Region” submenu, in the Pool
or in the Sample Editor).

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all events
on all lanes and select “Delete Overlaps” from the Advanced submenu on the Audio menu.
This puts all events back on a single lane and resizes events so that overlapped sections are removed.
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• Nuendo processes audio internally in 32 Bit Float format – recording in the same format means the audio quality will be kept absolutely pristine.
The reason is that the effect processing in the input channel (as well as
any level or EQ settings you make there) is done in 32 Bit Float format. If
you record at 16 or 24 Bit, the audio will be converted to this lower resolution when it’s written to file – with possible signal degradation as a result.

5. To turn off the lane display mode for the track, click the
Lane Display Type button in the track list and select “Lanes
Off”.

Note also that it doesn’t matter at which actual resolution
your audio hardware works. Even if the signal from the audio hardware is in 16 Bit resolution, the signal will be 32
Bit Float after the effects are added in the input channel.

If the button is hidden, you can bring it to view in the Track Controls Settings dialog – see “Customizing track controls” on page 507.

An example
This example shows how to apply the “SoftClipper” effect
while recording. Note that this is only an example. The principle is the same for all effects (or combinations of effects).
1. Set up an audio track for recording and select the desired input bus.

The Lane Display Type button.

For best results, you should also activate monitoring as this allows you to
hear and try out your settings before actually recording. See “Monitoring
via Nuendo” on page 71 for a description of monitoring via Nuendo.

Recording with effects
Normally you record the audio signals “dry” and add effects non-destructively during playback as described in
the chapter “Audio effects” on page 168. However, Nuendo also allows you to add effects (and/or EQ) directly
while recording. This is done by adding insert effects and/
or making EQ settings for the input channel in the mixer.
Note:

2. Open the Mixer and make sure the full extended view
is shown.
To show the extended mixer view, either click the arrow icon (“Show Extended Mixer”) in the Common Panel, select “Show Extended View” from
the Window submenu on the Mixer context menu or use a key command
(this can be set in the Key Commands dialog, see “Setting up key commands” on page 518).

Ö This will make the effects become part of the audio file
itself – you cannot change the effect settings after recording.

3. Locate the input channel (bus) from which you record.
If the input channels are hidden, click on the Show/Hide Input Channels
button to the left.

About the record format
When you record with effects, you should consider setting
the record format (bit depth) to 32 Bit Float. This is done
in the Project Setup dialog on the Project menu. Note that
this isn’t required in any way – you can also record with effects in 24 or 16 Bit format. However, there are two advantages to 32 Bit Float format:
• With 32 Bit Float recording, you don’t risk clipping (digital distortion) in the recorded files.
This can of course be avoided with 24 or 16 Bit recording as well, but requires more care with the levels.

4. Check the input level (of the signal coming into the audio hardware) as described in the section “Setting input
levels” on page 69 and adjust the level of the source audio
if necessary.
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MIDI recording specifics

5. Pull down the View Options pop-up menu for the input
channel and select “Inserts”.

Activating MIDI Thru
Normally, when working with MIDI, you will have MIDI Thru
activated in Nuendo, and Local Off selected in your MIDI
Instrument(s). In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.
1. Make sure the option “MIDI Thru Active” is activated in
the Preferences (MIDI page).
2. Record enable the track(s) on which you want to
record.

The View Options pop-up menu is opened by clicking the arrow button
between the fader panel and the extended panel.

Now, incoming MIDI is “echoed” back out again for all record-enabled
MIDI tracks.

Now the extended panel for the input channel shows the
insert slots.
6. Click on an insert slot and select an effect from the
pop-up menu that appears.
As you see, the included effects are sorted into submenus – you will find
the SoftClipper effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is
automatically opened.

Record Enable button

Monitor button

Ö If you just want to use the Thru function for a MIDI
track without recording, activate the monitor button for the
track instead.

7. Adjust the effect parameters to your liking.
For detailed information on the Effect parameters, see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

This is useful e.g. if you want to try out different sounds or play a VST
instrument in real time without recording your playing.

8. When the effect is set up as desired, you can check
the level of the input channel by setting the Meters to
post-fader (see “Setting input levels” on page 69).

Setting MIDI channel, input and output

Use the input channel fader to adjust the level if needed.

9. Activate recording.

Setting the MIDI channel in the instrument

10. When you’re finished, you can play back the recorded
audio track.

Most MIDI synthesizers can play several sounds at the
same time, each on a different MIDI channel. This is the
key to playing back several sounds (bass, piano etc.) from
the same instrument. Some devices (such as General
MIDI compatible sound modules) always receive on all 16
MIDI channels. If you have such an instrument, there’s no
specific setting you need to make in the instrument. On
other instruments, you will have to use the front panel controls to set up a number of “Parts”, “Timbres” or similar so
that they receive on one MIDI channel each. See the manual that came with your instrument for more information.

As you can hear, the effect you applied is now a part of the actual audio file.

11. If you don’t want to record more with the same plug-in,
you should deactivate it by clicking in the insert slot and
selecting “No Effect”.
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Naming MIDI ports in Nuendo

4. Pull down the Input Routing pop-up menu and select
an input.

MIDI inputs and outputs are often displayed with unnecessarily long and complicated names. However, you can rename your MIDI ports to more descriptive names:

The available MIDI inputs are shown. The items on the menu depend on
the type of MIDI interface you are using, etc.

1. Open the Device Setup dialog from the Devices menu.
2. Select the MIDI Port Setup item in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which
device to choose depends on your system.

3. To change the name of a MIDI port, click in the “Show
As” column and type in a new name.
After closing the dialog, the new name will appear on the MIDI Input and
Output Routing pop-up menus.

• If you select the “All MIDI Inputs” option, the track will receive
MIDI data from all available MIDI inputs.
• If you hold down [Alt]/[Option] and select a MIDI input, this is
selected for all selected MIDI tracks.

Setting the MIDI input in the Inspector
You select MIDI inputs for tracks in the Inspector (the area
to the left of the Track list in the Project window):

Setting the MIDI channel and output

1. If the Inspector is hidden, click the Show Inspector
button on the toolbar.

The MIDI channel and output settings determine where
the recorded MIDI is routed during playback, but are also
relevant for MIDI Thru in Nuendo. Channel and output can
be selected in the Track list or in the Inspector. The procedure below describes how to make the settings in the Inspector, but it can be done in largely the same manner in
the Track list as well.

2. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The
Inspector shows the settings for the first selected track (for details, see
“The Inspector” on page 26).

1. To select the track(s) and show the settings in the
Inspector, proceed as when selecting a MIDI input (see
above).

3. Click the track name in the Inspector to make sure the
topmost section is shown.

2. Pull down the Output routing pop-up menu and select
an output.
The available MIDI outputs are shown. The items on the menu depend on
what type of MIDI interface you are using etc.

• If you hold down [Alt]/[Option] and select a MIDI output, this is
selected for all selected MIDI tracks.
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Recording

3. Use the channel pop-up menu to select a MIDI channel for the track.

Recording MIDI is done according to the basic recording
methods (see “Basic recording methods” on page 65).
When you finish recording, a part containing MIDI events
is created in the Project window.
About overlap and the Record Mode setting
MIDI tracks are different from audio tracks when it comes
to overlapping parts:
Ö All events in overlapping parts are always played back.

• If you set the track to MIDI channel “Any”, each MIDI
event on the track will be sent out on the channel stored in
the event itself.

If you record several parts at the same locations (or move parts so that
they overlap), you will hear the events in all parts on playback, even
though some of the parts are obscured in the Project window.

In other words, the MIDI material will be played back on the channel(s)
used by the MIDI input device (the MIDI instrument you play during recording).

When recording overlapping parts, the result depends on
the Linear Record Mode setting on the Transport panel:
• If the record mode is set to “Normal”, overdub recording
works as with audio tracks, i.e. if you record again where
something has already been recorded, you get a new part that
overlaps the previous one(s).
• If the record mode is set to “Merge”, the overdubbed events
are added to the existing part.
• If the record mode is set to “Replace”, the new recording replaces any existing events in the area on that track.

Selecting a sound
You can select sounds from within Nuendo by instructing
the program to send Program Change and Bank Select
messages to your MIDI device. This is done using the
“Patch Selector” and “Bank Selector” fields in the Inspector or Track list.

About punch in and out on MIDI tracks
Performing and setting up manual and automatic punch
in/out recording for MIDI tracks is done in exactly the
same way as for audio tracks. There is one thing to note,
however:
• Punching in and out on recordings with Pitch Bend or
controller data (modulation wheel, sustain pedal, volume
etc.) may lead to strange effects (apparently hanging
notes, constant vibrato etc.).

Program Change messages give access to 128 different
program locations. If your MIDI instruments have more
than 128 programs, Bank Select messages (set in the
“Bank Selector” field) allow you to select different banks,
each containing 128 programs.

If this happens, you may need to use the Reset item on the MIDI menu
(see “The Reset function” on page 81).

About the Automatic MIDI Record Quantize function

Ö Bank Select messages are recognized differently by
different MIDI instruments. The structure and numbering
of banks and programs may also vary. Consult the documentation of your MIDI instruments for details.

If Auto Quantize is activated on the Transport panel (the
“Auto Q” button), the notes you record are automatically
quantized according to the current Quantize settings. For
more information about quantizing, see “The Quantizing
functions” on page 352.

Ö Note that it is also possible to select sounds by name.
For descriptions of how to set this up, see the separate
“MIDI Devices” PDF document.
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Recording MIDI in cycle mode

Cycle Record mode: Stacked/Stacked 2 (No Mute)

When you record MIDI in cycle mode, the result depends
on which Cycle Record mode is selected on the Transport
panel:

In this mode, the following happens:
• Each recorded cycle lap is turned into a separate MIDI part.
• The track is divided into “lanes”, one for each cycle lap.
• The parts are stacked above each other, each on a different
lane.
• All takes but the last one are muted (Stacked).
• If Stacked 2 is selected, no muting takes place.

Cycle Record mode: Mix (MIDI)
For each completed lap, everything you record is added to
what was previously recorded in the same part. This is
useful for building up rhythm patterns, for example.
Record a hi-hat part on the first lap, the bass drum part on
the second lap etc.
Cycle Record mode: Overwrite (MIDI)
As soon as you play a MIDI note (or send any MIDI message), all MIDI you have recorded on previous laps is overwritten from that point on in the part. An example:

2. The first take wasn’t good enough – you start directly
with a new take on the next cycle lap and overwrite the
first take.

This makes it easy to create a “perfect take” by combining
the best parts from the different cycle laps. You can edit
the parts in the Project window (by cutting, resizing and
deleting) or you can use a MIDI editor as in the following
example:

3. After recording the second take you let the recording
roll on and listen, without playing anything.

1. Unmute the muted takes by clicking the parts with the
Mute tool.

1. You start recording in an eight bar cycle.

You find that the take was good up until bar seven, for example.

2. Select all takes (parts) and open them in the Key Editor for example.

4. On the next lap, you wait until bar seven and start playing.

3. Use the part list pop-up menu on the toolbar to select
which part to edit.

This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins
– otherwise you will overwrite the entire take.

See “Handling several parts” on page 365.

Cycle Record mode: Keep Last

5. When you are happy with the result, close the editor.

Each completed lap replaces the previously recorded lap.
Note:

6. To turn it all into a single MIDI part (containing your
“perfect take”), select all parts and select “Merge MIDI in
Loop” from the MIDI menu.

4. Remove or edit notes as desired.

• The cycle lap must be completed – if you deactivate recording or press Stop before the cursor reaches the right
locator, the previous take will be kept.

7. In the dialog that appears, activate the Erase Destination option and click OK.
The remaining events in the parts are merged together into a single part.

• If you don’t play or input any MIDI during a lap, nothing
happens (the previous take will be kept).
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Recording different types of MIDI messages
!

System Exclusive messages
System Exclusive (SysEx) is a special type of MIDI message used to send data that only makes sense to a unit of
a certain make and type. SysEx can be used to transmit a
list of the numbers that make up the settings of one or
more sounds in a synth. For more about viewing and editing SysEx messages, see the chapter “Working with System Exclusive messages” on page 410.

You can decide exactly which event types should be
recorded by using the MIDI filters – see “Filtering
MIDI” on page 82.

Notes
When you press and release a key on your synth or other
MIDI keyboard, a Note On (key down) and a Note Off (key
up) message are sent out. The MIDI note message also
contains the information which MIDI channel was used.
Normally, this information is overridden by the MIDI channel setting for the track, but if you set the track to MIDI
channel “Any”, the notes will be played back on their original channels.

The Reset function
The Reset function on the MIDI menu sends out note-off
messages and resets controllers on all MIDI channels.
This is sometimes necessary if you experience hanging
notes, constant vibrato, etc.
• Nuendo can also automatically perform a MIDI reset on
stop.

Continuous messages
Pitch bend, aftertouch and controllers (like modulation
wheel, sustain pedal, volume etc.) are considered as MIDI
continuous events (as opposed to the momentary key down
and key up messages). If you move the Pitch bend wheel on
your synthesizer while recording, this movement is recorded together with the key (Note On and Note Off messages), just as you’d expect. But the continuous messages
can also be recorded after the notes have been recorded
(or even before). They can also be recorded on their own
tracks, separately from the notes to which they belong.

You can turn this function on or off in the Preferences (MIDI page).

• Also in the Preferences (MIDI page), you can find the
option “Insert Reset Events after Record”.
This is a very handy function for MIDI recording. At the end of each recorded part, a Reset event will be inserted, resetting controller data such
as Sustain, Aftertouch, Pitchbend, Modulation, Breath Control, etc. This
is useful if a MIDI part is recorded and e.g. the Sustain pedal is still held
after stopping recording. Usually, this would cause all following parts to
be played with Sustain, as the Pedal Off command was not recorded.
This can be prevented by activating “Insert Reset Events after Record”.

Say, for instance, that you record one or several bass
parts on track 2. If you now set another track, like track 55,
to the same output and MIDI channel as track 2, you can
make a separate recording of just pitch bends for the bass
parts on track 55. This means that you activate recording
as usual and only move the pitch bend wheel during the
take. As long as the two tracks are set to the same output
and MIDI channel, it will appear to the MIDI instrument as
if the two recordings were made at the same time.

Retrospective Record
This feature allows you to capture any MIDI notes you play
in Stop mode or during playback and turn them into a MIDI
part “after the fact”. This is possible due to the fact that
Nuendo can capture MIDI input in buffer memory, even
when not recording.
Proceed as follows:
1. Enable the Retrospective Record option in the Preferences (Record-MIDI page).

Program Change messages

This activates the buffering of MIDI input, making Retrospective Record
possible.

Normally, when you switch from one program to another
on your keyboard (or whatever you use to record), a number corresponding to that program is sent out via MIDI as
a Program Change message. These can be recorded on
the fly with the music, recorded afterwards on a separate
track, or manually entered in the Key or List Editors.

2. Make sure a MIDI track is record-enabled.
3. When you have played some MIDI material you want
to capture (either in Stop mode or during playback), select
Retrospective Record from the Transport menu (or use
the key command, by default [Shift]-[Pad*]).
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Filtering MIDI

The content of the MIDI buffer (i.e. what you just played) is
turned into a MIDI part on the record enabled track. The
part will appear where the project cursor was when you
started playing – this means that if you played along during playback, the captured notes will end up exactly where
you played them in relation to the project.
• The Retrospective Record Buffer Size setting in the
Preferences (Record-MIDI page) determines how much
data can be captured.

MIDI Preferences
There are several other options and settings in the Preferences that affect MIDI recording and playback:
MIDI page
• Length Adjustment
Adjusts the length of notes so that there is always a short time between
the end of one note and the start of another (of the same pitch and on the
same MIDI channel). The time is set in ticks. By default there are 120
ticks per 1/16 note, but you can adjust this with the MIDI Display Resolution setting on the same page.

The MIDI–MIDI Filter page in the Preferences allows you
to prevent certain MIDI messages from being recorded
and/or “thruput” (echoed by the MIDI Thru function).

Record-MIDI page

Section

Description

Record

Activating any of these options prevents that type of MIDI
message from being recorded. It will, however, be thruput, and if already recorded, it will play back normally.

Thru

Activating any of these options prevents that type of MIDI
message from being thruput. It will, however, be recorded and played back normally.

Channels

If you activate a channel button, no MIDI messages on
that MIDI channel will be recorded or thruput. Already recorded messages will, however, be played back normally.

Controller

Allows you to prevent certain MIDI controller types from
being recorded or thruput.
To filter out a controller type, select it from the list at the
top of the Controller section and click “Add”. It will appear on the list below.
To remove a controller type from the list (allow it to be recorded and thruput), select it in the lower list and click
“Remove”.

The dialog is divided into four sections:

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be lengthened to start and end at whole bar positions. If you are working in a
Bars+Beats-based context, this can make editing (moving, duplicating,
repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track
is automatically record-enabled. Furthermore, Record Enable is deactivated for all other MIDI tracks until you close the editor again.
This makes it easier to record MIDI data when you’re editing a part – you
will always be sure the recorded data ends up in the edited part and not
on any other track.

• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make
sure the very start of the recording is included. A very annoying scenario is
when you have recorded a perfect MIDI take, only to find out that the very
first note wasn’t included – because you started playing a little bit too early!
If you raise the Record Catch Range, Nuendo will catch the events played
just before the recording start point, eliminating this problem.

For a description of the other options, click the Help button in the Preferences.
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Options and Settings

An example:

Recording-related Transport Preferences

1. Set the locators to where you want to start and end recording.

A couple of settings in the Preferences (Transport page)
are relevant for recording. Set these according to your
preferred method of work:

2. Activate Punch in and Punch out on the Transport
panel.
3. Activate the option “Stop after Automatic Punch Out”
in the Preferences (Transport page).

Deactivate Punch In on Stop

4. Set suitable preroll and postroll times by clicking in the
corresponding fields on the Transport panel and typing in
time values.

If this is activated, punch in on the Transport panel is automatically deactivated whenever you enter Stop mode.
Stop after Automatic Punch Out

5. Activate preroll and postroll by clicking the buttons
next to the preroll and postroll times so that they light up.

If this is activated, playback will automatically stop after
automatic punch out (when the project cursor reaches the
right locator and punch out is activated on the Transport
panel). If the postroll value on the Transport panel is set to
a value other than zero, playback will continue for the set
time before stopping (see below).

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field
and playback starts. When the cursor reaches the left locator, recording
is automatically activated. When the cursor reaches the right locator, recording is deactivated, but playback continues for the time set in the
postroll field before stopping.

About Preroll and Postroll
Using the metronome

Preroll value field and on/
off switch.

The metronome can output a click that can be used as a
timing reference. The two parameters that govern the timing of the metronome are tempo and time signature, and
these are edited in the Tempo Track window (see “Editing
the tempo curve” on page 417).

Postroll value field and
on/off switch.

The preroll and postroll value fields (below the left/right
locator fields) on the Transport panel have the following
functionality:

You can use the metronome for a click during recording
and/or playback or for a precount (count-in) that will be
heard when you start recording from Stop mode. Click
and precount are activated separately:

• By setting a preroll value, you instruct Nuendo to “roll
back” a short section whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant
when recording from the left locator (punch in activated on the Transport
panel) as described below.

• To activate the metronome, click the Click button on the
Transport panel.
You can also activate the “Metronome On” option on the Transport menu
or use the corresponding key command (by default [C]).

• By setting a postroll value, you instruct Nuendo to play
back a short section after automatic punch out before
stopping.

• To activate the precount, click the Precount button on
the Transport panel.

This is only relevant when punch out is activated on the Transport panel
and “Stop after Automatic Punch Out” is activated in the Preferences
(Transport page).

You can also activate the “Precount On” option on the Transport menu
or set up a key command for this.

• To turn preroll or postroll on or off, click the corresponding button on the Transport panel (next to the pre/postroll
value) or use the “Use Preroll” and “Use Postroll” options
on the Transport menu.

Click on/off
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Precount on/off

Metronome settings
You make settings for the metronome in the Metronome
Setup dialog, opened from the Transport menu.

Precount
Options

Description

Use Time
Signature at
Project Time

When this is activated, the precount will be in the time
signature set in the Tempo track. Furthermore, any tempo
changes in the Tempo track during the precount will be
applied.

Use Signature… This lets you set a time signature for the precount. In this
mode, tempo changes in the Tempo track won’t affect
the precount.
MIDI Click

Description

Activate MIDI
Click

Selects whether or not the metronome will sound via
MIDI.

MIDI Port/
Channel

This is where you select a MIDI output and channel for
the metronome click.

Hi Note/
Velocity

Sets the MIDI note number and velocity value for the
“high note” (the first beat in a bar).

Lo Note/
Velocity

Sets the MIDI note number and velocity for the “low
notes” (the other beats).

Audio Click

Description

Activate Audio
Click

Selects whether or not the metronome will sound via the
audio hardware.

The metronome can use either an audio click played back
via the audio hardware, send MIDI data to a connected
device which will play back the click or do both.

Beeps

When this is selected, the audio clicks will be beeps generated by the program. Adjust the pitch and level of the
beeps for the “Hi” (first) beat and “Lo” (other) beats using
the sliders below.

The following metronome settings can be made in the dialog:

Sounds

When this is selected, you can click in the “Sound” fields
below to load any audio files for use as the “Hi” and “Lo”
metronome sounds. The sliders set the level of the click.

Metronome
Options

Description

Metronome in
Record / Play

Allows you to specify whether the metronome should be
heard during playback, recording or both (when Click is
activated on the Transport panel).

Use
Count Base

If this option is activated, a field appears to the right
where you specify the “rhythm” of the metronome. Normally, the metronome plays one click per beat, but setting
this to e.g. “1/8” gives you eighth notes – two clicks per
beat. It’s also possible to create unusual metronome
rhythms such as triplets etc.

Precount
Options

Description

Precount Bars

Sets the number of bars the metronome will count in before it starts recording if precount is activated on the
Transport panel.

Use Time Signa- When this is activated, the precount will automatically
ture at Record use the time signature and tempo set at the position
Start Time
where you start recording.
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Recovery of audio recordings after
system failure
Normally, when a computer crashes, all changes made to
your current project since you last saved it will be lost. Usually, there is no quick and easy way to recover your work.
With Nuendo, when your system crashes while you are recording (because of a power cut or other mishap), you will
find that your recording is still available, from the moment
when you started recording to the time when your computer crashed.
When you experience a computer crash during a recording, simply relaunch the system and check the project
record folder (by default this is the Audio subfolder inside
the project folder). It should contain the audio file you
were recording at the time of the crash.
!

Please note: This feature does not constitute an
“overall” guarantee by Steinberg. While the program
itself was improved in such a way that audio recordings can be recovered after a system failure, it is always possible that a computer crash, power cut, etc.
might have damaged another component of the
computer, making it impossible to save or recover
any of the data.

!

Warning: Please do not try to actively bring about
this kind of situation to test this feature. Although the
internal program processes have been improved to
cope with such situations, Steinberg cannot guarantee that other parts of the computer are not damaged
as a consequence.
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Creating fades

• If the option “Show Event Volume Curves Always” is activated in the Preferences dialog (Event Display–Audio
page), the fade curves will be shown in all events, regardless of whether they are selected or not.

There are two main types of fade-ins and fade-outs in audio events in Nuendo: fades created by using the fade
handles (see below) and fades created by processing
(see “Fades created by processing” on page 89).

If the option is deactivated, the fade curves are shown in selected events
only.

• If the option “Fade Handles always on Top” is activated
in the Preferences dialog (Event Display-Audio page), the
fade handles stay at the top of the event, and vertical help
lines indicate the exact end or start points of fades.

Fades created by using the fade handles
Selected audio events have blue handles in the upper left
and right corners. These can be dragged to create a fadein or fade-out respectively.

This is useful in situations where you want the event volume to be very
low, as this option allows you to still see the fade handles.

• If the option “Thick Fade Lines” is activated in the Preferences dialog (Event Display-Audio page), the fade lines
and volume curve are thicker, increasing their visibility.

Creating a fade-in. The fade is automatically reflected in the shape of
the event’s waveform, giving you a visual feedback of the result when
you drag the fade handle.

Fade handles on top of the event and thicker fade and volume lines allow you to edit and view fades even in situations where event volume is
very low.

Fades created with the handles are not applied to the audio clip as such but calculated in real time during playback. This means that several events referring to the same
audio clip can have different fade curves. It also means
that having a huge number of fades may demand a lot of
processor power.

• When the option “Use Mouse Wheel for Event volume
and Fades” is activated in the Preferences dialog (Editing–Audio page), you can use the mouse wheel to move
the volume curve up or down. When you hold down [Shift]
while moving the mouse wheel, this will change the fade
curves. This is useful in situations where the fade handles
are not visible (e.g. because of a very high zoom factor).

• If you select multiple events and drag the fade handles
on one of them, the same fade will be applied to all selected events.

When you position the mouse pointer somewhere in the left half of the
event, the fade in end point is moved. When the mouse pointer is in the
right half of the event, the fade out start point will move.

• A fade can be edited in the Fade dialog, as described
on the following pages.

Ö You can set up key commands for changing the event
volume curve and any fade curves, if you don’t want to use
the mouse for this.

You open the dialog by double-clicking in the area above the fade curve,
or by selecting the event and selecting “Open Fade Editor(s)” from the
Audio menu (note that this will open two dialogs if the event has both
fade-in and fade-out curves).
If you adjust the shape of the fade curve in the Fade dialog, this shape
will be maintained when you later adjust the length of a fade.

You will find these commands in the Key Commands dialog, in the Audio
category. See “Key commands” on page 517.

Ö As an alternative to dragging the fade handles, you
can use the items “Fade In to Cursor” and “Fade Out to
Cursor” on the Audio menu to create fades.

• You can make the fade longer or shorter at any time, by
dragging the handle.

Position the project cursor on an audio event where you want a fade in to
end or a fade out to begin, and select the appropriate option from the
Audio menu. A fade will then be created, ranging from the event’s start or
end to the position of the cursor.

You can actually do this even without selecting the event first, i.e. without
visible handles. Just move the mouse pointer along the fade curve until
the cursor turns into a bidirectional arrow, then click and drag.
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Creating and adjusting fades with the Range Selection
tool

About the volume handle
A selected audio event also has a blue handle in the top
middle. This is the volume handle, and it provides a quick
way of changing the volume of an event, directly in the
Project window. It is linked directly with the volume setting
on the info line, that is, dragging the volume handle also
changes the value on the info line.

“Handle-type” fades can also be created and adjusted
with the Range Selection tool, in the following way:

The volume change is displayed
numerically in the info line.

1. Select a section of the audio event with the Range Selection tool.

Drag the Volume handle
up or down to change
the volume of the event.

The result depends on your selection, in the following way:
• If you select a range from the beginning of the event, a fade-in
will be created within the range.
• If you select a range that reaches the end of an event, a fadeout will be created in the range.
• If you select a range encompassing a middle section of the
event, but not reaching neither the start nor the end, both a
fade-in and a fade-out will be created outside of the selected
range. In other words, the fade-in will cover the area from the
beginning of the event to the beginning of the selected range,
and the fade-out will cover the area from the end of the selected range to the end of the event.

The event waveform reflects the volume change.

Removing fades
To remove the fades for an event, select the event and select “Remove Fades” from the Audio menu.
You can also use the Range Selection tool to remove
fades and crossfades within the selected range:

2. Pull down the Audio menu and select “Adjust Fades to
Range”.

1. Drag the Range Selection tool in the Project window,
so that the selection encloses all of the fades and crossfades you wish to remove.

The fade areas are adjusted according to the selection range.
!

You can select multiple audio events on separate
tracks with the Range Selection tool, and apply the
fade to all of them simultaneously.

2. Select “Remove Fades” from the Audio menu.

Applying Default Fades
You can also create fades by using the commands “Apply
Standard Fade In” and “Apply Standard Fade Out” from
the Audio menu.
1. Select one or more audio events in the project window.
2. From the Audio menu, choose either “Apply Standard
Fade In” or “Apply Standard Fade Out”.
A fade will be created that is the same length and shape as the Default
fade (see “As Default button” on page 90 for more information on how to
define Default fades).
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Fades created by processing

The Fade dialogs

If you have selected an audio event or a section of an audio event (using the Range Selection tool), you can apply
a fade-in or fade-out to the selection by using the “Fade
In” or “Fade Out” functions on the Process submenu on
the Audio menu. These functions open the corresponding
Fade dialog, allowing you to specify a fade curve.

The Fade dialogs appear when you edit an existing fade or
use the “Fade In”/”Fade Out” functions on the Process
submenu on the Audio menu. The picture below shows
the Fade In dialog; the Fade Out dialog has identical settings and features.

!

Note that the length of the fade area is determined
by your selection. In other words, you specify the
length of the fade before you enter the Fade dialog.

!

Also note that you can select multiple events and apply the same processing to all of them simultaneously.

Fades created this way are applied to the audio clip rather
than to the event. Please note the following:
• If you later create new events that refer to the same clip, these
will have the same fades.
• You can remove or modify the fades at any time using the Offline Process History (see “The Offline Process History dialog”
on page 251).

• If you open the Fade dialog(s) with several events selected, you can adjust the fade curves for all these events
at the same time.

If other events refer to the same audio clip, you will be
asked whether you want the processing to be applied to
these events or not.

This is useful if you want to apply the same type of fade-in to more than
one event, etc.

Curve Kind

• Continue will apply the processing to all events that refer to
the audio clip.
• New Version will create a separate, new version of the audio
clip for the selected event.
• You can also activate “Do not show this message again”. Regardless of whether you then choose “Continue” or “New Version”, any further processing will conform to the option you
select.
!

These determine whether the fade curve should consist of
spline curve segments (left button), damped spline segments (middle button) or linear segments (right button).
Fade display
Shows the shape of the fade curve. The resulting waveform shape is shown in dark gray, with the current waveform shape in light gray.

You can change this setting at any time in the Preferences dialog (Editing–Audio page), under “On Processing Shared Clips”.

You can click on the curve to add points, and click and
drag existing points to change the shape. To remove a
point from the curve, drag it outside the display.
Curve shape buttons
These buttons give you quick access to some common
curve shapes.
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Restore button

Preview, Apply and Process

The Restore button (to the right above the fade display) is
only available when editing fades made by dragging the
fade handles. Click this to cancel any changes you have
made since opening the dialog.

The buttons in the bottom row are different depending on
whether you are editing a fade made with the fade handles
or applying a fade using processing:

Fade Length Value

The Edit Fade dialog.

The Fade Length Value can be used to enter fade lengths
numerically. The format of values displayed here are determined by the Primary Time Display in the Transport Panel.

The Process Fade dialog.

When you activate the “Apply Length” option, the value
entered in the Fade Length value field will be used when
clicking “Apply” or “OK”. This setting is deactivated by default.
!

The Edit Fade dialogs have the following buttons:

When you set the current Fade as the Default fade,
the length value is included as part of the default settings.

Button

Function

OK

Applies the set fade curve to the event, and closes the
dialog.

Cancel

Closes the dialog.

Apply

Applies the set fade curve to the event, without closing
the dialog.

Presets
The Process Fade dialogs have the following buttons:

If you have set up a fade-in or fade-out curve that you may
want to apply to other events or clips, you can store it as a
preset by clicking the Store button.

Button

Function

Preview

Plays back the fade area. Playback will repeat until you
click the button again (the button is labeled “Stop” during
playback).

Process

Applies the set fade curve to the clip, and closes the
dialog.

Cancel

Closes the dialog without applying any fade.

• To apply a stored preset, select it from the pop-up menu.
• To rename the selected preset, double-click on the name
and type a new one.
• To remove a stored preset, select it from the pop-up
menu and click Remove.
!

Stored fade-in presets will only appear in the Fade In
dialog, and fade-out presets will only appear in the
Fade Out dialog.

As Default button
The “As Default…” button is only available when editing
fades made by dragging the fade handles. Click this to
store the current settings as default fade. This shape will
be used whenever you create new fades by dragging
event handles. Both the shape and length will be used
when you create fades using the “Apply Standard Fade…”
commands from the Audio menu.
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Creating crossfades
Overlapping audio material on the same track can be
crossfaded, for smooth transitions or special effects. You
create a crossfade by selecting two consecutive audio
events and selecting the Crossfade command on the Audio menu (or by using the corresponding key command,
by default [X]). The result depends on whether the two
events overlap or not:

When you select the Crossfade function, the two events are resized so
that they overlap, and a default crossfade is created in the overlapping
section.

• If the events don’t overlap, and cannot be resized
enough to overlap, a crossfade cannot be created.
• You can specify the length of the crossfade using the
Range Selection tool: make a selection range covering the
desired crossfade area and use the Crossfade command.

• If the events overlap, a crossfade is created in the overlapping area.
The crossfade will be of the default shape – initially a linear, symmetric
crossfade, but you can change this as described below.

The crossfade is applied in the selected range (provided that the events
or their clips overlap, as above). You can also make a selection range after creating the crossfade and use the function Adjust fades to Range on
the Audio menu.

• Once you have created a crossfade, you can edit it by
selecting one or both crossfaded events, and selecting
“Crossfade” from the Audio menu again (or by doubleclicking in the crossfade zone).

Overlapping section.

This opens the Crossfade dialog, see below.

Removing crossfades
To remove a crossfade, select the events and select “Remove Fades” from the Audio menu, or use the Range Selection tool:

• If the events don’t overlap but are directly consecutive
(lined up end-to-start, with no gap) it’s still possible to
crossfade them – provided that their respective audio
clips overlap! In this case, the two events are resized so
that they overlap, and a crossfade of the default length
and shape is applied.

1. Drag the Range Selection tool in the Project window,
so that the selection encloses all of the fades and crossfades you wish to remove.

The default crossfade length and shape are set in the Crossfade dialog
(see “As Default button” on page 90).

2. Select “Remove Fades” from the Audio menu.

An example:

• You can also remove a crossfade by clicking and dragging it outside the track.
Audio events.

Audio clips.
The events in themselves do not overlap, but their clips do. Therefore,
the events can be resized so that they overlap, which is required for a
crossfade to be created.
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The Crossfade dialog

Ö This section describes the default Crossfade dialog.

• Click and drag these points to move the fade-out curve
(upper) or the fade-in curve (lower), respectively:

However, if you activate the option Simple Crossfade Editor in the Preferences dialog (Editing-Audio page), a simplified dialog will be used instead (similar to the regular fade dialogs).

The Crossfade display
The upper part of the Crossfade dialog shows the shape
of the whole crossfade curve and the resulting waveform.
You can perform a number of click and drag operations in
this display.
• Click and drag these points to change the length of the
fade-out curve (upper) or the fade-in curve (lower), respectively:

If “Symmetric Fades” is activated, these change the length of both the
fade out curve and the fade in curve instead – by moving only the end or
the start of the curves as well as the “Offset Point”.

If “Symmetric Fades” is activated, these change the length of both the
fade out and the fade in curve instead. The length change will be applied equally to both sides, without moving the “Offset Point” (see
“Changing the Offset Point” on page 96).
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• Click and drag these points to move the Offset Point
(the dotted line) for the fade-out curve (upper) or the fadein curve (lower), respectively:

Nudge Mode
Here, you can specify whether you want the fade or the
audio to move when you use the Nudge buttons, see “Using the Nudge controls” on page 95.
Point Offset
The Offset Point is the “center” of the fade area, i.e. the
point where the volume of the event is precisely halfway
between full level and zero level. For further information,
see “Changing the Offset Point” on page 96.
Symmetric Fades
If this is activated, you cannot edit the fade in and fade out
curves of the crossfade separately, i.e. the editing controls
will be “linked”, so that both fade curves are affected by
the same amount regardless of whether you use the fadeout or fade-in controls. The actual result however, depends on which control is used.

Moving the Offset Point will also move the fade curve. If “Symmetric
Fades” is activated, the Offset Point for both curves will be moved.

• You can also click and drag to move audio clips (along
with the fade curve) in the display. The pointer takes on the
shape of a hand to indicate that it’s possible to move a clip.

Length, Overlap and Volume
• Use the Length field to specify the length of the crossfade, see “Resizing the crossfade area” on page 95.
• Use the Overlap field to move the fade area without adjusting the Offset point, see “Using the Overlap controls”
on page 96.
• You can right-click (Win) or [Ctrl]-click (Mac) in the
ruler and use the pop-up menu to select a time format
(see “The ruler” on page 31).

• You can use the Volume controls to change the volume
of the crossfaded events. Either use the Volume sliders or
click in the Volume fields, change the values numerically
and press [Return].

• You can scroll and zoom the display with the horizontal
and vertical scroll bars and zoom controls.

This is the same as using the volume handles in the Event display, see
“About the volume handle” on page 88.

Options and settings

The Nudge buttons

The lower part of the Crossfade dialog contains a number
of common settings and controls, as well as separate (but
identical) settings for the fade-in (top) and the fade-out
curve (bottom) of the crossfade.

Use the nudge buttons to nudge the fade area or the audio in the desired direction, see “The Nudge buttons” on
page 93.

Nudge Range

The Fade Displays

This pop-up menu lets you specify the range that is moved
when using the nudge buttons, see “Using the Nudge
controls” on page 95.

The fade displays show the shape of the fade-out and
fade-in curve, respectively. You can click on the curve to
add points, and click and drag existing points to change
the shape. To remove a point from the curve, drag it outside the display.
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Curve buttons

• To specify how long the pre- and post-roll should be,
click in the time fields and enter the desired time (in seconds and milliseconds).

• The curve kind buttons determine whether the corresponding fade curve should consist of spline curve segments (left button), damped spline segments (middle
button) or linear segments (right button).

• The curve shape buttons give you quick access to some
common curve shapes.

• To activate pre-/post-roll, click the respective button.
To deactivate, click the button again.

Equal Gain and Power
• If you activate the “Equal Gain” checkbox, the fade
curves are adjusted so that the summed fade-in and fadeout amplitudes will be the same all along the crossfade
region.

1 second pre-roll activated.

Autoscroll

This is often suitable for short crossfades.

• If you activate the “Equal Power” checkbox, the fade
curves are adjusted, so that the energy (power) of the
crossfade will be constant all along the crossfade region.
!

If this option is activated, the crossfade display will be
scrolled during playback, so that the play position cursor
is always visible. This works just like Autoscroll in the
Project window (see “Autoscroll” on page 57).

Equal Power curves have only one editable curve
point. You cannot use the Curve kind buttons or the
presets when this mode is selected.

Play buttons

Ö Note that this only applies if you use the Transport play
controls – not if you use the Play controls in the Crossfade
dialog.

• The “Play Fade Out” and “Play Fade In” buttons allow
you to audition the fade-out or fade-in part only, without
the crossfade.

Zoom and Auto Zoom

• The “Play Crossfade” button plays back the whole
crossfade.

If you have scrolled or zoomed the crossfade display horizontally (see “The Crossfade display” on page 92), you can
click the “Zoom to Fade” button (the magnifying glass icon)
to quickly revert to the standard zoom factor and center the
display on the currently selected crossfade area.

You can also use the Transport play controls to play back
the crossfaded audio events. However, that method will
play back all unmuted audio events on other tracks as well.

If Auto Zoom is activated (checked), the crossfade display
will automatically be zoomed and centered on the current
crossfade if you resize it (see “Resizing the crossfade
area” on page 95).

Pre-roll and Post-roll
When auditioning with the Play buttons, you can activate
pre-roll and/or post-roll. Pre-roll lets you start playback
before the fade area, and post-roll lets you stop playback
after the fade area. This can be useful for auditioning the
fade in a context.
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Presets

• If possible, the length change will be applied equally to
“both sides” of the crossfade (i.e. Nuendo tries to “center”
the crossfade).

If you have set up a crossfade that you may want to apply
to other events, you can store it as a preset by clicking the
store button (the disk icon).

!

• To apply a stored preset, select it from the pop-up
menu.
• To rename the selected preset, double-click on the
name and type in a new one.

To be able to resize a crossfade this way, it must be
possible to resize the corresponding event. For example, if the left crossfaded event already plays its
audio clip to the end, its endpoint cannot be moved
any further to the right.

Moving the crossfade area

• To remove a stored preset, select it from the pop-up
menu and click the remove button (the trash icon).

You can move the crossfade area in the crossfade display
(see “The Crossfade display” on page 92), with the
Nudge buttons, with the Overlap controls (either the slider
or numerically) or by changing the Offset Point.

Default buttons
Clicking the “As Default” button stores all of the current
settings as the default crossfade. These settings will then
be used whenever you create new crossfades.

Using the Nudge controls
• When you use the Nudge controls, you can decide
whether they should move the fade area or the audio clip,
by clicking the corresponding radio button under “Nudge
Mode”.

Clicking the “Recall Default” button copies the curves and
settings in the Default crossfade to the Crossfade dialog.
Select Crossfade buttons
These allow you to select the previous/next crossfade
area on the current track, if it contains more than one
crossfade.

• Each time you click a Nudge button, the fade area or the
audio event will be moved in the corresponding direction
by the amount specified on the “Nudge Range” pop-up
menu.

• If “Project selection follows” is activated, selecting another crossfade will automatically change the event selection in the Project window.

The Nudge buttons in the upper region affect the fade-out curve, and the
Nudge buttons in the lower region affect the fade-in curve. Note that it is
only possible to move the audio of the second event – i.e. the event that
is faded in.

Resizing the crossfade area

• You can also click in the Nudge value field, enter a numerical value and press [Return] to move a fade area or an
audio event.

You can adjust the length of the crossfade area either in
the crossfade display (see “The Crossfade display” on
page 92), by using the Length controls or by clicking in
the “Length” fields, changing the value numerically and
pressing [Return].

• If “Symmetric Fades” is activated, and the Nudge Mode
is set to “Move Fade”, both the fade-out area and the
fade-in area will be moved by the same amount.

• If “Symmetric Fades” is activated, both the fade out and
the fade in length will be changed by the same amount.
Otherwise, the upper Length controls change the length
of the fade-out curve, and the lower controls change the
length of the fade-in curve.

• If “Symmetric Fades” is activated, and the Nudge Mode
is set to “Move Audio”, the Nudge buttons in the lower region will move the audio event with the fade in.
In this mode, the Nudge buttons in the upper region will move both the
entire fade area and the audio event with the fade in.
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Auto Fades and Crossfades

Using the Overlap controls
The Overlap controls let you move the fade area without
moving the Offset Point – the “center” of the fade area
(see below). This means that the “center” of the fade will
be offset in relation to the fade area.

Nuendo features an Auto Fade function that can be set
both globally, i.e. for the entire project, and separately for
each audio track. The idea behind the Auto Fade function
is to create smoother transitions between events by applying short (1 - 500 ms) fade-ins and fade-outs.

• You can either use the Overlap sliders or you can click
in the Overlap fields, change the values numerically and
press [Return].

!

As mentioned earlier, fades are calculated in real
time during playback. This means that the larger the
number of audio tracks with Auto Fades activated in
a project, the higher the demands on the processor.

!

Note that auto fades are not indicated by the fade
lines!

• If “Symmetric Fades” is activated, both the upper and
the lower Overlap controls will move both the fade-out
and the fade-in area.
Changing the Offset Point
You can also move a fade area by changing its Offset
Point. The Offset Point is the “center” of the fade area, i.e.
the point where the volume of the event is precisely halfway between full level and zero level.

Making global Auto Fade settings
1. To make Auto Fades settings globally for the project,
select “Auto Fades Settings...” from the Project menu.
This opens the Auto Fades dialog for the project.

• Click in the value field, enter the desired value, in accordance with the selected display format (see “The Crossfade display” on page 92) and press [Return].
This will move the Offset Point along with the fade area by the specified
amount. Note however that this only applies to the fade-in area!

• The Offset Point is indicated by a dotted vertical line in
the crossfade display.

2. Use the checkboxes in the upper right corner to activate or deactivate Auto Fade In, Auto Fade Out and Auto
Crossfades, respectively.
3. Use the Length value field to specify the length of the
Auto Fade or Crossfade (1-500 ms).
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Event Envelopes

4. To adjust the shapes of Auto Fade In and Auto Fade
Out, select the “Fades” tab and make settings as in the
regular Fade dialogs.

An envelope is a volume curve for an audio event. It is similar to the real-time fades, but allows you to create volume
changes within the event, not only at the start or end. To
create an envelope for an audio event, proceed as follows:

5. To adjust the shape of the Auto Crossfade, select the
“Crossfades” tab and make settings as in the regular
Crossfade dialog.

1. Zoom in on the event so that you can view its waveform
properly.

6. If you want to use the settings you have made in future
projects, click the “As Default” button.
The next time you create a new project, it will use these settings by default.

2. Select the Pencil tool.

7. Click OK to close the dialog.

When you move the Pencil tool over an audio event, a small volume curve
symbol is shown next to the tool.

Making Auto Fade settings for a separate
track

3. To add an envelope point, click in the event with the
Pencil tool.
A blue envelope curve and a curve point appear.

By default, all audio tracks will use the settings you have
made in the project’s Auto Fades dialog. However, since
Auto Fades use computing power, a better approach may
be to turn Auto Fades off globally and activate them for individual tracks, as needed:
1. Right-click the track in the Track list and select “Auto
Fades Settings...” from the context menu (or select the
track and click the “Auto Fades Settings” button in the Inspector).

4. Drag the curve point to adjust the envelope shape.
The waveform image reflects the volume curve.

The Auto Fades dialog for the track opens. This is identical to the project’s
Auto Fades dialog, with the addition of a “Use Project Settings” option.

• You can add as many curve points as you like.

2. Deactivate the “Use Project Settings” option.

• To remove a curve point from the envelope, click on it
and drag it outside the event.

Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

• The envelope curve is a part of the audio event - it will
follow when you move or copy the event.

Reverting to project settings

After copying an event with an envelope, you can make independent adjustments to the envelopes in the original event and the copy.

If you want a track to use the global Auto Fade settings,
open the Auto Fades dialog for the track and activate the
“Use Project Settings” checkbox.

Ö It is also possible to apply an envelope to the audio
clip using the Envelope function on the Process submenu
on the Audio menu.
See “Envelope” on page 242.

• To remove an event envelope curve from a selected
event, open the Audio menu and select the Remove
Volume Curve option.
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7
The Arranger track

Introduction

3. On the Project window toolbar, make sure that Snap
is activated, and that the Grid resolution is set to a mode
that allows your arranger events to snap to appropriate
positions in the project.

The Arranger track allows you to work with sections of
your project in a non-linear fashion, to simplify arranging to
the maximum extent. Instead of moving, copying and pasting events in the Project window event display to create a
linear project, you can define how different sections are to
be played back, like a playlist.

Snap to events is activated, i. e. when drawing in the Project window,
new events will snap to existing events.

For this, you can define arranger events, order them in a list,
and add repeats as desired. This offers a different and more
pattern-oriented way of working, which complements the
usual linear editing methods in the Project window.

4. On the Arranger track, use the Pencil tool to draw an
event of the desired length.
An Arranger event is added, called “A” by default. Any following events
will be named in alphabetical order.

You can create several Arranger chains, making it possible to store different versions of a song within the project
without sacrificing the original version. When you have
created an Arranger chain that you like, you have the option of “flattening” the list, which creates a normal linear
project based on the Arranger chain. You can chose to
keep the Arranger track or to remove it.

• You can rename an Arranger event by selecting it and
changing its name in the Project window info line or by
holding down [Alt]/[Option], double-clicking on the name
in the Arranger chain (see below) and entering a new
name.
You may want to name your arranger events according to the structure of
your project, e.g. Verse, Chorus etc.

You can also use the Arranger track for live performances
on the stage, in clubs or at parties.

5. Create as many events as you need for your project.

Setting up the Arranger track
Let’s say you have prepared a number of audio files that
form the base of a typical pop song, with introduction,
verse, chorus and bridge. Now you want to arrange these
files.
The first step is to create an Arranger track. On the Arranger track, you define specific sections of the project by
creating arranger events. These can be of any length, may
overlap and are not bound to the start or end of existing
events and parts. Proceed as follows:

In this example, arranger events have been created that correspond to a
classic pop song structure. Note how there is no real time line in the
project: the music sequence is determined by the arranger events.

1. Open the project for which you want to create arranger
events.

Events can be moved, resized and deleted using the standard techniques. Please note:

2. Open the Project menu and select “Arranger” from the
Add Track submenu (or right-click in the Track list and select Add Arranger track).

• If you want to change the length of a event, select the
Arrow tool and click and drag the bottom corners of the
event in the desired direction.

An Arranger track is added. There can be only one Arranger track in a
project, but you can set up more than one Arranger chain for this track,
see “Managing Arranger chains” on page 102.

• If you copy an Arranger event (by [Alt]/[Option]-dragging or by using copy/paste), a new event will be created
with the same name as the original.
However, this new event will be totally independent from the original event.

• Double-clicking on an arranger event adds it to the current Arranger chain.
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Working with arranger events

• Double-clicking on the name of an event in the window
section on the right (or in the project window).

You now have a number of arranger events that form the
basic building blocks for your arrangement. The next step
is to arrange these events using the functions of the Arranger Editor.

When an event is selected in the Arranger chain on the left will add the
event above the selected event. When no events are selected in the Arranger chain on the left will add the event to the end of the list.

• By selecting one or more events in the right list, rightclicking and selecting “Append Selected In Arranger
Chain”.

Creating an Arranger chain

This will add the selected events at the end of the list.

You can set up an Arranger chain in the Arranger Editor or
in the Inspector for the Arranger track. The Arranger Editor
is opened by clicking the “e” button in the Inspector or in
the Arranger track.

• By dragging and dropping arranger events from the
right list to the left list.
A blue insertion line shows you where the dragged event will end up in the
list.

Click in the Inspector…

…or the Track list…

Here, the Verse event is dragged into the Arranger chain and placed after the first chorus.
…to open the Arranger Editor.

• By dragging arranger events from the Project window
and dropping them in the Arranger chain.
If you followed our example, you should now have arranger
events arranged in a very basic pop song pattern. However, we have used audio files that are only a few bars
long – to turn our pattern into a “song” (or at least into a
basic sketch of the song structure), these files must be
looped. This is where the Repeats function comes in.
If you want an event to repeat several times, proceed as
follows:

To the right in the Arranger Editor, the available arranger
events are listed, in the order they appear on the time line.
To the left you find the actual Arranger chain, which shows
in which order the events will be played back, from top to
bottom, and how many times they should be repeated.

• Click in the Repeats field for an event, type in the desired number of repeats and press [Enter].
When playing back the Arranger chain, the Counter column indicates
which repeat of this event is currently playing.

Initially the Arranger chain will be empty – you set up the
Arranger chain by adding events from the right list to the
Arranger chain. There are several ways to add events to
the Arranger chain.
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Editing the Arranger chain

• Click in the Mode field for an event and select the desired repeat mode.
Option

Button

In the Arranger chain to the left, you can do the following:

Description

Normal

In this mode, your Arranger chain will be played
back normally, just as you set it up.

Repeat forever

In this mode, the current Arranger event will be repeated in a loop until you either click on another
event in the Arranger Editor or press play once
again.

Pause after
Repeats

In this mode, the playback of the Arranger chain
will be stopped after having played back all repeats of the current Arranger event.

• Select events by clicking or [Shift]-clicking.
The selected events do not have to be a continuous selection.

• Drag events to move them in the list.
• Drag events while holding [Alt]/[Option] to create copies of the selected items.
The insert location for both move and copy operations is indicated by a
blue or red line in the list. A blue line indicates that the move or copy is
possible; a red line indicates that if the current position were to be used,
a move or copy is not allowed.

When you now play back the Arranger chain, you will hear
the complete arrangement. Proceed as follows:

• Use the Repeats column to specify how many times
each event should be repeated.

1. Make sure that Arranger mode is activated.

• Click the arrow to the left of an event in the Arranger
chain to move the playback position to the start of that
event.

When Arranger mode is activated, the project will be played back using
the Arranger settings.

• To remove an event from the list, right-click on it and select “Remove Touched” from the pop-up menu that appears. To remove several events, select them, right-click
and select “Remove Selected”.
The Arranger mode button must be activated.

Navigating

2. Position the Arranger Editor window so that you can
see the Arranger track in the Project window, and click in
the arrow column for the event at the top of the list so that
the arrow becomes blue.

To navigate between arranger events, you use the Arranger transport buttons:
Previous chain step

You should see the project cursor jump to the beginning of the first event
specified in the Arranger chain.

First repeat of current chain step

3. Activate playback, either from the Arranger Editor or
on the Transport panel.
The events are played back in the specified order.
Next chain step

Last repeat of current chain step

These controls are available in the Arranger Editor, the
Project window toolbar, and the Transport panel.
In the Arranger Editor, the event that is currently played
back is indicated by an arrow in the leftmost column, and
the indicators in the Counter column. You can switch between Arranger chains during playback using the pop-up
menu in the Editor, Inspector or Track list.
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Managing Arranger chains

2. Activate Playback.
The project will now play back exactly as in Arranger mode, but you can
view it and work with it as usual.

You can create several Arranger chains. This way, you can
create alternative versions for playback. In the Arranger
Editor, the toolbar buttons on the right are used for this:
Button

!

Description
Click this to rename the current Arranger chain.

Flattening the Arranger chain may remove events
and parts from the project. Only use the Flatten function when you know you don’t want to edit the Arranger track/chain any more. If in doubt, save a copy
of the project before flattening the Arranger chain.

Creates a new, empty Arranger chain.

Flattening options
Sometimes it might be useful to keep the original Arranger
events even after flattening the Arranger track. By using flattening options you can define which chain should be flattened (Source section), where it should be stored and how
it should be named (Destination section) together with
other options (Options section).

Creates a duplicate of the current Arranger chain, containing
the same events.
Removes the currently selected Arranger chain. Only available if you have created more than one Arranger chain.

1. Click the Flattening options button.

The Arranger chains you create will be listed on the Name
pop-up menu, found in the Arranger Editor to the left of
the buttons, at the top of the Arranger track Inspector, and
in the Track list. Please note that to be able to select another Arranger chain from the pop-up menu, Arranger
mode must be activated.

2. In the window that appears, select the desired options.

• In the Inspector, these functions are accessed from the
Arranger pop-up menu (opened by clicking on the Arranger name field).

Flattening the Arranger chain
When you have found an Arranger chain that suits your purposes, you can “flatten” it, i.e. convert the list into a linear
project. Proceed as follows:
In the Source section you can specify, which Arranger
chain should be flattened. The available options are:

1. Click the Flatten button (or select Flatten Chain from
the pop-up menu in the Inspector for the Arranger track).
The events and parts in the project are reordered, repeated, resized,
moved and/or deleted (if these are not within the boundaries of any used
Arranger event), so that they correspond exactly to the Arranger chain.

Option

Description

Current Chain

If you activate this option, only the current chain will be
flattened.

Checked Chain If you activate this option, you can select the arranger
chains you want to flatten in the list to the left.
All Chains
The Flatten button
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If you activate this option, all arranger chains of the current project will be flattened.

Live Mode

The Destination section allows you to choose where the
result of the flattening should be saved. The available options are:
Option

If you have set up an Arranger track and play it back, you
have also the possibility to influence the playback order
“live”. Note that the Arranger mode has to be activated to
be able to use the Live mode.

Description

Current Project This option is only available, if you have selected “Current
Chain” as Source. If you activate this option, the result of
the flattening of the current chain will be saved in the current project.
New Project

1. Add an Arranger track by selecting “Arranger” from the
Add Track submenu of the Project menu.

If you activate this option, you can flatten one or several
chains in a new project. In this case it might be useful to
use naming options. If you activate “Append Chain
Name”, the Chain Name(s) will be appended in brackets
to the project name. If you activate “Use Chain Name”,
the new project(s) will have the name of the current Arranger chain(s). If you activate “Add Number”, the new
project(s) will be named like the old ones and a number
will be appended in brackets.

2. Create the desired Arranger events by drawing with
the Pencil tool on Arranger track.
3. Set up an Arranger chain in the Inspector for the Arranger track or in the Arranger Editor, activate the Arranger mode and play back your project.
Now you can use your Arranger events listed in the lower
section of the Arranger track Inspector to play back your
project in Live Mode:

In the Options section you can make further settings. The
available options are:
Option

Description

Keep Arranger
Track

If you activate this option, the Arranger Track will be kept
when flattening the Arranger chain. If you activate the option “Rename Arranger Events” a number will be appended to the events according to their use. If e.g. you
use Arranger event “A” two times, the first occurrence
will be renamed “A 1” and the second “A 2”.

4. Switch into Live mode by clicking on the little arrow in
the lower list of the Arranger track Inspector to the left of
the Arranger event you want to trigger.
The Arranger event will be looped endlessly, until you click on another Arranger event. This might be useful, if you want to loop e.g. a guitar solo with
a flexible length.

Make Real Event Normally, you will get shared copies when flattening the
Copies
Arranger track. If you activate this option, real copies will
be created instead.
Don’t Split
Events

If the option is activated, MIDI notes that start before or
are longer than the Arranger event will not be included.
Only MIDI notes that begin and end inside the Arranger
event boundaries will be taken into account.

Open New
Projects

If you activate this option, a new project will be created
for every flattened Arranger chain. If you activate the option “Cascade New Projects” the opened projects will be
cascaded.

• You can stop Live mode by clicking the Stop button or
go back to “normal” playback in Arranger mode by clicking
on any arranger event in the upper list.
In the latter case, playback will be continued from the arranger event
where you clicked. The “Select grid” pop-up menu will always be taken
into account. When the grid is set to “1 Bar” and you click the STOP
button e.g., playback will be stopped after the next bar.

3. You can now flatten the Arranger track by clicking the
Flatten button.
If you realize that you want to do further arrangements, you can also click
the “Go Back” button and make your adjustments. Your Flattening settings will be kept.

4. Click the “Go Back” button to go back to the Arranger
Editor or close the window by clicking its Close button.
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The active Arranger event will be played back as long as
defined before jumping to the next.
Option

Description

Now

Jumps to the next section immediately.

4 bars,
2 bars

When one of these modes is selected, a grid of 4 or 2 bars (depending on the setting) will be placed on the active Arranger
event. Whenever the respective grid line is reached, playback
will jump to the next Arranger event. An example:
Let’s say you have an Arranger event which is 8 bars long and
the grid is set to 4 bars. When the cursor is anywhere within the
first 4 bars of the Arranger event when you hit the next Arranger
event, playback will jump to the next event when the end of the
fourth bar of the Arranger event is reached. When the cursor is
anywhere within the last 4 bars of the Arranger event, playback
will jump to the next event at the end of the event.
When an event is shorter than 4 (or 2) bars when this mode is
selected, playback will jump to the next section at the event end.

1 bar

Jumps to the next section at the next bar line.

1 beat

Jumps to the next section at the next beat.

End

Plays the current section to the end, then jumps to the next section.

1. Set up a project with a MIDI track and three MIDI parts.
The first should start at position 00:00:00:00 and end at
position 00:01:00:00, the second should start at position
00:01:00:00 and end at position 00:02:00:00 and the
third should start at position 00:02:00:00 and end at position 00:03:00:00.
2. Activate the Sync button on the transport panel.
3. Add an Arranger track and create Arranger events that
match the MIDI parts.
4. Set up the Arranger chain “A-A-B-B-C-C”, activate
the Arranger mode and play back your project.
5. Start external Timecode at position 00:00:10:00
(within the range of "A").
In your project, the position 00:00:10:00 will be located and you will hear
"A" playing. Nothing special!

Now, let’s see what happens if your external sync master
device starts at a position that does not match the Project
Start time:

Arranging your music to video

6. Start at 00:01:10:00 (within the range of what originally was "B").

The relative time of your Arranger track can be taken as a
reference instead of the project time. This is useful, if you
want to use the Arranger track to compose music for
video and fill e.g. a specific video section with music, by
repeating the corresponding number of Arranger events.

In your project, the position 00:01:10:00 will be located and you will hear
"A" playing, because it plays twice in the Arranger track.

7. Start external Timecode at position 00:02:10:00
(within the range of what originally was "C").
In your project, the position 00:02:10:00 will be located and you will hear
"B" playing, because it plays "later" in the Arranger track.

If you position your external sync master device to a position that does not match the Project Start time, Nuendo
will jump automatically to the right position in the Arranger
track and will start playback from there, i.e. the correct relative position and not the absolute project time will be
found. The reference for the external timecode can be
MIDI or any other Timecode that can be interpreted/read
by Nuendo.
Ö If the Arranger mode is not activated or no Arranger
track exists, Nuendo will work as usual.
Below follows an example, that will help you understand
this functionality:
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8
Folder tracks

About folder tracks

2. Release the mouse button.
The track is now placed in the folder track, and all parts and events on
the track will be represented by a corresponding folder part (see “Working with folder parts” on page 107), which is a graphical representation
of all parts and events in the folder.

A folder track

Tracks in the
folder

Just as the name implies, a folder track is a folder that contains other tracks. Moving tracks into a folder is a way to
structure and organize tracks in the Project window. For
example, grouping several tracks in a folder track makes it
possible for you to “hide” tracks (thus giving you more
working space on the screen). You can solo and mute
several tracks in a quicker and easier way and perform editing on several tracks as one entity. Folder tracks can
contain any type of track including other folder tracks.

Since you can move any type of track into a folder track, it
is possible to create sub-folders by moving one folder
track into another. This is called “nesting”. For example,
you could have a folder containing all the vocals in a
project, and each vocal part could have a nested folder
containing all the takes for easier handling etc.

Removing tracks from a folder

Handling folder tracks

To remove a track from a folder, simply drag it out of the
folder and release it in the Track list.

Creating a folder track
Hiding/showing tracks in a folder

Folder tracks are created just like any other track: Select
“Add Track” from the Project menu and select “Folder”
from the submenu that appears, or right-click in the Track
list and select “Add Folder Track” from the context menu.

You can hide or show the tracks located in a folder by
clicking on the “Expand/Collapse Folder” button (the
folder icon). Hidden tracks are still played back as usual.

Moving tracks into a folder
You can move any type of track into a folder by using drag
and drop:
1. In the Track list, click on a track that you want to move
into a folder and drag it onto a folder track.

When a folder is “closed” this way, the folder part(s) still
give you a graphic representation of the parts and events
within the folder.

A green arrow pointing to a folder appears when you drag the track onto
the folder track in the list.

• In the Track Folding submenu of the Project menu, there
are several options for hiding/showing elements inside
folders. These are described in detail in the section “Track
folding” on page 39.
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Muting and soloing folder tracks

• If there is a gap between parts/events on the tracks,
there will be two separate folder parts.

One of the main advantages of using folder tracks is that
they provide you with a way to mute and solo several tracks
as one unit. Muting and soloing a folder track affects all
tracks in the folder. You can also solo or mute individual
tracks in the folder.

• Parts or events that overlap within the folder may be
represented by the same folder part or by two different
folder parts – depending on how much they overlap.
If a part/event overlaps by half its length or less, it will be placed in a new
folder part.

Muting a folder track
You can mute a folder track (and thereby mute all tracks
within it) the same way you mute other tracks by clicking in
the Mute (“M”) button in the Track list.

The “snare1” event overlaps the
“snare2” event by more than half
its length, which means it is included in the same folder part.

Soloing a folder track

The “bass drum” event does not
overlap with any of the other
events. This means a new folder
part is created.

You can solo a folder track (and thereby mute all tracks
outside the folder, except those already set to Solo) the
same way you solo other tracks, by selecting it and clicking the Solo button.

Handling and editing folder parts

Soloing or muting tracks within a folder

Most of the editing you can do in the Project window applies to folder parts as well.

This can be done by showing the tracks in the folder and
using the Mute and Solo buttons in the Track list as usual
for any tracks inside the folder.

Any Project window editing you perform to a folder part
affects all the events and parts it contains (those elements
on the track within the folder that are represented by the
folder part). You can select several folder parts if you like
– this allows you to handle and edit them together. The
editing you can perform includes:

Working with folder parts
A folder part is a graphic representation of events and
parts on the tracks in the folder. Folder parts indicate the
position and length of the events and parts, as well as on
which track they are (their vertical position). If part colors
are used, these are also shown in the folder part.

• Moving a folder part. This will move its contained events and
parts (possibly resulting in other folder parts, depending on
how the parts overlap).
• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and
parts.
• Splitting a folder part with the Scissors tool (see the example
below).
• Gluing folder parts together with the Glue tube tool. This will
only work if the adjacent folder parts contain events or parts
on the same track.
• Resizing a folder part resizes the contained events and parts
according to the selected resizing method. This is set by clicking the Arrow tool icon on the toolbar and selecting “Normal
Sizing”, “Sizing Moves Contents” or “Sizing Applies Time
Stretch” from the pop-up menu – see “Resizing events” on
page 48. Note that if you select “Sizing Applies Time Stretch”,
any automation data is not taken into account.
• Muting a folder part. This will mute its contained events and
parts.

Folder parts are created automatically when there are
parts or events on the tracks within the folder. The following rules apply:
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An example

Splitting the folder part
with the Scissors tool…

…will split all contained parts or
events present at that position.

Editing tracks within folder parts
Tracks inside a folder can be edited as one entity by performing the editing directly on the folder part containing
the tracks as explained above. You can also edit individual
tracks within the folder by showing the contained tracks,
selecting parts and opening editors as usual.
Double-clicking a folder part opens the editors for the corresponding track classes present in the folder. The following applies:
• All MIDI parts located on the tracks within the folder are
displayed as if they were on the same track, just like when
opening the Key Editor with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each
track a different color in the Project window and use the “Part Colors”
option in the editor (see “Coloring notes and events” on page 370).

• If the folder contains tracks with audio events and/or audio parts, the Sample and/or Audio Part Editors are opened
with each audio event and audio part in a separate window.
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Using markers

About markers

The Marker window columns
The Marker window is divided into six columns which are
used for performing the following operations:

Markers are used to locate certain positions quickly. If you
often find yourself jumping to a specific position within a
project, you should insert a marker at this position. There
are two types of markers:

• The leftmost column is the Locate column.
Clicking in this column will move the project cursor to the corresponding
marker position. A blue arrow indicates the marker at the project cursor
position (or the closest marker before the project cursor).

• Cycle markers allow you to store the start and end positions of
a range.
• Standard markers store a specific position.

• The ID column is used to edit marker ID numbers.
See “About marker ID numbers” on page 111.

Markers can be created and edited in several ways:

• The Position column displays the markers’ time positions (or start positions for cycle markers).

• By using the Marker window (see below).
• By using the Marker track (see “Using the Marker track” on
page 111).
• By using key commands (see “Marker key commands” on
page 113).
• By using the Project Browser (see “Editing markers in the Project Browser” on page 113).

The marker positions can be edited directly in this column.

• The End and Length columns display the end positions
and length of cycle markers – see “About cycle markers”
on page 111.
These values can also be edited directly in the respective column.

• The Description column lets you enter names or descriptions for markers.

Ö The left and right locators are handled separately –
see “The left and right locators” on page 61.

Click on a column heading to sort the marker list by that
column. The Marker columns can also be reordered by
dragging and dropping the column headers.

The Marker window

Adding and removing markers in the Marker window
• You add position markers (in Stop mode, during playback or during recording) by clicking the Add button or by
pressing [Insert] (Windows only) on the computer keyboard. Markers are always added at the current project
cursor position.
• To add a cycle marker, select “Cycle Markers” from the
Show pop-up menu and click the Add button.
This adds a cycle marker between the left and right locator. You can also
draw cycle markers on the Marker track (see “Editing markers on the
Marker track” on page 112).

In the Marker window, you can perform most editing operations concerning markers. The markers are listed in the
Marker window in the order in which they occur in the
project. Most functions in the Marker window are also
available in the Inspector when the Marker track is selected.

• To remove a marker, select it and click the Remove button.
Ö Note that you can assign key commands to various
marker commands in the Key Commands dialog (see
“Marker key commands” on page 113).

To open the Marker window, you can:
• Select “Markers” from the Project menu
• Click the “Show” button in the Marker section on the Transport panel
• Use the key command (by default [Ctrl]/[Command]-[M]).
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Moving marker positions in the Marker window

2. Enter this ID number in the ID column of the marker you
want to access with a key command and press [Enter].

The Move button in the Marker window can be used to
“reprogram” marker positions. Proceed as follows:

The two marker ID numbers are switched, and the key command now
locates to the marker selected in this step.

1. Set the project cursor to the position to which you
want to move (or re-program) a marker.

3. Repeat as necessary for other markers.

2. Select the marker that you want to change in the
Marker window.

• You can also simply remove a marker with an ID number
between 1 to 9 to free up a key – see “Adding and removing markers in the Marker window” on page 110.

Do not select the marker by clicking in the leftmost column, as this will
move the project cursor to this marker.

• For more about marker key commands, see “Marker key
commands” on page 113.

• If a cycle marker is selected, the Move operation affects
the cycle marker start position.

Using the Marker track

The length of the range is not affected.

3. Click the Move button.

Cycle markers

Markers

Locators

You can also move markers by editing their position numerically in the Position column.

About marker ID numbers
Each time you add a marker, it is automatically and sequentially assigned an ID number, starting from ID 1. ID
numbers can be changed at any time – this allows you to
assign specific markers to key commands (see below).

The Marker track is used for viewing and editing markers.
Markers shown on the Marker track are exactly the same
as shown in the Marker window, and any changes made
on the Marker track are reflected in the Marker window
and vice versa. Standard position markers in the Marker
track are shown as marker events: vertical lines with the
marker name (if assigned) and number beside it. If you select the Marker track, all markers are shown in the Inspector, much like in the Marker window.

IDs for cycle markers are shown in brackets and start from
[1]. These may also be changed.
Assigning markers to key commands
As explained above, marker ID numbers are assigned automatically and sequentially each time you add a marker.
The nine first markers (1 to 9) can be recalled by using key
commands – by default these are [Shift]-[1] to [9] on the
typewriter part of the keyboard.

About cycle markers
Cycle markers are shown on the Marker track as two
markers bridged by a horizontal line. Cycle markers are
ideal for storing sections of a project. By setting cycle
markers for sections of a song, for example “Intro”,
“Verse”, “Chorus” etc., this enables you to quickly navigate to the song sections, and also to optionally repeat
the section (by activating Cycle on the Transport panel).

Ö If you have more than nine markers, you cannot use
key commands to navigate to markers numbered 10 or
higher.
If you want to keep all current markers, but want to specify
which markers should be accessed via key commands,
the solution is to reassign the marker ID numbers. Proceed as follows:

In addition, Cycle markers appear on the horizontal Zoom
pop-up menu in the Project window (see below).

1. First decide which of the current markers with an ID
between 1 and 9 you want to reassign to a new ID number,
and thus remove its key command assignment.

Adding the Marker track
To add the Marker track to the Project, select “Marker” from
the Add Track submenu of the Project menu (or right-click
in the Track list and select “Add Marker Track”). You can
only have one Marker track in a project.

Memorize the ID number.
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Editing markers on the Marker track

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting
them and pressing [Delete], using the Erase tool etc.

The following editing functions can be performed directly
on the Marker track:

• Naming markers.

• Adding position markers “on the fly”.

A selected marker’s name can be edited on the info line.

Use the [Insert] key (Win) or the “Add Marker” button in the Track list for
the Marker track to add position markers at the current cursor position
during playback.

Navigating using cycle markers
Cycle markers represent ranges rather than single positions. Therefore you don’t use them for moving the project
cursor, but for moving the left and right locators:
• If you double-click on a cycle marker or select it from
the Cycle pop-up menu in the Track list, the left and right
locators are moved to encompass the cycle marker.

Add Marker/Add Cycle Marker buttons

• Adding a cycle marker at the left and right locator positions.

To move the project cursor position to the start or the end of the cycle
marker, move it to the corresponding locator (e.g. by using the numeric
pad keys [1] and [2]).

Clicking the “Add Cycle Marker” button in the Track list for the Marker
track adds a cycle marker spanning the area between the left and right
locator.

• You can also use key commands for this – see “Marker
key commands” on page 113.

• Selecting markers.
You can use standard selection techniques like dragging to make a selection rectangle, or use [Shift] to select separate markers.

Zooming to cycle markers
• By selecting a cycle marker on the Zoom pop-up menu,
the event display is zoomed in to encompass the selected
range only (see the section “Zoom presets and Cycle markers” on page 36).

• Drawing position markers.
By using the Pencil tool (or pressing [Alt]/[Option] and using the Arrow
tool), you can create or “draw” position marker events at any position on
the track. If snap is activated on the toolbar, this determines at which positions you can draw markers.

You can also do this by pressing [Alt]/[Option] and double-clicking on
the cycle marker in the event display.

• Drawing cycle markers.

Editing cycle markers using tools

To draw a cycle marker range, press [Ctrl]/[Command] and use the Pencil tool or the Arrow tool. Snap settings are applied if activated.

Cycle markers can be edited on the Marker track using the
following tools (Snap applies as usual):
Tool

Use

Pencil

Press [Ctrl]/[Command] and use the Pencil tool to create
new cycle markers (as described above).

Eraser

Click with the Eraser tool to delete a cycle marker. If you
hold down [Alt]/[Option] when you click, all consecutive
markers will also be deleted.

Selection
Range

This is described in the following section.

Ö Cycle markers can freely overlap.
• Resizing a cycle marker.
Select a cycle marker by clicking on it. Two handles appear at the bottom
of the start and end events. If you click and hold one of the handles you
can drag the event left or right to resize the cycle marker. This can also
be done numerically on the info line.

The other tools cannot be used with cycle markers.

• Moving markers.
Click and drag to move the selected markers or edit marker positions on
the info line. As usual, snap is taken into account if activated.
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Using markers to make range selections in the
Project window

Operation

Description

Default key

Set Marker 1-9 Moves the specified marker (number 1 [Ctrl]+[1] to [9]
to 9) to the current project cursor position.

Besides enabling you to quickly move the project cursor
and the locators, markers can be used in conjunction with
the Range Selection tool to make range selections in the
Project window. This is useful if you quickly want to make
a selection that spans all tracks in the project.

Recall Cycle
Marker 1-9

Moves the left and right locators to
[Shift]+[Pad1] to
encompass the specified cycle marker [Pad9]
(1 to 9).

If you need to check or change any key command assignments, the marker commands can be found in the Transport category in the Key Commands dialog.

• Double-click with the Range Selection tool between any
two markers – this creates a selection range between the
markers, spanning all tracks in the project (just as if you had
used the Range Selection tool to draw a rectangle).

Ö For the [Shift]+[Pad1] to [Pad9] commands to work,
Num Lock must be deactivated on the computer keyboard!

Any functions or processing you perform now will affect the selection only.

Moving and copying sections
This is a quick way to move or copy complete sections of
the project (on all tracks):

Editing markers in the Project
Browser

1. Set markers at the start and end of the section you
want to move or copy.

!

2. Select the Range Selection tool and double-click on
the Marker track between the markers.

To view and edit markers in the Project Browser, the
Marker track must be added to the Project window.

If you have a Marker track in the Project window, you can
create and edit all marker parameters, including marker
IDs, in the Project Browser. Proceed as follows:

Everything in the project within the cycle marker boundaries is selected.

3. Click on the Marker track in the selected range and
drag the range to a new position.
The selection in the Project window is moved to the same position.

1. Open the Project Browser by selecting it from the
Project menu.

• If you hold down [Alt]/[Option] while you drag the range,
the selection in the Project window is copied instead.

2. Select “Marker” in the Project Structure window.
A list of the markers is shown in the main Browser window.

3. Now you can edit marker names, positions and ID
numbers by selecting an item and typing in values as usual
in the main editor window.

Marker key commands
You can use key commands for the following marker operations:
Operation

Description

Default key

Insert Marker

Creates a new marker at the current
project cursor position.

[Insert]
(Windows only)

Locate Next
Marker

Moves the project cursor to the right to [Shift]+[N]
the next marker position (if any).

Locate Previous Moves the project cursor to the left to
Marker
the previous marker position (if any).
To Marker 1-9

For details about editing in the Project Browser see “Editing the Marker
track” on page 433.

• You can use the Add pop-up menu in combination with
the Add button to insert new markers or cycle markers
when the Marker track is selected in the Project Browser.
This works just like the Add button in the Marker window (see “Adding
and removing markers in the Marker window” on page 110).

[Shift]+[B]

Moves the project cursor to the speci- [Shift]+[1] to [9]
fied marker (number 1 to 9).
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The Transpose functions

Introduction

Transposing your music

Nuendo offers transpose functions for audio, MIDI and instrument parts and for audio events. These allow you to
create variations of your music or change the harmonics of
an entire project or separate sections.

In the following sections we will describe the different
possibilities of transposing your music. Note that these
can also be combined. However, we recommend you to
set the root key first, before recording or changing transpose values on the transpose track.

Transpose can be applied on three levels:

!

• On the entire project
By changing the project Root Key in the Project window toolbar, the
whole project will be transposed (see “Transposing an entire project with
the Root Key” on page 115).

Transposing an entire project with the Root Key

• On sections of the project
By creating Transpose events on the Transpose track you can set transpose values for separate sections of your project (see “Transposing separate sections of a project using Transpose events” on page 118).

The root key you specify for a project will be the reference
that audio or MIDI events in your project will follow. You can
of course exclude separate parts or events from being
transposed, e.g. drums or percussion (see “The Global
Transpose setting” on page 119).

• On individual parts or events
By selecting individual parts or events and changing their transpose
value in the info line, you can transpose individual parts or events (see
“Transposing individual parts or events using the info line” on page 118).
!

As a general rule, you should always set the root key
first when you work with content with a defined root
key.

Depending on whether you are using events which already contain root key information or not, the procedures
differ slightly:

The transpose functions do not change the actual
MIDI notes or the audio, but only affect the playback.

If the events already contain root key information

Apart from the transpose features described in this chapter, you can also transpose all MIDI notes on the selected
track using the MIDI modifiers (see “Transpose” on page
346), selected notes using the Transpose dialog (see
“Transpose” on page 357), and MIDI tracks using MIDI effects (see the separate manual “Nuendo Expansion Kit –
Cubase Music Tools for Nuendo 4”).

Let’s say you want to create a project based on loops.
Proceed as follows:
1. Open the Mediabay and drag some loops into an empty project, see “Browsing for media files” on page 316.
For this example, import audio loops with different root keys.
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2. Now, open the Root Key pop-up menu in the Project
window toolbar and set the project root key.

If the events do not contain root key information
Let’s say you have created a project by recording audio
and importing some MIDI loops, and you want to match
the root key of the whole project to the register of a certain
singer.

The entire project will be played back with this root key. Note that by default, the project root key is not specified (“-”).

Proceed as follows:
1. In your project, open the Project menu and select
“Transpose” from the Add Track submenu (or right-click in
the Track list and select “Add Transpose Track”) to add the
Transpose track.
You can only have one Transpose track in a project.

2. Set the project to the desired root key by selecting the
corresponding option from the Root Key pop-up in the
Project window toolbar.
3. Right-click in the Track list for the Transpose track and
select “Set root key for unassigned events” from the context menu.

A loop-based project with different event root keys

The separate loops will be transposed in order to match
the project root key. If you e.g. have imported a bass loop
in C and the project root key is set to E, the bass loop will
be transposed up by 4 semitones.

This sets the project root key for all unassigned parts or events. You can
undo this command by selecting Undo from the Edit menu. The “Set root
key for unassigned events” option is only available, if a project root key
has been set.

3. Now (with the root key set), record audio or MIDI.
The recorded events will get the project root key.

4. When you are done and satisfied with the result, you
can change the project root key and your events will follow.
!

!

If you work with drums or percussion, you should exclude these from being transposed by setting the
“Global Transpose” setting on the info line to “Independent” (see “The Global Transpose setting” on
page 119).

If you work with drums or percussion, you should exclude these from being transposed by setting the
“Global Transpose” setting on the info line to “Independent” (see “The Global Transpose setting” on
page 119).
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To check the root key setting of a MIDI part, proceed as
follows:

Recording with a project root key
Let’s say that you want to record a guitar line for a project
that is in D# minor, but your guitar player prefers to play A
minor and G major. In this case, you can change the
project root key to A, so that you can record your guitar.
Proceed as follows:

1. Select your MIDI part in the Project window and check
the Project window info line.

1. Open your project and set the project root key to A.
All parts and events will be transposed in order to match the root key.

2. Listen to your project and verify that no drums and
percussions have been transposed.

A MIDI part with a root key set to “E”

If drums have been transposed, select them and set their Global Transpose setting to “Independent”.

2. Click on the root key value in the info line to open the
Root key pop-up menu in the Project window info line and
select the desired root key.

3. Record your guitar line as desired.
4. When you are done and you are satisfied with the result, you can change the project root key back to D# minor and your events will follow.
!

!

For recorded audio events and MIDI parts, the “Global
Transpose” setting on the info line ist automatically set
to “Follow”, i.e. the events or parts will get the project
root key.

If you change the project root key after setting the
event root key, the events will keep their own root key
settings, and will be transposed to match the project
root key. If you record an audio or a MIDI part and the
project root key is specified, this root key is automatically set.

Changing the Root key of single events or parts
If you want to check if an audio event or part has root key
information or if you want to change it, proceed as follows:
1. Open the Pool and display the Key column by selecting “Root Key” from the “View/Attributes” pop-up menu in
the Pool.

An audio event with a root key set to “C”

2. Click in the Root Key column for the desired audio
event and set the key according to your needs.
You can also check and assign Root Keys in the MediaBay.

Ö If you change the root key of an audio part or event,
the corresponding audio file will not change. To save the
Root Key setting in the audio file, you have to use the
“Bounce Selection” function from the Audio menu.
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Transposing separate sections of a project
using Transpose events

4. Click in the transpose value field and enter the transpose value for the transpose event.
You can enter the desired value with the computer keyboard, use the
mouse wheel or [Alt]/[Option]-click on the transpose value to open a
value fader. You can specify values between -24 and 24 semitones.

Sometimes you may want to transpose only certain sections of your project, e.g. to create harmonic variations.
This can be done by creating transpose events. Transpose events allow you to add a relative transpose offset by
specifying transpose values in semitones. You can e.g.
brighten up your loops in C major by transposing them by
5 semitones, so that the subdominant on F major is played
back, or you can turn your hit more interesting by transposing the last chorus one semitone upwards.

If you move the mouse over the transpose event, the cursor turns into a
hand symbol. This indicates that you can use the mouse wheel to
change the value.

1. In your project, open the Project menu and select
“Transpose” from the Add Track submenu (or right-click in
the Track list and select “Add Transpose Track”) to add the
Transpose track.

5. Play back your project.
The parts of your project on the same position as the transpose events
will be transposed according to the specified transpose values.

You can only have one Transpose track in a project.

Ö You can also transpose the whole project by means of
the transpose track. This is useful e.g. if your singer does
not reach a certain pitch. In this case you can transpose
your whole project by e.g. -2 semitones. Always remember to verify that the “Global Transpose” setting for drums
and percussion is set to “Independent” on the info line
(see “The Global Transpose setting” on page 119).

2. Select the Pencil tool from the toolbar and click in the
Transpose track to create a transpose event.
A transpose event will be created from the point where you clicked until
the end of the project.

You can erase and move transpose events, but you can
not mute, cut or glue them. The option “Locators to Selection” does not apply on transpose events.

Transposing individual parts or events using
the info line

3. To create another transpose event, click with the pencil tool on the first transpose event.

You can also transpose individual audio and MIDI parts and
events via the Info line (or the Inspector). This transposition
will be added to the global transposition (i.e. the root key or
the transpose events). Proceed as follows:

By default, the transpose value of new transpose events is set to 0.

1. Select the event that you want to transpose.
2. In the Project window info line, adjust the Transpose
value as desired.
Ö A global transpose change will not overwrite individual
part or event transpose, but will be added to the transpose value for the part or event. In this case, it might be
useful to keep the transposition within the octave range
(see “Keep Transpose in Octave Range” on page 120).

You can add more transpose events by clicking with the pencil tool.
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Other functions

The Global Transpose setting
If you are working with drum and percussion loops or with
special effects (FX) loops, you normally want to exclude
these events from being transposed. This can be achieved
by locking them using the Global Transpose setting. Proceed as follows:

Indicate Transpositions
When you transpose your music, you may sometimes
want to visually compare the original sounds and the
transposed music. For MIDI parts, you can check this by
opening the Key Editor and clicking the “Indicate Transpositions” button. This will help you see how your MIDI notes
will be transposed. If the button is activated, the Key Editor will show the note pitch you will hear, if it is deactivated, the Key Editor shows the original pitch of the notes
in your MIDI part. By default, the “Indicate Transpositions”
button is deactivated.

1. Open your project.
2. Select the desired event or part and set the “Global
Transpose” setting on the info line to “Independent”.
A symbol will be displayed in the upper right corner of the selected part
or event. This indicates that the part or event will not be transposed neither by changing the root key nor by specifying transpose events.

If Global Transpose is set to Independent, the selected part will not be
transposed.

3. You can now change the project root key.
The “Independent” parts or events will not be affected by the root key
changes.

Ö If you import ready-made parts or events that are
tagged drums or FX, Global Transpose will be automatically
set to Independent.

A MIDI part as originally recorded.

If you record audio or MIDI, Global Transpose will be set to
“Independent”, if the transpose track exists and you have
specified at least one transpose event (even when the
transpose value is not defined). In this case, your recording
will sound exactly the way you played it. The transpose
events will not be taken into account during recording and
the recorded event will not get the project root key. Have a
look at the following example:
1. Set up a project with the root key in C.
2. Add a transpose track and enter transpose events
with the values 0, 5, 7 and 0.
3. Record some chords with your MIDI keyboard. For our
example, record C, F, G and C.

When you activate “Indicate Transpositions” you will see how your MIDI
part will be transposed.

The transpose events are not taken into account and the result of your
recording will be C, F, G and C. The root key will be not set.
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Ö You will get exactly what you have recorded, i.e. when
your record C, F, G and C this will be played back exactly
as you recorded it. This is because the recorded event is
“Independent” from Global Transpose.

2. Add a transpose track and create a transpose event.
By default, the transpose value is set to 0.

If no transpose track exists or if no transpose event has
been added, Global Transpose will be set to Follow.

If Global Transpose is set to Follow, the selected part will follow all global transpositions.

The Edit Lock on the Transpose track
If you want to prevent your transpose events from being
changed by mistake, you can activate the Lock button on
the transpose track. This way, you will not be able to move
your transpose events or change their transpose values.

Mute transpose events
Sometimes it might be useful to disable the transpose
track, e.g. to hear the original sound of individual tracks. If
you activate the mute button on the transpose track, your
transpose events will not be taken into account during
playback.

3. Make sure that the “Keep Transpose in Octave
Range” button is activated on the transpose track and
change the transpose value of the transpose event.
Your chord will be transposed upwards or downwards according to the
entered values.

Keep Transpose in Octave Range
The “Keep Transpose in Octave Range” button on the
transpose track (the button with an up and down arrow in
brackets) keeps the transposition in the octave range. This
option is activated by default. This way, nothing will be
transposed by more than seven semitones. This ensures
that your music never sounds unnatural because the pitch
was raised too high or too low.
To understand the principle behind this, follow the example below:
1. Create a MIDI part, enter a C major chord, open the key
editor and activate “Indicate Transpositions”.
This way you can observe and understand what happens, when you
change the tranposition.
If you enter a transpose value of 7, your chord will be transposed by
seven semitones upwards. In this example, this would be G3/B3/D4.
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4. Set the transpose value to 8 semitones.
As “Keep Transpose in Octave Range” is activated, your chord will now
be transposed to the nearest interval or pitch.

Your chord has been transposed to the nearest pitch, this results in
G#2/C3/D#3.
!

If you mainly work with audio loops, we recommend
to activate “Keep Transpose in Octave Range”.
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11
The mixer

About this chapter
This chapter contains detailed information about the elements used when mixing audio and MIDI, and the various
ways you can configure the mixer.
Some mixer-related features are not described in this
chapter. These are the following:
• Setting up and using audio effects.
See the chapter “Audio effects” on page 168.

• Setting up and using MIDI effects.
See the chapter “MIDI realtime parameters and effects” on page 342.

• Surround Sound.
See the chapter “Surround sound” on page 202.

• Automation of all mixer parameters.
See the chapter “Automation” on page 213.

• How to mix down several audio tracks (complete with
automation and effects if you wish) to a single audio file.
See the chapter “Export Audio Mixdown” on page 437.
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Overview

The picture shows an extended mixer (see “Normal vs. Extended channel strips” on page 126).

• By clicking the Mixer button in the Devices panel.

The mixer offers a common environment for controlling
levels, pan, solo/mute status etc. for both audio and MIDI
channels.

You open the Devices panel by selecting Show Panel from the Devices
menu.

Opening the mixer

About the multiple mixer windows

The mixer can be opened in several ways:

You may have noticed that there are in fact several separate
mixer items selectable from the Devices menu. These are
not separate mixers, but rather separate views of the same
mixer.

• By selecting Mixer from the Devices menu.
• By clicking the Mixer icon on the toolbar
This always opens the first Mixer window (see below).

• Each of the mixer windows can be configured to show
any combination of channels, channel types, narrow and
wide channel strips, etc. (how to do this is described later
in this chapter).
You can for example configure one mixer window to show MIDI channel
strips, another to show input and output channels or another to show all
audio-related channels.

• By using a key command (by default [F3]).
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The order of audio, MIDI, instrument, group and effect return channel strips (from left to right) in the mixer corresponds to the Project window Track list (from the top
down). If you reorder tracks of these types in the Track list,
this will be mirrored in the mixer.
In addition to the above, the following channel types are
also shown in the mixer:
• Activated ReWire channels (see the chapter “ReWire” on
page 482).
• VST Instrument channels (see the chapter “VST Instruments
and Instrument tracks” on page 189).
ReWire channels cannot be reordered and always appear
to the right of other channels in the main mixer pane (see
below). VST instrument (VSTi) channels can be reordered
in the Track list which will in turn be mirrored in the mixer.
Folder, Marker, Video and Automation tracks are not
shown in the mixer.
• You can also save channel configurations as View sets
(see “Channel view sets” on page 129), which are then
accessible from all mixer windows.

Input and output busses in the mixer
Input and output busses are represented by input and output channels in the mixer. They appear in separate “panes”
separated by movable dividers and with their own horizontal
scrollbars, see “The input and output channels” on page
132.

These features are very convenient when working with
large projects. Considering the number of different channel types that can be shown in the mixer, they could even
be described as necessary!
The use of multiple mixer windows combined with the ability to recall different mixer configurations enables you to
focus on the task at hand and keep window scrolling
down to a minimum.

About multichannel audio
Nuendo has full support for surround sound. Each audio
channel and bus in the mixer can carry up to 12 speaker
channels. This means that if you have an audio track configured for 5.1 surround sound, for example, it will have a
single channel strip in the mixer, just like mono or stereo
tracks, but its level meter will have six meter bars, one for
each speaker channel.

Ö All options for configuring the mixer described in this
chapter are identical for all mixer windows.

What channel types can be shown in the mixer?

Another thing to note is that the look of a channel strip differs slightly depending on how it is routed – mono or stereo
tracks routed to a surround output bus will have a surround
panner control instead of a regular pan control, for example.
For further information on multichannel audio, see the chapter “Surround sound” on page 202.

The following track-based channel types are shown in the
mixer:
• Audio
• MIDI
• Effect return channels (referred to as FX channels in the
Project window)
• Instrument channels (VSTi Return)
• Group channels
• Instrument tracks
• ReWire channels
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Configuring the mixer

The fader panel shows the basic controls – faders, pan
controls and an associated vertical row of buttons. The extended panel can be set to show EQ, effect sends, insert
effects, etc. The input/output settings panel contains input
and output routing pop-up menus (where applicable),
along with input phase switches and input gain controls.

As mentioned earlier, the mixer windows can be configured in various ways to suit your needs and to save screen
space. Here follows a run through of the various view options (the following descriptions assume that you have an
active project containing some tracks):

A fully extended channel strip
with the input/output routing
section at the top.

Normal vs. Extended channel strips
You have the option of selecting normal or extended channel strips and whether to show the input and output settings at the top of the channel strips. Proceed as follows:
1. Open any of the mixer windows.
The leftmost strip is called the common panel and is always shown in the
mixer. It contains various global settings and options relating to the mixer.
For further information, see “The common panel” on page 131.

A basic channel strip with no
extended options.

2. Click on the arrow button on the common panel
(“Show Extended Mixer”) or right-click in the Mixer to
open the Mixer context menu and select “Show Extended
View” from the Window submenu.
You can also use a key command for this. See the chapter “Key commands” on page 517.
Opening the Extended Mixer via the Mixer Common panel…

Selecting what to display in the extended
channel strips

…and via the Mixer context menu.

You can select what to display in the extended channel
strip either globally from the common panel or individually
from each channel strip.
The available options vary depending on the type of channel.
• For a description of the options for audio channels, see “Options for the extended audio channel strip” on page 136.
• For a description of the options for MIDI channel, see “Selecting
what to show in the extended MIDI channel strip” on page 144 .

3. You can show or hide the Routing panel of the channel strips by clicking on the respective arrow button
(“Show Routing”) or by selecting “Show Routing View”
from the Window submenu on the Mixer context menu.
The fader panel is always shown.
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Selecting globally from the common panel

Selecting for individual channels

1. Open any of the mixer windows.

Each channel strip in the mixer features a View options
pop-up menu, which is used for two things:

The leftmost strip is called the common panel and is always shown in the
mixer. It contains various global settings and options relating to the mixer.
For more information, see “The common panel” on page 131.

• To determine what is shown in the extended panel for
individual channels in the mixer.

2. Make sure that the extended panel of the mixer is visible.

• To set the “Can Hide” status for individual channels in
the mixer.

In the extended area of the common panel, you can see a
vertical row of icons. These act as buttons and determine
globally what is displayed in the extended panel for all
channel strips in the mixer.

This is described in the section “Showing/hiding individual channels (the
“Can Hide” setting)” on page 128.

The View options pop-up is opened by clicking the down
arrow located just above the fader panel of the channel
strip.

Clear all views (blank panels)
Show all Inserts
Show all Equalizers
Show all Equalizers with curve

Show all Sends
Show Sends 1-4
Show Sends 5-8
Show Studio Sends

• To select what to display in the extended panel from the
View options pop-up menu, you must first open the extended mixer.

Show Surround Panners (where applicable)
Show all Meters

You can then use the pop-up to select which parameters to show in the
extended panel for each individual channel in the mixer.

Show Channel Overview

If you place the pointer on an icon, a tooltip appears.

3. Click on the “Show all Inserts” button (second icon
from the top).
Now all channel strips in the mixer will show Insert effect slots in the extended panel.

• As mentioned above, what can be set globally depends
on the type of channel.
Channel types that do not support a selected global option will be unaffected.

• If you press [Alt]/[Option] and click one of the global
view buttons, input and output channels will be affected
as well.
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Setting the width of channel strips
!

Selecting what channel types to show/hide
You can specify what channel types to show or hide in the
mixer. In the lower part of the common panel you find a
vertical strip with different indicator buttons. Each indicator represents a channel type to show or hide in the mixer:

Each channel strip can be set to either “Wide” or
“Narrow” mode by using the Channel Narrow/Wide
button on the left above the fader strip.

“Command Target” options – see “About
the Command Target” on page 129.
“Can Hide” options – see below.

Input Channels
Audio Channels
Group Channels
The Channel Narrow/Wide button

ReWire Channels

• Narrow channel strips contain a narrow fader, miniature
buttons, and the View options pop-up.

MIDI Channels
VST Instrument Channels

If you have selected to show parameters in the extended section, only the
channel overview or the Meter can be shown in narrow mode. (The parameters will be shown again when you return to wide mode.)

Effect Return Channels
Output Channels
Reveals all channel strips

• To hide or show a channel type, click the corresponding
indicator.
If an indicator is dark, the corresponding channel type will be shown in
the mixer. If it is orange, the corresponding channel type will be hidden.

Showing/hiding individual channels (the “Can
Hide” setting)
You can also show/hide individual channels of any type in
the mixer. For this, you can assign channels a “Can Hide”
status, which allows you to hide these channels collectively. Proceed as follows:
1. Pull down the View options pop-up menu for the channel you want to hide and activate the “Can Hide” option.
If “Can Hide” is activated for a channel strip, the corresponding icon (/)
will be visible in the top middle section of the channel strip.

Wide and narrow channel strips

• When selecting “All targets narrow” or “All targets
wide” on the common panel, all channel strips selected as
command targets (see “About the Command Target” on
page 129) are affected.
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3. A dialog appears, allowing you to enter a name for the
view set.

2. Repeat this for all channels you want to hide.
3. Click the top “hide button” (Hide Channels set to
“Can Hide”) on the common panel.

4. Click OK to store the current mixer view set.

This hides all channels set to “Can Hide”. To show them again, click the
Hide button again or click the button at the bottom on the common panel
(“Reveal All Channels”).

• You can now return to this stored configuration at any
time, by clicking the “Select Channel View Set” button
(the down arrow to the left of the “Store View Set” button)
and selecting it from the pop-up menu.

Below the top hide button, there are three additional “Can
Hide” buttons.

• To remove a stored channel view set, select it and click
the “Remove View Set” button (the minus sign).
!

Option

Some remote control devices (such as Steinberg’s
Houston) feature this function, which means that you
can use the remote device to switch between the
channel view sets.

Description

About the Command Target

Set Target Channels This activates “Can Hide” for all Channels you specto ’Can Hide’
ified as “Command Targets”. For more information,
see below.

Command targets let you specify which channels should
be affected by the “commands” (basically all the functions
that can be assigned key commands) when working with
the Mixer, e.g. what to display in the extended mixer, the
width setting of the channel strips, etc. You can set command targets using the Mixer common panel or the context menu.

Remove ’Can Hide’ This deactivates “Can Hide” for all Channels you
from Target
specified as “Command Targets”. For more informaChannels
tion, see below.
Remove ’Can Hide’ This deactivates “Can Hide” for all Channels in the
from All Channels
Mixer.

Channel view sets

The Command Target Controls
on the common panel

Channel view sets are saved configurations of the mixer
windows, allowing you to quickly switch between different
layouts for the mixer. Proceed as follows:
1. Set up the mixer the way you wish to store it as a view
set.

The Command Target
submenu in the Mixer
context menu

The following settings will be stored:

• Settings for individual channel strips (e.g. narrow or wide mode
and whether the channel strip is (or can be) hidden or not).
• The hide/show status for channel types.
• The mixer’s display status (fader panel, extended panel, input/
output panel).
• Settings for what is shown in the extended view of the mixer.

The following options are available:
• All Channels
Select this if you want your commands to affect all channels.

2. Click the “Store View Set” button (the plus sign) at the
bottom of the (non-extended) common panel.

• Selected Only
Select this if you want your commands to affect the selected channels
only.

• Exclude Inputs
Select this if you don’t want your commands to affect the input channels.

• Exclude Outputs
Select this if you don’t want your commands to affect the output channels.
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The audio-related channel strips
Channel input/
output routing

Channel View
options pop-up

The speaker configuration for
the channel

The Can Hide State
for the channel

Input Gain control

Input Phase switch
Narrow/Wide button
Pan control
Level fader
Level meter
Listen button (see the chapter
“Control Room” on page 151)
Edit button (opens the
Channel Settings window)

Channel name

Record Enable and
Monitor buttons
The common panel
(see “The common
panel” on page 131)

Channel automation controls

Insert/EQ/Send indicators and
bypass buttons (see below)

Opens the control panel for the VST Instrument

About the Insert/EQ/Send indicators and bypass
buttons

The mixer in normal mode (faders and Routing View visible), showing
(from left to right): the common panel, a stereo audio channel, a group
channel, an instrument channel, an effect return channel and a VST Instrument channel strip.

All audio-related channel types (audio, instrument track,
input/output channels, group, effect return, VST Instrument and ReWire) basically have the same channel strip
layout, with the following differences:

The three indicator buttons in each audio channel strip
have the following functionality:

• Only audio track channels have an Input Routing pop-up menu.
• Only audio and instrument track channels have a Monitor and
Record Enable button.
• Input/output channels do not have sends.
• Instrument track and VST Instrument channels have an additional button for opening the instrument’s control panel.
• Input channels and output channels have clip indicators.

• If an Insert or Send effect or an EQ module is activated
for a channel, the corresponding button is lit.
The effect indicators will be blue, the EQ indicator will be green.

• If you click these buttons when lit, the corresponding
EQ or effects section will be bypassed.
Bypass is indicated by yellow buttons. Clicking the button again deactivates bypass.
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The MIDI channel strips
This opens the
control panel for
a connected VST
Instrument
Input Transformer
button
Channel Narrow/
Wide button

The common panel
The common panel appears to the left in the mixer windows
and contains settings for changing the look and behavior of
the mixer, as well as global settings for all channels.

MIDI input pop-up
MIDI output pop-up
MIDI channel pop-up
Can Hide State

Shows/hides the
Routing panel

Pan control

Mute and Solo
Channel automation
controls

The View options buttons
determine what to display
in the extended panels of
channel strips. Only visible
in extended mixer mode.

Level (velocity) meter

Edit button
Insert/Send indicators
and Bypass buttons

Monitor and Record
Enable buttons

Buttons for showing/
hiding the extended
panel

Toggles “All Wide”
(left arrows) or “All
Narrow” channel
strips in the mixer.

Global Mute, Solo
and Listen buttons

Command Target settings,
see “About the Command
Target” on page 129.

Level fader
(MIDI volume)

The MIDI channel strips allow you to control volume and
pan in your MIDI instrument (provided that they are set up to
receive the corresponding MIDI messages). The settings
here are also available in the Inspector for MIDI tracks.

Global automation
Read/Write buttons
Resets the settings
to default (for all or
selected channels).
Channel settings copy/
paste, see “Copying
settings between audio
channels” on page 141.
Opens the VST Connections window, see
“The VST Connections
window” on page 12.
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“Can Hide” settings, see
“Showing/hiding individual
channels (the “Can Hide”
setting)” on page 128.
These indicator buttons select what channel types are shown/
hidden in the mixer.

Store/Remove View set buttons (+/-) and Select View
set pop-up, see “Channel
view sets” on page 129.

The input and output channels

Basic mixing procedures

The busses you have set up in the VST Connections window are represented by input and output channels in the
mixer. These are shown in separate “panes” (to the left
and right of the regular channel strips, respectively), with
their own dividers and horizontal scrollbars. The i/o channel strips are very similar to other audio channels and are
identical for input and output channels (except that input
channels don’t have Solo buttons or Sends).

Setting volume in the mixer

The Speaker configuration for the bus.

Input Phase switch
Mute and Listen
buttons
(the Output bus
also features a
Solo button)

In the mixer, each channel strip has a fader for volume
control.
• For audio channels, the faders control the volume of the
channels before they are routed directly or via a group
channel to an output bus.
Each channel can in turn handle up to 12 speaker channels – see “Surround sound in Nuendo” on page 203.

Input gain

• An output channel fader determines the master output
level of all audio channels routed to that output bus.
Pan control (no
Panner used for
surround busses)

• MIDI channels handle fader volume changes in the mixer
by sending out MIDI volume messages to the connected instrument(s).

Bus volume fader

Connected instruments must be set to respond to MIDI messages (such
as MIDI volume in this case) for this to function properly.

Bus level meter

• The fader settings are displayed numerically below the
faders, in dB for audio channels and in the MIDI volume 0
to 127 value range for MIDI channels.

Read/Write
Automation

You can click in the fader value fields and enter a volume setting by typing.

• To make fine volume adjustments, hold down [Shift]
when you move the faders.

Edit button
Inserts and EQ
indicators and
Bypass buttons

• If you hold down [Ctrl]/[Command] and click on a fader,
it will be reset to its default value, i.e. 0.0 dB for audio
channels, or MIDI volume 100 for MIDI channels.

Clip indicator, see
“Setting input levels” on page 69.

This reset to default values works for most mixer parameters.

You can use the faders to set up a volume balance between the audio and MIDI channels and perform a manual
mix by moving the faders and other controls while playing
back. By using the Write function (see “Enabling and
disabling the writing of automation data” on page 214),
you can automate the levels and most mixer actions.

• For information on how to set up input and output busses, see “VST Connections: Setting up input and output
busses” on page 10.
• How to route audio channels to busses is described on
“Routing audio channels to busses” on page 143.

!

• If the Control Room is disabled (see the chapter “Control Room” on page 151), the Main Mix (the default output)
bus is used for monitoring. For information about Monitoring, see “About monitoring” on page 17.
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It is also possible to create volume envelopes for
separate events in the Project window or Audio Part
Editor (see “Event Envelopes” on page 97) or to
make static volume settings for an event on the info
line or with the volume handle (see “About the volume handle” on page 88).

domain, the maximum level is 0dB – higher levels will cause
the clip indicator for each bus to light up.

About the level meters for audio channels
When playing back audio in Nuendo, the level meters in
the mixer show the level of each audio channel.

If the clip indicators light up for a bus, this indicates actual clipping – digital distortion which should always be avoided.

• Directly below the level meter is a small level readout –
this shows the highest registered peak level in the signal.

!

Click this to reset the peak levels.

• Peak levels can also be shown as static horizontal lines
in the meter, see “Changing the meter characteristics” on
page 141.

If the clip indicator lights up for an output channel,
reset the clip indicator by clicking on it, and lower the
level until the indicator doesn’t light up.

Adjusting Input Gain

If the peak level of the audio goes above 0dB, the numerical level indicator will show a positive value (i.e. a value
above 0dB).
Nuendo uses 32 bit floating point processing internally, so
there is virtually limitless headroom – signals can go way
beyond 0dB without clipping. Therefore:

Each audio channel and input/output channel features an
Input Gain control. This controls the gain for the incoming
signal, before EQ and effects.

Ö Having higher levels than 0dB for individual audio
channels is not a problem in itself. The audio quality will
not be degraded by this.

The Input Gain is not meant to be used as a volume control in the mixer, as it is not suited for continuous level adjustments during playback. It can, however, be used to cut
or boost the gain in various circumstances:

However, when many high level signals are mixed in an output bus, this
may require that you lower the output channel level a lot (see below).
Therefore it’s good practice to keep the max levels for individual audio
channels roughly around 0dB.
!

• To change the level of a signal before the effects section.
The level going into certain effects can change the way the signal is affected. A compressor, for example, can be “driven” harder by raising the
Input Gain.

When Direct Monitoring is used and the option “Map
input bus metering to Audio track (in Direct Monitoring)” is activated in the Preferences (VST–Metering
page), the level meters in the mixer will show the level
of the input bus instead.

• To boost the level of poorly recorded signals.

For the input and output channels, things are different. I/O
channels have clip indicators.

To change the Input Gain, you need to press [Shift] and
adjust the control (to avoid accidental gain changes). If
you press [Alt]/[Option], you can adjust the Input Gain
with a fader. Alternatively, you can also enter the desired
number in the value field.

• When you are recording, clipping can occur when the
analog signal is converted to digital in the audio hardware.

Input Phase switch

About the level meters for input and output channels

It’s also possible to get clipping in the signal being recorded to disk
(when 16 or 24 bit record format is used and you have adjusted the mixer
settings for the input channel). For more about checking and setting input levels, see “Setting input levels” on page 69.

• In the output busses, the floating point audio is converted
to the resolution of the audio hardware. In the integer audio

Each audio channel and input/output channel has an Input
Phase switch, to the left of the Input Gain control dial.
When activated, the phase polarity is inverted for the signal. Use this to correct for balanced lines and mics that
are wired backwards, or mics that are “out of phase” due
to their positioning.
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• Phase polarity is important when mixing together two
similar signals.

• [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel.

If the signals are “out of phase” with respect to one another, there will be
some cancellation in the resulting audio, producing a hollow sound with
less low frequency content.

In this mode the channel will not be muted if you solo another channel. To
turn off Solo Defeat, [Alt]/[Option]-click the Solo button again.

About level meters for MIDI channels
The level meters for MIDI channels do not show actual volume levels. Instead, they indicate the velocity values of the
notes played back on MIDI tracks.

[Alt]/[Option]-click a Solo button…

About MIDI tracks set to the same MIDI channel and
output

• You can un-mute or un-solo all channels by clicking the
Mute or Solo indicator on the common panel.

If you have several MIDI tracks set to the same MIDI channel (and routed to the same MIDI output), making volume
and pan settings for one of these MIDI tracks/mixer channels will also affect all other mixer channels set to the
same MIDI channel/output combination.

…to activate Solo Defeat
for that channel.

Listen Mode

Using Solo and Mute

The Listen button for a channel strip and the global Listen button on the
Common panel

Clicking the Listen button for a channel routes that channel to the Control Room without interrupting the normal
signal flow. The following applies:
The Mute (top) and Solo buttons.

• When the channel is set to after-fader (also referred to
as post-fader), the signal being routed to the Control
Room channel will come after the fader and pan controls
of the Listen-enabled channel.

You can use the Mute and Solo buttons to silence one or
several channels. The following applies:
• The Mute button silences the selected channel.
Clicking the Mute button again un-mutes the channel. Several channels
can be muted simultaneously. Muting Group channels can have two different results depending on how the Preferences are set (see “Settings
for group channels” on page 142). A muted channel is indicated by a lit
Mute button and also by the lit Global Mute indicator on the common
panel.
A muted channel in the mixer.

• When the Control Room channel is set to pre-fader, the
signal will be routed from just before the fader.

A lit Global Mute indicator on the
common panel shows that one or
more channels are muted.

Control Room channel set
to after-fader (AFL)…

• Clicking the Solo button for a channel mutes all other
channels.

…and to pre-fader (PFL).

• Several channels can be soloed at the same time.

A Listen-enabled channel is indicated by a lit Listen button, and also by the lit Global Listen button on the common panel. Click the Listen button again to turn off Listen
mode. You may also turn off Listen mode for every Listenenabled track at once by clicking the Listen button on the
common panel.

However, if you press [Ctrl]/[Command] and click the Solo button for a
channel, any other soloed channels will automatically be un-soloed (i.e.
this Solo mode is exclusive).

For more information about the Listen functionality, see
the chapter “Control Room” on page 151.

A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo indicator on the common panel. Click the Solo button again to
turn off Solo.
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Setting pan in the mixer

About the three pan modes
If you right-click in the pan control field for a (stereo) audio
channel, you can select one of three pan modes:

The pan control.

The pan controls in the mixer are used to position a channel between the left and right side of the stereo spectrum.
By default for stereo audio channels, pan controls the balance between the left and right channels. You can change
this in the Preferences. By selecting one of the other pan
modes (see below), you can set pan independently for the
left and right channel.

• Stereo Balance Panner controls the balance between
the left and right channels.
This is the default mode.

• If Stereo Dual Panner is selected, there will be two pan
controls with the upper controlling pan for the left channel,
and the lower controlling pan for the right channel.

• To make fine pan adjustments, hold down [Shift] when
you move the pan control.
• To select the (default) center pan position, hold down
[Ctrl]/[Command] and click on the pan control.

This allows you set pan independently for the left and right channels.
Note that it is possible to reverse the left and right channels, i.e. the left
channel can be panned to the right and vice versa. You can also “sum”
two channels by setting them to the same pan position (i.e. mono) – note
that this will increase the volume of the signal.

• For MIDI channels, the pan control sends out MIDI pan
messages.
The result depends on how your MIDI instrument is set to respond to pan
– check your documentation for details.

Ö The Surround Panner is described in the section
“Using the Surround Panner” on page 208.
Panning Bypass
• If Stereo Combined Panner is selected, the left and
right pan positions are shown as two lines with a blue/gray
area between them.

You can bypass the panning for all track types except
MIDI tracks. To do this, keep [Shift] and [Alt]/[Option]
pressed and click on the pan setting for the respective
channel in the mixer (on the fader panel or in the extended
mixer view). The Panning Bypass state is reflected in all
the different pan setting sections, e.g. if you bypass a
channel in the mixer, this is automatically reflected in the
Inspector for the respective track.

If you reverse the left and right channels, the area between the pan controls
will be red instead of blue/gray.

When panning is bypassed for a channel, the following
happens:

In this mode, the left and right pan controls are linked, and
can be moved left and right like a single pan control (keeping their relative distance).

• Mono channels will be panned center.
• Stereo channels will be panned left and right.
• Surround channels will be panned center.

• Stereo Combined mode also allows you set pan independently for the left and right channels. This is done by
holding down [Alt]/[Option] and dragging the corresponding pan control.

Ö To deactivate Panning Bypass, simply press
[Shift]+[Alt]/[Option] and click again.
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When moving combined pan controls so that the left or
right pan control reaches its maximum pan value, it naturally cannot go any further. If you continue to move further
in the same direction, only the other pan control will move,
thus altering the set relative pan range until both channels
are panned fully to one side. If you move the pan controls
in the opposite direction without releasing the mouse, the
previously set pan range will be restored.

The following views are possible:
• The 8 insert effect slots.
The inserts can also be found in the Inspector and the Channel Settings
window, see “Using Channel Settings” on page 137.

• The 8 effect sends, with pop-ups and send level value
sliders.
The sends can also be found in the Inspector and the Channel Settings
window, see “Using Channel Settings” on page 137.

Ö The pan settings made with the Dual Panner are reflected in the Combined Panner and vice versa.

• You also have the option of displaying four sends at a
time (the Sends 1-4 and 5-8 menu items).
These modes offer the additional benefit of displaying send levels as dB
values.

Ö You can specify the default pan mode for inserted audio tracks in the Preferences (VST page).

Ö There are no sends for Input channels.

About the “Stereo Pan Law” Preference (audio channels
only)

• The EQ section, either with value sliders (“EQs”) or as
numerical settings with a curve display (“EQs curve”).

In the Project Setup dialog there is a pop-up menu named
“Stereo Pan Law”, on which you can select one of several
pan modes. This is related to the fact that without power
compensation, the power of the sum of the left and right
side will be higher (louder) if a channel is panned center
than if it is panned left or right.

These two views have exactly the same controls but different graphic layouts. The EQ section is also available in the Channel Settings window.
For EQ parameter descriptions, see “Making EQ settings” on page 138.

• The Surround Panner section (where applicable).
If the channel is routed to a surround bus you can view a compact version of the Surround Panner in the extended panel – double-click to
open the full Surround Panner panel. Also in this section, three parameters of the Mixconvert plug-in will be shown (provided that this plug-in is
inserted and active). They are SRD (surround), CTR (center) and LFE
levels. You can edit these values by clicking on them and typing in new
values.

To remedy this, the Stereo Pan Law setting allows you to
attenuate signals panned center, by -6, -4.5 or -3dB (default). Selecting the 0dB option effectively turns off constant-power panning. Experiment with the modes to see
which fits best in a given situation. You can also select
“Equal Power” on this pop-up menu, which means that the
power of the signal will remain the same regardless of the
pan setting.

• The “Meter” option shows large level meters in the extended panel.
These operate exactly like the regular meters.

This section describes the options and basic procedures
regarding audio channels in the mixer.

• The User Panel option displays Device panels for the
audio track, including panels for inserted VST effects, see
“Audio tracks” on page 28. You can access User panels
by clicking on the tab at the top of the User Panel display
in the extended mixer.

Options for the extended audio channel strip

For information on Device Panels, see the separate PDF document “MIDI
Devices”.

Audio specific procedures

• Selecting the “Empty” option will display a blank panel
in the extended strip.

When using the extended channel strip view options, the
upper panel can be set to show different views for each
audio channel strip. You can select what to display in the
extended panel individually for each channel or globally for
all channels (see “Selecting what to display in the extended channel strips” on page 126).

• You can also select the “Overview” option – this shows
a graphic overview of which insert effect slots, EQ modules and effects sends are activated for the channel.
You can click the indicators to turn the corresponding slot/EQ module/
send on or off.

136
The mixer

Ö If you have selected a parameter for the extended
channel strip and then switch to “narrow” mode, only the
channel overview and the Meter can be shown in the extended channel strip. When you switch back to “wide”
mode, the parameter settings are displayed again.

Every channel has its own channel settings (although you
can view each in the same window if you like – see below).
Click the Edit button to open the
Channel Settings window.

Using Channel Settings
For each audio channel strip in the mixer and in the Inspector and Track list for each audio track, there is an Edit button (“e”).
Clicking this opens the VST Audio Channel Settings window. By default, this window contains:
• A section with eight insert effect slots (see “Audio effects” on
page 168).
• Four EQ modules and an associated EQ curve display (see
“Making EQ settings” on page 138).
• A section with eight effect sends (see “Audio effects” on page
168).
• A duplicate of the mixer channel strip (without the extended
panel but with the input and output settings panel).

The Channel Settings window is used for the following
operations:

You can customize the Channel Settings window, by
showing/hiding the different panels and/or by changing
their order:

•
•
•
•

• To specify which panels should be shown/hidden, right-click
in the Channel settings window, and activate/deactivate the
respective options on the Customize View submenu on the
context menu.
• To change the order of the panels, select “Setup” on the Customize View pop-up menu and use the “Move up” and “Move
Down” buttons.

Apply equalization, see “Making EQ settings” on page 138.
Apply send effects, see “Audio effects” on page 168.
Apply insert effects, see “Audio effects” on page 168.
Copy channel settings and apply them to another channel, see
“Copying settings between audio channels” on page 141.
!

All channel settings are applied to both sides of a
stereo channel.

Changing channels in the Channel Settings window
You can view any channel’s settings from a single window.

For further information, see the chapter “Customizing” on
page 503.

If the option “Sync Project and Mixer Selection” is activated in the Preferences (Editing–Project & Mixer page),
this can be done “automatically”:
• Open the Channel Settings window for a track and position it so that you can see both the Project window and
the Channel Settings window.
Selecting a track in the Project window automatically selects the corresponding channel in the mixer (and vice
versa). If a Channel Settings window is open, this will immediately switch to show the settings for the selected
channel. This allows you to have a single Channel Settings
window open in a convenient position on the screen, and
use it for all your EQ and channel effect settings.
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Making EQ settings

You can also select a channel manually (thereby changing
what is shown in the open Channel Settings window).
Proceed as follows:

Each audio channel in Nuendo has a built-in parametric
equalizer with up to four bands. There are several ways to
view and adjust the EQs:

1. Open the Channel Settings window for any channel.
2. Open the Choose Edit Channel pop-up menu by
clicking the arrow button to the left of the channel number
at the top of the Fader view.

• By selecting one of the EQ display modes (“EQs” or
“EQs Curve”) for the extended channel strip in the mixer.
These modes contain the same settings but present them in different
ways:
In “EQs” mode, the top value
slider controls the gain, the middle controls frequency and the
lower sets the filter type and the
Q parameter for each EQ band.

In “EQs Curve” mode, EQ settings are shown as a curve.
Parameters are set by clicking on the value and adjusting
with the fader that appears.

• By selecting the “Equalizers” or “Equalizer Curve” tab in
the Inspector.
The “Equalizers” section is similar to the “EQs” mode in the extended
mixer, while the “Equalizer Curve” section shows a display in which you
can “draw” an EQ curve. Setting EQ in the Inspector is only possible for
track-based audio channels.

3. Select a channel from the pop-up to show the settings
for that channel in the open Channel Settings window.

Ö Note that by default, only the Equalizers tab is shown.
To display the Equalizer Curve tab, right-click on an Inspector tab (not in the empty area below the Inspector)
and activate the “Equalizer Curve” option.

• Alternatively, you can select a channel in the mixer by
clicking its channel strip (make sure not to click on a control as this will change the respective parameter setting instead).

• By using the Channel Settings window.

This selects the channel, and the Channel Settings window is updated.

This offers both parameter sliders and a clickable curve display (the
Equalizer + Curve pane) and also lets you store and recall EQ presets.

• To open several Channel Settings windows at the same
time, press [Alt]/[Option] and click the Edit buttons for the
respective channels.

!
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Below we describe how to set up EQ in the Channel
Settings window, but the parameters are the same in
the mixer and Inspector (apart from the presets and
reset function, which are not available in the mixer).

The Equalizers + Curve pane in the Channel Settings window consists of four EQ modules with parameter sliders, an
EQ curve display and some additional functions at the top.

Using the curve display
When you activate EQ modules and make settings, you will
see that your settings are automatically reflected in the
curve display above. You can also make settings directly in
the curve (or combine the two methods any way you like):
1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below are activated.

2. Make EQ settings by dragging the curve point in the
display.
This allows you to adjust gain (drag up or down) and frequency (drag left
or right).

3. To set the Q parameter, press [Shift] and drag the
curve point up or down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/
[Command] (sets gain only) or [Alt]/[Option] (sets frequency only) while you drag the curve point.
4. To activate another EQ module, click somewhere else
in the display and proceed as above.

Using the parameter controls

5. To turn off an EQ module, double-click its curve point
or drag it outside the display.

1. Activate an EQ module by clicking its power button.
Although the modules have different default frequency values and different Q names, they all have the same frequency range (20Hz to 20kHz).
The only difference between the modules is that you can specify different
filter types for each individual module (see below).

6. To mirror the eq curve on the x axis, click the button to
the left of the curve display.

2. Set the amount of cut or boost with the gain control –
the upper slider.
The range is ± 24 dB.

3. Set the desired frequency with the frequency slider.

EQ bypass

This is the center frequency of the frequency range (20Hz to 20kHz) to
be cut or boosted.

Whenever one or several EQ modules are activated for a
channel, the EQ button will light up in green in the mixer
channel strip, Inspector (Equalizer and Channel sections),
Track list and Channel Settings window (top right corner
of the EQ section).

4. Click on the lower slider (to the left) to open the filter
type pop-up menu and select the desired filter type.
The “eq1” and “eq4” bands can act as parametric, shelving or high/lowpass filters, while “eq2” and “eq3” will always be parametric filters.

You can also bypass all EQ modules. This is useful, as it
allows you to compare the sound with and without EQ.
Proceed as follows:

5. Set the Q value with the lower slider (to the right).
This determines the width of the affected frequency range. Higher values
give narrower frequency ranges.

• In the mixer, the Track list and in the Channel section in
the Inspector, click the EQs state button so that it turns
yellow.

6. If needed, you can activate and make settings for up to
four modules.
• Note that you can edit the values numerically as well, by
clicking in a value field and entering the desired gain, frequency or Q value.

To deactivate EQ Bypass, click the button again, so that it turns green
again.
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• In the Inspector (Equalizers tab) and in the Channel
Settings window, click the Bypass button (next to the EQ
button) so that it turns yellow.

EQ in the channel overview
If the “Channel” section is selected in the Inspector or the
“Overview” view mode is selected in the extended mixer,
you will get an overview of which EQ modules, insert effects and effect sends are activated for the channel.

Click again to deactivate EQ Bypass mode.

By clicking the respective indicator (1 to 4), you can turn
the corresponding EQ module on or off.

EQ bypass in the mixer, the Channel Settings window and in the Inspector.

EQ reset
On the preset pop-up menu in the Channel Settings window and in the Inspector, you will find the Reset command.
Holding down [Alt]/[Option] and clicking this will turn off all
EQ modules and reset all EQ parameters to their default
values.
Using EQ presets
Some useful basic presets are included with the program.
You can use them as they are, or as a starting point for further “tweaking”.

The channel overview in the Inspector.

The option “Use Nuendo 3 EQ settings as default”

• To call up a preset, pull down the presets pop-up menu
in the Channel Settings window or in the Inspector and
select one of the available presets.

In the Preferences (VST page) you will find the option “Use
Nuendo 3 EQ settings as default”. When you activate this
option, the EQ settings from the previous program version
will be used by default. This means that when you create a
new track, the four EQ modules will be set to the EQ band
types they had in Nuendo 3:

• To store the current EQ settings as a preset, select
“Store Preset” on the presets pop-up menu and enter the
desired name for the preset in the dialog that appears.
• To rename the selected preset, select “Rename Preset”
on the pop-up menu and enter a new name.

This EQ module…

…will be set to

EQ1

Low Shelf 1

• To delete the selected preset, select “Remove Preset”
on the pop-up menu.

EQ2

Parametric 1

EQ3

Parametric 1

EQ4

High Pass 1

Ö You can also apply EQ (and Inserts) settings from
Track presets, see “Inserts and EQ settings from track
presets” on page 337.
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Copying settings between audio channels

Initialize Channel and Reset Mixer

It is possible to copy all channel settings for an audio channel and paste them to one or several other channels. This
applies to all audio-based channel types. For example, you
can copy EQ settings from an audio track and apply these
to a group or VST Instrument channel, if you want them to
have the same sound.

The Initialize Channel button can be found at the bottom in
the Control Strip section of the Channel Settings window
(if this section is not shown in the Channel Settings window, open the context menu and select “Control Strip” on
the Customize View submenu). Initialize Channel resets
the selected channel to the default settings.

Proceed as follows:

Similarly, the mixer common panel holds a Reset Mixer/
Reset Channels button – when you click this, you will be
asked whether you want to reset all channels or just the
selected channels.

1. In the mixer, select the channel you want to copy settings from.
You can also select channels with the Channel Select pop-up menu –
see “Changing channels in the Channel Settings window” on page 137.

The default settings are:

2. Click the “Copy Selected Channel Settings” button on
the common panel.

• All EQ, Insert and Send effect settings are deactivated and reset.
• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.

Changing the meter characteristics
In the Mixer context menu, opened by right-clicking anywhere on the mixer panel, there is a submenu named “Global Meter Settings”. Here you can make settings for the
preferred meter characteristics, with the following options:

3. Select the channel(s) you want to copy the settings to
and click the “Paste Settings to Selected Channels” button (below the “Copy First Selected Channel Settings”
button).

• If “Hold Peaks” is activated, the highest registered peak
levels are “held” and are shown as static horizontal lines in
the meter.

The settings are applied to the selected channel(s).

Note that you can turn this on or off by clicking in any audio level meter in
the mixer.

• You can copy channel settings between different types
of channels, but only those channels will be used for
which corresponding settings are available in the target
channel:

Hold is activated. The highest registered peak is displayed in the meter.

• For example, as input/output channels don’t have send effects, copying from them will leave the Sends settings in the
target channel unaffected.
• Also, in case of Surround Sound, for example, any Insert effects routed to surround speaker channels will be muted,
when the settings are pasted to a mono or stereo channel.
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• If “Hold Forever” is activated, the peak levels will remain
until meters are reset (by clicking the numerical peak display below the meter).

4. Do the same for the other channels you wish to route
to the group.
!

If “Hold Forever” is off, you can specify for how long the peak levels will
be held with the parameter “Meters’ Peak Hold Time” in the Preferences
(VST–Metering page). The peak hold time can be between 500 and
30000ms.

• If “Meter Input” is activated, meters will show input levels for all audio channels and input/output channels.

You can select a group channel as an Input for an
audio track, e.g. to record a downmix of separate
track outputs routed to a group (see “Recording
from busses” on page 69).

Settings for group channels
The group channel strips are (almost) identical to audio
channel strips in the mixer. The descriptions of the mixer
features earlier in this chapter apply to group channels as
well. Some things to note:

Note that the input meters are post input gain.

• If “Meter Post-Fader” is activated, meters will show
post-fader levels.
This is the default setting for channels in the mixer.

• You can route the output of a group to an audio channel
(see “Recording from busses” on page 69), to an output
bus or to another group with a higher number.

• There is also a “Meter Post-Panner” mode.
This is similar to “Meter Post-Fader”, but the meters will reflect pan settings as well.

You cannot route a group to itself. Routing is done with the Output Routing pop-up menu in the Inspector (select the subtrack for the Group in
the Track list) or in the Routing section at the top of each channel strip.

• If “Fast Release” is activated, the meters respond very
quickly to level peaks. If “Fast Release” is deactivated, the
meters respond more like standard meters.

• There are no Input Routing pop-ups, Monitor buttons or
Record Enable buttons for group channels.

You can set the time it takes for the meters to “fall back” in the Preferences (VST–Metering page).

This is because inputs are never connected directly to a group.

Using group channels

• Solo functionality is automatically linked for channels
routed to a group and the group channel itself.

You can route the outputs from multiple audio channels to
a group. This enables you to control the channel levels using one fader, apply the same effects and equalization to
all of them etc. To create a group channel, proceed as follows:

This means that if you solo a group channel, all channels routed to the
group are automatically soloed as well. Similarly, soloing a channel
routed to a group will automatically solo the group channel.

• Mute functionality depends on the setting “Group Channels: Mute Sources as well” in the Preferences (VST page).

1. Select Add Track from the Project menu and select
“Group Channel” from the submenu that appears.

By default, when you mute a group channel no audio will pass through
the group. However, other channels that are routed directly to that group
channel will remain unmuted. If any of those channels have aux sends
routed to other group channels, FX channels or output busses, those will
still be heard.
If the option “Group Channels: Mute Sources as well” is activated in the
Preferences (VST page), muting a group channel will cause all other
channels directly routed to it to be muted as well. Pressing mute again

2. Select the desired channel configuration and click OK.
A group channel track is added to the Track list and a corresponding
group channel strip is added to the mixer. By default the first group channel strip is labeled “Group 1”, but you can rename it just like any channel
in the mixer.

3. Pull down the Output routing pop-up for a channel you
want to route to the group channel, and select the group
channel.
The output of the audio channel is now redirected to the selected group.

142
The mixer

Viewing the output busses in the mixer

will unmute the group channel and all other channels directly routed to it.
Channels that were muted prior to the group channel being muted will
not remember their mute status and will be unmuted when the group
channel is unmuted.
!

Output busses are shown as output channels in a separate pane to the right in the mixer. You show or hide this
pane by clicking the Hide Output Channels button in the
mixer’s common panel to the left:

The option “Group Channels: Mute Sources as well”
does not affect how mute automation is written.
Writing mute automation on a group channel only affects the group channel and not channels routed to
it. When writing the automation, you will see the
other channels being muted when this option is activated. However, upon playback, only the group
channel will respond to the automation.

Each output channel resembles a regular audio channel
strip. Here you can do the following:

One application of group channels is to use them as “effect
racks” – see the chapter “Audio effects” on page 168.

• Adjust master levels for all configured output busses using the
level faders.
• Adjust input gain and input phase of the output busses.
• Add effects or EQ to the output channels (see the chapter
“Audio effects” on page 168).
• Create Sends that can be routed to other Output channels as
long as they are to the right of the selected Output channel in
the mixer. This can be useful when creating quick headphone
mixes from the current monitor mix. This is done by creating a
send from the current monitor Output bus to another Output
bus that is routed to a headphone amplifier.

About output busses
Nuendo uses a system of input and output busses which
are set up using the VST Connections dialog. This is described in the chapter “VST Connections: Setting up input
and output busses” on page 10.
Output busses let you route audio from the program to the
outputs on your audio hardware.
Routing audio channels to busses
To route the output of an audio channel to one of the active busses, proceed as follows:
1. Open the mixer.
2. Make sure the input/output settings panel is visible –
see “Normal vs. Extended channel strips” on page 126.
3. Pull down the Output Routing pop-up menu at the top
of the channel strip and select one of the busses.
This pop-up menu contains the output busses configured in the VST
Connections window, as well as available group channels (provided that
the busses and groups are compatible with the speaker configuration for
the channel – see “Routing” on page 14).

You can also make routing settings in the Inspector.
For details on routing surround channels, see “Surround in
the mixer” on page 205.
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MIDI specific procedures

Using Channel Settings
For each MIDI channel strip in the mixer (and MIDI track in
the Track list or the Inspector), there is an Edit (“e”) button.

This section describes basic procedures for MIDI channels in the mixer.

Clicking this opens the MIDI Channel Settings window.
By default, this window contains a duplicate of the mixer
channel strip, a section with four MIDI inserts and a section with four MIDI send effects.

Selecting what to show in the extended MIDI
channel strip
When using the extended channel strip view options (see
“Normal vs. Extended channel strips” on page 126), the
upper panel can be set to show different views for each
MIDI channel strip. You select what to display for each
channel by using the View options pop-up menu at the top
of each channel strip. The following views are possible:

You can customize the Channel Settings window, by
showing/hiding the different panels and/or by changing
their order:
• To specify, which panels should be shown/hidden, right-click
in the Channel settings window, and activate/deactivate the
respective options on the Customize View submenu on the
context menu.
• To change the order of the panels, select “Setup” on the Customize View pop-up menu and use the “Move up” and “Move
Down” buttons in the dialog that opens.

• The MIDI insert effects.
MIDI inserts can also be found in the Inspector and the Channel Settings
window for MIDI channels. How to use MIDI insert effects is described in
the chapter “MIDI realtime parameters and effects” on page 342.

• The MIDI send effects.
The sends can also be found in the Inspector and the Channel Settings
window for MIDI channels. How to use MIDI send effects is described in
the chapter “MIDI realtime parameters and effects” on page 342.

Every MIDI channel has its own channel settings.

• The “Meter” option shows large level (velocity) meters in
the extended panel.
• You can also select the “Overview” option – this shows
a graphic overview of which insert effect slots and effect
sends are activated for the channel.
You can click the indicators to turn the corresponding slot/send on or off.

• The “User Panel” option allows you to import MIDI device panels – this is described in the separate PDF document “MIDI Devices”.
• Selecting “Empty” will display a blank panel in the extended strip.
• By selecting from the View options pop-up on the common panel, you can set the view for all channels in the
mixer.
Selecting EQ or Surround Panners (which apply to audio channels only)
will not change the view for MIDI channels. Selecting inserts or send effects from the common panel will change the view for all channel types.

The MIDI Channel Settings window.

144
The mixer

Utilities

What will be linked?
The following rules apply for linked channels:

Link/Unlink channels

• Only level, mute, solo, select, monitor and record enable
will be linked between channels.

This function is used to “link” selected channels in the
mixer so that any change applied to one channel will be
mirrored by all channels in that group. You can link as
many channels as you like, and you can also create as
many groups of linked channels as you like. To link channels in the mixer, proceed as follows:

Effect/EQ/pan/input and output routing settings are not linked.

• Any individual channel settings you have made before
linking will remain until you alter the same setting for any of
the linked channels.
For example, if you link three channels, and one of them was muted at the
time you applied the Link Channel function, this channel will remain muted
after linking. However, if you mute another channel all linked channels will
be muted. Thus, the individual setting for one channel is lost as soon as
you change the same parameter setting for any of the linked channels.

1. Press [Ctrl]/[Command] and click on all the channels
you want to link.
[Shift]-clicking allows you to select a continuous range of channels.

• Fader levels will be “ganged”.
The relative level offset between channels will be kept if you move a
linked channel fader.

2. Right-click somewhere on the gray mixer panel.
The Mixer context menu appears.

3. Select “Link Channels” from the context menu.
• To unlink channels, select one of the linked channels and
select “Unlink Channels” from the Mixer context menu.
The channels are unlinked. Note that you do not need to select all the
channels that are linked, only one of them.

Ö It is not possible to remove individual channels from
Link status.
To make individual settings to a linked channel, press [Alt]/[Option] when
changing the setting.

The three channels shown are linked. Pulling down one fader changes
the levels for all three channels, but keeps the relative level mix.
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• By pressing [Alt]/[Option], you can make individual settings and changes for channels that are linked.

It is possible to save complete mixer settings for selected
or all audio channels in the mixer. These can later be
loaded into any project. Channel settings are saved as
mixer settings files. These have the Windows file extension “.vmx”.

Ö Linked channels have individual automation subtracks.
These are completely independent, and are not affected
by the Link function.

Right-clicking somewhere in the mixer panel or in the
Channel Settings window brings up the Mixer context
menu where the following Save options can be found:

The Window submenu
The Mixer context menu, opened by right-clicking anywhere
on the Mixer window background, provides the Window
submenu. Its options are handy for quickly switching to another open mixer window, showing/hiding the different
mixer panes etc. It contains the following options:

• “Save Selected Channels” will save all channel settings
for the selected channels.
Input/output routings are not saved.

• “Save All Mixer Settings” saves all channel settings for
all channels.

• Show Routing View
Allows you to show/hide the topmost section of the mixer which contains
the input/output routing settings.

• Show Extended View

When you select any of the above options, a standard file
dialog opens where you can select a name and storage location on your disk for the file.

Allows you to show/hide the middle section of the mixer, where you can
display different settings for the channels (EQs, Send effects, etc.).

Loading mixer settings

• Next Mixer

Load Selected Channels

This displays the next mixer window (if you have several mixer windows
open).

To load mixer settings saved for selected channels, proceed as follows:

Saving mixer settings
!

1. Select the same number of channels in the new project
to match the number of channels you saved settings for in
the previous project.

Saving/Loading mixer settings does not apply to
MIDI channels in the mixer – only audio-related
channels (group, audio, instrument, effect return,
VSTi and ReWire) are saved with this function!

For example, if you saved settings for six channels, select six channels in
the mixer.

• Mixer settings will be applied in the same order as they
were in the mixer.
Thus, if you save settings from channels 4, 6 and 8 and apply these settings to channels 1, 2 and 3, the settings saved for channel 4 would be
applied to channel 1, the settings saved for channel 6 to channel 2 and
so on.

2. Right-click the mixer panel to open the context menu,
and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
The channel settings are applied to the selected channels.
!
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If you choose to apply mixer settings to fewer channels than you saved, the order of the saved channels
in the mixer applies – i.e. the saved channels that are
“left over” and not applied will be the channels with
the highest channel numbers (or furthest to the right
in the mixer).

Load All Mixer Settings
Selecting “Load All Mixer Settings” from the context menu
allows you to open a saved mixer settings file, and have
the stored settings applied to all channels for which there
is information included in the file. All channels, master settings, VST Instruments, sends and master effects will be
affected.
Ö Please note that if the saved mixer settings were for
24 channels, for example, and the mixer you apply it to
currently contains 16 channels, only the settings for channels 1 to 16 will be applied – this function will not automatically add channels.

About the VST Performance window

The VST Performance window is opened from the Devices
menu. It indicates the current load on the CPU and the hard
disk transfer rate. It is recommended that you check this
from time to time, or keep it always open. Even though you
have been able to activate a number of audio channels in
the project without getting any warning, you may run into
performance problems when adding EQ or effects.
• The upper bar graph shows the CPU (processor) load.
If the red Overload indicator lights up, you need to decrease the number
of EQ modules, active effects and/or audio channels playing back simultaneously.

• The lower bar graph shows the hard disk transfer load.
If the red overload indicator lights up, the hard disk is not supplying data
fast enough to the computer. You may need to reduce the number of tracks
playing back by using the Disable Track function (see “About track disable/
enable” on page 62). If this doesn’t help, you need a faster hard disk.
Note that the overload indicator may occasionally blink, e.g. when you locate during playback. This does not indicate a problem, but happens because the program needs a moment for all channels to load data for the
new playback position.

Ö The CPU and Disk load meters can also be shown on
the Transport panel (as “Performance”) and on the Project
window toolbar (as “Performance Meter”).
There they are shown as two miniature vertical meters (by default at the
left side of the panel/toolbar).
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12
Control Room

Background

The concept
The concept behind creating the Control Room features
was to divide the studio environment into the performing
area (studio) and the engineer/producer area (control
room) common to traditional studios. Previously, an analog
console or some method of speaker control and monitor
routing was necessary to provide this functionality to the
DAW environment.

Large console Monitoring sections
In traditional analog studios, the audio console maintained
control over every audio signal in the studio, including the
control room monitors, headphone systems, external 2track tape machines and communications such as the talkback system.

Nuendo now provides all the functionality of the analog
console’s monitoring section, along with many more features, in the virtual world where flexibility and instant recall
are expected.

The console itself provided a means of creating multiple
cue mixes for performers in the studio. Using available aux
sends, the engineer could create multiple cue mixes for
the various performers, each one having a unique mix tailored for that person or group of performers.

!

With the advent of the DAW, many of the functions of the
console started being performed inside the audio software, allowing for more flexibility and instant recall of any
setting. In many studios, the console sat idle except for
adjusting the playback level of the speakers, switching to
monitor external devices and routing signals to headphones and other cue mix playback systems.

Please note that when we speak of “the Mixer” in this
chapter we refer to the Control Room Mixer window.
The normal Nuendo Mixer is referred to as the
“Project Mixer”. For information about the Project
mixer, see the chapter “The mixer” on page 122.

Control Room features
The following features are available for the Control Room
Mixer:

Smaller hardware units have been made to replace the
monitoring section using a simple volume knob with
speaker and input switches. Some even include a talkback
system and headphone amplifiers.

• Support for up to four sets of monitors with various speaker
configurations from mono up to 10.2 cinema speaker systems.
• Dedicated Headphone output.
• Support for up to four discrete cue mix outputs called “Studios”.
• Dedicated Talkback channel with flexible routing and automatic
record defeat.
• Support for up to six external inputs with configurations up to
10.2 surround.
• Click track routing and level control to all Control Room outputs.
• Flexible Listen Bus options with the Listen Dim setting that
allows Listen-enabled tracks to be heard in context with the
whole mix.
• Listen Bus Enabling on both Control Room and Headphone
outputs.
• User-definable downmix settings using the MixConvert plug-in
for all speaker configurations.
• Individual speaker soloing for all speaker configurations.
• Multiple inserts on each Control Room channel for metering
and surround de-coding among other possibilities.
• Monitor Dim function with adjustable level.
• User-defined Calibrated Monitor level for post-production
mixing in a calibrated environment.

Surround sound
With more and more surround recording and mixing being
performed in the DAW environment, the needs of the monitoring section have become magnified. Surround speaker
setups must be able to work with smaller, stereo speakers
and even mono speaker systems. Switching back and forth
between them can become quite complicated. Also, the
ability to perform downmixes of multi-channel audio is now
needed on a regular basis for many audio professionals.
Virtual Control Room solution
Nuendo has now added the functionality of the control
room monitoring section of large format analog consoles to
the virtual audio environment of VST with the creation of the
Control Room Mixer and Control Room Overview windows.
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• Adjustable Input Gain and Input Phase on all external inputs
and Speaker outputs.
• Full-sized meters on every Control Room channel.
• Support for up to four aux sends (Studio Sends) for creation
of discrete cue mixes for performers. Each Studio output has
its own cue mix.
• The ability to disable the Control Room Section when working
with an external monitoring solution or console.
• Full support for the monitoring section functionality of the ID
control surface.

• Phones
The Phones channel is used by the engineer in the control room for
checking cue mixes and as another option for listening to the mix or external inputs on a pair of headphones. It is not intended for cue mixes that
performers use while recording. Only one stereo Headphone channel is
available.

• Studios
Studio channels are intended for sending cue mixes to performers in the
studio during recording. They have talkback and click functions and can
monitor the main mix, external inputs or a dedicated cue mix. Up to four
Studios can be created allowing four discrete cue mixes for performers.

• External inputs
External inputs are for monitoring external devices such as CD players,
multi-channel recorders or any other audio source. Up to six external inputs can be created with various configurations from mono up to 10.2
surround.

Configuring the Control Room
The Control Room features are configured in several locations within Nuendo.

• Talkback

• The VST Connections window has a tab labelled “Studio” in
which the hardware inputs and output are defined for the
Control Room channels.
• In the Devices menu you will find the Control Room Overview
that displays a visual overview of the Control Room channels
and signal flow.
• In the Devices menu you will find the Control Room Mixer
which allows operation of the Control Room features.
• In the Preferences (VST–Control Room page) you will find
some settings for altering the Control Room preferences.

The Talkback is a mono input used for a communications system between the control room and performers in the studio. Only one mono
Talkback channel is available.

Control Room channels cannot share hardware inputs or
outputs with external FX or external instruments, as defined in the VST Connections window (see “Connecting
the external effect/instrument” on page 18). As you create
connections for each channel, only those device ports that
have not been used for external FX or instruments will be
available. However, Control Room channels and inputs
and outputs can share the same device ports.

VST Connections Studio tab

A great deal of confusion can result if outputs and Control
Room Monitor channels share the same device ports. As a
starting point, set all the outputs to “Not Assigned” while
the Control Room is set up. By default, one stereo Monitor
channel is created after installing Nuendo.

The Studio tab of the VST Connections window is where
you configure the inputs and outputs for the Control Room
Mixer. For more information, see the chapter “VST Connections: Setting up input and output busses” on page 10.
Control Room channels

!

There are five types of channels that you can create, each
defining either an input or output of the Control Room
Mixer. As more channels are created, the Control Room
Mixer expands to display controls for each channel.
• Monitors
Each Monitor channel is a set of outputs that are connected to monitor
speakers in the Control Room. Each Monitor can be configured for a
mono, stereo or up to a 10.2 surround speaker configuration. Up to four
Monitors can be created, each with a different speaker configuration.
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The Control Room Mixer is designed to display information and controls only for the channels you have
defined in the VST Connections dialog. For example,
if you have not defined any Studio channels, they will
not appear in the Control Room Mixer. The Control
Room Overview displays all the possible channels
but only highlights the ones that have been defined.
To see all the available controls in the Control Room
Mixer, start by creating the maximum amount of
channels in the VST Connections Studio tab.

Creating a Control Room channel

Phones

To create a new channel, click on the Add Channel button
in the Studio tab of the VST Connections window. A popup menu lists all available channels along with how many
of each type are available. Select the type of channel you
wish to create and a dialog will appear allowing you to
choose the configuration of the channel (stereo, 5.1, etc.).

Create a Phones channel if you intend to listen to headphones in the control room. The Phones channel is not intended for use by performers in the studio. It is designed
for the engineer to quickly listen to any source in the studio, including the four cue mixes, as a reference.
!

!

If you are adding the Talkback or Phones channels,
there are no channel configuration choices since Talkback is mono only and Phones are stereo only. Also,
Studio channels can either be mono or stereo only.

The Phones channel is stereo only.

Studios
Create a Studio channel for each cue mix you wish to create for performers in the studio. For example, if you have
two available headphone amplifiers for performers to use,
create two Studio channels, one for each headphone mix.
There are four available Studio channels.
!

Studio channels can either be mono or stereo.

External inputs
The Studio tab of the VST Connections window with several Control
Room Channels created

Create external input channels for every playback device
you wish to be able to monitor in the Control Room. There
are six available external inputs with channel configurations from mono up to 10.2 surround. Use external inputs
to quickly listen to CD players, master recorders, or other
workstations.

After clicking OK, the new channel will appear in the VST
Connections window. You can now connect it to any
available device port using the “+” buttons and the context menu in the Device Port column. An audio device
must be selected and then a device port must be chosen
for each audio path. You assign device ports to channels
in the same fashion as assigning any VST connection.
!

!

Control Room channels can share device ports with
each other. This can be helpful if you use the same
speakers as a stereo pair and also as the left and
right channels of a surround speaker configuration.
Switching between monitors that share device ports
will be seamless, providing any downmix of multichannel audio to stereo if needed. Only one monitor
set can be active at a time.

If you select external inputs as input source of an audio channel, you can record them. In this case, you
will not need to assign the device ports to the input
channel (see “Routing” on page 14).

Talkback
Create a Talkback channel if you have a microphone in the
control room available for communication with performers in
the studio. The Talkback channel can be routed to each
Studio channel with variable levels in order to optimize
communications between the control room and performers.

Monitors

Additionally, the Talkback is available as a possible input
source for audio tracks. You can record from the Talkback
just like any other input.

Create a Monitor channel for every set of speakers in your
studio. A typical post-production studio could have one
set of 5.1 surround speakers, another stereo set of speakers and even a single, mono speaker for checking balances for mono broadcast. The Control Room Mixer will
allow you to switch speakers easily. Each set of Monitors
can have its own custom downmix settings, input gain and
input phase adjustments.

!
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Inserts are available on the Talkback and all other
Control Room channels. A compressor/limiter can
be inserted on the Talkback channel to ensure that
erratic levels do not bother performers and clear
communication with everyone is possible.

Disabling the Control Room

Output click enabling

Once you have created all the channels for your studio
configuration, the Control Room functions are available for
use. If you need to use Nuendo without the Control Room
functions, you can simply press the Disable Control Room
button on the Studio tab of the VST Connections window.
Any channels you have created will be saved and when
you enable the Control Room again, that configuration will
be reloaded.

There may be a situation when you want the click to be
routed always to a specific output bus, regardless of the
actual Control Room settings, or indeed when the Control
Room is disabled. In these cases, enable the click on specific outputs using the Click column on the Outputs tab in
the VST Connections window.

You can also create presets for the Control Room configuration in the same manner as for inputs and outputs, see
“Other bus operations” on page 14.
!

If you disable the Control Room, make sure that
there are device ports assigned to the default output
bus “Main Mix” on the outputs tab. Otherwise, you
will not hear any sound from the Main Mix.

The Output tab showing two stereo outputs, the Main Mix and a second
output that is click enabled.

Outputs – Main Mix
For the Control Room to function correctly, the Main Mix in
the Outputs tab must be assigned to the set of outputs that
actually contains your final mix signal. If you only have one
output bus, it will be the Main Mix by default.
If you have more than one output bus defined, you can
change which one is the Main Mix by right-clicking on the
name of the output and selecting “Set “Out” as Main Mix”.
The Main Mix is marked by a small speaker icon to the left
of its name.

!

The click will only be heard in outputs that are assigned to device ports. Be aware that the click can
also be routed to device ports using the Control
Room features.

!

Sharing audio device ports between outputs and
Control Room channels can cause confusing behavior and possible overload of those ports without any
indication from Nuendo. It is advisable to disconnect
all outputs from all device ports when first configuring the Control Room.

!

Be aware that some audio interfaces allow very flexible routing within the hardware itself. Certain routing
configurations could cause overloads and possible
damage to speaker equipment. Consult the hardware documentation for further information.

The VST Connections Output tab showing one bus as the Main Mix
marked by the small speaker icon.

outputs other than the Main Mix are not routed through the
Control Room Mixer. They can, however, share the device
ports of Studio and Monitor channels in the Control Room.
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The Control Room Overview

The Control Room Mixer

You can access the Control Room Overview from the Devices menu. The Control Room Overview is designed to
display the current configuration of the Control Room. The
window shows all possible channels, with active channels
highlighted once they have been created in the VST Connections window. Channels that are grayed out have not
been defined in the VST Connections window.

The Control Room Mixer is where you access all the features of the Control Room. The Control Room Mixer can
be resized to accommodate more channels and to display
more controls. When you open the window for the first
time, it will show none of the extendable panels.

The Control Room Overview allows you to see the signal
flow through the Control Room Mixer. All the routing functions of the Control Room Mixer are duplicated in the
Overview.

The Control Room Mixer

Configuring the Control Room Mixer
In order to display more controls in the Control Room
Mixer, the small arrows at the lower left and right corners
can be clicked to open or close the extended speaker
controls on the right (“Right Strip”) and the External Input
and Talkback controls on the left (“Left Strip”).
The arrow at the upper right corner of the Control Room
Mixer extends the Mixer vertically to display meters and inserts (“Extended view”). A second arrow appears above
the inserts and meter display. Extending the Mixer using
this arrow exposes the Input Gain and Input Phase switch,
channel configuration and name for each channel (“Routing view”).

The Control Room Overview

Open the Control Room Mixer and the Control Room Overview windows side by side. As you operate the controls in
the Mixer you will see the various pale green squares light
up in the Overview, indicating changes in signal flow. You
can also click the squares in the Overview and watch the
controls in the Mixer reflect the changes in signal flow.
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The different Control Room Mixer panels are handled in
the same way as the Project Mixer panels, see “Configuring the mixer” on page 126.

Each Control Room channel has a set of inserts configured as six pre-fader and two post-fader inserts. External
inputs and Monitor channels only have the six pre-fader inserts.

The Control Room Mixer’s Extended View displaying channel inserts

If you do not wish to see full sized meters but still want
some indication of signal activity, activate the option “Signal Presence Indicators” in the Preferences (VST–Control
Room page). They will be displayed next to the input selection buttons and will indicate signal presence for all inputs.

!

You can also use the Window submenu on the Control Room Mixer context menu to show/hide the different panels, just as in the Project Mixer.

Control Room inserts and meters
When the Control Room Mixer displays the Extended
View, the meters become visible. These meters look and
function the same way as the ones in the Project Mixer.
Pressing the small meter icon at the center right side of
the mixer will change the view to display inserts. Alternatively, these can also be displayed by deactivating the
Show Meters option on the Window submenu of the Control Room Mixer context menu.

The Control Room Mixer with all Signal Presence indicators lit up.

Inserts for external inputs
Each external input has its own set of six inserts. Selecting
each external input by clicking the button next to its name
at the left of the Mixer window will display the inserts associated with that channel in the extended view.
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Inserts for the Talkback channel

Click here to open the
MixConvert control panel.

The Talkback channel has a separate set of eight inserts.
In order to view and adjust them, the Talkback must be enabled via the TALK button located to the lower right of the
Control Room Mixer. Click once on the Talkback to latch it
on. The inserts for external inputs will now display the
Talkback inserts. Once the Talkback is disabled, the view
will revert back to external input inserts.
!

The Down-Mix Presets section.
!

You can easily identify the inserts for the Talkback
since they have six pre-fader and two post-fader inserts while the external inputs only have six pre-fader
inserts. If the Control Room Mixer is fully expanded,
the name displayed at the very top of the Mixer will reflect which channel is currently in the Extended View.

Automatic configuration of the downmix settings follows a logical path. For example, if you have defined
one set of 5.1 monitors and another set of stereo
monitors, Nuendo will create a 5.1 to stereo downmix preset and another downmix to mono. You can
modify all the settings for each downmix preset using
the MixConvert plug-in.

Monitor Inserts

Control Room operations

Each Monitor channel has a set of six inserts. These inserts are all post Control Room fader level and are most
useful for surround decoding or brickwall limiting to protect sensitive monitor speakers.

In traditional analog studios, the control room section of
the console contained the most used set of controls in the
whole studio. Often, the studio monitor level had all the
markings rubbed off from so much use.

Each set of monitors has its own Input Phase and Input
Gain settings available in the top section of the extended
Control Room Mixer. In addition, there are speaker solo
icons along with various soloing modes and speaker routing options in the Speaker Solo panel.

The need to constantly be able to switch monitoring
sources, adjust the volume of monitors and route various
cue mixes and other sources to headphone systems is the
norm in most sessions. Meeting the needs of several performers in the studio plus a producer and the engineer becomes a constant task that requires flexibility and ease of
operation. Communication between everyone must be
flawlessly clear without intruding on the creativity of performers.
With all this in mind, the Nuendo Control Room Mixer is
designed to fill those needs with a simple yet highly flexible solution. The virtual mixing environment of VST is the
ideal solution to the varied needs of a control room matrix.
With a virtual mixer, a high degree of customization and
precise settings are possible with the ability to completely
recall these settings at any time.

The Speaker Solo panel

Ö Use the speaker solos to test your multichannel speaker
system and ensure that the proper channels are routed to
each speaker.
Just below the configuration display, all settings for automatic downmixing of multichannel sources are shown.
There are four down-mix presets. Some will automatically
configure themselves for the sets of monitors you have
defined. Each preset is adjustable by accessing the MixConvert plug-in by clicking the small arrow icon above the
downmix presets section.
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Control Room Mixer layout
The Control Room Mixer has a variety of controls, some
that are similar to the Project Mixer and some that are
unique to Control Room operations. The following diagrams show every control, followed by a brief description
of what each control does.
2.

3.

4.

5.

6.

1.

7.

8.

29.
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6.
10.
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28.
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24.

6.

23.

6.

22.

21.

20.
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19.

18.

17.

16.

1. Input Phase

12. Listen DIM

Each external input and Monitor speaker output has an Input Phase reversal switch. When lit, all audio paths within the channel will have their
phase reversed.

This gain control adjusts the volume of the Main Mix when channels have
been put in Listen mode. This allows you to keep Listen enabled channels in context with the Main Mix. If the Listen DIM is set to minus infinity,
Listen enabled channels will be heard by themselves. Any other setting
leaves the Main Mix on at a lower level.

2. Input Gain
Each external input, Monitor speaker output and the Talkback input has
an Input Gain control. When an external input or Monitor becomes active, the Gain settings will be recalled.

13. DIM Enable
This turns the Control Room Level down by a preset amount (the default
setting is -30dB). This allows a quick reduction in monitor volume without disturbing the current monitor level. Clicking on the DIM button again
returns the monitor level to the previous setting.

3. Channel Inserts
Each channel in the Control Room Mixer has inserts available. While most
channels have six pre-fader and two post-fader inserts, the external inputs
and Monitors only have six pre-fader inserts.

14. Talkback Enable
Click the Talk button to turn on the Talkback system, allowing communication between the control room and performers in the studio. There are
two modes of operation: momentary mode used by clicking and holding
the Talk button, and latch mode where clicking once turns the Talkback
on until you click it again to turn it off.

4. Channel Configuration
This displays the current configuration of audio paths in the channel, e.g.
Stereo, 5.1, etc.

5. Channel Labels
This displays the name of the channel as defined in the VST Connections.

15. Talkback DIM Level

There are several arrow buttons that open and close various panels of
the Control Room Mixer. By default, all expandable panels are hidden.

When the Talkback is enabled, this control allows you to determine how
much the output of all the channels in the Control Room Mixer is reduced. This prevents unwanted feedback. If the Talkback DIM level is set
to 0dB, no change will occur in the Control Room channels.

7. Use Reference Level

16. Cycle Down-Mix Preset Selection

When you click this button, the Control Room Level is set to the reference level set in the Preferences, e.g. a level for calibrated mixing environments such as film dubbing stages. Press [Alt]/[Option] and click on
this button to set the Preferences reference level setting to the current
Control Room level.

The Control Room allows four different Speaker down-mix settings for
auditioning with various speaker configurations. Clicking this button cycles through the four down-mix presets. Various icons appear to show
which preset is active.

8. Control Room and Headphone Input Selectors
These buttons allow the selection of various input sources for the Control Room and Headphone channels. The choices are for External Input,
Main Mix, or any one of the four Studio channels.

Pressing this button changes the Monitor selection to the next available
set. As Monitors are changed, so are the down-mix presets, Monitor inserts, Input Gain and Input Phase controls associated with that Monitor
set.

9. Show Meters/Inserts button

18. Listen Bus Enable

This allows you to switch between the display of Meters and Inserts for
the extended Mixer view.

This turns on Listen bus functions for either the Control Room or Headphone outputs. If this is not enabled, the Listen bus will not be routed to
that channel.

6. Expansion controls

17. Cycle Monitor Selection

10. Listen Bus AFL/PFL

19. Listen Bus Gain

This button determines whether the source signals sent to the Listen bus
are pre-fader (PFL) or post-fader (AFL).

This level adjustment determines how loud Listen bus signals are when
routed to the Control Room or Headphone outputs. Clicking on the number pops up a fader control for adjustment.

11. Global Listen Defeat
When lit, this indicates that one or more channels in the Project Mixer are
Listen enabled. Clicking on this button defeats Listen mode for all channels.

20. Studio Input Selectors
For Studio Channels, the input choices are External Input, Aux (from Studio
Sends) or Main Mix.

21. Activate Channel Buttons
These buttons turn each channel’s output on or off. When lit, the channel
is on.
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22. Channel Labels

30. Individual Speaker Solos

These labels reflect the names created in the VST Connections window.

Each speaker icon is a solo button for that channel. [Shift]-clicking a
speaker will solo all the speakers in that row (front or rear). [Ctrl]/[Command]-clicking on a speaker that is already soloed will mute that speaker
and solo all other channels.

23. Talkback Level
This pop-up fader controls the amount of Talkback signal fed to the output
of each Studio.

31. LFE Solo

24. Talkback Enable

The plus icon solos the LFE channel.

In order for Talkback signals to be routed to a Studio, this button must be
lit. Clicking on it turns it on or off. When Talkback Enable is deactivated,
the Talkback DIM setting has no effect on this output.

32. Solo Rear Channels
This solos all rear channels.

25. Metronome Mix

33. Listen to Rear Channels on Front Monitors

These level and pan controls determine how the Metronome will be
heard in each channel. These controls are independent for each channel.

This button solos the rear channels and routes them to the front speakers.

26. Metronome Enable

34. Listen to Solo Channels on Center Monitor

This determines whether click signals are sent to each channel. When lit,
click signals will be heard in that output.

When this button is enabled, all speakers that are soloed will be heard in
the center channel if there is one in the configuration. If not (as with stereo)
the soloed channel will be heard equally in both left and right speakers.

27. Channel Level Control

35. Edit Down-Mix

This is the main volume for each Control Room output. These faders do not
affect recording input levels or the Main Mix level for exporting mixdowns.

Clicking on this tab opens the MixConvert plug-in used to down-mix multichannel signals for monitoring.

28. External input switching

36. Down-Mix Labels

There are six available external inputs. These buttons determine which
external input is currently being used. The names for each external input
are displayed here as they were created in the VST Connections.

This area displays the names of the four down-mix presets. You may click
on a name to change it. A “?” appears when there is no preset defined
for that down-mix.

29. Signal Presence Indicators

37. Monitor Labels

In the Preferences dialog, there is the option to display these Signal
Presence Indicators as a substitute for the full size meters.

This area displays the names of the four possible Monitors. The names
are created in the VST Connections when you define a Monitor channel.

30.

38. Monitor Selection
31.

These buttons select the current Monitor set. Each Monitor has its own
settings including down-mix preset, solo enables, inserts, Input Gain and
Input Phase. These settings are automatically recalled when a Monitor is
selected.

42.
32.
41.
40.

33.

39. Down-Mix Preset Selection

34.

These buttons select the down-mix preset for the current Monitor.

35.

40. Speaker Solo Defeat
36.

This button defeats all speaker solos, resetting them for normal playback.

39.
38.

41. Solo Front Channels
This button solos all front speakers.

37.

42. Solo Left and Right Channels
This button solos the left and right channels.
The Monitor controls in the Control Room Mixer
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The Main Mix and the Control Room channel

• A brickwall limiter in the last insert of the Control Room channel can prevent accidental overloads and damage to speaker
systems.
• Use the inserts for the Talkback channel to control the dynamics of the talkback microphone. This will help protect performers’ hearing and ensure that everyone can be heard over the
talkback microphone.
• Use the Gain settings on the external inputs to level balance
CD players and other sources to the Main Mix level for A/B
comparisons.
• Use the Gain settings on each Monitor to level balance all your
monitor systems. Switching between sets of speakers will result in the same playback volume.
• Use the calibrated Control Room level for film or DVD mixing.
Set this level to the proper speaker volume as determined by
the mixing standard you choose to follow.

The channel configuration of the “Main Mix” (the default
output) determines what the channel configuration of the
Control Room channel will be. Switching between a project
that has a stereo Main Mix to a project that has a 5.1 Main
Mix will cause the Control Room channel in the Control
Room Mixer to change from a stereo to a 5.1 configuration.
The Main Mix configuration also determines the layout of
the Speaker Solo panel. If the Main Mix is stereo, there will
only be a left and right speaker in the solo panel.
Any external input that has more channels than the Main
Mix will not be heard correctly when routed to the Control
Room channel. Only the channels available will be heard.
Ö If a 5.1 external input is routed to a stereo Control
Room channel, only the left and right channels will be heard
even if a 5.1 Monitor is selected. Only two channels can be
routed through a stereo Control Room channel. You could
use an instance of MixConvert on the external input’s inserts to down-mix the material to stereo in order to hear it.

Control Room preferences
There are several preferences for the Control Room Mixer.
These are found in the Preferences (VST–Control Room
page).

Suggested settings
With all the versatility that the Control Room provides
there are also opportunities for confusion when first setting up the Control Room. The following list contains suggestions that could help to quickly set up the Control
Room to get started for recording and mixing.
• If you do not have a master recording device and only use the
Export Mixdown function to create finished mix files, set your
Main Mix output to “Not Assigned”. This eliminates many confusing errors and unpredictable behavior since outputs and
Control Room Monitors can share hardware outputs. The
Main Mix is automatically routed to the Control Room channel
and will not be affected.
• Create one stereo Monitor to familiarize yourself with the Control Room level controls, DIM settings, the Listen Bus and
other monitoring features. Once you have become acquainted
to some of these functions, create additional Monitors for every set of speakers you intend to use.
• Use the inserts on Monitor channels for surround decoding
and bass management plug-ins among other things.
• Use the inserts on the Control Room channel for metering and
spectral analysis plug-ins. All solos including the Listen Bus
will come through the Control Room channel allowing analysis
of individual sounds.

The Control Room Preferences

Most of these preferences deal with what options are visible in the Control Room Mixer. This allows you to customize the layout of the Mixer and only have the controls
visible that you use the most without added clutter.
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The other preferences have the following functionality:

• In the Project Mixer, the Studio Sends are accessed by
choosing the Studio Sends option from the View options
pop-up menu in each channel or by clicking the star icon
(“Show Studio Sends”) on the common panel of the extended Project Mixer.

• Reference Level
This setting determines the Control Room level used when the Reference Level button is activated.

• Main Dim Volume
This is the amount of gain reduction applied to the Control Room channel when the DIM button is activated.

• Show Control Room Volume in Transport Panel
This option makes the small fader at the right hand side of the Transport
Panel control the Control Room level. When this option is not activated
(or the Control Room is disabled), that fader controls the level of the
Main Mix bus.

• Disable Talkback during Recording
When activated, this option will turn off the Talkback channel when the
transport enters Record. It is advisable to set the Talkback DIM to 0dB
when using this feature so as not to radically change the mix level when
punching in and out of Record.

• Use Phones Channel as Preview Channel
When activated, the Headphone output will be used for Preview options
such as Import preview, scrubbing, offline process preview and certain
Sample Editor operations. Note that when using the Headphones output
for preview, the Control Room channel will no longer output preview audio.

• Dim Studio during Talkback
When this option is enabled, the cue mix heard in a Studio will be dimmed
(by the amount set in the Talkback dim level field (below the TALK button)
for as long as the Talkback channel is used. When disabled, the cue mix
level remains the same during Talkback.

Studios and Studio Sends
Studio Sends are displayed in the Nuendo Project Mixer
and the Inspector. Each Studio Send is intended for the
creation of a discrete cue mix for performers to listen to
during recording. Studio Sends are essentially stereo aux
sends that are routed to Studio outputs in the Control
Room Mixer. There are up to four Studios and Studio
Sends available.

Configuring Studio Sends
Studio Sends only become active when a Studio channel
has been created in the VST Connections window. Otherwise they remain grayed out. For every Studio defined in
the VST Connections, every channel in the Project Mixer
has an additional aux send with level, pan and pre/postfader selection. This aux send is used to create a mix for a
performer to listen to while recording.

The Studio Sends view in the Project Mixer
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• In the Inspector, a Studio Sends tab can be found. This
will display all Studio Sends for the selected track.

The name of each Studio is displayed in the Control Room
Mixer. To hear the Studio Sends mix in the Studio output,
the input selector for each Studio must be set to “Aux”.

Please note that not all Inspector sections are available by default. To
show/hide a section, right-click on an Inspector section and activate/
deactivate the desired option on the context menu.

A Studio channel in the Control Room Mixer with its input set to Aux.

Setting up a Studio cue mix
The Studio Sends are very flexible. There are several ways
to create a cue mix for each Studio in a very fast and efficient manner. Simple “more me” mixes and more complex
discrete mixes are easily accommodated by the Studio
Sends.

The Studio Sends tab in the Inspector

Each Studio can have a unique name in order to help
identify what it is being used for. For example, the four
Studios could be named:
•
•
•
•

Using fader and pan settings from the Project Mixer

Vocalist Mix
Guitarist Mix
Bassist Mix
Drummer’s Mix

You can create a cue mix from the fader and pan levels already used in the Project Mixer and then alter them to
meet the needs of an individual performer. You can do this
with any single channel or group of channels at any time.
To copy fader and pan information from the main mix, proceed as follows:
1. In the Project Mixer, select all the channels that you
wish to copy settings from.
The following operations affect only selected channels.
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2. In the Control Room Mixer, right-click anywhere in a
Studio Channel’s mixer strip and a context menu will appear that has the Studio’s name as a submenu.

Adjusting the overall Studio Send level
Levels in the main mix are often optimized for the loudest
signal level possible without clipping. However, when you
are creating a “more me” mix, you may find that there is not
enough headroom available in the Studio Send to turn up
channels without clipping becoming a possibility.

This submenu contains all the Studio Send functions for that Studio. If
you open the context menu outside of a Studio mixer strip, the submenu
will be for All Studios.

Fortunately, the Studio Sends have an option to adjust
multiple send levels at the same time, allowing you to keep
the blend intact while lowering the overall volume to make
room for “more me” signals.
Once you have created a Studio Send mix, proceed as
follows to adjust their relative levels.
1. Select all the channels you wish to modify.
Only selected channels are affected by the context menu commands.

2. Right-click anywhere in the Studio mixer strip on the
Control Room Mixer to open the context menu for that
Studio.
You may also use the context menu outside of the Studio strip to adjust
all four Studio Sends on the selected channels at the same time.

3. Choose the “Change Studio Sends Level” option from
the Studio submenu.

The Control Room Mixer’s context menu

3. Choose the “Use Current Mix Levels” option to copy
the fader levels on the selected tracks to the Studio Sends.

This will bring up a gain window with a checkbox that reads “Relative
Mode”. Make sure this is activated if you want to adjust already existing
levels.

This option sets all Studio Send levels for the selected tracks to the
same level as the main channel fader. It also changes the Studio Send
status to pre-fader so that changes in the main mix do not affect the Studio Sends.

4. Either use the up and down buttons or click on the numeric readout to open a pop-up fader and adjust the gain
as necessary.

4. Choose the “Use Current Pan Settings” option to
copy pan information from the main mix to the Studio
Sends on selected tracks.

The level of all selected Studio Sends will be adjusted by the amount
shown here. For example, if the amount reads -3dB, then each Studio
Send level is reduced by 3dB.

Studio Sends are either mono or stereo. If the Send is mono, the pan
setting will still be copied. However, the output of the Studio Send will
sum the left and right channels together.

5. Choose the “Enable Studio Sends” option to activate
the Sends on selected channels.
By default, Studio Sends are not enabled even when level and pan information is copied to them. You must enable them in order to hear the Studio cue mix.

By copying the level and pan information from the main
mix to the Studio Sends, a rough balance can be created
in a matter of moments. Next, you may alter the level and
pan settings on any channel’s Studio Sends to change the
mix to meet the performer’s needs. This may require increasing the volume of the performer herself. This is often
referred to as a “more me” mix.
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5. Click OK and the level change will be performed.

3. Selecting the “Reset Studio Sends” option changes
the Send level of all selected channels to -6dB and sets
the signal source to post-fader.

It is possible to view these changes as they occur if you have the Project
Mixer open and the extended view set to show the Studio Sends.

The -6dB level is designed to allow for headroom for “more me” signals
in the Studio outputs.

Once all Studio Sends have been set to -6dB, post-fader,
any changes to the main mix will also change the Studio
mix. For “more me” channels, simply turn up the level on
that channel or even set the signal to pre-fader for absolute control.
Studio Send cue mix summary
!

If you deactivate the “Relative Mode” option, all Studio Sends will be set to the same absolute level.
While the dialog window is still open, you may check
the “Relative Mode” box again and reload the previous relative levels. Only when you click OK, will the
level settings be made permanent. Choosing Cancel
returns all Send levels to their previous settings.

Using various combinations of the above techniques
should allow you to create complex discrete cue mixes for
performers in very little time. Modifications to these mixes
can occur in the Project Mixer or the Inspector, giving you
the most accessibility for quick changes.
To familiarize yourself with how the Studio Sends work,
open the extended Project Mixer and set the view to the
Studio Sends. Follow the above examples and watch how
the Studio Sends react to various commands. This should
help you get a feel for how they function and increase the
workflow productivity of recording sessions.

Using Studio Sends from outputs
Each output also has Studio Sends. Studio Sends from
the Main Mix output can be used to route the main mix instantly to the Studio output.
Any level changes made to the main mix will be reflected
in the signal sent by the Studio Send. Setting the level
lower than 0dB can leave headroom for “more me” signals
in the Studio channel output.

Direct Monitoring and latency
The Control Room and Studio Sends functions use the internal processing power of the host computer system for
all routing and processing, which means they are subject
to the computer’s latency.

Post-Fader Studio Sends
It is also possible to use the Studio Sends as post-fader
aux sends. This is another way for the cue mix to follow
changes made to the Main Mix. The Reset function is very
helpful in this regard.

When recording with several performers at once, a system
capable of running at very low ASIO buffer settings will be
necessary to take full advantage of all the Studio Send
features.

To reset the Studio Sends to the post-fader default level
of -6dB, proceed as follows:

Studio Sends are not capable of controlling the Direct
Monitoring features of various audio hardware interfaces.
This means that unless the internal latency of the system is
very low (128 samples or less), monitoring of record-enabled tracks through the Studio Sends will have some delay that could affect performers during recording.

1. Select all the channels you wish to reset.
Studio Send commands only work on selected channels.

2. In the Studio Channel mixer strip right-click to open
the context menu. In the Studio submenu, select the “Reset Studio Sends” command.

In the situation where internal latency is too much for
record monitoring, it is advisable to use the Studio Sends
for monitoring of tracks that have already been recorded
and use normal Direct Monitoring for tracks currently being recorded.

If you open the context menu in other areas of the Control Room Mixer
besides the Studio mixer strips, the context menu commands will affect
all Studios at the same time.
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WK-Audio’s ID Controller
With the implementation of the Control Room Features,
functionality for the Monitoring Section of the ID control
surface has been enabled. The ID has controls for most of
the Control Room features including:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Control Room Level
Studios 1-3 Level
Control Room Level Meter
DIM
Talkback (with built in mic preamp)
Talkback DIM
Listen Bus AFL/PFL
Listen Bus DIM
Monitor Selection
Speaker Solos
External Input Switching
Headphones (with built-in headphone amp)
Speaker Down-Mix Control
Input Selection for Control Room and Headphones
!

Complete documentation on the ID features is available from WK-Audio.
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Ö Please note that this functionality is provided to allow
you to load older projects including their original plug-ins
on current computers. However, the plug-ins will require
higher CPU performance when compared to their native
platform. Therefore, it is recommended to use 64 bit versions or Intel Mac (Universal Binary) versions of such
plug-ins or instruments once available.

About this chapter
Nuendo comes with a number of effect plug-ins included.
This chapter contains general details about how to assign,
use and organize effect plug-ins. The effects and their parameters are described in the separate manual “Nuendo
Expansion Kit – Cubase Music Tools for Nuendo 4”.
!

In the program, effects compatible with previous VST versions will be easily recognized:

This chapter describes audio effects, i.e. effects that
are used to process audio, group, VST Instrument
and ReWire channels.

Overview
An effect compatible with
a previous VST version.

There are three ways to use audio effects in Nuendo:

A VST 3
effect.

• As insert effects.
VST Preset management

An insert effect is inserted into the signal chain of an audio channel, which
means that the whole channel signal passes through the effect. This makes
inserts suitable for effects for which you don’t need to mix dry and wet
sound, e.g. distortion, filters or other effects that change the tonal or dynamic characteristics of the sound. You can have up to eight different insert effects per channel (and the same is true for input and output busses
– for recording with effects and “master effects”, respectively).
Each audio channel has eight effect sends, each of which can be freely
routed to an effect (or to a chain of effects). Send effects are practical for
two reasons: you can control the balance between the dry (direct) and
wet (processed) sound individually for each channel using the sends,
and several different audio channels can use the same send effect. In
Nuendo, send effects are handled by means of FX channel tracks.

From a user perspective, the main difference between
VST 2 and VST 3 is in the effect preset management. The
“.fxp/.fxb” files used in VST 2 have been replaced by
VST 3 Presets (extension “.vstpreset”). Using the preset
management features, you can assign various attributes to
your effect presets to help you quickly find the right patch.
You can also preview effect presets before you load them.
A large number of presets for effects are included with the
program. If you have any previous VST plug-ins installed
on your computer, you can still use them, and you can also
convert their programs to VST 3 presets. See “Effect presets” on page 183 for details.

• By using offline processing.

Smart plug-in processing

• As send effects.

You can apply effects directly to individual audio events – this is described in the chapter “Audio processing and functions” on page 238.

Another feature of the VST3 standard is “smart” plug-in
processing. Previously, any loaded plug-in was processing
continuously, regardless of whether a signal was present or
not. In VST3, processing by a plug-in can be disengaged if
there is no signal present. This can greatly reduce the CPU
load, thus allowing for more effects to be used.

About VST 3
The new VST 3 plug-in standard offers many improvements over the previous VST 2 standard, yet retains full
backwards compatibility, i.e. you will still be able to use
your previous VST effects and presets.

This is achieved by activating the option “Deactivate VST3
Plug-in when silence is detected” in the Preferences dialog (VST – Plug-ins page).

Nuendo is able to run plug-ins originally developed for different platforms: you can use a 32-bit plug-in under Windows Vista 64 bit, and you can use plug-ins developed for
Mac PPC on MacIntel systems.

When this is activated, VST 3 plug-ins will not consume
CPU power on silent passages, i.e. when no audio data
runs through them.

As the use of 32-bit plug-ins on 64-bit computers affects
the computer performance, these will be marked by an
icon in the plug-in menus.
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About tempo sync

Be aware, however, that this can lead to a situation where
you added more plug-ins on "transport stop" than the system can handle on playback. Therefore, you should always
find the passage with the largest number of events playing
simultaneously to make sure that your system offers the required performance.

Plug-ins can receive timing and tempo information from
the host application (in this case, Nuendo). Typically, this
is used to synchronize certain plug-in parameters (such as
modulation rates or delay times) to the project tempo.
• This information is automatically provided to any VST
(2.0 or later) plug-in that “requests it”.

Ö Activating this option can increase your system performance a lot in certain projects, but it also makes it more
unpredictable whether the project can play back fine on
any timecode position of the project.

You don’t need to make any special settings for this.

• You set up tempo sync by specifying a base note value.
You can use straight, triplet or dotted note values (1/1 - 1/32).

About side-chain inputs

Please refer to the separate manual “Nuendo Expansion
Kit – Cubase Music Tools for Nuendo 4” for details about
the included effects.

Several VST3 effects feature side-chain inputs. This
means that the operation of the effect can be controlled
via external signals routed to the side-chain input. The effect processing is still applied to the main audio signal.
See “Setting up side-chain” on page 180.

Insert effects
Background

About plug-in delay compensation

As the name implies, insert effects are inserted into the
audio signal path – this means that the audio channel data
will be routed through the effect. You can add up to eight
different insert effects independently for each audio channel (audio track, group channel track, FX channel track,
VST Instrument channel or ReWire channel) or bus. The
signal passes through the effects in series from the top
downwards, with the signal path shown below:

A plug-in effect may have some inherent delay or latency.
This means that it takes a brief time for the plug-in to process the audio fed into it – as a result, the output audio
will be slightly delayed. This especially applies to dynamics processors featuring “look-ahead” functionality.
However, Nuendo provides full plug-in delay compensation throughout the entire audio path. All plug-in delays
are compensated for, maintaining the sync and timing of
all audio channels.

Input gain

Normally, you don’t have to make any settings for this. However, VST3 dynamics plug-ins with look-ahead functionality
have a “Live” button, allowing you to disengage the lookahead to minimize latency, if they are to be used during realtime recording (see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”).

Insert effect 1
Insert effect 2
Insert effect 3
Insert effect 4
Insert effect 5

You can also constrain the delay compensation, which is
useful to avoid latency when recording audio or playing a
VST Instrument in real time. See “VST Instruments and Instrument tracks” on page 189.

Insert effect 6
EQ
Volume (fader)
Insert effect 7
Insert effect 8
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• If the effect has a dry/wet Mix parameter you can use
this to adjust the balance between the dry signal and the
effect signal.

As you can see, the last two insert slots (for any channel)
are post-EQ and post-fader. Post-fader slots are best
suited for insert effects where you don’t want the level to
be changed after the effect, such as dithering (see “Dithering” on page 173) and maximizers – both typically used
as insert effects for output busses.

See “Making settings for the effects” on page 182 for details about editing effects.

• To remove an effect, pull down the effect type pop-up
menu and select “No Effect”.

Ö Applying several effects on several channels may be
too much for your CPU to handle!

You should do this for all effects that you don’t intend to use, to reduce
the CPU load.

If you want to use the same effect with the same settings on several
channels, it may be more efficient to set up a group channel and to apply
your effect only once, as a single insert for this group. You can use the
VST Performance window to keep an eye on the CPU load.

• You can add up to 8 insert effects per channel this way.
• You can reorder the effects by clicking in the area above
the name field and dragging the effect onto another slot.

Routing an audio channel or bus through
insert effects

• You can copy an effect into another effect slot (for the
same channel or between channels) by holding down
[Ctrl]/[Command] and dragging it onto another effect slot.

Insert effect settings are available in the mixer (in extended
mode), the Channel Settings window and the Inspector.
The examples below show the Channel Settings window,
but the procedures are the same for all three inserts sections:

Deactivating vs. bypassing
If you want to listen to the track without having it processed by a particular effect, but don’t want to remove
this effect completely from the insert slot, you can either
deactivate or bypass it:

1. Bring up the Channel Settings window, the Inserts
pane in the extended mixer, or open the Inspector’s Inserts
section.

• To deactivate an effect, click the blue button on the left
above the insert slot.

In the Channel Settings window, the inserts are located to the far left by
default.

• To bypass an effect, click its Bypass button (the middle
button above the insert slot).

2. Pull down the effect type pop-up for one of the insert
slots, and select an effect.

When an effect is bypassed, this button is yellow.
This effect is activated, and
its control panel is open.
This insert effect is bypassed.

Deactivating means to terminate all processing, whereas
bypassing means to play back only the unprocessed original signal – a bypassed effect is still processing in the
background. Bypassing allows for crackle-free comparison
of the original (“dry”) and the processed (“wet”) signal.

The effect is loaded and automatically activated and its control panel opens. You can open or close the control panel
for an effect by clicking the “e” button for the insert slot.
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• To bypass all inserts for a track, click the global bypass
button.

However, you may want to apply the effect to other speaker
channels. This is done in the Channel Settings window:

This button can be found at the top of the Inserts section in the Inspector
or the Channel Settings window. It lights up in yellow to indicate that the
inserts of this track are bypassed. In the track list and the channel strip in
the mixer, the Inserts State button will also light up in yellow.

1. Right-click somewhere in the Channel Settings window (except the EQ display) to open the Channel Settings
context menu.
2. Select “Customize View” from the menu, and select
“Insert Routing” from the submenu.
The Insert Routing section appears to the left of the EQ display. It contains a row of small signal diagrams.

Insert effects in the channel overview
If the “Channel” section is selected in the Inspector or the
“Channel Overview” view mode is selected in the extended
mixer, you will get an overview of which insert effects, EQ
modules and effect sends are activated for the channel.
You can activate or deactivate individual insert effect slots
by clicking the corresponding number (in the top part of
the overview).

The blue color of inserts 1 and 2 and
the blue Inserts State button in the
channel strip indicate that this track
has active inserts.

3. Double-click on the small signal diagram for the effect
to open the Routing Editor window.

The channel overview in the Inspector.

Using mono or stereo effects with a surround
channel

The Routing Editor window.

Whether your effect supports mono, stereo or multi-channel processing, depends entirely on the effect plug-in.

The columns in the diagram represent the channels in the
current configuration, with signals passing from top to
bottom. The gray field in the middle represents the actual
effect plug-in.

Normally, when you apply a mono or stereo insert effect to
a surround (multi-channel) track, the first speaker channels of the track (often L and/or R) are routed through the
effect’s available channels, and the other channels of the
track are left unprocessed.

• The squares above the effect represent inputs to the effect
plug-in.
• The squares below the effect represent outputs from the effect plug-in.
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• A line that passes through the effect (with no square input/
output indicators) represent a bypass connection – the audio
on that speaker channel passes the effect without being processed.
• A “broken” line indicates a broken connection – the audio on
that speaker channel will not pass on to the output at all.

• Clicking Reset takes you back to the original standard
connection.
Ö Changes you make in this window are audible immediately.

Adding insert effects to busses
All input and output busses have eight insert slots, just like
regular audio channels. The procedures for adding insert
effects are the same.
• Adding insert effects to an input bus allows you to
record with effects.
The effects will become a permanent part of the recorded audio file (see
the chapter “Recording” on page 64).

• Insert effects added to an output bus will affect all audio
routed to that bus, like a “master insert effect”.

Here, the effect will process the L and R channels. The Ls, Rs and C
channels are not processed, while the Lfe connection is broken.

Typically you would add compressors, limiters, EQ or other plug-ins to
tailor the dynamics and sound of the final mix. Dithering is a special case,
as described below.

Operations
You can move connections to the effect inputs and outputs sideways to route the audio to/from inputs/outputs
other than the standard configuration. To do this, click the
arrow buttons to the right.

Ö Please note that the input/output busses only appear
as tracks in the Track list, when their automation W(rite)
buttons have been activated once. I.e. you can only use
the Inspector section to make Inserts settings for the busses if you have activated Write automation for the respective bus beforehand.

• The upper two arrows move the input connections, and
the lower two arrows move the output connections.
If the “Link” checkbox is activated, the input and output connections will be
moved at the same time. This is the mode to use when you simply want to
process other channels than the default, without any cross-connections.

However, you can always make Inserts settings in the Channel Settings
window and the extended mixer.

• If you move inputs or outputs independently of each
other, this means you create a “cross-connection”.

Dithering
Dithering is a method for controlling the noise produced
by quantization errors in digital recordings. The theory behind this is that during low level passages, only a few bits
are used to represent the signal, which leads to quantization errors and hence distortion.
For example, when “truncating bits”, as a result of moving
from 24 to 16 bit resolution, quantization errors are added
to an otherwise immaculate recording. By adding a special kind of noise at an extremely low level, the effect of
these errors is minimized. The added noise could be perceived as a very low-level hiss under exacting listening
conditions. However, this is hardly noticeable and much
preferred to the distortion that otherwise occurs.

The audio on the Ls-Rs channels is processed in the plug-in and output
on the L-R channels. Since the L-R channels are bypassed, this means
the final L-R output will contain both the original L-R signals and the
processed Ls-Rs signals.

• If a channel is bypassed (a straight line is shown
through the plug-in) you can click the line to break the
connection.
Click again to replace the broken connection with a bypass.
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When should I use dithering?

Using group channels for insert effects

• Consider dithering when you mix down to a lower resolution, either in real-time (playback) or with the Export Audio Mixdown function.

Like all other channels, group channels can have up to
eight insert effects. This is useful if you have several audio
tracks that you want to process through the same effect
(e.g. different vocal tracks that all should be processed by
the same compressor).

A typical example is when you mix down a project to a 16-bit stereo audio file for audio CD burning.

What is a “lower resolution” then? Well, Nuendo uses 32bit float resolution internally, which means that all integer
resolutions (16 bit, 24 bit, etc.) are lower. The negative effects of truncation (no dithering) are most noticeable when
mixing down to 8 bit, 16 bit and 20 bit format; whether to
dither when mixing down to 24 bits is a matter of taste.

Another special use for group channels and effects is the
following:
If you have a mono audio track and want to process this
through a stereo insert effect (e.g. a stereo chorus or an
auto panner device), you cannot just insert the effect as
usual. This is because the audio track is in mono – the
output of the insert effect will be in mono as well, and the
stereo information from the effect will be lost.

Applying dithering
1. Open the VST Output Channel Settings window by
clicking the “e” button for the Output channel in the mixer.

One solution would be to route a send from the mono
track to a stereo FX channel track, set the send to prefader mode and lower the fader completely for the mono
audio track. However, this makes mixing the track cumbersome, since you cannot use the fader.

You can also display the Inserts section in the extended mixer pane.

2. Open the Inserts pop-up menu for slot 7 or 8.
The two last Insert effect slots (for all channels) are post-fader, which is
crucial for a dithering plug-in. The reason is that any master gain change
applied after dithering would bring the signal back to the internal 32 bit
float domain, rendering the dithering settings useless.

Here’s another solution:
1. Create a group channel track in stereo and route it to
the desired output bus.

3. Select the included UV22HR dithering plug-in from
the pop-up menu.

2. Add the desired effect to the group channel as an insert effect.

The included dithering plug-ins and their parameters are
described in the separate manual “Nuendo Expansion Kit
– Cubase Music Tools for Nuendo 4”. If you have installed
another dithering plug-in that you prefer, you can of
course select this instead.

3. Route the mono audio track to the group channel.
Now the signal from the mono audio track is sent directly
to the group, where it passes through the insert effect, in
stereo.

4. Make sure the dithering plug-in is set to dither to the
correct resolution.
This would be the resolution of your audio hardware (on playback) or the
desired resolution for the mixdown file you want to create (as set in the
Export Audio Mixdown dialog, see the chapter “Export Audio Mixdown”
on page 437).

5. Use the other parameters in the control panel to set up
the dithering to your liking.
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Freezing (rendering) insert effects for a track

Unfreezing

Effect plug-ins can sometimes require a lot of processor
power. If you are using a large number of insert effects for
a track, you may eventually reach a point where the computer cannot play back the track properly (the CPU overload indicator in the VST Performance window lights up,
you get crackling sounds, etc.).

If you need to edit the events on a frozen track or make
settings for the insert effects, you can unfreeze the track:

To remedy this, you can freeze the track, by clicking the
Freeze button in the Inspector.

This reactivates the frozen insert effects. Clicking “Keep Freeze Files”
will unfreeze the channel but not delete the freeze files. After editing you
can freeze the track again.

1. Click the Freeze button in the Inspector for the track.
You will be asked whether you really want to unfreeze the channel and if
you wish to keep or delete the freeze files.

2. Click “Unfreeze” or “Keep Freeze files”.

Send effects
Background
• The Freeze Channel Options dialog is opened, allowing
you to set a “Tail” time in seconds.

As their name implies, send effects are outside of an audio
channel’s signal path, i.e. the audio data to be processed
must be sent to the effect (as opposed to insert effects,
which are inserted into the channel’s signal path).

This adds time at the end of the rendered file to allow reverb and delay
tails to fully fade out.

• The program now renders the output of the track, including all pre-fader insert effects, to an audio file.

To this end, Nuendo provides FX channel tracks. When
you have created such a track, it is added to the track list
and can be selected as a routing target in the Send slots
of audio channels.

This file is placed in the “Freeze” folder within the Project folder (Windows). On the Mac, the Freeze folder is stored under “User/Documents”.

• The frozen audio track is locked for editing in the Project
window.

• When selecting an FX channel track in one of the send
slots of an audio channel, the audio is sent to the FX channel and through any insert effects set up for it.

The frozen insert effects cannot be edited or removed and you cannot
add new insert effects for the track (except post-fader effects).

Each audio channel has eight sends, which can be routed to different FX
channels, and thus different FX channel insert effect configurations. You
control the amount of signal sent to the FX channel by adjusting the effect send level.

• On playback, the rendered audio file is played back.
You can still adjust the level and panning in the Mixer,
make EQ settings and adjust the effect sends.
In the Mixer, the channel strip for a frozen track is indicated by a “snow
flake” symbol on the volume fader handle.

• If you have added several effects to the FX channel, the
signal passes through the effects in series, from the top
(the first slot) downward.

After freezing the Inserts for a track, you hear the track
play back as before but the insert effects don’t have to be
calculated in real time, easing the load on the computer
processor. Typically, you would freeze a track when it’s
finished and you don’t need to edit it anymore.

This allows for “custom” send effect configurations – e.g. a chorus followed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel strip in the
mixer, the effect return channel.

• You can only freeze audio tracks this way, not group
channel tracks or FX channel tracks.

Here you can adjust the effect return level and balance, add EQ and
route the effect return to any output bus.

• The last two insert effects will not be frozen. This is
because these are post-fader insert slots.

• Each FX channel track can have any number of automation tracks, for automating various effect parameters.
See the chapter “Automation” on page 213 for more information.

• You can also freeze VST instruments and their insert
effects – see “VST Instruments and Instrument tracks” on
page 189.
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Setting up send effects

Adding and setting up effects
As mentioned above, you can add a single insert effect
when you create the FX channel track. To add and set up
effects after the FX channel track is created, you can either use the Inspector for the track (click the Inserts tab)
or the VST FX Channel Settings window:

Adding an FX channel track
1. Pull down the Project menu and select “FX Channel”
from the “Add Track” submenu.
A dialog appears.

1. Click the Edit (“e”) button for the FX channel track (in
the Track list, mixer or Inspector).
The FX Channel Settings window appears, similar to a regular Channel
Settings window.

2. Select a channel configuration for the FX channel
track.
Normally, stereo is a good choice since most effect plug-ins have stereo
outputs.

3. Select an effect for the FX channel track.
This is not strictly necessary at this point – you can leave the plug-in
pop-up menu set to “No Effect” and add effects to the FX channel later if
you like.

4. Click OK.

To the left in the window is the Inserts section with eight effect slots.

An FX channel track is added to the track list, and the selected effect, if
any, is loaded into the first insert effect slot for the FX channel (in that
case, the lit Inserts tab for the FX channel track in the Inspector indicates
that an effect has been assigned and automatically activated).

2. Make sure the FX channel is routed to the correct output bus.

• All FX channel tracks you create will appear in a dedicated “folder” track in the Track list.

3. To add an insert effect in an empty slot (or to replace
the current effect in a slot), click in the slot and select an
effect from the pop-up menu.

This is done with the output routing pop-up menu at the top of the fader
section (also available in the mixer and Inspector).

This makes it easy to manage and keep track of all your FX channel
tracks, and also allows you to save screen space by folding in the FX
Channel folder.

This works just like when selecting insert effects for a regular audio
channel.

4. When you add an effect, its control panel will automatically appear. When you set up send effects, you would
normally set the wet/dry Mix control to all “wet”.
This is because you control the balance between the wet and the dry signal with the effect sends. For more information, see “Making settings for
the effects” on page 182.

• You can add up to eight effects for an FX channel.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you
can rename them if you wish. Just double-click the name of an FX channel track in either the Track list or the Inspector and type in a new name.

The signal will pass through all the effects in series. It is not possible to
adjust the effect send and return levels separately for the effects – this is
done for the FX channel as a whole. If what you want is several separate
send effects (where you can control the send and return levels independently), you should instead add more FX channel tracks – one for each
effect.
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• You can reorder the effects by clicking in the area above
the name field and dragging the effect onto another slot.

2. Pull down the routing pop-up menu for a send by
clicking in the empty slot, and select the desired routing
destination.

• You can copy an effect into another effect slot (for the
same channel or between channels) by holding down
[Ctrl]/[Command] and dragging it onto another effect slot.
• To remove an insert effect from a slot, click in the slot
and select “No Effect” from the pop-up menu.
You should do this for all effects that you don’t intend to use, to reduce
the CPU load.

• You can bypass individual effects (or all effects) by
clicking the corresponding Bypass button(s) for the FX
channel track.

• If the first item on this menu (“No Bus”) is selected, the send
isn’t routed anywhere.
• Items called “FX 1”, “FX 2” etc. correspond to existing FX
tracks. If you renamed an FX track (see “Adding an FX channel
track” on page 176) that name will appear on this menu instead of the default.
• The menu also allows for routing a send directly to output busses, separate output bus channels or Group channels.

See “Routing an audio channel or bus through insert effects” on page 171.

• You can also adjust level, pan and EQ for the effect return in the FX Channel Settings window.
This can also be done in the mixer or in the Inspector.

Ö Remember that the more effect units you use, the
higher the CPU load.

3. Select an FX channel track from the pop-up menu.

Setting up the sends

Now the send is routed to the FX channel.

The next step is to set up a send for an audio channel and
route it to the FX channel. This can be done in the mixer (in
the extended panel), in the Channel Settings window or in
the Inspector for the audio track. The example below
shows the Channel Settings window, but the procedure is
similar for all three sections:

4. Click the power button for the effect send so that it
lights up in blue.
This activates the send.

1. Click the “e” button for an audio channel to bring up its
Channel Settings window.
In the mixer you would select one of the Sends modes for the extended
mixer panel; in the Inspector you would click the Sends tab.

5. Click and drag the send level slider to a moderate
value.

In the Channel Settings window, the send section is located to the left of the channel strip by default. Each of the
eight sends has the following controls:

The send level determines how much of the signal from the audio channel is routed to the FX channel via the send.

•
•
•
•

An On/Off button for activating/deactivating the effect
A send level slider
A pre/post-fader switch
An “e” (edit) button
Setting the Send level.

Note that the last three items are not shown until the send
is activated and an effect has been loaded.
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6. If you want the signal to be sent to the FX channel before the audio channel’s volume fader in the mixer, click on
the Pre-Fader button for the send so that it lights up.

• You can also bypass individual sends in the channel
overview.

Normally you want the effect send to be proportional to the channel volume (post-fader send). The picture below shows where the sends are
“tapped” from the signal in pre and post-fader mode.

• You can also bypass the send effects by clicking the
“Bypass Inserts” button for the FX channel.

See “Insert effects in the channel overview” on page 172.

This bypasses the actual send effects which may be used by several different channels. Bypassing a send affects that send and that channel
only. If you bypass the insert effect the original sound will be passed
through. This may lead to unwanted side effects (higher volume). To deactivate all effects, use the mute button in the FX channel.

Input gain
Insert effects 1-6

Setting pan for the sends

EQ
Pre-fader sends

By default, the sends for an audio channel follow any pan
settings – stereo or surround – you make for the channel
itself. This means that if an audio channel is panned to the
right, the signal from its effect sends will be panned the
same way, making the stereo imaging as clear and true as
possible.

Volume (fader)
Insert effects 7-8
Post-fader sends

However, you may want to have different pan settings for
the sends. There are several uses for this:
• If you route a send from a mono channel to a stereo FX channel track, you can position the send signal at center pan in the
stereo FX channel (or anywhere you like).
• If you route a send from a stereo channel to a mono FX channel track, the pan control works as a crossfader, determining
the balance between the stereo sides when the stereo send
signal is mixed to mono.
• If you route a send from a mono or stereo channel to a FX
channel track in surround format, you can use the surround
panner to position the send signal in the surround image.
• If you route a send from a surround channel to an FX channel in
a format with less channels, you can set the panning with the
Mixconvert plug-in.

A send set to pre-fader mode.

Ö You can choose whether a send in pre-fader mode
should be affected by the channel’s Mute button or not.
This is done with the option “Mute Pre-Send when Mute” in the Preferences dialog (VST page).

• When one or several sends are activated for a channel,
the Send Effects buttons light up in blue in the mixer and
the Track list. Click the button for a channel to bypass
(disable) all its effect sends.
When the sends are bypassed, the button is yellow. Click the button again
to enable the sends. Note that this button is also available in the Inspector
and the Channel settings window.

Click this button to bypass the sends.
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You set up send panning in the following way:

4. Click and drag the pan control for the desired send(s)
in the display.

1. Open the Channel Settings window for the audio
channel.

You can reset the pan control to the center position by [Ctrl]/[Command]clicking on the pan control.

2. Right-click somewhere in the Channel settings window (not the EQ display), to open the context menu and
open the “Customize View” submenu.

• If the FX channel is configured in a surround format, the
pan control will be a miniature surround panner, similar to
the one found in the mixer.
You can click and drag the “ball” in the miniature panner display to position the send in the surround field, or double-click in the display to bring
up the surround panner. See the chapter “Surround sound” on page 202.

Ö If both the send (the audio channel) and the FX channel are in mono, the pan control is not available.
About sends for FX channels
The FX channels themselves have sends, too. However,
these can only be routed to output busses, not to effects.

3. From the submenu, select “Send Routing” and “Control Strip”.

Setting effect levels

In the Send Routing section of the Channel Settings window, each send is
shown as a small routing diagram showing a pre/post selector to the right
and a pan fader (where applicable). In the Control Strip section, you can
activate the option “Link Send Routing Panners to Channel Panner as Default”. When this is activated, the send panners follow the pan for the channel. This item is also available in the Preferences dialog (VST page).

When you have set up the sends as described in the previous sections, you can do the following:
• You can use the send level slider in the Channel Settings window, the Inspector or the extended mixer panel to
set the send level.

The Control Strip section

By adjusting the send level, you control the amount of signal sent from
the audio channel to the FX channel.

Link Send Routing
Panners to Channel
Panner

Setting the effect send level.

The Sends, Send Routing and Control Strip sections in the Channel Settings window.
179
Audio effects

• In the mixer, you can use the level fader for the FX channel to set the effect return level.

Using the Side-Chain input

By adjusting the return level, you control the amount of the signal sent
from the FX channel to the output bus.

Many VST 3.0 effects feature a side-chain input. Sidechaining allows you e.g. to lower the music volume when
someone is speaking (“ducking”) or to use compression
on e.g. a bass sound when the drums are hit, thereby
“harmonizing” the intensity of the two instruments. Another possibility is to use the side chain signal as a source
for modulation.
The following types of effects feature side-chain inputs:
• Delay plug-ins
The included delay plug-ins with side-chain functionality are MonoDelay,
PingPongDelay and StereoDelay.

• Dynamics plug-ins
The included dynamics plug-ins with side-chain functionality are Compressor, Expander, Gate and VintageCompressor.

• Modulation plug-ins
The included modulation plug-ins with side-chain functionality are AutoPan, Flanger, Phaser, StudioChorus, Tremolo and Vibrato.

• Filter plug-ins
The included filter plug-in with side-chain functionality is the WahWah
effect.
Setting the effect return level.

Setting up side-chain

FX channels and the Solo Defeat function

Ö Certain combinations of tracks and side-chain inputs
may lead to feedback loops and added latency. If this is
the case, the side-chain options will not be available.

When mixing, you might sometimes want to solo specific
audio channels, and listen only to these while other channels are muted. However, this will mute all FX channels as
well. If the soloed audio channels have sends routed to FX
channels, this means you won’t hear the send effects for
the channels.

!

For detailed descriptions of the plug-ins that feature
side-chaining, see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

Delay plug-ins

To remedy this, you can use the Solo Defeat function for
the FX channel:

The delay repeats can be silenced by side-chain signals
exceeding a certain threshold.

1. [Alt]/[Option]-click the Solo button for the FX channel.

You can use this feature to create a so-called “ducking
delay” for your vocals. Let’s say you want to add a delay
effect that is audible only when no signal is present on the
vocal track. For this, you need to set up a delay effect
which is deactivated every time the vocals start again.

This activates the Solo Defeat function for the FX channel. In this mode,
the FX channel will not be muted if you solo another channel in the mixer.

2. You can now solo any of the audio channels without
having the effect return (the FX channel) muted.
• To turn off the Solo Defeat function for the FX channel,
[Alt]/[Option]-click the Solo button for the FX channel
again.
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Proceed as follows:

Dynamics plug-ins

1. Select the vocal track.

Compression, expansion or gating can be triggered by
side-chain signals exceeding a specified threshold.

2. On the Project menu, select “Duplicate Tracks”.

You may run into a situation where you want to lower the
volume of one instrument every time another instrument is
played. You could e.g. want to lower the volume of the bass
guitar during the bass drum hits. This can be achieved by
applying compression to the bass guitar signal every time
the drum signals are present on the respective track.

Now you can use the vocal events on the second track to silence the delay effect.

3. Open the Insert tab for the first Vocal track in the Inspector and select “PingPongDelay” from the Effects
pop-up menu.
The control panel for the effect opens.

Proceed as follows:

4. On the control panel for the effect, make the desired
effect settings and activate the Side Chain button.

1. Select the bass guitar track.

Try out the effect settings to find out which settings will work best with your
project. For detailed descriptions of the parameters, see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

2. Open the Inserts tab in the Inspector, click in an insert
slot to open the effect selection pop-up menu and, on the
Dynamics submenu, select “Compressor”.
The effect is loaded into the effect slot and the effect control panel opens.

3. Make the desired effect settings (you will most likely
have to adjust them later to get the right compression
level) and activate the Side-Chain button.
4. Select the bass drum track.
5. Open the Sends Inspector section, click in a send slot
and from the Side-Chain submenu, select the Compressor effect you created for the bass guitar track. Adjust the
Send level.

5. In the Track list, select the second vocal track.
6. Pull down the Output Routing pop-up menu and on
the Side-Chain submenu, select the PingPongDelay effect you set up for the vocal track.

This way, the bass drum signal triggers the compressor on the bass guitar track.

When you now play back the project, the bass guitar will
be compressed whenever the signals on the bass drum
track exceed the threshold.

This way, the signals from the second (duplicate) track are routed to the
effect (and do not end up in the mix).

Modulation plug-ins
Side-chain signals bypass the built-in LFO modulation
and instead apply modulation according to the envelope
of the side-chain signal. Since each channel will be analyzed and modulated separately, this allows for creating
astonishing spatial stereo or surround modulation effects.
Feel free to experiment with the functions to see what they
have to offer!

Now every time the signals on the vocal track exceed the
threshold, the delay will be deactivated. Since the threshold for the delay effect is fixed, you may have to adjust
the volume of track 2, in this example, to ensure that vocal
parts of low or middle volume will also silence the delay
effect.
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About drag&drop and Side chain connections

Making settings for the effects

When you drag effects from one insert slot to another (on
the same channel or between different channels), the following applies:

Editing effects
All inserts and sends have an Edit (“e”) button. Clicking
this opens the control panel for the effect, in which you
can make parameter settings.

• When you move an effect within a channel (e.g. from slot 4 to
slot 6), the side chain connections will be kept.
• When you drag and drop an effect between two channels, the
side chain connections will not be kept.
• When copying an effect into another effect slot (for the same
or a different channel), the side chain connections will not be
copied, i. e. they will be lost.

The contents, design and layout of the control panel depends on the selected effect. However, all effect control
panels have an On/Off button, a Bypass button, Read/
Write automation buttons (for automating effect parameter
changes, see the chapter “Automation” on page 213), a
preset pop-up menu and a Preset Management pop-up
menu for saving and loading effect presets. Some plug-ins
also feature a side-chain button, see “Using the Side-Chain
input” on page 180.

Using external effects
Although this program comes with a top selection of VST
effect plug-ins, and although there’s a huge range of additional plug-ins available on the market, you may still have
some hardware effect units that you want to use – valve
compressors, reverb units, vintage tape echo machines,
etc. By setting up external FX busses you can make your
outboard equipment part of the Nuendo virtual studio!
An external FX bus is a combination of outputs (sends)
and inputs (returns) on your audio hardware, along with a
few additional settings. All external FX busses you have
created will appear on the effect pop-up menus and can
be selected like the internal effect plug-ins. The difference
is that if you select an external effect as an insert effect for
an audio track, the audio will be sent to the corresponding
audio output, processed in your hardware effect (provided
that you have connected it properly) and returned via the
specified audio input.

The Rotary effect control panel.

• Please note that all effects can be edited using a simplified control panel (horizontal sliders only, no graphics). This
panel is opened by pressing [Ctrl]/[Command]+[Alt]/[Option]+[Shift] and clicking on the Edit button for the effect
send or slot.
Effect control panels may have any combination of knobs,
sliders, buttons and graphic curves.

Ö Creating and handling of external effects is described
in detail in the chapter “VST Connections: Setting up input and output busses” on page 10.

Ö The included effects and their parameters are described in detail in the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.
If you edit the parameters for an effect, these settings are
saved automatically with the project.
You can also save the current settings as a preset, see
below.
• Effects parameters can be automated – see the chapter
“Automation” on page 213.
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Effect presets

4. Activate playback to audition the selected preset.
Simply step through the presets until you found the right sound. It may be
helpful to set up cycle playback of a section to make comparisons between different preset settings easier.

Effect preset management in Nuendo is very versatile. In
the MediaBay – or with certain limits in the Save Preset dialog – you can assign attributes to presets which allow
you to organize and browse them according to various criteria. Nuendo comes with a huge array of categorized
track and VST presets that you can use straight out of the
box. You can also preview effect presets before loading
them which considerably speeds up the process of finding the right effect preset.

5. Double-click on the desired preset (or click outside
the Preset browser) to apply the preset.
• To return to the preset that was selected when you
opened the Preset browser, click the Reset button.
• You can also open the Preset browser by clicking the
VST Sound button to the right of the preset field an selecting "Load Preset" from the Preset Management popup menu.

Effect presets can be divided into the following main categories:
These are stored parameter settings for a specific effect.

• The preset handling for VST 2 plug-ins is slightly different, see “About earlier VST effect presets” on page 184.

• Inserts presets that contain insert effect combinations.

The Browser sections

These can contain the whole insert effects rack, complete with settings
for each effect, see “Saving insert effect combinations” on page 185.

The Preset browser contains the following sections:

• VST presets for a plug-in.

• The “Search & Viewer” section (displayed by default)
lists the available presets for the selected effect.

Selecting effect presets
Most VST effect plug-ins come with a number of useful
presets for instant selection.

• The Filter section (displayed when you click the Categories button) shows the available preset attributes for the
selected effect.

The preset browser

If no attributes have been specified for the effect presets, the columns
will be empty. If attributes have been assigned to a preset for this effect,
you can click on the attribute in the respective column (Category, Style
etc.), to filter out all presets that do not match the selected attribute(s).

To select an effect preset in the preset browser, proceed
as follows:
1. Load an effect, either as a channel insert or into an FX
channel.

• If you also activate the “Show Location” button, the
Browser & Filter section is displayed, allowing you to
specify the Presets folder that should be searched for
preset files.

The control panel for the effect is displayed.

2. Click in the preset field at the top of the control panel.
This opens the preset browser.

• You can also open the Preset browser from the Inspector (Inserts tab) or the Channel Settings window.
3. Select the desired preset in the list.
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Saving effect presets

• Win: Documents and Settings/User name/Application data/
VST3 presets\<company>\ <plug-in name>
• Mac: Users/<user name>/Library/Audio/Presets/<company>/<plug-in name>

You can save your edited effect settings as presets for
further use (e.g. in other projects):
1. Click the VST Sound button to open the Preset
Management pop-up menu.

You cannot change the default folder, but you can add further subfolders inside the individual effect preset folders.

About earlier VST effect presets
As stated previously, you can use any VST 2.x plug-ins in
Nuendo. For a description of how to add VST plug-ins see
“Installing and managing effect plug-ins” on page 186.
2. Select “Save Preset…” from the pop-up menu.

When you add a VST 2 plug-in, any previously stored presets for it will be in the old FX program/bank format (.fxp/
.fxb). You can import such files, but the preset handling will
be slightly different. You will not be able to use the new features like the Tag editor until you have converted the old
“.fxp/.fxb” presets to VST 3 presets. If you save new presets for the included VST 2 plug-ins, these will automatically be saved in the new “.vstpreset” format.

This opens a dialog where you can save the current settings as a preset.

!

All VST 2 presets can be converted to VST 3 presets.

Importing and converting FXB/FXP files
To import .fxp/.fxb files, proceed as follows:
1. Load any VST 2 effect you may have installed, and click
on the VST Sound button to open the Preset Management
pop-up menu.

3. In the File name field in the lower part of the Save Preset dialog, enter a name for the new preset.
• If you wish to assign attributes to the preset, click the
Tag Editor button.

2. Select “Import FXB/FXP…” from the pop-up.

Click in the Value column to select an appropriate “tag” for one or several of the available categories in the Attributes column. For further information on preset handling and the Tag Editor, see the chapter “The
MediaBay” on page 314.

This menu item is only available for VST 2 plug-ins.

3. In the file dialog that opens, locate the .fxp file and
click Open.
If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected
effect program only. Note that such files exist only if you created your
own .fxp/.fxb presets with a previous version of Nuendo (or any other
VST 2 application).

4. Click OK to store the preset and exit the dialog.
User-defined presets are saved in the following location:

184
Audio effects

4. After importing, you can convert the current program
list to VST presets by selecting “Convert Program List to
VST Presets” from the Preset Management pop-up.

6. Select the preset you created from the pop-up menu.

After converting, the presets will be available in the Preset Browser, and
you can use the Tag Editor to add attributes and audition the presets.
The new converted presets will be stored in the VST3 Preset folder.

• Note that when loading insert combination presets, any
plug-ins that were previously loaded for the track will be
removed, regardless of whether these slots are used in
the preset.

The effects are loaded into the Insert slots of the new track, and the control panels for all effects are opened.

Saving insert effect combinations

In other words, saving an inserts preset means saving the states of all insert slots.

You can save the complete insert effect rack for a channel
together with all parameter settings as an inserts preset.
Inserts presets can be applied to audio, instruments, FX
channel or group tracks.

• You can use the Preset Management pop-up to save
your settings as preset, or to rename or remove the current preset.

This works as follows:

Extracting insert effect settings from track presets

1. Select the desired track in the Track list and open the
Inserts Inspector section.

You can extract the effects used in a track preset and load
them into your inserts “rack”:

2. Load a combination of insert effects and adjust the parameters (or select effect presets) for each effect.

• Select “From Track Preset…” on the Preset Management pop-up menu to open a dialog where all track presets are shown.

3. At the top of the Inserts tab, click the VST Sound button to open the Preset Management pop-up menu for the
inserts and select “Store Preset”.

• Select an item in the list to load the effects used in the
track preset.

This can also be done from the Channel Settings window using the VST
Sound button at the top of the Inserts section.

Track presets are described in their own chapter in the
Operation Manual.

4. Type in a name for the preset in the dialog that appears.
5. Select the track (audio/group/instrument/fx channel)
you wish to apply the new preset to, and click its VST
Sound button.
As you can see, the new preset is available at the top of the pop-up menu.
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Ö If an effect plug-in comes with its own installation application, you should use this.

Installing and managing effect plugins

As a general rule, always read the documentation or readme files before
installing new plug-ins.

Nuendo supports two plug-in formats; the VST 2 format
(with the file name extensions “.dll” on the PC and “.VST”
on the Mac) and the VST 3 format (extension “.vst3” on
both platforms). The formats are handled differently when
it comes to installation and organizing.

Installing VST 3 plug-ins under Windows
Under Windows, VST 3 plug-ins are installed by dragging
the files (with the extension “.vst3”) into the vst3 folder in
the Nuendo application folder. When you launch Nuendo
again, the new effects will appear on the Effect pop-up
menus. In the VST 3 protocol, the effect category, subfolder structure etc. are built-in and cannot be changed.
The installed new effect(s) will simply show up in the assigned category folder(s) on the effect pop-up menu.

Installing additional VST plug-ins
Installing VST 3 plug-ins under Mac OS X
To install a VST 3.x plug-in under Mac OS X, quit Nuendo
and drag the plug-in file into one of the following folders:
• /Library/Audio/Plug-Ins/VST3/

Installing VST 2 plug-ins under Windows

This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that
support them.

Under Windows, VST 2.x plug-ins are installed by dragging the files (with the extension “.dll”) into the Vstplugins
folder in the Nuendo application folder, or into the Shared
VST Plug-in folder – see below. When you launch Nuendo
again, the new effects will appear on the effect pop-up
menus.

• Users/Username/Library/Audio/Plug-Ins/VST3/
“Username” is the name you use to log on to the computer (the easiest
way to open this folder is to go to your “Home” folder and use the path /
Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder
are only available to you.

Ö If an effect plug-in comes with its own installation application, you should use this.

When you launch Nuendo again, the new effects will appear on the effect pop-up menus. In the VST 3 protocol, the
effect category, sub-folder structure etc. are built-in and
cannot be changed. The effect(s) will simply show up in the
assigned category folder(s) on the Effect pop-up menu.

As a general rule, always read the documentation before installing new
plug-ins.

Organizing VST 2 plug-ins
If you have a large number of VST 2 plug-ins, having them
all on a single pop-up menu in the program may become
unmanageable. For this reason, the VST 2 plug-ins installed with Nuendo are placed in appropriate subfolders
according to the effect type.

Installing VST 2.x plug-ins under Mac OS X
!

Plug-ins in Mac OS 9.X format cannot be used.

To install a VST 2.x plug-in under Mac OS X, quit Nuendo
and drag the plug-in file to one of the following folders:

• Under Windows, you can organize VST plug-ins by moving, adding or renaming subfolders within the Vstplugins
folder.

• /Library/Audio/Plug-Ins/VST/
This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that
support them.

When you launch the program and pull down an effects pop-up menu,
the subfolders will be represented by hierarchical submenus, each listing
the plug-ins in the corresponding subfolder.

• Username/Library/Audio/Plug-Ins/VST/

• Under Mac OS X, you cannot change the hierarchic arrangement of the “built-in” VST plug-ins.

“Username” is the name you use to log on to the computer (the easiest
way to open this folder is to go to your “Home” folder and use the path /
Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder
are only available to you.

However, you can arrange any additional plug-ins you have installed (in the
/Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, the subfolders will be represented by hierarchical
submenus, each listing the plug-ins in the corresponding subfolder.

When you launch Nuendo again, the new effects will appear on the effect pop-up menus.
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The other columns show the following information about
each plug-in:

About the effects from previous Nuendo versions
The Legacy folder on the program DVD contains effects
from previous versions of Nuendo.

Column

The main reason for installing these earlier plug-ins is
backwards compatibility, allowing you to import old Nuendo projects and get the correct effect settings.

The name of the plug-in.

Vendor

The manufacturer of the plug-in.

File

This shows the complete name of the plug-in (with extension).

Category

This indicates the category of each plug-in (such as VST Instruments, Surround Effects, etc.).

Version

Shows the version of the plug-in.

SDK

Shows with which version of the VST protocol a plug-in is
compatible.

Latency

This shows the delay (in samples) that will be introduced if the
effect is used as an Insert. This is automatically compensated
for by Nuendo.

The Plug-in Information window
On the Devices menu, you will find an item called “Plug-in
Information”. Selecting this opens a dialog listing all the
available VST compatible plug-ins in your system (including VST Instruments), along with all MIDI plug-ins.

Description

Name

Side Chain Shows the number of side-chain inputs for a plug-in.
Inputs
I/O

This column shows the number of inputs and outputs for each
plug-in.

Path

The path and name of the folder in which the plug-in file is
located.

Update button
Clicking this button will make Nuendo re-scan the designated VST folders for updated information about the plugins.
Managing and selecting VST plug-ins
VST 2.x Plug-in Paths button

To display all available VST plug-ins, open the “VST
PlugIns” tab.

This opens a dialog where you can see the current paths
to where VST 2.x plug-ins are located. You can freely
Add/Remove folder locations by using the corresponding
buttons. If you click “Add”, a file dialog is opened, where
you can select a folder location.

• To enable a plug-in (make it available for selection), put
a check mark in the left column.
Only the enabled plug-ins will appear on the effect menus.

• The Instances column indicates how many instances of
the plug-in are currently used in Nuendo.

About the “shared” plug-ins folder (Windows and VST
2.x only)

Clicking in this column for a plug-in which is already in use produces a
pop-up showing exactly where each use occurs.

You can designate a “shared” VST 2.x plugins folder. This
will allow VST 2.x plug-ins to be used by other programs
that support this standard.

Ö A plug-in may be in use even if it isn’t enabled in the
left column.
You might for example have opened a project containing effects that are
currently disabled on the menu. The left column only determines whether
or not the plug-in will be visible on the effect menus.

You designate a shared folder by selecting a folder in the
list and clicking the “Set As Shared Folder” button in the
VST 2.x Plug-in Paths dialog.

• All columns can be resized by dragging the divider in
the column header.
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Exporting plug-in information files
You can also save plug-in information as an .xml file, e.g.
for archiving purposes or troubleshooting. The Export function is available for VST, MIDI and Audio Codec plug-ins.
Proceed as follows:
1. Right-click on the desired tab in the Plug-in Information
window (for VST, MIDI or Audio Codec plug-ins), to open
the context menu and select “Export”.
A file dialog opens.

2. In the dialog, specify a name and location for the Plugin Information export file and click OK to export the file.
• The Plug-in Information file contains information on the
currently installed/available plug-ins, their version, vendor,
etc.
• The .xml file can then be opened in any editor application supporting the xml format.
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14
VST Instruments and Instrument tracks

Introduction

VST Instrument channels

VST Instruments are software synthesizers (or other sound
sources) that are contained within Nuendo. They are played
internally via MIDI. You can add effects or EQ to VST Instruments, just as with audio tracks.

You can access a VST Instrument from within Nuendo by
creating a VST Instrument channel and associating this
channel with a MIDI track. Proceed as follows:

Ö This chapter describes the general procedures for
setting up and using VST Instruments.

The VST Instruments window opens.

1. On the Devices menu, select “VST Instruments”.

Ö Depending on the VST version the instrument is compatible with, an icon may be displayed in front of the instrument name, see “About VST 3” on page 169.
Ö Note that VST instruments are only supplied as part of
the Nuendo Expansion Kit. You can, however, use your
own VST instruments in Nuendo. The VST instrument included in the Nuendo Expansion Kit are described in detail in the separate manual “Nuendo Expansion Kit –
Cubase Music Tools for Nuendo 4”.

2. Click in one of the empty slots to open the instrument
pop-up menu and select the desired instrument.
3. You will be asked if you want to create an associated
MIDI track connected to the VST Instrument. Do so.

VST Instrument channels vs. instrument tracks

The instrument is loaded and activated, and its control panel is opened.
A MIDI track with the name of the instrument is added to the Track list.
The output of this track is routed to the instrument.

Nuendo allows you to make use of VST Instruments in two
different ways:

In the Preferences dialog (VST–Plug-ins page), you can
specify what should happen when loading a VST instrument in an instrument slot. Open the pop-up menu “Create MIDI track when loading VSTi” and select one of the
available options:

• By activating instruments in the VST Instruments window.
This creates a VST Instrument channel, which can be played by one (or
several) MIDI track(s) routed to it.

• By creating instrument tracks.

• When you select “Always”, a corresponding MIDI track will always be created.
• When you select “Do not”, no track will be created and only
the instrument will be loaded.
• Select “Always ask to” if you want to decide whether a MIDI
track should be created whenever you load an instrument.

Instrument tracks are a combination of a VST Instrument, an instrument
channel and a MIDI track. You play and record MIDI note data directly for
this track.

Both methods have their advantages, and should be selected according to what best suits your needs. The following sections describe the two approaches.

You can also use modifiers to specify what should happen
when you load a VST instrument (overriding the Preference setting):
• When you hold down [Ctrl]/[Command] while selecting a VST
Instrument for an instrument slot, a corresponding MIDI track
with the name of the instrument is automatically created.
• When you hold down [Alt]/[Option] while selecting a VST Instrument for an instrument slot, no MIDI track will be created
for the instrument.
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• If you don’t want the plug-in control panels to open every
time you load a plug-in, open the Preferences dialog
(VST–Plug-ins page) and deactivate “Open Effect Editor
After Loading it”.

7. Activate the Monitor button for the MIDI track (in the
Track list, Inspector or mixer).
When this is activated (or when the track is record enabled), incoming
MIDI is passed on to the selected MIDI output (in this case the VST Instrument), see the chapter “Recording” on page 64.

You can open a plug-in panel at any time by clicking the “e” button of the
corresponding plug-in slot.

8. Open the mixer.
You will find one or more channel strips for the audio outputs of the VST
Instrument. VST Instrument channel strips have the same features and
functionality as group channel strips, with the addition of an Edit button at
the bottom of the strip for opening the VST Instrument control panel. You
will also find output routing pop-up menus at the top of the channel strips,
for routing the VST Instrument channels e.g. to output channels or
groups. Routing is described in detail in the chapter “VST Connections:
Setting up input and output busses” on page 10.

4. If you now look in the Project window track list, you will
find that a dedicated folder for the chosen instrument has
been added, within a “VST Instruments” folder (where all
your VST Instrument channels will be listed).
The separate folder for the added VST Instrument contains two or more
automation tracks: one for automating the plug-in parameters and one for
each mixer channel used by the VST Instrument. For example, if you add a
VST Instrument with four separate outputs (four separate mixer channels),
the folder will contain five automation tracks. To keep the screen less cluttered, you may want to close the folder for the VST Instrument until you
need to view or edit any of the automation tracks. For more about automation, see the chapter “Automation” on page 213.

9. Play the VST Instrument from your MIDI keyboard.
You can use the mixer settings to adjust the sound, add EQ or effects, etc.,
just as with regular audio channels. Of course, you can also record or manually create MIDI parts that play back sounds from the VST Instrument.

• When you select the MIDI track routed to the VST instrument, you will see that the Inspector contains a separate section for the instrument.

!

This section contains the audio channel settings for the VST Instrument
(inserts, EQs, Sends and fader settings). The tab has two buttons for
opening the Channel Settings window (for the VST Instrument channel)
and the Edit Instrument button which opens the control panel for the VST
Instrument.
Opens the control panel
for the VST Instrument

You can have up to 64 VST Instruments activated at
the same time, either different instruments or several
instances of the same instrument. However, software
instruments can consume a lot of CPU power – keep
an eye on the VST Performance window to avoid running out of processor power. See also “Instrument
Freeze” on page 195.

• VST Instrument channels give you full access to multitimbral instruments.

Opens the Channel
Settings window

You can have several MIDI tracks routed to the VST Instrument, each
playing a different part.

• Similarly, you can route channels to any available output
provided by the VST Instrument.

The VST Instruments window
When a VST Instrument is loaded, six controls are displayed for this slot in the VST Instruments window.

5. Depending on the selected VST Instrument, you may
also need to select a MIDI channel for the track.

Instrument
on/off

For example, a multitimbral VST Instrument can play back different
sounds on different MIDI channels – check the documentation for the
VST Instrument for MIDI implementation details.

Bypass
instrument

Open instrument panel

Instrument
Freeze

6. Make sure the option “MIDI Thru Active” is activated in
the Preferences dialog (MIDI page).
Event received

Activate outputs

• The button on the far left is used for the Freeze function,
see “Instrument Freeze” on page 195.
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Properties

• The second button is used to activate or deactivate the
VST Instrument.

• Each Instrument track has a corresponding channel
strip in the mixer.

When an instrument is selected from the instrument pop-up menu, it is
activated automatically, i.e. the on/off control lights up in blue.
For some instruments you may also bypass the instrument by clicking the
Bypass button to the right of the on/off button.

• In the Inspector, you can select a VST Instrument from
the Instrument pop-up menu.
When you select an instrument from this pop-up, its control panel will
open automatically.

• Click the Edit (“e”) button to open the control panel for
the VST Instrument.

• The rightmost button allows you to activate the desired
output for the instrument.

• You can also exchange the “sound” of an instrument
track (i.e. the VST Instrument and its settings) by extracting these data from another instrument track or a VST preset, see “Extracting sound from an instrument track or VST
preset” on page 335.

This is useful when you are using VST Instruments that have a large number of audio busses, which may be confusing. Click entries in the pop-up
list to activate/deactivate output busses for this effect.

• On the Input Routing pop-up menu, you can select a
MIDI input.

• Below the Edit button is a small LED that will light up
when MIDI data is received by the instrument.

Instrument tracks have only one MIDI input.

Instrument tracks

• To open the control panel for the VST Instrument, click
the “Edit Instrument” button in the Inspector.

An instrument track is a combination of a VST Instrument, a
MIDI track, and a VST Instrument channel, in other words:
it is a track coupled with a sound – it allows you to think in
terms of sounds rather than in terms of track and instrument settings.

Adding Instrument tracks

• As with MIDI tracks, you can perform the usual MIDI editing procedures on the instrument track, like duplicate,
split repeat or lock the track, use the In-Place Editor, drag
and drop the MIDI parts of an instrument track etc. For
more information, see the chapter “MIDI realtime parameters and effects” on page 342.

To open and use an Instrument track, proceed as follows:
1. Open the Project menu and select Instrument from the
Add Track submenu.
You can also right-click in the track list and select “Add Instrument
Track” on the context menu.

• As with MIDI track inspector and track controls, you can
adjust track delay, choose MIDI input, work with VST Instrument panels, etc. For more information, see the chapter
“MIDI realtime parameters and effects” on page 342.

2. The Add Instrument Track dialog is opened.
You can select an instrument for the track from the pop-up (but you can
also leave this until later if you wish). Specify the number of instrument
tracks you wish to create in the “count” field. If you click the “Browse
Presets” button, the dialog expands to show the preset browser, where
you can browse for sounds.

• Instrument tracks have all options that VST Instrument
channels have, i.e. Inserts, Sends, EQ, etc.

3. Click OK to add the Instrument track.

Ö VST Instruments used in Instrument tracks do not appear in the VST Instruments window.

When you selected an Instrument in the Add Track dialog, the new track
will get the name of the instrument. When no instrument was selected,
the track will be named “Instrument track”.

For an overview over all used VST Instruments, open the Plug-in Information window via the Devices menu. For further information, see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4”.

An instrument track in the Track list.
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Restrictions

3. In the Viewer section, select the desired MIDI loop and
drag it in an empty section in the Project window.

• Instrument tracks have no MIDI Sends.

An Instrument track is created and the Instrument part is inserted at the
position where you dragged the file. The Inspector will reflect all settings
saved in the MIDI loop, e.g. the VST instrument that was used, applied
Insert effects, Track parameters, etc.

• MIDI volume and pan cannot be controlled (there is no
“MIDI fader” tab in the Inspector); instead, the VST Instrument volume and pan are used (via the “Channel” tab in the
Inspector). This applies also to the respective automation
parameters.

Ö You can also drag MIDI loops onto existing Instrument
or MIDI tracks. However, this will only import the part information.

Ö Due to there being only one volume and pan control for
the instrument track, the Mute button will mute the complete track including the VST Instrument. (As opposed to a
MIDI track with an assigned VST Instrument, for which muting the MIDI track still allows you to monitor and record the
VST Instrument.)

This means this part will only contain the MIDI data (notes, controllers)
saved in the MIDI loop, but no inspector settings or instrument parameters.

Exporting MIDI loops
Exporting MIDI loops is a great way of saving a MIDI part
together with its instrument and e.g. effect settings. This
allows you to easily reproduce patterns you once created
without having to search for the correct sound, style or effect.

• Instrument tracks always have one stereo output channel only. This means that VST Instruments that do not provide a stereo output as their first output channel cannot be
used with instrument tracks, and must be loaded via the
VST Instruments window.

Proceed as follows:
1. Select the desired Instrument part.

• Due to the limitation to one output channel, instrument
tracks play only the first voice of a multi-timbral VST Instrument. If you want to use all voices, you have to load the
instrument via the VST Instruments window and set up a
MIDI channel to play it.

2. On the File menu–Export submenu, select “MIDI
Loop…”.
A file dialog opens.

3. Enter the desired name for the MIDI loop in the Name
field in the lower section of the dialog.

Import and export options

• If you want to save attributes for the MIDI loop, click the
Tag Editor button.

Importing MIDI loops

This lets you specify e.g. a category and a sub category for your MIDI
loop.

You can import “MIDI loops” (file extension “*.midiloop”) in
Nuendo. These files contain MIDI Part information (MIDI
notes, controllers, etc.) as well as all the settings that are
saved in Instrument track presets (see “About track presets and VST presets” on page 197). This way, you can
easily reuse instrument patterns you really like in other
projects or applications for example.

4. Click OK to close the dialog and save the MIDI loop.
MIDI Loop files are saved in the following folder:
• Windows: /Documents and Settings/<Username>/Application Data/Steinberg/MIDI Loops.
• Mac: /Users/<Username>/Library/Application Support/
Steinberg/MIDI Loops/

Proceed as follows:
1. Open the MediaBay window via the Media menu.

This default folder cannot be changed, you can however
create subfolders within this folder to organize your MIDI
loops. Simply click the “Create New Folder” button in the
Save MIDI Loop dialog.

2. In the Filter section, activate the “Show MIDI Loops”
button.
This is not necessary, but will help you locate your MIDI loops more quickly.
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Automation considerations

Exporting instrument tracks as MIDI file
You can also export instrument tracks as standard MIDI
files, see “Exporting MIDI files” on page 498.

• Automation of the VST Instrument channel settings or
the settings for an instrument track is done in the same
way as automating regular channels.

Please note:
• As there is no MIDI patch information in an instrument
track, this information is missing in the resulting MIDI file.

• Automation of the specific parameters for a VST Instrument is done in the same way as automating VST effect
parameters.

• If you activate “Export Inspector Volume/Pan”, volume
and pan information of the VST Instrument will be converted and written into the MIDI file as controller data.

When you set up a VST Instrument in the VST Instruments
window, you also need to create a MIDI channel in which
to enter the notes that you want the instrument to play. Although the VST Instrument channel and the MIDI track are
connected via the VST Instrument, there is no direct connection between, for example, the volume automation of
the VST Instrument channel and the events on the MIDI
track. If you move the MIDI part, the automated volume
curve of the VST return channel will not move with it.

Comparison
Since instrument tracks are a combination of MIDI and
VST features, the instrument track properties and their
handling show aspects of both.

On the left, the MIDI Inspector for a MIDI channel with its output routed
to a VST Instrument – on the right, the instrument track Inspector for an
instrument track using the same VST Instrument.
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Instrument Freeze

In the instrument track, however, you have one track that
includes the MIDI data, the VST Instrument and the channel you wish to automate. Therefore, the information on
the automation track will move with the MIDI part.

Like all plug-ins, VST Instruments may require a lot of processor power. If you are using a moderately powerful computer or if you are using a large number of VST Instruments,
you may come to a point where your computer cannot handle all VST Instruments playing back in real time (the CPU
overload indicator in the VST Performance window lights
up, you get crackling sounds, etc.).
Enter the Instrument Freeze function! This is how it works:
• When you freeze a VST Instrument, the program renders
an audio file of the instrument output (taking into account
all unmuted MIDI parts routed to that VST Instrument). This
file is placed in the “Freeze” folder within the Project folder.
• All MIDI tracks routed to the VST Instrument, or the instrument track associated with the VST Instrument, are
muted and locked (the controls for these tracks will appear “grayed-out” in the track list and Inspector).

For more information on track automation, see the chapter
“Automation” on page 213.

• When you start playback, the rendered audio file is
played back from an “invisible” audio track, routed to the
VST Instrument’s mixer channel. Thus, any effects, EQ or
mixing automation will still be applied.

What do I need? Instrument channel
or Instrument track?
• If you need a particular sound without knowing which
VST Instrument to use, create an instrument track and use
the preview features to find the sound you want.

• You can also freeze the mixer channel of the VST Instrument. This freezes any pre-fader insert effects for the channels, just as when freezing audio tracks (see “Freezing
(rendering) insert effects for a track” on page 175).

• Do likewise if the Instrument track restrictions described
above do not matter.

The result of the Freeze is that you get exactly the same
sound as before, but the computer processor doesn’t have
to calculate the sound of the VST Instrument in real time.

• If you are planning to create an instrument track preset,
complete with inserts and EQ settings, you have to use an
instrument track.

Performing the freeze

• If you need to use multitimbral parts and/or multiple outputs, set up a VST Instrument channel.

The instrument freeze function is available in the VST Instruments window, and in the track list and the Inspector
for instrument tracks.
1. Set up the project so that the VST Instrument plays
back the way you want it to.
This includes editing the MIDI tracks routed to the VST Instrument, or editing the instrument track, and making parameter settings for the VST Instrument itself. If you have automated parameter changes for the VST
Instrument, make sure the Read (R) button is activated.

2. Open the VST Instruments window from the Devices
menu, or, if you are using an instrument track, select the
track and open the top Inspector tab.
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3. Click the Freeze button for the VST Instrument (the
button to the left of the VST Instrument slot), or the Freeze
button in the Inspector for the instrument track.

The Freeze button lights up. If you check the Project window at this point, you will find that the relevant MIDI/instrument tracks have grayed out controls in the Track list
and Inspector. Furthermore, the MIDI parts are locked and
cannot be moved.
5. Play back the project.
You will hear exactly the same sound as before freezing the VST Instrument – but the CPU load will be considerably less!

The Freeze button in the
VST Instruments window…

• If you selected “Freeze Instrument and Channels”, any
insert effects used by the VST Instrument are also frozen
(except for the post-fader inserts). However, you can always adjust level, pan, sends and EQ for frozen VST Instruments.

…and in the Inspector.

The Freeze Instrument Options dialog appears with the
following options for the Freeze operation:

Unfreezing
If you need to make adjustments (either to the MIDI tracks,
to the VST Instrument parameters or to the VST Instrument channels if these were frozen) you need to unfreeze
the VST Instrument:
1. Click the Freeze button for the VST Instrument again
(either in the VST Instruments window or in the Inspector).
• Select “Freeze Instrument Only” if you don’t want to
freeze any insert effects for the VST Instrument channels.

You will be asked to confirm this operation.

If you are using insert effects on the VST Instrument channel(s) and want
to be able to edit, replace or remove these after freezing the VST Instrument, you should select this option.

The tracks and VST Instrument are restored and the rendered “freeze
file” is deleted.

2. Click “Unfreeze”.

• Select “Freeze Instrument and Channels” if you want to
freeze all pre-fader insert effects for the VST Instrument
channels.

VST instruments and processor load
If you are working with VST 3 instruments, another way to
relieve processor load is the option “Deactivate Plug-in
when silence is detected” in the Preferences dialog
(VST–Plug-ins page). This is described in detail in the
section “Smart plug-in processing” on page 169.

If your VST Instrument channels are set up with the desired insert effects
and you don’t need to edit these, select this option.

• You can set a Tail Size time to let sounds complete their
normal release cycle.
Otherwise, the sound might be cut off at the very end of the freeze file.

• When you activate “Unload Instrument when Frozen”,
the frozen VST Instrument will be removed.
This is useful if you are freezing an instrument that uses a lot of RAM, e.g.
for pre-loading samples. By unloading the instrument, the RAM becomes
available for other plug-ins, etc.

4. Click OK.
A progress dialog is shown while the program renders the VST Instrument audio to a file on your hard disk.
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Using presets for VSTi configuration

For example, if you are looking for a bass sound, simply
select the Bass category and you can browse and preview
all bass sounds for all instruments. If you know you want a
synth bass sound, select Synth Bass as sub-category and
all synth bass sounds will be shown etc.

About track presets and VST presets
Track presets and VST presets allow you to quickly set up
tracks or instruments with all the settings required for the
sound you want. Nuendo provides various types of presets for various purposes. Two of these are of relevance
for VST Instruments:

You can also browse and preview track presets for instrument tracks, i.e. instrument sounds plus all track settings
and all channel insert effect settings for this track.
These features combined speed up the process of finding
the right sound immensely.

• Track presets for instrument tracks store the parameter
settings of a VST Instrument together with all track/channel settings (applied audio and MIDI insert effects, etc.).

• When creating your own presets, it is always a good
idea to set up attributes for them, as it allows you to fully
use the browsing features for your files, too.

Instrument track presets can only be applied to instrument tracks, not to
instrument channels activated in the VST Instruments window.

This is described in detail in the chapter “The MediaBay” on page 314.

• VST presets store all panel settings for a plug-in (VST Instruments and VST effects), but no track/channel settings.

There are two ways of browsing for sounds:

Note that you can create instrument tracks from VST 3 presets, i.e. selecting a VST 3 preset will create an instrument track with all settings
stored in the VST preset plus an “empty” track.

• Using the Presets browser.
This will apply preset settings to an existing track.

• Using the Browse Sounds dialog.

As described in the chapter “Audio effects” on page 168,
there are two types of VST presets that can be used: the
VST 2 standard “.fxb/.fxp” files and the VST 3 preset standard with the extension “.vstpreset”. Some of the included
VST Instruments use the VST 2 preset standard, and others use the VST 3 standard.

Use this dialog if you haven’t set up a track yet.

Using the Presets browser
1. Create an instrument track and select it in the track list.
You do not have to assign an instrument to the track, but make sure to
specify a MIDI input.

All VST 2 instruments can import “.fxb/.fxp” files and also
convert them to the VST 3 standard. Once converted, you
can use all VST 3 features. See “About earlier VST Instrument presets” on page 200.

2. Make sure that the track settings are shown in the Inspector.
3. Click in the Track Preset field in the Inspector (the text
field currently reads “No Track Preset”).

Ö For further information on Track presets and VST presets, see the chapter “Track Presets” on page 327.

Click here…

Browsing for sounds
One important and often time-consuming aspect of music
creation is the search for the right sounds. You might spend
a huge amount of time trying out the presets for a particular
instrument only to find out later that the preset for another
instrument contains the sound you were looking for.
…to open the Presets browser.

This is why Nuendo features extensive browsing possibilities, allowing you to preview all available presets without
having to load them first!
In addition, you can filter your search by specifying category, style etc.
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4. The Presets browser is opened. It contains three sections (Browser, Search & Viewer and Filter). By default, only
the Search & Viewer section is shown. Note that it may take
a moment before all available sounds appear in the Viewer.

To preview the presets, you have to select a MIDI file or
play MIDI notes on your MIDI keyboard because at this
stage there is no track connected. This is done as follows:

• The Viewer section to the right displays all track presets
for instrument tracks and all VST 3 presets.

A row of buttons appears in the dialog below the Viewer section.

2. Select a preset in the Viewer section.
3. Click the “Choose MIDI File” button.

Track presets for audio tracks, MIDI tracks or “multi” track setups are not
displayed. The preset icon to the left of the file name indicates the type of
preset.

This opens a file dialog where you can navigate to the location of a MIDI
file (extension “.mid”).

4. Click “MIDI Input” and then the “Play” button.

5. Select a preset in the list.

The sound is played. For each new preset you select you have to click
the “Play” button to preview the preset.

6. Play a few notes on your MIDI keyboard to hear the
preset sound. You can switch between presets and hear
the sound when you play. You can also play back/loop a
MIDI part on a track. Each time you select a preset, all associated track and/or instrument settings are automatically loaded.

5. Use the Filter section to search for specific attributes if
you wish.
You can click on the attributes in the respective column (Category, Style
etc.), to filter out all presets that do not match the selected attribute(s).

6. When you have found a preset, click OK to close the
dialog.

7. Use the Filter section to search for specific attributes if
you wish.

An instrument track is created. It will show all track and/or instrument
settings that were saved in the preset.

You can click on the attributes in the respective column (Category, Style
etc.), to filter out all presets that do not match the selected attribute(s).

Selecting VST Instrument presets

8. When you have found the right sound, click OK to
close the dialog.

The previous sections focussed on selecting presets for
the creation of new instrument tracks, or for changing the
setup of an existing track. However, you can also use presets to change the settings of a VST Instrument.

Using the “Browse Sounds” dialog
1. Open the Project menu–Add Track submenu and select “Browse Sounds”.

!

The Browse Sounds dialog is opened. It contains the same sections as the
Apply Track Presets dialog (Browser, Viewer and Filter) and its Browser
section also has the root “Presets” item selected – leave it like this.

Note that the following refers to the selection of VST 3
presets (.vstpreset). If you want to apply .fxp/.fxb presets to your VST 2 instruments in this way, see “About
earlier VST Instrument presets” on page 200.

To select a VST Instrument preset, proceed as follows:
1. Load a VST Instrument (either in the VST Instruments
window or via an instrument track).
2. If you use the VST Instruments window, select a MIDI
track routed to the instrument. If you use an instrument
track, select this.
3. If necessary, click on the track name at the top of the
Inspector to open the basic track settings.
• The Viewer section of the Browse Sounds dialog displays all preset sounds for all track types and all VST Instruments.
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4. Click in the Programs field in the Inspector.

Presets are saved into a default folder named VST3 Presets. Within this folder, there is a folder called “Steinberg
Media Technologies” where the included presets are arranged in sub-folders named after each instrument.

The Preset browser is opened.

You cannot change the default folder, but you can add further subfolders inside the instrument’s preset folder.
• Under Windows, the default preset folder is in the following location:
Boot drive/Documents and Settings/User name/Application data/VST3
Presets.

• Under Mac OS, the default preset folder is in the following location:
Users/Username/Library/Audio/Presets/<company>/<plug-in name>

2. Enter a name for the new preset in the File name field
in the lower part of the dialog.
• If you wish to assign attributes to the preset, click the
Tag Editor button.

5. Step through the presets during playback to find the
sound you are looking for.

Click in the Value column to select an appropriate “tag” for one or several of the available categories in the Attributes column. Tagging is described in detail in the chapter “The MediaBay” on page 314.

6. Double-click the desired preset to load it and close
the preset browser.

3. Click OK to store the preset and exit the dialog.

• You can also open the preset browser by clicking in the
preset name field in the the control panel of a VST Instrument or by clicking the VST Sound button in the control
panel and selecting “Load Preset…” from the pop-up

Extracting sound from Track Presets
You can extract a sound from a Track preset (disregarding
any track/channel settings) and save it as a VST preset.
Proceed as follows:

• Selecting another preset in the preset browser will load
it directly, replacing the previous preset.

1. Click the VST Sound button (“Extract sound from
Track Preset”) below the Output Routing pop-up menu in
the Inspector.

• When the preset browser is open, you can still use
Project window key commands, allowing you to start/stop
playback or locate to different positions in the project.

This opens a dialog where all Track Presets are shown.

• Clicking the Reset button below the Viewer will reload
the last loaded preset.

2. Select an instrument track preset or VST preset and
click OK.
The VST Instrument and the settings (but no inserts, EQs or modifiers) of
the existing track are overwritten using the data of the track preset. The
previous VST Instrument for this instrument track is removed and the
new VST Instrument with its settings is set up for the instrument track.

Saving VST Instrument presets
You can save your settings as presets for further use (e.g.
in other projects):

Track Presets are described in detail in the chapter “Track
Presets” on page 327.

1. In the VST Instrument panel, click the VST Sound button to the right of the preset name and select “Save Preset” from the pop-up menu.
This opens a dialog where you can save the current settings as a preset.
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About latency

About earlier VST Instrument presets
You can use any VST 2.x Instrument plug-ins in Nuendo.
Installing VST Instrument plug-ins works the same way as
for audio effects – see “Installing additional VST plug-ins”
on page 186.

Depending on your audio hardware and its ASIO driver,
the latency (the time it takes for the instrument to produce
a sound when you press a key on your MIDI controller)
may simply be too high to allow comfortable real-time VST
Instrument playback from a keyboard.

When you install a VST 2 instrument, any previously
stored presets for it will be of the old FX program/bank
(.fxp/.fxb) standard. You can import such files, but the preset handling will be slightly different. You will not be able
to use the new features like the Preview function or the
Tag editor until you have converted the old “.fxp/.fxb” presets to VST 3 presets. If you save new presets for a VST 2
plug-in these will automatically be saved in the new “.vstpreset” format in the default location.

If this is the case, a workaround is to play and record your
parts with another MIDI sound source selected, and then
switch to the VST Instrument for playback.
Ö You can check the latency for your audio hardware in
the Device Setup dialog (VST Audio System page).
The input and output latency values are shown below the ASIO Driver
pop-up menu. For live VST Instrument playing, these values should ideally be a few milliseconds (although the limit for “comfortable” live playing
is a matter of personal taste).

Importing and converting FXB/FXP files
To import .fxp/.fxb files, proceed as follows:

Constrain Delay Compensation

1. Load any VST 2 instrument you may have installed, and
click on the VST Sound button to open the Preset Management pop-up menu.

Nuendo features full delay compensation throughout the
entire audio path. This means that any delay inherent in the
VST plug-ins you use will automatically be compensated
for during playback, so that all channels are kept in perfect
sync (see “About plug-in delay compensation” on page
170).

2. Select “Import FXB/FXP” from the pop-up menu.
This menu item is only available for VST 2 instrument plug-ins.

3. In the file dialog that opens, locate the .fxp file and
click “Open”.

However, when you play a VST Instrument in real time or
record live audio (with monitoring through Nuendo activated), this delay compensation may sometimes result in
added latency. To avoid this, you can click the Constrain
Delay Compensation button on the Project window toolbar. This function tries to minimize the latency effects of
the delay compensation, while maintaining the sound of
the mix as far as possible.

If you load a bank (.fxb), it will replace the current set of all effect programs. If you load a single program, it will replace the currently selected
effect program only. Note that such files exist only if you created your
own .fxp/fxb presets with a previous version of Nuendo (or any other
VST 2 application).

• After importing, you can convert the current program list
to VST presets by selecting “Convert Program List to VST
Presets” from the Preset Management pop-up.
When the presets are converted, they will be available in the preset
browser, and you can use the Tag Editor to add attributes and audition
the presets. The presets will be stored in the VST3 Preset folder.

• In the Preferences dialog (VST page) you will find a setting called Delay Compensation Threshold. Only plug-ins
with a delay higher than this setting will be affected by the
Constrain Delay Compensation function.
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• VST plug-ins (with higher delay than the threshold
value) which are activated for VST Instrument channels,
audio track channels that are record enabled, group channels and output channels will be turned off when you activate Constrain Delay Compensation.
• VST plug-ins activated for FX channels are not turned
off but their delay is disregarded by the program (delay
compensation is turned off).
After recording or using a VST Instrument with Constrain
Delay Compensation, you should turn off the function to
restore full delay compensation.

External instruments
An external instrument bus is an input (return) to your audio hardware, along with a MIDI connection via Nuendo
and few additional settings. External instrument busses
are created in the VST Connections window. All external
instrument busses you have created will appear on the
VST Instrument pop-up menus and can be selected in the
same way as any VST Instrument plug-in. If you select an
external instrument, you play it via MIDI as usual (you have
to create a MIDI device to play it) and the sound (synth audio output) will come in to the VST environment where you
can apply processing etc. For more information on external instruments, see “Setting up external instruments” on
page 19.
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Background

• Nuendo is ready for surround specific plug-ins, that is plug-ins
with multi-channel support specifically designed for surround
sound mixing tasks (the included “Mix8to2” plug-in is an example of this). There are also surround aware plug-ins, which
are not designed specifically for Surround but which due to
their multi-channel support work well in a Surround configuration. An example is the Surrounddither plug-in.
• You configure Nuendo for surround by defining input and output busses in the desired surround format, and specifying
which audio inputs and outputs should be used for the different channels in the busses. This is done in the VST Connections window.

What is Surround sound?
Surround is a common name for various techniques for
positioning audio in reference to the listener. Whereas
regular stereo is limited to left/right positioning, within a
relatively narrow field, surround sound opens possibilities
of positioning an audio source anywhere around the listener.
Surround sound comes in many flavors, from the ill-fated
Quadraphonic format for vinyl discs launched in the 70s,
to today’s more successful incarnations.

Requirements for using Surround

The differences between the formats are in two areas:

The following additional equipment is required for taking
advantage of the surround sound implementation in Nuendo:

• The number and configuration of speakers.
This varies from two speakers up to 12.

• The intended final coding format.

• An audio card with more than two outputs.

This depends on the media the audio will be “stored” on: film, broadcast
video or DVD, for example.

The card must have as many outputs as the surround format you plan to
select.

Surround sound is a large topic, there are entire books
and regular publications devoted to the subject. This
chapter will not provide an in-depth introduction to surround sound as such. Instead it will concentrate on the
specific implementation in Nuendo.

• A matching amplifier/speaker configuration.

Encoding
The result of a surround mix in Nuendo is either the multichannel audio sent from the surround output bus to your
surround speaker setup, or (if you use the Export audio
feature) audio file(s) on your hard disk. Exported surround
mixes can either be split (one mono file per speaker channel) or interleaved (a single file containing all the surround
channels).

Surround sound in Nuendo
Nuendo has integrated surround sound features with support for several formats. This support goes all the way
through the audio path – all audio channels and busses
can handle multiple speaker channel configurations (up to
12 channels). A channel in the mixer can either carry complete surround mixes, or an individual speaker channel
which is part of a surround setup.

Getting from this step to the final product (surround sound
on DVD disc, DTS, etc.) requires special software and
possibly hardware. This equipment will encode the signal
into the desired format, possibly compress the audio and
store it on the final media.

• Audio channels can be routed freely to surround channels.
• The Surround Panner function in the mixer allows you to
graphically position channels in the surround field.
• The Mixconvert plug-in allows conversion of one surround
channel into another with a different speaker configuration.
Nuendo places Mixconvert automatically where needed.

Exactly what type of software and/or hardware you need
depends on what kind of format you are mixing for and is
not dependent on Nuendo in any way.
• Steinberg provides Dolby Digital and DTS encoders for
purchase, tailored for use with Nuendo.
For details, please go to www.steinberg.net.
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About surround plug-ins

The VST Connections window

Included with the program are some specific surroundplug-ins. These are:

In this window you can add input and output busses.
There is a complete selection of common surround configurations available, as well as standard mono or stereo
busses.

• MatrixEncoder and MatrixDecoder.
These are used for working with LRCS Surround encoded material. In
LRCS Surround, four audio channels are converted to two channels, for
distribution via regular video and broadcast formats. These plug-ins perform such conversions (in both ways) and are compatible with the LRCS
Surround format.

The Bus Name column contains the currently configured
busses as they will appear in the input and output routing
pop-ups in the mixer.

• Mixconvert

Click here to add a bus.

Mixconvert gives you an easy way to take surround mixes and convert
them to other formats with less channels. For example, Mixconvert can
be used to downmix a 5.1 surround mix to a normal stereo mix. This plugin is unique in that Nuendo will automatically insert it in place of the channel panner or aux send panner in certain situations. Please refer to the
manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo 4” for
complete information about Mixconvert.

The outputs selected for the
channels in the busses.

• Mix6to2
The Mix6to2 effect allows you to control the levels of up to six surround
channels, and to mix these down to a stereo output.

• Mix8to2
The Mix6to2 effect allows you to control the levels of up to eight surround channels, and to mix these down to a stereo output.

The currently configured busses.
VST Connections showing the Outputs page. The “5.1 Out” bus is unfolded, displaying the individual speaker channels, with their physical
output ports displayed in the Device Port column to the right.

• Mixer Delay
The Mixer Delay effect is useful for time aligning surround speakers if
your room configuration does not allow for proper ITU-R speaker placement. It is also handy for re-routing surround channels to their proper
speaker channels in your setup (refer to the separate manual “Nuendo
Expansion Kit – Cubase Music Tools for Nuendo 4” for more information
about Mixer Delay.

• SurroundDither
This is a dithering plug-in capable of handling six channels at the same
time – use this for applying dithering to a surround output bus.

• SurroundPanner
This is described in the section “Using the Surround Panner” on page
208.

Ö Surround plug-ins (apart from the SurroundPanner)
are described in the separate manual “Nuendo Expansion
Kit – Cubase Music Tools for Nuendo 4”.
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Operations

Surround in the mixer
Surround sound is supported throughout every stage of
the signal path in the Nuendo mixer, from input to output
bus. Each bus or audio channel can carry up to 12 surround speaker channels.

Setting up the surround configuration
Output bus configuration
Before you can start working with surround sound, you
have to configure a surround output bus, through which all
the speaker channels of the chosen surround format are
routed. How to add and set up busses is described in detail in the section “Setting up busses” on page 11. Here is
a brief run through:
1. Open the VST Connections window from the Devices
menu.
2. Click the “Outputs” tab.
3. Click the “Add Bus” button and select one of the preset formats from the Configuration pop-up (see below).
The new bus appears with the ports visible.

4. By clicking in the Device Port column you can now
route the speaker channels to the desired outputs of your
audio hardware.
Here, the SurroundPanner is used for positioning
the sound “dynamically” in the surround field.

5. If you like, rename the output bus by clicking its name
and typing in a new one.
This name will appear in the mixer and on routing pop-ups.

Using the Output Routing pop-up,
audio channels can be routed directly to surround channels.

The following surround configurations are included:
Format
LRCS
L
C

Description

R

LRCS refers to Left Right Center Surround, where the
surround speaker is center-rear positioned. This is the
original surround format that first appeared as Dolby Stereo in cinema and later as the home cinema format Dolby
ProLogic.

R

This is the same as 5.1 (see below) but without the LFE
channel. The LFE channel is optional in 5.1 and if you
don’t plan to use it, you might find this option more convenient.

S
5.0
L

C

SR

SL
5.1

In the output channel section of the mixer you can control
the master levels for configured busses. The level meter
for a bus (or channel in the mixer) that carries multiple surround channels will show multiple level bars, one for each
speaker channel in the surround configuration.

L

C

R

+
SL
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SR

This format is one of the most popular in cinema and
DVD. In its various cinema and DVD encoding implementations (established by different manufacturers) it is referred to as Dolby Digital, AC-3, DTS and MPEG 2
Multichannel. 5.1 has one center speaker (mainly used
for speech), main left and right speakers, and two surround speakers (mostly for sound effects). Additionally a
subchannel (LFE – Low Frequency Effects) with lower
bandwidth is used for special low frequency effects.

Format

Description

Format

LRC
L

Description

6.0 Music
R

C

Same as LRCS, but without the surround speaker channel.

L

R
RS

LS
SL
LRS

This uses 2 (Left/Right) front channels with Left and
Right surround channels and Left and Right Side channels.

SR

6.1 Cine

L

R

Left-Right-Surround, with the surround speaker positioned at center-rear.

L

R

C

Same as 6.0 Cine but with an Lfe sub-channel added.

+
S

SL

LRC+Lfe
L

R

C

S

6.1 Music

Same as LRC but with an Lfe sub-channel added.

L
LS

+

R
SR

7.0 Cine
L LC C RC R

LRS+Lfe
R

Same as LRS but with an Lfe sub-channel added.

Same as 6.1 Cine but with an Lfe sub-channel added.

+ RS

SL

L

SR

A Left, Mid-left, Center, Mid-right, Right front speaker arrangement with Left and Right surround channels.

+
S
Quadro
L

SL

R

7.0 Music
C
L
R

The original Quadraphonic format for music, with one
speaker in each corner. This format was intended for vinyl
record players.

SL

SR

C

R

SR

SL

S

7.1 Music

Quadro+Lfe
R

Same as Quadro but with an Lfe sub-channel added.

L
LS

+

SL

C
+

Same as 7.0 Music but with an Lfe sub-channel added.
R
RS
SR

SR

SL
6.0 Cine
L
C

SL

Same as 7.0 Cine but with an Lfe sub-channel added.

+

+

L

SR

7.1 Cine
L LC C RC R

Same as LRCS but with an Lfe sub-channel added.

Same as 6.0 Music but with a Center front channel
added.

RS

LS

LRCS+Lfe
L

SR

SL

S

R

8.0 Cine
L LC C RC R

A Left-Right-Center front speaker arrangement with 3
(Left-Right-Center) surround channels.

SL

SR
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S SR

Same as 7.0 Cine but with the addition of a Center Surround channel.

Format

Description

8.0 Music
C
L
R

Same as 7.0 Music but with the addition of a Center Surround channel.

LS
SL

• You have existing audio material in a specific surround
format, and you wish to transfer this material into Nuendo
as a single, multi-channel file.
• You wish to record a surround setup “live”.

RS
S

In both cases, you can add and configure an input bus of
the format you wish to use in the VST Connections dialog
so that each input on your audio hardware is routed to the
corresponding speaker channel.

SR

8.1 Cine
L LC C RC R

Same as 8.0 Cine but with an Lfe sub-channel added.

+
SL

8.1 Music
C
R
L
SL
LS

To add an input bus, use the same general method as described for output busses (see “Output bus configuration”
on page 205), but select the “Inputs” tab instead.

S SR
Same as 8.0 Music but with an Lfe sub-channel added

Routing channels directly to surround channels

+ SR
S

If you want to place an audio source in one separate
speaker channel only, you can route it directly to that
speaker channel. This is useful for pre-mixed material or
multi-channel recordings that don’t require panning.

RS

10.2
L
C
R
TFL TFC TFR
++
TRL
TRR
SR
SL

This is an experimental format with ten surrounding
speakers and two Lfe channels (a combination of two
5.1, one at the top and one at the bottom of the room).

1. Open the mixer and locate the channel you wish to
route.
2. From the output routing pop-up menu, select the corresponding surround speaker channel.

Child busses

• If a stereo audio channel is routed directly to a speaker
channel, the left/right channels will be mixed to mono.

Essentially a child bus is a bus within a (bigger) bus. Typically you may want stereo child busses within your surround bus – this allows you to route stereo tracks directly
to a stereo speaker pair within the surround bus. You may
also want to add child busses in other surround formats
(with fewer channels than the “parent bus”).

The pan control for the audio channel governs the balance between the
left and right channel in the resulting mono mix. Center pan will produce
a mix of equal proportion.

Routing channels using child busses
Child busses provide a way to route stereo (or multi-channel) audio channels to specific speaker channels in a surround configuration.

Once you have created a surround bus, you can add one or
several child busses to it by right-clicking the bus and selecting “Add Child Bus”. This is described in detail in the
section “Adding a child bus” on page 13.

The most obvious application of a child bus is when you
wish to add a stereo channel to two specific left/right surround speaker channels.

Input bus configuration
To work with surround sound in Nuendo, it is often not
necessary to configure a surround format input bus. You
can record audio files via standard inputs, and easily route
the resulting audio channels to surround outputs at any
stage. You can also directly import multi-channel files of
specific surround format onto audio tracks of the same
format.
You should add a surround input bus in the following circumstances:
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If you have added a child bus within a surround bus (see
above), it appears as a submenu item within the surround
bus on the output routing pop-up menu. Select this to
route a stereo audio channel directly to that stereo
speaker pair in the surround bus.

3. You can click and drag directly in the miniature image
to move the sound in the surround field.
The horizontal red strip to the right controls the subbass (LFE) level (if
available in the selected surround format).

• You can also view a slightly larger version of this control
by selecting “Panner” on the View options pop-up menu
for the extended mixer panel.
This mode offers click and drag-panning as well as numerical values for
left/right balance, front/rear balance and LFE amount – enter the desired
number or use the mouse wheel to adjust them.

• The SurroundPan can also be displayed in the Inspector
for all audio channel track types. To display the Surround
Pan tab in the Inspector, make sure the corresponding option is enabled in the Inspector context menu.
• For total control over surround panning, double-click on
the miniature image to open the full Surround Panner
interface in a separate window.

Using the Surround Panner
Nuendo has a special feature for graphically positioning a
sound source in a surround field. This is actually a special
plug-in which distributes the audio from the channel in
various proportions to the surround channels.
1. Open the mixer and locate the channel you wish to
position.
This could be a mono or stereo channel.

2. From the output routing pop-up menu, select the
“whole surround bus” option (not a specific speaker
channel).
A miniature graph of the surround plug-in interface appears above the
fader in the channel strip.

When the “whole surround bus” is selected, the channel strip shows a
miniature surround control.
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The SurroundPan controls

Mode – Standard/Position/Angle
The Standard Mode/Position Mode/Angle Mode switch
allows you to work in three modes:
• In both Standard and Position mode, the speakers in the front
are aligned, as they would normally be in a cinema-type situation. This means that the front speakers are at a varying distance from the center. Standard mode (default) is the best
mode for moving sources between speakers without level attenuation.
• Angle Mode is the traditional surround sound mixing definition.
Note that here the speakers are defined as being at equal distance from the center. This is not really a true representation of
for example a cinema, but has still proven to work well in many
situations.
Speakers
The speakers in the panel represent the chosen surround
configuration.
• The speakers in the front are aligned, as they would normally be in a cinema-type situation.
This means that the front speakers are at a varying distance from the
center, allowing you to move sources between speakers without level
attenuation.

• You can turn speakers on and off by clicking them with
[Alt]/[Option] pressed. When a speaker is turned off, no
audio will be routed to that surround channel.
Positioning and levels
!

The text below assumes that the Mono/Stereo popup is set to “Mono Mix”. For more information on the
other modes, see below.

A sound source is positioned either by clicking or by dragging the gray “ball” around in the panel (or by using key
commands, see below). By dragging during playback you
can record automation, see “Enabling and disabling the
writing of automation data” on page 214.

The SurroundPan plug-in interface in Standard, Position and Angle
mode, respectively.

The SurroundPan plug-in allows you to position your audio in the surround field. It consists of an image of the
speaker arrangement, as defined by the output bus selected on the output routing pop-up menu, with the sound
source indicated as a gray ball.

• In Standard Mode, the signal levels from the individual
speakers are indicated by colored lines from the speakers
to the center of the display.
• In Position Mode, the concentric circles will help you
determine the level of the signal at a certain position.
The yellow circle represents -3dB below nominal level, the red circle is at
-6dB and the blue is located at -12dB. These are affected by attenuation, see below.
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• In Angle Mode, a red arc helps you determine the perceived “range” of a source. The sound will be at its loudest in the middle of the arc and will have dropped in level
towards the ends.

The LFE dial (all modes)

Exactly how levels are handled may require some explanation:
• When you move a source around, a number will indicate
the loudness in each speaker.

If the selected surround setup includes an LFE (Low Frequency Effects) channel, a separate LFE level dial will be
available in the SurroundPan window. Use this to set the
signal amount sent to the LFE channel. You can also set
this using the small red strip to the right of the Surround
Panner in the mixer channel strip, or by typing in a number
in the LFE value field in the larger Surround Panner that
can be shown in the extended channel strip.

This is a value in dB (decibel) and is relative to the nominal level of the
source. In other words, 0.0 (dB) represents full level.

• If you position the source far enough away from a
speaker, its level will drop to zero (indicated by an infinity
symbol).
• The signal levels from the individual speakers are indicated by colored lines from the speakers to the center of
the display.
• You can use modifier keys to restrict movement in various ways:
In Standard and Position Mode:
Key

Click here and type in a LFE level value…

Movement restriction

[Shift]

Horizontally only

[Ctrl]/[Command]

Vertically only

[Alt]/[Option]

Diagonally (up left, down right)

[Ctrl]/[Command]+
[Alt]/[Option]

Diagonally (up right, down left)

…or drag this control to set LFE level.

The Surround Panner in the channel strip (bottom) and in the extended
panel of the mixer channel strip (“Panner” selected on the View options
pop-up menu).

In Angle Mode:

Mono/Stereo pop-up (All Modes)

Key

Movement restriction

[Shift]

From center to perimeter only

[Ctrl]/[Command]

Along the perimeter only (at current distance from
center)

If you have a mono channel the Mono/Stereo pop-up is by
default set to Mono Mix. The panner will then behave as
described above.
If you have a stereo channel, you have the option of using
one of the three Mirror modes. Two gray balls will then appear, one for each channel (L/R). This will allow you to
move the two channels symmetrically, by dragging one of
them. The three modes allow you to select which axis
should be used for mirroring.

There is also a special set of key commands for working in
the SurroundPan window.
!

For a complete list of the available key commands,
click on the “SurroundPanner” logo and then click
again!

• The default mode for stereo channels is the Y-Mirror mode.
• If you run a stereo signal through the panner in Mono Mix
mode, the two channels will be mixed together before entering
the plug-in.
• If you run a mono signal through the plug-in in one of the stereo modes, the signal will be split before entering the plug-in.
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Mixconvert

Additional parameters (Standard mode)

Mixconvert is a special plug-in that converts one multichannel audio source into another multi-channel destination. It is most frequently used to “downmix” a multi-channel surround mix into another format with less channels (a
5.1 surround mix into a stereo mix for example).
This plug-in can be used as an insert effect in the mixer
like other plug-ins but it also has special functions. Nuendo will automatically insert Mixconvert in place of the
surround panner in cases where the channel (audio track,
group channel etc…) is being routed to a destination that
has fewer audio paths. Mixconvert will also be inserted in
place of any aux send panner when the destination has a
different audio path than the source. The surround panner’s displays and controls will be replaced by Mixconvert’s.

• Center Level.
This determines how center source signals should be reproduced by the
front speakers. With a value of 100%, the center speaker will provide the
center source. With a value of 0%, the center source will be provided by
the ghost image created by the left and right speakers. Other values will
produce a mix between these two methods.

• Divergence Controls.
The three divergence controls determine the attenuation curves used
when positioning sound sources, for X-axis front, X-axis back and Y-axis
(front/rear), respectively. If all three Divergence values are 0% (default),
positioning a sound source on a speaker will set all other speakers to
zero level (-×) (except for the center speaker which depends on the center level). With higher values, the other speakers will receive a percentage of the sound source.

Please refer to the separate manual “Nuendo Expansion
Kit – Cubase Music Tools for Nuendo 4” for detailed information on the operation of Mixconvert.
Ö There is one exception to this behavior. When a stereo
channel is routed to a mono destination through the channel routing or an aux send routing, a normal panner will appear. However, this panner will control the balance of the
left and right channels as they are blended into the mono
destination. The center position blends both channels together equally. With the pan set all the way to the left, only
the left channel will be heard. With the pan set all the way
to the right, only the right channel will be heard.

Additional parameters (Position and Angle mode)

• Attenuate.
Attenuate can be used to amplify or weaken the source. Exactly what effect
this has on the level in each speaker can be determined by the level readouts, the concentric circle (Position mode) and the arc (Angle mode).

Exporting a Surround mix
When you have set up a surround mix you can choose to
export it with the Export Audio Mixdown function. This
function exports a single selected output bus – this means
that all channels that you want to be part of the mix must
be routed to the surround output bus.

• Normalize.
Normalize is a function for controlling the overall loudness from all speakers. When this is set to 1.0 (full normalization), the level from all speakers
together is always exactly 0dB. The individual levels will then be boosted
or attenuated accordingly.
!

You have the following export options when doing surround work:

Please note that this is not a dynamic feature, like
compression or limiting. It is instead just a tool for
scaling the nominal output levels from the surround
channels.

• Export to “split” format, resulting in one mono audio file
for each surround channel.

Automation

• Export to interleaved format, resulting in a single multichannel audio file (e.g. a 5.1 file, containing all six surround channels).

All parameters in the SurroundPan plug-in can be automated, just as with any other plug-in. See “Enabling and
disabling the writing of automation data” on page 214.
211

Surround sound

• Under Windows you can also export a 5.1 surround mix
to a file in Windows Media Audio Pro format.
This is an encoding format tailored for 5.1 surround – see “Windows
Media Audio Pro files (Windows only)” on page 442.

• You can also export a surround mix to a Dolby Digital
AC3 file or a DTS file, if you have the Steinberg Dolby Digital Encoder or the Steinberg DTS Encoder (both optional,
separate plug-ins) installed in your system.
Please go to www.steinberg.net for details.

For more about exporting to files, see the chapter “Export
Audio Mixdown” on page 437.

Using effects in surround configurations
Nuendo introduces a special surround format for VST
plug-ins, that is plug-ins that can process more than two
channels. Mix8to2 is an example of such a plug-in.
Applying a Surround-aware plug-in
This is not different from applying a regular plug-in. The
only difference is that the plug-in panel may have controls
for more than two channels.
Using a stereo plug-in in a surround configuration
Normally, when you apply a stereo insert effect to a surround configuration, the first two speaker channels (often
L and R) are routed through the plug-in and other channels are left unprocessed.
However, you may want to use the plug-in on other speaker
channels. This is described in the chapter “Audio effects”
on page 168.
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16
Automation

Introduction

Enabling and disabling the writing
of automation data

In essence, automation means finding and recording, for
each and every moment of your project, the right values for
a particular mixer parameter. When you create your final
mix, you won’t have to worry about having to adjust this
particular parameter control yourself – Nuendo will do it
for you.

Tracks and mixer channels in Nuendo can be “automation
enabled” by activating their automation Write (W) buttons.
All track types except arranger, folder, marker, transpose,
video and ruler tracks feature Write (W) and Read (R) buttons in the mixer, in the Track list and in the Channel Settings window. Furthermore, the control panels for all plugin effects and VST Instruments also feature Write and
Read buttons.

Automation is a key feature when mixing audio data in
complex, multi-track projects. Whether you want to mix a
music project or if you are performing a feature-film re-recording – without comprehensive automation features
your task would be impossible. Nuendo provides very
powerful and yet intuitive automation of virtually every
mixer and effect parameter.
The following sections provide detailed descriptions of the
Nuendo automation features:

The Write and Read buttons for a channel in the mixer and for an automation track in the Track list.

• The section following below describes how to activate
automation Write mode and how the automation data is
displayed.

• If you activate Write for a channel, virtually all mixer parameters you adjust during playback for that specific
channel will be recorded as automation events.

• What can and what cannot be automated is briefly explained in “What can be automated?” on page 216.

• If Read is activated for a channel, all your recorded
mixer actions for that channel will be performed during
playback, just like you performed them in Write mode.

• “The Automation panel” on page 217 provides a first
look at the Automation panel and its features.

• The W and R buttons for a track in the Track list are mirrors of the W and R buttons in the corresponding channel
strip in the mixer.

• Make sure you read and understand “Virgin territory vs.
the initial value” on page 217!
• The various automation punch-out modes are explained
in detail in the section “Automation modes” on page 219.

Ö Note that the Read button is automatically enabled
when you enable the Write button. This allows Nuendo to
read existing automation data at any time.

• The Nuendo automation features become truly powerful
thanks to the automation performance utilities, as explained in the section “Automation performance utilities”
on page 222.

You can separately deactivate Write, if you want to only read existing
data. There is no status Write on/Read off.

There are also global Read and Write indicator buttons
(“All Automation to Read/Write Status”) in the common
panel of the mixer and at the top of the Track list:

• “The Settings section” on page 229 describes the global options and settings available on the Automation
panel.
• “Hints and further options” on page 230 gives you general information on how the automation features interact
with other Nuendo features.
• The section “Automation track operations” on page 231
describes how to open and manipulate automation tracks.

The “All Automation to Read/Write Status” buttons in the mixer, and in
the Track list.

• Finally, the section “Working with automation curves”
on page 235 explains how to edit automation curves.
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These buttons light up as soon as there is a single enabled Read or Write button on any channel/track within
your project.

There are two approaches you can use to create automation curves:
• “Offline”, by manually drawing the curves on automation
tracks in the Project window.

• When “All Automation to Read/Write Status” is disabled and you click on one of these buttons, all Read/
Write buttons on all tracks/channels are enabled.

See “Editing automation events” on page 235.

When “All Automation to Read/Write Status” is enabled, this means that
at least one of the Read/Write buttons on one of the channels of your
project is enabled.

• When “All Automation to Read/Write Status” is enabled
and you click on one of these buttons, any enabled Read/
Write buttons on the tracks/channels of your project are
disabled.

• “Online”, by enabling the Write/Read buttons and adjusting parameters in the mixer or channel settings window while rolling through the project in real-time. The
value settings are recorded and displayed as a curve on
the automation track.

Ö You will also find global Read/Write buttons on the
Automation panel. See the section “The Read/Write buttons in the Mode section” on page 221.

In the following sections, this online writing of automation data is also referred to as an “automation pass”. See “Enabling and disabling the writing of automation data” on page 214.

MIDI Controller Input to Automation Tracks
If you set up a remote device to control parameters and
settings in Nuendo, you can record automation with that
remote device – just activate Write as usual. However, if
you are recording a MIDI track and want to record automation at the same time, the controller data sent by the remote device will be recorded “twice” – as automation and
as MIDI controller data on the MIDI track.
To avoid this, activate the “MIDI Controller Input to Automation Tracks” option in the Preferences (MIDI page).
When this is activated, the controllers will be recorded as
automation only, not as MIDI controller data on the recorded MIDI track.

Creating automation data

The methods are not different in terms of how the automation data is applied. They only differ in the way the automation events are created – manually drawing them or
recording them during automation passes. Any applied
automation data will be reflected in both the mixer (a fader
will move for example) and in a corresponding automation
track curve.

Within a Nuendo project, the changes in a parameter
value over time are reflected as curves on so-called automation tracks. The curves are drawn in real-time while you
write the automation data. Most of the tracks in your
project have automation tracks, one for each automated
parameter.
Ö Note that automation tracks are hidden by default. You
can display all automated parameters and the corresponding automation tracks at the same time.

There are no hard and fast rules regarding which method
you should use. For example, you can create your automation data online without ever even opening an automation
track. Or you can stick to drawing automation curves offline. Every method has its advantages, but of course it is
up to you to decide what to use and when.

See the section “Automation track operations” on page 231 for details on
how to show, hide or remove automation tracks. “Working with automation
curves” on page 235 explains what you can do with automation curves.

215
Automation

What can be automated?

• Editing curves on automation tracks offers a graphical
overview in relation to the track contents and the time position.

You can automate virtually every parameter in the Nuendo
mixer.

This makes it easy to quickly change parameter values at specific points,
without having to activate playback. For example, this method gives you a
good overview if you have a voice-over or a dialog on one track and a
music bed on another track, the level of which needs to be lowered by a
specific amount every time the dialog occurs.

• To find out which parameters can be automated for a
particular track, click in the Parameter display of the automation track to open a pop-up menu. Select “More…” to
open the Add Parameter dialog.

• By using write automation in the mixer you don’t have to
manually select parameters from the Add Parameter list.

This dialog lists all automatable parameters for a particular track type. It is
described in detail in the section “Assigning a parameter to an automation track” on page 232.

You can work much like you would using a “real” physical mixer. Every
action you perform is automatically recorded on automation tracks which
you can later open for viewing and editing of the parameters you changed.

The following actions CANNOT be automated, even
though they are features of the Nuendo mixer:

The automation tracks themselves indicate the writing of
automation data:

•
•
•
•
•
•
•
•

• While writing automation data, the color of the automation track in the track list changes to red.

Changing the input phase
Changing the input gain
Changing of routing settings
Inserting a plug-in
Moving of plug-ins to different insert slots
Copying insert settings
Changing the stereo panner mode
Changing Control Room settings

• The delta indicator in the automation track shows the
relative amount by which the new parameter setting deviates from any previously automated value.
This is an additional visual aid when writing new automation data.
The delta indicator
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The Automation panel
Click here…

…to open the Automation panel.

Virgin territory vs. the initial value

The Automation panel is a floating window, similar to the
Mixer and Transport panel. You can leave it open while
you work – the Project window will always have the focus.

!

To open the Automation panel, open the Project menu and
select the Automation Panel option or click the Automation Panel button on the Nuendo toolbar.
The Automation panel gives you access to all automation
options in Nuendo. By default, all seven sections are displayed.

When we speak of “touching a control” in the following sections, we mean both clicking a parameter
control on the Nuendo program interface and physically touching a fader or other control on a remote
control device.

Before we go into detail about the various modes and options available through the Automation panel, we need to
explain how Nuendo handles those sections of your project
in which you have not yet performed an automation pass.
For parameter automation, Nuendo works either with an
initial value (see below) or with “virgin territory” (see “Virgin territory” on page 218).
It is very important that you understand the difference between these two concepts and their individual advantages
and disadvantages before continuing.

You can change the panel configuration using the Setup
dialog – see “The Setup dialogs” on page 506. The following sections will explain all options and functions.

The initial value
An initial value is always used when “Use Virgin Territory” is
disabled on the Automation panel.

Use Virgin Territory is disabled.
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When no automation data exists for a particular parameter, and you perform an automation pass for this parameter, its value at the moment when you start the automation
pass is saved as the initial value. When you punch-out of
the automation pass, it is this initial value to which the parameter will return.

The idea here is that you find automation only where you
actually perform an automation pass – there is no initial
value to which the parameter can return.

This has one very important consequence: As soon as the
initial value is set, the corresponding parameter is fully automated, on this track, at any given timecode position of
the project – even if your automation pass lasted only 2
seconds.

Gaps

The straight line after the last automation event indicates the initial value.

Only the dynamic change in the parameter is automated.

This is reflected in the curve on the automation track – it is
visible right through to the end of the project that the initial
value is kept. As long as the track is in Read mode, the parameter control will follow this curve – it will either take
values set during an automation pass, or it will return to its
initial value.

You can create gaps inside a section with automated values. This is useful if you want to have full manual control:

Outside a section with automated values, you always have
full manual control of the parameter.

After an automation pass you will find virgin territory only
to the right of the last automation event. “Empty” sections
between two automation curves are referred to as “gaps”
in the following sections.

1. Make sure that “Use Virgin Territory” is enabled.
2. Select the Range Selection tool.
3. On an automation track with existing automation data,
select a range and press [Delete] or [Backspace].

You may touch the parameter control and force it to a different value manually. But as you let go of the control, it
will return to the value defined by the automation curve –
even when in Stop mode.

A gap is created.

Virgin territory
Think of virgin territory as the “state” of the automation
track before performing the first automation pass. When
you enable the “Use Virgin Territory” option, no automation curve is displayed on the automation track, and you
have full manual control of the parameter.

A new break-point at the position where the selected
range started marks the end point of the automation curve
to the left. A second new break-point can now be found at
the position where the selected range ended, marking the
start of the automation curve to the right of the gap.

Use Virgin Territory is enabled.
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• When you select one or more break-points of an automation curve with the Arrow tool and press [Delete] or
[Backspace], no gap is created.

• When you set the “Terminator” option for the last (rightmost) automation break-point of an automation curve to
“Yes”, any automation data to the right of this point (as defined by an initial value) is deleted.

Instead, the selected break-points are deleted. The curve between the
deleted points is replaced by a new line connecting the two points to the
left and right of the deleted points.

Automation modes
Nuendo provides three different punch-out modes for automation, available on the Automation Mode pop-up menu
on the main toolbar and in the Mode section on the Automation panel.

The “Terminator” setting
You can “force” any automation track into using virgin territory, by defining any automation break-point on the automation curve as the “terminator” point of this part of the
curve. This will automatically delete the line between this
break-point and the next one, creating a gap – a section
on the automation track where you find no automation
data. The next break-point to the right of the terminator
point will automatically become the “start” point of the
next automated section.

Selecting the automation mode in the Automation panel and the Nuendo toolbar

The three modes available are Touch, Auto-Latch and
Cross-Over. In all three modes, automation data will be
written as soon as a parameter control is touched in play
mode. They differ in the way the writing of automation data
is ended, i.e. in their “punch-out” behavior. Which mode
to use depends on what is required in your particular
working situation.

Ö Note that this is independent of the setting for “Use
Virgin Territory” – you can create gaps at any time.
• To define a break-point as the last point in an automation curve, select it by clicking on it with the mouse
pointer, and in the Event info line above the Project window, set “Terminator” to Yes.

Ö Note that you can change the automation mode at any
time, i.e. in play or stop mode or during an automation
pass. You can also assign key commands to the automation modes so you can quickly change between them.

Select a break-point…

See “Automation key commands” on page 230.

General punch-out conditions
The current automation pass will always punch-out as
soon as one of the following conditions is met, independent of which automation mode is selected:

…and set “Terminator” to Yes.

•
•
•
•
•

A gap is created.

If you Disable Write
If you Stop playback
If you activate Fast Forward/Rewind
If the project cursor reaches the right locator in Cycle mode.
If you click in the timeline to move the project cursor.
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Touch
Typically, you would use Touch mode in situations where
you want to make a change lasting only a few seconds to
an already set up parameter.
As the name implies, Touch will write automation data only
for as long as you actually touch a parameter control –
punch-out occurs as soon as you release the control.
After punch-out, the control will return to the previously
set value. The Return Time setting (see “Return Time” on
page 229) determines how long it takes for the parameter
to reach the previously set value.

Automation mode: Auto-Latch

Ö The automation mode for ON/OFF switches is always
Auto-Latch (even if another mode is selected globally or
for the track).

Cross-Over
Think of the Cross-Over mode as a kind of “manual return
time” option (see also “Return Time” on page 229). The
Cross-Over mode can be used in situations where you are
not happy with an already existing automation curve or
with the automatically applied return settings. Cross-Over
mode gives allows you to perform a “manual return” to ensure smooth transitions between new and existing automation settings.

Automation mode: Touch

Auto-Latch

For Cross-Over, the punch-out condition is crossing over
an already existing automation curve after touching the
parameter for a second time.

In Auto-Latch mode, there is no specific punch-out condition other than those valid in all modes – see “General
punch-out conditions” on page 219.

Look at the figure below: Like in Auto-Latch mode, once
the automation pass begins with the first touching of the
parameter control, automation data is written for as long
as playback lasts.

Auto-Latch is probably the automation mode you will use
the most, in all situations where you want to keep a value
over a longer period of time – for example when making
EQ settings for a particular scene.

When you have found the correct value setting, you can
release the fader – the automation pass continues, with
the value setting remaining the same.

Once your pass has started, the writing of automation
data continues for as long as playback lasts or Write is
enabled – if you wanted an adjustment that lasted for just
a few moments, you would use Touch mode. The last
value setting will be kept until you stop writing.
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Now, re-touch the fader and move it towards the original
value. As soon as you cross the original curve, punch-out
occurs automatically.

• When selecting the Global option from the pop-up
menu, the track will again use the automation mode selected from the toolbar or the Automation panel.
Note that you can use the option “All track modes to Global” in the Key
Commands dialog–Automation category to set up a key command that
will reset all tracks to using the global automation mode.
!

When selecting Trim as the automation mode for a
track (see “Trim” on page 224), the punch-out behavior will always be as in Auto-Latch.

The Read/Write buttons in the Mode section
At the bottom of the Mode section, you find two Read and
two Write buttons. These are used to globally enable or
disable the Read and Write buttons on all tracks.
Automation mode: Cross-Over

Trim
The All Automation to Read/Write buttons in the Mode section.

This is described in the section “Trim” on page 224.

• Click “All Automation to Write” to enable all Write buttons (and, at the same time, all Read buttons) on all
tracks/channels of your project.

Automation mode: global or different for each
track?

Clicking “All Automation Write off” will disable all Write buttons. The
Read buttons will remain enabled.

The automation mode you set on the Automation panel (or
in the Project window toolbar) is used globally, i.e. for all
tracks of your project.

• Click “All Automation to Read” to enable all Read buttons on all tracks/channels of your project.

However, you may also select a different automation mode
for individual tracks:

Clicking “All Automation Read off” will disable all Read buttons.

The various other Read and Write buttons on the Nuendo
interface are described in detail in the section “Enabling
and disabling the writing of automation data” on page 214.

• Open the topmost Inspector section for a track for
which you require a different automation mode, and from
the Track Automation Mode pop-up menu, select the desired automation mode.

Selecting an automation
mode for an individual track.
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Automation performance utilities

4. Move the fader until you have found the setting you
want, and release the fader.

The automation modes described above become far more
effective when used in combination with the Nuendo automation performance utilities. These are a number of options and functions tailored to specific situations, allowing
you to write automation data quickly and efficiently. You
will find these utilities in the various sections on the Automation panel.

This will punch-out the writing of automation data. As you let go of the
fader, the automation curve will take the found value setting, from where
you punched out through to the end of the project.

The Fill options

Fill To End

Fill To Punch
Let’s say you are rolling, in real-time, over a scene cut and
volume must be softer in the next scene – you don’t yet
know how much softer, but the change in volume from the
first to the second scene must be abrupt.

The Fill options define conditions for what is to happen in
a specific section of your project when you punch-out of a
running automation pass. They can be used in real-time
while rolling through your project, in situations that are not
too complex. Look at these two examples:

1. Select Touch as automation mode and “Fill To Punch”
as Fill option.

Fill To End

2. Start rolling somewhere during the first scene and
touch the fader on the moment of scene change.

Imagine you are automating volume for the background
tracks of a two-minute scene. Rather than to hold on to
the fader for two minutes, you can proceed as follows:

The automation pass is punched in.

3. Move the fader until you have found the volume setting
you need in the second scene, and release the fader to
punch-out.

1. Open the Automation panel and select Touch as your
automation mode.

The volume curve is set from the point of punch-out back to where you
punched in. The values written while moving the fader to find the right
value are deleted, and volume jumps, at exactly the right moment, from
the value set in the first scene to the value found for the second scene.

2. Click the “To End” button once to activate it as Fill option.
The “To End” button is highlighted.

3. Start rolling and touch the parameter control to punchin the automation pass.

You will find this works the same for the other Fill options:
• When “To Start” is selected, punching out of automation will fill the automation track from where you punched
out to the start of the project.
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• To use the Loop option, you must first set up a loop
range with the left and right locators. When you then select Loop, punching out of automation will set the found
value within the range defined by the left and right locator.

Fill combinations
You can also combine the various Fill options.

Note that, even when the project cursor is outside the defined loop, the
found automation value will be applied only between the locators.

• Select “To Punch” and “To End” if you want the found
value to be used from where you punched in through to
the end of your project.

Fill Loop

Combining Fill To Punch and Fill To End

• The Gaps option is used only in combination with Virgin
Territory. This is explained in detail in the section “Virgin
territory vs. the initial value” on page 217. When Gaps is
selected, punching out of automation will fill any gaps between previously written automation with the last value
found during the last automation pass.

• Combining “To Start” and “To End” will fill the automation
track from the beginning through to the end of the project.

!

The Fill options write one particular value across a
defined section of your automation track – any previously created data within this section is overwritten.
Therefore, use the Fill options with caution, to avoid
accidental loss of data.

!

Note that when Trim is active, the Fill–Gaps option
will have no effect. This is because Trim will only
modify already existing data.

Combining Fill To Start and Fill To End

• You can also combine the Fill options with the Preview
options (see “The Preview options” on page 225), and
when working offline with the Pencil tool.
Offline editing is explained in more detail in the section “Editing automation events” on page 235). This is a very fast and efficient way to move
through your project.

Feel free to experiment!
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One shot vs. continuous fill

Trim in Play mode

The Fill options can be used in two different ways:

In Play mode, moving the fader in Trim mode will move the
existing break-points by a relative amount as the project
cursor passes over them.

• When you click one of the Fill options once, it is highlighted, and will be enabled during the next automation
pass.

• In Play mode, as the project cursor moves along the
timeline, your Trim moves will adjust the existing breakpoints on the automation curve.

Afterwards, the option is disabled again, i.e. the operation can be performed only once.

• If you click a Fill option a second time, a lock symbol is
displayed on the highlighted button, indicating that you
are permanently in “Fill to X” mode and that the operation
can be repeated as many times as you wish.

Ö Note that the exact result of your trim moves in Play
mode will only be visible after punch-out.

Clicking the option for a third time will disable this Fill option.

Trim
Trim is available from the Automation panel only. Trim is a
way of manipulating an already written automation curve,
other, rather than an automation mode.
Ö Trim works for channel volume and aux send level
adjustments.
When enabling Trim, a channel volume fader is positioned
in the exact middle position, and will not move with any existing volume automation curve.

Trim in Play mode, in combination with Fill to Punch. Note that you
would arrive at a similar curve when enabling Trim, setting the left and
right locators, selecting Fill Loop and moving the fader downwards in
Stop mode.

You can use Trim either in Stop mode or in Play mode.

Ö Note that Trim is not merely a matter of rewriting the
automation curve using the fader movements you perform.
Instead, the settings from the existing curve and the settings calculated from your fader movements are used to
re-calculate the automation curve as soon as you punchout.

Trim in Stop mode
In Stop mode, selecting one of the Fill options and moving
the fader in Trim mode will move the entire existing volume
automation curve up or down, so you can still adjust the
overall volume of a channel without destroying any automation data that you might have created earlier.
• In Stop mode, Trim is used in combination with some of
the Fill options (see “The Fill options” on page 222), to
determine within which range the automation curve is adjusted.
The Fill options available are To Start, To End, Loop and any combination
of these.
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The Preview options

• Note that each automation track has its own Preview
button.

Clicking this button will enable Preview mode for this particular automation track. This is touch-collecting via automation tracks.

3. Play back the scene (you may want to loop it) and find
the parameter setting(s) you want.
Preview provides an easy way to find new settings without
recording the steps needed to locate them:
• Preview allows you to deal with abrupt changes in your
audio material, e.g. in music when changing from verse to
chorus, or in film when moving into the next scene.
• With Preview, you can do a test run of your automation
pass.
• Preview is the mode to use in complex situations where
many things happen in a very short period of time, and
where it is not possible to set all required parameters in
real-time.
Touch the required parameter, start rolling, find the desired value and
select Punch to start the new automation pass.

• Preview allows you to set up automation for several parameters simultaneously.

• Use the Suspend option in the Preview section on the
Automation panel to compare any previously automated
value with the value found during preview.

Imagine two film scenes where the actors move from a hotel entrance hall into the open air: while some of your parameter settings might still be OK for the second scene,
others will have to change abruptly as soon as the second
scene starts.

Suspend will play back your audio material using the parameter values
set before activating Preview – in our example above, to hear the settings
for the indoor scene, you need to click Suspend, and at the moment of
scene change, you need to click Suspend again to return you to Preview
mode and the values found for the open-air scene.

So for the second scene, you must find new settings, but
without deleting any existing automation data.
The Preview workflow
The Preview workflow has three different phases: touchcollecting the required parameters, finding the required values, and the actual automation pass. Proceed as follows:
1. On the Automation panel, click the Preview button in
the Preview section.
The Preview button is highlighted.

2. Touch a parameter control.
Below the Preview button three other buttons are displayed. You now
have full manual control of the touch-collected parameter, suspending
(but not deleting!) any previously recorded automation data. You may
now touch-collect another parameter, if you want to write data for several
parameters during the same automation pass.

Suspend allows you to listen to the existing automation settings.
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Ö Remember: you can use the delta indicator in the automation track as an additional visual aid for comparing
the previously found and the currently set parameter values.

When in Preview mode, you can also use the left and right
locators to automatically punch-in and out at defined positions, using the Auto Punch command.
• Use Auto Punch when you want the automation pass to
begin and end at defined positions.

4. When you are happy with the values found, start rolling and click Punch to punch-in the automation pass.

You can also use Auto Punch without enabling Preview
mode, to set up a “safe zone” for previously written automation data:

The new value setting is recorded, from the point where you punched in
to your punch-out position (as defined by the automation mode setting).

• Place the right locator at the beginning of an area you
wish to protect and enable cycle mode.
This will ensure that a running automation pass will always punch-out before reaching this section of your project.

Touch Assist
When you use Preview mode, you may get into a situation
where you change some parameters, but not others, although they belong to the same group of parameters (e.g.
EQ settings). To prevent you from forgetting some parameters while touch-collecting parameters for Preview (see
also “The Preview workflow” on page 225), you can enable the Touch Assist option. You will find this option at
the bottom of the Preview section on the Automation
Panel.

The result of the Preview automation pass.

Punch vs. Punch on Play
When using the Punch option as described above, starting playback and punching in are two separate actions. If
you want to punch-in when starting playback, activate
Punch on Play.
• Punch would be the option to use if you need to listen to
the section before your desired punch-in point and if this
section has automation data already that you don’t want to
overwrite – you would roll through this section and then
punch-in the automation pass.

The Touch Collect Assistant is enabled.

• You can also use Punch in Stop mode. To create automation data in this way, Punch must be combined with
one of the Fill modes (see “The Fill options” on page 222).

When the Touch Collect Assistant is enabled, the parameters of the following features will be treated as groups:
•
•
•
•
•

• Use Punch on Play when you cannot punch-in on the fly
– i.e. in situations where you need to find the punch-in position in stop mode. Once you have found the exact position, enable Punch on Play and start playback from there.
Auto Punch

Channel EQ module (21 parameters total)
Aux send on/off and send level
Stereo panner
Surround panner (Left-Right, Front-Rear, LFE)
Insert plug-ins (only available for plug-ins with 32 or less
parameters)

• When this option is enabled, it will ensure that touching
one parameter in a group will “touch” all other parameters
in that group as well.

As described in the section “General punch-out conditions” on page 219, when setting up a loop with the left
and right locators, an automation pass will always punchout when reaching the right locator.
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• If, however, you want to automate one and only one particular parameter, the Touch Collect Assistant should be
disabled to prevent you from inadvertently overwriting any
previously created automation data.
!

• To specify how many log entries are displayed, click the
Max. Log Entries button in the Settings section.
If this value is set to 10 entries, the eleventh punch event will overwrite
the entry created for the first event, the twelfth will replace the second
entry, etc. The maximum possible number of punch log entries is 100.

Enabling the Touch Collect Assistant may lead to the
creation of a large amount of automation data, causing a higher CPU load. If performance is an issue in
your workflow, you should consider not using the
Touch Collect Assistant.

• You can prevent a particular entry from being overwritten by clicking in the right column for this entry, so that a
check mark is displayed.

Changing plug-in presets in Preview mode
When changing a preset of a VST plug-in while in Preview
mode, the change in the parameter settings caused by the
preset change is recorded automatically as automation.
Note that the plug-in must have 32 or less parameters for
this to work.

• Punch log entries are saved with the current project.
Punch log data is always project-specific. There is no way to export log
entries to another project.

Loading behavior
When loading a log entry, you add the corresponding parameter(s) to any other parameters that you have touchcollected during the current Preview session.

The Punch Log section

However, if you manually touch-collect a parameter, e.g.
volume, and then add volume again by loading a punch
log entry, the settings for volume from the punch log will
be used, replacing any values set manually.

The Suspend options
This section of the Automation panel displays a list of recent punch-in operations performed in Preview mode.
By loading one of these log entries for the current track,
you recall the corresponding touch-collected parameters
and their values at the moment of punch-in.
• To recall the settings of a particular entry in the punch
log, select it in the list and click Load.

The parameters or parameter groups selected here are
excluded from the reading or writing of automation data –
giving you full manual control of these parameters.

The Preview button on the Automation panel and the “Preview mode”
button on the corresponding automation track light up to indicate that
this parameter is now in Preview mode.

Ö Note that the Others options refer to all parameters
not covered by any of the options Volume, Pan, Mute, EQ,
Sends or Inserts.

• You can rename any log entry by double-clicking it and
entering a new name.
• To delete an entry, select it and click Delete.
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The Show options

Suspending Write
Imagine the following situation: To help you concentrate
while working on a particular track, you mute several other
tracks. However, because automation Write is active on
these tracks, this mute state is also automated during the
next automation pass – a classic situation in mixing.
To avoid inadvertently excluding whole tracks from your
mix in this way, you can exclude Mute from all automation
writing. Simply click Mute below the Suspend Write button in the Suspend section on the Automation panel.

The Show options in the Automation panel

When any of the options below the Suspend Write button are enabled,
clicking Suspend Write will disable these buttons.

The Show options in the Automation panel always affect
all tracks. Clicking on these buttons opens the automation
tracks for the corresponding parameters, e.g. volume or
pan. This makes it easy to look at, e.g., your EQ settings
on several tracks.

• When an automation pass is in progress for a particular
parameter and you write-suspend this parameter, it will
punch-out of the automation pass.

• When you click either Volume, Pan, EQ, Sends or Inserts, this will open the corresponding automation track(s)
for all tracks.

Suspending Read

The automation tracks will be opened even if no automation data was recorded on these tracks.

• Click the Suspend Write button to enable all Suspend
Write options, thus suspending the writing of automation
data for all parameters/parameter groups.

Imagine you have already automated several tracks. While
working on the current track, you want one of the other
tracks to be louder, to better identify a particular position
in your audio material. By suspending Read for the volume
parameter, you regain full manual control and can set the
volume to the required level.

• For parameter groups (i.e. Pan, EQ, Sends and Inserts)
you can step through the individual parameter sets by repeatedly clicking the respective button.

• Click the Suspend Read button to enable all Suspend
Read options, thus suspending the reading of automation
data for all parameters/parameter groups.

“Empty” automation tracks will not be displayed.

• When the Used Only button is enabled, clicking one of
the parameter options will show you only the automation
tracks for which automation data has already been written.
• When you click Show Used, only those automation
tracks that contain automation data will be displayed.

When any of the options below the Suspend Read button are enabled,
clicking Suspend Read will disable these buttons.

These will be all automation tracks, for any parameter, on all automated
tracks.

• Hide All will hide all open automation tracks.
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The Settings section

Fill Gaps on Selected Tracks
When working with virgin territory (see “Virgin territory vs.
the initial value” on page 217), selecting this option will,
on the selected track(s), fill the gaps between those sections of the project that show automation curves with a
continuous value.
The value used is the value of the last break-point (the end
point) of a section. This value is written across the gap up
to one millisecond before the first break-point of the next
automated section. A new break-point is inserted here;
the value will be ramped to the next automated section.

The options in the Settings section of the Automation panel

In the Settings section of the Automation panel you will
find a number of global options and commands.

Fill Gaps with current Value (Selected Tracks)
When working with virgin territory (see “Virgin territory vs.
the initial value” on page 217), selecting this option will,
on the selected track(s), fill the gaps between those sections of the project that show automation curves with the
value set by the current position of the corresponding
control.

The Functions pop-up menu

Global options
Return Time

At the top of the Settings section you will find the Functions pop-up menu. Here you will find a number of global
commands affecting automation.

The Return Time setting determines how fast the automated parameter returns to any previously automated
value when you release the mouse button.

Ö You can always undo these actions!

The default setting is 33ms. Make sure that the return time
is set to a value larger than 0, to prevent sudden jumps in
your parameter settings (which may lead to crackles).

Delete All Automation in Project
This global command will remove all automation data from
your project. Use this option with great caution, otherwise
you may loose your work.

Reduction Level
The automation reduction function automatically reduces
the number of automation events. During an automation
pass (or when drawing automation with the Pencil tool),
these are added as a continuous stream of densely packed
break-points. This is necessary because the program cannot “guess” what you will be doing next.

Delete Automation of Selected Tracks
When you select this command, all automation data for
the selected track(s) will be removed. Make sure you have
selected the right track(s) before using this option.
Delete Automation in Range

However, when punching out, the reduction function will
remove all break-points that are not needed. The automation curve will contain only the break-points necessary to
reproduce your actions.

This command will delete, on all tracks, all automation
data between the left and right locator. Be sure that this is
what you want to do before proceeding!
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Hints and further options

For example, all break-points that lie between two other
points, but do not deviate from the curve, will be automatically removed by reduction.

Automation key commands
In the Key Commands dialog (opened from the File menu
in Nuendo), in the Commands section on the left, you will
find an Automation category which lists all automation
commands to which you can assign key commands.

If you try to add a break-point that doesn’t deviate from the existing
curve between two existing points…

How to assign key commands is described in detail in the
chapter “Key commands” on page 517.

About automation undo

…it will be removed when the mouse is released. If you move the selected break-point by any amount so that the resulting curve isn’t a
straight line, a new event will be added.

Every automation write operation you perform creates its
own event in the undo history, so you can undo or redo
any of your automation moves at any time.

• If you are unhappy with the default setting (a reduction
of roughly 75%), you can change it, but normally the default setting works well.
!

About linking and automation
Nuendo allows you to link, in the mixer window, various
parameters between different channels (see “Link/Unlink
channels” on page 145).

The higher the number of automation events, the
higher the CPU load. If performance is an issue in
your workflow, you should consider moving the reduction level slider further to the right, to remove
more events.

Also, in the channel settings window, you can link a send’s
panorama settings to the panorama settings displayed in
the channel strip (by enabling the option “Link Send Routing Panners to Channel Panner as Default” in the Preferences–VST page).

Max. Log Entries
This setting refers to the Punch Log and is described in
“The Punch Log section” on page 227.

• When automating the settings of a channel that is linked
to another channel in the mixer, the parameters of the
linked channel will NOT be automated.

Show Data on Tracks
When this option is enabled, audio waveforms or MIDI
events will be displayed not only on the audio or MIDI
tracks, but also on the corresponding automation tracks.

• For linked panners of sends and channels, automating
one panner will automate the linked panner as well.

Ö Note that this depends on two options in the Preferences dialog: The events will be displayed only when the
option “Show waveforms” (Event Display–Audio) is enabled and when “Part Data Mode” (Event Display–MIDI) is
set to an option other than “No data”.

Use Virgin Territory
This option is described in detail in the section “Virgin territory vs. the initial value” on page 217.
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Automation track operations

• By clicking along the left edge of the track in the Track
list. (Also, when you position the mouse pointer over the
lower left corner of the track, a corresponding arrow icon
(“Show/Hide Automation”) appears.)

About automation tracks
Audio tracks, group channel tracks and FX channel tracks
all have automation tracks. These allow you to view and
edit the automation of all mixer settings for the track, including settings for the track’s insert effects. There is one
automation track for each parameter, and automation
tracks can be shown or hidden in any combination.

An automation track opens in the Track list. Depending on your Preference settings (see above), the event display shows a straight black horizontal line as well as a grayed out mirror image of the audio events’
waveform (or MIDI events for MIDI tracks). By default, the volume parameter is assigned to the first automation track.
Click here to open an
automation track

Similarly, MIDI tracks have automation tracks for mixer settings, track parameters and (if used) for send and insert effect settings.
VST Instruments have special automation tracks that appear in the Project window when you load a VST Instrument
via the VST Instruments window. There is one automation
track for the plug-in parameters, and one track for each
mixer channel used by the instrument. These tracks all have
automation tracks, giving you access to all parameters and
mixer settings.

For VST Instruments (not for Instrument tracks, see below),
automation tracks appear automatically when you add them
in the VST Instruments window.

Instrument tracks, as a combination of a MIDI track and a
VST Instrument, have automation tracks that provide automation parameters for the VST Instrument itself, for the
VST Instrument channel and the respective MIDI automation parameters.

For ReWire channels and input/output busses, automation tracks are automatically created when the Write automation button (see “Enabling and disabling the writing of
automation data” on page 214) is activated in either:

Finally, for ReWire channels and input/output channels,
automation tracks are automatically added as soon as you
activate automation (with the Write button) in the corresponding mixer channel strip or in the Channel Settings
window. These tracks have automation tracks for all parameters as well.

•
•
•
•

The corresponding channel strip in the mixer.
The corresponding Channel Settings window.
The mixer common panel (“All Automation to Write Status”).
The area above the Track list (“All Automation to Write Status”).

Opening additional automation tracks

Opening automation tracks

• If you position the mouse pointer over the lower left corner of an automation track, a “+” sign (“Append Automation Track”) will appear. If you click this, another
automation track opens, by default showing the next parameter in the Add Parameter list (see below).

Every track/channel has a number of automation tracks,
each showing one automation parameter.
For audio, Instrument, group channel, MIDI and FX channel tracks, there are two ways you can open an automation track for the channel:
• By right-clicking the track in the Track list and selecting
“Show Automation” from the context menu.
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• If the parameter you wish to automate is on the pop-up
menu, you can select it directly.
The parameter will then replace the current parameter in the automation
track.

• If you wish to add a parameter not available on the popup menu or want to view all parameters that can be automated, go on to the next step.
3. Select “More...”.
The Add Parameter dialog appears. This dialog shows a list with all parameters that can be automated for the selected channel (sorted into different categories), including the parameters for any assigned insert
effects. To view the parameters in each category, click the “+” sign for
the category folder.

Assigning a parameter to an automation track
Default parameters are already assigned to automation
tracks when you open them, according to their order in the
Add Parameter list (see below).
To select which parameter an open automation track
should display, proceed as follows:
1. If none exists, open an automation track using one of
the methods described above.
2. Click in the parameter display for the automation track.
A pop-up list is shown, containing some of the automation parameters
plus the item “More...” at the bottom of the list. The contents of the list
depend on the track type (audio, MIDI, VST instrument, etc.).

The Add Parameter dialog for an audio track.

4. Select a parameter from the list and click OK.
The parameter will then replace the current parameter in the automation
track.
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Ö Note that the “replacing” of the parameter displayed in
the automation track is completely non-destructive.

Showing/hiding automation tracks
• To hide a single automation track, position the pointer
over the top left border of the automation track in the Track
list and click the “Hide Automation Track” button (the minus
sign).

For example, if the automation track contained any automation data for
the parameter you just replaced, this data will still be there, although it
will not be visible after you replaced the parameter. If you click in the parameter display you can switch back to the replaced parameter. On the
pop-up menu, all automated parameters are indicated by an asterisk (*)
after the parameter name.

• To hide all automation tracks for a track, right-click the
track for which you wish to hide the automation tracks,
and select “Hide Automation” from the context menu.
• To hide all automation tracks for all tracks in the Track
list, right-click any track and select “Hide All Automation”
from the context menu.
This option is also available in the Track Folding submenu of the Project
menu.

• On the Automation panel, you can hide or show automation tracks using the options in the Show section.

The Volume parameter is automated.

You can click the “Append Automation Track” button (the
“+” sign) for the automation track several times to open
additional automation tracks. Repeat the above procedure
to assign a parameter to each automation track.

See “The Show options” on page 228.

Showing only used automation tracks

Removing automation tracks
To remove automation tracks from the Track list, proceed
as follows:
If a lot of automation tracks are used, it may be impractical
to have them all open in the Track list. If you want to view
only the automation tracks that are used (i.e. those that
actually contain automation events) and hide all empty automation tracks, do one of the following:

• To remove a single automation track, click the parameter name and select “Remove Parameter” from the pop-up
menu.
Note that this will also delete any automation events on the automation
track, and the automation track will be closed.

• Right-click any track in the Track list and select the option “Show All Used Automation” from the pop-up menu.

• To remove all currently unused automation tracks from a
track in the Track list, select “Remove Unused Parameters” from any of its automation track parameter name
pop-ups.

This will close all automation tracks not containing any automation
events, while leaving used automation tracks open for all tracks. This option is also available in the Track Folding submenu of the Project menu.

All automation tracks that do not contain automation events will be
closed for the selected track.

• Right-click a specific track and select the option “Show
Used Automation (Selected Track)” from the context menu.

• On the Automation panel, you will find the Delete options in the Functions pop-up menu (see “The Functions
pop-up menu” on page 229).

This will close all automation tracks for the selected track not containing
any automation events, while leaving used automation tracks open.

Using these commands will also lead to the removal of automation tracks.
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Ö Please note that not all Inspector tabs are shown by
default. You can show/hide Inspector sections by rightclicking on an Inspector tab and activating/deactivating
the desired option(s).

Muting automation tracks

Make sure to click on an Inspector tab and not on the empty area below
the Inspector, as this will open the Quick context menu instead.

You can mute individual automation tracks by clicking their
Mute buttons in the Track list. Clicking the Read (R) button (see “Enabling and disabling the writing of automation
data” on page 214) for an automation track will activate or
deactivate Read mode for all automated parameters of the
track. Using the Mute button allows you to turn off automation for a single parameter.

2. Open the control panel for the effect by clicking the Edit
button (“e”) above the insert effect slot in the Inspector.

The “Automation follows Events” setting

4. Start playback and adjust some effect parameters in
the control panel.

3. Click the Write button in the control panel to enable
Write mode.
The Read button is enabled as well. All effects and VST Instruments have
Write/Read buttons on their control panels. These work exactly like the
corresponding buttons in the mixer or in the Track list.

If you activate “Automation follows Events” on the Edit
menu (or in the Preferences–Editing page), automation
events will automatically follow when you move an event or
part on the track.

When you are finished, stop playback and return to the position where
you started playback.

5. Disable Write.
The Read button remains enabled.

This makes it easy to set up automation related to a specific event or part, rather than to a specific position in the
project. For example, you can automate the panning of a
sound effect event (having the sound pan from left to right,
etc.) – if you need to move the event, the automation will
automatically follow! The rules are:

6. Start playback and watch the control panel.
All actions you performed during the previous playback will be reproduced exactly.

Assigning an automated parameter to an automation
track

• All automation events for the track between the start
and end of the event or part will be moved.

To select which parameter is currently shown in the automation track for a channel, proceed as follows:

If there are automation events in the new position (to which you move the
part or event), these will be overwritten.

1. Click on the parameter name for the channel’s automation track.

• If you copy an event or part (using Copy/Paste, or [Alt]/
[Option]-dragging, or using the Duplicate or Repeat functions), the automation events will be duplicated as well.

The parameter name pop-up list is shown containing the automation parameters for the plug-in. The parameter(s) you previously automated are
indicated by an asterisk after the parameter name in the list.

Recording plug-in automation
Every parameter for every assigned effect or VST Instrument can be automated in much the same manner as described above.
The following example assumes that you have assigned an
insert effect to an FX channel track (see the chapter “Audio effects” on page 168), and describes how to record
automation for the effect:

Automated parameters for the PingPongDelay effect.

2. Select the parameter you wish to view from the parameter display pop-up.
The automation curve for the parameter you selected is displayed on the
automation track.

1. Select the FX channel track in the Track list and open
its Inserts section in the Inspector.
If the Inspector is hidden, click the “Show Inspector” button in the
Project window toolbar.
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• To view VST Instrument parameters, you use the same
method.

previously adjusted that parameter with write automation
activated), and this is reflected in the event display as a
straight horizontal black line, the “static value” line. This
line represents the current parameter setting.

As described earlier, each VST Instrument has two or more automation
tracks – one for the plug-in settings and one for each VST Instrument
mixer channel.

• If you have manually added any automation events or
used write automation for the corresponding parameter,
and then disable the reading of automation data, the automation curve will be grayed-out in the automation track
event display and the static value will be used instead.

Dragging and dropping of insert plug-ins
You can drag an insert plug-in from one insert slot to another, either on the same channel or on a different channel.

As soon as Read mode is enabled, the automation curve will become
available.

• When dragging a plug-in to a different insert slot on the
same channel, any existing automation data will move with
the plug-in.

Editing automation events

• When dragging a plug-in to a different insert slot on a
different channel, any existing automation data will not be
transferred to the new channel.

Drawing automation events
By using write automation in the mixer, you generate automation events by moving parameter dials and faders in the
mixer. You can also add them manually by drawing automation curves on an automation track. Proceed as follows:

Working with automation curves
About automation curves

1. Show the automation track by clicking on the left edge
of the track in the Track list.

There are two kinds of automation curves, “ramp” and
“jump”:

The static value line is shown in the event display for the automation
track.

• Jump curves are created for any parameter that only has
on/off values, like a Mute button, for example.
• Ramp curves are created for any parameter that generates continuous multiple values, such as fader or dial
movements etc.

2. Select the Pencil tool.
You can also use the various modes of the Line tool for drawing curves,
see below.

3. Click on the static value line. An automation event is
added, read automation mode is automatically activated,
and the static value line changes to a blue automation
curve.
Examples of jump and ramp automation curves shown in the event display.

About the static value line
When you are not using virgin territory (see “Virgin territory vs. the initial value” on page 217) and you open an
automation track for a parameter for the first time, it
doesn’t contain any automation events (unless you have
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4. If you click and hold, you can draw a curve by adding a
multitude of single automation events.

4. Release the mouse button.
At the moment of release, a final automation event is created. The automation curve is written from this last break-point through to the end of
the project.

Note that the track color in the track list changes to red to indicate that
automation data is being written.

You will find this works the same for all the other Fill options. For more information on what you can do with Fill
and the other automation performance utilities, see “Automation performance utilities” on page 222.
Using the various modes of the Line tool to draw
automation curves

5. When you release the mouse button, the number of
automation events is reduced to a few events, but the basic shape of the curve still remains the same.

The Line tool can be very useful for drawing automation
events. The various modes are accessed by selecting the
Line tool on the toolbar, clicking on it a second time and
selecting from the pop-up menu that appears.

This “thinning out” of events is governed by the Reduction Level setting
in the Settings section of the Automation panel, see “Reduction Level”
on page 229.

• Clicking and dragging with the Line tool in Line mode
shows a line in the automation track and creates automation events aligned with this line.
This is a quick way to create linear fades, etc.

6. If you now activate playback, the volume will change
with the automation curve.
In the mixer, the corresponding fader moves accordingly.

• The Line tool in Parabola mode works in the same way,
but aligns the automation events with a parabolic curve instead, resulting in more “natural” curves and fades.

7. Simply redo the operation if you are not happy with the
result.
If you draw over existing events, a new curve is created.

Note that the result depends on the direction from which you draw the
parabolic curve.

• If the automation track is in Read mode already, you can
also add automation events by clicking with the Arrow
tool.
If you are trying to add a break-point between two existing points and the
new point doesn’t deviate from the existing curve, it will be removed by
reduction as soon as you release the mouse button (see “Reduction
Level” on page 229).

• The Sine, Triangle and Square Line tool modes create
automation events aligned with continuous curves.
If snap is activated and set to Grid, the period of the curve (the length of
one curve “cycle”) is determined by the grid setting. If you press [Shift]
and drag, you can set the period length manually, in multiples of the grid
value.

Drawing curves with Fill enabled
You can use the Fill options on the Automation panel in
combination with the Pencil tool. This provides you with an
extremely powerful tool for offline work:
1. As in the example above, open an automation track for
the desired parameter and select the Pencil tool.
Remember: the Write button does not have to enabled.

2. On the Automation panel, select “To End”.
3. Click and draw to create an automation curve.
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Selecting automation events

Editing automation events

• To select a single automation break-point, click on it
with the Arrow tool.

Automation events can be edited much like other events.
You can use cut, copy and paste, you can group and
nudge events etc. There are, however, four items on the
Edit menu that are not applicable to automation events.
These are:

The break-point turns red, and you can drag it in any horizontal or vertical
direction between two points.

• To select multiple break-points, you can either [Shift]click or drag a selection rectangle with the Arrow tool.

•
•
•
•

All break-points inside the selection rectangle will be selected.

Split at Cursor
Split Loop
Move to Front
Move to Back

Editing automation events in the Project
Browser
You can also edit automation events in the Project
Browser. Proceed as follows:
1. Open the Project Browser by selecting it from the
Project menu.

Drawing a selection rectangle around break-points to select them.

The Browser window opens. The window is divided into two sections,
the Structure list to the left and the event display to the right.

• To select all automation events on an automation track,
right-click the automation track in the Track list and
choose “Select All Events” from the context menu.

2. Click on the “+” sign for a track in the structure list.
Automated tracks have two subitems: Track Data and Automation. The
Automation item corresponds to the automation track in the Project window, and contains the track’s automation events.

3. Click on the “+” sign for the Automation item.
All automated parameters for the track are shown in the structure list.

Removing automation events

4. Clicking on a parameter in the structure list brings up
the automation events in the event display.

There are several ways to remove break-points:
• By selecting points and pressing [Backspace] or [Delete] or selecting Delete from the Edit menu, or by clicking
on a break-point with the Eraser tool.
This will remove the break-points. The curve is redrawn to connect the
break-points immediately to the left and right of the removed points.

• By selecting a range (with the Range Selection tool),
and pressing [Backspace] or [Delete] or selecting Delete
from the Edit menu.
When “Use Virgin Territory” is enabled, this will create a gap. When “Use
Virgin Territory” is disabled, this will remove the break-points within the
range, but the curve will be redrawn to connect new break-points at the
start and end of the selected range. See also “Gaps” on page 218.

The following parameters are available for all automation
tracks:
Parameter

• By clicking in the parameter display on an automation
track and selecting “Remove Parameter” from the pop-up.
This will remove all automation events from the automation track, and the
automation track will be closed.

Description

Position

The position of the automation event.

Value

The value of the automation event.
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17
Audio processing and functions

Background
Audio processing in Nuendo can be called “non-destructive”, in the sense that you can always undo changes or
revert to the original versions. This is possible because
processing affects audio clips rather than the actual audio
files, and because audio clips can refer to more than one
audio file. This is how it works:
1. If you process an event or a selection range, a new audio file is created in the Edits folder, within your project
folder.
This new file contains the processed audio, while the original file is unaffected.

2. The processed section of the audio clip (the section
corresponding to the event or selection range) then refers
to the new, processed audio file.
The other sections of the clip will still refer to the original file.
This event plays a section of this clip…

• Furthermore, the original, unprocessed audio file can
still be used by other clips in the project, by other projects
or by other applications.

Audio processing
Basically, you apply processing by making a selection and
selecting a function from the Process submenu on the Audio menu. Processing is applied according to the following rules:
• Selecting events in the Project window or the Audio
Part Editor will apply processing to the selected events
only.
Processing will only affect the clip sections that are referenced by the
events.

• Selecting an audio clip in the Pool will apply processing
to the whole clip.
• Making a selection range will apply processing to the
selected range only.
Other sections of the clip are not affected.

…which refers to this audio file.

If you attempt to process an event that is a shared copy
(i.e. the event refers to a clip that is used by other events in
the project), you are asked whether you want to create a
new version of the clip or not.

Select “New Version” if you want the processing to affect the selected
event only. Select “Continue” if you want the processing to affect all
shared copies.

After processing the event the clip will refer both to the original file and
a new file, containing the processed section only.

• Since all edits are available as separate files, it is possible to undo any processing, at any point and in any order!
This is done in the Offline Process History dialog, see “The Offline Process History dialog” on page 251.
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Ö If you activate “Do not show this message again”, any
further processing you do will conform to the selected
method (“Continue” or ”New Version”).
You can change this setting at any time by using the “On Processing
Shared Clips” pop-up in the Preferences (Editing–Audio page).

Common settings and features

Acoustic Stamp

If there are any settings for the selected Audio processing
function, these will appear when you select the function
from the Process submenu. While most settings are specific for the function, some features and settings work in
the same way for several functions:
The “More…” button
If the dialog has a lot of settings, some options may be
hidden when the dialog appears. To reveal these, click the
“More…” button.

To hide the settings, click the button again (now labeled
“Less…”).
The Preview, Process and Cancel buttons
These buttons have the following functionality:
Button

Description

Preview

Allows you to listen to the result of the processing with
the current settings. Playback will continue repeatedly
until you click the button again (the button is labeled
“Stop” during Preview playback). You can make adjustments during Preview playback, but the changes are not
applied until the start of the next “lap”. Some changes
may automatically restart the Preview playback from the
beginning.

Process

Performs the processing and closes the dialog.

Cancel

Closes the dialog without processing.

Pre/Post-CrossFade
Some processing functions allow you to gradually mix the
effect in or out. This is done with the Pre/Post-CrossFade
parameters. If you activate Pre-CrossFade and specify a
value of e.g. 1000 ms, the processing will be applied gradually from the start of selection, reaching full effect 1000 ms
after the start. Similarly, if you activate Post-CrossFade, the
processing will gradually be removed, starting at the specified interval before the end of the selection.
!

The sum of the Pre- and Post-CrossFade times cannot be larger than the length of the selection.

The Acoustic Stamp function is a convolution tool, which
allows you to apply room characteristics (reverb) to the
audio. This is done by processing the audio signal according to an impulse response – generally a stereo or mono
recording of a very short signal (the impulse) in a room or
other location. As a result, the processed audio will sound
as if it were played in the same location.
!

This function requires a lot of processing power, especially when using the Preview function. If you are
working with long impulse response files or stereo
files, you may find that Preview playback stutters or
stops. In that case, it’s better to process the material,
listen to the result and modify it in the Offline Process History (see “The Offline Process History dialog” on page 251) if necessary.

The dialog contains the following settings:
Impulse and Envelope display
This display shows the loaded impulse response (in white)
and the Envelope (in red). You can zoom in vertically on
the impulse response using the slider to the right of the
display (this can be useful since impulse responses typically are very weak). Zooming does not affect the processing in any way.
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Load Impulse button

Filter controls

Clicking the “Load Impulse” button allows you to load an
impulse response file from disk. These are ordinary wave
or aiff audio files, with a maximum duration of 12 seconds.
The name of the currently loaded impulse response file is
shown above the display.

The three sliders to the right allow you to tailor the tonal
character of the processed sound. In essence, this is a
graphic equalizer with three broad bands: the LPF slider
governs the low frequency content, the BPF governs the
midrange and the HPF governs the high frequency content.

• A number of demonstration impulse response files are
included in the Nuendo program folder.

• Setting a slider to 100% means that the corresponding
filter is “fully open”.

For proper use of the Acoustic Stamp function, we recommend that you
acquire files from a professional impulse response library.

When all three sliders are set to 100%, the processed audio is not filtered at all.

Play Impulse button

Reset button

Plays back the currently loaded impulse response.

Sets all parameters in the upper section of the dialog to
their default values.

Channel selector
If the currently loaded impulse response is a stereo file,
this pop-up menu allows you to select whether the left
channel, right channel or both (stereo) should be used for
the convolution process.
Envelope controls
The five sliders below the display are used for setting up
the “reverb envelope”, that is, a gain curve modifying how
the impulse response is applied over time, and thereby the
reverb character. These settings are reflected in the red
Envelope display above. The sliders have the following
functionality:

Wet/Dry Mix
These two sliders allow you to specify the balance between wet (processed) and dry (original) signal in the resulting clip.
Normally the two sliders are “reverse-ganged”, so that
raising the Wet mix slider lowers the Dry mix slider by the
same amount. However, if you press [Alt]/[Option] and
drag a slider, you can move it independently. This allows
you to set e.g. 80% dry and 80% wet signal. Be careful to
avoid distortion.
Tail

First Ref. Length This determines the length of the First Reflections section (the level of which is controlled by the previous parameter). Usually you would want to set this so that it
includes the first reflection in the impulse response (normally about 5% of the total length).

This parameter allows you to “add space” after the original
audio section, to avoid that the reverb tail is cut off. When
the checkbox is activated, you can specify a tail length using the slider. The tail time is included when playing back
with the Preview function, allowing you to find the appropriate tail length. A good value would be the Reverb
Length value, displayed in ms to the right of the Reverb
Length parameter.

Reverb Att.

A level control for the end section of the reverb (the section after the First Reflections, see above).

Pre and Post-CrossFade

Reverb Length

Governs the reverb time, in milliseconds.

See “Pre/Post-CrossFade” on page 240.

Gain

Allows you to adjust the gain of the impulse response.
This may be necessary for optimal results, since different
impulse response files may be recorded at different levels.

Parameter

Description

First Reflections A level control for the first section of the reverb (the
length of which is set with the next parameter, see below). Usually, this governs the volume of the first reflection(s) of the reverb.
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Envelope

Gain

Allows you to change the gain (level) of the selected audio.
The dialog contains the following settings:
Gain
The Envelope function allows you to apply a volume envelope to the selected audio. The dialog contains the following settings:
Curve Kind buttons
These determine whether the envelope curve should consist of spline curve segments (left button), damped spline
segments (middle button) or linear segments (right button).
Fade display
Shows the shape of the envelope curve. The resulting
waveform shape is shown in dark gray, with the current
waveform shape in light gray. You can click on the curve
to add points, and click and drag existing points to change
the shape. To remove a point from the curve, drag it outside the display.
Presets

This is where you set the desired gain, between -50 and
+20dB. The setting is also indicated below the Gain display as a percentage.
Clipping detection text
If you use the Preview function before applying the processing, the text below the slider indicates whether the
current settings result in clipping (audio levels above
0dB). If that is the case, lower the Gain value and use the
Preview function again.
• If you want to increase the level of the audio as much as
possible without causing clipping, you should use the Normalize function instead (see “Normalize” on page 244).
Pre- and Post-CrossFade
See “Pre/Post-CrossFade” on page 240.

If you have set up an envelope curve that you may want to
apply to other events or clips, you can store it as a preset
by clicking the Store button.
• To apply a stored preset, select it from the pop-up
menu.
• To rename the selected preset, double-click on the
name and enter a new one in the dialog that appears.
• To remove a stored preset, select it from the pop-up
menu and click Remove.

Fade In and Fade Out
For a description of these functions, see the chapter
“Fades, crossfades and envelopes” on page 86.
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Merge Clipboard

This functions mixes the audio from the clipboard into the
audio selected for processing, starting at the beginning of
the selection.
!

For this function to be available, you need to have cut
or copied a range of audio in the Sample Editor first.

The dialog contains the following settings:
Sources mix
Allows you to specify a mix ratio between the original (the
audio selected for processing) and the copy (the audio on
the clipboard).

Noise Gate

Scans the audio for sections weaker than a specified
threshold level and replaces them with silence. The dialog
contains the following settings:
Threshold
The level below which you want audio to be silenced.
Levels below this value will close the gate.
Attack Time
The time it takes for the gate to open fully after the audio
level has exceeded the threshold level.

Pre- and Post-CrossFade
See “Pre/Post-CrossFade” on page 240.

Min. Opening Time
This is the shortest time the gate will remain open. If you
find that the gate opens and closes too often when processing material that varies rapidly in level, you should try
raising this value.
Release Time
The time it takes for the gate to close fully after the audio
level has dropped below the threshold level.
Linked Channels
This is available for stereo audio only. When it is activated,
the Noise Gate is opened for both channels as soon as
one or both channels exceed the Threshold level. When
Linked Channels is deactivated, the Noise Gate works independently for the left and right channel.
Dry/Wet mix
Allows you to specify a mix ratio between “dry” and processed sound.
Pre- and Post-CrossFade
See “Pre/Post-CrossFade” on page 240.
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Normalize

The Normalize function allows you to specify the desired
maximum level of the audio. It then analyzes the selected
audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level
and raises the gain of the audio by the resulting amount (if
the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for
Normalizing is to raise the level of audio that was recorded
at too low an input level. The dialog contains the following
settings:
Maximum
The desired maximum level for the audio, between -50 and
0dB. The setting is also indicated below the Gain display as
a percentage.
Pre- and Post-CrossFade
See “Pre/Post-CrossFade” on page 240.

Pitch Shift

This function allows you to change the pitch of the audio
with or without affecting its length. You can also create
“harmonies” by specifying several pitches or apply pitch
shift based on a user specified envelope curve.
When the “Transpose” tab is selected, the dialog contains
the following parameters:
Keyboard display
This offers a way to specify the transpose interval in semitones and gives a graphic overview of the transposition
setting.

Phase Reverse

• The “root note” is indicated in red.

Reverses the phase of the selected audio, turning the
waveform “upside down”. The dialog contains the following settings:

This has nothing to do with the actual key or pitch of the original audio, it
just provides a way to display transpose intervals. If you like, you can
change the root note by using the settings in the Pitch Shift Base section, or by pressing [Alt]/[Option] and clicking in the keyboard display.

Phase Reverse on

• To specify a transpose interval, click on one of the keys.

When processing stereo audio, this pop-up menu allows
you to specify which channel(s) should be phase-reversed.
Pre- and Post-CrossFade
See “Pre/Post-CrossFade” on page 240.

The key is indicated in blue, and the program plays test tones in the base
pitch and transpose pitch to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on
several keys to create “chords”.
Clicking on a blue (activated) key removes it.

Pitch Shift settings
The “Semitones” and “Fine tune” settings allow you to
specify the amount of pitch shift. You can transpose the
audio ±16 semitones, and fine tune it by ±200 cents
(hundredths of semitones).
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Volume/Amplitude

Option

Description

Allows you to lower the volume of the pitch-shifted sound.

Poly Musical

Use this for processing monophonic and polyphonic material. This is the recommended MPEX default quality setting. You can use this for drum loops, mixes, chords.

Poly Complex

This high quality setting is quite processor intense and
should be used only when processing difficult material or
for stretch factors above 1,3.

Multi Shift
When this is activated, you can add more than one transpose value, creating multi-part harmonies. This is done by
adding intervals in the keyboard display (see above). Note
that you cannot use the Preview function in Multi Shift
mode.
• If the intervals you add make up a standard chord, this
chord is displayed to the right.
Note however, that to include the base pitch (the original, untransposed
sound) in the processed result, you need to click the base key in the keyboard display as well, so that it is displayed in blue.

Listen Key/Chord button
Clicking this button plays a test tone pitched according to
the activated interval key on the keyboard display. If “Multi
Shift” is activated, this button is called “Listen Chord” and
plays all activated intervals as a chord.

Formant Mode
If you are processing vocal material, you should activate
this option in order to preserve the vocal characteristics of
the pitch-shifted audio and to avoid a a “chipmunk voice”
effect.
Time Correction
When this is activated, the pitch shift process will not affect the length of the audio. When this is deactivated, raising the pitch will shorten the audio section and vice versa,
much like changing the playback speed on a tape recorder.
Using envelope based Pitch Shift

Pitch Shift Base
This allows you to set the root note (the red key in the keyboard display). It has nothing to do with the actual pitch,
but is an aid for setting up intervals and chords.
Pitch Shift Mode
This is where you can make settings for the MPEX 3 algorithm.
You can choose between 7 quality settings:
Option

Description

Preview

This mode should only be used for preview.

Mix Fast

This mode is a very fast mode for preview. This works
best with composite music signals mono or stereo material.

Solo Fast

Use this mode for single instruments (monophonic material) and voice.

Solo Musical

Same as above but higher quality.

Poly Fast

Use this for processing monophonic and polyphonic material. This is the fastest setting that gives still very good
results. You can use this for drum loops, mixes, chords.
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When the “Envelope” tab is selected, you can specify an
envelope curve on which the pitch shift should be based.
This allows you to create pitch bend effects, pitch-shift
different sections of the audio by different amounts, etc.

Envelope display

Range

Shows the shape of the envelope curve over the waveform image of the audio selected for processing. Envelope
curve points above the center line indicate positive pitch
shift, while curve points below the center line indicate
negative pitch shift. Initially, the envelope curve will be a
horizontal, centered line, indicating zero pitch shift.

This parameter determines the vertical pitch range of the
envelope. If set to “4”, moving a curve point to the top of
the display corresponds to pitch shifting by + 4 semitones. The maximum range is +/- 16 semitones.

• You can click on the curve to add points, and click and
drag existing points to change the shape. To remove a
point from the curve, drag it outside the display.

These parameters allow you to adjust the value of a curve
point numerically:

Curve Kind
These buttons determine whether the envelope curve
should consist of spline curve segments (left button),
damped spline segments (middle button) or linear segments (right button).

Transpose and Fine Tune

1. Click on a curve point to select it.
The selected point is shown in red.

2. Adjust the Transpose and Fine Tune parameters to
change the pitch of the curve point in semitones and
cents, respectively.
Pitch Shift Mode
These are the same parameters as on the Transpose tab,
see “Pitch Shift Mode” on page 245.
Example
Let’s say that you wish to create a pitch bend effect, so
that the pitch is raised linearly by exactly 2 semitones in a
specific part of the selected audio.

Spline curve segment envelope.

1. Remove all curve points by clicking the Reset button.
2. Select a linear curve by clicking the Curve Kind button
to the right.
3. Make sure the Range parameter is set to 2 semitones
or higher.
4. Create a point where you want the pitch bend to start
by clicking on the envelope line.

The same envelope with damped spline segments selected.

Since this is the starting point for the pitch bend, you want its pitch to be
zero (the envelope line should still be straight). If necessary, use the Fine
Tune parameter to set the curve point to 0 cents, because this point governs the start point, where you want the pitch transition to begin.

5. Create a new curve point at the horizontal position
where you want the pitch bend to reach the full value.
This curve point determines the rise time of the pitch bend effect, i.e. the
further away from the starting point the new point is positioned, the
longer it will take for the pitch bend to reach the full value, and vice versa.

The same envelope with linear segments selected.

6. With the second point still selected, use the Transpose and Fine Tune parameters to set the pitch to exactly
2 semitones.
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7. Create a new curve point to set the duration of the
pitch bend, i.e. the time the pitch should remain transposed by 2 semitones.

Resample

8. Finally, create a point where you want the pitch bend
to end.
You don’t need to create a new point if you are at the end of the audio
file, since there is always an end point at the right side of the waveform
display.

9. If necessary, make additional settings in the Pitch Shift
Mode section, see “Pitch Shift Mode” on page 245.
10. Click Process.
The pitch bend is applied according to the specified settings.

Remove DC Offset
This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct
current) component in the signal, sometimes visible as the
signal not being visually centered around the “zero level
axis”. DC offsets do not affect what you actually hear, but
they affect zero crossing detection and certain processing, and it is recommended that you remove them.
!

It is recommended that this function is applied to
complete audio clips, since the DC offset (if any) is
normally present throughout the entire recording.

There are no parameters for this function. Note that you can
check for DC Offset in an audio clip using the Statistics
function (see “Statistics” on page 256).

The Resample function can be used for changing the
length, tempo and pitch of an event.
The original sample rate of the event is listed in the dialog.
Resample the event to a higher or lower sample rate by either specifying a sample rate or by specifying the difference (as a percentage value) between the original sample
rate and the desired new one.
• Resampling to a higher sample rate will make the event
longer and cause the audio to play back at a slower speed
with a lower pitch.
• Resampling to a lower sample rate will make the event
shorter and cause the audio to play back at a faster speed
with a higher pitch.
• You can audition the result of the resampling by entering the desired value and clicking “Preview”.
The event will then be played back as it will sound after the resampling.

• When you are satisfied with the preview result, click
“Process” to close the dialog and apply the processing.

Reverse
Reverses the audio selection, as when playing a tape
backwards. There are no parameters for this function.

Silence
Replaces the selection with silence. There are no parameters for this function.
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Stereo Flip

Time Stretch

This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various
ways. The dialog contains the following parameters:
This function allows you to change the length and “tempo”
of the selected audio without affecting the pitch. The dialog contains the following parameters:

Mode

Define Bars section
In this section you set the length of the selected audio and
the time signature:
This pop-up menu determines what the function does:
Option

Description

Flip Left-Right

Swaps the left and right channel.

Left to Stereo

Copies the left channel sound to the right channel.

Parameter

Description

Bars

If you use the tempo setting (see below), you can specify
the length of the selected audio here, in bars.

Beats

If you use the tempo setting, you can specify the length of
the selected audio here, in beats.

Sign.

If you use the tempo setting, you can specify the time signature here.

Right to Stereo Copies the right channel sound to the left channel.
Merge

Merges both channels on each side for mono sound.

Subtract

Subtracts the left channel information from the right and
vice versa. This is typically used as a “Karaoke effect”, for
removing centered mono material from a stereo signal.

Original Length section
This section contains information and settings regarding
the audio selected for processing:
Parameter

Description

Length in
Samples

The length of the selected audio, in samples.

Length in
Seconds

The length of the selected audio, in seconds.

Tempo in BPM If you are processing music, and know the actual tempo
of the audio, you can enter it here as beats per minute.
This makes it possible to time-stretch the audio to another tempo, without having to compute the actual time
stretch amount.
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Resulting Length section

Algorithm section

These settings are used if you want to stretch the audio to
fit within a specific time span or tempo. The values will
change automatically if you adjust the Time Stretch Ratio
(see below).

Allows you to select a time stretch algorithm: MPEX 3 and
Realtime mode.

Parameter

Description

Samples

The desired length in samples.

Seconds

The desired length in seconds.

BPM

The desired tempo (beats per minute). For this to work,
you have to know the actual tempo of the audio, and
specify this (along with time signature and length in bars)
in the Original Length section to the left.

Seconds Range section
These settings allow you to set the desired range for the
time stretch.
Parameter

Description

Range

Allows you to specify the desired length as a range between two time positions.

Use Locators

Clicking the diamond-shaped button below the Range
fields sets the Range values to the left and right Locator
positions, respectively.

Time Stretch Ratio section
The Time Stretch Ratio determines the amount of time
stretch as a percentage of the original length. If you use
the settings in the Resulting Length section to specify the
amount of time stretch, this value will change automatically. The possible range depends on the “Effect” option:
• If the “Effect” checkbox is deactivated, the range is 75125%.
This is the preferred mode if you want to preserve the character of the
sound.

• If the “Effect” checkbox is activated, you can specify values between 10 and 1000% (Realtime), or 50 and 200%
(MPEX 3).
This mode is mainly useful for special effects, etc.
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• MPEX 3 mode
This mode is based on Prosoniq's proprietary MPEX (Minimum Perceived Loss Time Compression/Expansion) algorithm. This algorithm
(which is also used in Prosoniq’s TimeFactory™ application) uses an artificial neural network for time series prediction in the scale space domain
to achieve high end time and pitch scaling. This gives the best possible
audio quality result. You can choose between 7 quality settings, see
“Pitch Shift Mode” on page 245.

• Realtime mode
This is the algorithm used for the realtime time stretching features in Nuendo. Although this algorithm is optimized for time stretching in realtime,
you can use it for offline processing as well. The Presets pop-up contains the same presets as found in the Algorithm pop-up in the Sample
Editor, see “Determining the audio tempo automatically and time-stretching your audio” on page 272.

Applying plug-ins
You can add plug-in effects in real-time during playback
(see the chapter “Audio effects” on page 168). However,
sometimes it’s useful to “permanently” apply effects to
one or several selected events. This is done in the following way:
1. Make a selection in the Project window, the Pool or an
editor.
Effects are applied according to the same rules as Processing (see
“Common settings and features” on page 240).

2. Select “Plug-ins” from the Audio menu.
3. Select the desired effect from the submenu that appears.
The Process Plug-in dialog appears.

About stereo and mono
If you are applying an effect to mono audio material, only
the left side of the effect’s stereo output will be applied.

The process plug-in dialog

Tail
This parameter is useful if you are applying an effect that
adds material after the end of original audio (such as reverb and delay effects). When the checkbox is activated,
you can specify a tail length using the slider. The tail time
is included when playing back with the Preview function,
allowing you to find the appropriate tail length.
Pre/Post-CrossFade

The process plug-in dialog for the StudioChorus effect.

The upper section of the process plug-in dialog contains
the actual effect parameters of the selected plug-in. For
details on the parameters of the included plug-ins, see the
separate manual “Nuendo Expansion Kit – Cubase Music
Tools for Nuendo 4”.
The lower section of the dialog contains settings for the
actual processing. These are common to all plug-ins.
• If the lower section is hidden, click the “More…” button
to display it.
Clicking the button again (now labeled “Less…”) will hide the lower section.

The following settings and functions are available in the
common, lower section of the dialog:
Wet mix/Dry mix

These settings allow you to gradually mix the effect in or
out. If you activate Pre-CrossFade and specify a value of
e.g. 1000 ms, the effect will be applied gradually from the
start of selection, reaching full effect 1000 ms after the
start. Similarly, if you activate Post-CrossFade, the processing will gradually be removed starting at the specified
interval before the end of the selection.
!

The sum of the Pre- and Post-CrossFade times cannot be larger than the length of the selection.

Preview button
Allows you to listen to the result of the processing with the
current settings. Playback will continue repeatedly until
you click the button again (the button is labeled “Stop”
during Preview playback). You can change the effect settings during Preview playback if needed.
Process button
Applies the effect and closes the dialog.
Cancel button
Closes the dialog without applying the effect.

These two sliders allow you to specify the balance between wet (processed) and dry (original) signal in the resulting clip.
Normally the two sliders are “reverse-ganged”, so that
raising the Wet mix slider lowers the Dry mix slider by the
same amount. However, if you press [Alt]/[Option] and
drag a slider, you can move it independently. This allows
you to set e.g. 80% dry and 80% wet signal. Be careful to
avoid distortion.
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The Offline Process History dialog

• To modify the settings of the selected processing, click
the “Modify” button.

Procedures

This opens the dialog for the processing function or applied effect, allowing you to change the settings. This works just as when you applied the
processing or effect the first time.

If you want to remove some or all processing from a clip,
this can be done in the Offline Process History dialog.
Processing that can be modified in the Offline Process
History dialog includes the functions on the Process
menu, any applied plug-in effects, and Sample Editor operations such as Cut, Paste, Delete and drawing with the
Pencil tool.

• To replace the selected operation with another processing function or effect, select the desired function from
the pop-up menu and click the “Replace By” button.
If the selected function has settings, a dialog will appear as usual. The
original operation will then be removed and the new processing will be
inserted in the Offline Process History.

Ö Due to the clip-file relationship (see “Background” on
page 239), it is even possible to modify or remove some
processing “in the middle” of the Process History, while
keeping later processing! This feature depends on the type
of processing performed (see “Restrictions” on page 251).

• To remove the selected operation, click the “Remove”
button.

Proceed as follows:

The processing is removed from the clip, but the operation remains in the
list. To redo the operation and apply the processing again, click the button, now renamed to “Activate”, again.

1. Select the clip in the Pool or one of its events in the
Project window.
You can see which clips have been processed by checking the Status
column in the Pool – the waveform symbol indicates that processing or
effects have been applied to the clip (see “About the Status column symbols” on page 299).

2. Select “Offline Process History…” from the Audio
menu.
The Offline Process History dialog appears.

The processing is removed from the clip.

• To undo the selected operation and remove the processing from the clip click the “Deactivate” button.

• To save the list of processing operations as a Batch
Process, click the “Save As Batch” button.
See “Batch Processing” on page 252.

4. Click “Close” to close the dialog.

Restrictions
• If there are no settings for the processing function, you
cannot modify it.
• If you have applied processing that changes the length
of the clip (such as Cut, Insert or Time Stretch), you can
only remove this if it is the most recent processing in the
Offline Process History (at the bottom of the list in the dialog). If an operation cannot be removed or modified, this
is indicated by an icon in the “Status” column. Also, the
corresponding buttons will be grayed out.

The left part of the dialog contains a list of all processing
you have added to the clip, with the most recent operations at the bottom of the list. The “Start” and “Length”
columns indicate which section of the clip was affected by
each operation. The “Status” column indicates if the operation can be modified or undone.
3. Locate the operation you want to edit and select it by
clicking on it in the list.

251 — Audio processing and functions

• The list must contain at least two processing operations
in order to be saved as a Batch Process (see “Batch Processing” on page 252.

Batch Processing
Nuendo features a Batch Processing function that lets you
apply a chain of audio processing to one or several events
in one go – in either the Project window or the Pool. Batch
Processing is based on operations in the Offline Process
History dialog, described above. That is, the list of applied
processes in this dialog is what can be made to constitute
a batch process.
Batch Processing is therefore a convenient way to apply
the same effects with the same settings to several audio
events in a project.
It can also be used to “store” effect settings for future use.
You may for example have performed a series of elaborate
audio processing with a good result, and want to retain
the particular combination and settings of effects you applied, so that you may quickly and easily apply them again
to other events in the future.

5. In the Process History Dialog, click “Save As Batch”,
and then type in a name for the batch process in the dialog that appears and click OK.
Regardless of which of the above two methods you use,
the batch process is now saved and available for use:
6. In the Project window, select all the audio events you
want to process.
You can also make a selection range that spans multiple tracks and
batch process the selection for all the audio events.

7. Pull down the Audio menu and open the Batch Processes submenu.
At the top of the menu you can now find the name of the batch process
you created. The menu will list the names of any batch processes you
create, until you delete them (see below).

To set up a batch process, proceed as follows:
1. Apply the desired processing to an audio event or selection range in the project.
Note that you must apply at least two audio processes to be able to set
up a batch process.

From here, there are two ways to go:
2. Pull down the Audio menu, and from the Batch Processes submenu, select “Create from Process History…”.
3. In the dialog that appears, type in a name for the batch
process, and click OK.

8. Select the batch process you want to apply from the
menu.
All the selected events will now be processed accordingly.

Ö Note that even if you clear the Offline Process History
dialog of all the operations that make up a batch process,
this will not affect the saved batch process. It will still contain and perform the operations on which it was based
when created.

or…
4. Pull down the Audio menu and select “Offline Process
History”.
The Offline Process History dialog opens. In this dialog you can modify
settings or remove operations as desired (see “The Offline Process History dialog” on page 251).
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Managing Batch Processes
You can delete and rename created batch processes in
the Manage Batch Processes dialog.

Freeze Edits
The Freeze Edits function on the Audio menu allows you
to make all processing and applied effects permanent for
a clip:
1. Select the clip in the Pool or one of its events in the
Project window.
2. Select “Freeze Edits…” from the Audio menu.
• If there is only one edit version of the clip (no other clips
refer to the same audio file), the following dialog will appear:

• Open the Audio menu and select “Manage…” from the
Batch Processes submenu to open the Manage Batch
Processes dialog.
The created batch processes are listed in the left column, and the operations each batch process contains are listed in the right column.

• To remove a batch process, just select it in the list and
click “Delete”.

If you select “Replace”, all edits will be applied to the original audio file
(the one listed in the clip’s Path column in the Pool). If you select “New
File”, the Freeze Edits operation will create a new file in the Audio folder
within the project folder (leaving the original audio file unaffected).

• If the selected clip (or the clip played by the selected
event) has several edit versions (i.e. there are other clips
referring to the same audio file), the following alert will appear:

• To change the name of a batch process, select it in the
list and click “Rename” and enter the new name.

As you can see, you don’t have the option to Replace the original audio
file in this case. This is because that audio file is used by other clips. Select “New File” to have a new file created in the Audio folder within the
project folder.
!
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After a Freeze Edits, the clip refers to a new, single
audio file. If you open the Offline Process History dialog for the clip, the list will be empty.

Detect Silence

The Detect Silence function on the Advanced submenu of
the Audio menu searches for silent sections in an event
and either splits the event, removing the silent parts from
the project, or creates regions corresponding to the nonsilent sections. Proceed as follows:
1. Select the event in the Project window or the Audio
Part Editor.
You can select several events if you like, in which case you will be allowed to make separate settings for each selected event.

2. Select “Detect Silence” from the Advanced submenu
of the Audio menu.

Setting

Description

min. time
open

Determines the minimum time that the function will remain “open” after the audio level has exceeded the Open
Threshold value.
If the audio contains repeated short sounds, and you find
that this results in too many short “open” sections, try
raising this value.

min. time
closed

Determines the minimum time that the function will remain “closed” after the audio level has dropped below
the Close Threshold value.
Usually you would want to set this to a low value, to avoid
removing sounds.

Pre-Roll

Allows you to have the function “open” slightly before the
audio level exceeds the Open Threshold value. In other
words, the start of each “open” section is moved to the
left according to the time you set here.
This is useful to avoid removing the attack of sounds.

Post-Roll

Allows you to have the function “close” slightly after the
audio level drops below the Close Threshold value.
This is useful to avoid removing the natural decay of
sounds.

The Detect Silence dialog appears.

3. Adjust the settings in the Detection section to the left.
They have the following functionality:
Setting

Description

Open
Threshold

When the audio level exceeds this value, the function will
“open”, i.e. let the sound through.
Set this low enough to open when a sound starts, but
high enough to remove unwanted noise during “silent”
sections.

Close
Threshold

When the audio level drops below this value, the function
will “close”. This value cannot be higher than the Open
Threshold value.
Set this high enough to remove unwanted noise during
“silent” sections.

Linked

If this checkbox is ticked, Open and Close Threshold will
have the same value.

4. Click the “Compute” button.
The audio event is analyzed, and the waveform display is redrawn to indicate which sections will be considered “silent”, according to your settings. Above the Compute Button the number of detected regions is
displayed.

• If you activate the “auto” checkbox next to the Compute
button, the audio event will be analyzed (and the display
will be updated) automatically every time you change the
settings in the Detection section of the dialog.
Please note that you should not activate this option when you are working with very long files, as this process might take some time.
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• You can use the Preview function to listen to the result.
The event is played back repeatedly in its entire length, but with the
“closed” sections silenced.

5. Repeat steps 3 and 4 until you are satisfied with the
result.
6. Select the desired result, by activating either the “Add
as Regions” or the “Strip Silence” checkbox, or both.
“Add as Regions” will create regions according to the non-silent sections. “Strip Silence” will split the event at the start and end of each nonsilent section, and remove the silent sections in between.

The Spectrum Analyzer
This function analyzes the selected audio, computes the
average “spectrum” (level distribution over the frequency
range) and displays this as a two-dimensional graph, with
frequency on the x-axis and level on the y-axis.
1. Make an audio selection (a clip, an event or a range selection).
2. Select “Spectrum Analyzer” from the Audio menu.
A dialog with settings for the analysis appears.

7. If you activate “Add as Regions”, you can specify a
name for the Regions in the Region Name field.
In addition to the name, the regions will be numbered, starting with the
number specified in the Auto Number Start field.

8. Click “Process”.
The event is split and/or regions are added.

The default values give good results in most situations, but
you can adjust the settings if you like:
Setting

The result of the “Strip Silence” option.

• If you selected more than one event in step 1 above, you
can activate the “process all” checkbox to apply the same
settings to all selected events. If you don’t activate this,
the dialog will appear again, allowing you to make separate settings for each event.
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Description

Size in Samples The function divides the audio into “analysis blocks”, the
size of which is set here. The larger this value, the higher
the frequency resolution of the resulting spectrum.
Size of Overlap The overlap between each analysis block.
Window used

Allows you to select which window type should be used
for the FFT (Fast Fourier Transform, the mathematical
method used for computing the spectrum).

Normalized
Values

When this is activated, the resulting level values are
scaled, so that the highest level is displayed as “1”
(0dB).

From Stereo

When analyzing stereo material, there is a pop-up menu
with the following options:
Mono mix – the stereo signal is mixed to mono before analyzing.
Mono left/right – the left or right channel signal is used
for analysis.
Stereo – both channels are analyzed (two separate spectrums will be displayed).

3. Click the “Process” button.
The spectrum is computed and displayed as a graph.

• If you analyze stereo audio and selected the “Stereo” option in the first dialog, the graphs for the left and right channel are superimposed in the display, with the left channel
graph in white and the right channel graph in yellow.
The display in the upper right corner shows the values for the left channel
– to see the right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which channel values are shown.

6. You can leave the window open or close it by clicking
the “Close” button.
If you leave it open and the “Active” checkbox is ticked, the result of the
next Spectrum Analysis will be displayed in the same window.

Statistics

4. You can adjust the display with the settings in the display window:
Setting

Description

dB

When this is activated, the vertical axis shows dB values.
When it is deactivated, values between 0 and 1 are
shown.

Freq. log

When this is activated, frequencies (on the horizontal
axis) are displayed on a logarithmic scale. When it is deactivated, the frequency axis is linear.

Precision

Indicates the frequency resolution of the graph. This
value cannot be changed here, but is governed by the
Size in Samples setting in the previous dialog.

Frequency/
Note

Allows you to select whether you want the frequencies to
be displayed in Hertz or with note names.

Min.

Sets the lowest frequency shown in the graph.

Max.

Sets the highest frequency shown in the graph. By adjusting the Min and Max values, you can take a closer look
at a smaller frequency range.

Active

When this is activated, the next Spectrum Analysis will
appear in the same window. When deactivated, new
Spectrum Analysis results will appear in separate windows.

5. If you move the mouse pointer over the graph, a
crosshair cursor follows the graph curve and the display in
the upper right corner shows the frequency/note and level
at the current position.
To compare the level between two frequencies, move the pointer to one
of the frequencies, right-click once and move the pointer to the second
frequency. The delta value (the difference in level between the current
position and the right-click position) is displayed in the upper right corner
(labeled “D”).

The Statistics function on the Audio menu analyzes the
selected audio (events, clips or range selections) and displays a window with the following information:
Item

Description

Min. Sample
Value

The lowest sample value in the selection, as a value between -1 and 1 and in dB.

Max. Sample
Value

The highest sample value in the selection, as a value between -1 and 1 and in dB.

Peak Amplitude The largest sample value (in absolute numbers) in the selection, in dB.
DC Offset

The amount of DC Offset (see “Remove DC Offset” on
page 247) in the selection, as a percentage and in dB.

Estimated
Resolution

Even though an audio file is in 16 or 24 bits, it may have
been converted from a lower resolution. The Estimated
Resolution value makes an educated guess about the actual audio resolution, by computing the smallest level difference between two samples.
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Item

Description

Estimated Pitch The estimated pitch of the audio selection.
Sample Rate

The sample rate of the audio selection.

Min. RMS
Power

The lowest loudness (RMS) measured in the selection.

Max. RMS
Power

The highest loudness (RMS) measured in the selection.

Average

The average loudness over the whole selection.
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The Sample Editor

Background
The Sample Editor allows you to view and manipulate audio at the audio clip level, by cutting and pasting, removing
or drawing audio data, processing or applying effects (see
“Audio processing and functions” on page 238). This editing can be called “non-destructive”, in the sense that you
can undo changes or revert to the original versions at any
time, using the Offline Process History (see “The Offline
Process History dialog” on page 251), and because the
actual audio file (if created or imported from outside the
project) will remain untouched.
The Sample Editor also contains most of the Audio Warp
related functions, i.e. the realtime time-stretching and
pitch-shifting functions in Nuendo. These are useful to e.g.
tempo-match any audio loop to the project tempo (see
“Audio Warp realtime processing / Tempo matching audio
to the project tempo” on page 272).
Another special feature of the Sample Editor is hitpoint
detection. Hitpoints allow you to create “slices”, that are
useful, if you want to e.g. change the tempo without affecting the pitch (see “Working with hitpoints and slices”
on page 278).

Opening the Sample Editor
You open the Sample Editor by double-clicking an audio
event in the Project window or the Audio Part Editor, or by
double-clicking an audio clip in the Pool. You can have
more than one Sample Editor open at the same time.
• Note that double-clicking an audio part in the Project
window will open the Audio Part Editor, even if the part
only contains a single audio event.
This is described in a separate chapter, see “The Audio Part Editor” on
page 290.
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Window overview

The Elements menu

The toolbar
The toolbar contains the tools…
The Sample Editor tools

Audition, Loop &
Volume controls

Show Inspector

Show Audio event

Autoscroll

Show
Use Snap
regions

… and information about the edited audio clip:
Global Transport status

Audio format and length

If you right-click in the Sample Editor to bring up the
Quick menu, you will find a submenu called “Elements”.
By activating or deactivating options on this submenu, you
specify what is shown in the editor window. Some of
these options are also available as icons on the toolbar.

Realtime status
Selected display format
(for info line and ruler)

Current selection range
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Number of edits
made to the clip

Zoom factor

Ö You can show/hide Inspector sections by right-clicking on an Inspector tab and activating/deactivating the desired option(s).

Initially, length and position values are displayed in the format specified in the Project Setup dialog. If you click in the
middle field, a pop-up menu opens, where you can select
another display format. This selection affects the Sample
Editor ruler as well.

Make sure you right-click on an inspector tab and not on the empty area
below the Inspector, as this will open the Quick context menu instead.

• You can customize the toolbar by right-clicking it and
using the pop-up menu to hide or show items.
• Selecting Setup from the pop-up menu allows you to
reorder sections on the toolbar, store presets, etc. See
“The Setup dialogs” on page 506.

The Sample Editor Inspector
To the left of the Sample Editor, you will find the Sample
Editor Inspector. It contains all the tools and functions for
working in the Sample Editor.
You open a tab by clicking on it. If you want to open another tab without closing the first, [Ctrl]/[Command]-click
on it. To open all tabs in the Inspector [Alt]/[Option]-click
on any tab.
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The Definition tab

The Playback tab

The topmost tab of the Sample Editor Inspector is used to
define the musical context of your audio. Here, you can define the grid, i.e. measure the audio tempo and the groove.
Open this tab, if you want to use your audio in a musical
context, so that you can later activate the Straighten Up
mode, create a groove quantize map or slices.

In this tab, the audio grid and the tempo of the audio can
be adjusted to the project grid by activating the Straighten
Up mode.
From the algorithm pop-up, you can select an algorithm
for the realtime time-stretching.

The upper section of the Definition tab will help you to adjust the audio grid. You can select a grid resolution from
the pop-up menu and adjust the grid manually by activating the Manual Adjust tool, or automatically by clicking the
Auto Adjust button. When you click on the Auto Adjust
button, the Manual Adjust tool will be activated, so that
you can afterwards verify and change the grid manually, if
necessary. The Preview mode should be activated (default
setting) to use the grid for playback. Preview is linked to
the Straighten Up mode and Quantize menu on the Playback tab. If you only want to create slices or quantize
grooves, you can deactivate the Preview mode.

If you activate Straighten Up mode, the audio file will snap
to the project grid. The Quantize pop-up lets you select a
resolution for the audio, allowing you to specify how exact
the quantization will be. When you select the “Bars” option,
the audio will be synced to tempo without quantizing. The
Swing fader lets you offset every second position in the grid
creating a swing or shuffle feel.
In Free Warp mode you can manually change the rhythm
of the audio. When this button is activated, you can drag
beats to time positions in the grid. This is described in the
section “Free Warp” on page 285.

The lower section displays the length of your audio file in
bars and beats (PPQ) together with the estimated tempo
and the time signature. You should always verify if the
length in bars corresponds to the audio file you imported.
If necessary, listen to your audio and enter the correct bar
length.
!

When the Transpose track has been added to the project,
or when the event root key is defined and the project root
key is set, you can follow global transpose by activating the
Follow Global mode (see “Realtime pitch-shifting of audio
events” on page 288). Note that the Transpose function on
the Playback tab is not available if you opened the Sample
Editor by double-clicking on an event in the Pool.

If you work with audio with triplet feeling, set the basic grid resolution to 1/8 or 1/16 and the signature
to 12/8. Note that you should afterwards also set the
time signature for the project to 12/8 (in the Transport panel).

If you click the Flatten button, the realtime warp processing
will be applied to the clip, making the settings permanent
(see “Flattening the realtime processing” on page 288).
!

Warp tabs will only be displayed in the waveform, if
this tab is open.
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The Hitpoints tab

The Range tab

In this tab you will find some utility functions for working
with ranges and selections (see “Making selections” on
page 267).
The Process tab
In this tab, the transients, i.e. hitpoints of the audio can be
marked.
Adjust the sensitivity slider to determine how many hitpoints should be shown, and edit them with the Edit Hitpoints tool, if necessary. If you want to clear all hitpoints,
e.g. to re-detect hitpoints, click the Remove All button.
This tab regroups the most important audio editing commands from the Audio and the Edit menus. For further information on the Select Process and Select Plug-in popup menus, see the chapter “Audio processing and functions” on page 238.

Click the Slice & Close button, if you want to slice your
audio to quantize the rhythm of the different slices separately (see “Creating slices” on page 283).
Click the Make Groove button, if you want to create an audio groove for quantizing other material to the groove of
your audio (see “Creating groove quantize maps” on page
283).

The thumbnail display

Click the Create Markers button, if you want to create markers for the hitpoints (see “Create Markers” on page 284).
Use the Create Regions button, if you want to create regions, e.g. for further use in a sampler (see “Create Regions” on page 284).

The thumbnail display provides an overview of the whole
clip. The section currently shown in the main waveform
display of the Sample Editor is indicated by a blue rectangle in the thumbnail, while the current selection range is
shown in blue.

Use the Create Events button, if you wish to create separate events according to the hitpoints for a file (see “Create
Events” on page 284).

• You can move the blue rectangle in the thumbnail to
view other sections of the clip.

Before you can use the Make Groove and the Slice & Close
buttons, the tempo and the time signature of the audio must
be defined (the Definition tab will light up in blue to indicate
this).
!

Click in the lower half of the rectangle and drag to the left or right to
move it.

• You can resize the blue rectangle (by dragging its left or
right edge) to zoom in or out, horizontally.

Hitpoints will only be displayed in the waveform, if
this tab is open.

• You can define a new viewing area by clicking in the upper half of the overview and dragging a rectangle with the
mouse.
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The ruler

• To display the level scale after hiding it, right-click to
bring up the Quick menu and activate “Level Scale” on the
Elements submenu.

The Sample Editor ruler is located between the thumbnail
and the waveform display. It shows the timeline in the display format specified in the Project Setup dialog (see “The
Project Setup dialog” on page 33). If you like, you can select an independent display format for the ruler by clicking
on the arrow button to the right of it and selecting an option from the pop-up menu that appears (this affects the
values in the info line too). For a list of the display format
options, see “The ruler” on page 31.

• This submenu also allows you to select whether you
want the zero axis and/or the half level axis indicated in the
waveform display.

The waveform display and the level scale
Zero axis

The waveform display shows the waveform image of the
edited audio clip – in the style selected in the Preferences
(Event Display–Audio page), see “Adjusting how parts
and events are shown” on page 37. To the left of the
waveform display, a level scale can be shown, indicating
the amplitude of the audio.
• When the level scale is shown, you can select whether
the level should be shown as a percentage or in dB.
This is done by right-clicking the level scale and selecting an option from
the pop-up menu that appears. This also allows you to hide the level scale.
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Half
level
axis

General Operations

• If you have zoomed in to one sample per pixel or less,
the appearance of the samples depend on the option
“Interpolate Audio Images” in the Preferences (Event Display–Audio page).

Zooming
Zooming in the Sample Editor is done according to the
standard zoom procedures, with the following special
notes:

If the option is deactivated, single sample values are drawn as “steps”. If
the option is activated, they are interpolated to “curves” form.

Auditioning

• The vertical zoom slider changes the vertical scale relative to the height of the editor window, in a way similar to
the waveform zooming in the Project window (see “Zoom
and view options” on page 34).

While you can use the regular play commands to play
back audio when the Sample Editor is open, it is often
useful to listen to the edited material only.

The vertical zoom will also be affected if the option “Zoom Tool Standard
Mode” (Preferences on the Editing–Tools page) is deactivated and you
drag a rectangle with the Zoom tool.

Ö When auditioning, audio will be routed to the Control
Room (if the Control Room is activated) or to the Main Mix
(the default output bus). For information about routing, see
the chapter “VST Connections: Setting up input and output busses” on page 10.

• The following options relevant to the Sample Editor are
available on the Zoom submenu (on the Edit menu and the
Quick context menu):
Option

Description

Zoom In

Zooms in one step, centering on the position cursor.

Ö You can adjust the auditioning level with the miniature
level fader on the toolbar.

Zoom Out

Zooms out one step, centering on the position cursor.

By using key commands

Zoom Full

Zooms out so that the whole clip is visible in the editor.

Zoom to
Selection

Zooms in so that the current selection fills the screen.

If you activate the “Playback Toggle triggers Local Preview” option in the Preferences (Transport page), you can
use the [Space] bar to audition. This is the same as clicking the Audition icon on the toolbar.

Zoom to
Zooms in horizontally so that the current selection fills
Selection (Horiz.) the screen.
(Edit menu only)

By using the Audition icon

Zoom to Event
Zooms in so that the editor shows the section of the clip
(Edit menu only) corresponding to the edited audio event. This is not
available if you opened the Sample Editor from the Pool
(in which case the whole clip is opened for editing, not
an event).
Zoom In/Out
Vertical (Edit
menu only)

This is the same as using the vertical zoom slider (see
above).

Clicking the Audition icon on the toolbar plays back the
edited audio, according to the following rules:
• If you have made a selection, this selection will be played
back.
• If there is no selection, but the option “Show Event” is activated (see “Show audio event” on page 271), the section of
the clip corresponding to the event will be played back.
• If there is no selection, and “Show Event” is deactivated, playback will start at the cursor position (if the cursor is outside
the display, the whole clip will be played back).
• If the Loop icon is activated, playback will continue repeatedly
until you deactivate the Audition icon. Otherwise, the section
will be played back once.

• You can also zoom by resizing the rectangle in the
thumbnail display.
See “The thumbnail display” on page 263.

• The current zoom setting is shown in the info line, as a
“samples per screen pixel” value.
• Note that you can zoom in horizontally to a scale with
less than one sample per pixel!
This is required for drawing with the Pencil tool (see “Drawing in the
Sample Editor” on page 271).

Ö Note that there is a separate Play button for auditioning regions. See “Auditioning regions” on page 270.
265
The Sample Editor

By using the Speaker tool

Adjusting the snap point

If you click somewhere in the waveform display with the
Speaker (“Play”) tool and keep the mouse button pressed,
the clip will be played back from the position at which you
clicked. Playback will continue until you release the mouse
button.

The snap point is a marker within an audio event (or clip,
see below). This is used as a reference position when you
are moving events with snap activated, so that the snap
point is “magnetic” to whatever snap positions you have
selected.

Scrubbing

By default, the snap point is set at the beginning of the audio event, but often it is useful to move the snap point to a
“relevant” position in the event, such as a downbeat, etc.
1. Activate the “Audio Event” option so that the event is
displayed in the editor.
2. Scroll so that the event is visible, and locate the “S”
flag in the event.

The Scrub tool allows you to locate positions in the audio
by playing back, forwards or backwards, at any speed:

If you haven’t adjusted this previously, it will be located at the beginning
of the event.

1. Select the Scrub tool.
2. Click in the waveform display and keep the mouse
button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played
back. The speed and pitch of the playback depends on how fast you
move the pointer.

• You can adjust the response of the Scrub tool with the
Scrub Response (Speed) setting in the Preferences
(Transport–Scrub page).
There you will also find a separate Scrub Volume setting.

3. Click on the “S” flag and drag it to the desired position.
When you drag the snap point, a tool tip shows its current position (in
the format selected on the Sample Editor ruler).

• If the Scrub tool is selected when you move the snap
point, you will hear the audio while dragging (just like
when scrubbing).
This makes it easier to find the correct position.
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You can also adjust the snap point by setting the project
cursor:

• You can resize the selection by dragging its left and
right edge or by [Shift]-clicking.

1. Place the cursor at the desired position (intersecting
the event).

• The current selection is indicated in the corresponding
fields in the Range tab of the Sample Editor Inspector.

You may want to do this by scrubbing, to spot the right position exactly.

You can fine-tune the selection by changing these values numerically.
Note that the values are relative to the start of the clip, rather than to the
project timeline.

2. Right-click to open the Quick menu and select “Snap
Point To Cursor” from the Audio submenu.
The snap point will be set to the position of the cursor. This method can
also be used in the Project window and the Audio Part Editor.
!

Using the Select menu
In the Select menu in the Range tab and in the Select submenu of the Edit menu you can find the following options:

When you set the Grid Start in the Definition tab, the
snap point will be moved to the Grid Start (see “Manually adjusting grid and tempo of your audio” on
page 275).

Function

• It is also possible to define a snap point for a clip (for
which there is no event yet).

Description

Select All

Selects the whole clip.

Select None

Selects no audio (the selection length is set to “0”).

Select in Loop

Selects all audio between the left and right locator.

To open a clip in the Sample Editor, double-click it in the Pool (or drag it
from the Pool to the Sample Editor). After having set the snap point using
the procedure described above, you can insert the clip into the project
from the Pool or the Sample Editor, taking the snap point position into
account.

Select Event

Selects the audio that is included in the edited event only.
This is not available if you opened the Sample Editor from
the Pool (in which case the whole clip is opened for editing, not an event).

Making selections

Locate Selec- Moves the project cursor to the beginning or end of the
tion (Range tab current selection. For this to be available, you must have
only)
selected one or more events or parts, or made a selection
range.

Locators to Se- Sets the locators to encompass the current selection.
lection (Range This is available if you have selected one or several
tab only)
events or made a selection range.

To select an audio section in the Sample Editor, you click
and drag with the Range Selection tool.

Loop Selection This activates playback from the start of the current se(Range tab only) lection and keeps starting over again when reaching the
selection end.

A selected range

From Start to
Cursor (Edit
menu only)

Selects all audio between the clip start and the project
cursor.

From Cursor to Selects all audio between the project cursor and the end
End (Edit menu of the clip. For this to work, the project cursor must be
only)
within the clip boundaries.
Left Selection Moves the left side of the current selection range to the
Side to Cursor project cursor position. For this to work, the cursor must
(Edit menu only) be within the clip boundaries.
Right Selection Moves the right side of the current selection range to the
Side to Cursor project cursor position (or the end of the clip, if the cursor
(Edit menu only) is to the right of the clip).

• If Snap to Zero Crossing is activated on the toolbar, the
start and end of the selection will always be at zero crossings (see “Snap to Zero Crossing” on page 271).
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Editing selection ranges

• Selecting Paste copies the data on the clipboard into
the clip.

Selections in the Sample Editor can be processed in several ways. Please note:

If there is a selection in the editor, this will be replaced by the pasted
data. If there is no selection, the pasted data will be inserted starting at
the selection line. The section to the right of the line will be moved to
make room for the pasted material.

• If you attempt to edit an event that is a shared copy (i.e.
the event refers to a clip that is used by other events in the
project), you are asked whether you want to create a new
version of the clip or not (if you haven’t made a “permanent” choice already – see below).
Select “New Version” if you want the editing to affect the selected event
only. Select “Continue” if you want the editing to affect all shared copies.
Note: If you activate the option “Do not show this message again” in the
dialog, any further editing you do will conform to the selected method
(“Continue” or “New Version”). You can change this setting at any time
with the “On Processing Shared Clips” pop-up menu in the Preferences
(Editing–Audio page).

• Any changes to the clip will appear in the Offline Process
History, making it possible to undo them at a later point (see
“The Offline Process History dialog” on page 251).
Cut, Copy and Paste
The Cut, Copy and Paste commands (on the Edit menu in
the Process tab of the Sample Editor Inspector or in the
main Edit menu) work according to the following rules:
The pasted data will be inserted at the selection line.

• Selecting Copy copies the selection to the clipboard.

Delete

• Selecting Cut removes the selection from the clip and
moves it to the clipboard.

Selecting Delete (on the Edit menu in the Process tab of
the Sample Editor Inspector or in the main Edit menu or
pressing [Backspace]) removes the selection from the
clip. The section to the right of the selection is moved to
the left to fill out the gap.

The section to the right of the selection is moved to the left to fill out the
gap.

Insert Silence
Selecting “Insert Silence” (on the Edit menu in the Process tab of the Sample Editor Inspector or in the Range
submenu of the main Edit menu) will insert a silent section
with the same length as the current selection, at the selection start.
• The selection will not be replaced, but moved to the
right to make room.
If you want to replace the selection, use the “Silence” function instead
(see “Silence” on page 247).
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Processing

Creating a region

Processing (on the Select Process menu in the Process
tab of the Sample Editor Inspector or in the Process submenu on the Audio menu) can be applied to selections in
the Sample Editor, as can the effects (on the Select Plugin menu in the Process tab of the Sample Editor Inspector
or in the Plug-ins submenu on the Audio menu). See the
chapter “Audio processing and functions” on page 238.

1. Select the range you want to convert into a region.
2. Click the “Show Regions” button on the toolbar, or activate the “Regions” option on the Elements submenu on
the Quick menu.
The regions list is displayed to the right in the Sample Editor window.

Creating a new event from the selection
You can create a new event that plays only the selected
range, using the following method:
1. Make a selection range.

3. Click the Add region button above the Regions list (or
select “Event or Range as Region” from the Advanced
submenu of the Audio menu).

2. Press [Ctrl]/[Command] and drag the selection range
to the desired audio track in the Project window.

A region is created, corresponding to the selected range.

Creating a new clip or audio file from the selection

4. To name the region, click on it in the list and enter a
new name.

You can extract a selection from an event and either create a new clip or a new audio file, in the following way:

Regions can be renamed at any time, using this procedure.

1. Make a selection range.

• When a region is selected in the Regions list, it is instantly displayed and selected in the Sample Editor.

2. Right-click to open the Quick menu and select
“Bounce Selection” from the Audio submenu.

Creating regions from Hitpoints

A new clip is created and added to the Pool, and another
Sample Editor window will open with the new clip. The
new clip will refer to the same audio file as the original clip,
but will only contain the audio corresponding to the selection range.

If your audio event contains calculated hitpoints, you can
choose to automatically create regions from hitpoints. This
can be useful to isolate recorded sounds. For further information on hitpoints, see “Working with hitpoints and slices” on page 278.

Working with regions
Regions are sections within a clip. One of the main uses for
regions is Cycle recording, in which the different “takes”
are stored as regions (see “Recording audio in cycle mode”
on page 73). You can also use this feature for marking important sections in the audio clip. Regions can be dragged
into the Project window from the Editor or the Pool to create new audio events. You can also export a region to disk
as a new audio file, from the Pool.
Regions are best created, edited and managed in the
Sample Editor.
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Editing regions

Making selections from regions

The region selected in the list is displayed in gray in the
waveform display and thumbnail.

If you select a region in the list and click the Select Region
button above, the corresponding section of the audio clip
is selected (as if you had selected it with the Range Selection tool). This is useful if you want to apply processing
to the region only.
• Note that you can also double-click a region in the Pool
to have its audio clip open in the Sample Editor with the
area of the region automatically selected.
Creating new events from regions
You can create new audio events from regions, using the
following method:
1. Click in the Region’s leftmost column in the list and
keep the mouse button pressed.
2. Move the pointer to the desired audio track and position in the Project window.
3. Release the mouse button.
A new event is created.

There are two ways to edit the start and end position of a
region:

• You can also use the function “Events from Regions”
from the Advanced submenu of the Audio menu for this
(see “Region operations” on page 55).

• Click and drag its start and end handles in the waveform
display (with any tool).

Removing regions

When you move the pointer over the handles, it will automatically change
to an arrow pointer to indicate that you can drag the handles.

To remove a region from a clip, select it in the list and click
the Remove Region button above the list.

• Edit the Start and End positions numerically in the Regions list.

Exporting regions as audio files
If you create a region in the Sample Editor, the region can
be exported to disk as a new audio file. This is done from
the Pool, see “Exporting regions as audio files” on page
308.

The positions are shown in the display format selected for the ruler and
info line, but are relative to the start of the audio clip, rather than the
project timeline.

Auditioning regions
You can listen to a region by selecting it in the list and
clicking the Play Region button (above the list). The region
will play back once or repeatedly, depending on whether
the Loop icon on the toolbar is activated or not.
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Drawing in the Sample Editor

• In this mode, you can adjust the start and end of the
event in the clip by dragging the event handles in the
waveform display.

It is possible to edit the audio clip at sample level by drawing with the Pencil tool. This can be useful if you need to
manually edit out a spike or click, etc.

When you move the pointer over the event handles (no matter what tool
may be selected), it takes on the shape of an arrow, to indicate that you
can click and drag.

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

Snap to Zero Crossing

2. Select the Pencil tool.
3. Click and draw at the desired position in the waveform
display.
When you release the mouse button, the edited section is automatically
selected.
!

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at
zero crossings (positions in the audio where the amplitude
is zero). This helps you avoid pops and clicks which might
otherwise be caused by sudden amplitude changes.

Any changes created by drawing will appear in the
Offline Process History, making it possible to undo
them at a later stage (see “The Offline Process History dialog” on page 251).

• This setting affects the Sample Editor only. In the
Project window and other editors, the Snap to Zero
Crossing setting on the Project menu toolbar or in the
Preferences (Editing–Audio page) is used.

Options and settings
Show audio event
!

Ö If hitpoints have been calculated, these will also be
taken into account when snapping to zero crossings.

This is only available if you opened the Sample Editor
by double-clicking an audio event in the Project window or the Audio Part Editor and not, if you opened
the audio event from within the Pool.

Autoscroll

When the Show Audio Event button is activated on the
toolbar (or the option “Audio Event” is activated on the Elements submenu on the Quick menu), the section corresponding to the edited event is highlighted in the waveform
display and Thumbnail. The sections of the audio clip not
belonging to the event are shown with a dark gray background.

Autoscroll activated.

When this option is activated, the waveform display will
scroll during playback, keeping the project cursor visible
in the editor.
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Audio Warp realtime processing /
Tempo matching audio to the
project tempo

Determining the audio tempo automatically
and time-stretching your audio
If you want to use an audio file with an unknown tempo in
your project context, the easiest way to determine the
tempo is to define a loop. You can then determine the
tempo of the loop automatically (or manually) and finally
match the tempo of this loop to the project tempo in Nuendo.

Audio warp is the generic name for the realtime timestretching and pitch-shifting functions in Nuendo. The main
audio warp features are tempo-matching any audio loop to
the project tempo (see “Determining the tempo of an audio
loop and slicing your audio” on page 277) and matching up
an audio clip with fluctuating tempo to a fixed tempo.

1. Import a suitable audio file, for example a drum loop
and double-click on it to open it in the Sample Editor.

If you want to tempo match an audio loop to the project
tempo, you will normally work with loops with straight
beats. In this case you will only need to activate the
Straighten Up mode.

2. Make sure that the first downbeat of the audio clip is
aligned with the first beat of the first bar in the Sample Editor.
If your audio file is a two or four bar loop, you can import it
into your project and proceed with step three, if you have
a longer audio file, possibly with an upbeat, you have the
following possibilities to define a loop:

Proceed as follows:
1. Import your loop into the project and double-click it to
open it in the Sample Editor.

• Resize your event by adjusting the Event Start and the
Event End and make sure that the Preview mode is activated.

2. Open the Playback tab in the Sample Editor Inspector
and activate the Straighten Up mode.
Or

Your loop will automatically adapt to the project tempo.

If you want to use an audio file instead, or if the beat of
your loop is not straight, further adjustments could be
necessary. These are described in the following sections.
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• Make a selection range in a longer clip and click the Audition Loop button.

When you click Auto Adjust, the following happens:
• If you created a loop by defining a selection range in a longer
audio file, the snap point (S symbol) will be moved to the loop
start.
• In the waveform, vertical lines will be displayed. The thick lines
should match the bar positions and the thin lines the beat positions. You can adjust these lines by means of the Manual
Adjust tool, see below.
• In the Definition tab the Manual Adjust tool will be activated
(see “Manually adjusting grid and tempo of your audio” on
page 275).

Adjust the selection range until the loop is smooth.

A 4 bar loop has been selected.

3. Open the Definition tab and make sure the Bars value
corresponds to the length of the audio file, or the selection
range, respectively.
If necessary, listen to your audio to determine the correct bar length.

• In the Playback tab the Straighten Up button will be switched
on (see “About the Straighten Up mode” on page 275).
5. Open the Playback tab to select an algorithm that
should be applied on realtime playback.

4. Cick the Auto Adjust button to automatically adjust the
grid to the audio file.

273
The Sample Editor

In this pop-up you can find various options that govern the
audio quality of the realtime time-stretching. There are presets for common types of audio material and an Advanced
option where you can manually set warp parameters:

If you select the Advanced menu item, a dialog opens
where you can manually adjust the three parameters that
govern the sound quality of the time-stretching:
Parameter

Description

Option

Description

Grainsize

Drums

This mode is best for percussive sounds, because it will not
change the timing of your audio. Using this option for pitched
audio will lead to noticeable artefacts. In this case, you can try
the Mix mode.

The realtime time-stretching algorithm splits the audio into
small pieces called “grains”. This parameter determines the
size of the grains. For material with many transients you
should use low Grainsize values for best results.

Overlap

Plucked

This should be used for audio with transients and a relatively stable spectral sound character (e.g. plucked instruments).

Overlap is the percentage of the whole grain that will overlap with other grains. Use higher values for material with a
stable sound character.

Pads

Use this mode for pitched audio with slower rhythmics and a
stable spectral sound character. This will minimize sound artefacts, but the rhythmic accuracy will not be preserved.

Variance

Vocals

This mode was optimized for slower signals with transients and
a prominent tonal character (e.g. vocals).

Variance is also a percentage of the whole length of the
grains and sets a variation in positioning so that the overlapping area will sound smooth. A Variance setting of 0 will
produce a sound akin to time-stretching used in early samplers, whereas higher settings will produce more (rhythmic)
“smearing” effects but less audio artefacts.

Mix

This mode will preserve the rhythm and minimize the artefacts
for pitched material which does not meet the above criteria (i.e.
with a less homogenous sound character).
This will be selected by default for audio that is not categorized.

6. If you are satisfied with the result, i.e. the vertical lines
match bars and beats positions, close the Sample Editor
and activate playback.

Advanced This allows for a manual tweaking of the time-stretching parameters. By default, the settings that are shown when you open the
dialog are those of the last used preset (except if the Solo mode
was selected, see below). The Advanced settings are described
in more detail below this table.
Solo

If your audio file contained an upbeat and you resized the audio event to
a smooth loop with the event handles, you might want to move the audio
event to the beginning of the project:

This mode will preserve the formants of the audio. It should only
be used for monophonic material (solo woodwind/brass instruments or solo vocals, monophonic synths or string instruments
that do not play harmonies).

The loop will now automatically adjust to the project
tempo, and follow any further tempo changes you make! In
the Project window, the audio event will have a note symbol and two arrows in the upper right corner. The note
symbol indicates Straighten Up mode and the arrow indicates that the file is stretched.
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About the Straighten Up mode

When you have correctly set a tempo or length for an audio clip, this information is saved with the project. This allows you to import files into the project with Straighten Up
mode already activated. The tempo (if set) is also saved
when exporting files.

The Straighten Up mode is one of the key audio warp features. It allows you to lock audio clips to the project tempo
by using realtime time-stretching. This is very useful if you
want to use loops in your project and do not want to worry
too much about timing.

!

Straighten Up mode is automatically activated if the Preview button on the Definition tab is activated and the
tempo of the audio file or loop has been specified either
automatically by clicking the Auto Adjust button or manually by using the Manual Adjust tool.
When this mode is activated, audio events will adapt to
any tempo changes in Nuendo, just like MIDI events. However, using Straigthen Up function should not be confused
with quantizing: the timing, i.e. the rythmic feeling will be
maintained.

Nuendo supports ACID® loops. These loops are
standard audio files but with embedded tempo/
length information. When ACID® files are imported
into Nuendo, Straighten Up mode is automatically
activated and the loops will adapt to the tempo set in
the project.

Manually adjusting grid and tempo of your
audio
If you want to manually adjust the grid and the tempo of
your audio file, because you have a very special loop and
the automatic functions did not lead to satisfying results,
proceed as follows:
1. Open the Definition tab in the Sample Editor Inspector
and activate the Manual Adjust tool.
The Sample Editor ruler does not reflect the audio event
position in the Project window, but the length of the audio
file in bars and beats. With the Manual Adjust tool you can
manipulate this time grid for the audio file. If you select the
Manual Adjust tool and move the mouse in the Sample
Editor the pointer turns to a flag. Depending on the position, the tool can have the following functions:
Function

Description

The Straighten Up mode in the Playback tab is automatically activated,
when the audio tempo (time positions) is specified and the internal audio quantization (musical positions) has been defined.

Set Grid Start
(green)

This tool is shown at the clip start. When it is displayed,
you can drag it with the mouse to the first downbeat in order to set the grid start at this position.

It is also possible to activate/deactivate Straighten Up
mode from within the Pool by clicking the respective
checkbox in the Straighten Up column.

Stretch Bars
(red)

This tool is shown at beat positions. When it is displayed,
you can drag it with the mouse to beat positions in order
to set the start of the next bar. All grid positions will be
stretched.

Stretch
This tool is shown at bar positions when you hold down
Previous - Move [Alt]/[Option]. When it is displayed, you can drag it with
Next (pink)
the mouse to bar positions in order to set the start of the
next bar. The tempo of the last bar will be changed, i.e. the
beat/grid positions of the last bar will be stretched, while
all following grid positions will be moved.
Adjust Beat
This tool is shown at beat positions when you hold down
Position - Single [Ctrl]/[Command]. When it is displayed, you can drag it
(blue)
with the mouse to adjust single beat positions, the previous and next beat will be locked. Edited or locked beats
will be displayed in red.
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!

7. Place the mouse pointer at the start of the second bar
in the waveform display.

You can change the modifiers for this in the “Define
Auto Grid” category in the Preferences dialog (Editing-Tool Modifier page).

8. Click and drag the red flag (Stretch Bars) to the left or
right until the second bar in the ruler is aligned with the
position of the second downbeat of the sample, and release the mouse button.

2. Audition the file to determine where the first downbeat
occurs.
3. Move the mouse pointer to the beginning of the audio
file until the pointer changes to a green flag (Set Grid
Start).

The start of the next bar is set, and all grid positions will be stretched.

9. Check the other beats and hold down [Alt]/[Option] to
use the pink flag (Stretch Previous - Move Next) if necessary.

4. Click and drag the green flag to the right until it
matches the first downbeat in the sample and release the
mouse button.

This flag is shown at bar positions. When you drag it with the mouse, the
start of the next bar is set, and the tempo of the last bar will be changed.

Now the ruler grid is offset so that it starts on the first downbeat in the
sample.

5. Make sure that the length in bars shown in the lower
section of the Definition tab corresponds to your settings.
6. Audition the file to determine where the next downbeat
occurs, i.e. the first beat of the second bar in the sample.
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Determining the tempo of an audio loop and
slicing your audio

10. Now have a look at the single beats in between the
bars, and, if necessary, hold down [Ctrl]/[Command] to use
the blue flag (Adjust Beat Position - Single) to adjust them.

1. Import a suitable audio file, for example a drum loop.

Drag the flag until the single beat position is aligned with the waveform,
and release the mouse button.

2. Double-click the loop to open it in the Sample Editor.
If your want to work with longer audio file, possibly with an upbeat, define
a loop or resize the event as described in the section “Determining the
audio tempo automatically and time-stretching your audio” on page 272.

3. Open the Definition tab and make sure the length in
bars corresponds to the actual audio file.
If necessary, listen to your audio and enter the correct bar length.

4. On the Hitpoints tab, open the “Use” pop-up and select the desired option.
This affects which hitpoints should be shown when moving the Sensitivity slider (see “Setting the sensitivity” on page 280).

5. Adjust the Sensitivity slider.
The hitpoints are shown.

6. If necessary, select the Edit Hitpoints tool to edit hitpoints manually.

11. Activate playback.
If you find that the beat sounds too straight, you can either adjust the
Quantize value on the Playback tab or move the Swing slider to add
swing.

You can add, delete and listen to hitpoints by pressing [Alt]/[Option] and
clicking in the waveform. For detailed informations about hitpoints and
their editing, see below.

The loop will automatically adjust to the project tempo,
and follow any further tempo changes you make! In the
Project window, the audio event will have a note symbol
and two arrows in the upper right corner. The note symbol
indicates Straighten Up mode and the arrow indicates that
the file is stretched.

7. Now, click the Slice & Close button in the Hitpoints
tab to create audio slices from your hitpoints.
The loop will be sliced and adjusted to the project tempo. The Sample
Editor will be closed.

In the following sections you will find more detailed information on editing and using hitpoints.
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Working with hitpoints and slices

Calculating hitpoints and slicing a loop
Before proceeding, find a suitable loop using the criteria
above. Proceed as follows:

Hitpoint detection is a special feature of the Sample Editor. It detects attack transients in an audio file and then
adds a type of marker, a “hitpoint”, at each transient.
These hitpoints allow you to create “slices”, where each
slice ideally represents each individual sound or “beat” in
a loop (drum or other rhythmic loops work best with this
feature). When you have successfully sliced the audio file,
you can do a number of useful things with it:

1. Open the event or clip for editing in the Sample Editor.
You can do this by double-clicking an event on an audio track in the
Project window or a clip in the Pool. In this example, we assume you
work with an event on a track.

2. Open the Hitpoints tab in the Sample Editor Inspector
and select an option from the Use pop-up.
These settings don’t affect the actual detection but rather which hitpoints will be shown afterwards. If you e.g. know that your loop is based
on 1/16th notes, select “1/16”. If you’re uncertain, set this to “All” – you
can change this setting afterwards if needed (see “Setting the sensitivity” on page 280).

• Change the tempo without affecting the pitch.
• Extract the timing (a groove map) from a drum loop. This can
then be applied to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the
basic feel.
• Extract sounds from loops.
Ö The term “loop” is used throughout this chapter. Loop
in this context usually means an audio file with a musical
time base, i.e. the length of the loop represents a certain
number of bars and/or beats at a certain tempo. Playing
the loop back at the right tempo in a cycle set to the correct length will produce a continuous loop without gaps.
!

When a selection range is defined, hitpoints will only
be detected within this range.
The Use pop-up menu

Using hitpoints

3. Adjust the sensitivity slider.

The basic functionality of using hitpoints to slice up a loop
is to make a loop fit the tempo of a song, or alternatively to
create a situation that allows the song tempo to be
changed while retaining the timing of a rhythmic audio
loop, just like when using MIDI files.

Now, as you can see, hitpoints have been set at the beginning of each
sound in the loop.

Which audio files can be used?
Here are some guidelines as to what type of audio files are
suited for slicing using hitpoints:
• Each individual sound in the loop should have some noticeable attack.
Slow attacks, legato playing etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice correctly.
In these cases, try to normalize the files or to remove DC Offset.

• There may be problems with sounds drowned in smearing effects, like short delays.
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4. If you now move the hitpoint sensitivity slider to the
left, this gradually hides the hitpoints. Moving the slider to
the right increases the sensitivity to reveal additional hitpoints detected during the calculate process.

7. If you activate cycle playback on the Transport panel,
the loop should now play back seamlessly at the tempo
set in the program!
8. To make the loop follow any further tempo changes,
make sure the track is set to “Musical time base” by using
the respective button in the Track list or Inspector (the
button should show a note symbol – see “Switching between musical and linear time base” on page 40).

The basic aim is to add, remove or edit the hitpoints in various other ways
so that one individual sound is played between each hitpoint. For details,
see “Editing hitpoints” on page 279.

5. Verify the tempo and bars in the Definition tab.
In the next step, the loop will adapt to the project tempo
set in Nuendo.

• Note that if the project tempo is lower than the original
tempo of the loop, there may be audible gaps between
each slice event in the part.

6. In the Hitpoints tab, click on the Slice & Close button
to create audio slices from hitpoints. (You can also use the
option “Create Audio Slices from Hitpoints” from the Audio menu.)

This can be remedied by using the Close Gaps function on the Advanced submenu of the Audio menu, see “Close Gaps” on page 284.
You should also consider activating auto fades for the respective audio
track – fade-outs set to about 10 ms will help eliminate any clicks between the slices when you play back the part. See “Auto Fades and
Crossfades” on page 96.

The following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for
each hitpoint.
• The audio event is replaced by an audio part, containing the
slices (double-click the part to view the slices in the Audio
Part Editor).
• The loop is automatically adapted to the project tempo.

• If the project tempo is higher than the loop’s original
tempo, you may want to activate auto crossfades for the
track.
You can use the Close Gaps functions in this case as well, see “Close
Gaps” on page 284.

Editing hitpoints
In this section, we go back a bit and look at what can be
done with hitpoints in the Sample Editor. There are two
ways to invoke the hitpoint calculation:
• Use the sensitivity slider on the Hitpoints tab of the
Sample Editor Inspector.
• Select Calculate Hitpoints from the Hitpoints submenu
on the Audio menu.
For some loops, this may be all that is needed to set the
hitpoints so that each slice to be created will contain a
single “hit” or sound. However, there will almost certainly
be cases when the automatic calculation may add a hitpoint where there shouldn’t be one, and fail to add a hitpoint where one is needed, even if the sensitivity slider is
set to maximum. If there are too many or too few hitpoints
in a loop, it will most probably not play back properly.

The slices in the Audio Part Editor. Here, the project tempo was higher
than the loop’s original tempo – the slice events overlap slightly.

• Sliced clips are represented by a different icon in the
Pool.

When this occurs, you have to edit the hitpoints manually
in the Sample Editor.

Dragging the sliced clip from the Pool to an audio track will create an
audio part with the slices adapted to the project tempo, just as above.

279
The Sample Editor

Auditioning slices

2. Open the Hitpoints tab and select the Edit Hitpoints
tool.

A slice is a section of the waveform, from one hitpoint to
the next.

When you point in the waveform display, the pointer changes to a
speaker icon.

Click on this button to edit hitpoints

3. Now you can simply point and click in any slice area
and the corresponding slice will be played back from the
beginning to the end.
Listen for “double hits” and slices that contain parts of a single sound.

If you find hitpoints that need to be removed or instances
where a hitpoint needs to be added, the first thing to try is
to change the sensitivity setting – see the following section.

The first thing you should do before editing hitpoints is to
listen to each slice in the Sample Editor to determine what
they contain. The aim is to avoid “double hits”, like a snare
hit being followed by a hi-hat hit within the same slice. You
also want to determine whether any hitpoints have been
added that should be removed:

Setting the sensitivity
The loop is first analyzed to determine where hitpoints
should appear (where the individual “beats” in the loop are),
then you manually set the sensitivity with the sensitivity
slider to determine how many hitpoints there should be.

1. Open a loop in the Sample Editor.
If you have already created slices, you can open them in the Sample Editor by double-clicking any event in the Audio Part Editor. If it is a new
loop, follow the instructions below.

• Try raising the sensitivity to add “missing” hitpoints and
lowering it to remove unwanted hitpoints.
This may or may not work, depending on the situation, but as a general
rule you should try this first.

• Audition the slices again to determine if changing the
sensitivity has improved matters.
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Disabling slices
You might run into situations where there are too many
slices – a single sound may have been split into two
slices, for example. You could of course reduce the sensitivity to get rid of the hitpoints you don’t want, but then
other hitpoints could disappear too, which may be undesirable. What you need to do in a situation like this is to
disable an individual slice:
1. Open the Hitpoints tab in the Sample Editor Inspector
and select the Edit Hitpoints tool.
2. Press [Alt]/[Option] and move the pointer to the handle (the triangle).

The “Use” pop-up menu in Hitpoints tab of the Sample
Editor Inspector affects which hitpoints are shown and is
a useful tool for removing unwanted hitpoints. The options
on the pop-up menu are:
Option

Description

All

All hitpoints are shown (taking the sensitivity slider into
account).

1/4, 1/8,
1/16, 1/32

Only hitpoints that are close to the selected note value
positions within the loop will be shown (e.g. close to exact sixteenth note positions, if the 1/16 option is selected). Again, the sensitivity slider is taken into account.

Metric Bias

The pointer turns into a cross.

3. Click on the handle of the hitpoint you wish to disable.
The hitpoint handle is diminished and its line disappears to indicate that
it is disabled.

This is like the “All” mode, but all hitpoints that are close
to even meter divisions (1/4 notes, 1/8 notes, 1/16
notes, etc.) get a “sensitivity boost” – they are visible at
lower sensitivity slider settings. This is useful if you are
working with dense or cluttered material with a lot of hitpoints, but you know that the material is based on a strict
meter. By selecting Metric Bias it will be easier to find the
hitpoints close to the meter position (although most other
hitpoints are also available, at higher sensitivity settings).

4. Now, the hitpoint won’t be taken into account when
you create slices.
5. To reactivate a disabled hitpoint, [Alt]/[Option]-click
on the hitpoint handle in Edit Hitpoints tool.
Locking slices
If you lock a hitpoint by clicking on its handle with the Edit
Hitpoints tool, it will stay even if you drag the sensitivity
slider all the way to zero. This can be used in situations
where one or several slices contain double hits, but raising
the sensitivity adds a lot of unwanted slices.

If your main reason for slicing the loop is to change the
tempo, you generally need as many slices as you can get,
but never more than one per individual “hit” in the loop.
If you want to create a groove (see “Creating groove
quantize maps” on page 283), you should try to get approximately one slice per eighth note, sixteenth note or
whatever the loop requires.

1. Find the place where you hear double hits when auditioning.
2. Remember the current slider setting.
3. Raise the sensitivity slider to a higher value so that a
hitpoint appears, separating the two sounds.
Most likely this will add a lot of other unwanted hitpoints as well.

4. Audition to make sure you got what you wanted.
5. Point at the handle with the Edit Hitpoints tool.
The speaker icon changes to a normal arrow pointer.
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6. Click on the handle to lock the new slice.

• If you click and keep the mouse button pressed, you can
adjust the position of the new hitpoint by dragging.

Locked hitpoints are displayed in a darker color.

7. Drag the sensitivity slider to the original setting.

Releasing the mouse button adds the hitpoint.

The locked hitpoint will remain shown.

5. Audition the new slice with the Audition tool to make
sure you got what you wanted.

• You can unlock a locked hitpoint by clicking it again
with the Edit Hitpoints tool.

If you manually added a hitpoint, and it was either placed
too far away from the start of the sound or too far into the
sound, you can manually move the hitpoint. It is also possible to move calculated hitpoints this way.

Setting hitpoints manually
If you cannot get the desired result by adjusting sensitivity,
disabling or locking, you can add, move and delete hitpoints manually.
!

1. Make sure Snap to Zero Crossing is activated on the
Sample Editor toolbar.

“Use Snap” may alter the timing. In some cases it
might be better to deactivate it, especially if you just
want to generate a groove quantize. However, if you
create slices afterwards, auto fades will then be necessary.

2. Select the Edit Hitpoints tool.
3. Click on the hitpoint handle and drag it to the new position.
To delete a hitpoint, select the Edit Hitpoints tool and drag
the hitpoint out of the Sample Editor window. Hitpoints
that you have created manually can also be deleted by
clicking their handle.

Manually adding hitpoints can be done in situations where
a hitpoint is missing at a specific point, but doesn’t appear
even if the sensitivity is set to full.
1. Zoom in on the waveform at the point where you wish
to add a hitpoint.

Match-Quantizing audio

2. Select the Edit Hitpoints tool to audition the area and
make sure that the start of the sound is in view.
3. Activate Snap to Zero Crossing on the Sample Editor
toolbar.
By finding zero crossings in the waveform (positions where the amplitude
is close to zero), manually added slices won’t introduce any clicks or
pops. All hitpoints found by the Calculate function are automatically
placed at zero crossings.

4. With the Edit Hitpoints tool selected press [Alt]/[Option] so that the mouse pointer changes to a pencil tool
and click just before the start of the sound.

!

Sounds with a slow attack have their rhythmic center
at some point before the peak.

Optionally, hitpoints can have individual Q-points. These
are mainly used for audio quantizing. Their function is to
define the point to which the quantizing will apply. Sometimes a slice might have a slow attack, and a peak further
into the slice which you wish to use as the Q-point. When
you apply quantize, the Q-point will define where the warp
tab will be added. This also defines the point which will be
stretched to a grid position when quantizing.

A new hitpoint appears. Manually added hitpoints are locked by default.
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• To activate Q-points, open the Preferences (Editing–
Audio page) and activate the option “Hitpoints have QPoints”.

You can change the tempo and have the loop automatically follow (provided that the track is set to musical time
base, see “Switching between musical and linear time
base” on page 40). Furthermore, you can double-click the
part to edit the slices in the Audio Part Editor to:

Next time you use the Calculate Hitpoints function, the hitpoints will have
Q-points.

• To offset the position of a Q-point in relation to the hitpoint, simply click on the “Q” icon and drag it to the right
to the desired position.

•
•
•
•

Remove or mute slices.
Change the loop by reordering, replacing or quantizing slices.
Apply processing or effects to individual slices.
Create new files from individual slices using the “Bounce Selection” function on the Audio menu.
• Realtime transpose and stretch slices.
• Edit slice envelopes.

Creating slices
!

Only when the audio tempo has been defined and
the audio grid matches the project tempo, your slices
will be straight (quantized).

Creating groove quantize maps

When you have specified the correct loop length and time
signature and worked on the hitpoints in the Sample Editor so that one sound per slice is heard, it is time to actually slice the file (if that is what you want to do – there are
other uses for hitpoints as well, as described on the following pages). This is done either by clicking on the Slice
& Close button in the Hitpoints tab of the Sample Editor
Inspector or by selecting “Create Audio Slices from Hitpoints” from the Hitpoints submenu on the Audio menu.

You can generate groove quantize maps based on the hitpoints you have created in the Sample Editor. Groove
quantizing is not meant for correcting errors, but for creating rhythmic feels. This is done by comparing your recorded music with a “groove” (a timing grid generated
from the file) and moving the appropriate notes so that
their timing matches the one of the groove. In other words,
you can extract the timing from an audio loop and use it for
quantizing MIDI parts (or other audio loops, after slicing
them).

The following happens:
• If you edited an event on an audio track, the Sample Editor closes.

Proceed as follows:
1. Check the audio tempo and define the audio grid as
described above.

• The audio event is “sliced” so that there is a separate
event for each hitpoint.

2. Create and edit hitpoints as described above.

In other words, the sections between the hitpoints become separate
events, all referring to the same original file.

You don’t have to create slices – just set up the hitpoints.

• You should try to get approximately one slice per eighth
note, sixteenth note or whatever the loop requires when
setting hitpoints for extracting a groove.

• On the audio track, the former audio event is replaced
by an audio part that contains the slices.
If you edited a clip from the Pool, you need to drag it to an audio track to
get a part with the slices.
!

It can be helpful to use one of the note value-based options on the “Use”
pop-up menu when you’re setting up the hitpoints (see “Setting the sensitivity” on page 280).

When you create slices, all events containing the edited clip will also be replaced.

3. When you have finished setting the hitpoints, click on
the Make Groove button in the Hitpoints tab of the Sample Editor Inspector or select “Create Groove Quantize
from Hitpoints” from the Hitpoints submenu on the Audio
menu.

See also the section “Calculating hitpoints and slicing a
loop” on page 278.
• The loop is automatically adapted to the tempo set in
Nuendo.

The groove is extracted.

This takes the loop length you specified into account: e.g., if the loop
was one bar long, the part is resized to fit exactly one bar in the Nuendo
tempo, and the slices are moved accordingly, keeping their relative positions within the part.
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4. If you now pull down the Quantize Type pop-up menu
in the Project window you will find an additional item at the
bottom of the list, with the same name as the file from
which you extracted the groove.

Close Gaps
This Advanced submenu function on the Audio menu is
useful, if you have sliced a loop for tempo changes. Lowering the tempo below the loop’s original tempo will create gaps between the slices. The lower the tempo is in
relation to the original tempo, the wider the gaps will be.
Close Gaps can be used to remedy this.

This groove can now be selected as a base for quantizing, just like any
other quantize value. See “The Quantizing functions” on page 352.

5. If you want to save this Groove, open the Quantize
Setup dialog and store it as a preset.

1. Set the desired tempo.

Ö You can also create grooves from a MIDI part by selecting the part and dragging it on the grid display in the
middle of the Quantize Setup dialog or by selecting “Part
to Groove” from the Advanced Quantize submenu on the
MIDI menu.

2. Select the part in the Project window.
3. Select “Close Gaps” from the Audio menu – Advanced submenu.
Now time-stretch is applied on each slice to close the gaps. Depending
on the length of the part and the algorithm set in the Preferences, this
can take a little while.

Other hitpoint functions
On the Hitpoints tab of the Sample Editor Inspector and
on the various submenus of the Audio menu, you will also
find the following functions:

4. The waveform is redrawn and the gaps are closed!

Create Markers

• Close Gaps can also be used when the project tempo
is higher than the original loop tempo.

• Note that this feature creates new clips in the Pool, one
for each slice.

If an audio event contains calculated hitpoints, you can
click on the Create Markers button in the Hitpoints tab to
add markers – one for each hitpoint (see “Using the Marker track” on page 111). This can be useful to snap to hitpoints, e.g. for locating hitpoints and for using the
Timewarp tool (see “The Time Warp tool” on page 422).

This will use the time-stretch function to compress the slices to fit.

• If you decide to change the tempo again after using the
Close Gaps function, you should undo the Close Gaps
operation or start over again, using the original unstretched file.
• You can also use this function on individual events (in
the Audio Part Editor or Project window).

Create Regions
If your audio event contains calculated hitpoints, you can
click the Create Regions button in the Hitpoints tab to automatically create regions from hitpoints. This can be useful to isolate recorded sounds, in order to upload them,
e.g. to HALion either as velocity or keyzones.

The events don’t have to be slices – you can use Close Gaps simply to
stretch an audio event to the start position of the next event.

When you make a selection, regions will only be calculated from the hitpoints that are contained in the selection.
Create Events
When you simply wish to create separate events according
to the hitpoints for a file, you can click on the Create Events
button in the Hitpoints tab. This means that you do not have
to make the same considerations as when slicing for tempo
changes. You can use any method you like to set hitpoints.
• The slices created will appear in the Project window as
separate events.
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Free Warp

4. Click the Auto Adjust button so that the audio event is
stretched to the project tempo.
The Straighten Up mode is automatically activated.

5. Select the Free Warp tool by clicking on it.
For aligning the tempo, you should use Bars and Beats as the ruler resolution. When you place the mouse pointer in the waveform display, it
changes to a clock with arrows on either side, and a vertical line in the
middle which represents the pointer. When you move the pointer in the
waveform window, it shows the position in bars, beats and ticks as well
as in seconds.

6. Line up the audio file so that the first beat of the first
bar (in the audio event) starts on the first beat of a bar in
the project.
• If the audio file doesn’t start on a downbeat, you can
use the Event Start handle in the Sample Editor and adjust
the position in the Project window so that the first downbeat in the sample is aligned with the first beat of a bar in
the grid.

Warp tabs are a kind of marker or anchor that can be
attached to musically relevant time positions in an audio
event, e.g. the first beat of every bar. Warp tabs can be
dragged to the corresponding time positions in the
project, and the audio will be stretched accordingly.

Now the musical first downbeat should be aligned with the first beat of a
bar in the project. The next step is to see where the first warp tab needs
to be added. It may be useful to hear the metronome click to determine
when the tempo of the audio clip drifts from the project tempo. To hear
the metronome, activate the Click button on the Transport panel and play
back using the transport controls.

A typical application of warp tabs is to use them to synchronize audio to video, i.e. manipulate audio that is not musical.
You can also use warp tabs for further tweaking after having applied Straighten Up (see “About the Straighten Up
mode” on page 275).
!

7. Play back the audio file, either by auditioning in the
Sample Editor or from the Transport panel, and determine
where the first beat of a bar in the audio event does not
match the corresponding ruler position in the project.

When you change the Straighten Up mode, select
another Quantize value or move the Swing slider, all
your warp edits will be lost.

If you find it difficult to pinpoint an exact position in the audio event, you
can switch to the Scrub tool and/or zoom in the view. Switch back to the
Free Warp tool when you have found the position.

Using the Free warp tool
Warp tabs are created using the Free Warp tool on the
Playback tab of the Sample Editor, but can also be created from hitpoints (see “Creating warp tabs from hitpoints” on page 287). In this example, we will show how a
file with a slightly varying tempo can be locked to a steady
tempo by using warp tabs.
1. Open the audio file you wish to process in the Sample
Editor.
2. Activate the “Use snap” button in the Sample Editor
toolbar.
When you activate this button, warp tabs will snap to zero crossings and
hitpoints (if shown).

3. Determine the original tempo (if this is non-varying) or
the length of the file (see “Determining the audio tempo automatically and time-stretching your audio” on page 272).
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8. In our example, the first beat of the third bar in the audio event is slightly offset from the corresponding grid position and thus needs to be moved back a bit.

11. Release the mouse button.
Now the first beat in the audio event is perfectly aligned with the corresponding position in the project!

The third downbeat in the audio event.

9. Place the pointer at the position of the first beat of the
third bar in the audio event and click and hold.
When you click, a warp tab is added. If the position where you clicked
was off, you can adjust it by dragging the tab in the ruler.

• You can also first add warp tabs at the relevant musical
positions and change their positions later, see “Editing
warp tabs” on page 287.

10. With the mouse button still pressed, drag the warp tab
so that the position lines up with the first beat of the bar in
the ruler.

Next to the warp tab handle in the ruler, a number is
shown. This number indicates the warp factor, i.e. the
amount of stretch. Warp factor numbers higher than 1.0
indicate that the audio region preceding the warp tab is
expanded and will play back slower. Warp factor numbers
lower than 1.0 indicate that the audio region preceding
the warp tab is compressed and will play back faster.
Ö Note that this ratio is limited to a range between 0.1 and
10. This factor is updated when you change the project
tempo with Straighten Up mode enabled or apply the
timestretch tool in the project.
12. Continue to use the same method to align the first
beat in each bar to the corresponding ruler position.
You only have to add warp tabs where the downbeat in the audio file
drifts from the ruler position and/or if you want to lock a warp tab so that
it is not moved when editing other points.

When you are done, the previously varying tempo of the
audio event will be metronome-steady and will adapt to
any tempo in Nuendo.
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This example illustrates the general methods of using
warp tabs and the Free Warp tool. But you can of course
use warp tabs for other operations than aligning downbeats to grid positions. With the Free Warp tool, you can
literally stretch any region within a sample to any position!

Unstretching audio files
By selecting “Unstretch Audio” from the Realtime Processing submenu of the Audio menu, all realtime time-stretching
(by sizing or by warp tabs) can be removed.
Ö Note that realtime transpose (in the infoline) and
Straighten Up mode will not be removed by this.

Editing warp tabs

Whether the “Unstretch Audio” menu item is available depends on whether the time-stretching was applied on the
event or clip level:

Moving the destination position of existing warp tabs
To move a destination position of a warp tab (and thus
stretch the audio), select the Free Warp tool and position
the pointer on the Warp line in the waveform so that the
line in the middle of the pointer becomes blue. Then click
and drag to move the position of the warp tab.

• If you sized an audio event in the Project window using
“Sizing Applies Time Stretch” (see “Resizing events using
time stretch” on page 49), you can undo the time-stretching by selecting the event in the Project window and then
applying “Unstretch Audio”.
This will remove all time-stretching and warp tabs.

• When you have entered a tempo and/or length using
the Definition tab, this information is saved for the source
clip and all events that use it.
Creating warp tabs from hitpoints

Moving the source position of existing warp tabs

You can also create warp tabs from hitpoints selecting
“Create Warp Tabs from Hitpoints” on the Realtime Processing submenu of the Audio menu.

If you simply wish to change the position of a warp tab regarding the audio, click and drag the warp tab header in
the ruler. However, this will change the warping.

For descriptions of how hitpoints are created and edited
please see “Using hitpoints” on page 278.

Deleting warp tabs
To delete a warp tab, press [Shift] so that the pointer becomes an eraser and click on the warp tab.
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Realtime pitch-shifting of audio
events

Flattening the realtime processing
You can “flatten” any realtime processing at any time. This
can be done to serve two purposes; to conserve CPU
power and to optimize the sound quality of the processing.

Audio events can be pitch-shifted in realtime just like MIDI
events. The process is very simple:

• Select the audio event(s) you wish to process and select “Flatten Timestretch and Transpose” from the Realtime Processing submenu of the Audio menu.

1. Open the audio event in the Sample Editor and open
the Playback tab.
2. Set a value in the corresponding field in the Transpose
section.

You should also use this function before applying any offline processing.
When the flatten processing is applied, a copy of the original file is automatically created in the Pool so that the original audio clip remains intact.

The value range is up/down two octaves in semitone steps.

Selecting an algorithm for the flattening
When you flatten the realtime processing, you can use the
MPEX 3 algorithm to process the audio, which may produce better sound quality than the realtime processing.
This is also the only way to achieve polyphonic formant
conserving pitch-shifting, apart from offline processing.
Proceed as follows:
1. Select the audio event(s) you wish to process.
2. Click the Flatten button on the Playback tab of the
Sample Editor Inspector, or select “Flatten Timestretch
and Transpose” from the Realtime Processing submenu of
the Audio menu.

3. Press [Enter].

A dialog appears where you can select an algorithm for the processing.
You can either select the MPEX 3 algorithm, which will produce the highest sound quality, or the Realtime algorithm which is much quicker but
will not improve the audio quality of the processing (although it will
lessen the CPU load).

The audio event is now transposed to the set value using pitch-shift.

4. If a root key is specified or if the Transpose track has
been added, you can click the Follow Global mode to activate/deactivate Global Transpose.
Event transpose will be added to the Global transpose value.

For more information on the transpose functions and the
Transpose track, see the chapter “The Transpose functions” on page 114.
• You can also select the audio event in the Project window and change the Transpose value on the infoline. In
this case, you can also fine-tune selected audio events in
cent steps (100ths of a semitone) by entering a value in
the Finetune field to the right.

!

Audio and MIDI events cannot be transposed simultaneously.
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The MPEX3 algorithm allows you to select one of seven
different quality settings:
Option

Description

Preview

This mode should only be used for preview.

Mix Fast

This mode is a very fast mode for preview. This works best
with composite music signals (mono or stereo material).

Solo Fast

Use this mode or single instruments (monophonic material) and voice.

Solo Musical

Same as above but higher quality.

Poly Fast

Use this for processing monophonic and polyphonic material. This is the fastest setting that gives still very good
results. You can use this for drum loops, mixes, chords.

Poly Musical

Use this for processing monophonic and polyphonic material. This is the recommended MPEX default quality setting. You can use this for drum loops, mixes, chords.

Poly Complex

This high quality setting is quite processor intense and
should be used only when processing difficult material or
for stretch factors above 1,3.

Ö Note that you can only select the MPEX 3 algorithm if
the time-stretching factor is between 0.5 and 2 throughout the whole event. For audio that has been stretched
with a factor outside this range, only the Realtime algorithm can be used.
• If the audio has been transposed, the dialog also contains the option “Formant Correction”. Activate this if you
want to e.g. avoid a “chipmunk voice” effect.
3. Select an algorithm and click OK.
When the processing is finished, any loop that was previously stretched
in realtime or had been pitch-shifted will play back exactly the same, but
Straighten Up mode will be deactivated and the realtime pitch-shifting
will be set to 0.

The audio clip is now like any standard audio clip before
applying realtime processing, i.e. it will not follow tempo
changes. The flattening processing function is best used
when you have determined the tempo or key of a project,
but you can of course always adapt the audio to a new key
or tempo. In this case, it is better to revert back to the original audio clip rather than to process the already processed file again.
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Background

Window overview

The Audio Part Editor allows you to view and edit the events
inside audio parts. Essentially, this is the same type of editing that you do in the Project window, which means that
this chapter contains a lot of references to the chapter “The
Project window” on page 22.
Audio parts are created in the Project window in one of
the following ways:
• By selecting one or several audio events on the same
track, and selecting “Events to Part” from the Audio menu.
• By gluing together two or more audio events on the
same track with the Glue Tube tool.
• By drawing an empty part with the Pencil tool.
• By double-clicking between the left and right locator on
an audio track.
With the last two methods, an empty part is created. You can then add
events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor
You open the Audio Part Editor by selecting one or more
audio part(s) in the Project window and double-clicking
on any one of them (or using the Edit-Open key command,
by default [Ctrl]/[Command]-[E]). The Audio Part Editor
can display several parts at once, and you can also have
more than one Audio Part Editor open at the same time.
Ö Double-clicking on an audio event in the Project window will open the Sample Editor (see “Opening the Sample Editor” on page 259).

The toolbar
The tools, settings and icons on the toolbar have the same
functionality as in the Project window, with the following
differences:
• A Solo button (see “Auditioning” on page 293).
• Separate tools for auditioning (Speaker) and scrubbing (see
“Scrubbing” on page 293).
• No Line, Glue Tube or Color tools.
• Play and Loop icons and an Audition Volume control (see “Auditioning” on page 293).
• Independent Track Loop settings (see “The independent track
loop function” on page 293).
• Part List controls for handling several parts: activating parts
for editing, restricting editing to active parts only and showing
part borders (see “Handling several parts” on page 294).
Ö You can customize the toolbar by hiding or reordering
its items.
See “The Setup dialogs” on page 506.

The ruler and info line
These have the same functionality and appearance as
their counterparts in the Project window.
• Note that you can select a separate display format for
the Audio Part Editor ruler by clicking on the arrow button
on the right and selecting an option from the pop-up menu
that appears.
For a list of the available formats, see “The ruler” on page 31.
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About lanes

Overlapping events

If you make the editor window larger, this will reveal additional space below the edited events. This is because an
audio part is divided vertically in lanes.

Only one event per track can be played back at the same
time! This means that if you have overlapping events (on
the same lane or different lanes) these will cut each other
off, according to the following rules:
• For events on the same lane, the ones that are on top
(visible) will be played.

Lanes

To move overlapping events to the front or back, use the Move to Front
and Move to Back functions on the Edit menu.

• For events on different lanes, the event on the lowest
lane gets playback priority.
Lanes can make it easier to work with several audio events
in a part:

The overlapping sections of the upper event will not be played since the
event on the lower lane has playback priority!

Imagine the following situation: You have two overlapping
audio events, with the top event audible during playback.
What happens when you mute the audible event?
• By default, you will not hear the overlapped event when
muting an event that has playback priority over another
event.
In the top figure it is unnecessarily hard to discern, select
and edit the separate events. In the bottom figure, some of
the events have been moved to a lower lane, making selection and editing much easier.
• To move an event to another lane without accidentally
moving it horizontally, press [Ctrl]/[Command] and drag it
up or down.

This default behavior ensures that you don’t suddenly hear audio events
that previously were not part of your mix.

• In the Preferences dialog (Editing–Audio page) you will
find the option “Treat Muted Audio Events like Deleted”.
When you activate this option, any events overlapped by a
muted event will become audible.

This is the default modifier key for this – you can adjust this in the Preferences if you like.
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Operations
!

Zooming, selecting and editing in the Audio Part Editor are done just as in the Project window (see “Operations” on page 33).

• Note that if a part is a shared copy (i.e. you have previously copied the part by [Alt]/[Option]+[Shift]-dragging),
any editing you perform will affect all shared copies of this
part.
To indicate that it is a shared copy, its name is displayed in italics and a
symbol is displayed in the lower right corner of the part in the Project
window (see “Aligning events” on page 45).

Auditioning
There are three ways to listen to the events in the Audio
Part Editor:
By using the Speaker tool
If you click somewhere in the editor’s event display with the
Speaker tool and keep the mouse button pressed, the part
will be played back from the position where you clicked.
Playback will continue until you release the mouse button.

By using regular playback
You can of course use the regular playback controls while
in the Audio Part Editor. Furthermore, if you activate the
Solo Editor button on the toolbar, only the events in the
edited part will be played back.
The independent track loop function
The independent track loop is a sort of “mini-cycle”, affecting only the edited part. When the loop is activated,
the events in the parts that are within the loop will be repeated continuously and completely independent – other
events (on other tracks) are played back as usual. The only
“interaction” between the loop and the “regular playback”
is that every time the cycle starts over again, so does the
loop.
To set up the independent track loop, proceed as follows:
1. Turn on the loop by clicking the Independent Track
Loop button on the toolbar.
If it isn’t visible, right-click the toolbar and add the Independent Track
Loop Settings section – see “The Setup dialogs” on page 506.

By using the Audition icon

The Audition and Audition Loop icons.

Clicking the Audition icon on the toolbar plays back the
edited audio, according to the following rules:
• If you have selected events in the part, only the section between the first and last selected event will be played back.
• If you have made a range selection, only this section will be
played back.
• If there is no selection, the whole part will be played back. If
the project cursor is within the part, playback starts from the
current cursor position. If the cursor is outside the part, playback starts from the beginning of the part.
• If the Audition Loop icon is activated, playback will continue
until you deactivate the Audition icon. Otherwise, the section
will be played back once.
• When auditioning with the Speaker tool or Audition
icon, audio will be routed directly to the Control Room or
to the Main Mix (the default output bus), if the Control
Room is disabled.
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When the loop is activated, the cycle isn’t shown in the
editor’s ruler. Now you need to specify the length of the
loop:
2. [Ctrl]/[Command]-click in the ruler to set the start and
[Alt]/[Option]-click to set the end of the loop.
You can also edit the loop start and end positions numerically in the
fields next to the Loop button.

The loop is indicated in purple in the ruler.
Ö The events will be looped as long as the Loop button
is activated and the Audio Part Editor window is open.

Scrubbing
In the Audio Part Editor, the Scrub tool has a separate icon
on the toolbar. Apart from that, scrubbing works exactly as
in the Project window (see “Scrubbing” on page 42).

Handling several parts
When you open the Audio Part Editor with several parts selected – all on the same track or on different tracks – they
might not all “fit” in the editor window, which can make it
hard to get an overview of the different parts when editing.
Therefore, the toolbar features a few functions to make
working with multiple parts easier and more comprehensive:
• The Part List menu lists all parts that were selected
when you opened the editor, and lets you select which
part should be active for editing.
When you select a part from the list, it is automatically made active and
centered in the display.

Ö Note that it is also possible to activate a part by clicking on it with the Arrow tool.
• The button “Edit Active Part Only” lets you restrict editing operations to the active part only.
If you for example select “All” from the Select submenu on the Edit menu
with this option activated, all events in the active part will be selected but
not the events in other parts.

• It is possible to cycle between parts, making them active, with key commands.
In the Key Commands dialog – Edit category, there are two functions:
“Activate Next Part” and “Activate Previous Part”. If you assign key commands to these, you can use them to cycle between parts. Please refer
to “Setting up key commands” on page 518 for instructions on how to
set up key commands.

Common methods
Assembling a “perfect take”
When you record audio in Cycle mode, either an event or
a region (or both) is created for each recorded lap (see
“Recording audio in cycle mode” on page 73). These
events and regions are named “Take X”, where “X” is the
number of the take. You can create a perfect take by putting together sections of the different takes in the Audio
Part Editor.
Ö The procedure below will not work if you recorded
with “Keep Last” mode selected on the Transport panel.
In that case, only the last take will be kept on the track (although the previous takes will be available as regions in the Pool).

First, you have to create an audio part from the takes. This
procedure is slightly different depending on whether you
choose to create events or regions.
Creating an audio part from events
1. In the Project window, use the Object Selection tool to
draw a rectangle around the recorded events.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on an active part so that it fills the
screen by selecting “Zoom to Event” from the Zoom submenu on the Edit menu.
• The button “Show Part Borders” can be used if you
want to see clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out,
making the borders easily discernible. There are also two “markers” in
the ruler with the name of the active part, marking its beginning and end.
These can be moved freely to change the part borders.

This is necessary, since clicking on the event may just select the event on
top (the last take). If in doubt, check the info line – the info text should be
yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it
easy to combine different takes in the Project window –
see “Create Events mode (Preferences)” on page 74.

“Show Part Borders” activated on the toolbar.
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Creating an audio part from regions
1. In the Project window, select the event you recorded in
Cycle mode.
After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”.
You are asked whether you want to “Create part using regions”.

3. Click “Regions”.
The regions are converted to an audio part.

Options and Settings
The following options and settings are available in the
Audio Part Editor:
• Snap
You can specify an independent Snap mode (and snap value for the Grid
mode) in the editor. The functionality is exactly the same as in the Project
window.

• Autoscroll

1. Double-click the part to open the Audio Part Editor.

When Autoscroll is activated on the toolbar, the window will scroll during
playback, keeping the project cursor visible in the editor. This setting can
be activated or deactivated individually for each window.

Now, the different takes will be placed on different lanes, with the last
take at the bottom.

• Snap to Zero Crossing

Assembling a take

2. Use the tools to cut out pieces of the takes and assemble the final result.
This can include splitting with the Scissors tool, resizing events with the
Arrow tool or deleting with the Eraser tool.

• Remember that the events on the lowest lane have playback priority.
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!
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When this option is activated, all audio edits are done at zero crossings
(positions in the audio where the amplitude is zero). This helps you avoid
pops and clicks which might otherwise be caused by sudden amplitude
changes.
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Background

Opening the Pool
You open the Pool in any of the following ways:

What is the Pool?

• By clicking the Pool icon in the Project window.

Every time you record on an audio track, a file is created
on your hard disk. A reference to this file – a clip – is also
added to the Pool. Two general rules apply to the Pool:
• All audio and video clips that belong to a project are
listed in the Pool.

• By selecting “Pool” on the Project menu or “Open Pool Window” on the Media menu.
• By using a key command (by default [Ctrl]/[Command]+[P] –
note that using this key command a second time will close the
Pool again).

• There is a separate Pool for every project.
The way the Pool displays folders and their contents is
similar to the way the Mac OS X Finder and the Windows
Explorer display folders and lists of files.

The content of the Pool is divided into three main folders:

What can you do in the Pool?

• The Audio folder

In the Pool you can, among other things, perform the following operations:

This contains all audio clips and regions currently in the project.

Operations that affect files on disk

This contains all video clips currently in the project.

• Import clips (audio files can automatically be copied and/or
converted).
• Convert file formats.
• Rename clips (this will also rename the referred files on disk),
and regions.
• Delete clips (if you select the “Move to Trash” option and
empty the Trash folder – see “Deleting clips” on page 302).
• Prepare File Archives for backup.
• Minimize files.

• The Trash folder

• The Video folder

Unused clips can be moved to the Trash folder for later permanent removal from the hard disk.

These folders cannot be renamed or deleted from the Pool,
but any number of subfolders can be added (see “Organizing clips and folders” on page 308).

Window overview
Audio clip name

Operations that only affect clips
•
•
•
•
•

Audio folder
Region name

Copy clips.
Audition clips.
Organize clips.
Apply audio processing to clips.
Save or import complete Pool files.

Trash folder
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Video folder

Toolbar
Column Headings

Waveform image

Toolbar overview

The Pool window columns

Open/Close all
Hide/show
Project Folder Path
info line View / Attributes Folders
Pop-up
Import Button

Various information about the clips and regions can be
viewed in the Pool window columns. The columns contain
the following information:

Play and Loop buttons,
audition volume control

Search Button
Pool Record Folder Path

The info line
Click the “Show Info” button on the toolbar to show or
hide the info line at the bottom of the Pool window. It
shows the following information:
Number of audio
files in the Pool

Number of audio
files in use

Total size of all audio
files in the Pool

Number of files in the Pool that are not
in the project folder (e. g. video files)

How clips and regions are displayed in the
Pool
• Audio clips are represented by a waveform icon followed by
the clip name.

Column

Description

Media

This column contains the Audio, Video and Trash folders.
If the folders are opened, the clip or region names are
shown and can be edited. This column is always shown.

Used

This column displays the number of times a clip is used in
the project. If a column row is empty, the corresponding
clip is not used.

Status

This column displays various icons that relate to the current Pool and clip status. See “About the Status column
symbols” on page 299 for a description of the icons.

Straighten up

The checkbox in this column allows you to activate or deactivate Straighten up. If the Tempo column (see below)
displays “???”, you have to enter the correct tempo before you can activate Straighten up.

Tempo

This shows the tempo of audio files for which a tempo
has been set. If no tempo has been specified, the column
displays “???”.

Sign.

This is the time signature, e.g. “4/4”.

Key

This ist the root key, if one was specified for the file.

Info

This column shows the following information for audio
clips: The sample rate, bit resolution, number of channels
and the length in seconds. For regions, it displays start
and end times in frames, and for video clips the frame
rate, number of frames, and length in seconds.

Type

This column shows the file format of the clip.

Date

This column shows the date when the clip was created.

Origin Time

This column shows the original start position where a clip
was recorded in the project. As this value can be used as
a basis for the option “Insert into Project” in the Media or
context menu (and other functions), you can change it if
the Origin Time value is independent (i.e. not for regions).
This can either be done by editing the value in the column, or by selecting the corresponding clip in the Pool,
moving the project cursor to the new desired position
and selecting “Update Origin” from the Audio menu.

Image

This column displays waveform images of audio clips or
regions.

Path

This column shows the path to the location of a clip on
the hard disk.

Reel Name

If you have imported an OMF file (see “Exporting and importing OMF files” on page 494), they may include this
attribute, in which case it is shown in this column. The
Reel Name describes the 'physical' reel or tape from
which the media was originally captured.

• Audio regions are represented by a region icon followed by
the region name.

• Video clips are represented by a camera icon followed by the
clip name.
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About the Status column symbols
The Status column can display various symbols that relate
to the clips status. The following symbols can be shown:
Symbol

Description
This indicates the current Pool Record folder (see
“Changing the Pool Record folder” on page 308).
This symbol is shown if a clip has been processed.
The question mark indicates that a clip is referenced to
the project but is missing from the Pool (see “About missing files” on page 305).
This indicates that the clip file is external, i.e. located outside the current Audio folder for the project.

Setting up a talent name attribute to keep track of ADR takes.

This indicates that the clip has been recorded in the currently open version of the project. This is useful for finding
recently recorded clips quickly.

Sorting the Pool contents
You can sort the clips in the Pool by name, date etc. This
is done by clicking on the corresponding column heading.
Clicking again on the same heading switches between ascending and descending sort order.

User Attributes
You can define your own attributes for elements in the pool.
This is handy when you have a large number of audio files in
the Pool. You can use the attributes to sort items in the pool
or merely keep track of some aspect of your project.

The arrow indicates the sort
column and sort order.

Simply select the “Define User Attributes” option from the
View/Attributes pop-up and create as many new attributes
as you need. These attributes will then get their own columns in the Pool. Each attribute can be defined as checkbox, text field or number. You can then specify the user
attributes for each file, thus categorizing them further. All
user attributes you created are automatically available as
search criteria in the Pool and can be added as separate elements to the search pane (or replace the search criteria
above the Location parameter, see above). This allows for a
very detailed search, helping you to master even the largest
sound database.
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Operations

Customizing the view

Ö Most of the Pool-related main menu functions are also
available on the Pool context menu (opened by right-clicking in the Pool window).

Renaming clips or regions in the Pool
To rename a clip or a region in the Pool, select it and click
on the existing name, type in a new name and press [Return].
Ö In case of a clip, this will also rename the referred files
on disk!
!

• You can specify which of the columns should be shown
or hidden by selecting the View/Attributes pop-up on the
toolbar and selecting/deselecting items.

Renaming a clip in the Pool is much preferred to renaming it outside Nuendo (for example on the computer desktop). This way, Nuendo already “knows”
about the change, and won’t lose track of the clip the
next time you open the project. See “About missing
files” on page 305 for details about lost files.

Renaming multiple clips or regions
You can also rename multiple clips or regions in the Pool
using the “Rename…” command from the Edit menu.

• You can rearrange the order of the columns by clicking
on a column heading and dragging the column to the left
or right.

1. Select one or more audio clips, video clips or regions
in the Pool.

The mouse pointer changes to a hand when you place it on the column
heading.

You can only select one type of object at a time.

2. From the Edit menu, select “Rename…”.

• The width of a column can also be adjusted by placing
the pointer between two column headers and dragging
left or right.

A dialog with several options for renaming objects automatically will
open.

3. Set the parameters for renaming objects and press
[Return].

The pointer changes to a divider when you place it between two column
headers.
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Setting parameters of the Rename Object dialog

Option

The Rename Object dialog provides a great deal of flexibility and options when renaming multiple objects in Nuendo. In addition to simple prefix, suffix, and incremental
numeric additions to names, you can remove certain characters, include timestamp information and more.

Samplerate

The samplerate of the audio file.

Audio Tempo

The audio tempo for that clip if it has been assigned.

User Attribute

Any one of the custom attributes created in the Setup User
Attributes dialog (see “User Attributes” on page 299).

Description

An example of the result is displayed in the bottom of the
window for reference. All of these parameters can be
saved as a preset as well.

Copying clips in the Pool
To make a duplicate clip, proceed as follows:
1. Select the clip you wish to copy.
2. Select “New Version” on the Media menu.
A new version of the clip appears in the same Pool folder, with the same
name but with a “version number” after it, to indicate that the new clip is
a duplicate. The first copy made of a clip will logically get the version
number “2” and so on. Regions within a clip are copied too, but keep
their name.
!

The Rename Objects dialog

Each of the eight fields found in the left section of the Rename Objects dialog can be used to add an element to
the name generated for each object.

Copying a clip does not create a new file on disk, but
just a new edit version of the clip (referring to the
same original file).

Inserting clips into a project

The first line will create text or numbers at the left of the
new name. The eighth and last line will create text or numbers at the very right of the new name.

By using menus
1. Select the clip(s) you want to insert into the project.

Each of the eight lines can add one of the following elements including a prefix and suffix for each item (You can
use a prefix to create a space separating items in the generated name.):

2. Pull down the Media menu and select an “Insert into
Project” option.
“At Cursor” will insert the clip(s) at the current project cursor position.
“At Origin” will insert the clip(s) at their Origin Time position(s).

Option

Description

Free Text

Any text you would like to include in the name.

Original Name

The original name given to the object. There are options
to remove all numbers or non-alphanumerics or just the
ones on the left or right sides.

You can also open the Sample Editor for a clip by double-clicking it, and
perform the insert operation from there. This way you can set the snap
point before inserting a clip.

Number

An increasing or decreasing number starting with a minimum amount of digits and a starting number (i.e. 001,
002 etc.).

3. The clip is inserted on the selected track or on a new
audio track.

Project Time

The current location of the clip in the project window using any of the seven ruler formats (Bars+Beats, Timecode etc.).

Date

The date that the file was created in several formats.

File Extension

The file type.

Audio Bitsize

The bit depth of the audio file.

• Note that the clip will be positioned so that its snap
point is aligned with the selected insert position.

If several tracks are selected, the clip will be inserted on the first selected
track.
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By using drag and drop

2. Click Remove.
A new prompt asks whether you want to move the clip to the Trash or remove it from the Pool.

You can use drag and drop to insert clips into the Project
window. You can also use drag and drop from the Sample
Editor for a clip by making a selection range and pressing
[Ctrl]/[Command] while dragging. Note:

3. Select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the hard
disk and can be used in other projects etc. This operation can be undone.

• Snap is taken into account if activated.
Deleting from the hard disk

• While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box.

To delete a file permanently from the hard disk, it must first
be moved to the Trash folder:

Note that these indicate the position of the snap point in the clip. For example, if you drop the clip at the position 10.00, this will be where the
snap point ends up. See “Adjusting the snap point” on page 266 for information on how to set the snap point.

1. Follow the instructions for deleting clips above and
click the Trash button.
Alternatively, you can drag and drop clips into the Trash folder.

2. Select “Empty Trash” on the Media menu. Select one
of the two options in the alert:
• Click “Erase” to delete the file on the hard disk permanently.
This operation cannot be undone!

Snap point

!

Before you permanently delete audio files from the
hard disk, make sure that they are not used by another project!

• Click “Remove from Pool” to remove the clip from the
Pool but to keep the file.

• If you position the clip in an empty area in the event display (i.e. below existing tracks), a new track is created for
the inserted event.

Ö To retrieve a clip or region from the Trash Folder, drag
and drop it back into an Audio or Video folder.

Deleting clips

Removing unused clips from the Pool

Removing clips from the Pool

This function finds all clips in the Pool that are not used in
the project. You can then decide whether to move them to
the Pool Trash folder (where they can be permanently deleted) or to remove them from the Pool:

To remove a clip from the Pool without deleting it from the
hard disk, proceed as follows:
1. Select the clip(s) and select “Delete” from the Edit
menu (or press [Backspace] or [Delete]).

1. Select “Remove Unused Media” on the Media or context menu.

Ö If you try to delete a clip that is used by one or more
events, the program will ask you if you want to remove
these events from the project.

A message appears asking you whether you want to move the file to the
trash or to remove it from the Pool.

2. Make your selection.
Removing regions
To remove a region from the Pool, select it and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).
Ö Note that for regions, there is no alert if the region is
used in the project!

If you cancel, neither the clip nor the associated events are deleted.
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Locating events and clips

• If you want to limit the search to certain folders, choose
“Select Search Path” and select the desired folder in the
dialog that appears.

Locating events via clips in the Pool

1. Select one or more clips in the Pool.

The search will include the selected folder and all subfolders. Note also
that folders you have recently selected using the “Select Search Path”
function will appear on the pop-up menu, allowing you to quickly select
any of them.

2. Select “Select in Project” on the Media menu.

4. Click the Search button.

All events that refer to the selected clip are now selected in the Project
window.

The search is started and the Search button is labeled Stop – click this
to cancel the search if needed.

Locating clips via events in the Project window

When the search is finished, the found files are listed to
the right.

If you want to find out which events in the project refer to a
particular clip in the Pool, proceed as follows:

If you want to find the clip for an event in the Project window, proceed as follows:

• To audition a file, select it in the list and use the playback controls to the left (Play, Stop, Pause and Loop).

1. Select one or more events in the Project window.

If Auto Play is activated, selected files will automatically be played back.

2. Pull down the Audio menu and select “Find Selected
in Pool”.

• To import a file into the Pool, double-click on it in the list
or select it and click the Import button.

The corresponding clip(s) will be located and highlighted in the Pool. If
the Pool window isn’t already open, it will be opened.

5. To close the search pane, click the Search button in
the toolbar again.

Searching for audio files

The Find Media window

The Pool can help you locate audio files in your Pool, on
your hard disk or other media. This works much like the
regular file search, but with a couple of extra features:

Alternatively to the search pane in the Pool, you can open
a stand-alone Find Media window by selecting the
“Search Media…” option from the Media or context menu
(also available from the Project window). This offers the
same functionality as the search pane.

1. Click the Search button in the toolbar.
A search pane appears at the bottom of the window, displaying the
search functions.

• To insert a found clip or region directly into the project
from the Find Media window, select it in the list in the dialog and select one of the “Insert into Project” options from
the Media menu.
The options are described in the section “Inserting clips into a project”
on page 301.

The search pane in the Pool.

By default, the search parameters available in the search
pane are “Name” and “Location”. For using other filter criteria, see “Extended search functionality” on page 304.
2. Specify the name of the file(s) to search for in the
Name field.
You can use partial names or wildcards (*). Note that only audio files of
the supported formats will be found.

3. Use the Location pop-up menu to specify where to
search.
The pop-up menu will list all your local drives and removable media.
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Extended search functionality

5. Select one of the topmost 6 options in the pop-up
menu to change the search option above the Location
pop-up menu.

Apart from the search criterion Name, additional search filters and user attributes are available. To use them, proceed
as follows:

This way, you can choose e.g. to display the Size or Sample Rate parameter instead of the Name field.

1. Set up a couple of user attributes using the “View/
Attributes” pop-up menu.

6. If you want to display more search options, select the
desired element from the Add filter submenu.
This allows you e.g. to add the Size or the Sample Rate parameters to
the already displayed Name and Location parameters.

2. Click the Search button on the toolbar.
The Search pane is displayed in the lower part of the Pool window.

3. Move the mouse pointer over the “Name” text to the
right of the name field, until an arrow is displayed, and
click it.

This allows for a very detailed search, helping you to master even the largest sound database.
• You can store presets of your search filter settings. For
this, click Store Presets in the Presets submenu and enter
a name for the preset.

Move the mouse pointer over the “Name” text to
the right of the name field and click…

Existing presets will be found at the bottom of the list. To remove a preset, click on the preset to activate it, then select Remove Preset.

… to show the Extended Search pop-up menu.

• It is also possible to further refine the search options by
including your user attributes in the search criteria.

4. The Extended Search pop-up menu opens.

When user attributes have been defined, these will appear on the popup menu (see above).

This contains six options determining which search criteria will be displayed above the Location field (Name, Size, Bitsize, Channels, Sample
Rate or Date). It also contains all the user attributes you specified and the
Add Filter and Presets submenus.

The search criteria have the following parameters:
• Name: partial names or wildcards (*)
• Size: Less than, more than, equal, between (two values), in
seconds, minutes, hours and bytes
• Bitsize (resolution): 8, 16, 32, 64
• Channels: mono, stereo and from 3 to 16
• Sample Rate: various values, choose “Other” for free setting
• Date: various search ranges
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About missing files

• If you select Folder, a dialog opens to let you specify the
directory in which the missing file can be found.

When you open a project, the Resolve Missing Files dialog
(see below) may open, warning you that one or more files
are “missing”. If you click Close, the project will open anyway, without the missing files. In the Pool, you can check
which files are considered missing. This is indicated by a
question mark in the Status column.

This might be the preferred method if you have renamed or moved the
folder containing the missing file, but the file still has the same name.
Once you select the correct folder, the program finds the file and you can
close the dialog.

• If you select Search, a dialog opens to let you specify
which folder or disk should be scanned by the program.

A file is considered missing under one of the following
conditions:

Click the Search Folder button, select a directory or a disk and click the
Start button. If found, select the file from the list and click “Accept”.
Afterwards Nuendo tries to map all other missing files automatically.

• The file has been moved or renamed outside the program since the last time you worked with the project, and
you ignored the Resolve Missing Files dialog when you
opened the project for the current session.

Reconstructing missing edit files

Locate missing files

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk), it will normally be indicated with a question mark in the Status column in the
Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder
within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file:

1. Select “Find Missing Files” from the Media or context
menu.

1. Open the Pool and locate the clip(s) for which files are
missing.

• You have moved or renamed the file outside the program during the current session.
• You have moved or renamed the folder in which the
missing files are located.

The Resolve Missing Files dialog opens.

2. Check the Status column – if it says “Reconstructible”, the file can be reconstructed by Nuendo.
3. Select the reconstructible clips and select “Reconstruct” from the Media menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool
If the Pool contains audio files that cannot be found or reconstructed, you may want to remove these. For this, select
“Remove Missing Files” from the Media or context menu.
This will remove all missing files from the Pool as well as
their corresponding events from the Project window.
2. Decide if you want the program to try to find the file for
you (Search), if you want to do it yourself (Locate) or if you
want to specify in which directory the program should
search for the file (Folder).
• If you select Locate, a file dialog opens, allowing you to
locate the file manually.
Select the file and click “Open”.

305
The Pool

Auditioning clips in the Pool

• If you click in the waveform image to audition, the section from the point you clicked to the end of the clip will repeat indefinitely until you stop playback.

There are three methods you can use to audition clips in
the Pool:
• By using key commands.

Opening clips in the Sample Editor

If you activate the “Playback Toggle triggers Local Preview” option in the
Preferences (Transport page), you can use the [Space] bar to audition.
This is the same as clicking the Audition icon on the toolbar.

The Sample Editor allows you to perform detailed editing
on the clip (see “The Sample Editor” on page 258). You
can open clips in the Sample Editor directly from the Pool
in the following ways:

• By selecting a clip and activating the Play button.
The whole clip will play back, unless you stop playback by clicking the
Play button again.

• If you double-click on a clip waveform icon or a clip
name in the Media column, the clip will open in the Sample Editor.
• If you double-click on a region in the Pool, its clip will
open in the Sample Editor with the region selected.

The Play button.

One practical use for this is to set a snap point for a clip
(see “Adjusting the snap point” on page 266). When you
later insert the clip from the Pool into the project, you can
have it properly aligned according to the set snap point.

• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end
of the clip, unless you stop playback by clicking the Play button, or by
clicking anywhere else in the pool window.

Import Medium…
The Import Medium dialog lets you import files directly into
the Pool. It is opened from the Media or context menu or
with the Import button in the Pool window.

Click in the waveform image to audition a clip.
Clicking the Import button opens the Import dialog:

• The audio will be routed directly to the Control Room, if
the Control Room is activated. When the Control Room is
deactivated, the audio will be routed to the Main Mix (the
default output) bus, bypassing the audio channel’s settings, effects and EQs.
You can adjust the auditioning level with the miniature level fader on the
toolbar. This does not affect the regular playback level.

If you have activated the Loop button before you audition,
the following will happen:

The Loop button.

• If you click the Play button to audition a clip, it will repeat
indefinitely until you stop playback by clicking the Play or
Loop button again.
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When you select a file in the Import Medium dialog and
click Open, the Import Options dialog opens:

This is a standard file dialog, where you can navigate to
other folders, audition files etc. The following audio file formats can be imported:
• Wave (Normal or Broadcast, see “Broadcast Wave files” on
page 441)
• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see “Importing ReCycle files” on page 493)
• Dolby Digital AC3 file (ac3 – if you have the Steinberg Dolby
Digital Encoder installed in your system)
• DTS file (dts – if you have the Steinberg DTS Encoder installed in your system)
• SD2 (Sound Designer II)
• MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see “Importing compressed audio files” on page 493)
• Ogg Vorbis (ogg files – see “Importing compressed audio
files” on page 493)
• Windows Media Audio (Windows – see “Importing compressed audio files” on page 493)
• Wave64 (w64 files)

It contains the following options:
• Copy File to Working Directory.
Activate this if you want a copy of the file to be made in the Audio folder
of the project, and have the clip refer to this copy. If the option is off, the
clip will refer to the original file in the original location (and will thus be
marked as “external” in the Pool – see “About the Status column symbols” on page 299).

They may have the following characteristics:
• Stereo or mono
• Any sample rate (although files with another sample rate than
the one used in the project will play back at the wrong speed
and pitch – see below).
• 8, 16, 24 bit or 32 bit float resolution

• Convert to Project section:
Here you can choose to convert the sample rate (if the sample rate is different than the one set for the project) or the sample size, i.e. resolution
(if the sample size is lower than the record format used in the project).
The options are only available if necessary. Note that if you are importing
several audio files at once, the Import Options dialog will instead contain
a “Convert if needed” checkbox. When this is activated, the imported
files will be converted only if the sample rate is different or the sample
size is lower than the project’s.

The following videos formats can also be imported:
•
•
•
•
•

AVI (Audio Video Interleave)
MOV and QT (QuickTime)
WMV (Windows only)
DV (Mac OS X only)
MPEG 1 and 2 video files.
!

• Split Channels
If this is activated, stereo and multi-channel files will be split into a corresponding number of mono files – one for each channel – and these will
be imported into the Pool. Note that if you use this option, the imported
files will always be copied to the Audio folder of the project, as described
above.

For video files to be played back correctly, the right
codecs have to be installed.

• Do not Ask again.

Ö It is also possible to use the commands on the Import
submenu on the File menu to import audio or video files
into the Pool.

If this is activated, files will always be imported according to the settings
you have made, without this dialog appearing. This can be reset in the
Preferences (Editing–Audio page).

Ö You can always convert files later by using the Convert
Files (see “Convert Files” on page 310) or Conform Files
(see “Conform Files” on page 310) options.
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Importing audio CD tracks

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or a subfolder in it) as the Pool
Record folder.

You can import tracks (or sections of tracks) from an audio CD directly into the Pool by using the “Import Audio
CD” function on the Media menu. This opens a dialog in
which you can specify which tracks should be copied from
the CD, converted to audio files and added to the Pool.

2. Select “Create Folder” on the Media or context menu.
A new empty audio subfolder appears in the Pool.

3. Select the new folder.

For details about the Import Audio CD dialog, see “Importing audio CD tracks” on page 491.

4. Select “Set Pool Record Folder” on the Media or context menu, or click in the Status column of the new folder.

Exporting regions as audio files

The new folder now becomes the Pool Record folder, and any audio recorded in the project will be saved in this folder.

If you have created regions within an audio clip (see “Working with regions” on page 269), these can be exported as
separate audio files. To create a new audio file from a region, proceed as follows:

Organizing clips and folders

A browser dialog opens.

If you accumulate a large number of clips in the Pool, it
may sometimes be difficult to quickly find specific items. In
such cases, organizing clips in new subfolders with suitable names that reflect the content can be a solution. For
example, you could put all sound effects in one folder, all
lead vocals in another etc. Proceed as follows:

3. Select the folder in which you want the new file to be
created.

1. Select the type of folder, audio or video, for which you
want to create a subfolder.

A new audio file is created in the specified folder. The file will have the
name of the region and will automatically be added to the Pool.

You cannot put audio clips in a video folder and vice versa.

Ö If you have two clips that refer to the same audio file
(different “versions” of clips, e.g. created with the “Convert
to Real Copy” function), you can use the Bounce Selection
function to create a new, separate file for the copied clip.

A new empty subfolder named “New Folder” appears in the Pool.

1. In the Pool, select the region you wish to export.
2. On the Audio menu, select “Bounce Selection”.

2. Select “Create Folder” on the Media on context menu.
3. Click on the name and enter an appropriate name for
the folder.
4. Drag and drop the clips you wish to move to the new
folder.

Select the clip, select Bounce Selection and enter a location and name
for the new file.

5. Repeat steps 1-4 as necessary.

Changing the Pool Record folder

Applying processing to clips in the Pool
You can apply audio processing to clips from within the
Pool in the same way as to events in the Project window.
Simply select the clip(s) and choose a processing method
from the Audio menu. To find out more about audio processing, see the chapter “Audio processing and functions”
on page 238.

The Pool Record folder.

In the Pool Record folder, all audio clips that you record in
the project will end up. The Pool Record folder is indicated by the text “Record” in the Status column and by a
red dot on the folder itself, as shown in the picture above.
By default, this is the main Audio folder. You can, however, at any time create a new Audio subfolder and designate this as your Pool Record folder. Proceed as follows:

308
The Pool

Undoing processing

Prepare Archive

If you have applied processing to a clip, in the Project window, the Sample Editor, or in the Pool, this is indicated by
the red and gray waveform symbol in the Status column.
This processing can always be undone using the Offline
Process History, see “The Offline Process History dialog”
on page 251.

The option “Prepare Archive” on the Media menu is useful
if you want to archive a project. It verifies that every clip
referenced in the project is located in the same folder, and
takes actions if that is not the case:
• Any files that are located outside the current project
folder will be copied into it.
Please note that audio files that reside within the project folder will not be
copied to the audio folder. You will therefore have to copy them there
manually before backing up the audio folder or save them separately during backup, see below.

Freeze Edits
You can use the Freeze Edits function to create a new file
with processing applied or to replace the original with a
processed version, see “Freeze Edits” on page 253.

• If any processing has been applied, you will be asked
whether you want to Freeze Edits.

Minimize File

If you do this, you don’t have to archive the Edits folder. Everything belonging to the project will be contained in the project file and the Audio folder.

The option “Minimize File” on the Media or context menu
allows you to change the size of audio files according to
the audio clips referenced in a project. The files produced
using this option will only contain the audio file portions
actually used in the project. This can significantly reduce
the size of the project, if large portions of the audio files
are unused. Therefore, the option is useful for archiving
purposes after you have completed a project.

Once you have performed a Prepare Archive, you can copy
the project file, the Audio folder and any other audio material you saved in the project folder to backup disks, etc.
It is not necessary to archive the Images folder, since
these Images can be recreated by Nuendo. You may also
find a file with the extension “.csh” in the project folder.
This contains image information for edited clips and other
data that can be recreated, so it can safely be deleted.

Ö This operation will permanently alter the selected audio files in the Pool. This cannot be undone!

!

If this is not what you want, you can use the option “Save Project to New
Folder” on the File menu instead, see “Save Project to New Folder” on
page 489. This function also has the option of minimizing files, but copies all files into a new folder, leaving the original project untouched.

Video clips are always referenced and not stored in
the project folder.

Importing and exporting Pool files
You can import or export a Pool as a separate file (file extension “.npl”), by using the “Import Pool” and “Export
Pool” options on the Media or context menu.

Proceed as follows:
1. Select the file(s) you wish to minimize in the Pool.
2. Select “Minimize File” on the Media menu.

When you import a Pool file, the file references in it are
“added” to the current Pool.

An alert appears, informing you that the entire Edit History will be cleared.
Click Minimize to proceed or Cancel to stop the process.

Click Save Now to save the updated project or click Later to proceed
with the unsaved project.

Ö Since the audio and video files are only referenced but
not saved in the Pool file, the Pool import is only useful if
you have access to all referenced files (which preferably
should have the same file paths as when the Pool was
saved).

Only the audio portions actually used in the project remain
in the corresponding audio file(s) in the Pool Record folder.

Ö You can also save and open libraries. These are standalone Pool files that are not associated with a project.

3. After the minimizing is finished, another alert appears,
because the file references in the stored project have become invalid.

See “Working with libraries” on page 490.
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Convert Files

Conform Files
By using this command, you will change all selected files
that have different file attributes than what is specified for
the project, to conform to this standard.
Proceed as follows:
1. Select the clips in the Pool.
2. Select “Conform Files” on the Media menu.
A dialog opens allowing you to choose between keeping or replacing the
original unconverted files in the Pool. The following applies:

• Clip/event references in the pool are always redirected to the
conformed files.
• If any “keep” option is selected, original files remain in the
Project’s Audio folder and new files are created.
• If you select the “Replace” option, files in the Pool and in the
Project’s Audio folder are replaced.

Selecting the option “Convert Files” on the Media or context menu opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify
which audio file attributes you want to keep and which you
want to convert. The available settings are:
• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

Extract Audio from Video

• Sample Width

This Media menu item allows you to extract the audio from
a video file on disk. It automatically generates a new audio
clip that will appear in the Pool Record folder. The resulting clip will have the following properties:

Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or
32 Bit float.

• Channels

• It will get the same file format and sample rate/width as
in the current project.

Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave, AIFF, Wave 64 or Broadcast Wave format.

• It will get the same name as the video file.

Options

Ö This function is not available for mpeg video files.

When you convert a file, you can use the Options pop-up
to set one of the following options regarding what to do
with the new file:
Option

Description

New Files

Creates a copy of the file in the audio folder and converts
this new file according to the chosen attributes. The new
file is added to the Pool, but all clip references will still
point to the original, unconverted file.

Replace Files

Converts the original file without changing clip references. The references are however saved with the next
save action.

New + Replace Creates a new copy with the chosen attributes, replaces
in Pool
the original file with the new one in the Pool and redirects
the current clip references from the original file to the
new file. This is the option to select if you want your audio
clips to refer to the converted file, but still want to keep
the original file on disk (e.g. if the file is used in other
projects).
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Introduction

One of the biggest challenges in typical project studio environments is how to manage the ever-growing number of
plug-ins, instruments, presets, etc. Nuendo provides a
truly universal, fully integrated solution to this problem:
VST Sound.

What constitutes VST Sound?

• With the introduction of the VST3 plug-in standard, Nuendo makes use of VST presets as an additional way to
apply sounds to instrument tracks and effects to audio
track (see “Inserts and EQ settings from track presets” on
page 337). Plug-in parameters can be saved as VST presets, and you can also generate VST presets (i.e. sounds)
from VST2 Instruments.

The Nuendo VST Sound is what links the MediaBay and
instrument tracks as well as track and VST3 presets.

You can identify VST Sound features through the VST
Sound logo.

• The MediaBay is a universal Media Management System providing different views that allows you to find and
tag media files, quickly import media files into projects and
more (see “The MediaBay” on page 314).

The VST Sound logo

• Instrument tracks are a sound-oriented combination of
MIDI tracks and VST Instruments, another way of applying
sounds to tracks easily (see “VST Instruments and Instrument tracks” on page 189).

The VST Sound logo is used in various places in Nuendo,
for example:
• In the Inspector as a button for applying track presets.
You will only see track presets corresponding to the type of track you are
working on.

• Track presets are a combination of track settings, effects and mixer settings that can be applied to new tracks
of various types. So right from the start, you can set up
your tracks for a specific sound (see “Track Presets” on
page 327).
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• In the Inspector for instrument tracks as a button for extracting sounds.

• In the Inspector or the Channel settings window as buttons for extracting Inserts or EQ settings from track presets.

What can VST Sound do for you?
• VST Sound allows you to manage any sound from any
software or hardware synthesizer under a single, unified
user interface.
• VST Sound can help you find any sound, not only by instrument but also by category, type, style, character or
other attributes (Track presets organized in the MediaBay).
• VST Sound comes with more than 1000 ready-to-play
sounds, which are also conveniently organized by instrument category, type, and character. These can even be instantly previewed before loading (Instrument track presets
managing the VST instruments – again organized in the
MediaBay).
• VST Sound can manage your VST plug-in presets.
These can be organized and categorized to form one big
effects library (VST presets organized in the MediaBay).
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Introduction

Accessing the Media Management System
Nuendo provides the following options to access the
Media Management System:

Modern media production involves having to deal with a
multitude of media files, e.g. audio, MIDI, video, etc.

• Pull down the Media menu and select “Open MediaBay”,
“Open Loop Browser” or “Open Sound Browser” (or use
the respective key commands).

Nuendo features a powerful media file management database that allows you to control all your media files from
within your sequencer program. This may involve several
different tasks:

When one of these windows is open, selecting the menu option or using
the key command will close it instead.

• You can browse the folders of your file system to view
folders and files.

The preconfigured windows of the Media
Management System

• You can define searches to find specific files and filter
the search results.
• You can organize your files in a folder structure.

The Media Management System in Nuendo can be accessed via the MediaBay, the Loop Browser or the Sound
Browser.

• You can use the tagging features to assign your files to
specific categories, and use these categories as the basis
for your searches.

Which of these to use depends entirely on your working
environment, and you may find that you want to change
the default setup to better meet your requirements.

Which file formats are supported?

• By default, the MediaBay is configured to show all window sections and display all file types. The default search
mode is Details search.

The following media file formats are supported by the Nuendo Media Management System:

If you want to work on media files of various types, if you have to move
files to different locations using the Browser section, or if you want to
perform other general file management tasks, the MediaBay is probably
the best view configuration.

• Audio: .wav, .w64, .aiff, .aifc, .rex, .rx2, .mp3, .mp2, .ogg,
.sd2, .wma (Windows only)
• MIDI: .mid and .midiloop

• The Loop Browser is configured to show audio files, with
Category search mode selected by default.

• Track Presets: .trackpreset
These are templates for audio tracks, MIDI tracks and instrument tracks.
Track Presets are described in detail in the chapter “Track Presets” on
page 327.

Use this if your focus is on audio files of any kind.

• The Sound Browser is focussed on the VST Sound
node (see “The VST Sound node” on page 318). Its filter
buttons are set to showing track preset and VST preset
files. Its default search mode is the Category search.

• VST Presets: .vstpreset
VST presets are files containing all parameter settings for a particular
VST plug-in. VST preset files are described in detail in the section “Inserts and EQ settings from track presets” on page 337.

Use this if you want to work with the available presets.

Whenever you read about the “MediaBay” in this manual,
please remember the following:

• Video: .avi, .mov, .qt, .mpg, .wmv (Windows only)
• Project files (from Cubase, Nuendo, Sequel): .cpr, .npr,
.steinberg-project

Ö The MediaBay is only one of these three preconfigured
views of the Nuendo Media Management System. In the
MediaBay window, all controls of the Media Management
System are visible by default, so we will refer to the MediaBay throughout this manual when describing functions.
However, what you can do in the MediaBay can also be
done in the Loop Browser and the Sound Browser.
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Window overview
The Filter section, see “Finding files in the Viewer section” on page 319.
The Tag Editor, see
“The Tag Editor”
on page 323.

The Browser
section, see
“Browsing for
media files”
on page 316.

The Scope section,
see “Previewing files
in the Scope section” on page 322.

The Viewer
section, see
“Finding files
in the Viewer
section” on
page 319.

Browsing for media files

The info line
The info line is located at the bottom of the window.

To the left in the default MediaBay window you will find
the Browser section.

The info line shows the number of files displayed in the
Viewer section and the path to the folder selected in the
Browser section in which these files were found.

MediaBay sections
You can use the three buttons below the Browser section
to show/hide the respective sections in the MediaBay
window. The Viewer section cannot be hidden.

Click this button to hide the Browser section.

• You can change the size of the individual sections by
dragging the divider line between two sections.
The Browser section of the MediaBay window

• When saving a Nuendo project, the current status of the
MediaBay is also saved.

Ö Note that the Browser section can only show folders;
any media files contained in a selected folder are displayed in the Viewer section to the right.

This means that if the MediaBay was open when you saved a project, it
will be opened again the next time you open this particular project. The
last MediaBay window configuration will also be restored.

This also depends on the “Deep Results” setting, see “Filtering the
Viewer display” on page 319.
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Scanning operations

• When the scan is complete, the scanning indicator will
not be shown.

When you open the MediaBay, the Loop Browser or the
Sound Browser for the first time, a scan for the media files
needs to be performed. Specify which folders or directories
should be included in the scan by activating the check
boxes to the left of their name. Depending on the amount of
media files on your computer, the scan may take a while.
The scan result is saved in the MediaBay database.

The scanning status for the individual folders in the
Browser section is indicated by the color of the icons:
• A red icon means that this folder is currently being scanned.
• A light blue icon means this folder has been scanned.
• Orange folder icons are displayed when a scanning process
was interrupted.
• Yellow icons are displayed for folders that have not been
scanned.

• To include a folder, activate its check box.

Deep Results
Clicking the “Deep Results” button switches the Viewer
display between showing only the folders and files contained in the selected folder, and showing the files contained in the selected folder and in any subfolders (without
showing the subfolders).

These folders will be scanned for files.

• You can also only scan individual subfolders.
This will be reflected in the icon for the folder the subfolder resides in.

Only the VST3 Presets subfolder of the Factory Content folder will be
scanned for files. The Track presets folder will not be searched.

The Deep Results button

When you select a folder in the Browser display, the
MediaBay will scan this folder and all its subfolders for
media files, even if they have been scanned before (unless
“Rescan on select” is deactivated, see below).

About “Rescan on Select”

• When “Stop scanning folders when closing MediaBay”
is activated in the Preferences dialog (MediaBay page),
Nuendo will scan for media files only when the MediaBay
window is open. When this is deactivated, the folders will
be scanned in the background, even when the MediaBay
window is not open.

The “Rescan on Select” button

• When this button is activated, selecting a folder in the
Browser section will always cause this folder to be rescanned. This ensures that the MediaBay will always display the current content of a folder.

Even if scanning in the background is activated, Nuendo will not scan
folders while playing back or recording.

!

Scanning indicator and status
At the top right in the in the Viewer section, you will find
the scanning indicator, which shows whether the MediaBay is scanning for files or whether the scan is complete.

When a folder contains a large number of media files,
the scanning process may take some time – you may
want to deactivate “Rescan on Select”, if you know
that you haven’t made any changes to the content of
your media folders since they were last scanned.

• When “Rescan on Select” is deactivated, you can always
right-click in the Browser section and select “Refresh” from
the context menu to force a rescan of the currently selected
folder.

When this indicator appears, a scan is performed.

• When the folders specified in the Browser section are
being scanned, the scanning indicator appears.
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Folder operations

• You can create a new folder inside the folder selected in
the Browser section by clicking the “Create New Folder”
button (the folder icon).

The Browser section shows the folder structure of your
computer’s file system in a way very similar to the Windows Explorer or the Mac OS Finder:

A dialog is opened in which you can enter a name for the new folder.
The “Create new
folder” button

• Click on the folder icons in the Browser display to select the corresponding folder.

The folder navigation
buttons

• Double-click on the folder icons in the Browser display
to open the corresponding folder.

The VST Sound node

• When a folder contains subfolders, this is indicated by a
plus icon in front of the folder icon. The plus icon changes
to a minus icon when the folder is open. To open or close
a folder, you can also click the plus/minus icons.
• You can switch the Browser display between the Full
view and the Focus view.

The VST Sound node in the Browser section.

Focussing a selected folder means showing only this folder and any subfolders it contains. Any folder levels above the focussed folder are not
displayed. When you switch back to the Full view, the entire file system
node can be accessed.

The Browser section provides a shortcut to user content
and factory content files, including the preset folders. You
find this node at the top of the Browser folder hierarchy, at
the same level as the File System node.
• The folders below the VST Sound node represent the
folders in which content files and newly created track presets, VST presets, etc. are stored by default.
To find out the “true” location of such a file, right-click on it in the Viewer
section and select “Open in Explorer” (Win)/“Reveal in Finder” (Mac).
This will open an Explorer/Finder window in which the corresponding file
is highlighted.

The Focus view for the Audio folder.

• You can hide all folders not being scanned for files by
clicking the “Show Mediabay Managed Items Only” button.

Creating Favorites

This will keep the list less cluttered.

If you constantly find yourself returning to specific folders
during your work, you can save these browse locations as
presets so that selecting such a preset will take you to the
folder instantly. Proceed as follows:
1. Select the desired folder in the folder display.

• Use the buttons “Previous Browse Location”, “Next
Browse Location” and “Browse Containing Folder” to
navigate to folders.

2. Click the Add Browse Location Preset button (the “+”
icon).

Click “Previous Browse Location” or “Next Browse Location” to select
the previous or next folder in a sequence of previously selected folders.
Clicking the “Browse Containing Folder” button will select the parent
folder of the previously selected folder.

A naming dialog for the new preset is displayed.

3. Accept the default name (the complete folder path) or
enter a new name for the preset.
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4. Click OK.

Depending on your settings, the number of files displayed
in the Viewer can be huge (the info line at the bottom of
the window shows the number of files found with the current filter settings). Therefore, the MediaBay provides a
number of ways to display only specific files and to perform very refined file searches.

The new preset is added to the Select Browse Location Presets pop-up
menu (which can be opened by clicking on the down arrow icon).

Ö By default, the number of files displayed in the Viewer
section is limited to 10,000 files. You can change this by
specifying a new value for “Maximum Number of Results in
Viewer” in the Preferences dialog (MediaBay page).

When you now open the Select Browse Location Presets
pop-up menu and select the new preset, the respective
preset folder will be selected in the Browser display.

Filtering the Viewer display

• To remove a preset from the Select Browse Location
Presets pop-up, select it from the pop-up and click the
“Remove Browse Location Preset” button (the “-” icon).

The MediaBay provides a number of filter buttons that can
be used to limit the number of files displayed in the Viewer
section.

Finding files in the Viewer section

• At the top of the Viewer section you will find the filter
buttons that can be used to show all supported file types
or any combination of file types.

The Viewer section consists of two panes: the Filter section
at the top and below it, the Viewer display. In the Filter section, you can set up filters and define searches for specific
files. The Viewer display lists any files contained in the folder
selected in the Browser, and tags of these files. How to set
up the tag display in the Viewer is described in the section
“Managing the tag lists” on page 323.

For example, when you activate the Audio and the MIDI filter buttons,
only the audio and the MIDI files contained in the folder selected in the
Browser will be displayed. When none (or all) of these buttons are activated, files of all supported types will be displayed.

Ö Note that it is only possible to edit tags in the Viewer if
“Allow Editing in Viewer” is activated in the Preferences
dialog (MediaBay page).

The filter buttons. The display is filtered to show only audio files.

When this preference is deactivated, editing is only possible in the Tag
Editor (see “Editing tags in the Tag Editor” on page 324).

Defining searches for specific files
The filter buttons let you find files according to the folder(s)
they might be located in, or according to their file type.
However, you can also perform very detailed searches for
files that meet certain criteria.
• The Details search mode allows you to perform a search
for a specific file tag value.
You define which tag to search for, e.g. “Name”, and specify the corresponding value, e.g. “myfilename.wav”.

• In Category search mode, the Filter section will display
all values found for a specific tag (or “category”). Selecting one of these values will result in a list of files all showing this particular tag value.
For example, you could look for sample rates and pick 44.1 kHz to give
you a list of all files with that particular sample rate. But Category search
mode becomes really interesting when making extensive use of tagging –
see “Performing a Category search” on page 320 and “Tagging media
files” on page 325.

The Viewer section
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• Once a search operation has been completed, the very
first entry in the Viewer list is selected. When you now
press [Tab] once, this selected entry will receive the focus
and you can use the Up and Down arrow keys to browse
the list of files.

The Reset button in the Filter section

• The condition pop-up menu contains the following options:

Performing a Details search

Option

Description

The following section briefly describes how to perform a
search for a particular file name in the file system.

contains

The searched tag value must contain the text or number specified in the text field to the right.

Proceed as follows:

omits

The searched tag value must not contain the text or number
specified in the text field to the right.

1. Select the root folder of your hard disk in the Browser
section.

equals

2. Select the Details search mode by clicking on the Details tab at the top of the Filter section.

The searched tag value must match the text or number specified in the text field to the right, including any file extension. Note
however, that detail searches for text are not case sensitive.

>=

The searched tag value must be higher than, or equal to, the
number specified in the field to the right.

<=

The searched tag value must be lower than, or equal to, the
number specified in the field to the right.

is empty

You can use this option to find files for which certain tags have
not been specified yet.

range

When “range” is selected, you can specify a lower and an upper limit for the searched tag value in the fields to the right.

3. By default, the tag pop-up menu to the left is set to
“Any Attribute”, and the condition pop-up menu in the
middle is set to “contains”.
Leave these as they are.

4. Enter part of the name of the file that you wish to find
in the text field to the right.
Note how the search is performed anew every time you enter a new letter. Detail searches are not case sensitive.

• Note that for all conditions except “range”, you can enter more than one string in the text field (separate different
search strings with a space).

Enter the file name here.

These strings form an AND condition, i.e. the files found will match all
strings entered in the field.

• To open a new filter line, move the mouse pointer to the
right end of the text field and click the “+” button that appears.
This way, you can set up up to five additional filter lines in which you can
define new search conditions. Note that two or more filter lines form an
AND condition, i.e. the files searched for must match the conditions defined in all filter lines. Click the “-” button for a filter line to remove it.

A Details search for files whose names contain “e-piano”.

• The Tag pop-up menu shows an alphabetical list of file
tags you can choose from. At the top of the pop-up menu,
the MediaBay maintains a smaller list of the last 5 tags selected during previous searches.

Performing a Category search
The MediaBay allows you not only to view and edit some
of the standard file attributes found in all computer files,
but it also provides preconfigured tags, or “categories”,
that you can use to organize your media files.

Note that you can select more than one tag. This will create an OR condition: the files found will match either one or the other tag. Click OK to
set the tag(s) to search for. How to configure the tag list is described in
the section “Managing the tag lists” on page 323.

The advantages of such categorization become obvious
when having to find one specific file, e.g. a certain guitar
sound, among large numbers of media files from various
contexts, without knowing the name of that file.

• To reset all search fields to their default settings, click
the Reset button in the top right corner of the Filter section.
This will also reset the tag list settings.
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When you select the Category search mode, the Filter
section will show the tag columns, each with its own list of
tag values.

• Selected tag values in the same tag column form an OR
condition.
This means that files must be tagged according to either one or the other
value to be displayed in the Viewer section.

These tag values were found in the currently selected folder.

For the “Style” tag, the files found will show either the “Blues” OR the
“Jazz” tag value.

• Tag values in different columns form an AND condition.
This means that files must be tagged according to all these values to be
displayed in the Viewer section.

The default setup of Category search mode

By clicking on individual tag values in the tag columns, you
define the search filter: only the files that match the selected tag values will be displayed in the Viewer. Select
more tag values from other columns to further refine your
search.
The files found will belong to the “E. Guitar” sub category tag AND
show “Blues” for the Style tag.

The files displayed in the Viewer match the selected tag values.

Categorization by tagging makes it easy to organize your
media files. How to assign tag values to your files is described in the section “The Tag Editor” on page 323 and
in the section “Tagging media files” on page 325.
Ö Note that you can use existing tags or use the user tag
feature (see “Defining user tags” on page 324) to create
your own categories.
Category searches are used not only in the MediaBay, but
throughout Nuendo in various VST Sound-related contexts (see the chapter “VST Sound” on page 311).
!

By default, the first two tag columns are set to “Category” and “Sub Category”. These tags are directly
linked to each other: for each Category value, there is
a number of Sub Category values. Changing to a different Category value in the first tag column will give
you different values in the Sub Category column!

!

Each tag column displays only the tag values found
in the folder selected in the Browser section of the
MediaBay! This means that selecting a different
folder in the Browser may lead to the display of different Category search settings.
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Previewing files in the Scope section

Further options for Category searches
• The text field at the top serves as an additional name filter: you can enter a file name or part of a file name here.

Below the Viewer you will find the Scope section. It allows
you to play back files selected in the Viewer section.

This corresponds to a “Name: contains” Details search, which means
that the name of the searched file must contain the text you enter here.
See also “Performing a Details search” on page 320.

The elements visible in this section and their functions
depend on the type of media file selected in the Viewer.
!

The Scope section does not play back video files or
project files. Also, it is not possible to preview audio
track presets in the MediaBay (see below).

Previewing audio files
Transport controls

Preview level

Auto Play

Play in Project
context

The Scope section for an audio file.

In addition to the filter defined by the tag columns, the name of the
searched file must contain “120bpm”.

• To preview an audio file, simply click the Start button.

• You can change which tag is displayed at the top of
each tag column by clicking on the tag and selecting a different tag from the Filter tag list pop-up menu.

• When Auto Play is activated, selecting a file in the
Viewer will automatically start playback.
• When “Play in Project context” is activated, the file will
be played back together with the current project, starting
at the current project cursor position.

How to configure the Filter tag list is described in the section “Managing
the tag lists” on page 323.

• To select a tag value, simply click on it. To deselect it,
click the value again.

Previewing MIDI files

Note that you can select more than one value in each tag column.
Transport controls

• Click the Reset button on the top right of the Filter section to clear all settings in the tag columns.

Output

Auto Play

Play in Project
context

This will also reset the tag list settings.

The Scope section for a MIDI file.

• To preview a MIDI file (.mid), you first have to select an
output device in the Output pop-up.
The “Auto Play” and “Play in Project context” options work in the same
way as with audio files.

• Auto Play and “Play in Project context” work as for audio
files, see above.
Previewing MIDI loops
• To preview a MIDI loop file, click the Start button.
• Auto Play works as for audio files, see above.
MIDI Loops are always played in the project context.
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Previewing track and instrument presets

The Media Management System provides further tags,
such as “Category” or “Character”.

MIDI In activity

You have access not only to the standard tags and the
preconfigured tags provided by Nuendo, but you can also
define your own tags and add these to your files.
The Scope section for a MIDI track preset.

The following sections describe how to set up the various
tag lists, how to edit tags in the Tag Editor, and how to define user tags.

Track presets for MIDI or Instrument tracks and VST plugin presets require MIDI notes for previewing. There are
two ways these notes can be sent to the track template:

Managing the tag lists

• Click the “MIDI Input” button and play MIDI notes on a
MIDI keyboard connected to your system.

Lists of tags and tag values are used in various places in
the MediaBay window. You can configure these lists and
define certain tag properties in the Manage Tags dialog.

• Clicking “Choose MIDI File” will open a file dialog where
you can navigate to a MIDI file. When you now click “Play”,
the notes received from the MIDI file will be played with
the settings of the track preset applied.

Proceed as follows:
1. Open the Manage Tags dialog by clicking on the Manage Tags button in the lower right corner of the MediaBay
window.

Track presets for audio tracks cannot be previewed in the
MediaBay. You can do this in the Apply Track Template
dialog (for further information, see “Previewing track or
VST presets before applying” on page 336).

2. Click one of the filter buttons at the top of the Manage
Tags dialog to select the file type for which you want to
configure the tag lists.

The Tag Editor

The Manage Tags dialog shows a list of all tags available for the media
files supported by the MediaBay, and three columns of checkboxes, one
for the Filter section, one for the Viewer and one for the Tag Editor.

When a file is selected in the Viewer section, the Tag Editor
shows a two-column list of tags and tag values for this file.

3. To display a certain tag in the Filter tag lists, the Viewer
or the Tag Editor, activate the corresponding checkbox for
this tag:
The “Category” tag
is selected for display in the Filter tag
lists, the Viewer and
in the Tag Editor.

Tags for media files (also called “attributes”) are sets of
metadata providing additional information on the file. The
different types of media files have different tags: for example, for .wav audio files you will find standard tags like
name, length, size, sample rate, etc., while for .mp3 files,
additional tags such as “Artist” or “Genre” are available.

4. Close the Manage Tags dialog by clicking its close box.
Your settings will be applied.

• The Type column shows whether the value for a tag is a
number, text or a Yes/No-type switch. The Precision column shows the number of decimals displayed after a point
for number tags.
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• Click and drag in the tag display to select several tags
(click somewhere outside the selected area to deselect).

• Most tag values can be edited by double-clicking in the
Value column of the Tag Editor.

This way, you can activate/deactivate all selected check boxes in one go.

Tag values can be text, numbers or yes/no switches. Simply enter/change
the text, number or Yes/No setting in the field displayed for a value.

• To return to the default tag display settings for the Filter,
Viewer and Tag Editor sections, click the “Reset to Default”
button (above the tag display) in the Manage Tags dialog.
Displaying tags in the Tag Editor
You can switch the tag display in the Tag Editor:

Renaming a file in the Tag Editor

• Click on “Managed” to show only the tags activated for
display in the Manage Tags dialog.

• When clicking in the Value column for “Category”, “Sub
Category” or “Style”, a pop-up menu opens from which
you can choose a value.

Use this view to limit the tag display to only those tags that are of interest
to you.

The tags “Category” and “Sub Category” are directly linked to each
other. The “Category” pop-up allows you to set a category, the “Sub
Category” pop-up allows you to set a category and a corresponding sub
category. If you pick a sub category from a category that is different from
the category set for the “Category” tag, this tag will be changed as well.

• Click on “All” to show all tags for the file selected in the
Viewer for which values are available.
Use this display if you wish to see all tags, including standard file attributes such as Name, Size or Date Modified.

Displaying tags in the Viewer

• Clicking in the Value column for the “Character” tag will
open the Edit Character dialog.

Most of the time, tags displayed in the MediaBay are
sorted alphabetically. Only in the Viewer can you change
the tag display order:

Click a radio button on the left or the right side and then click OK to define values for the Character tag.

• Clicking in the Value column for the Rating tag allows
you to rate the file on a scale from 1 – 5.

• Move the mouse pointer to a column heading, click and
drag that heading to a different position in the display.

For example, use this to indicate the file’s sound quality or its suitability
for a certain purpose.

Editing tags in the Tag Editor
Defining user tags

You can use the Tag Editor to edit tag values of the various media files.

You can define your own tags and save these in the MediaBay. You can use such user tags for example to define your
own filter categories, further refining the categorization of
your media files.

Ö Note that changing a tag value in the Tag Editor may
permanently change the corresponding file.
When it comes to editing, you will notice that there are different types of tags:

To define a user tag, proceed as follows:

• “Display only” tags cannot be edited. Their values are
displayed in a slightly lighter color.

1. Open the Manage Tags dialog by clicking the Manage
Tags button in the lower right corner of the MediaBay window.

In this case, the file format probably doesn’t permit changing this value,
or changing a particular value makes no sense (e.g. you cannot change
the file size in the MediaBay, because you have no way of adding or removing media information).

2. Click on the Add Tag button.
The Add User Tag dialog opens.

3. Enter a name for the new tag and define its type.
Tags can be of type “Text”, “Number” or “Yes/No” switch.

• For tags of type “Number”, you can also specify how
many decimals should be displayed after a decimal point.
Enter the corresponding value in the Precision field.
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4. Click OK.

Viewer operations

The new tag is added to the list of available tags and can be displayed in
the Tag Editor and the Viewer.

• You can move/copy a file from the Viewer section to a
different location by clicking and dragging it to a different
folder in the Browser section.

• To remove a user tag, select it in the Tags list and click
the Remove Tag button.

You will be asked if you wish to copy or move the file to the new location.

The tag will be removed from all tag lists in which it was previously displayed.

• To insert a file into the project, right-click the file and select one of the “Insert into project” options from the context menu.

Media management

This will import this file into your current project, either at the start of the
project or at the current cursor position.

General handling

• To delete a file, right-click on it in the Viewer and select
“Delete” from the context menu.

• You can use the [Tab] key on your computer keyboard
to move the focus between the different sections of the
MediaBay window. Use the arrow keys to navigate to different folders, files or tags.

A warning message is displayed, asking you to confirm that you really
want to move this file to the operating system’s trash folder.

• When the option “Allow Editing in Viewer” is activated
in the Preferences dialog–MediaBay page, you can also
edit tags in the Viewer.

• When assigning tag values, note that you can select
several files and assign the same tag value to all files.

Otherwise this is possible only in the Tag Editor.

File management

Tagging media files

You can use the MediaBay for various file management
tasks, similar to what you can do in the Windows Explorer/
Mac OS Finder.

The search functions, especially the Category search
mode, become a truly powerful media management tool
when making extensive use of tagging.

• When the option “Show file extensions” is activated in
the Preferences dialog (MediaBay page), file name extensions (e.g. “.wav” or “.cpr”) will be displayed in the MediaBay. When this is deactivated, file extensions will not be
shown.

Media files are usually organized in complex folder structures to provide a logical way of guiding the user to the
desired files, with the folder and/or file names indicating
the instrument, style, tempo etc.
To find a particular sound or loop in such a folder structure
can be very time consuming – tagging is the answer! To
assign a number of meaningful tags, e.g. to a library of
loop files, proceed as follows:

Browser operations
The following tasks can be performed in the Browser section:
• To delete a folder, right-click on the folder icon and select “Delete from Disk” from the context menu.

1. Copy the loop files to your hard disk.

A warning message is displayed, asking you to confirm that you really
want to move this folder to the operating system’s trash folder.

2. Open the MediaBay and browse to where the new
loops are located.

Tagging means editing the files, so you need them on your system.

• To rename a folder, select it in the list, click on its name
and enter a new name.

3. Navigate to a folder containing loops.
For example, you might have a folder containing Metal style drum loops,
at 120bpm.

• You can drag & drop a folder to a different location.
You will be asked if you wish to copy or move the folder to the new
location.

4. In the Viewer, select all files contained in this folder.
Make sure that the Deep Results button is deactivated, so that only files
contained in this folder are displayed.
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5. Assign tags that reflect the information indicated by
the folder structure.
In the above example, you would put “Metal” as a value for the Style tag,
and “Drums” for the Instrument tag. The Tag Editor also allows you to
display a “Tempo” tag, for which you could specify a value of “120”.

You can now use the Category search mode to find quickly
all Metal style drum loops at 120bpm, without the need to
navigate through a large number of folders and subfolders.
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Track Presets

Introduction

Audio track presets

Track presets are templates that you can create from audio, MIDI or instrument tracks – or several of these tracks.
With these track presets, you can then create new tracks
or apply them to existing tracks of the same type.

Track presets for audio tracks include all inserts and effects that “define” the sound. Since there are big differences between the typical settings for a trumpet and a
human voice, for example, audio track presets are a quick
way to optimize your track.

The idea behind track presets is:

For example, you can:

• To allow you to quickly access, browse, select, change
and preview sounds.

• Easily audition your audio track with the factory presets.
• Use the factory presets as a starting point for your own
editing.

• To give you an easy way to reuse channel settings
across projects.

• Save the audio settings that you optimized for an artist
with which you often work and use the resulting audio
track preset for future recordings.

Track presets are part of the VST Sound concept (see
“VST Sound” on page 311) and organized in the Sound
Browser (a view of the MediaBay, see “The MediaBay” on
page 314). This allows you to categorize track presets
with tags like “EPiano” or “Jazz” and search for these tags.

Data saved in audio track presets
•
•
•
•

Related topics
Nuendo offers a variety of related functions that allow you
to handle presets of program settings:

Insert FX settings
EQ settings (including VST effect presets)
Volume + Pan
Input Gain + Phase

Ö Note that volume, pan, input gain and input phase will
be restored only when creating a new track from a track
preset.

• You can save and load channel settings in the mixer (not
for MIDI), see “Saving mixer settings” on page 146.
• You can save and load inserts rack and EQ presets, see
“Inserts and EQ settings from track presets” on page 337.

Instrument track presets

• You can export and import tracks as track archives , see
“Exporting and importing tracks” on page 500.

Instrument track presets are best choice when handling
sounds of simple, mono-timbral VST Instruments. Like the
instrument track, they offer both MIDI and audio features.

Types of track presets

• You can use instrument track presets like the audio
track presets above for auditioning your tracks, inspiration,
or saving your preferred sound settings.

There are four kinds of track presets:
• Audio

• In addition, you can directly extract sounds from instrument track presets and VST presets for use in instrument
tracks.

• Instrument (this also includes certain VST3 presets, see
“VST (Instrument) presets” on page 330)

VST presets also behave like instrument track presets,
see “VST (Instrument) presets” on page 330.

• MIDI
• Multi (any number of the three preset types above in any
sequence)
Since the purpose of track presets is to make sound
handling easier, only parameters are saved that are relevant for the sound of a certain track.
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Ö The choice is exclusive – you can either save the
channel or the patch, but not both.

Data saved in instrument track presets
•
•
•
•
•
•
•
•

Audio Insert FX
Audio EQ
Audio Volume + Pan
Audio Input Gain + Phase
MIDI Insert FX
MIDI Track Parameters
Input Transformer
VST Instrument

Example 1: Multi-timbral external instrument
Assume you have a multi-timbral external instrument (for
example, a MIDI Expander), with all sounds available on all
channels, but the sounds (patches) might change.
In this case, set it up as an external instrument, open a
MIDI track and select it as output. In the Programs List,
select a patch. Then save the MIDI track preset with the
patch included.

And also:
• Staff settings
• Color settings

Example 2: Multi-timbral external instrument with preconfigured setup

Ö Volume, pan, input gain and input phase will be restored only when creating a new track from a track preset.

In a rarer case we have a multi-timbral external instrument
(for example, a Sampler) which is completely pre-configured. There is no sound (patch) to configure, but only the
device and the MIDI channel to know.

MIDI track presets
MIDI tracks offer more possibilities than instrument tracks;
therefore, they should be used for multi-timbral VST Instruments and external instruments.

In this case, include the channel in the MIDI track preset
so that the correct channel will be called up.

Due to the resulting complex settings, more details have
to be taken into account when working with MIDI track
presets, to ensure that the saved settings are really usable
as presets for new tracks.

Example 3: VSTi as pre-configured setup
If you want to use a MIDI track preset for a pre-configured
VST Instrument setup, the following conditions have to be
met:

• To ensure that saved MIDI track presets for external instruments will work again with the same instrument later,
install the instrument as MIDI device, because in this case
the MIDI interface and the connecting ports are irrelevant.
(For this to work, the MIDI device has to have exactly the
same name as in the original setup.) For more information
about this, see the separate pdf document “MIDI Devices”.

• The VST Instrument(s) are installed in the VST Instruments
window.
• The VST Instrument patches have not been changed since the
track preset was saved (that means for example that no other
FXP/FXB was installed in the meantime).
To ensure this, use a template project with the VSTi setup
included and put the sounds (track presets) of this template project into specific subfolders, as they only work
within this setup.

Include MIDI Channel or MIDI Patch
There is an additional Include option when creating MIDI
track presets:
• Choose “MIDI Patch” if you want to save the MIDI track
preset with the currently set patch. This is useful if your external MIDI device offers sounds as certain patches but
does not require any specific channel settings.
• Choose “MIDI Channel” if you want to save the MIDI
track preset with the currently set channel. This is useful if
you have the sounds of an external device always on the
same channel, e.g. strings on channel 12, trumpets on
channel 13.
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VST presets

Data saved in MIDI track presets
•
•
•
•
•

MIDI Modifiers (Transpose etc.)
MIDI Inserts (FX)
Output + Channel or Program Change
Input Transformer
Volume + Pan

As of VST3, VST presets make it easy for you to work with
VST plug-ins and instruments, substituting the .fxp and
.fxb files of the VST2 standard.
There are two kinds of VST presets:

And also:

• VST presets based on effect plug-ins
• VST presets based on VST Instrument plug-ins

• Staff settings
• Color settings

Ö In this manual, the wording “VST presets” stands for
VST3 Instrument presets, unless stated otherwise.

Ö Note that volume and pan will be restored only when
creating a new track from a track preset.

VST effect plug-in presets
VST effect plug-ins are available in VST3 and VST2 format, for example as insert effects like Expander or Limiter.
Therefore, VST effect presets can be part of audio track
presets, see also “VST Sound” on page 311.

Multi track presets
If you select more than one track when creating a track
preset, the settings of all selected tracks will be saved as
one multi track preset. Since you can apply a multi track
preset only if the target tracks are of the same type, number and sequence as the tracks in the track preset, multi
track presets are useful when you have a reoccurring situation with very similar tracks and settings.

VST (Instrument) presets

For example, this would be the case for:

VST3 (Instrument) presets (extension .vstpreset) are media files that can be managed in the Sound Browser and
to which you can assign tags. VST presets are also listed
in dialogs like the “Add Track” dialog, see below.

• Recording setups that require several microphones,
e.g. when recording a drum set or a choir, where you
record always under the same conditions and have to edit
the resulting tracks in a similar way.

The VST presets behave like instrument track presets in
the context of the Project window and contain a VST Instrument and its settings but no modifiers, MIDI inserts, inserts or EQ settings:

• Layered tracks, where you use several tracks to generate a certain sound instead of manipulating only one track.

• You can create instrument tracks from VST presets just
like from instrument track presets, see “Creating tracks
from track presets or VST presets” on page 333.

Data saved in multi track presets

In the Inspector of the new instrument track, the VST Instrument, the selected program and the name of the applied VST preset are displayed.

For each track type, the respective track preset parameters are saved in the same sequence as the tracks in the
Project window.

• You can apply VST presets to instrument tracks just like
instrument track presets, see “Applying audio, MIDI and
instrument track presets” on page 334.
• When selecting VST presets in the Browse presets
section or the Sound Browser, you can preview them like
instrument track presets, see “Creating tracks from track
presets or VST presets” on page 333.
• Like with instrument tracks presets, you can extract the
“sound” of VST presets, see “Extracting sound from an instrument track or VST preset” on page 335.

330
Track Presets

The programs of VST2 plug-ins also can be converted to
VST3 presets. For more information about plug-ins,
please refer to the separate manual “Nuendo Expansion
Kit – Cubase Music Tools for Nuendo 4”.

Browse Presets section
When you create a new track, the Add Track dialog opens:

Browsing for presets
Using the Sound Browser
When browsing track presets, the quickest way is to use
the Sound Browser, as it is set up specifically to display
track and VST presets.

The “Add MIDI Track” dialog.

To open this browser, select “Open Sound Browser” on
the Media menu.

(For a more detailed description of the Add Track dialog,
see “Handling tracks” on page 38.)
Click “Browse Presets...” to open the Browse Presets
section with the Category search and a list of all available
presets. For details, see “Performing a Category search”
on page 320.

The Sound Browser.

In the Sound Browser, you can preview track and VST
presets as well as select them to drag and drop them into
the project to create new tracks (see “Creating tracks
from track presets or VST presets” on page 333) or to apply them to existing tracks (see “Applying audio, MIDI and
instrument track presets” on page 334).

The Add Track dialog with the Browse Presets section opened.

The general handling of the Sound Browser is the same
as for the MediaBay, see “The MediaBay” on page 314.

Dialogs related to VST Sound
When you work with track presets, you will find the same
user interface in all “Add Track” and “Browse Sounds” dialogs and the Presets browser.
Ö Note that some of the dialogs will save their last state.
They may therefore not look exactly like the dialogs described below.
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Browser section

The Presets browser

In addition to the Browse Presets section, you can click
“Show Location” to open the Browser section. It is similar
to the one in the MediaBay (see “Browsing for media files”
on page 316), but only necessary if you want to take an
explicit look at the contents of Presets subfolders, as you
can’t move up to other folders.

When you apply a track or VST preset to an existing track
or when you extract a sound, the Presets browser opens,
allowing you e.g. to preview the presets.

The Presets browser for an audio track preset.

The Browse Sounds dialog
Normally, the view of the Browse Presets section is filtered to show only track presets of a certain kind. Therefore, if you want to see all available presets, e.g. also multi
track and VST presets, you can open the Browse Sounds
dialog.

The Add Track dialog for a MIDI track with all sections open.

When you select a MIDI or instrument track preset (or a
VST preset), you can see a preview section below the list.
The preview works like the one in the Scope section in the
MediaBay (see “Previewing MIDI, instrument and VST
presets independently of tracks” on page 336).

Browse Sounds dialog showing all available track and VST presets.
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Creating a track preset

Track presets are saved in the “Track Presets” folder in
default subfolders named according to their track type
(audio, MIDI, instrument and multi). For further information,
see “Where are the settings stored?” on page 514.

A track preset is created from an existing audio, MIDI or
instrument track – or several of these tracks. Proceed as
follows:

!

1. Select one or more tracks in the Project window.
If several are selected, all of them are stored in one combined multi track
preset, see “Multi track presets” on page 330.

You cannot change the default folders, but you can
add further subfolders, e.g. “drums” and “choir”.

All presets are available under the (virtual) VST Sound
node, see “The VST Sound node” on page 318.

2. Right-click one of the selected tracks in the track list to
open the context menu and select “Create Track Preset”.

Creating tracks from track presets
or VST presets

The Save Track Preset dialog opens. The buttons on top work like the corresponding ones in the MediaBay, see “Folder operations” on page 318.

Creating tracks via drag and drop
1. Open the Sound Browser.
You can also drag and drop from the Windows Explorer or the Mac OS
Finder, but in this case, no preview for MIDI and instrument track presets
is possible.

2. Select a track or VST preset from the list of all presets.
At this point you can preview selected MIDI and instrument track presets
as well as VST presets, see “Previewing MIDI, instrument and VST presets independently of tracks” on page 336.

3. Drag and drop the track preset onto the track list in the
Project window.
One or more (in case of multi track presets) tracks will be created. If you
drag and drop a VST instrument preset, this will result in an instrument
track.

3. Enter a file name in the “File Name” field.
The track preset file name extension .trackpreset is assigned automatically.

Creating tracks in the Browse Sounds dialog

In the case of MIDI files, you have the additional option of
including the MIDI channel or the MIDI patch, see “Include
MIDI Channel or MIDI Patch” on page 329.

1. Right-click the track list to open the context menu and,
on the Add Track submenu, select “Browse Sounds…”.
The Browse Sounds dialog opens.

4. If you want to apply tags, click on “Tag Editor”.

2. Select a track or VST preset from the list of all presets.

The available tags are displayed (on how to edit the list of available tags,
see “Managing the tag lists” on page 323). To enter a value, click in the
value field. For many tags, e.g. “Character” and “Style”, pop-up menus
open in which you can select an entry. In case of a free text entry, enter
the text in the text field. For more information about the Tag Editor, see
“Editing tags in the Tag Editor” on page 324.

At this point you can preview selected MIDI and instrument track presets
as well as VST presets, see “Previewing MIDI, instrument and VST presets independently of tracks” on page 336. If you want to list a certain
track preset type only, open the respective folder in the Browser section.

3. Click OK to create one or more (in case of multi track
presets) tracks.

Ö As the category search is based on the tags, we highly
recommend that you use them.
5. Click OK to create the track preset.
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Applying track presets

Creating one or more audio, MIDI or instrument
tracks with the Add Track function

Track presets can be applied to tracks of their own type
only, i.e. audio track presets to audio tracks, etc.

1. To create one or more new tracks from a track preset,
proceed as if adding a new track by selecting the corresponding option on the context menu (or by using the key
command).

When you apply a track preset, all saved settings are applied, see “Types of track presets” on page 328.

A dialog opens, in this example the “Add Audio track” dialog:

• For instrument tracks, VST presets are also available.
Since VST presets have no modifiers, MIDI inserts, inserts
or EQs, applying them leads to removal of your current
settings for these, see “Inserts and EQ settings from track
presets” on page 337.

Applying audio, MIDI and instrument track
presets
• If you want to create more than one track of this type,
enter the number in the Count field.

Applying track or VST presets via drag and drop

2. Click “Browse Presets” to open the Browse Presets
section of the “Add Track” dialog.

You can also drag and drop from the Windows Explorer or the Mac OS
Finder, but in this case, no preview for track presets is possible.

The view is filtered to show only the corresponding track presets, e.g. if
you choose “Add Audio Track”, only audio track presets will be displayed.

2. Select a track or VST preset.

1. Open the Sound Browser from the Media menu.

At this point, you can preview selected presets, see “Previewing track or
VST presets before applying” on page 336.

3. Select a track or VST preset.
At this point, you can preview selected MIDI and instrument track presets
as well as VST presets, see “Previewing MIDI, instrument and VST presets independently of tracks” on page 336.

3. Drag and drop it onto a track of the same type.
Applying track or VST presets in the Inspector or the
context menu of the track

4. Click OK to create the track(s).
The new track(s) will be named after the original track (not the track preset).

Proceed as follows:
1. Select a track in the Project window.

Ö As adding multiple tracks is not available as menu option, multi track presets can only be used for track creation
via drag and drop or the “Browse Sounds” dialog.

2. Click the VST Sound button in the Inspector or rightclick the track to open the context menu and select “Apply
Track Preset”.

Click here to open the Presets browser.

In both cases, the Presets browser opens. Here, the files
are sorted by categories.
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Ö Once the track preset is applied, you cannot undo the
changes!

3. Select a track or VST preset from the list to the right.

Reloading track or VST presets
To revert to the default settings of the applied preset, click
the “Reload Track Preset” button.

Applying another track or VST preset
To apply another track or VST preset, open the Presets
browser as described above and select another preset.

At this point you can preview selected presets, see “Previewing track or VST presets before applying” on page 336.

Removing a track or VST preset from a track

4. Click outside the browser to apply the selected preset
or click the Reset button below the list to return to the unchanged track.

It is not possible to remove an applied preset from a track
and return to the previous state. If you are unsatisfied with
the track settings, you can either edit the settings manually
or apply another preset.

Ö Once the track preset is applied, you cannot undo the
changes!

Extracting sound from an instrument track or
VST preset

In the Inspector, you can see which preset was applied
last, in this example “Jazz Bazz”.

For instrument tracks, you can extract the “sound” of an
instrument track preset or VST preset, that means the VST
Instrument and its settings.
Proceed as follows:
1. Select the instrument track to which you want to apply
a sound.

Applying a multi track preset
To be able to apply a multi track preset, certain requirements have to be met. Proceed as follows:

2. Click the VST Sound button below the Output Routing field in the Inspector.

1. Select several tracks in your project.
The selected tracks have to be of the same type, number and sequence
as the tracks in the track preset.

2. Right-click the track to open the context menu and select “Apply Track Preset”.
The Presets browser opens. Only multi track presets corresponding to
the selection of tracks in the project will be shown.

The Presets browser opens, showing a list of all available
presets.

3. Select a multi track preset from the list.
4. Click outside the browser to apply the selected preset
or click the Reset button below the list to return to the unchanged track.
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3. Select an instrument track preset or VST preset and
click OK.
The VST instrument and its settings (but no inserts, EQs and modifiers)
of the existing track are overwritten with the data of the track preset. The
previous VST instrument for this instrument track is removed and the new
VST instrument with its settings is set up for the instrument track. Note
that the VST instrument of an instrument track does not show up in the
VST Instrument window but only in the Plug-In Information window, see
the separate manual “Nuendo Expansion Kit – Cubase Music Tools for
Nuendo 4”.
Track-independent preview, for example a VST preset in the “Browse
Sounds” dialog.

Previewing track and VST presets

Two preview options are available:

You can preview all types of track and VST presets except
for multi track presets.

Previewing with standard MIDI input
1. Click the MIDI Input button.

Previewing track or VST presets before
applying

2. Play some MIDI notes via your MIDI input device, for
example a keyboard.

When you apply a track preset to an existing track, the
corresponding dialog opens. Here you can preview the
track presets before applying them permanently. This
works for audio, MIDI and instrument track presets as well
as for VST presets.

The Activity meter on the far right mirrors the MIDI in activity.

You can use this preview for listening to the changes in
the output in real time. Proceed as follows:

Previewing using a MIDI file

1. Set your target track to cycle and play back the loop.

A file dialog opens.

2. Select a track preset in the list.

2. Select a MIDI file (.mid) to be played back with the
track or VST preset applied and click OK.

3. Hit the Play button on the Transport panel to listen to
the track with all settings from the track preset applied to it.

3. Click the MIDI Input button.

Ö For this to work, “In All Inputs” has to be activated for
your MIDI input device (this is the default setting), as only
MIDI data incoming via “All MIDI Inputs” is used for preview.

1. Click the Choose MIDI File button.

The Play button will become available.

4. Click outside the browser to apply the selected preset
or click the Reset button below the list to return to the unchanged track.

4. Click “Play”.
The program applies the track or VST preset to the MIDI file.

• In the Browse Sounds dialog, clicking OK will create a
new track (see “Creating tracks in the Browse Sounds dialog” on page 333).

Previewing MIDI, instrument and VST presets
independently of tracks

Ö The MIDI file selection is not saved when closing the
dialogs or the Sound Browser. Therefore, you have to select a new file the next time you want to preview a preset
using a MIDI file.

You can also preview MIDI and instrument track presets
as well as VST presets in the Sound Browser or in dialogs
with the Browse Presets section open.
For example, when you open the “Browse Sounds” dialog
and select a MIDI or instrument track preset or a VST preset, preview buttons appear on the lower right. (In the
Sound Browser, the preview buttons appear in the Scope
section.)
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Inserts and EQ settings from track
presets
Instead of handling complete track presets, it is also possible to apply settings for Inserts or Equalizers from track
presets.
This can be done via the Inspector or via the Channel settings window.
• In the Inspector, select e.g. an Instrument track and
click the VST Sound button on the Inserts or Equalizers
tab to open the presets pop-up menu. There, select the
option “From Track Preset…”.

• In the Channel Settings window for a MIDI track, instrument track or audio channel track (opened by clicking the
“e” button in the Inspector), click on the VST Sound button in the Inserts section and select “From Track Preset…” in the pop-up menu.

The Presets browser opens, showing all available track
presets that contain Inserts or EQ settings. Select the
track preset whose Inserts or EQs you want to apply and
click outside the browser.
• For information on the general handling of Inserts presets, see the separate manual “Nuendo Expansion Kit –
Cubase Music Tools for Nuendo 4”.
• For information on the general handling of EQ presets,
see “Using EQ presets” on page 140.
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Track Quick Controls

Introduction

Assigning parameters to quick controls
The opened Quick Controls tab shows eight slots, one for
each quick control. To start with, these slots are empty.
Proceed as follows to assign track parameters to the
quick control slots:

Nuendo can give you instant access to up to eight parameters of each audio track, MIDI track or instrument track.
This is done with the aid of the so-called quick controls,
set up on the Quick Controls Inspector tab for these
tracks.

1. In the Quick Controls tab, click on the first quick control slot.

The Quick Controls tab can be used as a kind of track
control center, an area in which your most important parameters are assembled in one place. This saves you from
having to click your way through the various windows and
sections pertaining to your track.

A context menu is opened. This context menu lists all parameters currently accessible for this particular track.

Also, Nuendo allows you to assign these quick controls
very quickly to an external remote control device. This
gives you manual control of your most important track parameters.

Setting up the Quick Controls tab
2. Double-click the parameter that you want to assign to
the first quick control slot.

The Quick Controls tab in the track Inspector is available
for all audio tracks, MIDI tracks and Instrument tracks. It is
displayed by default.

The parameter name and its value are displayed in the slot. You can
change the value by dragging the quick control’s slider.

The track’s main volume parameter is assigned to quick control 1.

You can now repeat these steps for each quick control
slot until all eight slots are associated with track parameters!
Renaming a quick control
By default, the parameter name as listed in the browser
pop-up menu for available track parameters is displayed in
the quick control slot.
The Quick Controls tab in the Inspector.

• To rename a quick control, simply double-click on the
name in the slot to select it, enter a new name and press
[Enter].
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Replacing a quick control assignment

2. Hold down the [Ctrl]/[Command] key and click on the
slot for quick control 1.

• To replace a parameter assignment with a different parameter, click on the corresponding quick control slot and
double-click on a different parameter in the browser popup menu list.

The parameter selection context menu is opened, but it lists not the parameters of the current track, but all automatable parameters.

The parameter assignment in this slot is changed.

Removing a quick control assignment
To remove a parameter from a slot, you have the following
possibilities:
• Double-click the parameter name to select it and press
the [Delete] or [Backspace] key. Confirm this operation by
pressing [Enter].

3. Click the + sign in the list to open the VST Mixer folder.

• Click in the corresponding slot and select “No parameter” from the browser pop-up menu.
The parameter assignment is removed, and the quick control slot is empty.

Options and settings

The pop-up lists all channels available in the mixer of your
current project.

• Quick control assignments are saved with the current
project.

4. Now assign a parameter of one particular channel to
quick control 1, and another parameter of another channel
to quick control 2.

• Since quick control settings are part of the track setup,
you can save them as track presets, allowing you to re-use
your settings across different projects.
Track presets are described in the chapter “Track Presets” on page 327.

• You can automate all parameter settings on the Quick
Controls tab using the Read/Write Enable buttons (R and
W) at the top right.
The automation features of Nuendo are described in detail in the chapter
“Automation” on page 213.

Quick controls and automatable parameters
The quick controls feature has one special extension that
should be used with caution: you can use quick controls
not only to access certain parameters of the current track,
but also to control all automatable parameters.

Here, quick controls 1-5 have been set up to control the main volume of
five audio tracks.

The Quick Controls tab has become a “secondary” mixer,
dedicated to quick-controlling parameters on other tracks.

This makes it possible to use the Quick Controls tab of a
dedicated track as a kind of “mini mixer”, controlling parameters on other tracks. Proceed as follows:

!

Quick controls that are assigned that way cannot
work when saved as track presets.

1. Create a new, empty audio track and open its Quick
Controls tab.
This track has no events or parts.
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Setting up quick controls on an
external remote controller

7. In the Device Setup dialog, click the Learn button.

Quick controls become really powerful when used in combination with a remote controller.
Setting up the connection between the slots on the Quick
Controls Inspector tab and a remote control device is
easy. Proceed as follows:

8. Repeat the last 3 steps for the other quick controls.
You have now associated the slots on the Quick Control
tab with control elements on your external remote controller. Moving a control element will automatically change the
value of the parameter assigned to the corresponding
quick control.

1. In Nuendo, open the Device Setup dialog from the Devices menu.
2. In the Devices list on the left, select the Quick Controls option.

• The remote controller setup for quick controls is saved
globally, i.e. independent of any projects.
If you have various remote controllers, you can store and load several
quick control setups using the Export and Import buttons.

This will open the Quick Controls section on the right of
the dialog:

3. With your remote controller device connected to Nuendo via MIDI, select the corresponding MIDI port on your
computer in the MIDI Input pop-up (or select “All MIDI Inputs”).
If your remote controller has its own MIDI input and supports MIDI feedback, you can connect your computer to the device input. Then, select
the corresponding MIDI port in the MIDI Output pop-up.

4. Click “Apply” to apply your settings.
5. Select “QuickControl1” in the “Control Name” column.
6. Move the control (knob, fader or other) on your remote
control device that you want to use for the first quick control.
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MIDI realtime parameters and effects

Introduction
For each MIDI track, you can set up a number of track parameters, or modifiers, and MIDI effects. These affect how
the MIDI data is played back, “transforming” MIDI events
in real time before they are sent to the MIDI outputs.
On the following pages, the available parameters and effects are described. Keep in mind:
• The actual MIDI events will not be affected – the changes
happen “on the fly”.
• Since the modifier settings don’t change the actual MIDI data
on the track, they will not be reflected in the MIDI editors. To
convert the track settings to “real” MIDI events, use the Freeze
MIDI Modifiers function or the Merge MIDI in Loop function
(see “Making your settings permanent” on page 357).

The Inspector – General handling

The Inspector for a MIDI track.

Ö Folding or hiding (via the Setup dialog) a section does
not affect the functionality but merely hides the section
from view.

The MIDI modifiers and effects are set up in the Inspector
(although some settings are available in the mixer as well).
Here’s a brief rundown on how to handle the Inspector:

This means your settings will still be active even if you fold or hide the Inspector settings.

• To show or hide the Inspector, click the Inspector icon
on the Project window toolbar.

• For a MIDI track, up to nine sections are available.
Which of these sections are displayed in the Inspector is
determined in the setup context menu or the Setup dialog
of the Inspector.
For information about setting up the Inspector, see “The Setup dialogs”
on page 506.

• You can fold or unfold the sections individually by clicking on the section name.
Clicking the name for a hidden section brings it to view and hides the
other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or
show a section without affecting other sections. Finally, [Alt]/[Option]clicking a tab shows or hides all sections in the Inspector.
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Basic track settings
The topmost Inspector section contains the basic settings
for the selected MIDI track.

These are settings that either affect the basic functionality
for the track (mute, solo, enable record, etc.) or send out
additional MIDI data to the connected devices (program
change, volume, etc.). The section contains all settings in
the Track list (see “The Track list” on page 25), with a few
additional parameters:
Parameter

Description

Track name
field

Click once to show/hide the topmost Inspector section.
Double-click to rename the track.

Edit button

This opens the Channel Settings window for the track (a
window showing a channel strip with volume fader and
other controls, along with effect settings – see “Using
Channel Settings” on page 137).

Mute/Solo
buttons

Mutes or solos the MIDI track.

Read/Write
buttons

Used for automating the track settings – see “Enabling
and disabling the writing of automation data” on page
214.

Open Device
Panels button

If the MIDI track is routed to a device with a panel, clicking this button opens the respective panel. For more information, see the separate PDF document “MIDI
Devices”.

Input transformer button

Opens the Input Transformer dialog, allowing you to
transform incoming MIDI events in real time, see “The Input Transformer” on page 397.

Record enable
button

Activate this to make the track ready for recording.

Monitor button

When this is activated (and the option “MIDI Thru Active”
is activated in the Preferences–MIDI page), incoming
MIDI will be routed to the selected MIDI output.

Parameter

Description

Toggle Timebase button

Switches between musical (tempo related) and linear
(time related) time base for the track. See “Switching
between musical and linear time base” on page 40.

Lock button

Activate this to disable all editing of all events on the
track.

Lane Display
Type button

Allows you to divide the tracks in lanes. For more about
lanes, see “Recording audio in Stacked mode” on page
75.

Volume

Use this to adjust the level for the track. Changing this
setting will move the track’s fader in the mixer window,
and vice versa. See “Setting volume in the mixer” on page
132 for more about setting levels.

Pan

Use this to adjust the panning of the track.

Delay

This adjusts the playback timing of the MIDI track. Positive values delay the playback while negative values
cause the track to play earlier. The values are set in milliseconds.

In/Out/Chn
pop-ups

This is where you select MIDI input, MIDI output and MIDI
channel for the track.

Edit Instrument If the MIDI track is routed to a VST instrument, clicking
button
this button opens the control panel for the VST instrument.
Bank and Patch Allows you to select a sound, see below. (If no bank is
Selector pop-up available, only the Patch selector is shown.)
Apply Track
Preset button

Allows you to apply a track preset, see “Applying track
presets” on page 334.

Ö Note that the functionality of the Bank and Patch selector settings (used for selecting sounds in the connected MIDI instrument) depends on the instrument to
which the MIDI output is routed, and how you have set it
up in the MIDI Device Manager.
The MIDI Device Manager allows you to specify which MIDI instruments
and other devices are connected to the various MIDI outputs, thus making it possible to select patches by name. See the separate PDF document “MIDI Devices” for details about the MIDI Device Manager.

Ö Many of the basic track settings are duplicated in
“mixer channel strip form” in the MIDI Fader section of the
Inspector (see below).
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Other Inspector sections

New sub-panels will also be added in the following cases:

Apart from the basic track settings (see above), the MIDI
Modifiers (see “MIDI Modifiers” on page 346) and the effect sections (see “MIDI effects” on page 348), the Inspector for a MIDI track also contains the following sections:

• When a MIDI track is routed to an external instrument or effect
that has an associated MIDI Device. In this case, the new subpanel will get the name of the device.
• When a MIDI track is routed to an effect plug-in that also receives audio data, i.e. that is used as an insert effect for an audio track (e.g. MIDI Gate), a sub-panel for this audio track
appears in the MIDI track inspector.
• If a MIDI track is routed to a plug-in assigned to a FX Channel
track, a corresponding FX sub-panel is added to the Inspector.

The MIDI Fader section
This contains a single channel strip, allowing you to set
volume, pan, mute/solo and other parameters for the track,
and a panel view of the active sends/inserts. This is a “mirror” of the track’s channel strip in the Nuendo mixer – see
“The MIDI channel strips” on page 131.

Ö For an easy way to combine MIDI and VST instruments,
check out instrument tracks (see “VST Instruments and Instrument tracks” on page 189).

The Notepad section
This is a standard notepad, allowing you to enter notes
and comments about the track. Each track has its own
notepad in the Inspector.

User Panel section
This allows you to display MIDI device panels, which are
control panels for external hardware. This is described in
the separate PDF document “MIDI Devices”.

The Network section
This contains controls related to Nuendo’s Network functions. See the Networking pdf document for information.

Quick Controls section
This allows you to configure quick controls, e.g. to use remote devices. See the chapter “Track Quick Controls” on
page 338.

VST Instrument section
If the MIDI track is routed to a VST Instrument, a new subpanel will appear at the bottom of the Inspector, labeled
with the name of the VST instrument. Clicking this section
shows a duplicate of the Inspector settings for the VST Instrument channel. This makes it easy to adjust the channel
settings for the VST Instrument while you are editing the
MIDI track.

• If the VST Instrument has multiple outputs (and thus
several mixer channels), there will be a setting called
“Output” at the top of the VST Instrument section.
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MIDI Modifiers

Velocity Shift
This setting lets you change the dynamics of all notes on
the track. The value in this field is added to the velocity of
each note message that is sent out (use negative values to
lower the velocities). The range is -127 to +127 with 0
representing no change in velocity.
Note that the effect of changing the velocity depends on
the sound and instrument.
Ö You can also adjust the velocity of events in individual
MIDI parts using the Velocity field in the info line.
The velocity shift in the info line (for the individual part) is added to the
velocity shift you have set up for the whole track in the Inspector.

The following settings will affect the MIDI events on the
track in real time during playback. They will also be in effect if you play “live” with the track selected and record
enabled (provided that “MIDI Thru Active” is activated on
the Preferences–MIDI page). This makes it possible to e.g.
transpose or adjust the velocity of your live playing.

Velocity Compression
This function multiplies the velocity values with the factor
you specify. This factor is set using a numerator (left value)
and a denominator (right value), resulting in a fractional
number (1/2, 3/4, 3/2 etc.). For example, if you set the
factor to 3/4, the velocities will be three quarters of their
original values. This will also affect the difference in velocity between the notes, thus compressing or expanding the
velocity scale. Typically, you would combine this setting
with the Velocity Shift parameter. An example:

Ö If you want to compare the result of your modifier settings with the “unprocessed” MIDI, you can use the Bypass button in the MIDI Modifiers section.
When this is activated, the MIDI Modifiers settings will be temporarily
disabled. A bypassed section is indicated by a yellow Bypass button.

Let’s say you have three notes with the velocity values 60,
90 and 120, and wish to “even out” the velocity differences somewhat. If you set the Velocity Compression
value to 1/2, the notes will play back with the velocities
30, 45 and 60. By adding 60 in the Velocity Shift field, the
notes will play back with the velocities 90, 105 and 120,
meaning you have compressed the velocity range.

Transpose
This allows you to transpose all notes on the track in semitones. The available range is -127 to +127 semitones, but
remember that the total range of MIDI note numbers is 0
to 127. Furthermore, not all instruments can play back
notes over the whole range. Therefore, extreme transpositions can give rather strange and unwanted results.

In a similar way, you can use Velocity Compression values
greater than 1/1 together with negative values in the Velocity Shift field, to expand the velocity range.
!

• You can also transpose individual MIDI parts using the
Transpose field in the info line.

Remember that the maximum velocity is always 127
no matter how much you try to expand.

Length Compression

The transposition in the info line (for the individual part) is added to the
transpose value you have set up for the whole track in the Inspector.

This value adjusts the lengths of all notes on the track. As
with Velocity Compression, the value is set with a numerator and denominator. For example, the value 2/1 means
that all note lengths will be doubled, while 1/4 means all
note lengths will be a quarter of the actual lengths.

Ö This setting is also affected by the global Transpose
settings. For detailed information, see the chapter “The
Transpose functions” on page 114.
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Random

Range

The Random settings let you introduce random variations
to various properties of MIDI notes. Anything from very
subtle variations to dramatic changes can be applied.
There are two separate “random generators”, set up in the
following way:

The Range function lets you specify a note (pitch) or velocity range and either force all notes to fit within this
range, or exclude all notes outside this range from playback. As with the Random function, there are two separate Range settings. Set them up as follows:

1. Pull down the Random pop-up menu and select which
note property should be randomized.

1. Pull down the Range pop-up menu and select one of
the following four modes:

The options are position, pitch, velocity and length.

Ö Keep in mind that depending on the content of the
track, certain parameter changes might not be immediately noticeable or have any effect at all (as would be the
case if applying random length to a percussion track playing “one-shot” samples for example).
To best audition the random changes, choose a track with clearly defined
rhythm and note content (as opposed to a string pad).

Mode

Description

Vel. Limit

This function affects all velocity values outside the specified range. Velocity values below the Min setting (the
lower limit of the range) are set to the Min value, and velocity values above the Max setting are set to the Max
value. Notes with velocity values within the set range are
not affected. Use this if you want to force all velocity values to fit within a certain range.

Vel. Filter

Velocity Filter works by excluding all notes with velocity
values outside the specified range. Notes with velocity
values below the Min setting or above the Max setting will
not be played back. Use this to “isolate” notes with certain velocity values.

Note Limit

This function allows you to specify a pitch range, and
forces all notes to fit within this range. Notes outside the
specified range are transposed up or down in octave
steps until they fit within the range.
Note: If the range is too “narrow”, so that some notes
cannot be fit within the range by octave-transposing,
these notes will get a pitch in the middle of the range. For
example, if you have a note with a pitch of F3, and the
range is C4-E4, that note will be transposed to D4.

Note Filter

Note Filter works by excluding all notes with pitches outside the specified range. Notes lower than the Min setting or higher than the Max setting will not be played
back. Use this to “isolate” notes with certain pitches.

2. Set the desired range of random deviation by entering
values in the two number fields.
The two values govern the limits of the randomization, so that the values
will vary between the left value and the right value (you cannot set the left
value higher than the right value). The maximum random range for each
property is listed in the table below:
Property

Range

Position

-500 to +500 ticks

Pitch

-120 to +120 semitones

Velocity

-120 to +120

Length

-500 to +500 ticks

Ö You can make independent settings for the two random generators.

2. Use the two fields to the right to set the minimum and
maximum values.

• To deactivate the Random function, pull down the Random pop-up menu(s) and select “OFF”.

These values will be shown as numbers (0-127) for the velocity modes
and as note numbers (C-2 to G8) for the pitch modes.

Ö Note that you can make independent settings for the
two Range functions.
• To deactivate the Range function, pull down the Range
pop-up menu(s) and select “OFF”.

347
MIDI realtime parameters and effects

MIDI effects

MIDI Inserts section

Nuendo comes with a number of MIDI effect plug-ins, capable of transforming the MIDI output from a track in various ways.
Just like the MIDI modifiers, MIDI effects are applied in real
time to the MIDI data played back from the track (or to
MIDI you play live “thru” the track).

What are MIDI effects?
Although a MIDI effect can be similar to an audio effect,
it’s important to remember that you’re not processing the
sound resulting from MIDI playback, but the MIDI data (the
“instructions” for how the music should be played back).

This allows you to add up to four MIDI insert effects. The
section contains the following items:
Item

Description

A MIDI effect will change properties of the MIDI events
(e.g. change the pitch of notes) and/or generate new MIDI
events (for example, a MIDI delay may add new MIDI
notes, “echoing” the original notes).

Bypass button

Ö The included MIDI effect plug-ins are described in the
separate manual “Nuendo Expansion Kit – Cubase Music
Tools for Nuendo 4”.

Click this to temporarily disable all insert effects for the
track (useful for comparing with the unprocessed MIDI,
etc.).

Inserts section
tab

This is in blue if an insert effect is activated.

Preset Manage- Click this to open the track presets pop-up menu and sement button
lect an insert preset or apply an insert from a track preset,
see “Inserts and EQ settings from track presets” on page
337.

Effect selection Selecting an effect from this pop-up menu automatically
pop-up menu
activates it and brings up its control panel (which can be
(x 4)
a separate window or a number of settings below the insert slot in the Inspector).
To remove an insert effect completely, select “No Effect”.

Insert and send effects
As with audio effects, there are two ways to route the MIDI
events on a track to an effect:

On button (x 4) Allows you to turn the selected effect on or off.

Ö If you add an insert effect, the MIDI events will be sent
to the effect, which will process the data and pass it on to
the track’s MIDI output (or to another insert effect).

Edit button (x4) Click this to bring up the control panel for the selected
effect. Depending on the effect, this may appear in a separate window or below the insert slot in the Inspector.
Clicking the button again hides the control panel.

In other words, the MIDI events will be routed “through” the insert effect.

Ö If you use a send effect, the MIDI events will be sent
both to the track’s MIDI output and to the effect.

Ö Effects that display their controls in the Inspector can
be opened in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.

That is, you will get both the unprocessed MIDI events and the output of
the MIDI effect. Note that the effect can send its processed MIDI data to
any MIDI output – not necessarily to the one used by the track.

There are separate sections in the Inspector for MIDI inserts and MIDI sends.
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About presets

MIDI Sends section

Several of the MIDI plug-ins come with a number of presets for instant use. The controls for handling presets consist of a Presets pop-up menu along with Store (+) and
Remove (-) buttons.
Store button

Remove button

This allows you to add up to four MIDI send effects. Unlike
audio send effects, you can select and activate send effects individually for each track. The section contains the
following items:
Item

Description

Bypass button

Click this to temporarily disable all send effects for the
track (useful for comparing with the unprocessed MIDI,
etc.).

Sends section
tab

• To load a preset, select it from the Presets pop-up menu.
• To store your current settings as a preset, click the (+)
button to the right.

This is in blue if any send effect is activated.

A dialog appears, asking you to specify a name for the preset. The stored
preset will then be available for selection from the pop-up menu for all instances of that MIDI plug-in, in all projects.

Effect selection Selecting an effect from this pop-up menu automatically
pop-up menu
activates it and brings up its control panel (which can be
(x 4)
a separate window or a number of settings below the
send slot in the Inspector).
To remove a send effect completely, select “No Effect”.
On button
(x 4)

• To remove a stored preset, select it and click the (-) button to the right.

Allows you to turn the selected effect on or off.

Pre/Post button If this is activated, the MIDI signals will be sent to the
(x4)
send effects before the MIDI modifiers and insert effects.
Edit button
(x4)

Click this to bring up the control panel for the selected
effect. Depending on the effect, this may appear in a separate window or below the sends slot in the Inspector.
Clicking the button again hides the control panel.

Output pop-up This determines to which MIDI output the effect should
menu (x4)
send the processed MIDI events.
Channel setting This determines on which MIDI channel the effect should
(x4)
send the processed MIDI events.

Ö Effects that display their controls in the Inspector can
be opened in a separate control panel window by pressing [Alt]/[Option] and clicking the Edit button.
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Managing plug-ins

Applying a MIDI insert effect – an example
Here is a step-by-step example of how to add a MIDI insert effect to a MIDI track:

Selecting Plug-in Information from the Devices menu
opens a window in which all loaded plug-ins, audio and
MIDI, are listed.

1. Select the MIDI track and open the Inspector.
2. Open the MIDI Inserts tab in the Inspector.

• To view the MIDI effect plug-ins, click the MIDI Plug-ins
tab.

• Alternatively you could use the mixer: bring up the extended mixer panel and select “Inserts” on the view options pop-up menu for the track’s channel strip.
3. Click in one of the insert slots to open the MIDI effect
pop-up menu.
4. Select the desired MIDI effect from the pop-up menu.
The effect is automatically activated (the power button for the insert slot
lights up) and its control panel appears, either in a separate window or in
the MIDI Inserts section below the slot (depending on the effect).

Now all MIDI from the track will be routed through the effect.
5. Use the control panel to make settings for the effect.
All included MIDI effects are described in the separate manual “Nuendo
Expansion Kit – Cubase Music Tools for Nuendo 4”.

• You can bypass the insert effect by clicking its power
button (above the insert slot).
• To bypass all insert effects for the MIDI track, use the
bypass button in the MIDI Inserts section in the Inspector,
in the mixer channel strip or in the Track list.

• The leftmost column allows you to deactivate plug-ins.
This is useful if you have plug-ins installed that you don’t want to use in
Nuendo. Only plug-ins that are activated (ticked checkbox) will appear
on the MIDI effect pop-up menus.
Note that plug-ins that are currently in use cannot be deactivated.

• To remove an insert effect, click in its slot and select
“No Effect”.

• The second column shows how many instances of each
plug-in are currently used in the project.
• The remaining columns show various information about
each plug-in and cannot be edited.
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MIDI processing and quantizing

Introduction

• In the Project window, the MIDI functions apply to all
selected parts, affecting all events (of the relevant types)
in them.

This chapter describes the various MIDI processing functions available on the MIDI menu. They offer various ways
to edit MIDI notes and other events, either in the Project
window or from within a MIDI editor.

• In the MIDI editors, the MIDI functions apply to all selected events. If no events are selected, all events in the
edited part(s) will be affected.

MIDI functions vs. MIDI modifiers

The Quantizing functions

In some cases, the result of a MIDI function can also be
obtained by using MIDI modifiers and effects (see “MIDI
realtime parameters and effects” on page 342). For example, the operations “Transpose” and “Quantize” are available as MIDI modifiers as well as MIDI functions.

What is quantizing?
Quantizing in its fundamental form is a function that automatically moves recorded notes, positioning them on exact note values:

The main difference is that MIDI modifiers and effects don’t
affect the actual MIDI events on the track in any way, while
MIDI functions change the events “permanently” (although
recent changes can be undone).

For example, if you record a series of eighth notes, some of them
may end up slightly beside the exact eighth note positions.

Use the following guidelines to decide which path to
choose for operations that are available both as modifiers
or effects and as functions:
• If you want to adjust a few parts or events only, use MIDI
functions. The MIDI modifiers and effects affect the output
of the whole track (although they can be made permanent
in a specific area with the Merge MIDI in Loop function).

Quantizing the notes with the quantize grid set to eighth notes
will move the “misplaced” notes to exact positions.

• If you want to experiment with different settings, use
MIDI modifiers and effects.
• MIDI modifiers and effects settings are not reflected in
the MIDI editors, since the actual MIDI events aren’t affected. This can be potentially confusing; if you’ve e.g.
transposed notes using modifiers, the MIDI editors will still
show the notes with their original pitch (but they will play
back at their transposed pitch). Therefore MIDI functions
are a better solution if you want to see the effects in the
MIDI editors.

However, quantizing is not only a method of correcting errors, it can also be used creatively in various ways. For example, the “quantize grid” does not have to consist of
perfectly straight notes, some notes can automatically be
excluded from quantizing, etc.
Ö When quantizing MIDI, only MIDI notes are affected
(no other event types).

What is affected by the MIDI functions?

However, you can choose to move the controllers together with their respective notes by activating the “Move Controller” option in the Quantize
Setup dialog, see “The Move Controller setting” on page 355.

Which events are affected when you use a MIDI function
depends on the function, the active window and the current selection:
• Some MIDI function only apply to MIDI events of a certain type.
For example, quantization affects notes only, while the Delete Controllers
function obviously applies to MIDI controller events.
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Setting up quantize on the toolbar

Setting up quantize in the Quantize Setup
dialog

At its most basic, setting up quantizing consists of selecting a note value from the Quantize pop-up menu on the
toolbar (in the Project window or a MIDI editor).

If you want more options than those available on the popup menu, select “Quantize Setup…” from the MIDI menu
(or “Setup…” from the Quantize pop-up menu) to open
the Quantize Setup dialog.

Straight note values

Triplet note values

Dotted note values

This allows you to quantize to exact note values (straight,
triplet or dotted notes) only.

!

Any settings you make in the dialog are immediately
reflected in the Quantize pop-up menus. However, if
you want your settings permanently available on the
Quantize pop-up menus, you have to use the presets
functions (see “Presets” on page 354).

The grid display in the middle of the dialog shows one bar
(four beats), with blue lines indicating the quantize grid
(the positions that notes will be moved to). Value changes
in the grid, presets and quantize options will be graphically
reflected here, see below.
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The Quantize Setup dialog contains the following settings:

Magnetic Area
This allows you to specify that only notes within a certain
distance from the grid lines should be affected by quantizing.

The Grid and Type pop-ups
These are used to determine the basic note value for the
quantizing grid. In other words, these have the same functionality as the Quantize pop-up menu on the toolbar.

• When the slider is set to 0%, the Magnetic Area function is deactivated, i.e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the magnetic areas are shown around the blue lines in the grid display.

Swing
The Swing slider is only available when a straight note
value is selected for the grid and Tuplet is off (see below).
It lets you offset every second position in the grid, creating
a swing or shuffle feel. When you adjust the Swing slider,
the result is shown in the grid display.

Only notes within the indicated zones will be affected by quantizing.

Presets
The controls in the lower left corner of the dialog allow you
to store the current settings as a preset, which will then be
available on the Quantize menus on the toolbars. The
usual preset procedures apply:
• To store the settings as a preset, click the Store button.
• To load a stored preset into the dialog, just select it from
the pop-up menu.
This is useful if you want to modify an existing preset.

• To rename the selected preset, double-click on the
name and type in a new one.
• To remove a stored preset, select it from the pop-up
menu and click Remove.
• You can also create presets by extracting existing
grooves from a MIDI part.

A straight eighth note grid compared with a grid with 60% swing.

Just select the desired MIDI part and drag it on the grid display in the
middle of the Quantize Setup dialog or open the Advanced submenu on
the MIDI menu and select “Part to Groove” (see “Part to Groove” on
page 356).

Tuplet
Allows you to create more rhythmically complex grids by
dividing the grid into smaller steps.
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Apply and Auto

Applying quantize

These functions allow you to apply quantizing directly from
the dialog, see below.

There are several ways to apply the quantize:

!

• The standard method is to select “Over Quantize” from
the MIDI menu (or using a key command, by default [Q]).

If you don’t want to apply the quantizing you have set
up in the dialog, close the window by clicking its
standard close box.

This quantizes the selected MIDI parts or notes according to the current
Quantize pop-up menu setting.

The Non Quantize setting

• You can also apply quantizing directly from the Quantize
Setup dialog, by clicking the “Apply Quantize” button.

This additional setting affects the result of the quantizing.
It allows you to set a “distance” in ticks (120ths of sixteenth notes).

• If you activate the “Auto” checkbox in the Quantize
Setup dialog, any change you make in the dialog is immediately applied to the selected MIDI parts or notes.
A great way of using this feature is to set up a playback loop, and adjust
the settings in the dialog until you get the desired result.
!

Events that already are within the specified distance from
the quantize grid will not be quantized. This allows you to
keep slight variations when you quantize, but still correct
notes that are too far from the grid.

When you apply quantize, the result is based on the
original position of the notes. Therefore, you can
freely try out different quantize settings with no risk of
“destroying” anything. See also “Undo Quantize” on
page 356.

The Random Quantize setting

The Auto Quantize function

This additional setting affects the result of the quantizing. It
allows you to set a “distance” in ticks (120ths of sixteenth
notes).

If you activate the Auto Q button on the Transport panel,
all MIDI recordings you make are automatically quantized
according to the settings you have made in the Quantize
Setup dialog.

Events will be quantized to random positions within the
specified “distance” from the quantize grid, thus creating
a more “loose” quantizing. Much like the Non Quantize
setting, this allows for slight variations, while at the same
time keeping notes from ending up too far from the grid.

Iterative Quantize
Another way to apply “loose” quantization is to use the Iterative Quantize function on the MIDI menu. It works like this:
Instead of moving a note to the closest quantize grid position, Iterative Quantize moves it only part of the way. You
specify how much the notes should be moved towards the
grid with the “Iterative Strength” setting in the Quantize
Setup dialog.

The Iterative Strength setting
Here you specify how much the notes should be moved
towards the grid when using the Iterative Quantize function, see below.

Iterative Quantize also differs from “regular” quantization
in that the operation is not based on the notes’ original positions but on their current, quantized position. This makes
it possible to repeatedly use Iterative Quantize, gradually
moving the notes closer to the quantize grid until you’ve
found the desired timing.

The Move Controller setting
When this is activated, controllers related to notes (pitch
bend, etc.) are automatically moved with the notes when
these are quantized.
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Advanced Quantize functions

Quantize Ends

Quantize Lengths

The Quantize Ends function on the Advanced Quantize
submenu will only affect the end positions of notes. Apart
from that, it works just like regular quantizing, taking the
Quantize pop-up menu setting into account.

!

This function is only available from within the MIDI
editors.

This function (on the Advanced Quantize submenu on the
MIDI menu) will quantize the length of the notes, without
changing their start positions. At its most basic level, this
function will set the length of the notes to the Length
Quantize value on the MIDI editor toolbar. However, if you
have selected the “Quantize Link” option on the Length
Quantize pop-up menu, the function will resize the note
according to the quantize grid, taking the Swing, Tuplet
and Magnetic Area settings into account. An example:

Undo Quantize
As mentioned above, the original position of each quantized note is stored. Therefore, you can make the selected
MIDI notes revert to their original, unquantized state at any
time by selecting Undo Quantize from the Advanced
Quantize submenu. This is independent from the regular
Undo History.
Freeze Quantize
There may be situations when you want to make the quantized positions “permanent”. For example, you may want to
quantize notes a second time, having the results based on
the current quantized positions rather than the original positions. To make this possible, select the notes in question
and select “Freeze Quantize” from the Advanced Quantize
submenu. This makes the quantized positions permanent.

1. Length Quantize set to “Quantize Link”.

!

After you have performed a Freeze Quantize for a
note, you cannot undo its quantization.

2. Some 1/16th notes.

Part to Groove
With this function, you can extract the groove from a selected MIDI part and turn it into a Quantize preset.
You can also extract grooves from audio, using e.g. hitpoints (see “Creating groove quantize maps” on page 283),
or audio parts, rex parts or drum parts that have been processed with the Detect Silence function. Since audio contains no velocity information, velocity will remain unchanged
after applying a Groove that you extracted from audio.

3. Here, the quantize value has been set to straight 1/16th notes with
Swing at 100%. Since Snap is activated (see “Snap” on page 370), the
quantize grid is reflected in the note display’s grid.

In both cases, the resulting groove appears on the Quantize menus and you apply it as you would any Quantize
preset. You can also view and edit the resulting quantize
settings in the Quantize Setup dialog.
4. Selecting Quantize Lengths will adjust the note lengths according to
the grid. If you compare the result to the first figure above, you will find
that notes that started within the odd sixteenth note “zones” show the
longer grid length, and notes in the even zones have the shorter length.
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Transpose

Keep Notes in Range

The Transpose item on the MIDI menu opens a dialog with
settings for transposing the selected notes:

When this is activated, transposed notes will remain
within the Upper and Lower Limit values.
• If a note ends up outside the limits after transposition, it
will be shifted to another octave, keeping the correct
transposed pitch if possible.
If this isn’t possible (if you have set a very narrow range between the Upper and Lower Limit), the note will be transposed “as far as possible”, i.e.
to the Upper or Lower Limit note. If you set the Upper and Lower Limits
to the same value, all notes will be transposed to this pitch!

OK and Cancel
Clicking OK performs the transposition. Clicking Cancel
closes the dialog without transposing.

Making your settings permanent
The settings described in the chapter “MIDI realtime parameters and effects” on page 342 do not change the MIDI
events themselves, but work like a “filter”, affecting the
music on playback. Therefore, you may want to make them
permanent, i.e. convert them to “real” MIDI events, for example to transpose a track and then edit the transposed
notes in a MIDI editor. For this, you can use two commands from the MIDI menu:

Ö You can also use the Transpose track for transposing,
see “The Transpose functions” on page 114.
Semitones
This is where you set the amount of transposition.
Scale Correction
Scale Correction transposes the selected notes by forcing them to the closest note of the selected scale type.
This can be used for creating interesting key and tonal
changes, either by itself or in conjunction with the other
settings in the Transpose dialog.

• “Freeze MIDI Modifiers” – This applies all filter settings
permanently to the respective track.
With this function, the settings are “added” to the events on the track,
and all modifiers will be set to zero.

• To activate Scale Correction, click the checkbox.

• “Merge MIDI in Loop” – This merges all selected tracks
(or parts) to create a new track.

• Select a root note and scale type for the current scale
from the upper pop-up menus.

The settings are applied during the merge and will still be displayed later
in the respective menus.

• Select a root note and scale type for the new scale from
the lower pop-up menus.

These two functions are described in the following sections.

Make sure to select the correct root note if you want to keep the result in
the same key as the original notes, or select an entirely different key if you
want to experiment.
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Freeze MIDI Modifiers

4. Select “Merge MIDI in Loop” from the MIDI menu.
A dialog appears with the following options:

The “Freeze MIDI Modifiers” function affects the following
settings for MIDI tracks:
• Several settings on the main tab of the Inspector (program
and bank selection and the Delay parameter).
• The settings on the MIDI Modifiers tab (i.e. Transpose, Velocity Shift, Velocity Compression and Length Compression).
• The settings on the MIDI Inserts tab (if, e.g., you are using an arpeggiator and want to convert the added notes to real events).

Option

Description

Include Inserts

If this is activated, any MIDI insert effects currently activated for the track(s) will be applied.

Include Sends

If this is activated, any MIDI send effects currently activated for the track(s) will be applied.

Erase
Destination

If this is activated, all MIDI data between the left and right
locator on the destination track will be deleted.

Include Chase

If this is activated, events placed outside the selected part
but relating to it will be included in the processing, e.g. a
Program Change right before the left locator. For more
about chase events, see “About Chase” on page 63.

The following settings for MIDI parts are taken into account as well:
• The Transpose and Velocity settings for parts displayed on the
info line – the Volume setting is not taken into account.

5. Click OK.
A new part is created between the locators on the destination track, containing the processed MIDI events.

To use the “Freeze MIDI Modifiers” function, proceed as
follows:

Applying effects to a single part

1. Select the desired MIDI track.

Normally, the MIDI modifiers and effects affect a whole
MIDI track. This may not always be what you want – you
may want to apply some MIDI effects to a single part for
example (without having to create a separate track for that
part only). The Merge MIDI in Loop function can help:

2. Pull down the MIDI menu and select “Freeze MIDI
Modifiers”.
The Inspector settings will be converted to MIDI events and inserted at
the beginning of the part(s). All notes of the part(s) will be modified accordingly and the Inspector settings will be reset.

1. Set up your MIDI modifiers and MIDI effects the way
you want them for the part.

Merge MIDI in Loop

This will of course affect the whole track, but focus on the part for now.

The function “Merge MIDI in Loop” combines all MIDI
events on all unmuted tracks, applies MIDI modifiers and
effects and generates a new MIDI part, containing all the
events as you would hear them play back. Proceed as follows:

2. Set the locators to encompass the part.
Simply select the part and choose Locators to Selection from the Transport menu (or use the corresponding key command, by default [P]).

3. Make sure the track holding the part is selected in the
Track list.

1. Make sure only the desired MIDI track(s) are unmuted.
If you only want to include events from a single track in the merge operation, you may want to solo the track.

4. Select Merge MIDI in Loop.

2. Set up the left and right locator around the area you
want to merge.

5. In the dialog that appears, activate the desired effect
options, make sure that Erase Destination is activated and
click OK.

Only events starting within this area will be included.

Now a new part is created on the same track, containing the processed
events. The original part is deleted.

3. Select the track on which you want the new part to be
created.

6. Turn off or reset all MIDI modifiers and effects, so that
the track plays back as usual.

This can be a new track or an existing track. Data in the cycle area on the
track can be kept or overwritten (see below).
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Dissolve Part

Now, for each MIDI channel used in the selected part(s), a
new MIDI track is created and set to the corresponding
MIDI channel. Each event is then copied into the part on
the track with the corresponding MIDI channel. Finally, the
original part(s) are muted.

The Dissolve Part function on the MIDI menu has two separate uses:
• When you work with MIDI parts (on MIDI channel “Any”)
containing events on different MIDI channels.

An example:

Dissolve Part separates the events according to MIDI channel.
This part contains events on
MIDI channel 1, 2 and 3.

• When you want to separate MIDI events according to
pitch.
A typical example would be drum and percussion tracks, where each
pitch usually corresponds to a separate drum sound.

Ö When dissolving a part into either separate channels
or separate pitches, you can automatically remove the silent (empty) areas of the resulting parts by activating the
“Optimized Display” checkbox in the Dissolve Part dialog.

Selecting “Dissolve Part” creates new parts on new tracks, set
to channel 1, 2 and 3. Each new part contains only the events
on the respective MIDI channel.

Dissolving parts into separate channels
Setting a track to MIDI channel “Any” will cause each MIDI
event to play back on its original MIDI channel, rather than
a channel set for the whole track. There are two main situations when “Any” channel tracks are useful:
• When you record several MIDI channels at the same
time.

The original MIDI part is muted.

You may for example have a MIDI keyboard with several keyboard zones,
where each zone sends MIDI on a separate channel. Recording on an
“Any” channel track allows you to play back the recording with different
sounds for each zone (since the different MIDI notes play back on separate MIDI channels).

Dissolving parts into separate pitches
The Dissolve Part function can also scan MIDI parts for
events of different pitches, and distribute the events into
new parts on new tracks, one for each pitch. This is useful
when the different pitches are not used in a regular melodic context, but rather for separating different sounds
(e.g. MIDI drum tracks or sampler sound FX tracks). By
dissolving such parts, you can work with each sound individually, on a separate track. Proceed as follows:

• When you have imported a MIDI file of Type 0.
MIDI files of Type 0 contain only one track, with notes on up to 16 different
MIDI channels. If you were to set this track to a specific MIDI channel, all
notes in the MIDI file would be played back with the same sound; setting
the track to “Any” will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on
different MIDI channels and distributes the events into new
parts on new tracks, one for each MIDI channel found. This
allows you to work with each musical part individually. Proceed as follows:

1. Select the part(s) containing MIDI data.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that appears, select the “Separate
Pitches” option.

1. Select the part(s) containing MIDI data on different
channels.

A new MIDI track is created for each used pitch in the selected part(s).
The events are then copied into the parts on the track for the corresponding pitch. Finally, the original part(s) are muted.

2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that appears, select the “Separate Channels” option.
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Repeat Loop

Fixed Lengths
!

With this function, the events inside the independent track
loops will be repeated until the end of the part, i.e. the
notes that were previously only played repeatedly are now
actual notes on the MIDI track. Events to the right of the
independant track loop (within the same part) will be replaced by this function. For more information about independent track loops, see “The independent track loop” on
page 369.

This function is only available from within the MIDI
editors.

This function resizes all selected notes to the length set
with the Length Quantize pop-up menu on the MIDI editor
toolbar.

Delete Doubles
This function removes double notes, i.e. notes of the same
pitch on the exact same position. Double notes can occur
when recording in Cycle mode, after Quantizing, etc.

Other MIDI functions
The following items can be found in the Functions submenu of the MIDI menu:

!

This function always affects whole MIDI parts.

Delete Controllers

Legato

This function removes all MIDI controllers from the selected MIDI parts.

Extends each selected note so that it reaches the next note.

!

This function always affects whole MIDI parts.

Delete Continuous Controllers
This function removes all “continuous” MIDI controller
events from the selected MIDI parts. Therefore, “on/off”
events such as sustain pedal events are not removed.
!

You can specify the desired gap or overlap with the “Legato
Overlap” setting in the Preferences (Editing–MIDI page).

This function always affects whole MIDI parts.

Delete Notes
Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes…” opens a dialog
in which you set up the criteria for the function.

When using Legato with this setting, each note will be extended to end
5 ticks before the next note.

When you activate the “Legato Mode: Selected Only” option, the length of the note will be adjusted so that it
reaches the next selected note, allowing you e.g. to only apply Legato to your bass line (when playing on a keyboard).
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The parameters have the following functionality:

Pedals to Note Length

Minimum Length

This function scans for Sustain pedal on/off events, lengthens the affected notes to match the Sustain pedal off position, and then removes the Sustain Controller on/off events.

When the Minimum Length checkbox is activated, the
note length is taken into account, allowing you to remove
short notes. You can either specify the minimum length
(for notes to be kept) in the value display or by dragging
the blue line in the graphical length display below.

Delete Overlaps (mono)
This function allows you to make sure that no notes of the
same pitch overlap (i.e. that one starts before the other
ends). Overlapping notes of the same pitch can confuse
some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then
be used to automatically solve the problem.

• The graphical length display can correspond to 1/4 bar,
one bar, two bars or four bars.
You change this setting by clicking in the field to the right of the display.

Delete Overlaps (poly)
In this case, the whole length display corresponds to two bars, and the
Minimum Length is set to 1/32nd notes (60 ticks).

This function shortens notes when required, so that no
note begins before another ends. This happens regardless of which pitch the notes have.

Minimum Velocity
When the Minimum Velocity checkbox is activated, the velocity of notes is taken into account, allowing you to remove weak notes. You specify the minimum velocity (for
notes to be kept) in the value display.

Velocity
This function opens a dialog that allows you to manipulate
the velocity of notes in various ways.

Remove when under
This setting is only available when both Minimum Length
and Minimum Velocity is activated. By clicking the value
display, you select whether both length and velocity criteria must be met for notes to be deleted, or whether one of
the criteria will suffice.
OK and Cancel
Clicking OK performs the automatic delete according to
the rules set up. Clicking Cancel closes the dialog without
deleting notes.

The following types of velocity processing are available:
Add/Subtract
This simply adds a fixed number to the existing velocity
values. You set the value (positive or negative) with the
Amount parameter.

Restrict Polyphony
Selecting this item opens a dialog in which you can specify how many “voices” should be used (for the selected
notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony
and want to make sure all notes will be played. The effect
is achieved by shortening notes as required, so that they
end before the next note starts.
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Compress/Expand

Extract MIDI Automation

Compresses or expands the “dynamic range” of MIDI
notes by scaling the velocity values according to the Ratio
setting (0 – 300%). The principle behind this is that multiplying different velocity values with a factor higher than 1
(over 100%) will also make the differences between velocity values greater, while using a factor lower than 1 (under 100%) will make the differences smaller. In short:

This option allows you to automatically convert continuous
controller data of a MIDI part into MIDI track automation
data. Proceed as follows:
1. Select the desired MIDI part containing the continuous
controller data.
2. Select “Extract MIDI Automation”. (This command is
also available on the Key Editor context menu.)

• To compress (“even out” velocity differences), use ratio
values below 100%.

The controller data will automatically be removed from the controller lane
in the editor.

After compression, you would probably want to add a velocity amount
(with the Add/Subtract function) to maintain the average velocity level.

3. In the Project window, open the automation track(s)
for the respective MIDI track. You will find that an automation track has been created for each of the continuous
controllers in the part.

• To expand (create greater difference in velocity), use ratio values above 100%.
Before you expand, you may want to adjust the velocity with the Add/
Subtract function, so that the average velocity is somewhere in the middle of the range. If the average velocity is high (near 127) or low (near 0),
expansion will not work properly, simply because velocity values can only
be between 0 and 127!

Ö Please note that this function can only be used for continuous controllers. Data such as Aftertouch, Pitchbend or
SysEx cannot be converted to MIDI track automation data.
!

Limit
This function allows you to make sure that no velocity values fall outside a given range (the Lower and Upper values). Any velocity values outside this range are raised/
lowered to exactly the Lower/Upper values.

This is an extremely useful function as it allows you to
quickly and easily convert the continuous controllers
of your recorded MIDI parts into MIDI track automation data, making them available for editing in the
Project window.

Ö Remember that to be able to hear the automation data,
you have to activate the Read button for the respective automation track(s).

Fixed Velocity
This function sets the velocity of all selected notes to the
Insert Velocity value on the toolbar in the MIDI editors.

Reverse
This function inverts the order of the selected events (or of
all events in the selected parts), causing the MIDI music to
play backwards. Note that the effect is different from reversing an audio recording. With MIDI, the individual notes
will still play as usual in the MIDI instrument – it’s only the
order of playback that is changed.

Thin Out Data
Thins out MIDI data. Use this to ease the load on your external MIDI devices if you have recorded very dense controller curves etc.
You can also manually thin out the controller data by using
the quantize function in the Key Editor.

Merge Tempo from Tapping
This function allows you to create a complete tempo track
based on your tapping, see the section “Merge Tempo
From Tapping” on page 422.
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The MIDI editors

About editing MIDI

Opening a MIDI editor

There are several ways to edit MIDI in Nuendo. You can
use the tools and functions in the Project window for
large-scale editing, or use the functions on the MIDI menu
to process MIDI parts in various ways (see “What is affected by the MIDI functions?” on page 352). For hands-on
graphical editing of the contents of MIDI parts, you use the
MIDI editors:

There are two ways to open a MIDI editor:

• The Key Editor is the default MIDI editor, presenting
notes graphically in an intuitive piano roll-style grid.

The selected parts (or all parts on the track, if no part was selected) will
open in the chosen editor.

The Key Editor also allows for detailed editing of non-note events such
as MIDI controllers. For more information, see “The Key Editor – Overview” on page 366.

• Double-click a part to open it in the default editor.

• Select one or several parts (or a MIDI track, with no
parts selected) and select Open Key Editor, Open Score
Editor (Nuendo Expansion Kit only), Open Drum Editor
(Nuendo Expansion Kit only), Open List Editor or Open InPlace Editor from the MIDI menu (or use the corresponding key command).

Which editor opens depends on the Default Edit Action setting in the
Preferences (Event Display–MIDI page).

• The Score Editor (Nuendo Expansion Kit only) shows
MIDI notes as a musical score and comes with advanced
tools and functions for notation, layout and printing.
• The Drum Editor (Nuendo Expansion Kit only) is similar
to the Key Editor, but takes advantage of the fact that with
drum parts, each key corresponds to a separate drum
sound.
• The List Editor shows all events in the selected MIDI
parts as a list, allowing you to view and edit their properties numerically.

Nuendo Expansion Kit only: If the option “Edit as Drums
when Drum Map is assigned” is activated and a drum map
is selected for the edited track, the Drum Editor will open.
This way you can double-click to open the Key Editor (or
the Score Editor, List or Edit In-Place Editor, depending
on your preferences) but drum tracks will automatically
open in the Drum Editor.

For more information, see “The List Editor – Overview” on page 383.

• The Edit In-Place function allows you to edit MIDI parts
directly in the Project window.
This is similar to working in the Key Editor, but makes it easier to edit
MIDI in context with other track types. See “Edit In-Place” on page 381.

Ö If the part you open for editing is a shared copy, any editing you perform will affect all shared copies of this part.

• You can also edit MIDI in the Project Browser.
Like the List Editor, the Project browser shows the events in a list and allows you to perform numerical editing. However, you will probably find the
List Editor better suited for MIDI editing, since it has various dedicated features and functions for this. The Project Browser is described in the chapter “The Project Browser” on page 428.

Shared copies are created by pressing [Alt]/[Option]+[Shift] and dragging, or by using the Repeat function with the “Shared copies” option
activated. In the Project window, shared copies are indicated by the part
name in italics and an icon in the bottom right corner of the part (see
“Aligning events” on page 45).

Ö You can define each of the editors mentioned above
as your default MIDI editor, see below.
About this chapter
Please note that features that are identical in these editors
will be described in the Key Editor section. The sections
about the Inplace-Editor (see “Edit In-Place” on page 381)
and the List Editor (see “The List Editor – Overview” on
page 383) describe the specific features of these editors
only.
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Handling several parts

• The button “Show Part Borders” can be used if you
want to see clearly defined borders for the active part.

When you open a MIDI editor with several parts (or a MIDI
track containing several parts) selected, you might find it
somewhat hard to get an overview of the different parts
when editing.

When this is activated, all parts except the active one are grayed out, making the borders easily discernible. In the Key Editor, there are also two
“markers” in the ruler with the name of the active part, marking its beginning and end. These can be moved freely to change the size of the part.

For such cases the editor toolbar features a few functions
to make working with multiple parts easier and more comprehensive:
• The Part List menu lists all parts that were selected when
you opened the editor (or all parts on the track, if no parts
were selected), and lets you select which part should be
active for editing.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts (making them active) using key commands.

When you select a part from the list, it is automatically made active and
centered in the note display.

In the Key Commands dialog – Edit category, you will find two functions for
this: “Activate Next Part” and “Activate Previous Part”. If you assign key
commands to these, you can use them to cycle between parts in the editors. For further information, see “Setting up key commands” on page 518.

Ö Note that it is also possible to activate a part by selecting an event within this part with the Arrow tool.
• The button “Edit Active Part Only” lets you restrict editing operations to the active part only.
For example, if you select “All” from the Select submenu on the Edit menu
with this option activated, only events in the active part will be selected.
Similarly, if you select notes by dragging with the Arrow tool (making a selection rectangle), only the notes in the active part will be selected.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on the active part so that it fills the
screen by selecting “Zoom to Event” from the Zoom submenu on the Edit menu.
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The Key Editor – Overview
Info line

Toolbar

Ruler

Note display

Controller display

The toolbar

Quantize settings

As in other windows, the toolbar contains tools and various settings. You can specify which toolbar items should
be shown and store/recall different toolbar configurations
– see “The Setup dialogs” on page 506.
Solo Editor button
Key Editor tools

Autoscroll
on/off

Mouse pointer display: Current Color pop-up menu
pitch and meter position

Show/Hide Part
borders
Part list

Velocity for inserted notes

Indicate Transpositions

Transpose Palette

Nudge Tools

Independent track
loop on/off

Edit active
part only

Auto Select
Controllers

Step/MIDI input controls

MIDI Input

Show/Hide Info line
Audition on/off

Step Input

Loop range (see “The independent track loop” on page 369).

Chord recognition display

Open Device
Button

The info line

Grid modes

The info line shows information about selected MIDI
notes. You can edit all values on the info line using regular
value editing (see “Editing on the info line” on page 375
for details). Length and position values are displayed in
the format currently selected for the ruler (see below).

Snap on/off

• To hide or show the info line, click the icon in the toolbar.
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The ruler

The note display

The ruler shows the time line, by default in the display format selected on the Transport panel. You can select a
separate format for a MIDI editor ruler on the Ruler pop-up
menu, opened by clicking the arrow button to the right of
it. For a list of the available formats, see “The ruler” on
page 31.
At the bottom of the pop-up menu, there are two additional items:

The note display is the main area in the Key Editor. It contains a grid in which MIDI notes are shown as boxes. The
width of a box corresponds to the note length, and the
vertical position of a box corresponds to the note number
(pitch), with higher notes higher up in the grid. The piano
keyboard to the left serves as a guide for finding the right
note number.
• If “Time Linear” is selected, the ruler, note display and
controller display will be linear in relation to time.

For a description on how to display colors in the note display, see “Coloring notes and events” on page 370.

This means that if the ruler shows bars and beats, the distance between
the bar lines will vary depending on the tempo.

The chord recognition function

• If “Bars+Beats Linear” is selected, the ruler, note display
and controller display will be linear in relation to tempo.

Nuendo features a handy chord recognition function that
helps you identify chords in the Key Editor note display. To
find out which chord is formed by simultaneously played
notes, place the project cursor over the notes. All MIDI
notes currently “touched” by the project cursor are analyzed and the chord recognition display in the toolbar
shows you which chord the notes form.

This means that if the ruler shows bars and beats, the distance between
beats will be constant.

In most cases, you would probably set the display format
to “Bars+Beats” in “Bars+Beats Linear” mode when editing MIDI.

In the picture above, the project cursor touches the notes C, Eb and G.
As shown in the chord recognition display, this results in a C minor chord.
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The controller display

The area at the bottom of the Key Editor window is the
controller display. This consists of one or several controller lanes, each showing one of the following properties or
event types:
•
•
•
•
•
•

If you zoom in on the upper “curve”, you will find that it consists of separate events.

Velocity values of the notes.
Pitch Bend events.
Aftertouch events.
Poly Pressure events.
Program Change events.
Any type of continuous controller event.

Ö Unlike notes, events in the controller display have no
length. The value of an event in the display is “valid” until
the start of the next event:

To change the size of the controller display, drag the divider between the controller display and the note display.
This will make the controller display larger and the note
display smaller, or vice versa.
Velocity values are shown as vertical bars in the controller
display, with higher bars corresponding to higher velocity
values:

If you delete the second event…

…the first event will be “valid”
until the start of the third event.

For a description of editing in the controller display, see
“Editing in the controller display” on page 377.

Key Editor operations
Zooming
Zooming in the Key Editor is done according to the standard zoom procedures, using the zoom sliders, the Zoom
tool or the Zoom submenu on the Edit menu.
• When you drag a rectangle with the Zoom tool, the result
depends on the option “Zoom Tool Standard Mode: Horizontal Zooming Only” in the Preferences (Editing–Tools
page).

Each velocity bar corresponds to a note in the note display.

Events in the controller display (that is, anything other than
velocity values) are shown as “blocks”, the heights of which
correspond to the “values” of the events. However, events
that have been recorded (or drawn with a low quantize
value) may appear more like “filled curves”, simply because
they are positioned very closely:

If this is activated, the window will only be zoomed horizontally; if not, the
window will be zoomed both horizontally and vertically.
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Using the Trim tool

Playing back

The Trim tool allows you to change the length of note
events by cutting off the end or the beginning of notes. It
is available in the Key Editor and in the List Editor.

You can play back your music as usual when working in a
MIDI editor. There are several features designed to make
editing easier during playback:

Using the Trim tool means moving the note-on or the noteoff event for one or several notes to a position defined with
the mouse. Proceed as follows:

Solo button

1. Select the Trim tool in the toolbar.
The mouse pointer changes to a knife symbol.

If you activate the Solo button, only the edited MIDI parts
will be heard during regular playback.
Autoscroll

2. Locate the notes that you wish to edit.
• To edit a single note, click on it with the Trim tool. The
range between the mouse cursor and the end of the note
will be removed.

As described in the section “Autoscroll” on page 57, the
Autoscroll function makes the window “follow” the project
cursor during playback, so that the current play position is
visible at all times. However, when you are working in a
MIDI editor, you may want to deactivate Autoscroll – this
way, the events you are working with will stay visible.

You can use the mouse position display in the toolbar to find the exact
position for the trim operation.

• To edit several notes, click and drag with the mouse
across the notes.
A line is displayed. The notes will be trimmed along this line.

The Autoscroll buttons in each of the MIDI editors are independent of the Project window Autoscroll setting, which
means that Autoscroll can be activated in the Project window and deactivated in the MIDI editor you are working in.
The independent track loop
Trimming the end of three note events.

The independent track loop is a sort of “mini-cycle”, affecting only the MIDI part being edited. When the loop is activated, the MIDI events within the loop will be repeated
continuously and completely independent – other events
(on other tracks) will be played back as usual. The only “interaction” between the loop and the “regular playback” is
that every time the cycle starts over again, so does the loop.

• By default, the Trim tool will cut off the end of notes. To
trim the beginning of the note(s), press [Alt]/[Option] while
dragging.
• If you press [Ctrl]/[Command] while dragging, you will
get a vertical trim line, allowing you to set the same start or
end time for all edited notes.

To set up the independent track loop, proceed as follows:

You can change the Trim tool key commands in the Preferences (Editing–Tool Modifiers page).

1. Activate the loop by clicking on the Loop button on the
toolbar.

Ö Note that when you trim the beginning of a note in the
List Editor, the note may move to a different position in the
list (since other events may now begin before the edited
event).

If it isn’t visible, right-click the toolbar and add the Independent Track
Loop Settings section – see “The Setup dialogs” on page 506.

Ö Note that the trimmed note ends don’t snap to the grid.
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When the loop is activated, the cycle isn’t shown in the
ruler.

• When the “Bars+Beats” display format is selected in
the ruler, the snap grid is set by the quantize value on the
toolbar.

2. Now you need to specify the length of the loop. You
have the following possibilities:

This makes it possible to snap not only to straight note values but also to
swing grids set up in the Quantize Setup dialog (see “The Quantizing
functions” on page 352).

• [Ctrl]/[Command]-click and [Alt]/[Option]-click in the
ruler to set the start and end of the loop, respectively.

When any of the other display formats is selected in the
ruler, positioning is restricted to the displayed grid, i.e. you
can snap in finer increments by zooming in, and in coarser
increments by zooming out the display.

• Edit the loop start and end positions numerically in the
fields next to the Loop button.
• Click and drag in the upper part of the ruler to move the
locators to the desired positions.

Coloring notes and events

The independent track loop is indicated in purple in the
ruler.

By using the Colors pop-up menu on the toolbar, you can
select a color scheme for the events in the editor. The following options are available:

Ö The MIDI events will be looped as long as the Loop
button is activated and the MIDI editor window is open.
To turn the loop into actual MIDI notes, use the Repeat
Loop function on the MIDI menu, see “Repeat Loop” on
page 360.

Option

Description

Velocity

The notes get different colors depending on their velocity
values.

Pitch

The notes get different colors depending on their pitch.

Channel

The notes get different colors depending on their MIDI
channel value.

Part

The notes get the same color as their respective part in
the Project window. Use this option when you are working with two or more tracks in an editor, to make it easier
to see which notes belong to which track.

GridMatch

The notes get different colors depending on their time
position. This mode makes it easy to see e.g. if the notes
in a chord start at the exact same beat.

Auditioning

If the speaker icon on the toolbar is activated, individual
notes will automatically be played back (auditioned) when
you move or transpose them, or when you create new notes
by drawing. This makes it easier to hear what you’re doing.

When any of the options (apart from “Part”) is selected,
you can select “Setup” from the Colors pop-up menu.
This opens a dialog in which you can specify which colors
should be associated with which velocities, pitches or
channels, respectively.

Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when
editing in a MIDI editor. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by snap include moving, duplicating,
drawing, sizing, etc.
• How Snap works depends on the Snap mode pop-up
menu next to the Snap button.
See “Snap” on page 55.
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Creating and editing notes

The tool icon will change appearance according to the selected mode.

To draw in new notes in the Key Editor, you use the Pencil
tool or the Line tool.
Drawing notes with the Pencil tool

Mode

Description

Line

This is the default mode for the Line tool. When this
mode is selected, you click and drag to create a straight
line, in any angle. When you release the mouse button a
series of notes will be created, aligned with the line. If
Snap is activated, the notes will be spaced and sized according to the Quantize value.

With the Pencil tool, you insert single notes by clicking at
the desired time (horizontal) and pitch position (vertical).
• When you move the pointer in the note display, its bar
position is indicated in the toolbar, and its pitch is indicated
both in the toolbar and on the piano keyboard to the left.

Parabola, Sine, These modes insert events along different curve shapes.
Triangle, Square While they can be used for creating notes, they’re probably best suited for controller editing (see “Adding and
editing events in the controller display” on page 379).

This makes it easy to find the right note and insert position.

Paint

Allows you to insert multiple notes by dragging with the
mouse button pressed. If Snap is activated, the notes will
be positioned and sized according to the Quantize and
Length Quantize values. If you press [Ctrl]/[Command]
while painting, movement will be restricted to horizontal
only (i.e. the painted notes will have the same pitch).

Setting velocity values
When you draw notes in the Key Editor, the notes will get
the velocity value set in the insert velocity field on the toolbar.
You can use one of four different methods for determining
the velocity:

• If Snap is activated, this determines the start position of
the created note.

• When a key command is assigned for the Select tool–
Edit Velocity action (in the Editing–Tool Modifiers page of
the Preferences dialog), you can select one or more notes,
press [Ctrl]/[Command]+[Shift] and click on one of the
selected notes to change the velocity.

• If you click once, the created note will have the length
set on the Length Quantize pop-up menu on the toolbar.
You can create a longer note by clicking and dragging. The length of the
created note will be a multiple of the Length Quantize value.

Drawing notes with the Line tool

The cursor changes into a speaker and, next to the note, a field with the
velocity value appears – the Note Velocity slider. Move the mouse
pointer up or down to change the value. Value changes will be applied to
all selected notes, as you can see in the controller lane.

The Line tool can be used for creating series of contiguous notes. To do so, click and drag to draw a line and then
release the mouse button.

• Selecting a predefined velocity value from the insert velocity pop-up menu.

Ö The Line tool has several different modes.
To select one of the modes, click on the Line tool icon on the toolbar
when the tool is already selected. This opens a pop-up menu from which
you can select one of the Line tool modes.

The menu contains five different predefined velocity values. The “Setup…”
item opens a dialog that allows you to specify which five velocity values
should be available on the pop-up menu. (This dialog can also be opened
by selecting “Insert Velocities…” from the MIDI menu.)
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• Manually entering the desired velocity value by clicking
in the insert velocity field and typing in the desired value.

• To select all notes of a certain pitch, press [Ctrl]/[Command] and click on the desired key in the keyboard display
to the left.

• Using a key command.
You can assign a key command to each of the five available velocity values in the Key Commands dialog (MIDI category – the items Insert Velocity 1-5). This allows for quick switching between different velocity
values when entering notes. See “Setting up key commands” on page
518 for instructions on how to set up key commands.

All notes of the corresponding pitch are selected.

Selecting notes
You can also press [Shift] and double-click on a note to select all the following notes of the same pitch – or use the Equal Pitch functions on the
Select submenu.

Selecting notes is done using any of the following methods:
• Use the Arrow tool.
The standard selection techniques apply, like selecting by clicking on the
note or using a selection rectangle. Note that when you press [Shift] and
click on notes or draw a selection rectangle, these notes will be added to
the overall selection. When you press [Ctrl]/[Command] and click on
notes or draw a selection rectangle, these notes will be removed from
the overall selection (standard Windows behavior).

• If the option “Auto Select Events under Cursor” is activated in the Preferences (Editing page), all notes “touched”
by the project cursor are automatically selected.
Toggle selections
If you want to toggle the selected elements within a selection rectangle, press [Ctrl]/[Command] and enclose the
same elements within a new selection rectangle. Once
you release the mouse button, the previous selection is
deselected and vice versa.

• Use the Select submenu on the Edit menu or Quick
menu.
The Select menu options are:
Option

Description

All

Selects all notes in the edited part.

None

Deselects all events.

Invert

Inverts the selection – all selected events are deselected
and all notes that were not selected are selected instead.

In Loop

Selects all notes that are partially or completely inside the
boundaries of the left and right locators (only visible if locators are set).

From Start to
Cursor

Selects all notes that begin to the left of the project cursor.

Selecting controllers within the note range
You can select the controllers within the range of the selected notes. The following applies:

From Cursor to Selects all notes that end to the right of the project curEnd
sor.
Equal Pitch –
all Octaves

This function requires that a single note is selected. It selects all notes of this part that have the same pitch (in any
octave) as the currently selected note.

Equal Pitch –
same Octave

As above, but selects notes of the exact same pitch only
(same octave).

• When the Auto Select Controllers button is activated
on the toolbar, the controllers will always be selected
when the respective notes are selected.
• When you select “Select Controllers in Note Range” on
the Select submenu of the Edit menu, the controllers
within the note range (i.e. between the first/leftmost and
last/rightmost note) will be selected.

Select Control- Selects the MIDI controller data within range of the selers in Note
lected notes, see below.
Range

Please note that for this to work, only two notes have to be selected. All
controllers within this range will be selected.

• You can also use the left and right arrow keys on the
computer keyboard to step from one note to another.

• A note range lasts until the start of the next note or the
end of the part.

If you press [Shift] and use the arrow keys, the current selection will be
kept, allowing you to select several notes.

• Selected controllers for notes are moved when the corresponding notes are moved.
372
The MIDI editors

Moving and transposing notes

• Selecting Duplicate from the Edit menu creates a copy
of the selected note and places it directly after the original.

To move notes in the editor, use any of the following methods:

If several notes are selected, all of these are copied “as one unit”, maintaining the relative distance between the notes.

• Click and drag to a new position.

• Selecting Repeat from the Edit menu opens a dialog, allowing you to create a number of copies of the selected
note(s).

All selected notes will be moved, maintaining their relative positions. If
Snap is activated, this determines to which positions you can move the
notes, see “Snap” on page 370.
!

This works like the Duplicate function, but you can specify the number of
copies.

Note also that you can restrict movement to horizontal or vertical only by holding down [Ctrl]/[Command]
while dragging.

• You can also perform the Repeat function by dragging:
Select the note(s) to repeat, press [Alt]/[Option], click the
right edge of the last selected note and drag to the right.

• Use the up and down arrow keys on the computer keyboard.

The longer to the right you drag, the more copies are created (as indicated by the tool tip).

This method allows you to transpose the selected notes, without risking
to move them horizontally. You can also use the Transpose function (see
“Transpose” on page 357) or the info line (see “The info line” on page
366) for this. Note that pressing [Shift] and using the up and down arrow
keys will transpose notes in steps of one octave.
Transport is also affected by the global transpose setting, see “The
Transpose functions” on page 114.

• Use the Move to Cursor function on the Edit menu.
This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info
line.

Using cut and paste

See “Editing on the info line” on page 375.

You can use the Cut, Copy and Paste options on the Edit
menu to move or copy material within a part or between
different parts. When you paste copied notes, you can either use the regular Paste function or the function “Paste
Time” from the Range submenu of the Edit menu.

• Use the Move buttons in the Nudge palette on the toolbar.
This moves the selected note(s) by the amount set on the Quantize popup menu.
By default, the Nudge palette isn’t shown on the toolbar – see “The Setup dialogs” on page 506 for more information.

• “Paste” inserts the copied notes at the project cursor position
without affecting existing notes.

Ö Note that when you move selected notes to a different
position, any selected controllers for these notes will move
accordingly.
See also “Moving and copying events” on page 380.

You can also adjust the position of notes by quantizing
(see “The Quantizing functions” on page 352).
Duplicating and repeating notes
Notes are duplicated much in the same way as events in
the Project window:
• Hold down [Alt]/[Option] and drag the note(s) to a new
position.
If Snap is activated, this determines to which positions you can copy
notes (see “Snap” on page 370).
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• “Paste Time” inserts at the project cursor position, but moves
(and if necessary, splits) existing notes to make room for the
pasted notes.

Splitting notes
There are three ways to split notes:
• Clicking on a note with the Scissors tool splits the note
at the position you pointed (taking the Snap setting into
account if activated).

Selecting “Paste Time” with this data on the
clipboard and the project cursor here…

If several notes are selected, they are all split at the same position.

• If you select “Split at Cursor”, all notes that are intersected by the project cursor are split at the cursor position.
• If you select “Split Loop”, all notes that are intersected
by the left or right locator are split at the locator positions.
Gluing notes
Clicking on a note with the Glue Tube tool will “glue it together” with the next note of the same pitch. The result will
be one long note spanning from the start of the first note
to the end of the second note and with the properties (velocity, etc.) of the first note.

…will give you this.

Muting notes
Individual notes can be muted in the Key Editor, as opposed to muting an entire MIDI part in the Project window.
This allows you to exclude notes from playback, but keep
the option to bring them back again at any time. To mute a
note, use one of the following methods:

Resizing notes
To resize a note, use one of the following methods:
• Position the arrow tool at the start or end of the note, so
that the pointer takes on the shape of a small double arrow. Click and drag to the left or right to resize the note.

• Click on it with the Mute tool.

This method allows you to resize the note from either direction.

• Drag a rectangle with the Mute tool, enclosing all notes
you want to mute.

• Click with the Pencil tool within the note box and drag
to the left or the right (to make the note shorter or longer,
respectively).

• Select the note(s) and choose Mute from the Edit menu.
The default key command for this is [Shift]+[M].

With both these methods, the resulting length will be a
multiple of the Length Quantize value on the toolbar.
• Use the Trim Start/End buttons on the Nudge palette on
the toolbar.
This resizes the selected note(s) by moving their start or end positions, in
steps according to the Length Quantize value on the toolbar. By default,
the Nudge palette isn’t shown on the toolbar – see “The Setup dialogs” on
page 506 for more information.

• Select the note and adjust its length on the info line.
See “Editing on the info line” on page 375 for details on info line editing.

Muted notes are “dimmed” in the note display.

• Use the Trim tool, see “Using the Trim tool” on page 369.

To unmute a note, either click it or enclose it with the Mute
tool, or select it and choose Unmute from the Edit menu.
The default key command for this is [Shift]+[U].
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How the Key Editor handles drum maps
(Nuendo Expansion Kit only)

Deleting notes
To delete notes, either click on them with the Eraser tool
or select them and press [Backspace].

When a drum map is assigned to a MIDI track, the Key
Editor will display the drum sound names as defined by
the drum map.

Editing on the info line
The info line shows the values and properties of the selected event(s). If a single event is selected, its values are
displayed on the info line. If several events are selected,
the info line shows the values of the first of these events in
yellow.

The drum sound names are displayed…
…in the Mouse Note Value field…
…in the info line, in the Pitch field…

Several events selected.

You can edit the values on the info line using regular value
editing. This allows you to move, resize, transpose or
change velocity of events in a very precise manner. It’s also
possible to click the Pitch or Velocity field in the info line
and play a note on your MIDI keyboard – the pitch or velocity will be adjusted according to the note you played.

…when dragging a note…

…in the event itself (provided the
zoom factor is high enough).

This allows you to use the Key Editor for drum editing, e.g.
when editing drum note lengths (which may be necessary
for some external instruments) or when editing several
parts, to identify drum events.

Ö If you have several events selected and change a value,
all selected events will be changed by the set amount.

Editing notes via MIDI

Ö If you have several events selected, hold down [Ctrl]/
[Command] and change a value, the change will be absolute.

You can change the properties of notes via MIDI. For example, this can be a fast way to get the right velocity value,
since you will hear the result even as you edit:

In other words, the value setting will be the same for all selected events.

1. Select the note you want to edit.
2. Click on the MIDI connector symbol on the toolbar.

Click this button to enable editing via MIDI.
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3. Use the note buttons on the toolbar to decide which
properties should be changed by the MIDI input.

3. Click anywhere in the note display to set the start position (the desired position of the first note or chord).

You can enable editing of pitch, note-on and/or note-off velocity.

The step input position is shown as a blue line in the note display, and in
the lower mouse pointer display in the toolbar.

With this setting, the edited notes will get the pitch and velocity values
of the notes input via MIDI, but the note-off velocities will be kept as
they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will get the pitch, velocity and/or note-off
velocity of the played note.

The next note in the edited part is automatically selected,
making it easy to quickly edit a series of notes.

4. Specify the desired note spacing and length with the
Quantize and Length Quantize pop-up menus.

• If you want another try, select the note again (e.g. by
pressing the left arrow key on the computer keyboard) and
again play a note on your MIDI instrument.

The notes you input will be positioned according to the Quantize value
and have the length set with the Length Quantize value. For instance, if
you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the
notes will be sixteenth notes, appearing on each eighth note position.

Step input

5. Play the first note or chord on your MIDI instrument.

Step input, or step recording, is when you enter notes one
at a time (or one chord at a time) without worrying about
the exact timing. This is useful e.g. when you know the part
you want to record but are not able to play it exactly as you
want it.

The note or chord appears in the editor and the step input position advances one quantize value step.

Ö If Insert mode is activated, all notes to the right of the
step input position will be moved to “make room” for the
inserted note or chord.

Proceed as follows:
1. Click the Step Input button on the toolbar to activate
Step Input mode.
Insert mode activated.

6. Continue in the same way with the rest of the notes or
chords.
2. Use the note buttons to the right to decide which
properties should be included when you input the notes.

You can adjust the Quantize or Length Quantize value as you go along,
to change the timing or note lengths. You can also move the step input
position manually by clicking anywhere in the note display.

For example, you may not want to include the velocity and/or note-off velocity of the played notes. It’s also possible to turn off the pitch property,
in which case all notes will get the pitch C3, no matter what you play.

• To insert a “rest”, press the right arrow key on the computer keyboard.
This advances the step input position one step.

7. When you’re done, click the Step Input button again
to deactivate step input.
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Editing in the controller display

• Selecting “Setup…” opens a dialog in which you can
specify which continuous controller event types should be
available on the pop-up menu.

About controller lanes
By default, the controller display has a single lane, showing one event type at a time. However, you can add lanes
by right-clicking in the display and selecting “Create new
controller lane” from the Quick menu. This allows you to
view and edit different controllers at the same time.

Controller types in this
list are already listed on
the pop-up menu.

Controller types in this
list are not listed on the
pop-up menu.

The controller display with three lanes set up.
Click this button to remove the Click this button to add
controller type selected in the the selected controller
left list from the pop-up menu. type to the pop-up menu.

• To remove a lane, right-click in it and select “Remove this
Lane” from the Quick menu, or click on the minus button.
This hides the lane from view – it doesn’t affect the events in any way.

• If you remove all lanes, the controller display will be
completely hidden.

• Each MIDI track has its own controller lane setup (number of lanes and selected event types).

To bring it back again, select “Create new controller lane” from the Quick
menu.

When you create new tracks, they get the controller lane setup used last.

Controller lane presets
Selecting the event type

Once you have added the required number of controller
lanes and selected the event types you need, you can
store this combination as a controller lane preset. You
could for example have a preset with one velocity lane
only, another with a combination of velocity, pitch bend
and modulation, and so on. This can make working with
controllers much quicker.

Each controller lane shows one event type at a time. To
select which type should be displayed, use the pop-up
menu to the left of the lane.

• To add the current controller lane setup as a preset, pull
down the pop-up menu to the left of the horizontal scrollbar and select “Add”.
Enter a name for the preset in the dialog that appears and click OK.

• To apply a stored preset, select it from the pop-up menu.
This immediately brings up the controller lanes and event types in the
preset.

• To remove or rename presets, select “Organize” from
the pop-up.
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Editing velocity values

• Use the Line tool in Line mode for creating linear velocity ramps.

When “Velocity” is selected for viewing, the lane shows
the velocity of each note as a vertical bar.

Click where you want the ramp to start and drag the cursor to where you
want the ramp to end. When you release the mouse button, the velocity
values are aligned with the line between the two points.

Velocity values are edited with the Pencil or the Line tool.
The different tools and Line tool modes offer several possibilities, as listed below.

• Parabola mode works in the same way, but aligns the
velocity values to a Parabola curve instead.

Ö If the option “Controller Lane Editing: Select Tool defaults to Pen” is activated in the Preferences (Editing–MIDI
page), the Arrow tool automatically switches to the Pencil
tool when you move the pointer into the controller display.

Use this for smooth, “natural” velocity fades, etc.

If you want to use the Arrow tool to select events in the controller display,
press [Ctrl]/[Command].

Ö If the Speaker icon (Acoustic Feedback) is activated
on the toolbar, the notes will be played back when you adjust the velocity, allowing you to audition your changes.
• You can use the Pencil tool to change the velocity of a
single note: click on its velocity bar and drag the bar up or
down.

• The remaining three Line tool modes (Sine, Triangle and
Square) align the velocity values to continuous curve
shapes (see below).

While you drag, the current velocity value is shown in the display to the left.

• You can use the Pencil tool or the Line tool in Paint
mode to change the velocity values of several notes by
painting a “freehand curve”.

Note:
• If there is more than one note at the same position (e.g. a
chord), their velocity bars will overlap in the controller lane.

When editing velocity, these two methods have the same functionality.

If none of the notes are selected, all notes at the same position will be set
to the same velocity value when you draw. To edit the velocity of only one
of the notes at the same position, first select the note in the note display.
Now, editing will only affect the velocity of the selected note.

You can also adjust the velocity of a single note by selecting it and changing its velocity value on the info line.
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Adding and editing events in the controller display

• Clicking and dragging with the Line tool in Line mode
shows a line in the controller lane, and creates events with
values aligned to this line.

When any option other than “Velocity” is selected for a
controller lane, you can create new events or edit the values of existing events using the Pencil tool or the Line tool
in its various modes:

This is the best way to draw linear controller ramps. If you press [Alt]/[Option], no new events are created – use this mode for modifying existing
controller curves.

• Clicking with the Pencil tool or the Line tool in Paint
mode creates a new event.

Converting a controller curve to a ramp
using the Line tool.

Note the “Select Tool defaults to Pen” option – see “Editing velocity values” on page 378.

• Press [Alt]/[Option] and use the Pencil tool or the Line
tool in Paint mode to modify the value of an event (without
creating a new one).
Note that you can click and drag to change or add multiple events, draw
controller curves, etc. You can press or release [Alt]/[Option] while drawing, switching dynamically between “edit mode” and “create mode”.
If you want to enter or adjust a single event, click once with the Pencil
tool or the Line tool in Paint mode.

• The Parabola mode works in the same way, but aligns
the values to a parabola curve instead, giving more “natural” curves and fades.
Note that the result depends on the direction from which you draw the
parabola.

If you want to “paint a curve”, drag the tool (with the mouse button
pressed):

When you move the pointer in the controller lane, the
corresponding value is displayed in this field.

Ö With the Pencil tool and the Line tool in Paint mode, the
quantize value determines the “density” of created controller curves (if Snap is activated, see “Snap” on page 370).
For very smooth curves, you should use a small quantize value or turn off
Snap. However, this will create a very large number of MIDI events, which
can cause MIDI playback to “stutter” in some situations. A medium-low
density is often sufficient.

• In Parabola mode, you can use modifier keys to determine the shape of the parabola curve.
If you press [Ctrl]/[Command], the parabola curve will be reversed. If you
press [Alt]/[Option]+[Ctrl]/[Command] while Snap is activated, you can
change the position of the whole curve (in both cases the snap value for
the positioning will be a quarter of the quantize value). If you press [Shift],
the exponent will be increased or decreased.
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Ö In Line and Parabola modes, the length quantize value
determines the “density” of created controller curves (if
Snap is activated).

Moving and copying events
You can move or duplicate events in a controller lane,
much like you can with notes:

For very smooth curves, you should use a small length quantize value or
turn off Snap. To avoid over-dense controller curves (which may cause
MIDI playback to “stutter”), use a medium-low density.

1. Click with the Arrow tool to select the events you want
to cut or copy.
If the option “Controller Lane Editing: Select Tool defaults to Pen” is activated in the Preferences (Editing–MIDI page), you need to press [Ctrl]/
[Command] to get the Arrow tool.

• The Sine, Triangle and Square modes create events
with values aligned to continuous curves.
In these modes, the quantize value determines the period of the curve
(the length of one curve “cycle”) and the length quantize value determines the density of the events (the lower the length quantize note value,
the smoother the curve).

2. Click and drag the events to move them.
If Snap is activated, this determines to which positions you can move the
events (see “Snap” on page 370).

• In Sine, Triangle and Square mode you can also use
modifier keys to determine the shape of the curve.

• If you hold down [Alt]/[Option] and drag, the events will
be copied rather than moved.

If you press [Ctrl]/[Command] you can change the phase of the beginning
of the curve, if you press [Alt]/[Option]+[Ctrl]/[Command] while snap is
activated you can change the position of the whole curve (in both cases
the snap value for the positioning will be a quarter of the quantize value).

!

If there is an event of the same type at the exact
same position already, this will be replaced by the
moved event.

!

Remember that a non-note event doesn’t have a
length – it’s “valid” until the next event (see “The
controller display” on page 368.

!

When the Auto Select Controllers button is activated
in the Key Editor toolbar, selecting controller events
will also select the corresponding notes. Moving
events (either using cut/copy/paste or drag & drop)
in the note display will also move the corresponding
controller events and vice versa. See also “Selecting
controllers within the note range” on page 372.

Using cut, copy and paste

Ö You can also set the curve period freely by holding
down [Shift] when you insert events in Sine, Triangle or
Square mode.

You can use the standard Cut, Copy and Paste options on
the Edit menu to move or copy events in the controller display:

Activate Snap, [Shift]-click and drag to set the length of one period. The
period length will be a multiple of the quantize value.

1. Select the events you want to cut or copy.

• In Triangle and Square mode, you can press [Shift] +
[Ctrl]/[Command] to change the maximum position of the
triangle curve (to create sawtooth curves) or the pulse of
the square curve. As in other modes, you can press [Alt]/
[Option] if you want to change the existing events rather
than creating new ones. Again, the snap value for the positioning will be a quarter of the quantize value.

2. Select Cut or Copy from the Edit menu.
3. If you want to paste the events into another MIDI part,
open that part in another Key Editor window.
4. Position the project cursor where you want to paste
the events.
5. Select Paste from the Edit menu.
The events on the clipboard are added, starting at the project cursor position, maintaining their relative distances. If a pasted event ends up at
the same position as an existing event of the same type, the old event is
replaced.
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2. Click on the arrow button next to the note number field
to the left of the controller lane.

Deleting events in the controller display
You delete events by clicking on them with the Eraser tool
or by selecting them and pressing [Backspace]. Please
note:

A pop-up menu appears, listing all note numbers for which there already
are Poly Pressure events.

3. Select a note number from the pop-up menu.

• Deleting a controller event makes the last event before
this valid up until the next event. It does not “zero” any
controller changes.

The Poly Pressure events for the selected note number are shown in the
controller lane.

4. Use the Pencil tool to edit the events as usual.

• You can delete notes by deleting their velocity bars in
the controller display.

Press [Alt]/[Option] to edit existing events without adding any new ones.

• Poly Pressure events can also be added and edited in
the List Editor.

Please be aware that if there is more than one note on the same position,
there may still only be one velocity bar visible – make sure you delete only
the desired notes!

Edit In-Place

Adding and editing Poly Pressure events

The Edit In-Place function makes it possible to edit MIDI
parts directly in the Project window, for quick and efficient
editing in context with other tracks.

Poly Pressure events are special, in that they “belong to” a
specific note number (key). That is, each Poly Pressure
event has two editable values: the note number and the
amount of pressure. Therefore, when Poly Pressure is selected on the event type pop-up menu, there are two value
fields to the left of the controller display, one for the note
number and one for the amount:

To open the In-Place editor for one or more selected
tracks, you have the following possibilities:
• Select “Open In-Place Editor” on the MIDI menu.
• Use a key command, by default [Ctrl]/[Command]+[Shift]+[I].
• Toggle the In-Place Editor for all selected tracks by
clicking on the respective button above the Track list.

To add a new Poly Pressure event, proceed as follows:
1. Select Poly Pressure on the event type pop-up menu.
2. Set the note number by clicking on the keyboard display.

• To open a single MIDI track, you can also click the Edit
In-Place button in the Track list (if necessary, expand the
Track list to see the button).

The selected note number is displayed in the upper value field to the left
of the controller display. Note that this only works for the topmost lane. If
you have selected “Poly Pressure” for several controller lanes, you have
to type in the desired note number directly in the lower value field to the
left of each lane.

3. Use the Pencil tool to add a new event, just as when
adding regular controller events.

This expands the MIDI track to show something like a miniature Key Editor, allowing you to edit MIDI notes and controllers.

To view and edit existing Poly Pressure events, proceed
as follows:
1. Select Poly Pressure on the event type pop-up menu.
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• To close the In-Place Editor for one track, you can click
the Edit In-Place button in the Track list or double-click
below the controller display in the In-Place Editor.
Working with Parts
If you work with parts in the In-Place Editor, some editing
functions are available. You can:
• change the length of the parts by clicking on the lower part
edges (so that the mouse pointer changes to a double arrow)
and dragging it to the left or right.
• drag and drop notes from one part to the other.
• change the length of notes by clicking on them and dragging
the double arrow to the left or right.

• To zoom or scroll the In-Place Editor, point at the left
part of the piano keyboard display so that the pointer
changes to a hand. Now you can click and drag to the
right or left to zoom in or out vertically, and drag up or
down to scroll the editor.
• Clicking on the little gray triangle in the upper right corner of the Track list for the edited track brings up a local
toolbar with some settings specific to the In-Place Editor.

For descriptions of these settings, see “The toolbar” on page 366.

• Just like in the Key Editor, you can edit velocity or continuous controllers at the bottom of the In-Place Editor.
To change which controller type is shown, click in the controller name field
directly below the piano keyboard and select a controller type from the
pop-up menu. To add or remove controller lanes, right-click below the controller name field and select an option from the context menu that appears.

• When you select a MIDI note, the Project window info
line shows information about that note, just like the info
line in the Key Editor.
You can perform the same editing here as on the Key Editor info line, see
“Editing on the info line” on page 375.

• The Snap button and Snap type pop-up menu on the
Project window toolbar govern snapping in the In-Place
Editor, but the snap grid is set using the Quantize pop-up
menu.
• To close the In-Place Editor for one or several selected
tracks, you can use the key command or click the “Toggle
the In-Place Editor” button above the Track list.
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The List Editor – Overview
Toolbar

Filter view

Ruler

Value
display

Event list

Event display

The toolbar

The list

The toolbar contains several items that are the same as in
the Key Editor (edit solo, snap, quantize settings, etc.).
These are described earlier in this chapter. The following
toolbar items are unique to the List Editor:

This lists all events in the selected MIDI part(s), in the order (from top to bottom) in which they are played back.
You can edit the event properties by using regular value
editing, see “Editing in the list” on page 384.

• The Insert pop-up menu is used when creating new
events.

The event display
This shows the events graphically. The vertical position of
an event in the display corresponds to its entry in the list
(i.e. to the playback order), while the horizontal position corresponds to its actual position in the project. This is where
you add new parts or events, drag to move them, etc.

This is where you determine what type of event to add (see “Inserting
events” on page 384).

• The Mask pop-up menu and Filter view (Show Filter
View button) allow you to hide events from view, based on
their type and other properties.
See “Filtering” on page 385.

The value display

• The Value View button can be used for hiding and
showing the Value display (see below).

This display shows the “value” of each event, allowing for
easy viewing and graphical editing. Typically, the value
shown is the “Data 2” or “Value 2” property (amounts to
MIDI controller events, velocity for notes, etc.). You can
show or hide this display by clicking the “Show List Value
View” button on the toolbar.

The List Editor has no info line (numerical editing is available in the list instead).
Ö If you see an empty or incomplete list of items although
the items are visible in the Key Editor, check if you have activated any filters (see “Filtering” on page 385).
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List Editor operations

• Notes will get the insert velocity value set in the insert
velocity field on the toolbar. See “Setting velocity values”
on page 371.

Customizing the view
You can click and drag the divider between the list and
the event display to make one area wider and the other
narrower. Furthermore, the list can be customized in the
following ways:

Editing in the list
The list allows you to perform detailed numerical editing of
the events properties. The columns have the following
functionality:

• You can change the order of the columns by dragging
the column headings.
• You can resize columns by dragging the dividers between the column headings.

Column

Description

L

Locate column. An arrow in this column indicates the
event that starts closest before the project cursor position. If you click in this column for an event, the project
cursor is moved to the start of that event. Double-clicking
moves the cursor position and starts/stops playback –
useful for auditioning when editing in the list.

Setting the display format
Just like in the Project window, you set the display format
(bars+beats, seconds, etc.) by right-clicking in the ruler
and selecting an option from the pop-up menu. This setting affects both the ruler and all start, end and length values shown in the list.
Zooming
You can change the horizontal magnification in the event
display by using the zoom slider below the display or the
Zoom tool (the magnification glass).

Type

The event type. This cannot be changed.

Start

The start position of the event, shown in the format selected for the ruler. Changing this is the same as moving
the event. Note that moving the event past any other
event in the list will re-sort the list (the list always shows
the events in the order they are played back).

End

This is only used for note events, allowing you to view and
edit the end position of a note (thereby resizing it).

Length

This is only used for note events. It shows the length of
the note – changing this resizes the note and automatically changes the End value as well.

Data 1

This is the “data 1” or “value 1” property of the event. The
content of this depends on the event type – for notes,
this is the pitch, for example. Where applicable, the values are shown in the most relevant form. For instance, the
Data 1 value for notes is shown as a note number in the
format selected in the Preferences (Event Display–MIDI
page). See also the table in the section “Editing in the value display” on page 386.

Data 2

This is the “data 2” or “value 2” property of the event. The
content of this depends on the event type – for notes,
this is the velocity value, for example. See the table in the
section “Editing in the value display” on page 386.

Channel

The MIDI channel of the event. Note that this setting is
normally overridden by the channel setting for the track.
To make a MIDI event play back on “its own” channel, set
its track to channel “Any” in the Project window.

Comment

This column is used for some event types only, providing
an additional comment about the event.

Inserting events
To add a new event to the edited part, proceed as follows:
1. Use the Insert pop-up menu on the toolbar to select
the event type.

2. Select the Pencil tool and click in the event display at
the desired position (relative to the ruler).

• You can edit several events at once. If several events
are selected and you edit a value for one event, the other
selected events’ values will be changed as well.

If you are creating note events, you can click and drag to set the length of
the note.

Normally, any initial value differences between the events will be maintained – i.e. the values will change by the same amount. If you press [Ctrl]/
[Command] when you edit, however, all events will get the same value.

The new event appears in the list and in the display. Its
properties will be set to default values, but can be adjusted in the list.
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Ö For SysEx (system exclusive) events, you can only edit
the position (Start) in the list.

• To see one event type only (hide all other event types),
press [Ctrl]/[Command] and click its checkbox. If you
[Ctrl]/[Command]-click again, all checkboxes are cleared
(all events will be visible).

However, when you click the Comment column, the MIDI SysEx Editor
opens, in which you can perform detailed editing of system exclusive
events (see “Working with System Exclusive messages” on page 410).

Ö The event types remain hidden even if you close the filter view.

Editing in the event display

To make sure you see all events, open the filter view and check that all
checkboxes are deactivated.

The event display allows you to edit the events graphically
using the tools on the toolbar. You can edit single events
as well as several selected events simultaneously.

Ö The filter view does not remove, mute or change the
events in any way.

• To move an event, click and drag it to a new position.
Note that moving the event past any other event in the display will re-sort
the list (the list always shows the events in the order they are played
back). As a result, the vertical position of the event in the display will
change as well.

Masking

• To make a copy of an event, press [Alt]/[Option] and
drag it to a new position.
• To resize a note, select it and drag its end point with the
Arrow tool as in the Project window.
This only works with notes.

• To mute or unmute an event, click on it with the Mute
tool.
You can mute or unmute several events in one go by enclosing them in a
selection rectangle with the Mute tool.

The Mask function is similar to the filter view but allows
you to hide events based on other criteria as well. Proceed as follows:

• You can select a color scheme for the events with the
Colors pop-up menu on the toolbar.
This affects how all MIDI events are shown in the List and Key editors –
see “Coloring notes and events” on page 370.

1. Select an event (or several events) of the type you want
to view.

• To delete an event, select it and press [Backspace] or
[Delete], or click on it with the Eraser tool in the event display.

2. Pull down the Mask pop-up menu on the toolbar and
select one of the options.
The results are as follows:

Filtering

Clicking the “Show Filter View” button on the toolbar
opens an additional filter bar that allows you to hide specific event types from view. For example, it may be hard to
find note events if the part contains a lot of controllers. By
hiding these, the list becomes more manageable.

Option

Description

Event Types

Only events with the type of the selected event will be
shown. This does the same as the filter view but is
quicker if you only want to view a single event type.

Event Types
and Data 1

Only events of the same type and with the same “Data 1”
value will be shown. For example, if a note event is selected, only notes with the same pitch will be shown. If a
controller event is selected, only controllers of the same
type will be shown.

Event Channels Only events with the same MIDI channel value as the selected event will be shown.

• To hide an event type, activate its checkbox on the filter
view.
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In addition to the above options, the menu also gives you
access to the presets available in the Logical Editor (see
“The Logical Editor, Transformer and Input Transformer”
on page 387). Furthermore, the “Setup…” item on the
Mask pop-up menu gives you direct access to the Logical
Editor. In that editor you can create very complex masking
settings.

Exactly which value is shown for an event depends on the
event type. The following table shows what is displayed
and edited in the Data columns and the value display:
Event type

Data 1

Data 2

Value display

Note

Pitch
(note number)

Velocity

Velocity

Controller

Controller type

When you apply any of the presets from the Logical Editor
or use the Logical Editor to create masking settings yourself, only the events that meet the criteria specified will be
visible.

Controller
amount

Controller
amount

Program
Change

Program
number

Not used

Program
number

Aftertouch

Aftertouch
amount

Not used

Aftertouch
amount

• To deactivate the Mask function, select “Nothing” from
the Mask pop-up menu.

Pitch Bend

Bend amount

Not used

Bend amount

SysEx

Not used

Not used

Not used

The most typical usage of the Mask function is to view a
certain type of controller only (e.g. Modulation, Breath
Control, etc.). Since these are all the same event types
(controller), this would not be possible using the filter
view. With the “Event Types and Data 1” option on the
Mask pop-up menu, it is!

• The value display can be hidden from view by clicking
the “Show List Value View” button on the toolbar, so that it
is not lit.

Editing in the value display
The value display to the right of the event display is a tool
for quick viewing and editing of multiple values, e.g. velocities or controller amounts. The values are shown as horizontal bars, with the bar length corresponding to the value.

A velocity ramp in the value display.

You edit the values by clicking and dragging. Note that the
pointer automatically takes on the shape of the Pencil tool
when you move it into the value display – you don’t have to
select the Pencil tool for this.
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28
The Logical Editor, Transformer and
Input Transformer

Introduction

About the Input Transformer
Again, this is very similar to the Logical Editor. Just like the
Transformer effect, the Input Transformer works in real
time. However, the Input Transformer filters out and transforms MIDI data as it is recorded. In other words, the settings you make in the Input Transformer will affect the
actual MIDI events you record.

Most of the time you will perform your MIDI editing graphically in one of the main graphic editors. But there are times
when you want more of a “search and replace” function on
MIDI data, and that’s where the Logical Editor comes in.
The principle for the Logical Editor is this:
• You set up filter conditions to find certain events.

The Input Transformer is described in the section “The Input Transformer” on page 397. However, we recommend
that you make yourself familiar with the Logical Editor first,
since they share many features and principles.

This could be events of a certain type, with certain attributes or values or
on certain positions, in any combination. You can combine any number of
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.

About the Project Logical Editor

The options include Transform (changing properties of the found events),
Delete (removing the events), Insert (adding new events based on the
found events’ positions) and more.

There is also a “Project Logical Editor” available via the
Edit menu. This is described in the chapter “The Project
Logical Editor” on page 399.

• You set up a list of actions, which specify exactly what
should be done.
This is not necessary for all functions. For example, the Delete function
does not require any additional action specifications – it simply removes
all found events. The Transform function on the other hand requires that
you specify which properties should be changed and in which way
(transpose notes by a certain amount, adjust velocity values, etc.).

Opening the Logical Editor
1. Select the desired parts or events.
What will be affected by the operation depends on the current selection:

• In the Project window, edits using the Logical Editor are applied to all selected parts, affecting all events (of the relevant
types) in them.
• In the MIDI editors, edits using the Logical Editor are applied
to all selected events. If no events are selected, all events in
the edited part(s) will be affected.

By combining filter conditions, functions and the specific
actions, you can perform very powerful processing.
To master the Logical Editor you need some knowledge
about how MIDI messages are structured. However, the
Logical Editor also comes with a rich selection of presets,
allowing you to access its processing powers without
delving into its more complicated aspects, see “Selecting
a preset” on page 389.

You can change the selection while the Logical Editor
window is open.
2. Select “Logical Editor…” from the MIDI menu.

!

Studying the included presets is an excellent way to
learn the workings of the Logical Editor! Many of them
can also be used as starting points when you set up
your own editing operations using the Logical Editor.

Ö For details on how to open the Transformer (and other
MIDI effects), see “MIDI realtime parameters and effects”
on page 342.

About the Transformer MIDI effect
The Transformer effect is a real-time version of the Logical
Editor, allowing you to apply editing to the events played
back from a track “on the fly”. The Transformer contains
virtually the same settings and functions as the Logical
Editor – where there are differences between the two, this
is clearly stated on the following pages.
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Window overview
This is the filter condition
list, specifying which
events to look for.

Setting up filter conditions

This is where you select a function
(Transform, Delete, etc.). The field to the
right shows an additional explanation of
the selected function.

General procedure

The upper list is where you set up the filter conditions, determining which events to find. The list contains one or
several conditions, each on a separate line.
Ö If you want to start from scratch (as opposed to basing
your settings on an existing preset), you may want to initialize the settings by selecting the Init option from the
Presets pop-up menu.
This is the action
list, specifying e.g.
how to change the
found events.

This is where you load,
store and handle presets. See “Working with
presets” on page 397.

• To add a new line (condition), click the Add Line button
to the right.

The “Do It” button
performs the task
you have set up
(not available in
the Transformer).

The new line is added at the bottom of the list. If there are many lines, you
may need to use the scrollbar to the right to view them.

• To remove a line, click anywhere on it to select it and
click the Delete Line button to the right.

Selecting a preset

You set up a filter condition line by clicking in the columns
and selecting options from the pop-up menus that appear.
Here is a brief description of the columns:

To understand the Logical Editor, it might be a good idea to
start by exploring the included presets. These are found on
the Presets pop-up menu at the bottom of the window, to
the right.

Column

Description

Left bracket

This is used for “bracketing” several lines together when
creating conditions with multiple lines and the boolean
operators And/Or. See “Combining multiple condition lines” on page 393.

Filter Target

Here you select which property to look for when finding
events. Your choice here affects the available options in
the other columns as well, see below!

Condition

This determines how the Logical Editor should compare
the property in the Filter Target column to the values in
the Parameter columns (Equal, Unequal, Bigger, etc. –
see the separate table below). The available options depend on the Filter Target setting.

Parameter 1

Here you set which value the event properties should be
compared to (a numeric value, a position or a choice from
a pop-up menu, depending on the Filter Target).
For example, if the Filter Target is “Position” and Condition
is “Equal”, the Logical Editor will look for all events starting
at the position you specify in the Parameter 1 column.

Parameter 2

This column is only used if you have selected one of the
“Range” options in the Condition column. Typically, this
allows you to find all events with values inside (or outside) the range between Parameter 1 and Parameter 2.

• To load a preset, select it from the Presets pop-up menu.
The window will show the settings stored in the preset. As the preset is
not applied to the MIDI events yet, you can load different presets just to
study them without affecting any events. You can also edit the preset before applying it.

• To apply the loaded preset (i.e. to perform the operations defined in the Logical Editor), click Do It.
Ö You can also select Logical Presets directly from the
MIDI menu.
This allows you to apply a preset to the selected MIDI part directly, without having to open the Logical Editor.

Ö It is also possible to select and apply Logical Presets
directly in the List Editor (from the Mask menu). You can
also open the Logical Editor from the List Editor.
For information on how to create and handle your own
presets, see “Working with presets” on page 397.
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Column

Description

Condition

Events will be found if their Filter Target property…

Bar Range

This column is only used if the Filter Target is “Position”
and one of the “Bar Range” options is selected in the
Condition column. In these cases, you use the Bar Range
column to specify “zones” within each bar (allowing you
to find e.g. all events on or around the first beat of every
bar). See “Searching for events at certain positions” on
page 390.

Inside Track
Loop

…is inside the set track loop (Position only).

Right bracket

This is used for “bracketing” several lines together. See
“Combining multiple condition lines” on page 393.

bool

This allows you to insert the boolean operators And/Or,
when creating conditions with multiple lines. See “Combining multiple condition lines” on page 393.

Inside Cycle

…is inside the set cycle (Position only).

Exactly matching Cycle

…exactly matches the set cycle (Position only).

Note is equal to …is the note specified in the Parameter 1 column, regardless of octave (Pitch only). Lets you find e.g. all C
notes, in all octaves.

Ö The Conditions for the “Property” filter target are different, see “Searching for properties” on page 392.
Below, the different Filter Targets (and their corresponding Condition and Parameter options) are described in
more detail.

• You can also set up filter conditions by dragging MIDI
events directly into the upper list.
If the list contains no line entries, a MIDI event dragged into this section will
form conditions including the state and type of the event. If it contains entries, the dragged event(s) will initialize the matching parameters. E.g. if a
length condition is used, the length will be set according to the event
length.

Searching for events at certain positions

Conditions

Selecting Position in the Filter Target column lets you find
events starting at certain positions, either relative to the
start of the song or within each bar.

The options in the Condition column have the following
meaning (note that the available Condition options depend on the Filter Target setting):

• If you select any condition other than the Range or Bar
Range options, you set up a specific position (in bars,
beats, sixteenth notes and ticks) in the Parameter 1 column.

Condition

Events will be found if their Filter Target property…

Equal

…has the exact same value as set up in the Parameter 1
column.

Unequal

…has any value other than the one set up in the Parameter 1 column.

Bigger

…has a value higher than the one set up in the Parameter
1 column.

Here, the Logical Editor will find all events at 5.1.1. in the project.

Less

…has a value lower than the one set up in the Parameter
1 column.

• If you select Inside Range or Outside Range in the Condition column, you set the start position of the range in the
Parameter 1 column and the end position in the Parameter
2 column.

Less or Equal

…has a value that is the same as or lower than the one
set up in the Parameter 1 column.

The Logical Editor will then find all events inside or outside this position
range.

Inside Range

…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter
1 should be the lower value and Parameter 2 the higher.

Bigger or Equal …has a value that is the same as or higher than the one
set up in the Parameter 1 column.

Outside Range …has a value that is not between the values set up in the
Parameter 1 and Parameter 2 columns.
Inside Bar
Range

…is within the “zone” set up in the Bar Range column
(Position only), in each bar within the current selection.

Outside Bar
Range

…is outside the “zone” set up in the Bar Range column
(Position only), in each bar within the current selection.

Before Cursor

…is before the song cursor position (Position only).

Beyond Cursor …is after the song cursor position (Position only).
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• If you select one of the Bar Range options in the Condition column, the Bar Range column will show a graphic
bar display. You specify the range within the bar by clicking and dragging in the bar display (the specified Bar
Range is indicated in blue).

Since value 1 and 2 have different meanings for different
events, searching for e.g. value 2 = 64 would both find
notes with the velocity 64 and controllers with the amount
64, etc. If this is not what you want, you can add an additional filter condition line with the Filter Target “Type”,
specifying which type of events to find (see below).

The Logical Editor will then find all events starting inside or outside this
Bar Range, in all bars (within the current selection).

!

This is particularly useful when searching for note
pitch or velocity values, as described below.

The general procedures when searching for value 1 or 2
are:
• If you select any Condition other than the Range options,
you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find events starting around the second beat
in each bar.

Searching for notes of certain lengths
Only note events have lengths (actually, a note is made up
of separate note-on and note-off events but in Nuendo it’s
considered as a single event with a length). Therefore, the
“Length” Filter Target is only valid if you’re specifically
searching for notes – there has to be another condition
line with the Filter Target “Type”, Condition “Equal” and
Parameter 1 set to “Note”. See “Combining multiple condition lines” on page 393 for more about using multiple filter conditions.

Here, the Logical Editor will find all events with a value 2 less than 80.

• If you select Inside Range or Outside Range in the Condition column, the range consists of the values between
Parameter 1 and Parameter 2.
Note that Parameter 1 should have the lower value.

Searching for note pitch or velocity

Searching for Value 1 or Value 2

If you add another condition line with the Filter Target
“Type”, Condition “Equal” and Parameter 1 set to “Note”,
the Logical Editor will “know” you are searching for pitch
or velocity. This has the following benefits:

A MIDI event is composed of several values. The meanings of value 1 and 2 depend on the type of event:
Event type

Value 1

Notes

The Note Number/Pitch. The velocity of the note.

Value 2

PolyPressure

The key that was
pressed.

The amount of pressure for
the key.

Controller

The type of Controller,
displayed as a number.

The amount of Control
Change.

Program Change

The Program Change
number.

Not used.

Aftertouch

The amount of pressure. Not used.

Pitchbend

The “fine tune” of the
The coarse amount of bend.
bend. Not always used.

• The Filter Targets Value 1 and Value 2 will be displayed as
“Pitch” and “Velocity” respectively, making it easier to grasp
the function of the filter condition.
• Pitch values in the Parameter columns will be displayed as
note names (C3, D#4, etc.). When entering pitch values you
can either type a note name or a MIDI note number (0–127).
• When Value 1 (pitch) is selected as Filter Target, an additional
option appears in the Condition column: “Note is equal to”.
When this is selected, you specify a note name in the Parameter 1 column but without any octave number (C, C#, D, D#,
etc.). The Logical Editor can then find all notes of a certain key,
in all octaves.

Ö System Exclusive events are not included in the table
above, since they don’t use value 1 and 2.

See “Combining multiple condition lines” on page 393 for
more info on working with multiple filter condition lines.
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Searching for controllers

Searching for properties

There is similar extended functionality when searching for
controllers: If you’ve added an additional “Type = Controller” condition line, the Logical Editor will “know” you are
searching for controllers. The Parameter 1 column will
then show the names of the MIDI controllers (Modulation,
Volume, etc.) when Value 1 is selected as Filter Target.

On the Filter Target pop-up menu you will find an option
called Property. This allows you to search for properties
that are not part of the MIDI standard but rather eventspecific Nuendo settings.
When the Property option is selected, the Condition column has two options: “Property is set” and “Property is not
set”. Which property to look for is selected in the Parameter
1 column. The options are “muted” and “selected”. Two examples:

Searching for MIDI channels
Each MIDI event contains a MIDI channel setting (1–16).
Normally, these settings are not used, since the MIDI event
plays back on the MIDI channel set for its track. However,
you can come across MIDI parts with events set to different
channels, for example in the following scenarios:
• If you have recorded MIDI from an instrument sending on several different channels (e.g. a master keyboard with different
key zones).
• If you have imported a MIDI file of type 0 (with a single track,
containing MIDI events with different channel settings).

Here, the Logical Editor will find all muted events.

Searching for MIDI channel values is straightforward; you
select a Condition and enter a MIDI channel (1–16) in the
Parameter 1 column (and, if you’ve selected one of the
Range Conditions, a higher channel in the Parameter 2
column, creating a value range).

Here, the Logical Editor will find all events that are selected but not
muted.

Searching for event contexts
On the Filter Target pop-up menu you will find an option
called “Last Event”. This can be used to perform context
dependent searches (especially useful in the Input Transformer).

Searching for event types
Selecting Type as the Filter Target allows you to find
events of a certain type only.
• The Condition column contains only three options: Equal, Unequal and All Types.
• Clicking the Parameter 1 column displays a pop-up menu, listing the available event types (Note, PolyPressure, Controller,
etc.).

“Last Event” indicates the state of an event which has already passed the Input Transformer/Logical Editor. The
condition has to be combined with Parameter 1 and Parameter 2.
A few examples on how the Last Event filter target can be
used:

The Logical Editor will find all events matching or not
matching the selected type (depending on the Condition).
!

Here, the action will only be performed when the sustain
pedal is down:

As mentioned above, selecting Type = Note or
Type = Controller adds some additional functionality
to the Logical Editor. You should make it a habit to
add a Type condition when applicable.

Fiiter Target

Condition

Parameter 1

Last Event

Equal

MIDI Status

176/Controller

Last Event

Equal

Value 1

64

Last Event

Bigger

Value 2

64
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Parameter 2

Ö If two condition lines are separated by a boolean Or,
one of the conditions (or both) must be fulfilled for an
event to be found.

In this example, the action will be performed when the
note C1 is pressed (the “Note is playing” condition is only
available in the Input Transformer and in the Transformer
effect):
Filter Target

Condition

Parameter 1

Type is

Equal

Note

Last Event

Equal

Note is playing

Parameter 2

36/C1
The Logical Editor will find all events that are notes (regardless of their
position) and all events starting at the beginning of the third bar (regardless of their type).

In this example, the action will be performed after playing
the C1 note:
Filter Target

Condition

Parameter 1

Parameter 2

Last Event

Equal

Value 1

36/C1

!

Combining multiple condition lines
As described above, you can add condition lines by clicking the Add Line button to the right of the list. The result of
combining condition lines depends on the boolean And/
Or operators and the brackets.

When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is
set up two or more conditions that all must be met
for an event to be found, you don’t have to think
about the boolean column – just add the required
lines and make the usual filter settings.

Using brackets
The bracket (parenthesis) columns let you enclose two or
more condition lines, dividing the conditional expression
into smaller units. This is only relevant when you have
three or more condition lines and want to use the boolean
Or operator. This is how it works:

The bool column
By clicking in the “bool” column to the right in the list, you
can select a boolean operator: “And” or “Or”. A boolean
operator separates two condition lines and determines the
result in the following way:

Ö Without brackets, the conditional expressions are
evaluated according to their order in the list.

Ö If two condition lines are separated by a boolean And,
both conditions must be fulfilled for an event to be found.

In this case we have the expression Type = Note AND Pitch = C3
(Win)/60 (Mac) OR Channel = 1, without brackets. This means that the
Logical Editor will find all MIDI notes with the pitch C3, as well as all
events (regardless of their type) set to MIDI channel 1.

The Logical Editor will only find events that are notes and start at the
beginning of the third bar.

Maybe you wanted to find all notes that either had the
pitch C3 or the MIDI channel 1 (but no non-note events)?
Then you need to add some brackets:

Here the expression is Type = Note AND (pitch = C3 (Win)/60 (Mac)
OR Channel = 1), which will find what you want. The rule behind this is:
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Ö Expressions within brackets are evaluated first.

Below, the available options are listed. Note that some options are available in the Logical Editor only – not in the
Transformer effect.

If there are several layers of brackets, these are evaluated “from the inside out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and
selecting an option. Up to triple brackets can be selected.

Delete

Editing filter conditions as text

Deletes all events found by the Logical Editor. In the case
of the Transformer, this function will remove (or “mute”) all
found events from the “output stream” – the actual events
on the track are not affected.
Transform
Changes one or several aspects of the found events. You
set up exactly what should be changed in the action list,
see “Specifying actions” on page 395.

The area directly below the filter condition list shows you
the current filter conditions as text. It also allows you to
enter and edit the filter conditions in textual form. For tips
on the syntax, please study the included presets.

Insert
This will create new events and insert these into the
part(s) (Logical Editor) or the output stream (Transformer).
The new events will be based on the events found by the
Logical Editor’s filter conditions, but with any changes you
have set up in the action list applied.

Ö There is no additional functionality involved when editing filter conditions as text; it is simply another way to
make settings.
When you enter something in the text field you will see the corresponding settings appear in the filter condition list (provided that you have used
the correct syntax).

Another way of expressing this is that the Insert function
copies the found events, transforms them according to the
action list and inserts the transformed copies among the
existing events.

Selecting a function

Insert Exclusive
This will transform the found events according to the action list. Then, all events that were not found (that didn’t
meet the filter conditions) are deleted (Logical Editor) or
removed from the output stream (Transformer).
Copy (not available in the Transformer)
This will copy all found events, transform them according
to the action list and paste them into a new part on a new
MIDI track. The original events are not affected.

The pop-up menu in the top left corner of the Logical Editor is where you select the function – the basic type of editing to be performed. When you select an option from the
pop-up menu, the field to the right displays a comment,
making it easier to see what the function does.
!

Extract (not available in the Transformer)
This works like Copy, but will cut the found events instead.
Or in other words, Extract will transform all found events
and move them to a new part on a new MIDI track.

In the Logical Editor, processing isn’t performed until
you click the Do It button. When using the Transformer MIDI effect, there is no Do It button – the current settings are automatically applied in real time
during playback or live playing.

Select (not available in the Transformer)
This will simply select all found events, highlighting them
for further work in the regular MIDI editors.
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Specifying actions

Operation
This setting determines what to do with the Action Target.
The options on this pop-up menu are different depending
on the selected Action Target. Below, all available operations are listed:
Add

The lower list in the Logical Editor window is the action
list. This is where you specify any changes that should be
made to the found events (relevant for all function types
except Delete and Select).

Adds the value specified in the Parameter 1 column to the
Action Target.
Subtract

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the Add Line button to the right,
and fill out the columns as required. To remove a superfluous action line, select it and click the Delete Line button.

Subtracts the value specified in the Parameter 1 column
from the Action Target.
Multiply by
Multiplies the Action Target value with the value specified
in the Parameter 1 column.

Action Target
This is where you select the property that should be
changed in the events:

Divide by

Option

Description

Divides the Action Target value by the value specified in
the Parameter 1 column.

Position

Adjusting this value will move the events.

Length

Lets you resize the events (notes only).

Round by

Value 1

This adjusts value 1 in the events. As described in the
section “Searching for Value 1 or Value 2” on page 391,
the meaning of value 1 depends on the event type. For
notes, value 1 is the pitch.

Value 2

This adjusts value 2 in the events. As described in the
section “Searching for Value 1 or Value 2” on page 391,
the meaning of value 2 depends on the event type. For
notes, value 2 is the velocity value.

This “rounds” the Action Target value using the value
specified in the Parameter 1 column. In other words, the
Action Target value is changed to the closest value that
can be divided by the Parameter 1 value.

Channel

Allows you to change the MIDI channel setting. See
“Searching for MIDI channels” on page 392.

Type

Allows you to change an event from one type to another,
e.g. transform aftertouch events to modulation events.

Value 3

This adjusts value 3 in the events, which is used for handling of Noteoff-velocity when searching for properties.
See “Searching for properties” on page 392.

For example, if the Action Target value is 17 and Parameter 1 is 5, the result of rounding will be 15 (the closest
value that can be divided by 5). Another word for this type
of operation would be “quantizing”, and it’s actually possible to use it for this, by setting the Action Target to “Position” and specifying a quantize value with Parameter 1 (in
ticks, with 480 ticks per quarter note).
Set Random Values between
This will set the Action Target value to a random value
within the range specified with Parameter 1 and 2.
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Set Relative Random Values between

Use Value 1

This will add a random value to the current Action Target
value. The added random value will be within the range
specified with Parameter 1 and 2. Note that these can be
set to negative values.

This is only available when Action Target is set to Value 2.
If this option is selected, the Value 1 setting in each event
will be copied to the Value 2 setting.
Mirror

For example, if you set Parameter 1 to -20 and Parameter
2 to +20, the original Action Target value will get a random variation, never exceeding ±20.
Set to fixed value

This is only available when Action Target is set to Value 1
or Value 2. When this option is selected, the values will be
“mirrored” or “flipped” around the value set in the Parameter 1 column.

This sets the Action Target to the value specified in the
Parameter 1 column.

In the case of notes, this will invert the scale, with the key
set in the Parameter 1 column as “center point”.

Add Length

Linear Change in Loop Range

This is only available when Action Target is set to Position.
Furthermore, it is only valid if the found events are notes
(and thus have a length). When Add Length is selected,
the length of each note event will be added to the Position
value. This can be used for creating new events (using the
Insert function) positioned relative to the end positions of
the original notes.

This will affect events within the loop range (between the
left and right locators) only. It will create a linear “ramp” of
values (replacing the original values) starting at the value
in the Parameter 1 column and ending at the Parameter 2
value.
This can be used for creating linear controller sweeps, velocity ramps, etc.

Transpose to Scale

Relative Change in Loop Range

This is only available when Action Target is set to Value 1,
and when the filter conditions are specifically set up to
find notes (a “Type = Note” filter condition line has been
added). When “Transpose to Scale” is selected, you can
specify a musical scale using the Parameter 1 and 2 columns. Parameter 1 is the key (C, C#, D, etc.) while Parameter 2 is the type of scale (major, melodic or harmonic
minor, etc.).

As with the previous option, this will create a ramp of values, affecting events in the cycle loop range only. However, here the changes are “relative”, meaning that values
will be added to the existing values.
In other words, you set up a value ramp starting at Parameter 1 and ending at Parameter 2 (note that the Parameter values can be negative). The resulting value ramp is
then added to the existing values for the events within the
cycle loop range.

Each note will be transposed to the closest note in the selected scale.

For example, if you apply this to note velocities with Parameter 1 set to 0 and Parameter 2 set to -100, you create a
velocity fade-out, keeping the original velocity relations:

Use Value 2
This is only available when Action Target is set to Value 1.
If this option is selected, the Value 2 setting in each event
will be copied to the Value 1 setting.
For example, this would be useful if you are transforming
all Modulation controllers to Aftertouch events (since controllers use Value 2 for their amount, while Aftertouch uses
Value 1 – see “Searching for Value 1 or Value 2” on page
391).
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Applying the defined actions

This also makes it easy to share presets with other Nuendo users, by transferring the individual preset files.

Once you have set up filter conditions, selected a function
and set the required actions (or loaded a preset), you apply the actions defined with the Logical Editor by clicking
the Do It button.

Ö The list of presets is read each time the Logical Editor
is opened.

The Input Transformer

Logical Editor operations can be undone just like any
other editing.

This function allows you to selectively filter out and change
MIDI data coming to a MIDI track before it is recorded. The
Input Transformer is very similar to the Transformer MIDI effect, but contains four independent “modules”, for which
you can set up different filtering and actions if you like. You
can activate any or all of these four modules.

Ö Again, when using the Transformer MIDI effect there is
no Do It button. The processing is applied to the events
played back from the track (or played live “thru” the track)
as soon as you set it up.
Since no existing events on the track are affected by the Transformer
setting, there is no need for undo.

Here are some of the things the Input Transformer allows
you to do the following:

Working with presets

• Set up split keyboard combinations for recording left and right
hands separately.
• Turn a controller like a foot pedal into MIDI notes (for playing
bass drum the right way).
• Filter out one specific type of MIDI data on one MIDI channel
only.
• Turn aftertouch into any controller (and vice versa).
• Invert velocity or pitch.

The Presets section in the bottom right section of the window allows you to load, store and manage Logical Editor
presets. A preset contains all settings in the window,
which means you can simply load a preset and click Do It.
Ö To load a preset, select it from the Presets menu.
Storing your own settings as a preset

Again: four of these things can be done at the same time.

If you have made Logical Editor settings that you want to
use again, you can store them as a preset:

Opening the Input Transformer

1. You can enter some explanatory text in the Comment
field.

To open the Input Transformer for a MIDI track, select the
track and click the Input Transformer button in the Inspector to open the pop-up menu:

An extra description of the preset can be useful, especially if the settings
are complex.

2. Click the Store button in the Presets section.
A dialog for specifying a name for the new preset is displayed.

3. Enter a name for the preset and click OK.
The preset is stored.

Ö To remove a preset, load it and click the Remove button.

• Select Global to make Input Transformer settings that
affect all MIDI inputs (and thereby all MIDI tracks).

Organizing and sharing presets

• Select Local to make Input Transformer settings for this
track only.

The Logical Editor presets are stored within the application folder in the Presets\Logical Edit subfolder (see also
“Where are the settings stored?” on page 514). While
these files cannot be edited “manually”, you can reorganize them (e.g. putting them in subfolders) like any files.
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In both cases, the button lights up and the Input Transformer opens.

Setting up filtering and actions
This is done just like in the Logical Editor. Here is a brief
rundown:
• Click the Add Line buttons to add lines to the filter condition list or action list.
To remove a line, click it to select it and click the Delete Line button to
the right.

• Clicking the columns in the filter condition list opens
pop-up menus allowing you to specify the conditions to
match.
• Clicking the columns in the action list opens pop-up
menus allowing you to specify what should be done to the
found events (when Transform mode is selected).

Handling the four modules
The Input Transformer is really four separate transformers,
or modules.

For detailed descriptions of the filter conditions and action
columns, see “General procedure” on page 389.

• You select which module to view and make settings for
by clicking its button in the Selected Module section.

• Selecting the Init option from the Presets pop-up menu
will reset the selected module, removing all filter condition
and target list lines.
• The Input Transformer has no “Do It” button – the settings are active as soon as you activate an Active Module
checkbox.

Module 2 selected for viewing and editing.

• The checkboxes in the Active Module section determine
which module(s) are active.

The settings made in the activated modules will affect all MIDI data you
record on the track.

Ö Closing the Input Transformer window does not turn it
off – you need to deactivate all Active Module checkboxes
for this!
A lit Input Transformer button in the Inspector indicates that one or more
modules are active.

Here, modules 1, 2 and 4 are active.

The two modes
The Mode pop-up menu contains two options: Filter and
Transform.
• In Filter mode, only the filter conditions (the upper list)
are taken into account. All events matching the conditions
set up will be filtered out (excluded from the recording).
• In Transform mode, events matching the filter conditions
will be transformed according to the settings in the action
list (the lower list).
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29
The Project Logical Editor

Introduction

By combining filter conditions, functions and the specific
actions, you can perform very powerful processing.

On the Edit menu you will find the function “Project Logical Editor…” that opens a Project Logical Editor for the
entire project. It works similar as the Logical Editor on the
MIDI menu, see “The Logical Editor, Transformer and Input Transformer” on page 387. The most important difference is, that the Logical Editor for MIDI works on event
level whereas the Project Logical Editor works on project
level, and is therefore a very powerful tool for “search and
replace” functions in your project.

!

Opening the Project Logical Editor
1. Open the desired project.

Ö The MIDI events in the MIDI parts will not be affected
by the Project Logical Editor operations. If you want to
change MIDI notes or controller data, you have to use the
Logical Editor, see “The Logical Editor, Transformer and
Input Transformer” on page 387.
!

The Project Logical Editor allows all kind of settings
that may not always make sense. Experiment a bit before applying your edits to important projects. You can
undo the operations by using the Undo command on
the Edit menu.

All elements in the project will be affected, you do not have to make any
selection.

2. Select “Project Logical Editor…” from the Edit menu.

Window overview

When we speak of “events” in this chapter, we refer
to all the Project window elements that can be modified with the Project Logical Editor, e.g. MIDI parts,
audio events and parts, Transpose parts, Arranger
parts, automation events, etc.

This is the filter condition
list, specifying which
events to look for.

This is where you select a function
(Transform, Delete, etc.). The field to the
right shows an additional explanation of
the selected function.

The Project Logical Editor allows you to create “macros”,
e.g. for special track type operations on tracks that are
named identically. You can use its functions to delete all
muted MIDI parts or to toggle the open state of all folder
tracks in your project, etc.
Included with the Project Logical Editor are a number of
presets that give you an impression of the great possibilities that this feature offers, see “Selecting a preset” on
page 401. Many of them can also be used as starting
points when you set up your own editing operations.
The principle for the Project Logical Editor is this:
This is the action
list, specifying e.g.
how to change the
found events.

• You set up filter conditions to find certain events.
This could be events of a certain type, with certain attributes or values or
on certain positions, in any combination. You can combine any number of
filter conditions and make composite conditions using AND/OR operators.

• You select the basic function to be performed.
The options are Transform (changing properties of the found events),
Delete (removing the events) and Select (selecting the found events).

• You set up a list of actions, which specify exactly what
should be done.
This is not necessary for all functions. For example, the Delete function
does not require any additional action specifications – it simply removes
all found events.
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This is where you load,
store and handle presets. See “Working with
presets” on page 409.

The “Do It” button
performs the task
you have set up.

Selecting a preset

You set up a filter condition line by clicking in the columns
and selecting options from the pop-up menus that appear.
Here is a brief description of the columns:

To understand the Project Logical Editor, it might be a good
idea to start by exploring the included presets. These are
found on the Presets pop-up menu at the bottom of the
window, to the right.

Column

Description

Left bracket

This is used for “bracketing” several lines together when
creating conditions with multiple lines and the boolean
operators And/Or. See “Combining multiple condition lines” on page 406.

Filter Target

Here you select which property to look for when finding
elements. Your choice here affects the available options
in the other columns as well, see below!

Condition

This determines how the Project Logical Editor should
compare the property in the Filter Target column to the
values in the Parameter columns (see the separate table
below). The available options depend on the Filter Target
setting.

Parameter 1

Here you set which value the element properties should
be compared to (depending on the Filter Target).
For example, if the Filter Target is “Position” and Condition is “Equal”, the Project Logical Editor will look for all
elements starting at the position you specify in the Parameter 1 column.

Parameter 2

This column is only used if you have selected one of the
“Range” options in the Condition column. Typically, this
allows you to find all elements with values inside (or outside) the range between Parameter 1 and Parameter 2.

Bar Range

This column is only used if the Filter Target is “Position”
and one of the “Bar Range” options is selected in the
Condition column. In these cases, you use the Bar Range
column to specify “zones” within each bar (allowing you
to find e.g. all elements on or around the first beat of every bar). See “Searching for elements at certain positions” on page 404.

Right bracket

This is used for “bracketing” several lines together. See
“Combining multiple condition lines” on page 406.

bool

This allows you to insert the boolean operators And/Or,
when creating conditions with multiple lines. See “Combining multiple condition lines” on page 406.

• To load a preset, select it from the Presets pop-up menu.
The window will show the settings stored in the preset. As the preset is
not applied to the events yet, you can load different presets just to study
them without affecting any events. You can also edit the preset before
applying it.

• To apply the loaded preset (i.e. to perform the operations defined in the Project Logical Editor), click Do It.
Ö You can also open the Edit menu and select Presets directly from the “Process Project Logical Editor” submenu.
This allows you to apply a preset directly, without having to open the
Project Logical Editor.

For information on how to create and handle your own
presets, see “Working with presets” on page 409.

Setting up filter conditions
General procedure

The upper list is where you set up the filter conditions, determining which elements to find. The list contains one or
several conditions, each on a separate line.

Below, the different Filter Targets (and their corresponding
Condition and Parameter options) are described in more
detail.

Ö If you want to start from scratch (as opposed to basing
your settings on an existing preset), you may want to initialize the settings by selecting the Init option from the
Presets pop-up menu.
• To add a new line (condition), click the Add Line button
to the right.
The new line is added at the bottom of the list. If there are many lines, you
may need to use the scrollbar to the right to view them.

• To remove a line, select it and click the Delete Line button to the right.
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Searching for Media types

Searching for Container types

1. Select Media Type in the Filter Target pop-up menu.

1. Select Container Type in the Filter Target pop-up menu.

This allows you to find elements of certain types of media only.

This allows you to find parts, events or tracks.

2. Open the pop-up menu in the Parameter 1 column
and select the desired option.

2. Open the pop-up menu in the Parameter 1 column
and select the desired option.

When the Filter Target is set to Media type, the pop-up menu lists the
available media types. The following table lists what will be found:

When the Filter Target is set to Container type, the pop-up menu lists the
available container types. The following table lists what will be found:

Media Type

Description

Container Type

Description

Audio

If no container type is specified, this finds audio events,
audio parts and audio tracks.

Folder Track

This finds all folder tracks, included FX Channel and
Group Channel folders.

MIDI

If no container type is specified, this finds MIDI parts and
MIDI tracks.

Track

This finds all kinds of tracks.

Part

This finds audio, MIDI and Instrument parts. Folder
parts will not be found.

Event

This finds automation points, markers, audio events,
arranger events and transpose events.

Automation

If no container type is specified, this finds automation
events and automation tracks.

Marker

If no container type is specified, this finds marker events
and marker tracks.

Transpose

If no container type is specified, this finds transpose
events and transpose tracks.

3. Open the pop-up menu in the Condition column and
select the desired condition.

Arranger

If no container type is specified, this finds Arranger
events and Arranger tracks.

For container types, the following options are available:
Condition

Description

3. Open the pop-up menu in the Condition column and
select the desired condition.

Equal

…finds the Container Type set up in the Parameter 1 column.

For media types, the following options are available:

All Types

…finds all Container Types.

Condition

Description

Equal

…finds the Media Type set up in the Parameter 1 column.

All Types

…finds all Media Types.

If, e.g. you have set up the Project Logical Editor like this…

If, e.g. you have set up the Project Logical Editor like this…

…the Project Logical Editor will find all Folder tracks in the
project.
This Filter Target is very powerful in combination with the
Media type Filter Target:

…the Project Logical Editor will find all Marker events and
tracks in the project.

Here, the Project Logical Editor will find all MIDI and Instrument parts in
the project.
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Combining Media type and Container type

Searching for Names

The combination of the Filter Targets Media type and Container represents a vesatile tool for logical operations:

1. Select Name on the Filter Target pop-up menu.
2. Enter the desired name, or a part of a name in the Parameter 1 column.
3. Open the pop-up menu in the Condition column and
select the desired condition.
For names, the following options are available:

Here, the Project Logical Editor will find all Automation tracks (not
events) in the project whose name contains vol.

Condition

Description

Equal

…is the exact same string as set up in the Parameter 1
column.

Contains

…contains the set string.

If, e.g. you have set up the Project Logical Editor like this…

Here, the Project Logical Editor will find all MIDI and Instrument parts
(not tracks) in the project that are muted.

…the Project Logical Editor will find all tracks in the
project whose name contains “voc”.
Ö To take most advantage of this feature, we recommend you to use a standard nomenclature in your projects
(Drums, Perc, Voc, etc.).
Here, the Project Logical Editor will find all MIDI and Instrument parts
(not tracks) or all audio events (not parts or tracks) in the project that
are muted.
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Searching for elements at certain positions

• If you select any condition other than the Range, Bar
Range, Cursor, Loop or Cycle options, you set up a specific position (in bars, beats, sixteenth notes and ticks) in
the Parameter 1 column. Note that the position for Bar
Range is measured in ticks related to the start of the bar.

1. Select Position in the Filter Target pop-up menu.
This allows you to find elements starting at certain positions, either relative to the start of the project or within each bar.

2. Open the pop-up menu in the Condition column and
select the desired condition.
For positions, the following options are available:
Condition

Description

Equal

…has the exact same value as set up in the Parameter 1
column.

Unequal

…has any value other than the one set up in the Parameter 1 column.

Bigger

…has a value higher than the one set up in the
Parameter 1 column.

Here, the Logical Editor will find all elements at the position 5.1.1. in the
project.

• If you select Inside Range or Outside Range in the Condition column, you set the start position of the range in the
Parameter 1 column and the end position in the Parameter
2 column.

Bigger or Equal …has a value that is the same as or higher than the one
set up in the Parameter 1 column.

The Project Logical Editor will then find all elements inside or outside this
position range.

Less

…has a value lower than the one set up in the
Parameter 1 column.

Less or Equal

…has a value that is the same as or lower than the one
set up in the Parameter 1 column.

Inside Range

…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter
1 should be the lower value and Parameter 2 the higher.

• If you select one of the Bar Range options in the Condition column, the Bar Range column will show a graphic bar
display. You specify the range within the bar by clicking and
dragging in the bar display (the specified Bar Range is indicated in blue).

Outside Range …has a value that is not between the values set up in the
Parameter 1 and Parameter 2 columns.
Inside Bar
Range

…is within the “zone” set up in the Bar Range column, in
each bar within the current selection.

Outside Bar
Range

…is outside the “zone” set up in the Bar Range column,
in each bar within the current selection.

Before Cursor

…is before the song Project position.

The Project Logical Editor will then find all elements starting inside or
outside this Bar Range, in all bars (within the current selection).

Beyond Cursor …is after the song Project position.
Inside Track
Loop

…is inside the set track loop (see “The independent track
loop function” on page 293).

Inside Cycle

…is inside the set cycle.

Exactly matching Cycle

…exactly matches the set cycle.

Here, the Project Logical Editor will find elements starting around the
second beat in each bar.
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Searching for elements of certain lengths

Searching for properties

1. Select Length in the Filter Target pop-up menu.

1. Select Property on the Filter Target pop-up menu.

This allows you to find elements of a certain length only. The Length parameter is interpreted via the time base setting of the tracks, i.e. in ticks
(musical) or ms (time), except for audio parts or events: these are always
measured in samples.

2. Open the pop-up menu in the Condition column and
select the desired condition.
When the Property option is selected, the Condition column has two options: “Property is set” and “Property is not set”.

2. Open the pop-up menu in the Condition column and
select the desired condition.

3. Open the pop-up menu in the Parameter 1 column
and select the desired option.

For lengths, the following options are available:
Condition

Description

This sets which property will be searched. The options are “muted” and
“selected”.

Equal

…has the exact same value as set up in the Parameter 1
column.

Two examples:

Unequal

…has any value other than the one set up in the Parameter 1 column.

Bigger

…has a value higher than the one set up in the
Parameter 1 column.

Bigger or Equal …has a value that is the same as or higher than the one
set up in the Parameter 1 column.
Less

…has a value lower than the one set up in the
Parameter 1 column.

Less or Equal

…has a value that is the same as or lower than the one
set up in the Parameter 1 column.

Inside Range

…has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter
1 should be the lower value and Parameter 2 the higher.

Here, the Project Logical Editor will find all muted MIDI and Instrument
parts.

Here, the Project Logical Editor will find all elements that are selected
but not muted.

Outside Range …has a value that is not between the values set up in the
Parameter 1 and Parameter 2 columns.

If you select any condition other than the Range options,
you set up a specific position in the Parameter 1 column.

Here, the Project Logical Editor will find all audio parts and events in
the project with a length smaller than 200 samples.
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Combining multiple condition lines

Using brackets

As described above, you can add condition lines by clicking the Add Line button to the right of the list. The result of
combining condition lines depends on the boolean And/
Or operators and the brackets.

The bracket (parenthesis) columns let you enclose two or
more condition lines, dividing the conditional expression
into smaller units. This is only relevant when you have
three or more condition lines and want to use the boolean
Or operator. This is how it works:

The bool column

Ö Without brackets, the conditional expressions are
evaluated according to their order in the list.

By clicking in the “bool” column to the right in the list, you
can select a boolean operator: “And” or “Or”. A boolean
operator separates two condition lines and determines the
result in the following way:
Ö If two condition lines are separated by a boolean And,
both conditions must be fulfilled for an element to be found.

Here, the Project Logical Editor will find all audio parts and events
whose name contains perc and all Audio parts and events whose name
contains drums, as well as other parts and events (e.g. MIDI parts)
whose name contains drums.

Maybe you wanted to find all Audio parts and events that
either had the name perc or the name drums (but no other
parts or events named drums)? Then you need to add
some brackets:

The Project Logical Editor will only find MIDI Tracks.

Ö If two condition lines are separated by a boolean Or,
one of the conditions (or both) must be fulfilled for an element to be found.

Here, all audio parts or events will be found whose name contains perc
or drums. The rule behind this is:

Ö Expressions within brackets are evaluated first.
The Project Logical Editor will find all parts or events that match exactly
the cycle.

If there are several layers of brackets, these are evaluated “from the inside
out”, starting with the innermost brackets.

When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is
set up two or more conditions that all must be met
for an element to be found, you don’t have to think
about the boolean column – just add the required
lines and make the usual filter settings.

You add brackets by clicking in the bracket columns and
selecting an option. Up to triple brackets can be selected.

!

Editing filter conditions as text
You can also edit filter conditions as text. This works just
like in the Logical Editor for MIDI, see “Editing filter conditions as text” on page 394.
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Selecting a function

Specifying actions

The lower list in the Project Logical Editor window is the
action list. This is where you specify any changes that
should be made to the found elements, relevant for the
function type Transform.

The pop-up menu in the top left corner of the Project Logical Editor is where you select the function – the basic
type of editing to be performed. When you select an option from the pop-up menu, the field to the right displays a
comment, making it easier to see what the function does.

You can perform two different kinds of actions: track-based
actions (such as Track Operation, Name) and event-based
actions (such as Position, Length, Name). There are also
actions that only take effect on automation data (Trim).

The available options are:
Delete

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the Add Line button to the right,
and fill out the columns as required. To remove a superfluous action line, select it and click the Delete Line button.

Deletes all elements found by the Project Logical Editor.
Ö When you delete automation tracks and undo this operation by selecting Undo from the Edit menu, the automation tracks will be restored, but the tracks will be closed.
Transform

Action Target

Changes one or several aspects of the found elements.
You set up exactly what should be changed in the action
list, see below.

This is where you select the property that should be
changed. The Operations determine what to do with the
Action Target. Below, all available operations are listed:

Select

Position

This will simply select all found elements, highlighting
them for further work in the Project window.

Adjusting this value will move the elements:
Operation

Description

Add

Adds the value specified in the Parameter 1 column to the
Position.

Subtract

Subtracts the value specified in the Parameter 1 column
from the Position.

Multiply by

Multiplies the Position value with the value specified in the
Parameter 1 column.

Divide by

Divides the Position value by the value specified in the Parameter 1 column.

Round by

This “rounds” the Position value using the value specified in
the Parameter 1 column. In other words, the Position value is
changed to the closest value that can be divided by the Parameter 1 value.
For example, if the Position value is 17 and Parameter 1 is 5,
the result of rounding will be 15 (the closest value that can
be divided by 5). Another word for this type of operation
would be “quantizing”, and it’s actually possible to use it for
this, by specifying a quantize value with Parameter 1 (in ticks,
with 480 ticks per quarter note).
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Operation

Description

Track Operation

Set Relative
Random
Values
between

This will add a random value to the current Position value.
The added random value will be within the range specified
with Parameter 1 and 2. Note that these can be set to negative values.
For example, if you set Parameter 1 to -20 and Parameter 2
to +20, the original Position value will get a random variation,
never exceeding ±20.

This lets you change the track status.

Set to fixed
value

Operation

This sets the Position to the value specified in the Parameter
1 column.

Description

Folder

Opens, closes or toggles folders.

Record

Enables, disables or toggles the record enable status.

Monitor

Enables, disables or toggles the monitor status.

Solo

Enables, disables or toggles the solo status.

Mute

Enables, disables or toggles the mute status.

Length
Name

Lets you resize the elements. This parameter is interpreted
via the time base setting of the tracks, i.e. in ticks (musical)
or ms (time):

This lets you rename the found elements.
Operation

Description

Replace

Replaces names by the string specified under Parameter 1.

Adds the value specified in the Parameter 1 column to the
Length.

Append

Names will be appended with the string specified under Parameter 1.

Subtract

Subtracts the value specified in the Parameter 1 column
from the Length.

Prepend

The name will be prepended with the string specified under
Parameter 1.

Multiply by

Multiplies the Length value with the value specified in the
Parameter 1 column.

Generate
Name

Divide by

Divides the Length value by the value specified in the Parameter 1 column.

The name will be replaced by the string specified under Parameter 1 followed by the number set with Parameter 2. The
number will be increased by 1 for every found element.

Round by

This “rounds” the Length value using the value specified in
the Parameter 1 column. In other words, the Length value is
changed to the closest value that can be divided by the Parameter 1 value.

Replace
Search
String

You can specify a search string under Parameter 1 that
should be replaced by the string specified under Parameter 2.

Set to fixed
value

This sets the Length to the value specified in the Parameter
1 column.

Operation

Description

Add

Trim
This Action Target is used for automation only and lets you
trim the found elements.

Set Random This will add a random value to the current length. The
added random value will be within the range specified with
Values
Parameter 1 and 2.
between

Operation

Description

Multiply by

Multiplies the Trim value with the value specified in the
Parameter 1 column.

Divide by

Divides the Trim value by the value specified in the Parameter 1 column.

Applying the defined actions
Once you have set up filter conditions, selected a function
and set the required actions (or loaded a preset), you apply the actions defined with the Project Logical Editor by
clicking the Do It button.
Project Logical Editor operations can be undone just like
any other editing.
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Working with presets

Setting up key commands for your presets
If you have stored Project Logical Editor presets, you can
set up key commands for them:

The Presets section in the bottom right section of the window allows you to load, store and manage Project Logical
Editor presets. A preset contains all settings in the window,
which means you can simply load a preset and click Do It.

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to
the category “Process Logical Project Preset” and click
the plus-sign to display the items in the folder.

Ö To load a preset, select it from the Presets menu.
Storing your own settings as a preset

3. In the list, select the item to which you wish to assign a
key command, click in the “Type in Key” field and enter a
new key command.

If you have made Project Logical Editor settings that you
want to use again, you can store them as a preset:
1. You can enter some explanatory text in the Comment
field.

4. Click the Assign button above the field.
The new key command appears in the Keys List.

An extra description of the preset can be useful, especially if the settings
are complex.

5. Click OK to exit the dialog.

2. Click the Store button in the Presets section.

For more information on Key Commands, see the chapter
“Key commands” on page 517.

A dialog for specifying a name for the new preset is displayed.

3. Enter a name for the preset and click OK.
The preset is stored.

Ö To remove a preset, load it and click the Remove button.
Organizing and sharing presets
The Project Logical Editor presets are stored within the application folder in the Presets\Logical Edit Project subfolder
(see also “Where are the settings stored?” on page 514).
While these files cannot be edited manually, you can reorganize them (e.g. putting them in subfolders) like any files.
This also makes it easy to share presets with other Nuendo users, by transferring the individual preset files.
Ö The list of presets is read each time the Project Logical Editor is opened.

409
The Project Logical Editor

30
Working with System Exclusive
messages

Introduction

2. Make sure that recording of Sysex data is not filtered,
by unchecking the Sysex checkbox in the Record section.
The Sysex checkbox in the Thru section can be left as it is
(by default activated).

SysEx (System Exclusive) messages are model-specific
messages for setting various parameters of a MIDI device.
This makes it possible to address device parameters that
would not be available via normal MIDI syntax.
Every major MIDI manufacturer has its own SysEx identity
code. SysEx messages are typically used for transmitting
patch data, i.e. the numbers that make up the settings of
one or more sounds in a MIDI instrument.
Nuendo allows you to record and manipulate SysEx data
in various ways. This chapter points to various features
that help you manage and create SysEx data.
(To learn about the possibilities of the MIDI Device Manager for controlling your device, please refer to the separate PDF document “MIDI Devices”.)

This way, SysEx messages will be recorded but not echoed back out to
the instrument (which may lead to unpredictable results).

Bulk dumps

3. Activate recording on a MIDI track and initiate the
dump from the front panel of the instrument.

Recording a bulk dump in Nuendo

4. When done recording, select the new part and open
the List Editor from the MIDI menu.
This allows you to check that the SysEx dump was recorded – there
should be one or several SysEx events in the part/event list.

In any programmable device, the settings are stored as
numbers in computer memory. Change those numbers,
and you will change the settings.
Normally, MIDI devices allow you to dump (transmit) all or
some settings in the device's memory in the form of MIDI
SysEx messages. A dump is therefore (among other
things) a way of making backup copies of the settings of
your instrument: sending such a dump back to the MIDI
device will restore the settings.

!

If your instrument allows the dumping of a few or all of its
settings via MIDI by activating some function on the front
panel, this dump will probably be recordable in Nuendo.
1. Open the Preferences dialog from the File menu (on
the Mac, this is located on the Nuendo menu) and select
the MIDI–MIDI Filter page.
This allows you to govern which MIDI event types should be recorded
and/or thru-put.

If your MIDI instrument doesn’t offer a way to initiate a
dump “by itself”, you have to send a Dump Request
message from Nuendo to start the dump. In that case,
use the MIDI SysEx Editor (see “Editing System Exclusive messages” on page 413) to insert the specific
Dump Request message (see the instrument’s documentation) at the beginning of a MIDI track. When you
activate recording, the Dump Request message will
be played back (sent to the instrument), the dump will
start and be recorded as above.
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Recording System Exclusive
parameter changes

Transmitting a bulk dump back to a device
1. Make sure the MIDI track with the System Exclusive
data is routed to the device.

Often you can use SysEx to remotely change individual
settings in a device, e.g. open a filter, select a waveform,
change the decay of the reverb etc. Many devices are also
capable of transmitting changes made on the front panel
as SysEx messages. These can be recorded in Nuendo,
and thus incorporated into a regular MIDI recording.

You may want to check your device’s documentation to find details about
which MIDI channel should be used, etc.

2. Solo the track.
This might not be necessary, but it is a good safety measure.

3. Make sure the device is set up to receive SysEx messages (often, receiving SysEx is turned off by default).

Here's how it works: let's say you open up a filter while
playing some notes. In that case, you will record both the
notes and the SysEx messages generated when you
opened of the filter. When you play it back, the sound
changes exactly like it did when you recorded it.

4. If necessary, put the device in “Standby to Receive
System Exclusive” mode.
5. Play back the data.

Some advice

1. Open the Preferences dialog from the File menu, select the MIDI–MIDI Filter page and make sure that SysEx is
recorded, i.e. the Sysex checkbox in the Record section is
deactivated.

• Don't transmit more data than you need. If all you want is a single program, don't send them all, it will only make it harder to
find the one you want. Usually, you can specify exactly what
you want to send.
• If you want the sequencer to dump the pertinent sounds to
your instrument each time you load a project, put the SysEx
data in a silent “count-in” before the project itself starts.
• If the dump is very short (for instance, a single sound) you can
put it in the middle of the project to re-program a device on the
fly. However, you can achieve the same effect by using Program
Change. This is definitely preferable, since less MIDI data is
sent and recorded. Some devices may be set up to dump the
settings for a sound as soon as you select it on the front panel.
• If you create parts with useful “SysEx dumps”, you can put
these on a special muted track. When you want to use one of
them, drag it to an empty unmuted track and play it back from
there.
• Do not transmit several SysEx dumps to several instruments at
the same time.
• Make a note of the current device ID setting of the instrument.
If you change this, the instrument may refuse to load the dump
later.

2. Make sure the instrument is actually set to transmit
changes of front panel controls as SysEx messages.
3. Record normally.
When you’re done, you can check that the events were recorded properly in the List Editor.
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Editing System Exclusive messages

Editing a value
The selected value can be edited directly in the main display or in the decimal and binary displays. Just click on it
and type in the desired value as usual.

While SysEx events are shown in the List Editor/Project
Browser, their entire content is not (only the beginning of
the message is displayed in the Comment column for the
event). Also, you cannot edit the event (other than moving
it) as you can with other event types in the List Editor.

Adding and deleting bytes
Using the Insert and Delete buttons or their corresponding
computer keyboard keys, you can add and delete bytes
from the message. Inserted data will appear before the selection.

Instead, you have to use the MIDI SysEx Editor for this.
• To open the MIDI SysEx Editor for an event, click in the
Comments column for the event in the List Editor/Project
Browser.

To delete the complete SysEx message, select it in the
List Editor and press [Delete] or [Backspace].

Importing and exporting data
The Import and Export buttons allow you to get SysEx data
from disk and to export the edited data to a file. The file
has to be in “MIDI SysEx” (.SYX) binary format. Only the
first dump in a .SYX file will be loaded.
This format should not be confused with MIDI files, which
have the extension .MID.

The display shows the entire message on one or several
lines. SysEx messages always begin with F0 and end with
F7 with a number of arbitrary bytes in between. If the message contains more bytes than fit on one line, it continues
on the next. The Address indication to the left helps you
find out on which position in the message a certain value
resides.
You can edit all values except for the first (F0) and last one
(F7).

Selecting and viewing values
To select a value, either click on it or use the cursor keys.
The selected byte is displayed in various formats:
• In the main display, values are shown in hexadecimal format.
• To the right of this, values are shown in ASCII format.
• At the bottom of the dialog, the selected value is shown in
binary and decimal formats.
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Working with the Tempo track

Ö To adapt the tempo track to time-based material, you
can use the Time Warp tool, see “The Time Warp tool” on
page 422.

Background
For each track in Nuendo that can make use of this function, you can specify whether it should be time-based or
tempo-based (see “Switching between musical and linear
time base” on page 40). For tempo-based tracks, the
tempo can either be fixed through the whole project (this
is called “Fixed tempo mode”) or follow the Tempo track
(this is called “Tempo track mode”), which may contain
tempo changes.

This allows you to adjust the tempo track so that tempo-based material
(e.g. positions in music) coincides with time-based material (e.g. positions
in narration, video, etc.).

The Tempo Track Editor – Overview
To make changes to the actual Tempo track, you need to
open the Tempo Track Editor by selecting “Tempo Track”
on the Project menu.

• To switch between Fixed tempo mode and Tempo track
mode, use the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is
shown), the tempo follows the Tempo track; when it is deactivated (and the text “Fixed” is shown), the Fixed tempo
is used (see “Setting the Fixed tempo” on page 419). You
can also switch tempo mode in the Tempo Track Editor
(see below).
In Tempo track mode, the tempo cannot be changed on
the Transport panel, i.e. the tempo information here is for
display purposes only.
The Tempo track also contains time signature events.
These are always active, regardless of whether Fixed
tempo mode or Tempo track mode is selected.
A note about tempo-based audio tracks
For tempo-based tracks, the start time position of audio
events depends on the current tempo setting. However, it
is important to realize that the actual audio (“within” the
events) will play back as recorded, regardless of any
tempo changes you make. Therefore, it’s good practice to
make the proper tempo and time signature settings before
you start recording tempo-based audio.
Ö To make an already recorded audio track follow the
tempo changes, you can use the Sample Editor, see “The
Sample Editor” on page 258.
How well this works depends on the character of the audio recordings,
since the Hitpoint detection feature works best with fairly rhythmical material.

415
Working with the Tempo track

The toolbar

The two additional items at the bottom of the menu have
the following functionality:

The toolbar contains various tools and settings. The tempo
and time signature displays to the right allow you to view
and edit the value of the selected tempo curve point or time
signature event, much like the info line in other editors.
Tools

Snap on/off

Tempo track on/off
Curve type selector

The selected tempo
Tempo
record slider

• If “Time Linear” is selected, the ruler, time signature area
and tempo curve display will be linear in relation to the
timeline.
This means that if the ruler shows bars and beats, the distance between
the bar lines will vary depending on the tempo.

Snap pop-up

Autoscroll
Time signature

• If “Bars+Beats Linear” is selected, the ruler, time signature area and tempo curve display will be linear in relation
to beats.

Curve type for new tempo events
Open Process
Bars dialog)

If the ruler shows bars and beats, the distance between beats will be
constant.

Open Process
Tempo dialog)

The ruler
The ruler in the Tempo Track Editor shows the timeline. As
in other windows, you can select a display format by clicking on the arrow button to the right of the ruler and selecting an option from the pop-up menu that appears.

The time signature area
The area below the ruler contains time signature events.
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The tempo curve display

3. Click at the desired time position in the tempo curve
display, and keep the mouse button pressed.
If Snap is activated on the toolbar, this determines at which time positions you can insert tempo curve points, see “Snap” on page 421.

The main display shows the tempo curve (or, if Fixed tempo
mode is selected, the Fixed tempo – see “Setting the Fixed
tempo” on page 419). To the left of the display is a tempo
scale to help you quickly locate the desired tempo.

When you click, the tempo display in the toolbar shows the tempo value.

4. Drag the curve point to the desired tempo value (indicated in the tempo display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you
selected “Ramp” or “Jump” in step 1 above:

• Note that the vertical “grid lines” correspond to the display format selected for the ruler.

Insert curve set to “Ramp”:

Operations
Zooming
Changing the magnification is done using any of the following methods:
• By using the zoom sliders in the lower right corner of the
window.
• By using the Magnifying Glass tool.
Insert curve set to “Jump”:

This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
The options on the menu work as in other windows.

Editing the tempo curve
!

This section assumes that you are working in Tempo
track mode, i.e. the Tempo button must be activated
on the Transport panel.

Adding tempo curve points
• You can also just click and draw a tempo curve with the
Pencil tool, so that curve points are inserted while you draw.

1. Use the “insert curve” pop-up menu in the toolbar to
select whether you want the tempo to change gradually
from the previous curve point to the new one (“Ramp”) or
change instantly to the new value (“Jump”).

For this, the “Ramp” Insert Curve mode is useful.

2. Select the Pencil tool.
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• Instead of using the Pencil tool, you can press [Alt]/[Option] and use the Arrow tool.

• By adjusting the tempo value in the tempo display on
the toolbar.

This will only insert a single point (i.e. you cannot draw a curve with the
Arrow tool).

For this to work, a single tempo curve point must be selected.
!

!

You can also have tempo values automatically inserted by the Beat Calculator, see “The Beat Calculator” on page 421.

Selecting tempo curve points
Selecting curve points is done using any of the following
methods:
• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.

Dragging tempo curve points with a time-based display format (any other format than “Bars+Beats”) may
lead to confusing results. This is because moving a
point will change the relationship between tempo and
time. For example, let’s say you move a tempo point to
the right and drop it on a certain time position. When
you release the mouse button, the mapping between
tempo and time will be adjusted (since you have
changed the tempo curve). As a result, the moved
point will appear at another position. For this reason,
we recommend that you use the Bars+Beats display
format when editing tempo curves.

The options are:
Option

Description

All

Selects all curve points on the Tempo track.

None

Deselects all curve points.

Adjusting the curve type
You can change the curve type of a tempo curve segment
at any time, using the following method:

In Loop

Selects all curve points between the left and right locator.

From Start
to Cursor

Selects all points to the left of the project cursor.

From Cursor
to End

Selects all points to the right of the project cursor.

1. Select all curve points within the segment you want to
edit.

• You can also use the left and right arrow keys on the
computer keyboard to go from one curve point to the next.
If you press [Shift] and use the arrow keys, the current selection will be
kept, allowing you to select several points.

2. Pull down the Curve pop-up menu on the toolbar and
select “Jump” or “Ramp”.

Editing tempo curve points

The curve sections between the selected points are adjusted.

Curve points can be edited in the following ways:
• By clicking and dragging horizontally and/or vertically.
If several points are selected, all of them are moved. If Snap is activated
on the toolbar, this determines to which time positions you can move
curve points, see “Snap” on page 421.
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Removing tempo curve points

Adding and editing time signature events

To remove a curve point, either click on it with the Eraser
tool or select it and press [Backspace]. The first tempo
curve point cannot be removed.

• To add a time signature event, click in the time signature
area with the Pencil tool.
This adds a default 4/4 time signature event at the closest bar position.
You can also do this by pressing [Alt]/[Option] and clicking with the Arrow tool.

Recording tempo changes

• To edit the value of a time signature event, select it and
adjust the value in the signature display on the toolbar.
Note that there are two controls for the signature display; the left one adjusts the numerator and the right one adjusts the denominator.

The tempo record slider on the toolbar allows you to record
tempo changes “on the fly”: simply start playback and use
the slider to raise or lower the tempo at the desired positions. Useful for creating natural sounding ritardandos, etc.

• You can move a time signature event by clicking and
dragging it with the Arrow tool.

Setting the Fixed tempo

• To remove a time signature, either click on it with the
Eraser tool or select it and press [Backspace].

Again, note that time signature events can only be positioned at the start
of bars.

When the Tempo track button is deactivated, the Tempo
track curve is grayed out (but still visible). Since the Fixed
tempo is constant throughout the whole project, there are
no tempo curve points. Instead, the Fixed tempo is displayed as a horizontal black line in the tempo curve display.

The first time signature event cannot be removed.

Exporting and importing Tempo tracks
You can export the current tempo track for use in other
projects by selecting “Tempo Track” from the “Export”
submenu on the File menu. This allows you to save the
tempo track information (including time signature events)
as a special xml file (file extension “.smt”).
To import a saved tempo track, select “Tempo Track” from
the Import submenu on the File menu. Note that this replaces all tempo track data in the current project (although
the operation can be undone if needed).

There are three ways to set the tempo in Fixed mode:
• Drag the tempo line up or down with the Arrow tool.
• Adjust the value numerically in the tempo display on the
toolbar.
• On the Transport panel, in Fixed tempo mode, click on
the Tempo value to select it, enter a new value and press
[Enter].
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Process Tempo

The Process Bars dialog

Process Tempo allows you to define a specific length or
end time for a set range, and the Tempo track will automatically set a tempo that will fit the range in the specified time.

The Process Bars dialog, which can be opened from the
Tempo Track Editor, uses the global “Insert Silence” and
“Delete Time” functions from the Edit menu – Range submenu, but uses a musical “bars+beats-based” environment for calculating the necessary ranges (or parameters).
It also ensures that the time signatures stay “in sync” after
these operations. This allows for a much more intuitive approach when inserting, deleting or replacing “time” while
working with a project set to the Bars+Beats time type.

It works as follows:
1. Open the Tempo Track Editor and specify a region or
range that you wish to process by setting the left and right
locators.
2. Click on the Process Tempo button on the Tempo
Track toolbar.

The Process Bars dialog is opened by clicking on the respective button on the Tempo Track toolbar (next to the
Process Tempo button).

The Process Tempo dialog appears.

Click this button…

3. In the Process Range fields, the specified range is
shown, in Bars and Beats (PPQ) and in a time format, which
can be selected from the Time Display Format pop-up.

… to open the Process Bars dialog.

The dialog contains the following elements:

The range defined in step 1 will already be set, but you can edit the range
by adjusting the values in the Process Range fields if you wish.

Option

Description

Bar Range

The Bar Range display gives you a graphical overview of
the position of the bar range within the project as well as
its length. You can change the setting here by dragging
the green rectangle; however this is accomplished much
easier by using the Start and Length value fields (see below).
The small arrow pair in this section mark the length of the
current project. The area to the right marks the bar range
that can be added (500 bars max.).

Bar Range –
Start

This is where you specify the desired start position for the
bar range. Click on the small arrows to raise/lower the
value by one step or click directly in the value field and
enter the desired number manually.

Bar Range –
Length

This is where you specify the desired length of the bar
range. Click on the small arrows to raise/lower the value
by one step or click directly in the value field and enter
the desired number manually.

Action –
Insert Bars

When you select this action, clicking the Process button
will insert the specified number of empty bars with the set
time signature at the desired start position in the project.

Now you can either specify a new range length or a new
range end time. What to choose depends on whether the
range should have a specific length or whether it should
end at a specific time position.
4. Enter the desired End or Length in the corresponding
fields of the New Range section.
You can select a time format for the new range in the Time Display Format pop-up.

5. Click Process.
Now the tempo track is automatically adjusted, and the range will have
the specified duration.
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Option

The Beat Calculator

Description

Action – Delete When you select this action, clicking the Process button
Bars
will delete the specified number of bars beginning at the
set start position.
Action –
Reinterpret
Bars

When you select this action, clicking the Process button
will reinterpret the bar range to fit the specified time signature. This is very special in the sense that both
bars+beats positions of the notes and the tempo are being changed to fit the new time signature, but the playback of the notes will stay just the same.
If you want to reinterpret e.g. a bar with the time signature
3/4 so that it gets the time signature 4/4, quarter notes
will become half note triplets. If you reinterpret a bar with
the time signature 4/4 to attain 3/4, you will get quadruplets.

Action –
Replace Bars

When you select this action, clicking the Process button
will cause the time signature of the specified bar range to
be replaced by the one you specify in this dialog.

Action –
Signature

This lets you specify the desired time signature for the
action you select in the Action pop-up menu (except for
the Delete Bars action).

Process

Click this button to apply your changes to the desired bar
range.

Close

Clicking this button closes the Process Bars dialog.
Please note that you have to click the Process button first
to apply your settings. Clicking this button without clicking on “Process” first will close the dialog without applying your settings.

The Beat Calculator is a tool for calculating the tempo of
freely recorded audio or MIDI material. It also allows you to
set the tempo by tapping.

Calculating the tempo of a recording
1. In the Project window, make a selection that covers an
exact number of beats of the recording.
2. Select “Beat Calculator…” from the Project menu.
The Beat Calculator window appears.

3. Enter the number of beats that the selection encompasses in the Beats field.
The corresponding tempo is calculated and displayed in the BPM field.

Options and settings

• If you need to adjust the selection, you can go back to
the Project window, leaving the Beat Calculator open.

Snap

To re-calculate the tempo after adjusting the selection, click Refresh.

You activate or deactivate Snap by clicking the Snap icon
on the toolbar. The behavior of the function depends on
the display format selected for the ruler:

4. If you like, you can insert the calculated tempo into the
Tempo track by clicking one of the buttons in the lower left
corner of the Beat Calculator window.

• If “Bars+Beats” is selected, tempo curve points will
snap to the set resolution on the Snap pop-up.

Clicking “At Tempo Track Start” will adjust the first tempo curve point,
while “At Selection Start” will add a new tempo curve point at the selection’s start position, using the “Jump” curve type (see “Adding tempo
curve points” on page 417).

If this is set to 1/1, curve points will snap to the start of bars.

• If any other display format is selected, tempo curve
points will snap to the vertical grid lines in the tempo curve
display.

!

The spacing of the grid lines depends on the horizontal magnification.

If Fixed tempo mode is selected when you insert the
calculated tempo, the Fixed tempo will be adjusted,
regardless of which button you click.

• Time signature events can only be positioned at the start
of bars, regardless of whether Snap is activated or not.

Autoscroll
When this option is activated, the tempo curve display will
scroll during playback, keeping the project cursor visible.
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Using Tap Tempo

4. Select “Merge Tempo From Tapping” from the Functions submenu on the MIDI menu.

The Tap Tempo function allows you to specify a tempo by
tapping:

A dialog opens.

1. Open the Beat Calculator.

5. In the dialog, specify what type of note (1/2, 1/4 etc.)
you tapped during the recording.

2. If you want to tap the tempo to some recorded material,
activate playback.

If you activate the “Begin at Bar Start” option, the first note will automatically start at the beginning of a bar when calculating the new tempo curve.

3. Click the Tap Tempo button.

6. Click OK.

The Tap Tempo window appears.

The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to
check that the new tempo information is reflected in the
tempo curve.
Ö Another way of creating a tempo map for freely recorded audio would be to use the Time Warp tool, see
below.

The Time Warp tool

4. Tap the tempo on the computer keyboard’s space bar
or with the mouse button.

The Time Warp tool lets you adjust the Tempo track so
that “musical time-based” material (positions related to
the tempo) matches “linear time-based” material (positions in time). Some typical applications:

The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the
average timing of the taps and displays it.

• When you have recorded music (audio or MIDI) without tempo
reference or metronome click, the Time Warp tool can be used
for creating a tempo map that fits the recording (allowing you to
rearrange or add sequenced material).
• When you are creating music for a movie and want to match
certain positions in the video with certain positions in the music.

6. Click OK to close the Tap Tempo dialog.
The tapped tempo is now shown in the Beat Calculator’s BPM display. If
you like, you can insert it into the Tempo track as described above.

Merge Tempo From Tapping
This function allows you to create a complete tempo track
based on your tapping. Typically, you would use this if you
have an audio file with no tempo mapping and want to be
able to add sequenced material afterwards, etc.

The Time Warp tool makes use of the fact that tracks can
be based on time positions (linear time base) or positions
related to tempo (musical time base), see “Switching between musical and linear time base” on page 40 for a description of these modes.

1. Create an empty time-based MIDI track and, while
playing back your audio material, tap the new tempo on
your MIDI keyboard and record the created notes onto the
new MIDI track.
Note that you must create note events – pedal events cannot be used for
this function.

2. Play back the audio and check that the timing of the
MIDI notes corresponds to that of the audio.
If necessary, edit the MIDI notes in an editor.

3. Select the part (or the individual notes in an editor)
that you want to use for the calculation.
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Basic procedure

Rules

You use the Time Warp tool to drag a musical position (a
position in bars+beats format) to a certain position in time.
This can be done in the Project window or in editor windows, as described below. Here is the general procedure:

• When you use the Time Warp tool, the tempo value of
the last tempo event (before the click position) is adjusted.
• If later tempo events exist, a new tempo event will be
created at the click position. This way, the later tempo
event(s) will not be moved.

1. Make sure Tempo track mode is selected.
You cannot use the Time Warp tool in Fixed tempo mode.

• If you press [Shift] and use the Time Warp tool, a new
tempo event is created at the click position.

2. Select the Time Warp tool.

[Shift] is the default modifier for this – you can adjust this in the Preferences (Editing–Tool Modifiers page).

• If you use the Time Warp tool in an editor, a tempo
event will be created at the start of the edited part or
event. Only the currently edited track will be affected – but
note that events to the right of the edited events or parts
(on the edited track) will be affected as well.

Bars+Beats format is automatically selected for the ruler in the active
window, and the ruler is shown in brown.

3. Click in the window at a musical position and drag it
so that it matches a position in the material you are editing
– e.g. the start of an event, a certain “hit” within an audio
event, a frame in a video clip, etc.

• If you have made a selection range (in the Project window, Audio Part Editor or Sample Editor) and use the
Time Warp tool within that range, the tempo changes will
be confined to that range.

When you click with the Time Warp tool, it snaps to the grid in the window.

This means tempo events will be inserted at the start and end of the selection range, if needed – useful if you need to adjust the tempo within a
certain area but want all material outside that range to stay in place.

• When you click with the Time Warp tool, it snaps to the
tempo grid in the window.
Dragging the start of bar 3 to the start of the audio event.

• When you drag the tempo grid to a new position, it can
be magnetic to events in the window.

While you are dragging, the track(s) you are editing are
temporarily switched to linear time base. This means that
the contents of the tracks remain at the same time positions regardless of the tempo (there is an exception to this
in the Project window, see below).

In the Project window, this requires that Snap is activated and “Events”
is selected on the Snap pop-up menu – the grid will then snap to the
start and end of events or parts, and to markers. In the Sample Editor,
this requires that Snap to Zero Crossings is activated – the grid will then
snap to hitpoints (if any). In the MIDI editors, this requires that Snap is
activated – the grid will then snap to the start and end of notes.

4. When you release the mouse button, the musical position you clicked on matches the time position you dragged
it to.

• The function will create tempo values up to 300 bpm.

This is because the Time Warp tool changed the last tempo event on the
Tempo track (and/or added new ones, depending on window and usage), thereby scaling the tempo track to fit.
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Viewing and adjusting tempo events

Matching a musical score to video

When you select the Time Warp tool, the ruler of the active window is shown in brown. Existing tempo events are
shown in the ruler as “flags” with the tempo values displayed.

Here’s an example of how to use the Time Warp tool in
“musical events follow” mode. Let’s say you are creating
the music for a film. You have a video track, an audio track
with a commentary and some audio and/or MIDI tracks
with your music. Now you want to match the position of a
musical cue to a position in a video film. The musical cue
is located in bar 33. There are no tempo changes in the
project (yet).
1. Make sure tempo track mode is selected in the Transport panel.

This helps you see what’s going on, but you can also use
this for editing the tempo track:

• You can click on a tempo event in the ruler and drag to
move it.

2. Now you need to locate the position in the video. If you
don’t need very high precision, you can simply locate it
looking at the thumbnails on the video track – otherwise
you can pinpoint the exact position and add a marker to
the Marker track (that you can snap to later on).

This automatically edits the tempo value in the event so that elements to
the right keep their positions.

You can also make a note of the exact position and add an extra ruler
track set to show the time code.

• If you press [Alt]/[Option] and move (or delete) a tempo
event in the ruler, the tempo value is not adjusted – this
means elements to the right will be moved.

3. Make sure the correct tracks are set to linear time
base or musical time base, respectively.

• If you press the create/erase modifier key (by default
[Shift]) and click on a tempo event in the ruler, it is deleted.

In our example, we want the video track and the audio track with a commentary voice-over to be linear time-based (as well as the marker track, if
you are using one). All other tracks should be set to musical time base.
You change this by clicking the time base button in the Track list or Inspector.

This is the default modifier key for this – you can adjust this in the Preferences (Editing–Tool Modifiers page).

Using the Time Warp tool in the Project
window
In the Project window, there are two modes for the Time
Warp tool:

Musical time base selected.

• In the default mode, all tracks are temporarily switched to linear time base when you use the tool. This means that all tracks
will keep their absolute time positions when you adjust the
tempo track.
• In the “musical events follow” mode, no tracks are switched to
linear time base. This means that all tracks that are not set to
linear time base will follow the changes you make to the tempo
track.

Linear time base selected.

4. Set up the Grid Type pop-up menu as desired.
When you click with the Time Warp tool, it snaps to the selected grid. In
this case, you will find the musical cue at the start of bar 33, so we can
set the grid to “Bar”.

You select the Time Warp mode by selecting the tool,
clicking on the tool icon and selecting from the pop-up
menu that appears.
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• Note that this affects the snapping to the ruler (tempo
grid) when you click! In addition, the tool can be “magnetic” to events in the Project window when you drag – for
this, you need to activate Snap and select “Events” on the
Snap pop-up menu.

OK, let’s say you need to match another cue to another
position later on in the video. If you simply repeat this procedure, you will find that the first cue gets out of sync –
since you are still changing the first (and only) tempo
event on the Tempo track!

In our example, this would be useful if you created a marker at the desired position in the video – when you drag the grid (see below), it will
snap to the marker.

You need to create a “lock point” – a tempo event at the
first cue position:

5. Select the Time Warp tool and select the “musical
events follow” mode.

9. Press [Shift] and click with the Time Warp tool in the
event display at the cue position.
In our case this is bar 33.

6. Click in the event display at the start of bar 33 and
drag to the desired position in the video.
As mentioned above, this can mean dragging to a position indicated by
the thumbnails on the video track, to a marker on the Marker track or to a
time position on an additional ruler track.

As you can see, a tempo event (with the same value as the
first one) is added at that position.
10. Now match the second musical cue to the correct
video position by dragging the musical position to the
desired time position as before.
The new tempo event is edited – the first tempo event is unaffected and
the original cue is still matched.

• If you know you are going to match several cues this
way, you should make it a habit to press [Shift] each time
you use the Time Warp tool to match positions.
This adds a new tempo event – that way, you don’t have to add tempo
events afterwards as in step 9 above.

About snapping
If Snap is activated in the Project window and “Events” is
selected on the Snap pop-up menu, the Time Warp tool
will be magnetic to events when you drag the tempo grid.
This makes it easier to snap a tempo position to a marker,
the start or end of an audio event, etc.

When you drag, the ruler is scaled – and the music tracks
will follow.
7. Release the mouse button.
If you look in the ruler at the beginning of the project, you will see that the
first (and only) tempo event has been adjusted.

8. Try playing back.
The musical cue should now happen at the correct position in the video.
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Using the Time Warp tool in an audio editor

5. Press [Shift] and click in the event at the position of
the first downbeat (the start of the bar).

Using the Time Warp tool in the Sample Editor or Audio
Part Editor is different from using it in the Project window,
in the following ways:

When you press [Shift], the pointer turns into a pencil. Clicking adds a
tempo event at the first downbeat – when you later adjust the tempo with
the Time Warp tool, the first downbeat will stay in place. Note: if the
event started exactly on the first downbeat (no audio before the “one”),
you wouldn’t need to do this. This is because a tempo event is automatically added at the start of the edited event.

• When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited event or part –
this tempo event will be adjusted when you warp the tempo
grid with the tool. This means that material before the edited
events won’t be affected.
• Only the default mode for the Time Warp tool is available. So
when you use the tool, the edited track is temporarily switched
to linear time base.

6. Now, locate the start of the next bar in the ruler.
7. Click at that position in the event display and drag the
position to the downbeat of the second bar in the recording.
When you click, the pointer will snap to the ruler grid.

Making a tempo map for a “free” recording
The following example shows how to use the Time Warp
tool in the Sample Editor to create a tempo map matching
freely recorded music. Let’s say you have recorded a drummer, playing without a metronome – this typically means the
tempo varies ever so slightly. To be able to add sequenced
material and easily rearrange the recorded audio, you want
the tempo in Nuendo to match the recorded drum track:
1. If necessary, move the recorded event to its desired
start position.
Move it so that the first downbeat (“one”) happens on the start of the desired bar – zoom in if needed.

2. Open the drum recording in the Sample Editor and
make sure Hitpoint mode isn’t selected.
The Time Warp tool cannot be used in Hitpoint mode. However, if you
have calculated hitpoints already, these will be visible when the Time
Warp tool is selected (see below).

3. Set the zoom so that you can see the individual drum
hits clearly.

You do not have to match the downbeats (“ones”) – in this figure, beat
“2” in the second bar is matched to the “two” in the recording’s second
bar (simply because the snare drum hits on the upbeats are easier to
spot in the waveform image).

To achieve this type of “visual” beat matching, it’s important to have a
fairly clean recording, such as the drum track in this example.

When you dragged the grid you changed the tempo value
in the tempo event at the first downbeat. If the drummer
held a fairly consistent tempo, the following bars should
now match pretty well too.

4. Select the Time Warp tool.
You have already matched the first downbeat with the
start of a bar. However, if the recording starts before the
first downbeat (with a fill, some silence, etc.), you want to
“lock” the first downbeat so that it stays in position:

8. Check the following bars and locate the first position
where the audio drifts from the tempo.
Now, if you simply adjusted that beat in the tempo grid to
match the beat in the recording, the tempo event at the
first downbeat would be changed – this would ruin the
match in the previous bars! We need to lock these by inserting a new tempo event.
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9. Locate the last beat that is in sync.

Using the Time Warp tool in a MIDI editor

This would be the beat just before the position where the audio and
tempo drift apart.

This is very similar to using the tool in an audio editor:

Matching to hitpoints

• When you use the Time Warp tool, a tempo event is automatically inserted at the beginning of the edited part – this tempo
event will be adjusted when you warp the tempo grid with the
tool. Material before the edited part won’t be affected.
• Only the default mode for the Time Warp tool is available. So
when you use the tool, the edited MIDI track is temporarily
switched to linear time base.
• The rulers in the MIDI editors can be set to “Time Linear” or
“Bars+Beats Linear” mode (see “The ruler” on page 367) –
the Time Warp tool requires Time Linear mode. If necessary,
the ruler mode will be switched when you select the Time
Warp tool.
• If Snap is activated on the toolbar in the MIDI editor, the tool
will snap to the start and end of MIDI notes when you drag the
tempo grid.

If you have calculated hitpoints for the audio event you are
editing, these will be shown when the Time Warp tool is
selected.

Typically, you would use the Time Warp tool in a MIDI
editor to match the Nuendo tempo to freely recorded MIDI
material (much like the audio example above).

10. Press [Shift] and click at that position to insert a tempo
event there.
This locks this matched position. The material to the left will not be affected when you make adjustments further along.

11. Now match the tempo grid to the next (unmatched)
beat by clicking and dragging with the Time Warp tool.
The tempo event you inserted in step 10 will be adjusted.

12. Work your way through the recording this way – when
you find that the recording drifts from the tempo, repeat
steps 9 to 11 above.
Now the Tempo track follows the recording and you can
add sequenced material, rearrange the recording etc.

• The number of hitpoints shown depends on the Hitpoint Sensitivity slider setting you’ve made in Hitpoint mode.
• If you activate the Snap to Zero Crossing button on the toolbar, the Time Warp tool will snap to hitpoints when you drag
the tempo grid.
• You can use the Create Markers from Hitpoints function (on
the Hitpoints submenu of the Audio menu) to create markers
at the hitpoint positions. This can be useful when using the
Time Warp tool in the Project window, as the tool will be magnetic to markers (if Snap to Events is activated on the toolbar).
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Window Overview
The Time Format (display
format) pop-up menu.

The Add pop-up menu and Add button for
creating new parts, events and regions.

The Filter pop-up menu,
used when editing MIDI.

The event display. This is where you view
and edit parts, events and Regions.

The Project Structure list. This is where
you navigate through the project.

While the Project window and the editors display events
and other data graphically, the Project Browser window
provides a list based representation of the project. This allows you to view and edit all events on all tracks by using
regular value editing in a list.

Opening the Project Browser
You open the Project Browser by selecting “Browser”
from the Project menu. The Browser window can be open
while you are working in other windows; any changes
made in the Project window or an editor are immediately
reflected in the Project Browser and vice versa.

In this figure, the parts on a MIDI track are displayed.

• Items with hierarchical substructures can be folded out
by clicking the plus symbols or the “closed folder” symbols in the Project Structure list.

Navigating in the Browser

When the substructure of an item is revealed, a minus symbol or an “open
folder” symbol is shown instead – click this to hide the substructure.

You use the Project Browser much like you use the Windows Explorer and Mac OS X Finder for browsing folders
on your hard disk:
• Click on an item in the Project Structure list to select it
for viewing.
The contents of the item are shown in the event display.

• To reveal or hide all substructures in the Project Structure list, use the buttons “(+) All” and “(–) All” above the list.
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• The actual editing is done in the event display, using
regular value editing techniques.

Editing tracks

There is one exception: You can rename items in the Project Structure
list by clicking on their names and typing.

Editing audio tracks
Audio tracks can have two “subitems”: Track Data and
Automation.

Customizing the view

• The Automation item corresponds to the Automation subtrack
in the Project window, and contains the track’s automation
events (see “Editing Automation tracks” on page 432).
• The Track Data item corresponds to the actual audio track in
the Project window. It contains audio events and/or audio
parts, which in turn can contain audio events.

You can drag the divider between the Project Structure
list and the event display to make one of them wider and
the other narrower. Furthermore, the event display can be
customized in the following ways:
• You can change the order of the columns by dragging
the column headings to the left or right.

Note that if you have not performed any automation or
opened an automation subtrack, the Browser will only
contain the audio data.

• You can resize columns by dragging the dividers between the column headings.
• To select a display format for all position and length values, use the Time Format pop-up menu.
• You can sort events in the display by columns, by clicking the column heading.

Audio track

For example, if you want to sort events by their start positions, click that
column heading. An arrow appears in the column heading, indicating that
events are sorted by that column. The direction of the arrow indicates
whether the events are sorted in ascending or descending order. To
change the direction, click the column heading again.

Track Data subitem of
the audio track
Audio parts
Automation
subtracks

Importing files via the MediaBay
As the Project Browser is just another view of the project,
you can import audio, video and MIDI files into the project
via the MediaBay. For this, select the file in the MediaBay
and drag and drop it into the Project Browser.

Audio events

The following parameters are available for the different
items:

Ö You can only import into existing tracks. This means,
for example, that a video track has to exist in the Project
window prior to importing a video file in the Project
Browser.

The list columns for audio events:

For more information about the MediaBay, see
“The MediaBay” on page 314.

About the Sync Selection option
If the “Sync Selection” checkbox is activated (in the top
right corner of the Project Browser), selecting an event in
the Project window automatically selects it in the Project
Browser, and vice versa. This makes it easy to locate
events in the two windows.

Parameter

Description

Name

Allows you to enter a descriptive comment for the event.
Double-clicking on the waveform image beside it opens
the Sample Editor for the event.

File

The name of the audio file referenced by the event’s audio clip.

Start

The start position of the event. If the event belongs to an
audio part, you cannot move it outside the part.

End

The end position of the event.

Snap

The absolute position of the event’s snap point. Note that
adjusting this value will not change the position of the
snap point within the event – instead it is another way of
moving the event!

Length

The length of the event.
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Parameter

Description

Editing MIDI tracks

Offset

This determines “where in the audio clip” the event starts.
Adjusting this value is the same as sliding the contents of
the event in the Project window (see “Sliding the contents of an event or part” on page 49).
You can only specify positive Offset values, since the
event cannot start before the start of the clip. Likewise, it
cannot end after the end of the clip. If the event already
plays the whole clip, the Offset cannot be adjusted at all.

Just like audio tracks, MIDI tracks can have two “subitems”: Track Data and Automation.

Volume

The volume of the event, as set with the Volume handle or
on the info line in the Project Window.

Fade In
Fade Out

The length of the fade-in and fade-out areas respectively.
If you use these settings to add a fade (where there previously was none), a linear fade will be created. If you adjust the length of an existing fade, the previous fade
shape will be maintained.

Mute

Click in this column to mute or unmute the event.

Image

Displays a waveform image of the event inside a gray box
corresponding to the clip. The image is scaled according
to the width of the column.

• The Track Data item corresponds to the actual MIDI track in
the Project window and can contain MIDI parts (which in turn
can contain MIDI events).
• The Automation item corresponds to the automation subtrack
in the Project window, and contains the track’s automation
events (see “Editing Automation tracks” on page 432).
Note that if you have not performed any automation or
opened an automation subtrack, the Browser will only
contain the MIDI data.
When editing the Track Data, the following parameters are
available:
The list columns for MIDI events:
Parameter

The list columns for audio parts:
Parameter

Description

Name

The name of the part. Double-clicking on the part symbol
beside it opens the Audio Part Editor for the part.

Start

The start position of the part. Editing this value is the
same as moving the part in the Project window.

End

The end position of the part. Editing this value is the same
as resizing the part in the Project window.

Length

The length of the part. Editing this value is the same as
resizing the part in the Project window.

Offset

This adjusts the start position of the events within the
part. Adjusting this value is the same as sliding the contents of the part in the Project window (see “Sliding the
contents of an event or part” on page 49). Setting a positive Offset value is the same as sliding the contents to
the left, while a negative Offset corresponds to sliding
the contents to the right.

Mute

Click in this column to mute or unmute the part.

Description

Type

The type of MIDI event. This cannot be changed.

Start

The position of the event. Editing this value is the same as
moving the event.

End

This is only used for note events, allowing you to view and
edit the end position of a note (thereby resizing it).

Length

This is only used for note events. It shows the length of
the note – changing this resizes the note and automatically changes the End value as well.

Data 1

The property of this value depends on the type of MIDI
event:
For notes, this is the note number (pitch). This is displayed and edited as a note name and an octave number,
with the values ranging between C-2 and G8.
For Controller events, this is the type of Controller, displayed in words. Note that you can edit this by entering a
number – the corresponding Controller type is automatically displayed.
For Pitch Bend events, this is the fine adjustment of the
bend amount.
For Poly Pressure events, this is the note number (pitch).
For other event types, this is the value of the event.

Data 2

The property of this value depends on the type of MIDI
event:
For notes, this is the note-on velocity.
For Controller events, this is the value of the event.
For Pitch Bend events, this is the coarse bend amount.
For Poly Pressure events, this is the amount of pressure.
For other event types, this is not used.

Creating audio parts
When the “Audio” item of an audio track is selected in the
Project Structure list, you can create empty audio parts on
the track by clicking the Add button on the toolbar. This
will insert a part between the left and right locator.
Channel

The event’s MIDI Channel. See “Notes” on page 81.

Comment

This column is used for some event types only, providing
an additional comment about the event.
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The list columns for MIDI parts:

Creating MIDI events

Parameter

Description

Name

The name of the part.

You can use the Project Browser to create new MIDI
events:

Start

The start position of the part. Editing this value is the
same as moving the part.

End

The end position of the part. Changing this is the same as
resizing the part (and will automatically affect the Length
value as well).

Length

The length of the part. Changing this resizes the part and
automatically changes the End value.

Offset

This adjusts the start position of the events within the
part. Adjusting this value is the same as sliding the contents of the part in the Project window (see “Sliding the
contents of an event or part” on page 49). Setting a positive Offset value is the same as sliding the contents to
the left, while a negative Offset corresponds to sliding
the contents to the right.

Mute

Click in this column to mute or unmute the part.

1. Select a MIDI part in the Project Structure list.
2. Move the project cursor to the desired position for the
new event.
3. Use the Add pop-up above the event display to select
which type of MIDI event to add.

Ö For SysEx (system exclusive) events, you can only edit
the position (Start) in the list.

4. Click the Add button.

However, clicking the Comment column opens the SysEx Editor, in which
you can perform detailed editing of system exclusive events. For a description of this, see “Working with System Exclusive messages” on page 410.

An event of the selected type is added to the part, at the project cursor
position. If the cursor is outside the selected part, the event is added at
the beginning of the part.

Filtering MIDI events

Editing Automation tracks

When you are editing MIDI in the Project Browser, the
large number of different MIDI events displayed can make
it hard to find your way. To remedy this, the Filter pop-up
menu allows you to select a single event type for display.

All kinds of Nuendo automation (the automation subtracks
for MIDI, instrument, audio, group and FX channel tracks
or the individual automation tracks for VST Instruments,
ReWire channels or Input/Output busses) are handled in
the same way in the Project Browser. Each Automation
item in the Project Structure list will have a number of subentries, one for each automated parameter. Selecting one
of these parameters in the Project Structure list shows its
automation events in the list:

When this option is selected, only Program Change events will be
shown in the event display. To show all event types, select the top
item (“---”) from the menu.

Creating MIDI parts
When a MIDI track is selected in the Project Structure list,
you can create empty MIDI parts on the track by clicking
the Add button. This will insert a part between the left and
right locator.
You can use the two columns in the list to edit the position
of the events and their values.
432
The Project Browser

Editing the Video track

Editing the Tempo track

When the Video track is selected in the Project Structure
list, the event display lists the video events on the track,
with the following parameters:

When the Tempo track is selected in the Project Structure
list, the event display shows the events on the Tempo
track, with the following parameters:

Column

Description

Parameter

Description

Name

The name of the video clip that the event refers to.

Position

Start

The start position of the event. Editing this value is the
same as moving the event.

The position of the Tempo event. You cannot move the
first event on the Tempo track.

Tempo

The tempo value of the event.

End

The end position of the event. Editing this value is the
same as resizing the event, and will automatically change
the Length value as well.

Type

Length

The length of the event. Editing this value is the same as
resizing the event, and will automatically change the End
value as well.

This indicates whether the tempo should jump to the
value of the event (“Jump” type) or whether it should
change gradually from the previous Tempo event, creating a ramp (“Ramp” type). See “Editing the tempo curve”
on page 417.

Offset

This determines “where in the video clip” the event starts.
Note that the event cannot start before the start of the
clip, or end after the end of the clip. Thus, if the event already plays the whole video clip, the Offset cannot be
adjusted at all.

You can add new Tempo events by clicking the Add button.
This creates a jump-type event with the value 120 bpm at
the project cursor position. Make sure that there is no other
tempo event at the current cursor position.

Editing Time Signatures

Editing the Marker track

When “Signature track” is selected in the Project Structure list, the event display shows the Time Signature
events in the project:

Marker events have the following parameters:
Column

Description

Name

The name of the marker. This can be edited for all markers except the left and right locator.

Start

The position of “regular” markers or the start position of
cycle markers.

End

The end positions of cycle markers. Editing this value is
the same as resizing the cycle marker, and will automatically change the Length value as well.

Length

The length of cycle markers. Editing this value is the same
as resizing the marker, and will automatically change the
End value as well.

ID

The number of the marker. For regular (non-cycle) markers, this corresponds to the key commands used for
navigating to the markers. For example, if a marker has
ID 3, pressing [Shift]+[3] on the computer keyboard will
move the song position to that marker. By editing these
values, you can assign the most important markers to key
commands.
Note that you cannot edit the “L” and “R” marker IDs (left
and right locator) or assign IDs 1 and 2 to markers (since
these are reserved for the locators).

Parameter

Description

Position

The position of the event. Note that you cannot move the
first Time Signature event.

Signature

The value (time signature) of the event.

You can add new Time Signature events by clicking the
Add button. This creates a 4/4 event, at the beginning of
the bar closest to the project cursor position. Make sure
that there is no other time signature event at the current
cursor position.

Deleting Events
The procedure for deleting Events is the same for all different track types:
1. Click on an event (or a part) in the Event display to select it.

When the Marker track is selected, you can insert markers
by selecting “Marker” or “Cycle Marker” from the Add
pop-up menu and clicking the Add button. Regular markers will be added at the current project cursor position
while cycle markers will be added between the current left
and right locator positions.

2. Select Delete from the Edit menu or press [Delete] or
[Backspace].
!

Note that you cannot delete the first Tempo event or
the first Time Signature event.
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Overview

Viewing the pages in the Track Sheet

The Track Sheet provides a text-form “flow-chart” representation of the Project. It lists all audio (and video) tracks
and their contents, and can easily be printed out.

If your project is large (i.e. there are many tracks and/or
many events) or if you are working with a large scale factor
(see below), the resulting Track Sheet may have more
than one page.

To open the Track Sheet window, select “Track Sheet”
from the Project menu.

The more tracks you have, the larger the number of pages
next to each other (horizontally). The more events you
have, the larger the number of pages below each other.
To select which page should be visible in the Track Sheet
window, you use the “Y Page” and “X Page” fields in the
upper left part of the Track Sheet window. You could think
of the Track Sheet as divided into rows and columns, with
“Y Page” determining which row should be viewed and “X
Page” determining the column. The numbers in parenthesis
show the total number of rows and columns, respectively.

In this case, the page in row 2 and column 3 is shown:
X

The actual Track Sheet is displayed in the lower part of the
window. It contains the following items:

Y

• The leftmost time column contains a list of time positions
in the display format selected in the Project Setup dialog.

1

1

2

3

4

The time positions relate to start and end times of audio or video events
or parts on the tracks.

• The following columns display the tracks in the order
they appear in the Track list.
Only audio and video tracks are shown.

2

• The events are listed in their corresponding track columns in the order they appear (starting at the top).
• For each event, the start and end times are shown, with
a vertical line binding the two together.

• The size and proportions of the Track Sheet pages are
set with the Page Setup dialog, see “Printing the Track
Sheet” on page 436.
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Adjusting the view

Setting

Description

The two sliders at the bottom of the Track Sheet window
have the following functionality:

No leading
zeroes

By default, the time positions of events will be listed in a
syntax with “leading zeroes”. E.g. if the display format is
seconds, hours and minutes will be listed as “01”, “02”
etc. If this is activated, the time column will not display the
leading zeroes.

Merge events
if gap is less
or equal...

If events on a track are lined up end to end – i.e. there is
no gap between them – they will be considered as a single event in the Track Sheet. By defining a value in this
box, you can specify how large a gap between events has
to be for them to be considered as separate events. If
gaps between events are smaller than or equal to the
value you specify, they will be listed as a single event.
Otherwise they will be listed as separate events.

Name Filter

This allows you to filter out certain event names of your
choice so that they are not displayed in the Track Sheet.
Click in the text field and type in the name(s) – to enter
several names, separate each with a semi-colon (;). Partial names are OK, so if you e.g. want to filter out the
event name “Crossfade”, you could just write “Cross”.
However, this would filter out other events starting with
the word cross as well – e.g. “Crosstalk” would also be
filtered out.

• The slider in the lower left corner is the scale slider.
Use this to adjust the actual size of the Track Sheet contents (including
the font sizes). This will also affect the number of tracks and events
shown on each page.

• The slider in the lower right corner governs the display
zoom.
This affects how much of the Track Sheet is shown in the Track Sheet
window – the printout is not affected.

You can also adjust the width of the columns by dragging
the edges of the “Timecode” and “Tracks” fields at the top
of the window – this resizes the corresponding columns in
the Track Sheet.

Resizing the track columns. If the Timecode and Tracks fields are hidden, click the “More” button.

Printing the Track Sheet

Additional settings

Printing is done using the standard procedures:

• The “Pen Width” determines the thickness of the vertical
lines that bind together the start and end times for events
and parts.

1. Make sure the correct page size and page orientation
is selected in the Page Setup dialog on the File menu.
You may also want to make additional printer settings, following the standard Windows/Mac procedures.

• If the Track Sheet is more than one page wide, you can
use the “Timecode Column” pop-up menu to determine
whether the time column should appear only on the first
page, on each new page, or not at all.

2. Select “Print...” from the File menu.
Make the desired printer settings in the dialog that appears, and click
OK. The Track Sheet is printed.

The following settings can be shown or hidden by clicking
the “More/Less” button.
Setting

Description

Project

By default, this is the name of the current project, but you
can adjust this if you like. The project name will be shown
in the top left corner of each Track Sheet page.

Editor

The editor name you enter will be shown below the
project name in the Track Sheet.

Heading

Allows you to enter a heading (shown centered at the top
of each Track Sheet page).

Do not show
If this checkbox is ticked, the Track Sheet will not display
end times if
the end times of Events shorter than the time specified in
length is under... the field to the right. This is useful if you have many short
events, like spot effects, where only the start time is of
any relevance.
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Export Audio Mixdown

Introduction

Mixing down to an audio file

The Export Audio Mixdown function in Nuendo allows you
to mix down audio from the program to a file on your hard
disk, in a number of formats. You can choose to mix down
one of the following:

1. Set up the left and right locators to encompass the
area that you want to mix down.

• An output bus.

This includes muting unwanted tracks or parts, making manual mixer settings and/or activating the R (Read) automation buttons for some or all
mixer channels.

2. Set up your tracks, so that they play back the way you
want.

For example, if you have set up a stereo mix with tracks routed to a stereo
output bus, mixing down that output bus would give you a mixdown file
containing the whole mix. Similarly, you can mix down a complete surround
bus, either to a single multi-channel file or to one file per surround channel
(by activating the split channels option).

3. Pull down the File menu and select “Audio Mixdown…”
from the Export submenu.
The Export Audio Mixdown dialog appears.

• The channel for an audio track.
This will mix down the channel for the track, complete with insert effects,
EQ, etc. This can be useful for turning a number of events into a single file,
or if you are using CPU-intensive insert effects – by exporting the track and
re-importing it into the project you can turn off the insert effect, saving processor power.

• Any kind of audio channel in the mixer.
This includes VST Instrument channels, effect return channels (FX Channel tracks), Group channels and ReWire channels. There are many uses
for this – for example, you can mix down an effect return track or turn individual ReWire channels into audio files.

Notes
• The Export Audio Mixdown function mixes down the
area between the left and right locators.
• When you mix down, you get what you hear – mutes,
mixer settings and insert effects are taken into account.
Note though that you will only include the sound of the bus or channel
you select for mixdown.

The available settings and options differ depending on the
selected file format (see “The available file formats” on
page 439).

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first
need to record all your MIDI music to audio tracks (by connecting the
outputs of your MIDI instruments to your audio inputs and recording, as
with any other sound source).

4. In the File Location section at the top you can specify
a name and path for the mixdown file.
Note that there are a number of options:

• A single instrument track can be directly exported as an
audio mixdown.

• Click the Options/Functions button to the right of the File
Name field to open a pop-up menu.
• Select an entry from the Recent Paths sub-menu to reuse a
path specified for a previous export.
• Select “Set File Name to Project Name” to use the project
name for the export file.
• Enable the “Auto Update File Name” option (so that a check
mark is displayed before it) to add a number to the specified
file name everytime you click the Export button.

• You can also export selected tracks – this is a different
function that doesn’t create an audio mixdown.
Rather, this is a way to transfer complete tracks (including clips and
events) from one project to another. See “Importing audio” on page 491.
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• Activate the option “Use Project Audio Folder” to specify a
path. This saves the mixdown file in the Project Audio folder.

• If you have activated any of the “Import into project” options, the file will be imported back into the project.

5. Select a file format with the File Format pop-up menu.

When playing back the re-imported file in Nuendo, remember to mute
the original tracks so that you really hear the correct file.

6. Select the bus or channel you want to mix down with
the Outputs pop-up menu in the “Audio Engine Output”
section.

About the Import options dialog
When you activate any of the options in the Import section, the Import Options dialog will open. For a detailed
description of the options in this dialog see “Import Medium…” on page 306.

This lists all output busses and channels in the active project.

7. Activate the Split Channels option if you want to export all channels as mono files, or “Mono Export” if you
want to export all channels as a single mono file.
8. Make additional settings for the file to be created.

The available file formats

This includes selecting sample rate, bit depth, etc. The available options
depend on the selected file format – see “The available file formats” on
page 439.

The following pages describe the different export file formats, as well as their options and settings.
•
•
•
•
•

AIFF files (see “AIFF files” on page 439).
AIFC files (see “AIFC files” on page 440).
Wave files (see “Wave files” on page 440).
Wave 64 files (see “Wave64 files” on page 441).
Broadcast Wave files (see “Broadcast Wave files” on page
441).
• MP3 files (see “MPEG 1 Layer 3 files” on page 441).
• Ogg Vorbis files (see “Ogg Vorbis files” on page 442).
• Windows Media Audio Pro files (Windows only, see “Windows Media Audio Pro files (Windows only)” on page 442).

9. If you want to automatically import the resulting audio
file back into Nuendo, activate the checkboxes in the “Import into project” section.
If you activate the “Pool” checkbox, a clip referring to the file will appear
in the Pool. Activating the “Audio Track” checkbox as well, will create an
audio event that plays the clip, and place it on a new audio track, starting
at the left locator.

Ö The Import options are only available if you have selected an uncompressed file format.
10. If you activate Real-Time Export, the export will happen
in real time, i.e. the process will take the same time as regular playback.

AIFF files
AIFF stands for Audio Interchange File Format, a standard
defined by Apple Inc. AIFF files have the extension “.aif”
and are used on most computer platforms.

Some VST plug-ins require this in order to have enough time to update
correctly during the mixdown – consult the plug-in manufacturers if uncertain.

For AIFF files the following options are available:

• When Real-Time Export is activated, the exported audio
will be played back via the Control Room.

Option

Description

The fader below the Real-Time Export checkbox allows you to adjust the
Control Room volume. Note that if the Control Room is deactivated, the
Audition Volume slider will not be available.

File Name
(File Location
section)

In this field you can enter a name for the mixdown file.

11. If you activate Update Display, the meters will be updated during the export process.

Path
(File Location
section)

Here you can specify a path where you want the mixdown to be saved.

Use Project
Audio Folder
(File Location
section)

If you activate this options the mixdown file is saved in
the Project Audio folder, as opposed to the specified
path.

File Format popup menu (File
Format section)

From this pop-up menu you can select the file format
for the export, in this case “AIFF File”.

This allows you to check for clipping, for example.

12. Click Export.
A dialog with a progress bar is displayed while the audio file
is created. If you change your mind during the file creation,
you can click the Abort button to abort the operation.
• If the option “Close dialog after export” is activated, the
dialog will be closed, otherwise it will be left open.
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Option

Description

Option

Description

Insert Broadcast
Wave Chunk
(File Format
section)

This allows you to include information about the date
and time of creation, a timecode position (allowing you
to insert exported audio at the correct position in other
projects, etc.) along with author, description and reference text strings in the exported file.
Some applications may not be able to handle files with
embedded info – if you get problems using the file in
another application, turn off the option and re-export.

Bit Depth (Audio Engine Output section)

Edit button (File
Format section)

By clicking this button the “Broadcast Wave Chunk”
dialog opens where you can enter additional information that will be embedded in the exported files. Note
that in the Preferences (Record–Audio–Broadcast
Wave page) you can enter default text strings for author, description and reference that will automatically
be displayed in the “Broadcast Wave Chunk” dialog.

Outputs pop-up
menu (Audio
Engine Output
section)

This menu lists all output busses and channels in the
active project. Simply select the bus or channel you
want to mix down.

Allows you to select 8, 16, 24 bit or 32 bit (float) files.
If the file is an “intermediate mixdown” that you plan to
re-import and continue working on in Nuendo, we recommend that you select the 32 bit (float) option.
32 bit (float) is a very high resolution (the same resolution as used internally for audio processing in Nuendo),
and the audio files will be twice the size of 16 bit files.
If you are making a mixdown for CD burning, you should
use the 16 bit option, as CD audio is always 16 bit.
In this case, we recommend that you activate the UV22HR dithering plug-in (see the separate manual “Nuendo Expansion Kit – Cubase Music Tools for Nuendo
4” for details). This reduces the effects of quantization
noise and artifacts from being introduced when converting the audio down to 16 bit.
8 bit resolution should only be used if required, since it
will result in limited audio quality. 8 bit audio may be
suitable in some multimedia applications, etc.

Mono Export
(Audio Engine
Output section)

If you activate this option, the exported audio is mixed
down to mono.

Audition Volume
fader (Audio
Engine Output
section)

The fader below the Real-Time Export checkbox allows you to adjust the Control Room volume. Note that
this fader is only available if the Control Room is activated.

Split Channels
(Audio Engine
Output section)

Activate this option if you want to export all channels
as mono files.

Pool (Import into
project section)

Real-Time
Export (Audio
Engine Output
section)

If you activate this option, the export will happen in real
time, i.e. the process will take the same time as regular
playback. Some VST plug-ins require this in order to
have enough time to update correctly during the mixdown – consult the plug-in manufacturers if uncertain.
When Real-Time Export is activated, the exported audio will be played back via the Control Room.

Activate this option if you want to import the resulting
audio file automatically back into the Pool. A clip referring to the file will appear in the Pool.
If this option is activated, the Import Options dialog appears on export. For a description of the available settings, see “Import Medium…” on page 306.

Audio Track
(Import into
project section)

If you activate this option, an audio event that plays the
clip will be created and placed on a new audio track,
starting at the left locator.
If this option is activated, the Import Options dialog appears on export. For a description of the available settings, see “Import Medium…” on page 306.

Update Display
(Audio Engine
Output section)

If you activate this option, the meters will be updated
during the export process. This allows you to check for
clipping, for example.

Close dialog
after export

If this option is activated, the dialog will be closed after
the export, otherwise it will be left open.

Sample Rate
(Audio Engine
Output section)

This setting determines the frequency range of the exported audio – the lower the sample rate, the lower the
highest audible frequency in the audio. In most cases,
you should select the sample rate set for the project,
since a lower sample rate will degrade the audio quality (mainly reducing the high frequency content) and a
higher sample rate will only increase the file size, without adding to audio quality. Also consider the future
usage of the file – if you e.g. plan to import the file into
another application, you should select a sample rate
supported by that application.
If you are making a mixdown for CD burning, you
should select 44.100 kHz, since this is the sample rate
used on audio CDs.

AIFC files
AIFC stands for Audio Interchange File Format Compressed, a standard defined by Apple Inc. These files support compression ratios as high as 6:1 and contain tags in
the header. AIFC files have the extension “.aifc” and are
used on most computer platforms.
AIFC files support the same options as AIFF files.

Wave files
Wave files have the extension “.wav” and are the most
common file format on the PC platform.
Wave files support the same options as AIFF files.
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Wave64 files

Option

Description

Wave64 is a proprietary format developed by Sonic
Foundry Inc. In terms of audio quality, Wave64 files are
identical to standard wave files, but in the file headers
Wave64 files use 64-bit values for addressing where wave
files use 32-bit values. The consequence of this is that
Wave64 files can be considerably larger than standard
Wave files. Wave64 is therefore a good file format choice
for really long recordings (file sizes over 2GB), e.g. live surround recordings. Wave64 files have the extension “.w64”.

Bit Rate fader
(File Format
section)

By moving this fader, you can select a bit rate for the
mp3 file. As a rule, the higher the bit rate, the better the
audio quality and the larger the file. For stereo audio,
128kBit/s is often considered to result in “good” audio
quality.

Sample Rate
pop-up (File Format section)

In this pop-up menu you can select a Sample Rate for
the mp3 file.

Insert ID3 Tag
option (File Format section)

This allows you to include ID3 Tag information in the
exported file.

Wave64 files support the same options as AIFF files.

Edit ID3 Tag
button (File Format section)

When you click this, the ID3 Tag dialog opens, in
which you can enter information about the file. This additional information will be embedded as text strings in
the file, and can be displayed by some mp3 playback
applications.

Outputs pop-up
menu (Audio
Engine Output
section)

This menu lists all output busses and channels in the
active project. Simply select the bus or channel you
want to mix down.

Mono Export
(Audio Engine
Output section)

If you activate this option, the exported audio is mixed
down to mono.

Split Channels
(Audio Engine
Output section)

Activate this option if you want to export all channels
as mono files.

Real-Time
Export (Audio
Engine Output
section)

If you activate this option, the export will happen in real
time, i.e. the process will take the same time as regular
playback. Some VST plug-ins require this in order to
have enough time to update correctly during the mixdown – consult the plug-in manufacturers if uncertain.
When Real-Time Export is activated, the exported audio will be played back via the Control Room.

Update Display
(Audio Engine
Output section)

If you activate this option, the meters will be updated
during the export process. This allows you to check for
clipping, for example.

Audition Volume
fader (Audio
Engine Output
section)

The fader below the Real-Time Export checkbox allows
you to adjust the Control Room volume. Note that this
fader is available only if the Control Room is activated.

Close dialog
after export

If this option is activated, the dialog will be closed after
the export, otherwise it will be left open.

Broadcast Wave files
Concerning audio, Broadcast Wave files are the same as
regular Wave or Wave64 files, but without compression. To
create a Broadcast Wave file, select either Wave or
Wave64 as the file format and activate the Insert Broadcast
Wave Chunk option. Click Edit if you wish to edit the chunk
information, otherwise the defaults as specified in the Preferences (Record–Audio–Broadcast Wave page) will be
used. Broadcast Wave files have the extension “.wav”.
Broadcast Wave files support the same options as AIFF
files.

MPEG 1 Layer 3 files
MPEG 1 Layer 3 files have the extension “.mp3”. By use of
advanced audio compression algorithms, mp3 files can be
made very small, maintaining good audio quality.
For MPEG 1 Layer 3 files the following options are available:
Option

Description

File Name
(File Location
section)

In this field you can enter a name for the mixdown file.

Path
(File Location
section)

Here you can specify a path where you want the mixdown to be saved.

Use Project
Audio Folder
(File Location
section)

If you activate this option, the mixdown file is saved in
the Project Audio folder, as opposed to the specified
path.

File Format popup menu (File
Format section)

From this pop-up menu you can select the file format
for the export.
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Ogg Vorbis files

Other file formats

Ogg Vorbis is an open source, patent-free audio encoding
and streaming technology, offering compressed audio files
(extension “.ogg”) of small size, but with comparatively high
audio quality.

Steinberg also offers optional Dolby Digital (AC3) and
DTS encoders for export directly to AC3 or DTS format.
Please go to www.steinberg.net for more information.

Windows Media Audio Pro files (Windows only)

For Ogg Vorbis files the following options are available:
Option

Description

File Name
(File Location
section)

In this field you can enter a name for the mixdown file.

Path
(File Location
section)

Here you can specify a path where you want the mixdown to be saved.

Use Project Audio Folder
(File Location
section)

If you activate this option, the mixdown file is saved in
the Project Audio folder, as opposed to the specified
path.

File Format popup menu (File
Format section)

From this pop-up menu you can select the file format
for the export.

Quality fader
(File Format
section)

The Ogg Vorbis encoder uses variable bit rate encoding, and the Quality setting determines between which
limits the bit rate will vary. Generally speaking, the
higher the Quality setting, the higher the sound quality
but also the larger the files.

Outputs pop-up
menu (Audio Engine Output section)

This menu lists all output busses and channels in the
active project. Simply select the bus or channel you
want to mix down.

Mono Export
(Audio Engine
Output section)

If you activate this option, the exported audio is mixed
down to mono.

Split Channels
(Audio Engine
Output section)

Activate this option if you want to export all channels
as mono files.

Real-Time Export (Audio Engine Output
section)

If you activate this option, the export will happen in real
time, i.e. the process will take the same time as regular
playback. Some VST plug-ins require this in order to
have enough time to update correctly during the mixdown – consult the plug-in manufacturers if uncertain.
When Real-Time Export is activated, the exported audio will be played back via the Control Room.

Update Display
(Audio Engine
Output section)

If you activate this option, the meters will be updated
during the export process. This allows you to check for
clipping, for example.

Audition Volume
fader (Audio Engine Output section)

The fader below the Real-Time Export checkbox allows you to adjust the Control Room volume. Note that
this fader is available only if the Control Room is activated.

Close dialog after export

If this option is activated, the dialog will be closed after
the export, otherwise it will be left open.

This is a continuation of the Windows Media Audio format
developed by Microsoft Inc. Due to the advanced audio codecs and lossless compression used, WMA Pro files can
be decreased in size with no loss of audio quality. Furthermore, WMA Pro features the possibility of mixing down to
5.1 surround sound. The files have the extension “.wma”.

Exporting a WMA mixdown

Ö Depending on the chosen output, not all options may
be shown.
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The following options are available:

menu allows you to select from various levels of desired
quality, with 10 being the lowest and 100 the highest.
Generally, the higher the bitrate or quality you select, the
larger the final file will be. The menu also shows the channel format (5.1 or stereo).

General tab
In the Input Stream section, you set the sample rate (44.1,
48 or 96 kHz) and the bit resolution (16 bit or 24 bit) of the
encoded file. These should be set to match the sample rate
and bit resolution of the source material. If no value matches
that of your source material, use the closest available value
that is higher than the actual value. E.g. if you’re using 20 bit
source material, set the bit resolution to 24 bit rather than
16 bit.

Advanced tab
• Dynamic Range Control
These controls allow you to define the dynamic range of
the encoded file. The dynamic range is the difference in
dB between the average loudness and the peak audio
level (the loudest sounds) of the audio. These settings affect how the audio is reproduced if the file is played on a
Windows XP computer with a player from the Windows
Media series, and the user activates the special “Quiet
Mode” feature of the player to control the dynamic range.

Ö The setting in the Channels field depends on the chosen output and cannot be changed manually.
The settings in the Encoding Scheme section are used for
defining the desired output from the encoder, e.g. whether
it should be a stereo file or a 5.1 surround file. Make settings appropriate for the intended use of the file. If the file
will be downloaded or streamed on the Internet, you might
not want too high bit rates, for example. See below for descriptions of the options.

The dynamic range is automatically calculated during the
encoding process, but you can specify it manually as well.
If you want to manually specify the dynamic range, first put
a checkmark in the box to the left by clicking in it, and then
enter the desired dB values in the Peak and Average
fields. You can enter any value between 0 and -90dB.
Note, however, that it is usually not recommended to
change the Average value, since it affects the overall volume level of the audio and therefore can affect the audio
quality adversely.

• Mode
The WMA Pro encoder can use either a constant bit rate
or a variable bit rate for encoding to 5.1 surround, or it can
use lossless encoding for encoding to stereo. The options
on this menu are as follows:
Mode

Description

Constant Bitrate

This will encode to a 5.1 surround file with a constant
bit rate (set in the Bit Rate/Channels menu, see below). Constant bit rate is preferably used if you want to
limit the size of the final file. The size of a file encoded
with a constant bit rate is always the bit rate times the
duration of the file.

Variable Bitrate

Encodes to a 5.1 surround file with a variable bit rate,
according to a quality scale (the desired quality is set
in the Bit Rate/Channels menu, see below). When you
encode with variable bit rates, the bit rate fluctuates
depending on the character and intricacy of the material being encoded. The more complex passages in the
source material, the higher the bit rate – and the larger
the final file.

Lossless

Encodes to a stereo file with lossless compression.

The Quiet Mode in a Windows Media player can be set to
one of three settings. Below, these settings are listed together with an explanation of how the Dynamic Range settings affect them:
• Off: If Quiet Mode is off, the dynamic range settings that were
automatically calculated during the encoding will be used.
• Little Difference: If this is selected and you have not manually
changed the dynamic range settings, the peak level will be
limited to 6dB above the average level during playback. If you
have manually specified the dynamic range, the peak level will
be limited to the mean value between the peak and average
values you specified.
• Medium Difference: If this is selected and you have not manually changed the dynamic range settings, the peak level will be
limited to 12dB above the average level. If you have changed
the dynamic range, the peak level will be limited to the peak
value you specified.

• Bit Rate/Quality
This menu allows you to set the desired bit rate. The available bit rate settings vary depending on the selected
mode and/or output channels (see above). If the Mode
“Variable Bitrate with Quality” is used (see above), the
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• Surround Reduction Coefficients
Here you can specify which amount of volume reduction, if
any, should be applied to the different channels in a surround encoding. These settings affect how the audio is reproduced on a system incapable of playing back the file in
surround, in which case the surround channels of the file
will be combined into two channels and played back in
stereo instead.
The default values will normally produce satisfactory results, but you can change the values manually if you wish.
You can enter any value between 0 and -144dB for the
surround channels, the center channel, the left and right
channels and the LFE channel respectively.
Media tab
In these fields you can enter a number of text strings with
information about the file – title, author, copyright information and a description of its contents. This information will
then be embedded in the file header and can be displayed
by some Windows Media Audio playback applications.
Ö For more information about surround sound and encoding, see the chapter “Surround sound” on page 202.
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35
Synchronization

Background

Synchronization signals

What is synchronization?

Basically there are three types of synchronization signals
for audio: timecode, MIDI clock and word clock.

Synchronization is said to exist when you make two pieces
of equipment agree on time or tempo and position info.
You can establish synchronization between Nuendo and a
number of other types of devices, including tape recorders
and video decks, but also MIDI devices that “play back”,
such as other sequencers, drum machines, “workstation
sequencers” etc.

Timecode (SMPTE, EBU, MTC, VITC etc.)
Timecode appears in a number of guises. No matter which
“format” it has, it always supplies a “clock on the wall”
type of synchronization, that is, a synchronization related
to hours, minutes, seconds and two smaller units called
“frames” and “subframes”.

When you set up a synchronization system, you must decide which unit is the master. All other devices are then
slaved to this unit, which means they will adjust their playback speed to the master’s.
!

• LTC (SMPTE, EBU) is the audio version of timecode. This
means that it can be recorded on the audio track of an audio
or video recorder.
• VITC is the video format timecode, i.e. it is stored in the actual
video image.
• MTC is the MIDI version of timecode, transmitted via MIDI cables.
• ADAT sync (Alesis) is only used with the ASIO Positioning
Protocol, see “About the ASIO Positioning Protocol (APP)” on
page 452.
• Sony 9-pin is a standard that uses serial (RS-422) communication. Sony 9-Pin contains timecode as well as machine control messages (see “Setting up Sony 9-Pin” on page 457).

For a description of the VST System Link feature
(with which you can synchronize separate computers
running Nuendo or Cubase for example), see “Working with VST System Link” on page 460.

Nuendo as slave
When a synchronization signal is coming in to Nuendo from
another device, this device is the master and Nuendo is the
slave. Nuendo will adjust its playback to the other device.
Nuendo as master

For the ASIO Positioning Protocol, other high precision
timecode formats may also be supported.

When you set up Nuendo to transmit synchronization information to other devices, Nuendo is the master and the
other devices are the slaves; they will adjust their playback
to Nuendo.

Format recommendations for timecode – without ASIO
Positioning Protocol
• When synchronizing your system to external timecode, via a
synchronizer, the most common timecode format is MTC.
Contrary to some reports you might have heard, MTC delivers
good precision for external sync. This is due to the fact that
the operating system can “time stamp” incoming MIDI messages, which increases precision.
• Sony 9-Pin is not recommended for external sync and should
only be used when no other option is available. However, you
might of course use 9-Pin for machine control, see “Sony 9Pin” on page 455.

Nuendo – both master and slave
Nuendo is a very capable synchronization device. It can
operate as both a master and a slave at the same time. For
example, Nuendo might be slaved to a tape recorder
transmitting timecode, while at the same time transmitting
MIDI Clock to a drum machine, acting as a master for that.
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Synchronizing the transport vs.
synchronizing audio

Format recommendations for timecode – with ASIO
Positioning Protocol
• LTC and VITC are the formats with the highest precision and
are recommended when available.
• MTC is the next best option and probably the most common
choice, since few audio hardware solutions have built-in LTC
or VITC readers. However, LTC and VITC offer even higher
precision when available.
• The choice with the least precision is Sony 9-Pin.

How timing is handled in a non-synchronized
system
Let’s first look at the situation where Nuendo is not synchronized to any external source:
Any digital playback system has an internal clock that ultimately affects the playback speed and stability, and PC audio hardware is no exception. This clock is extremely stable.

MIDI Clock
MIDI Clock is a tempo-based type of synchronization signals, i.e. it is related to the number of “beats per minute”.
MIDI Clock signals are suitable for synchronizing two devices that agree on tempo, such as for example Nuendo
and a drum machine.

When Nuendo is playing back with no external synchronization, all playback is internally synchronized to the internal digital audio clock.

MIDI Clock is not suitable as a master sync source
for an application like Nuendo. Therefore Nuendo will
transmit MIDI Clock signals to other devices, but it
will not receive MIDI Clock.

Let’s assume now that we use external timecode synchronization with Nuendo. For example, we might synchronize
playback to a tape recorder.

!

Synchronizing Nuendo’s playback

Timecode coming from an analog tape recorder will always vary slightly in speed. Different timecode generators
and different tape recorders will also supply timecode with
slight differences in speed. In addition, the shuttling of
tape mechanisms due to overdubs and re-recordings can
cause the physical tape to wear and stretch, which affects
the speed of the timecode.

Word Clock
Word clock is basically a replacement for the sample rate
clock in for example an audio card. Word clock hence
runs at the same rate as the sample rate in the audio,
44.1kHz, 48kHz etc.

If you use a synchronizer that generates word clock and
set up Nuendo to sync to incoming timecode, it will vary
its overall playback speed to compensate for such fluctuations in the speed of the timecode – that’s the whole purpose of synchronization.

Word clock does not contain any position information, it is
only a “simple” signal for clocking the audio at its sample
rate.
Word clock comes in many formats, analog on coaxial cable, digital as part of an S/PDIF, AES/EBU or ADAT audio
signal, etc.

What happens with the digital audio?
The fact that Nuendo’s playback is synchronized to the
timecode does not affect the playback of the digital audio.
It still relies on the perfectly stable, built-in clock in the audio hardware.
As might be expected, problems will appear when the perfectly stable digital audio gets related to the slightly varying speed of a system synchronized to timecode.
The playback timing of each event will not be in total accordance with the tape or the MIDI playback, since the
playback speed of the audio is determined by the digital
audio hardware’s built-in clock.
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Making basic settings and
connections

Resolving to word clock
The solution to this problem is to use one external clock
for all components in the system. One master clock is
used to derive whatever type of clock signal each component in the system needs. For example, something called a
house clock can be used to generate sample rate clocks
for the digital audio hardware and timecode for Nuendo.
This ensures that all components in the system use the
same reference source for their timing.

Setting the Frame Rate
The frame rate is the number of frames per second in a film
or on a video tape. Just as there is always sixty seconds to
a minute, there is always a certain number of frames to
each second. However, the frame rate used varies with the
type of media (film or video), which country the video tape
has been produced in, and other circumstances.

Synchronizing digital audio to external clocks running at
sample rate is often called “resolving” or “synchronizing to
word clock”.

In the Project Setup dialog are two settings for frame rates:
• The Frame Rate pop-up is automatically adjusted to the
frame rate of the incoming timecode.

If you aim to perform synchronization to external signals,
we strongly recommend that you obtain proper synchronization equipment. This encompasses:

There is an exception to this when you are synchronizing Nuendo to MIDI
Timecode: If you have selected 29.97 fps or 30 dfps as Frame Rate in
Nuendo, this selection will be kept, since these frame rates are not included in the MTC format.

• An audio card that can be slaved to external word clock.
• A synchronizer that can read timecode (and possibly house
clock) and generate the required sync signals from that, such
as the Steinberg TimeLock Pro.

The following frame rates are available:

or...
• An audio system with complete built-in synchronization possibilities, preferably supporting the ASIO Positioning Protocol,
see “About the ASIO Positioning Protocol (APP)” on page 452.

Frame Rate

Description

24 fps

The traditional frame rate of 35mm film.

25 fps

The frame rate used for all video and audio in Europe
(EBU).

29.97 fps

Straight 29.97 frames per second.

30 fps

Straight 30 frames per second. This is often used in the
United States for audio only work.

29.97 dfps

“Drop frame” code running at 29.97 frames per second,
most often used in the United States of America for work
with color video.

30 dfps

Very rarely used.

23.976 fps

Frame rate used for HDTV.

24.976 fps

Frame rate used for HDTV.

59.94 fps

Frame rate used for HDTV.

60 fps

Frame rate used for HDTV.

Using timecode without word clock
Of course, it is possible to set up a synchronization system where you lock Nuendo to timecode without using
word clock. However, please note that the timing of audio
vs. MIDI cannot be guaranteed and that fluctuations in
speed in the incoming timecode will not affect the playback of audio events. This means that synchronizing to
timecode may work in the following situations:
• When the timecode was originally generated by the audio card itself.
• When the source providing the timecode is extremely
stable (such as a digital video system, a digital tape recorder or another computer).

• The Display Format pop-up contains a number of formats that when selected work as the “master” setting for
the display format used in the various windows’ rulers and
position displays.

• When you remain synchronized to that same stable
source throughout the entire process, both while recording and playing back audio.

The item “60 fps (user)” on this menu represents a user definable frame
rate. To make editing with frame accuracy correspond to the actual frame
rate in an external sync source, you need to set this frame rate to the
same value as the Frame Rate pop-up.
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Proceed as follows:

Synchronization settings

1. Open the Preferences dialog (accessed from the File
menu under Windows or the Nuendo menu on the Mac)
and select the Transport page.

In the following sections, you will find a description of how
to set up your system for the different timecode sources:

2. Enter the desired frame rate under “User Definable
Framerate”.

Internal Timecode
In this mode, Nuendo is the master. When working with
MMC (see “MIDI Machine Control (MMC)” on page 454),
the external device gives the start and stop signals, but is
synchronized by Nuendo.

Either type the desired value directly or use the arrow buttons to increase/decrease the value. You can enter any value between 2-200.

Use the “MIDI Timecode Destinations” and “MIDI Clock
Destinations” sections to specify which devices should be
slaved to Nuendo.

3. When you’re done, click OK to close the dialog and
save the settings.

Synchronizing other Equipment to Nuendo

The Frame Rate you specified will now be the one used
when you select the “User” option on the Display Format
pop-up.

You may have other MIDI devices that you want to synchronize to Nuendo. There are two types of synchronization that Nuendo can transmit: MIDI Clock and MIDI
Timecode.

Making connections
The following connections are required for external sync
via a synchronizer, including resolving of the audio card.
For details on audio card and synchronizer settings and
connections, see the manuals for these devices.

Transmitting MIDI Clock
If you transmit MIDI Clock to a device supporting this type
of synchronization signal, the other device will follow Nuendo’s tempo. The tempo setting in the other device is of
no relevance. Instead, it plays at the same tempo as Nuendo. If the device also reacts to Song Position Pointers
(which Nuendo transmits) it will follow when you wind, rewind and locate using the Nuendo Transport panel.

• Route the master clock signal (LTC, VITC, etc.) to an input on the synchronizer.
• Connect the word clock output on the synchronizer to a
word clock input on the audio card.

Ö MIDI Clock transport commands include “Start”,
“Stop” and “Continue”. However, some MIDI equipment
(e.g. some drum machines) do not recognize the “Continue” command. If this is the case with your equipment,
activate the option “Always Send Start Message” in the
Project Synchronization Setup dialog (for the MIDI Clock
Destinations).

• Connect the MIDI Timecode (MTC) or 9-Pin output on
the synchronizer to the corresponding input on the computer.
• Set up the synchronizer and make sure the frame rate
settings are in accordance with the master clock.

When this is activated, only the Start command is used.

A typical synchronization setup.
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3. Activate the sync outputs by using the corresponding
checkboxes.

• Activate “MIDI Clock Follows Project Position” if you
want the other device to follow when you loop, jump and
locate during playback.

You can output any combination of MIDI Timecode and MIDI Clock to
any combination of outputs (however, you probably don’t want to send
MTC and MIDI Clock to the same output).

When this is activated, the sent MIDI Clock signals will follow the sequencer time and tempo position at all times.
!

!

Please note that some external devices may not react
smoothly to these repositioning messages. Especially when working with some older devices, it may
take some time for them to synchronize accurately to
the project time.

Some MIDI interfaces will automatically send MIDI
Clock to all MIDI outputs, regardless of the MIDI
Clock Port selection in Nuendo. If this is the case,
you should only select one MIDI Clock Port (consult
the documentation of the MIDI Interface if in doubt).

MIDI Timecode transmitted to this output.

Transmitting MIDI Timecode
If you transmit MIDI Timecode to a device supporting this
type of synchronization signal, the device will synchronize
time-wise to Nuendo, that is, the time displays on Nuendo’s
Transport panel and on the other device will agree. When
you wind and locate Nuendo and then activate playback,
the other device will follow from the same position (if it has
this capability and is set up for it!).
Ö If you want to be able to loop, jump and locate during
playback in Nuendo and have the other device follow, activate “MIDI Timecode Follows Project Time”.

MIDI Clock transmitted to this output.

4. Set the other device(s) to their “external synchronization” mode (or some other mode with a similar name) and
activate playback on them if necessary.

When this is activated, the sent MIDI Timecode will follow the sequencer
time position at all times.

Setting Up

5. Activate playback in Nuendo, and the other device(s)
will follow.

1. Connect the desired MIDI Outputs from Nuendo to the
device(s) that you plan to synchronize.
2. Open the Project Synchronization Setup dialog from
the Transport menu.
Timecode Source settings

Input and Output for MIDI
Machine Control messages.
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MIDI Timecode and 9 Pin Sync

5. Use the Start value to set which frame on the external
device (e.g. a video tape) should correspond to the beginning of the project.

In these modes, Nuendo is the slave and the timecode is
sent by the MIDI Timecode Source specified in the corresponding section.

Most video projects have a program start time of 01:00:00:00 for convenience. It is recommended in most cases to have a project start time of
00:59:00:00 to allow for synchronizer lockup times, test tones, timing
beeps and so forth.

Setting up Nuendo for external sync to timecode
1. In the Project Synchronization Setup dialog, set the
Timecode Source to MIDI Timecode or one of the 9-Pin
options.

Set this to the timecode position where
you want the project
to start.

2. For MIDI Timecode, use the MTC Input pop-up menu
in the MIDI Timecode Settings section to select an input
for the timecode.
The MIDI Input for the timecode

• You can also set this with the function “Set Timecode at
Cursor” on the Project menu.
This is useful if you know that a certain position in your project would coincide with a certain timecode position in the external device. Move the
project cursor to the desired position, select “Set Timecode at Cursor”
and specify the corresponding timecode position in the dialog that appears – the Start value is adjusted accordingly.

Sync to timecode activated

6. In the dialog that appears, you are asked if you want to
keep the project content at its timecode positions. Select
“No”.
This will make all events and parts keep their positions relative to the
project start.

7. Close the Project Setup dialog.
8. On the Transport panel, activate the Sync button (or
select “Use External Sync” from the Transport menu).

Sync settings for MIDI Timecode.

3. For Sony 9-pin timecode, select a port from the Serial
Port pop-up menu. See “Setting up Sony 9-Pin” on page
457 for more on connecting 9-pin devices to your computer.
Selecting a serial port

9. Start the tape (or video, or other master device) that
contains the timecode. Nuendo starts playing when it receives timecode with a position “higher” than, or equal to,
the project Start frame.

Sync to 9-Pin activated

You can wind the device that sends the timecode to any
position and start from there.
!

When the master device with the timecode is
stopped, you can use the Nuendo transport controls
as you normally do, when it is not synchronized.

You should also look into the Sync Options, see “Timecode Preferences” on page 454.

4. Close the Project Synchronization Setup dialog and
open the Project Setup dialog from the Project menu.
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ASIO Audio Device

The Sync indicator
On the Transport panel, you can check the status of incoming timecode by observing the sync indicator.

!

This option is only available if your hardware is compatible with the ASIO Positioning Protocol.

In this mode, Nuendo is the slave and the synchronization
signal can be received from another device connected to
a digital interface of the audio hardware.
About the ASIO Positioning Protocol (APP)
The Sync indicator
!

• If you have selected MIDI Timecode as Timecode
Source and MIDI Machine Control as Machine Control
Option, the sync indicator switches between “Offline” (not
waiting for sync), “Idle” (ready for sync but no signal is
coming in), and “Lock xx” (where xx is indicating the frame
rate of the incoming signal).

ASIO Positioning Protocol requires audio hardware
with specific ASIO drivers.

The ASIO Positioning Protocol is a technology that expands on the type of sync described above and makes
sample-accurate positioning possible.
When transferring audio digitally between devices, it is important that synchronization using word clock and timecode is completely correlated. If not, the audio will not be
recorded at the exact intended (sample-accurate) position,
which can cause various types of problems, such as inaccurately positioned audio material, clicks and pops etc.

• If you have selected one of the 9-pin options as Machine Control Option, the following applies:
• When the Sync button is activated for the first time, the Sync
indicator displays the name of the machine.
• When Nuendo is ready for synchronization, but no signal is
coming in, the Sync indicator reads “Stopped”.
• When the Start button is pressed, the Sync indicator reads
“Waiting”.
• When Nuendo is locked to timecode (when correct timecode
was detected and the sequencer is running), “Locked” is displayed.
• While shuttling, the Sync indicator displays “Shuttle”.
• When you are rewinding, the Sync indicator reads “REW”.
• During Fast Forward, “FF” is displayed.
• If a communication error occurred, the indicator reads “Timeout”.
• If the external device is not in Remote mode, the indicator
reads “Local”.
• If you are using an external tape machine and no tape has
been inserted, the Sync indicator reads “No Tape”.
• While positioning on the external machine, the Sync indicator
reads “Locate”.
• While using the Auto Edit function, “Auto Edit” is displayed.

A typical situation is when transferring material from a digital multi-track tape recorder to Nuendo (for editing) and
then back again. If you do not have sample-accurate synchronization set up, you cannot be sure that the material
will appear in its exact original position, when transferred
back to the tape recorder.
In order to take advantage of the ASIO Positioning Protocol, your audio hardware must be suitably equipped and
the functionality must be included in the ASIO driver for
the hardware.
An example of a system for doing sample-accurate transfers, would be transferring audio tracks from an Alesis
ADAT to Nuendo. Here the ADAT will be the sync master
(though it doesn’t necessarily have to be). It provides both
the digital audio (with an inherent word clock) and position
information (timecode) via its ADAT sync protocol. The
master clock is generated by the ADAT itself.
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Hardware and software requirements for APP

You can now set up the synchronization:

• Your computer audio hardware (in the example above, this
would be an ADAT card in your computer) must support all
the functionality required for the ASIO Positioning Protocol.
That is, it must be able to read the digital audio and the corresponding position information from the external device.
• There must be an ASIO 2.0 driver for the audio hardware.
• For resolving to external timecode, the audio hardware must
have an integrated timecode reader/generator.
• For information about which audio hardware models currently
support APP, see the Steinberg web site (www.steinberg.net).

1. Open the Project Synchronization Setup dialog and
set the Timecode Source to “ASIO Audio Device”.

!

The ASIO Audio Device is selected as Timecode Source

The ASIO Positioning Protocol exploits the specific
advantage of having an audio card that has an integrated timecode reader. With such a card and the
ASIO Positioning Protocol, you can achieve constant
sample-accurate synchronization between the audio
source and Nuendo.

Timecode Preferences

2. Make the desired settings in the dialog.
For information on the different sections, click the Help button in the dialog.

3. Close the Project Synchronization Setup dialog.

Setting up the audio card for external
synchronization

4. Open the Project Setup dialog from the Project menu
and use the Start value to set which frame on the external
device (e.g. a video tape) should correspond to the beginning of the project.

1. Open the Device Setup dialog from the Devices menu
and, on the VST Audio System page, select the name of
your audio interface.

Set this to the timecode position
where you want the
project to start.

2. Click the Control Panel button to open the card’s proprietary setup dialog.
If this card is accessed via a special ASIO driver (as opposed to MME or
Direct X), this dialog is provided by the card, not by Nuendo. Hence the
settings vary with the card brand and model.

• You can also set this with the function “Set Timecode at
Cursor” on the Project menu.

3. Adjust the settings as recommended by the card manufacturer, then close the dialog.

This is useful if you know that a certain position in your project coincides
with a certain timecode position in the external device. Move the project
cursor to the desired position, select “Set Timecode at Cursor” and
specify the corresponding timecode position in the dialog that appears –
the Start value is adjusted accordingly.

The dialog may also contain various diagnostic tools that allow you to
verify for example whether word clock is arriving correctly.

4. From the Clock Source pop-up, select the input to
which you routed the word clock signal.

5. A message appears, asking you whether you want to
keep the project content at its timecode positions. Select
“No”.

This pop-up may not be used if you selected an input in the Control
Panel dialog instead.

This will make all events and parts keep their positions relative to the
project start.

6. Close the Project Setup dialog.
7. On the Transport panel, activate the Sync button (or
select “Use External Sync” from the Transport menu).
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Inhibit Restart

8. Start the tape (or video, or other master device) that
contains the timecode. Nuendo starts playing when it receives timecode with a position “higher” than, or equal to,
the project Start frame.

Some synchronizers will still transmit MIDI Time Code for
a short period after an external tape machine has been
stopped. These extra frames of timecode can sometimes
cause Nuendo to restart suddenly. Inhibit Restart allows
you to control the amount of time in milliseconds that Nuendo will wait to restart (ignoring incoming MTC) once it
has stopped.

You can wind the device that sends the timecode to any
position and start from there.
!

When the master device with the timecode is
stopped, you can use the Nuendo transport controls
as you normally do, when it is not synchronized.

Machine Control

You should also take a look at the Timecode Preferences,
see “Timecode Preferences” on page 454.

Nuendo can control external tape transports and similar
devices via MIDI Machine Control or Sony 9-Pin. This allows you to operate an external tape transport from Nuendo’s Transport panel. That is, Nuendo can make the
tape recorder locate to a certain position, start, stop, rewind etc.

The Sync indicator
On the Transport panel you can check the status of incoming timecode by observing the sync indicator. It
switches between “Offline” (not waiting for sync), “Idle”
(ready for sync but no signal is coming in), and “Lock xx”
(where xx indicates the frame rate of the incoming signal).

About sync and machine control
Controlling tape transports is a two-way process:

Timecode Preferences

• Nuendo sends out machine control commands to the tape recorder, asking it to locate to a certain position and activate
playback etc.
• The tape recorder locates to the requested position, starts
and delivers timecode back to Nuendo, to which Nuendo is
synchronized.

The following timecode preferences are available in the
Project Synchronization Setup dialog:

Lock Frames
Using this field you can set how many frames of “correct”
timecode Nuendo should receive before attempting to
“lock” (synchronize) to incoming timecode. If you have an
external tape transport with a very short start-up time, you
could try lowering this number to make lock-up even faster
than it already is.

Even though it appears as if Nuendo is controlling the
tape recorder completely, it is important to remember that
in this setup, Nuendo is still being synchronized to the external tape transport, not vice versa.
Also note that the two processes of sync and machine
control are completely separated, in terms of protocols
used. You can for example synchronize to MTC while
sending out transport commands via MMC.

Drop Out Frames
On an analog tape with timecode, dropouts may occur. If
a drop-out is very long, Nuendo may (temporarily) stop. In
the Drop Out Frames field you can set how long a dropout (in frames) should be tolerated until Nuendo decides
that the tape isn’t good enough to synchronize to. If you
have a very stable timecode source, you may lower this
number to make Nuendo stop more swiftly after the tape
recorder has been stopped.

MIDI Machine Control (MMC)
This is a standard MIDI protocol for controlling tape transports. There are a number of tape recorders and hard disk
recording systems on the market that support this protocol. Nuendo allows you to control the transport of an external MMC device and arm tracks for recording.
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Sony 9-Pin

5. In the Master Machine Control section, select “MIDI
Machine Control”.

This is a standard protocol established by Sony, for controlling audio and video tape transports. It is implemented
via regular serial port communication (RS-422). The correct cabling varies between computer platforms and models. Please refer to “Connecting a Sony 9-pin compatible
device” on page 456 to find out more about the correct
setup for your computer.

6. In the Master Machine Control Settings section, select the correct MMC Inputs and Outputs from the respective pop-up menus.
MIDI Machine Control selected

• If your Sony 9-pin device supports RS-232, you need a “null
modem cable”.
• The Sony 9-pin device most likely needs to be switched from
local control to remote control in order to be controlled by Nuendo. If the device is not set to the correct mode, Nuendo will
inform you. Most video decks have a switch on the front panel
for this.
• Normally you should not lock Nuendo to timecode from the
Sony 9-Pin device. There is timecode information in the 9-pin
signal but it is primarily used for locating and shuttling. It is erratic and not stable enough to use as a timing or speed reference. Timecode should be read from either an LTC source or
VITC source on a video tape machine.
• Nuendo implements Start, Stop, Record, Fast-Forward, Rewind, Shuttle, Nudge and Locate commands for 9-Pin devices, along with some special features - see “Audio Layback
for 9-Pin Devices” on page 458.

MIDI ports selected for MMC

7. Make sure that the MMC Device ID corresponds to
the ID of the controlled device.
If more that one machine is connected or if you do not know the Device
ID, this can be set to “All”, the “Broadcast” device ID.

8. Set the “Number of Audio Tracks” setting to the number of tracks on the external tape recorder.
9. Open the Preferences dialog from the File menu (on
the Mac, this is located on the Nuendo menu), select the
MIDI Filter section and make sure Sysex is activated in the
Thru section.

Setting up Machine Control

This is necessary since MMC uses two-way communication (the tape recorder “replies” to the MMC messages it receives from Nuendo). By filtering out Sysex Thru, you ensure that these MMC System Exclusive
replies are not echoed back to the tape recorder.

Machine Control commands can be sent using one of two
different protocols: MIDI Machine Control (MMC) or Sony
9-Pin. The setup procedures are slightly different for the
two formats:

10. Close the Preferences dialog and open the Project
Setup dialog from the Project menu.
11. As when synchronizing without using transport control, use the Start value to specify which frame on the tape
should correspond to the beginning of the project.

MIDI Machine Control
1. Set up and test basic timecode synchronization, as described earlier in this chapter.

12. Close the Project Setup dialog.

2. Connect a MIDI Out on your MIDI interface to MIDI In
on the tape recorder (or similar device).

13. Pull down the Devices menu and select MMC Master.
The MIDI Machine Control master transport panel appears.

If you have not already done so (when setting up for MIDI Timecode),
also connect a MIDI cable from the MIDI Output on the tape recorder to
a MIDI In on the computer.

3. Make sure you have timecode recorded on the tape
recorder, and that it is set up to use MMC.
4. Open the Project Synchronization Setup dialog on the
Transport menu in Nuendo.
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Connecting a Sony 9-pin compatible device

It is now possible to control the external tape recorder independently or together with Nuendo:

On Windows computers

• If you activate the Online button on the MMC Master
panel you can use the transport buttons on the panel to
control the transport of the device.

• The “A1, A2, TC, VD” items refer to additional tracks
usually found on video tape recorders.

The serial port (9-pin D-SUB connector) of your computer
is used to establish communication with your Sony 9-pin
compatible device (VTR, DAT, Multitrack etc.). However,
PCs provide an RS-232 signal at the serial port, not the
RS-422 signal expected by Sony 9-pin devices. External
RS-232 to RS-422 converters are available from various
manufacturers at your local dealer or can be purchased
via the internet. If you are planning to cover distances exceeding a few meters please make sure that this adapter
also balances the signal.

Refer to the manual of your VTR device to see if these tracks are supported.

On Macintosh computers

• You can also use the buttons to the left on the MMC
Master panel to arm tape tracks for recording.
The number of record arm buttons depends on the “Number of Audio
Tracks” setting in the Master Machine Control Settings section of the
Project Synchronization Setup dialog.

• If you activate the Sync button on the Transport panel,
the MMC Master transport buttons (or the buttons on the
main Transport panel) will control the external tape recorder and Nuendo in sync.

The serial port of your computer is used to establish communication with your Sony 9-pin compatible device. As
newer Macintosh computers do not provide serial ports,
you have to install extra serial ports on these Macintosh
computers using one of the following methods.

14. On the Transport panel, activate the Sync button.

• Stealth Serial Port.
This is a very common device used to provide a serial port
on Macintosh computers lacking this kind of connectivity.
This card can be bought in Macintosh stores or via the internet. It is inserted in the modem slot inside your Macintosh and is recognized by the operating system as a serial
port. The signal present at the 9-pin D-SUB connector is
already RS-422 but you need to adapt between the 8-pin
Mini DIN connector of the Stealth Card and the 9-pin DSUB connector found on your Sony 9-pin device using an
appropriate cable.

15. Try to Stop, Fast Forward and Rewind from Nuendo
and activate Play from different positions in the project.
The tape transport should follow.

• To turn off the synchronization between the tape recorder and Nuendo, simply deactivate Sync on the Transport panel.
Nuendo as MMC slave
This is set up in the MIDI Machine Control Slave section.
Simply specify the MIDI ports and the MMC Device ID.
Some mixers support the MMC-Master protocol for controlling external devices, including Tascam DM-24, Yamaha
DM2000 and SSL. This means that Nuendo can be used
as a “recorder”, where track arming and transport commands can be sent from the master device. In addition,
some digital audio workstations (DAWs) can only operate
in MMC-Master mode.

• USB to serial adapter.
These USB devices are used to provide a serial port on
Macintosh computers lacking this kind of connectivity.
Such devices are available from various manufacturers at
your local dealer or can be purchased via the internet.
Make sure to install the driver of the device properly so the
operating system can register the device as a serial port.
The Keyspan USB to serial converter USA-19W has been
used in this capacity with much success.
Depending on the kind of product you are using, the electrical signal available at the 9-pin D-SUB connector of the
adapter can be either RS-422 or RS-232. Refer to the
technical specification of the adapter used to find out
more. If an RS-232 signal is used, you must convert this to
the RS-422 signal expected by your Sony 9-pin device.
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External RS-232 to RS-422 converters are available from
various manufacturers at your local dealer or can be purchased via the internet. If you are planning to cover distances exceeding a few meters please make sure that this
adapter also balances the signal.

6. Set the number of audio tracks available on the 9-pin
device by clicking on the arrows in the respective field or
by entering a number directly. There can be up to 48 audio tracks for each 9-pin device.
You will be able to remotely arm each audio track for recording from the 9pin control window. This is very handy when working in a large facility that
utilizes a common machine room where all the tape machines are located.

Setting up Sony 9-Pin
1. Set up and test basic timecode synchronization, as described earlier in this chapter.

In the 9-Pin Device Settings section (to the left of the
Timecode Source section), you will find two additional options for each 9-pin device:

2. Connect an unused serial port (COM port) on the
computer to the external tape transport.

• “Control Playback Speed”.

As mentioned earlier, you may need a RS-232 to RS-422 converter or
conversion cable.

This option instructs Nuendo to attempt to control the playback speed of
the 9-pin device in order to keep it in sync with Nuendo’s internal clock.
This should be a last resort option as it is very difficult to achieve acceptable results. Use this if there is no other way to lock to timecode coming
from the 9-pin device other than through the 9-pin connection.

• “Display Follows Locating Device”.
This is a very useful option for tape-based machines that take a certain
amount of time to locate to new positions. When this option is activated
and sync is enabled, the project cursor in Nuendo will reflect the position
of the 9-pin machine’s transport as it locates to different positions. For
instance, if you place the cursor several minutes ahead of the current
tape position, Nuendo can immediately locate there but the tape machine will take several seconds to arrive at the same position. During that
time, the cursor will move with the tape machine, giving the user visual
feedback as to its location. This is necessary in larger facilities that have
a central machine room where the tape machine is located. Since the
Nuendo system is in another room, the user will not know when the tape
machine has located to the correct position.

A typical Sony 9-Pin setup.

• Note that you can have two separate 9-Pin devices
connected to the computer when using Nuendo!
3. Make sure you have timecode recorded on the tape
recorder, and that it is set up to utilize Sony 9-Pin.
4. In the Project Synchronization Setup dialog, select either 9 Pin Control 1 or 2 in the Master Machine Control
Device section.

7. Click OK to apply your changes and close the Project
Synchronization Setup dialog.
8. Open the Project Setup dialog from the Project menu.
9. As when synchronizing without using transport control, use the Start value to specify which frame on the tape
should correspond to the beginning of the project.
10. Close the Project Setup dialog.

5. In the Master Machine Control settings section, use
the Serial Port pop-up menu to select the correct serial
(COM) port.
By selecting different ports for the two 9-Pin Devices, you can separate
two different external tape recorders, video systems, etc. The other options in this dialog are described on the following pages.
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11. Pull down the Devices menu and select “9-Pin Device
1” or “9-Pin Device 2”.

• “Send Shuttle instead of FF/Rewind”.
When the fast forward and rewind buttons are pressed on the Transport
panel, Nuendo can send either fast forward and rewind commands to the
9-pin device or send shuttle commands. Each 9-pin device will react differently to these commands so some experimentation will be necessary.
Tape machines will most likely respond best to fast forward and rewind
commands. This option is deactivated by default.

The corresponding 9-Pin Device control panel appears. This has a separate set of transport buttons, for controlling the transport in the 9-pin device. There’s also a separate Online button, above the transport controls.

• “Send Still instead of Stop”.
Many video tape machines will not display an image when in stop mode
as the tape is typically retracted from the playback heads in this mode.
Using a still or pause command instead will allow most video tape machines to display the current frame of video while paused. Many video
tape machines have internal settings that affect this as well, allowing images to be displayed in stop mode.

The 9-pin control panel. Most professional video tape machines have
four audio tracks and if they are digital, use a 48k sampling rate. Tracks
1 and 2 are record enabled.

It’s now possible to control the transport and track arming
of the 9-pin device independently or together with Nuendo:

• “Allow machine controlled cycle”.

• If you activate the Online button on the 9-Pin Device
control panel you can use the transport buttons on the
panel to control the transport in the device.

Nuendo can behave in two ways when in cycle mode and using machine
control. When this option is not activated, Nuendo will begin the cycle
normally from the left locator. But when it gets to the right locator, Nuendo will go back to the left locator to start the cycle again while the tape
machine (or other external transport) will continue on until stop is
pressed. When this option is activated, once Nuendo reaches the right
locator, playback will stop on both the machine and in Nuendo. Both will
locate back to the left locator and begin playback automatically. This will
continue until stop is pressed. Also, if there are pre and post roll values
activated in the Transport panel, Nuendo will include these in the cycle,
playing past the right locator by the post-roll amount and then locating to
a point before the left locator by the pre-roll amount and playing from
there. The tape machine will follow all of this in sync.

• If you activate the Sync button on Nuendo’s Transport
panel, the 9-Pin Device transport buttons (or the buttons
on the main Transport panel) will control the 9-pin device
and Nuendo in sync.
• When using Sony 9-Pin it is possible to advance the external transport frame by frame by using the Nudge Position buttons on the Transport panel. You can assign a
keyboard shortcut for this as well.
• Whenever you want to turn off the synchronization between the tape recorder and Nuendo, simply deactivate
Sync on the Transport panel.

Audio Layback for 9-Pin Devices
Nuendo has some special features for working with 9-Pin
devices (typically video decks). These allow you to transfer audio to the 9-Pin device by recording it from Nuendo,
manually or automatically. A typical application would be
audio layback – if you have edited audio for a video in Nuendo and want to transfer the audio back to the audio
track(s) in the video deck, at the correct positions.

Preferences
There are several Master Machine Control Preferences
available for 9-pin control in the Project Synchronization
Setup dialog. They are as follows:
• “Machine position follows mouse edits”.
When this option is activated and the transport in Nuendo is set to “Edit
Mode,” the 9-pin device will track the edits you make with the mouse in
the project window. Actions such as adjusting event boundaries, moving
fade handles and even selecting events will cause the 9-pin machine to
follow the mouse position as you make the edit. This emulates the response of a video file playing in Nuendo under Edit Mode.

!

• “Machine position follows jog”.
When this option is activated, Nuendo will send Locate commands to the
9-pin device when you use the jog wheel on the Transport panel, allowing you to see each frame of video as you scroll through the tape. When
it is deactivated, the positioning of the device takes place when the jog
wheel has been released.
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This assumes that Machine Control of the 9-Pin device has been set up, and that the proper audio connections have been made for recording audio from
Nuendo to the 9-Pin device.

1. Open the Project Synchronization Setup dialog and
select the 9-Pin device (1 or 2) in the Master Machine
Control Device section.

• If the Auto Edit function is not supported by the 9-Pin
device, you have to activate recording “manually”.
Use the 9-Pin device control panel transport (or the main Transport
panel) to rewind to a position before the left locator, activate automatic
punch-in and punch-out and start playback. If no Nuendo tracks are
record enabled, recording will only be performed by the 9-Pin device.

2. Make sure the “Number of Audio Tracks” value is correct.
This should be set to the number of audio tracks in the 9-Pin device. The
maximum number of audio tracks supported is 48.

!

Ö If you have activated “Try to Recognize Device” and
the 9-Pin Device model is known to Nuendo, the number
of audio tracks is automatically set to the correct value.

Please consult the documentation for the 9-Pin device for information about whether the Auto Edit
function is supported or not.

Setting Preroll and Postroll for Auto Edit

3. Close the Project Synchronization Setup dialog.

For the Auto Edit function provided on 9-Pin device panels you can set individual preroll and postroll values. This
is done in the Master Machine Control section Settings in
the Project Synchronization Setup dialog.

4. Select “9-Pin Device 1” (or 2, depending on your connections and setup) from the Devices menu.
The control panel for the 9-Pin Device appears.

1. Open the Project Synchronization Setup dialog and
select the 9-Pin Device in the Master Machine Control Device section.
2. In the Master Machine Control Settings section to the
right, click on the Edit PRE/POST up/down arrow buttons
to set a new value for the preroll and/or postroll for the
auto edit function.

The numbered buttons to the left correspond to the set number of audio
tracks.

5. Make sure the Online button is activated.

You can also click directly in the value field and enter the desired pre/
postroll value manually.

6. To record enable an audio track in the 9-Pin device
(which is connected to Nuendo via a suitable device),
click the corresponding numbered button in the panel.
The button lights up, indicating that the corresponding audio track is
record enabled.

7. Set the locators in Nuendo to encompass the audio
section you want to transfer.
8. Click the Auto Edit button in the 9-Pin device panel.
This is the button to the right of the transport controls.

• If the Auto Edit function is supported by the 9-Pin device, the device will automatically go to a position just before the left locator, start playback, activate recording at
the left locator and punch out at the right locator.
Assuming you have connected the proper outputs from Nuendo to the
correct inputs of the tape machine, the audio section will be played back
in Nuendo and recorded on the audio tracks of the 9-Pin device.
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Working with VST System Link

• The audio hardware must have digital inputs and outputs.
Of course, to be able to connect the computers, the digital connections
must be compatible (i.e. the same digital formats and connection types
must be available).

VST System Link is a network system for digital audio that
allows you to have several computers working together in
one large system. Unlike conventional networks it does
not require Ethernet cards, hubs, or CAT-5 cables; instead it uses the kind of digital audio hardware and cables
you probably already possess in your studio.

• At least one digital audio cable for each computer in the
network.
• A VST System Link host application installed on each
computer.

VST System Link has been designed to be simple to set
up and operate, yet give enormous flexibility and performance gains in use. It is capable of linking computers in a
“ring” network (the System Link signal is passed from one
machine to the next, and eventually returns to the first machine). VST System Link can send its networking signal
over any type of digital audio cable, including S/PDIF,
ADAT, TDIF, or AES, as long as each computer in the system is equipped with a suitable ASIO compatible audio interface.

Any VST System Link applications can connect to each other.

Additionally, we recommend that you use a KVM switchbox:
Using a KVM switchbox
If you want to set up a multi-computer network, or even a
small network in a limited space, it's a good idea to invest
in a KVM (Keyboard, Video, Mouse) switchbox. With one
of these you can use the same keyboard, monitor, and
mouse to control each computer in the system, and switch
between computers very rapidly. KVM switchboxes are
not too expensive, and very easy to set up and operate. If
you decide not to go this route, the network will function
just the same, but you may end up doing a lot of jumping
from one machine to the other while setting up!

Linking up two or more computers gives you vast possibilities:
• Dedicate one computer to running VST instruments while recording audio tracks on another.
• If you need lots of audio tracks, you may simply add tracks on
another computer.
• You could have one computer serve as a “virtual effect rack”,
running CPU-intensive send effect plug-ins only.
• Since you can use VST System Link to connect different VST
System Link applications on different platforms, you can take
advantage of effect plug-ins and VST instruments that are
specific to certain programs or platforms.

Making connections
Below, we assume that you are connecting two computers. Should you have more than two computers, it’s still
best to start with two and add the others one by one once
the system is working – this makes troubleshooting easier
if you run into problems. For two computers, you will need
two digital audio cables, one in each direction:

Preparations

1. Connect a digital audio cable from the digital output of
computer 1 to the digital input of computer 2.

Requirements

2. Connect the other cable from the digital output of
computer 2 into the digital input of computer 1.

The following equipment is required for VST System Link
operation:

• If a card has more than one set of inputs and outputs,
choose whichever one that suits you – for simplicity usually the first set is best.

• Two or more computers.
These can be of the same type or use different operating systems – it
doesn’t matter. For example, you can link an Intel-based PC to an Apple
Macintosh without problems.

• Each computer must have audio hardware with specific
ASIO drivers, installed and working.
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Synchronization

• Typically, the ASIO control panel for an audio card contains some indication of whether the card receives a proper
sync signal or not, and the sample rate of that signal.

Before you proceed, you need to make sure that the clock
signals on your ASIO cards are synchronized correctly.
This is essential when cabling any kind of digital audio
system, not just VST System Link.
!

This is a good indication that you have connected the cards and set up
clock sync properly. Check your audio hardware’s documentation for details.

All digital audio cables by definition always carry a
clock signal as well as audio signals, so you don't
have to use a special Word Clock input and output
for this (although you may find that you get a slightly
more stable audio system if you do, especially when
using multiple computers).

!

It’s very important that one and only one card is the
clock master, otherwise the network cannot function
correctly. Once you have set this up, all the other
cards in the network will take their clock signal from
this card automatically.

The only exception to this procedure is if you are using an
external clock – which could be from a digital mixing desk
or special Word Clock synchronizer for example. If so, you
must leave all your ASIO cards in Clock Slave or AutoSync mode, and make sure that each of them is listening
for the signal coming from the synchronizer, usually
passed through your ADAT cables or Word Clock connectors in a daisy chain fashion.

The Clock Mode or Sync Mode is set up in the ASIO control panel of the audio hardware. Proceed as follows:
1. Pull down the Devices menu and open the Device Setup dialog.
2. On the VST Audio System page, select your audio interface from the “ASIO Driver” pop-up menu.
In the Devices List, the name of the audio interface is displayed below
the VST Audio System entry.

VST System Link and latency

3. Select your audio interface in the Devices list to the
left.

The general definition of latency is the amount of time it
takes any system to respond to whatever messages are
sent to it. For example, if your system’s latency is high and
you play VST instruments in real time, you will get a noticeable delay between when you press a key and when
you hear the sound of the VST instrument. Nowadays,
most ASIO-compatible audio cards are capable of operating with very low latencies. Also, all VST applications are
designed to compensate for latency during playback,
making the playback timing tight.

4. Click the Control Panel button.
The ASIO control panel appears.

5. Open the ASIO control panel on the other computer
as well.
If you are using another VST System Link host application on that computer, check its documentation for details on how to open the ASIO control panel.

6. Now, you need to make sure that one audio card (and
only one!) is set to be the Clock Master, and all the other
cards are set to listen for the clock signal coming from the
Clock Master i.e. they must be Clock Slaves.

However, the latency time of a VST System Link network
is the total latency of all the ASIO cards in the system
added together. Therefore it’s extra important to minimize
the latency times for each computer in the network.

The naming and procedure for this differs depending on the audio hardware – consult its documentation if required. If you are using Steinberg
Nuendo ASIO hardware, all cards default to the “AutoSync” setting – in
this case you must set one of the cards (and only one) to “Master” in the
Clock Mode section of the control panel.

Ö The latency does not affect the synchronization – it's
always perfectly in time. But it can affect the time it takes
to send and receive MIDI and audio signals, or make the
system seem sluggish.
To adjust the latency of a system, you adjust the size of the
buffers in the ASIO control panel – the lower the buffer
size, the lower the latency. It’s best to keep to fairly low latencies (buffer sizes) if your system can handle it – about
12 ms or less is usually a good idea.
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Setting up your software

Settings for the audio hardware

Now it’s time to set up your programs. The procedures
below describe how to set things up in Nuendo; if you are
using another program on the other computer, please refer to its documentation.

When you send VST System Link data between computers, it is important that the digital information isn’t changed
in any way between the programs. Therefore, you should
open the control panel (or additional application) for your
audio hardware and make sure that the following conditions are met:

Setting the sample rate
The projects in both programs must be set to use the
same sample rate. Select “Project Setup…” from the
Project menu and make sure the sample rate is the same
in both systems.

• If there are additional “format settings” for the digital
ports that you use for VST System Link data, make sure
these are turned off.
For example, if you are using an S/PDIF connection for VST System Link,
make sure that “Professional format”, Emphasis and Dithering are turned
off.

Streaming digital audio between applications
1. Create input and output busses in both applications
and route these to the digital inputs and outputs.

• If your audio hardware has a mixer application allowing
you to adjust the levels of digital inputs and outputs, make
sure that this mixer is disabled or that the levels for the
VST System Link channels are set to (± 0dB).

The number and configuration of the busses depends on your audio hardware and on your needs. If you have a system with eight digital i/o channels
(such as an ADAT connection), you could create several stereo or mono
busses or a surround bus together with a stereo bus, or any combination
you need. The important thing is that you should have the same configuration in both applications – if you have four stereo output busses on computer 1, you want four stereo input busses on computer 2, etc.

• Similarly, make sure no other forms of DSP (pan, effects, etc.) are applied to the VST System Link signal.
Notes for Hammerfall DSP users

2. Set things up so that computer 1 plays back some audio.

If you are using RME Audio Hammerfall DSP audio hardware, the Totalmix function allows for extremely complex
signal routing and mixing in the audio hardware. This can
in some situations lead to “signal loops” in which case the
VST System Link won’t work. If you want to make absolutely sure this won’t cause any problems, select the default or “plain” preset for the Totalmix function.

You could for example import an audio file and play this back in Cycle
mode.

3. In the Inspector or mixer, make sure the playing audio
channel is routed to one of the digital output busses you
set up.
4. In computer 2, open the mixer and locate the corresponding digital input bus.
The audio being played back should now “appear” in the program running on computer 2. You should see the input bus level meters moving.

5. Reverse this procedure so that computer 2 plays back
and computer 1 “listens”.
Now you have verified that the digital connection works as
it should.
Ö From this point on in this chapter, we refer to the busses connected to the digital inputs and outputs as “VST
System Link busses”.
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Activating VST System Link

As the computers are made active, you should see the
small Transmitting and Receiving indicators flashing on
each active computer, and the name of each computer
should appear in the list at the bottom of the pane. Each
computer is assigned a random number – don't worry
about this, it's just so the network knows internally which
one is which.

Before you proceed you need to make sure that VST System Link is set as Timecode Source in the Synchronization
dialog and that the desired Sync options are activated,
see “Timecode Preferences” on page 454.
After setting up the inputs and outputs, you now need to
define which input/output should carry the actual VST
System Link information.

• You can double-click on the name in bold (which is the
name of the computer you’re currently working on) and set
it to whatever other name you wish.

The System Link networking signal is carried on only one
bit of one channel. This means that if you have an ADAT
based system which normally carries eight channels of
24-bit audio, once you activate VST System Link you will
have seven channels of 24-bit audio and one channel of
23-bit audio (the least significant bit of this last channel
will be used for networking). In practice this makes no discernible difference to the audio quality, since you will still
have around 138dB headroom on this channel.

This name will appear in the System Link window of every computer on
the network.

Ö If you don't see the name of each computer appearing
once you have made it active, you may have to check your
settings.
Go through the procedure above again and make sure that all ASIO
cards are listening to the digital clock signals correctly, and that each
computer has the correct inputs and outputs assigned to the System
Link network.

To set things up, open the VST System Link panel:
1. Open the Device Setup dialog on the Devices menu.

Putting the network online

2. Select VST System Link in the Devices list to the left.

After each computer's name you will see whether it is online or not. When a computer is online, it will receive transport and timecode signals, and its sequencer application
can be started and stopped by remote control. If it is offline, it can only be started from its own keyboard – it is effectively an independent machine, although it is still on the
network.
Ö Note that any computer can control any and all of the
others – VST System Link is a peer-to-peer network and
there is no absolute “master” computer.
However, most users do like to think of one machine as the master (in a
one person/two computer network, this would be the machine you actually sit behind most of the time).

The Receiving and
Sending indicators

For now, let's put all computers online:
1. Activate the Online checkbox in the VST System Link
panel for all computers.
3. Use the ASIO Input and ASIO Output pop-up menus
to define which channel should be the networking channel
(and thus become a 23-bit audio channel, in our example).

2. Check that the system is working by pressing Play on
one computer – all computers should start almost instantly
and play perfectly in time, with sample-accurate precision.

Quite often you will be able to leave these pop-ups the way they are.

4. Click the Active checkbox at the top of the panel.
5. Repeat the steps above for every computer on the network.
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• The Offset Samples setting allows you to adjust whether
one machine will play back slightly ahead or behind the rest.

3. If you now pull down the Input or Output Routing popup menus, you will find the specified System Link ports
added to the list of MIDI Inputs and Outputs.

This is normally not needed, but occasionally with some hardware you
may find that the lock is a few samples out. In that case you can adjust
the lock with the Offset value. For now, leave it set to 0 – it will most likely
be what you want.

• The Transfer Bits setting allows you to specify whether
you want to transfer 24 or 16 bits. This allows you to use
older audio cards which do not support transfer of 24 bits.
VST System Link sends and understands all transport
commands, so you can play, stop, fast forward, rewind
etc. the entire network from one computer without a problem – try it! If you jump to a locator point on one machine,
all other machines will also instantly jump to that locator
point. You can even scrub on one computer and have the
video and audio on another computer actually scrub right
along with you.
!

Make sure that all computers have their tempos set
to the same value, otherwise your synchronization
will be seriously skewed.

Using MIDI
As well as supplying transport and sync control, VST System Link also supplies up to 16 MIDI ports, each with 16
channels. You set this up as follows:

This allows you to route MIDI tracks to VST instruments
running on another computer, as described in the application examples (see “Using one computer for VST instruments” on page 466).

1. Use the MIDI Inputs and Outputs value boxes to specify the number of MIDI ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

The “Active ASIO Ports for Data only” setting

2. Create a MIDI track in the Project window and open
the Inspector (top section).

If you are sending huge amounts of MIDI data at once,
there is a small possibility that you might run out of bandwidth on your VST System Link network. This will manifest
itself by notes “choking” or timing becoming erratic.
If this happens, you can devote more bandwidth to MIDI
by activating “Active ASIO Ports for Data only” in the VST
System Link Setup panel. When this is activated, the VST
System Link information will be sent on the entire channel
instead of just one bit, more than enough for all the MIDI
you could ever hope to use. The downside is that you can
no longer use this ASIO channel for audio transfer (do not
connect it to a speaker!), thus leaving you only 7 channels
of audio in our ADAT cable example. Depending on how
you work this might be a reasonable compromise.
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Hearing the network audio

If you now start playback, the audio from computer 2 will
be sent “live” to the new tracks on computer 1, allowing
you to hear them together with any tracks you play back
on computer 1.

If you are using an external mixing desk, hearing your audio
really isn't an issue – just plug the outputs of each computer
into the desired channels on the external mixing desk, press
Play on one of the computers, and you're good to go.

For more information about Monitoring, see “About monitoring” on page 17.

However, many people prefer to mix internally inside the
computer and just use a desk for monitoring (or maybe not
use any external mixer at all). In this case you'll need to select one computer to be your “main mix computer” and
send the audio from your other computers into this.

Adding more tracks
OK, but if you have more audio tracks than you have VST
System Link busses (physical outputs)? Then you just use
the computer 2 mixer as a submixer: Route several audio
channels to the same output bus and adjust the output
bus level if needed.

In the following example, we assume you are using two
computers, with computer 1 as your main mix computer
and computer 2 running two additional stereo audio
tracks, an FX channel track with a reverb plug-in and a
VST instrument plug-in with stereo outputs.

Note also that if your audio cards have multiple sets of input and output connections you can link up e.g. multiple
ADAT cables and send audio via any of the busses on any
of the cables.

1. First you want to set things up so that you can listen to
the audio playback from computer 1.

Internal mixing and latency

In other words, you need an unused set of outputs, e.g. an analog stereo
output, connected to your monitoring equipment.

One problem with mixing inside the computer is the latency issue we mentioned earlier. The VST engine always
compensates for record latencies, but if you are monitoring through computer 1 you will hear a processing delay
while you listen to signals coming from your other computers (not on your recording!). If your audio card in computer
1 supports ASIO Direct Monitoring you should definitely
turn this on – you'll find the setting in the VST Audio System Device Setup panel (see “ASIO Direct Monitoring” on
page 72). Most modern ASIO cards support this function.
If yours doesn't you may want to change the Offset value
in the VST System Link Setup panel to compensate for
any latency issues.

2. Go to computer 2 and route each of the two audio
tracks to a separate output bus.
These should be busses connected to the digital outputs – let’s call
them Bus 1 and 2.

3. Route the FX channel track to another VST System
Link bus (Bus 3).
4. Route the VST instrument channel to yet another bus
(Bus 4).
5. Go back to computer 1 and check the corresponding
four VST System Link input busses.
If you start playback on computer 2, the audio should “appear” on the input busses on computer 1. However, to mix these audio sources you
need actual mixer channels:

6. Add four new stereo audio tracks on computer 1 and
route these to the output bus you use for listening, e.g. to
the analog stereo outputs.
7. For each of the audio tracks, select one of the four input busses.
Now, each computer 2 bus is routed to a separate audio channel on
computer 1.

8. Activate monitoring for the four tracks.
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Application examples

Setting up a larger network
This is not much more difficult than a two computer network. The main thing to remember is that VST System Link
is a daisy chain system. In other words, the output of computer 1 goes to the input of computer 2, the output of
computer 2 goes to the input of computer 3, and so on
around the chain. The output of the last computer in the
chain must always go back into the input of computer 1, to
complete the ring.

Using one computer for VST instruments
In this example, one computer will be used as main record
and playback machine, and another computer as a virtual
synth rack.
1. Record a MIDI track into computer 1.
2. Once you have finished recording, route the MIDI output of that track to System Link MIDI port 1.

Once you've done this, the transmission of all the transport, sync, and MIDI information to the whole network is
handled pretty much automatically. However, where you
may run into confusion in a large network is in the transmission of audio signals back to a central mix computer.

3. Now go to computer 2, open up the VST Instrument
rack and assign an instrument to the first slot in the rack.
4. Route the VST Instrument channel to the desired output bus.

If you have lots of hardware inputs and outputs on your
ASIO cards you don't need to send audio via the chain at
all, but can transmit it directly to the master mix computer
via one or more of its other hardware Inputs. For example, if
you have a Nuendo Digiset interface or 9652 card on computer 1 you could use ADAT cable 1 for networking, ADAT
cable 2 as a direct audio input from computer 2, and ADAT
cable 3 as a direct audio input from computer 3.

If you are using computer 1 as your main mixing computer, this would be
one of the VST System Link output busses, connected to computer 1.

5. Create a new MIDI track in the Project window of
computer 2, and assign the MIDI output of the track to the
VST Instrument you created.
6. Assign the MIDI input of the track to be VST System
Link port 1.
Now, the MIDI track on computer 1 is routed to the MIDI track on computer 2, which in turn is routed to the VST Instrument.

You can also transmit audio via the ring system if you don't
have enough hardware I/Os for direct audio transmission.
For example, in a four computer scenario you could send
audio from computer 2 into a channel in the mixer in computer 3, and from there to a channel in the mixer in computer 4, and from there back to the master mixer in
computer 1. This can certainly be tricky to set up, so generally it is recommended that if you want to set up a complex network, you should make sure to use ASIO cards
with at least three separate digital I/Os.

7. Now activate monitoring for the MIDI track on computer 2, so that it will listen and respond to any MIDI commands coming in.
In Nuendo, you would click the monitor button in the Track list or Inspector.

8. Press play on computer 1.
It will now send the MIDI information on the track to the VST Instrument
loaded on computer 2.

Even with a slow computer you should be able to stack a
whole bunch of extra VST Instruments this way, expanding
your sound palette considerably. Don't forget that VST
System Link MIDI is also sample-accurate, and thus has
much tighter timing than any hardware MIDI interface ever
invented!
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Creating a virtual effect rack

Getting extra audio tracks

The effect sends for an audio channel in Nuendo can either be routed to an FX channel track or to any activated
Group or output bus. This allows you to use a separate
computer as a “virtual effect rack”, by setting things up in
the following way:

All computers on a VST System Link network are locked
with sample-accuracy. Therefore, if you find that the hard
drive on one computer isn’t fast enough to run as many
audio tracks as you need, you can record new tracks on
one of the other computers instead. This would create a
“virtual RAID system”, with several disks all operating together. All tracks will remain locked together just as tightly
as if they were all running on the same machine. This
means that you effectively have an unlimited track count!
Need another 100 tracks? Just add another computer.

1. Go to computer 2 (the machine you will use as effect
rack) and add a new stereo audio track.
You cannot use an FX channel track in this case, since the track must
have an audio input.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

Dedicated Video Playback

3. In the Inspector, select one of the VST System Link
busses as input for the audio track.

Playback of high-resolution video can be taxing on a system’s CPU. By dedicating one computer for video playback via System Link, you can free up resources on your
main CPU for audio and MIDI processing. Since all transport commands will respond on the System Link computers, scrubbing video is possible even when it is coming
from another computer. Spotting sound effects to picture
in Edit Mode will work the same way as it does on one
computer. This is a viable and economic alternative to
dedicated hard disk video systems like the Doremi V1.

You want to use a separate System Link bus, which will only be used for
this purpose.

4. Route the channel to the desired output bus.
If you are using computer 1 as your main mixing computer, this would be
one of the VST System Link output busses, connected to computer 1.

5. Activate monitoring for the track.
6. Now, go back to computer 1 and select a track to
which you want to add some reverb.
7. Bring up the effect sends for the track, in the Inspector
or the mixer.
8. Pull down the send routing pop-up menu for one of
the sends, and select the VST System Link bus assigned
to the reverb in step 3.
9. Use the send slider to adjust the amount of effect as
usual.
The signal will be sent to the track on computer 2 and processed through its insert effect, without using any processor power on computer 1.
You can repeat the steps above to add more effects to the
“virtual effect rack”. The number of effects available this
way is only limited by the number of ports used in the VST
System Link connection (and of course by the performance of computer 2, but given that it won’t have to handle any recording or playback, you should be able to use
quite a lot of effects).
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36
Video

Background

When this information reads “0x0 pixel”, “0.000 s” and “0
Frames”, the video file is either corrupt, or the format is not
supported by the codecs available to the selected video
playback engine. You will either have to change the video
playback engine, or install the required codec.

Nuendo plays back video films in a number of formats.
Under Windows, video playback can be done using the
playback engines DirectShow, DirectX Video or QuickTime.
Under Mac OS X, QuickTime is always used as playback
engine.

!

There are several ways to play back video:
• Without any special hardware.
While this will be fine in many situations it does put a limit on the size of
the internal video window as well as the quality of the image.

Trying to import or play back a file not supported by
the selected video player will lead to unpredictable
results – if no information on the number of frames,
the length and the pixel resolution is available (e.g. in
the Import Video dialog), you cannot import/play this
file properly with this particular video player.

Ö As a general rule, Nuendo should be able to use a certain video file, if the native video player on your system
(Windows Media Player on the PC or QuickTime Player
on the Mac) can play this file.

• Using FireWire (Mac OS X only).
Using a FireWire port, you can play back video on an external monitor using a DV-to-analog converter or a DV camera.
This is valid for DV video and QuickTime is used for playback. This can
reduce the CPU load since the external device is decoding the DV video
stream.

Ö You can expect most Windows hardware to work with
DirectShow and DirectX Video.
On a Windows system, the DirectShow and DirectX Video players are
provided by the operating system, you don’t have to install any additional
software. Make sure you are using the latest version of DirectX software
available from the Microsoft web site.

• Using Graphics cards (Windows only).
Multi-head graphics cards which support overlay functionality can be
used to display the video picture on an external monitor. As of this writing, the following manufacturers have working solutions available: nVIDIA
and Matrox.

Ö For the QuickTime playback method to be available,
you must have QuickTime 7.1 installed on your computer.

• Using Video cards.
Video cards can also be used to display the video on an external monitor.
Please note that this utilizes some of the CPU to process the video data.
As of this writing, e.g. the “Decklink” card (Blackmagic) can be used.

If you don’t have QuickTime, or if a version lower than 7.1 is installed,
QuickTime playback will not be available in Nuendo. There is a freeware
version (a QuickTime installer is included on the Nuendo DVD if required,
or you can download it from www.quicktime.com) and a “pro” version,
which offers additional video cutting options. The player engine is the
same in both versions, so for mere playback in Nuendo there is no need
to purchase the “pro” version.

Before you start
When working on a project involving a video file, there are
several points to bear in mind:

!

The playback engine is used not only for playback of the
video file, but also to provide file information in Nuendo. To
make sure that you have chosen the right player for a particular type of video file, check the file information displayed in Nuendo (e.g. in the Import Video dialog or the
Pool) prior to trying to import or playing back the file.
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Under Mac OS X, there is only one standard player
option. The QuickTime playback engine is always
used, supporting the formats AVI, MPEG, QuickTime
and DV. If your system has a FireWire port, there is
also a FireWire option – see “Playing back a video
file via FireWire (Mac OS X only)” on page 473.

Selecting the video playback engine
(Windows only)

Operations

When using Nuendo on a Windows system, you can select the playback engine in the Device Setup dialog (Video
Player page).

Importing a video file
Video files are imported in the same manner as audio files.
• By using the File menu (Import Video File).

Which playback engine to select depends largely on
which type of video system you are using, as well as on
the file format and codec of the video files you want to
work with.

• By using drag and drop from the Windows Explorer, the
Mac OS Finder, the Pool or the Media Bay.
• By importing to the Pool first and then dragging to the
Project window (see the chapter “The Pool” on page 296
for details).

• When you have changed the video playback engine,
make sure to remove any previously imported video file
from the Pool, and re-import it.

Note:
• To be able to play back the video, you must add a video track
(by using the Add Track submenu on the Project menu or Quick
menu). You can only have one video track in each project.
• You can have multiple video files on the track but all files must
be of the same size and compression format.
• You may trim video files in the project window as needed, adjusting the event boundaries as you would for an audio event.
• The Import dialog has an option for extracting the audio from a
video file (see “Extracting audio from a video file” on page 472)
and for generating a thumbnail cache file for the video file, see
below.

A note on editing
Nuendo allows you to cut, copy, paste and trim video
events, i.e. your video track may contain more than one
video event. Make sure that these video files are of the
same file format and resolution in order for them to play
properly.
Ö Windows only: When using the DirectShow video
playback engine, you may find that only the first event on
the video track is played back correctly. In such a case
make sure that the video track contains no more than one
video event. When you need to edit your video files (i.e.
cut, copy, paste or trim video events), it is therefore recommended to use the DirectX Video player.

Video import preferences
In the Preferences dialog (Editing–Video page), there are
two options that affect the import of video files:

Ö Windows only: If you find that you are unable to edit a
video file copied from a CD, this might be due to the fact
that files copied from CD are write-protected by default.
Right-click the file, and deactivate the “Read-Only” option
in the File Properties dialog.

• Extract Audio on Import Video File
When this is activated, the audio will automatically be extracted and imported into the project when you import a video file. This way, the audio
will also be included when you insert a video e.g. by using drag and drop.
When you import video files by using the File menu, you can activate this
option separately for each imported video file on the Import dialog.

When you have a video file in a format not supported by
Nuendo, use an external application to convert it to a format that Nuendo can import.

• Generate Thumbnail Cache on Import Video File
When this is activated, a thumbnail cache file will be created automatically when you import a video file. This is handy, as a cache file will also
be created when you import a video file using drag and drop. When you
import video files by using the File menu, you can activate this option
separately for each imported video file on the Import dialog, see below.
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About Thumbnail Cache files

A window will be displayed, showing you the progress
and the estimated time for the process.

Ö To display video thumbnails in the Project window, the
option “Show Video Thumbnails” has to be activated in
the Preferences dialog (Event Display–Video page).
When working with video in Nuendo, video files are displayed as events/clips on the video track with thumbnails
representing the frames in the film. These are calculated in
real time, i.e. they have to be redrawn during scrolling or
moving. As this consumes quite a lot of processor power,
reaction sometimes may be sluggish. To remedy this, you
can generate a thumbnail cache file.

The thumbnail cache file is created.

After the cache file is created, the window will be closed
and the video clip is inserted as usual. When you now
start video playback and perform processor consuming
operations, the thumbnail file is used to display the video
frames in the Project window. When enough processor
power is available, the “real” calculated thumbnail frames
are displayed again.

The cache file is used in situations where the processor
load is very high and the correct redrawing or real-time
calculation might use system resources necessary for editing or processing. When the cache file is used and you
zoom in on the thumbnails, you will see that they are in a
lower resolution, i.e. the pictures are not as clean as when
they are calculated. When the processes that rely heavily
on the computer CPU are finished, the frames will be automatically recalculated, i.e. the program automatically
switches between real-time calculation of the pictures and
using the cache file.

Ö To automatically create thumbnail cache files for all imported video files, activate “Generate Thumbnail Cache
on Import Video File” in the Preferences dialog (Editing–
Video page).
Generating thumbnail cache files from within the Pool

The generated thumbnail cache file will be stored in the
same folder as the video file and will get the name of the
file with the suffix “.videocache”.

When you have video files without thumbnail cache files
(e.g. if you did not create a thumbnail cache file during import or if you are working with an older project), you always have the possibility to generate the thumbnail cache
file at a later stage. This is done from within the Pool.

Generating thumbnail cache files during video import
Thumbnail cache files can be created when a video file is
imported into the project.

Proceed as follows:

Proceed as follows:

1. Open the Pool window and locate the video file you
want to create a thumbnail cache file for.

1. On the File menu, open the Import submenu and select
“Import Video File…”.

2. Right-click on the file to open the context menu and
select “Generate Thumbnail Cache”, or select “Generate
Thumbnail Cache” from the Media menu.

A file dialog is opened.

2. Locate and select the desired video file, activate
“Generate Thumbnail Cache” in the lower part of the dialog and klick “Open”.

Just as when creating the file during import, the status window opens
(see above).

The Generate Thumbnail Cache option in the Import Video dialog.
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There are three ways to extract audio from a video file:

After the file is created, the window will be closed and the
thumbnail cache file is used when necessary, i.e. under
high load.
!

• By activating “Extract audio” in the Import Video dialog.
This will add the audio to the currently active audio track. The new audio
event will start at the same time as the video event, so that they are in
sync with each other.

Please note that the cache file will not be automatically updated if a video file is edited. Whenever you
change a video file (e.g. in a video editing application), you need to create a new thumbnail cache file
manually, as described above. (To refresh the “real”
thumbnails of an edited video file, resize the video
track so that they are calculated again.)

• By using “Import Audio from Video File” from the File
menu.
This is just as above, but no video clip is created, only an audio event
(starting at the project cursor position on the selected track).

• By activating “Extract Audio on Import Video File” in the
Preferences dialog (Editing–Video page).

Adopting the Video Frame rate

This will automatically extract the corresponding audio from a video file
during import. This is also true if you import files using drag and drop.

When using video files within Nuendo, it is important to set
the project’s frame rate to that of the imported video. This
ensures that the time displayed in the SMPTE readout of
Nuendo corresponds to the actual frames in the video.

• By using Extract Audio from Video File on the Media
menu.
This creates an audio clip in the Pool, but doesn’t add any events to the
Project window.

1. Pull down the Project menu and select “Project Setup…” (or press [Shift]+S) to open the Project Setup dialog.

!

2. If a video file has been placed on a video track in the
Project window, a button now appears in the frame rate
section of the Project Setup dialog called “Get From
Video.” This will automatically detect the frame rate of the
video file and apply that setting to the project.
!

These functions are not available for mpeg video files.

Playing back a video file
Video files are displayed as events/clips on the video
track, with thumbnails representing the frames in the film –
if “Show Video Thumbnails” is activated in the Preferences dialog (Event Display–Video page).

The frame rate setting will change to that of the video
file and the project start time will be altered to reflect
the change in frame rate if needed. For example,
when switching the project frame rate from 30fps to
29.97fps, the start time will be changed so that all
the events currently in the project will remain at the
same positions in relation to realtime. If you want the
project start time to remain the same, you must manually change it back after clicking the “Get From
Video” button.

A video event on a video track.

In the Track list and Inspector, you will find the following
options:

Extracting audio from a video file
If a video file contains audio, it can be extracted. Regardless of the audio format in the actual file, the imported audio file will always be in the format (Sample Rate and
Record Format) that is specified for the Project in the
Project Setup dialog.

Button

Description

Lock

When this is activated, the video event will be locked, see
“Locking events” on page 50.

Show Frame
Numbers

When this is activated, each thumbnail is shown with the
corresponding video frame number.

Snap
Thumbnails

When this is activated, the individual thumbnail images
will be positioned exactly at their respective start time position. Also, no more than one thumbnail per frame will be
shown, even if you zoom in a lot.

Mute Video

When this is activated, video playback will be stopped,
but playback of any other events in the project will continue (to decrease the processor load). You may have to
use the Track Controls Settings dialog to make this button visible in the Track list.
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To view the video on the computer screen (as opposed to
on an external monitor, see below), proceed as follows:

• For DirectX and QuickTime, right-click in the Video window to open the context menu and select “Full Screen
Mode”. Right-click again or press [Esc] on your computer
keyboard to exit full screen mode.

• Under Mac OS, first make sure that “Onscreen Window”
is selected in the Video Output section in the Device Setup
dialog (Video Player page).

Disabling Video Playback

• Pull down the Devices menu and select Video (or use a
key command – by default [F8]).

In the Track list and Inspector of a video track, there is a
Mute button. (Note that this can be hidden for the Track
list, see “Customizing track controls” on page 507.) When
you mute a video track, the video will not play and the
CPU resources it used will be freed up for other purposes.
When performing complex editing tasks that do not require watching the video, temporarily muting the video
track can help speed up performance of Nuendo by reducing the strain on the CPU.

A video window appears. In Stop mode, this displays the video frame at
the project cursor position.

Playback of the video is performed together with all other
audio and MIDI material, using the Transport panel.
Video quality in QuickTime
• When you are using QuickTime as video playback engine, you can activate high quality mode, by selecting
“High Quality” on the Video window context menu, or by
activating “Use high-quality video settings when available”
in the Device Setup dialog–Video Player page (in the
Video Properties section for QuickTime).

Playing back a video file via FireWire (Mac OS X only)
For Apple computers equipped with a FireWire port, you
can easily use this to connect to external video hardware,
as OS X has built-in video support for the most common
formats (NTSC/PAL/DVCPRO). FireWire is capable of
high data-transfer speed and is the most common standard for communicating with video-related peripheral
equipment.

If the QuickTime video was recorded with the corresponding quality settings, this will make the video display sharper and smoother.
Note that this will also lead to increased processor load.

Setting the Window size

• To play back a video file via hardware connected to the
FireWire port, select “FireWire” on the Outputs pop-up
menu of the Device Setup dialog (Video Player page).

If you are playing back video in a window on your computer screen, you may want to adjust the size.
• For the QuickTime and DirectX player, you can drag the
borders, just like resizing other windows.

When FireWire is selected as output, a number of format options appear
on the Format pop-up, allowing you to select between various video formats and resolutions.

You can also right-click in the video window to open the context menu
and select one of the Size options.

• Adjust the Frame Offset value to compensate for DV
processing delays in the external device.

• For the DirectShow video player (Windows), open the
Device Setup dialog from the Devices menu, click Video
Player in the Devices list and use the buttons in the Video
Properties section to select a size.

Due to delays while processing DV video through the FireWire port, the
video image will be behind or later than the corresponding audio in Nuendo. By using the Frame Offset parameter, you can compensate for this
effect. Each hardware setup could have different processing delays so
you must experiment to determine what value is appropriate. Usually, 7
frames is a good starting point. All values for the frame offset are positive
and indicate how many frames the video will be delivered earlier in order
to compensate for the processing time.

Playing back video in full screen mode
When viewing video on the computer screen, you can
choose to let the video occupy the whole screen during
playback or in Stop mode:

Ö Note that there is a difference in the frame offset in
stop versus playback. The frame offset is defeated in stop
and scrub modes so that you can see the correct frame of
video since the processing delays are not an issue in
these modes. It is only used during playback when processing delays are noticeable.

• For DirectShow video, right-click in the video window to
switch to full screen. Right-click again to exit full screen.
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Playing back a video file using graphics cards (Windows
only)

Project window and Browser editing
operations

Multi-head graphics cards which support overlay functionality can be used to display the video picture on an external TV or computer monitor in full screen mode. As of this
writing, the manufacturers nVIDIA and Matrox have working solutions available. Check the card’s documentation
for information on how it handles video output and how to
set it up for multi-monitor display.

Video clips are played back by events just as audio clips
are. You can use all the basic editing operation on video
events, just as with audio events. The following operations
are not possible on the video track:
• Drawing, Gluing, Muting and Scrubbing.
• The video track has no editor and does not make use of
parts.

Playing back a video file using video cards
Video cards can also be used to display the video on an
external TV or computer monitor. As of this writing, e.g.
the “Decklink” card (Blackmagic) can be used. For further
information, check the documentation of the video card.

Pool operations

Video playback preferences

The Edit Mode

In the Preferences dialog (Event Display–Video page),
there are two options for video playback:

Video playback follows the Nuendo transport, so that the
video frame at the current project cursor position is shown,
during playback and in Stop mode (e.g. if you move the
project cursor manually or use fast forward/rewind). Nuendo has a special Edit Mode that makes use of this fact,
allowing you to edit audio while getting continuous visual
feedback on the video display:

For information about operations on video clips in the
Pool, see the chapter “The Pool” on page 296.

• Show Video Thumbnails.
When this is activated, thumbnail frames of the video contents are shown
in the track.

• Video Cache Size.
This determines how much memory is available for video thumbnails. If you
have long video clips and/or work with a large zoom factor (so that many
frames are shown in the thumbnails), you may have to raise this value.

• If you activate “Edit Mode” on the Transport menu, the
project cursor will automatically follow when you make selections or perform editing operations (such as moving,
resizing, adjusting fades, etc.).

Replacing the audio in a video file

Since the video automatically follows the project cursor, you will instantly
get a visual feedback when you edit! This makes it very easy to e.g. move
an audio event to a certain spot in the video.

Nuendo has a special function for replacing the audio in a
video file:
1. Pull down the File menu and select “Replace Audio in
Video File”.

• To avoid obscuring the view, the project cursor will be
hidden from the event display in Stop mode if Edit Mode is
activated.

2. In the file dialog that appears, locate and select the
video file on your hard disk, and click Open.

However, it will still be shown in the ruler.

A new file dialog appears.

Listed below are three examples of how you can use Nuendo’s Edit Mode for matching audio and MIDI to video.

3. Locate and select the audio file that you want to insert
into the video file, and click Open.
The audio is added to the video file, replacing its current audio track (if any).

• By combining the functions “Extract Audio”, “Export Audio Mixdown” and “Replace Audio in Video File”, you can
create a complete audio track for a video file.
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Adjusting the position of the audio event

8. Make the desired settings and click Process.
The audio is stretched or compressed to fit the range.

1. If required, set the snap point in the audio event so that
it identifies a significant point in the audio recording.

Creating fades

This would be the position in the audio that you want to match to a certain position in the video. If you don’t set the snap point, the start of the
audio event will be used instead.

If you want the audio to fade in, reaching full volume at a
certain position in the video, and fade out at another position, here is a quick way of achieving this:

2. Activate Edit Mode on the Transport menu.

!

3. Select the audio event.

This assumes that the audio event is already positioned and sized correctly according to the video.

The project cursor position is automatically moved to the position of the
snap point.

1. In Edit Mode, select the Range Selection tool.

4. While watching the video display, move the audio
event towards the correct position.

2. Make a selection range in the audio event, roughly
covering the section that should be played at full volume.

Since the project cursor automatically follows the snap point position
and the video automatically follows the project cursor, you just need to
move the event until the desired video frame is displayed!

3. Click and drag the edges of the selection range so
that they exactly correspond to the end of the fade-in and
the start of the fade-out, respectively.

Adjusting the length of the audio event

While you are dragging, the project cursor position follows the edge of
the range, allowing you to pinpoint the desired fade-in and fade-out position in the video.

If you have a video section and an audio event for it, that
doesn’t quite fit, you can use time stretch to change the
length of the audio:

4. Pull down the Audio menu and select “Adjust Fades to
Range”.

1. Use the method described above to position the start
of the audio event at the correct position according to the
video.

The fade-in and fade-out handles of the audio events are automatically
adjusted.

Ö When using the Fades handles of an audio event in
Edit Mode, the cursor will follow their position as well, allowing you to adjust fades to picture in this manner.

2. In Edit Mode, select the Range Selection tool and
double-click in the audio event.
This creates a selection range that spans the whole audio event.

3. Click the right edge of the selection range and drag to
adjust it to the desired length.
While you are dragging, the project cursor position follows the right
edge of the range, allowing you to pinpoint the desired end position in
the video.

4. Use “Locators to Selection” (on the Transport menu)
to set the locators to the selection range you just made.
5. With the Arrow tool, select the audio clip to be
stretched.
6. On the Audio menu–Process submenu, select “Time
Stretch”.
7. Click the “Use Locators” button.
The time stretch ratio is set up so that the audio event will fit the locator
range.
!

Make sure you don’t exceed the 75% to 125% limit!
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Working with film transfers

The audio recorded along with the film must also have
these speed changes applied to it in order to remain in
sync with the picture once it has been transferred to
video. Sometimes the speed change is applied at the
same time as the film transfer and is recorded directly on
the videotape. This allows the video editor to hear the audio along with the transferred video while editing.

Frame rates
Since Nuendo has been created from the ground up as a
total media production system, it must be capable of working with all different types of video and film frame rates.
Standard frame rates

These speed changes also result in pitch changes. Other
artifacts can also be added to the audio since direct digital
transfers from the field recorder to the videotape are not
possible since either sample rate conversion or an analog
transfer must be used as a result of the speed change.

There are several frame rate standards in use today. They
are as follows:
• 23.98 frames per second (23.98 fps) used for cinema film to
NTSC transfer.
• 24 frames per second (24 fps) used for cinema film cameras.
• 25 frames per second (25 fps) used for PAL/SECAM video
signals.
• 29.97 frames per second (29.97 fps) used for NTSC video
signals.
• 30 frames per second (30 fps) historically used for black and
white NTSC video signals. This frame rate is often used in:
1) Music recording as a reference for synchronizing audio recorders and MIDI sequencing devices.
2) Most field recorders also use 30 fps SMPTE during film
shoots at 24 fps so that after a 2-3 pull-down is performed for
NTSC video transfer, the frame rate becomes 29.97 fps.

Most audio engineers therefore prefer to use the original
source material when working with film audio. Once the
original audio has been digitally transferred into Nuendo,
the speed change must be compensated for in order to
have the audio stay in sync with the video. Nuendo has the
flexibility to apply these speed changes to either the audio
or video independently to compensate for the speed
change.
When a specific speed change has been applied to either
audio or video, it is called a “pull-down” or “pull-up” depending on the direction of speed change. The specific
amount and direction of speed change depends on the
type of transfer the film underwent. Transfers to PAL/SECAM and NTSC each require a different speed change in
order to keep the audio in sync. These speed changes
arise during the Telecine process.

Film transfers
When working with film projects, video post-production
editors typically transfer the film footage to video for use
with computer video editing systems. Once the film has
been edited, it can be transferred back to film for presentation in theaters or may remain in video format for television broadcast and release on videotape or DVD.

The Telecine process
A telecine machine is the device used to transfer film to
videotape. It transfers images from each frame of film to
frames of video in a very specific way. Having a clear understanding of this process will help alleviate the confusion surrounding pull-up and pull-down sample rates and
keeping film audio in sync.

Pull-up and Pull-down
When film footage is transferred to video, the frame rate
must be converted from 24 fps to either 25 fps (PAL/SECAM) or 29.97 fps (NTSC). This process introduces a
slight speed change as a result of the mathematical relationships between the different frame rates.
The film to NTSC conversion is done as 2-3 pull-down
and the film is running at 23.98 fps to maintain the exact
2-to-3 relationship. (Result: The film is running ~0.1%
slower in NTSC TV.)
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Film frames vs. video fields

Transferring film to NTSC video

One of the first things that needs to be understood is how
video signals are formatted in general. Each frame or single image of a video signal is composed of two video
“fields”, each containing half of the image. The first field
contains all the odd horizontal lines of resolution and the
second field contains the even horizontal lines of the image. This is called “interlacing” and is needed to minimize
the flicker effect that would result if the image was presented all at once.

Transferring film at 24 fps to NTSC video at 29.97 fps
presents a few more difficulties than the PAL transfer.
Simply speeding up film to 29.97 fps would cause both
the visual and audio elements to become too fast and
high-pitched to be usable. There is no neat mathematical
relationship between 24 fps and 29.97 fps. Another
method was devised called the 2-3 Pull-down.

Since the film frame is a single, complete image (like a
35mm photograph), there are no fields involved. The telecine machine must transfer part of the film image to one
field and then the rest to another field of video. This may
sound simple at first but as you will see, it can become
quite complex.

The 2-3 pull-down is a combination of speed change and
frame-to-field-counting that results in a smooth transfer to
NTSC video without any unwanted or noticeable pitch
changes in the audio. Here are the steps involved during
the process:

What is 2-3 Pull-down?

1. The film speed is slowed or “pulled” down to 23.976
fps (-0.1%).

Transferring film to PAL/SECAM video

At this speed there is a mathematical relationship between 23.976 and
29.97.

Film transfers to PAL/SECAM video are relatively straightforward. Film runs at 24 fps and PAL video runs at 25 fps.
If you speed up film by roughly 4% (or 4.16%, to be precise), it will be running at 25 fps. So, film transfers to PAL
video result in a 4% “pull-up” in speed. The audio must
also be pulled up by 4% in order to remain in sync with the
video.

2. The first frame of film is transferred to the first two
fields of video.
3. The second frame of film is transferred to three fields
of video, the two fields of the second video frame and just
the first field of the third video frame.
This is where the “2-3” part of the name comes from. Each alternating
frame of film is transferred to two fields of video then three fields of video
and so on.

When properly done, the first frame of film will be transferred to both fields of the first frame of video and so on.
All that is needed is the 4% increase in speed for this to
be a one-to-one transfer.
!

The only downside to PAL transfers is that a 4% increase in the speed will result in a 4% increase in the
pitch as well! This could affect the perception of a
character’s delivery of a line or the timbre of sound
effects or musical tonalities. If the final project is to
remain in the video format, pitch-correcting this
anomaly might be desired.

If the project is going to be returning to film for the final
presentation, the audio can be slowed back down to normal speed when transferring back to film in order to preserve the fidelity and performance values of the original
material.
!

Transferring film to PAL/SECAM video requires a
4% pull-up in speed for both the picture and sound
elements.
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4. The third film frame is transferred to the second field of
video frame three and the first field of video frame four.

When the audio is pulled down, it allows production audio
(DAT tapes or files from a field recorder) from a film shoot
to play in sync with NTSC video. Even though 29.97 fps is
a faster frame rate than 24 fps (film speed), the video is
running -0.1% slower than the original film due to the 2-3
transfer process and hence the need to slow the audio
down a bit.
!

Many video editors working with NTSC video refer to
30 fps as “film speed” as opposed to 24 fps. The
reason for this is if you speed NTSC video (29.97
fps) up by 0.1%, you are running at the same speed
as the original film at 24 fps. Conversations regarding this can often get very confusing. Make sure you
have a clear understanding of the material you are
working with when dealing with film transfers and
frame rates. It will avoid many mistakes and save time
in the long run.

Compensating for film transfers to
video
When working with film transfers to video, it is necessary
to compensate for the change in speed that results from
the telecine process. With Nuendo, there are two basic
ways this can be done. The first is by adjusting the playback speed of the audio to match the speed of the video.
The second is to adjust the speed of the video file to
match the original speed of the film and production audio
in Nuendo.

This is a block diagram of the 2-3 pull-down process. Notice that 4
frames of film are transferred to 5 frames of video using the 2-3 field
technique.

Adjusting audio playback speed

5. The remaining film frames are transferred in this manner, alternating between 2 and 3 fields of video, until the
end of the transfer.

When adjusting audio playback speed to match the video,
there are two scenarios based on the two video formats
that film is transferred to, NTSC and PAL/SECAM. Since
the telecine process for each video format results in different speed changes, there are two types of playback adjustments possible. For NTSC, the speed change is down
-0.1%. For PAL/SECAM, the change is up +4.1667%.

After four frames of film have been transferred this way, an even five
video frames will be created. Over the course of one second, 24 frames
of film and 30 frames of video will have gone by. Since they are running
at -0.1%, the actual frame rate is 29.97 video frames per second, the
NTSC standard.

It is important to have a clear understanding of 2-3 pulldown in order to make accurate decisions regarding audio
pull-down and video pull-up when working with NTSC film
transfers in Nuendo. Film speed is faster than NTSC video
speed.
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Audio pull-down -0.1% (NTSC)

Using this method preserves the quality of the original audio recording made during filming and allows for a digital
mixdown transfer at film speed without any generation
loss or sample rate conversion.

When working on a film project that has been transferred
to NTSC video, most audio engineers prefer to use the
original source tapes from the film shoot in order to retain
the highest quality and fidelity. Audio that has been transferred to the videotape during the film transfer has suffered a generation loss and speed change.

Audio Pull-up +4.1667% (PAL/SECAM)
Audio pull-up (+4.1667%) is the same concept applied to
PAL/SECAM video transfers. Since the film is sped up by
4.1667% during transfer, audio in Nuendo must be running at +4.1667% speed in order to remain in sync with
the video during editing and mixing.

Since the video is running -0.1% slower than the original
film, the audio must also be slowed down by the same
amount as the film in order to remain in sync.
To slow down audio playback in Nuendo, an external sample clock source will be needed to “pull” the clock speed
down by 0.1%.

In this case, the external clock must be set to +4%
varispeed.
!

Your audio card must be set to external sync and connected to the clock device via Word Clock, VST System
Link or some other clocking method for this to work.
Since the video and audio playback speeds are independent in Nuendo, the video will remain at the same speed
while the audio is slowed down (pulled down). This will
ensure that the production audio and film transfer will remain in sync.

Once the project is complete, Nuendo’s sample clock can
be returned to normal (48 kHz) for the final mixdown at film
speed. Once again, this allows for a digital transfer of the
final master at the correct speed for theatrical presentation.

You may receive an OMF, AES 31 or OpenTL file that
contains audio from the original source tapes conformed
to the edited video or you may have to record the source
tapes into Nuendo yourself. Either way, you have audio in
Nuendo that is edited to the picture but will not stay in
sync with the video unless you pull down the sample rate.
!

!

Devices such as the Rosendahl Nanosync are capable of varispeed and have presets for the 4.1667%
necessary with PAL film transfers and the -0.1% for
NTSC.

Non-standard audio pulls
It is also possible to use pulled sample rates that do not fit
one of the above scenarios. These sample rates would
only need to be used in exceptional circumstances when
an error has occurred elsewhere in the process of making
a film. These settings could be used to correct for sync errors made at another studio or problems with video editing
systems. Just about anything is possible.

When you are running at a non-standard sample rate
(47.952 kHz = 48 kHz pull-down), digital transfers
into Nuendo from external equipment must be made
with the external equipment locked to the same sample clock as your audio card. Most devices are capable of a 0.1% change in sample rate and will function
normally.

• -4% Pull-down
If a film project was transferred to PAL/SECAM video and the audio editing and mixing was performed at video speed (48 kHz) without using
audio pull-up, the final mix would be running at video speed not film
speed. In this case a -4% pull-down could be used to correct this and
get the audio running at film speed again. The downside to this is that the
final transfer to film would have to either be analog or through a sample
rate converter in order to be recorded with the film.

Any audio mixdowns that are exported from Nuendo
when the sample clock is pulled down, will play back
in other applications and devices faster since that
sample clock will be running at the standard 48 kHz.

• +0.1% Pull-up
This pull-up is not normally used except in situations similar to the one
described above but for NTSC video. It could be used to correct the
speed of a project finished at video speed (without pull-down) prior to
transferring it to film. Since film is moving 0.1% faster than NTSC video,
the audio mix could be sped up to film speed using +0.1% pull-up for the
transfer.

The idea is that when you have completed the audio mix
for your film project, the video will be sped back up to film
speed for the final transfer back to film and your audio mix
can then be played at the standard 48 kHz sample rate
(no pull-down) and will remain in sync with the picture.
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• Other pull-up/pull-down options

Moving events

There may be other scenarios where non-standard pull-ups and pulldowns can be used to correct mistakes. Nuendo provides further pullup/pull-down options for such situations in the Project Setup dialog and
the respective section in the Project Synchronization dialog (see below).
!

When you change the setting in the Pull-up/Pull-down
pop-up menu and there are events already in the timeline,
Nuendo prompts you to choose whether or not to keep
the original sample start times or not.

All the examples used here are with 48 kHz as the
standard sample rate for the film and video industry.
However, it is possible to accomplish the same tasks
using 44.1 kHz, 88.2 kHz, 96 kHz (this is double the
standard sample rate and commonly used for higher
fidelity), 176.4 kHz and 192 kHz, provided you have
an external clock device capable of pulling these
higher sample rates.
• Selecting “No” allows events to follow the timecode and minutes:seconds clock change and remain at their SMPTE start
times.
• Selecting “Yes” forces Nuendo to leave events at the same
sample start time regardless of the clock speed change.

Timeline adjustments when using pull-ups or pull-downs
When the audio clock of your audio card is being slowed
down or sped up from an external clock source, Nuendo
has no idea that it is running slower or faster than normal.
The time displays (minutes:seconds, timecode) will become inaccurate since they are based on a sample count,
not the independent clock source.

Video Pull-up and Pull-down
Nuendo also provides a method to adjust for film transfers
by speeding up or slowing down playback of the video
files in your project. Depending on the situation, it can be
helpful to make the video file playback at film speed and
not adjust the audio playback at all.

Nuendo provides an adjustment of the timeline to compensate for these changes. This setting is found in the
Project Setup dialog:

Adjusting the video playback speed back to film reverses
the process used when adjusting audio playback speed.
For NTSC video, the video playback speed must be adjusted up +0.1% back to film speed.
!

Nuendo does not offer a video pull-down for PAL/
SECAM since the -4% speed change necessary exceeds the video player’s capacity for varispeed.

Altering the video playback speed is done in the Device
Setup dialog (Video Player page). You have two options:
0.1% pull-up and 0.1% pull-down.

The Pull-up/Pull-down pop-up menu in the Project Setup dialog.

Whenever you apply an audio pull to Nuendo from an external clock, you should also set this menu to the appropriate choice. This allows Nuendo to recalculate the sample
count to reflect the adjusted sample rate.
For example, if the setting is switched from no pull-down to
-0.1% pull-down, events in the timeline will appear longer
since the sample rate has been slowed down. The event
display will show the accurate length of events relative to
timecode, minutes and seconds. The project setup info
line at the bottom of the Nuendo Track list will also indicate
whether pull-up or pull-down is applied to this project.
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Video +0.1% pull-up for NTSC
Since NTSC video is running -0.1% slower than the original film, pulling the video speed back up by +0.1%, returns it to original film speed. With the video now running
at the correct film speed, audio originally recorded at
48 kHz on the film shoot will remain in sync with the video.
Additionally, the final mix can be digitally transferred back
to film at 48 kHz without the need for an analog copy or
sample rate conversion.
Video -0.1% pull-down (non-standard)
Pulling the video speed down for a NTSC video is a nonstandard procedure and would not happen under normal
circumstances. It is possible to pull down a video file that
is running at 24 fps -0.1% so it matches with material running at NTSC video speed. The resulting frame rate is
23.976 fps.
Ö Speeding up or slowing down the video speed is only
possible if the video is running through a “computer
graphics card”. If a professional genlocked video card is
used, the video playback speed is derived from the genlock input.
What is 23.976 fps used for?
The world of digital video formats is ever changing and the
results are new developments for every media professional
involved in movies, television, corporate video and more.
With the advent of HD cameras that are capable of recording at several different frame rates internally, the options
available to cinematographers have become staggering.
Since the look of film running at 24 fps is unique, many HD
productions are filmed at 24 fps to mimic the look of film
on video. Since the speed change from 24 fps to 29.97
fps NTSC is such an odd one (requiring the 0.1% pulldown), designers of these cameras have developed a
method of recording that allows the camera to record like
film but also output a NTSC video signal at the same time
without any speed change. They record at 23.976 fps
which translates to 24 fps pulled down -0.1%.
Ö Many of the high-end professional HD cameras allow
you to record at 23.976 fps, 25 fps, 29.97 fps, 30 fps,
59.94 and even 60 fps.
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Introduction

Launching and quitting

ReWire and ReWire2 are special protocols for streaming
audio between two computer applications. Developed by
Propellerhead Software and Steinberg, ReWire provides
the following possibilities and features:

When using ReWire, the order in which you launch and
quit the two programs is very important:

• Real-time streaming of up to 64 separate audio channels (256 with ReWire2), at full bandwidth, from the “synthesizer application” into the “mixer application”.

1. First launch Nuendo.

Launching for normal use with ReWire
2. Enable one or several ReWire channels in the ReWire
Device dialog for the other application.

In this case, the “mixer application” is of course Nuendo. An example of a
“synthesizer application” is Propellerhead Software’s Reason.

This is described in detail in the section “Activating ReWire channels” on
page 484.

• Automatic, sample accurate synchronization between
the audio in the two programs.

3. Launch the other application.
It may take slightly longer for the application to start when you are using
ReWire.

• The possibility to have the two programs share one audio
card and take advantage of multiple outputs on that card.

Quitting a ReWire session

• Linked transport controls that allow you to play, rewind,
etc., either from Nuendo or from the synthesizer application (provided it has some kind of transport functionality).

When you are finished, you also need to quit the applications in a special order:
1. First quit the synthesizer application.

• Automatic audio mixing functions of separate channels
as required.

2. Then quit Nuendo.

In the case of Reason, for example, this allows you to have separate
mixer channels for the different devices.

Launching both programs without using
ReWire

• Additionally, ReWire2 offers the possibility to route MIDI
tracks in Nuendo to the other application, for full MIDI control.

We cannot think of any scenario, in which you would need
to run Nuendo and the synthesizer application simultaneously on the same computer, without using ReWire, but
you can:

For each ReWire2 compatible device, a number of extra MIDI outputs
will be made available in Nuendo. In the case of Reason, this allows you
to route different MIDI tracks in Nuendo to different devices in Reason,
having Nuendo serve as main MIDI sequencer.

1. First launch the synthesizer application.

• The overall load on your system is much reduced, compared to when using the programs together in the conventional way.

2. Then launch Nuendo.
Ö Please note that the two programs now compete for
system resources such as audio cards, just as when running either with other, non-ReWire audio applications.
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Activating ReWire channels

Using the transport and tempo
controls

ReWire supports streaming of up to 64 separate audio
channels, while ReWire2 supports 256 channels. The exact number of available ReWire channels depends on the
synthesizer application. Using the ReWire Device panels
in Nuendo, you can specify which of the available channels you want to use:

!

This is only relevant if the synthesizer application has
some sort of built-in sequencer or similar.

Basic transport controls
When you run ReWire, the transports in the two programs
are completely linked. It doesn’t matter in which program
you Play, Stop, Fast Forward or Rewind. However, recording (if applicable) is still completely separate in the two
applications.

1. Pull down the Devices menu and select the menu item
with the name of the ReWire application. All recognized
ReWire compatible applications will be available on the
menu.
The ReWire panel appears. This consists of a number of rows, one for
each available ReWire channel.

Loop settings
If there is a loop or cycle facility in the synthesizer application, that loop will be completely linked to the cycle in Nuendo. This means that you can move the start and end
point for the loop or turn the loop on or off in either program, and this will be reflected in the other.

Tempo settings
As far as tempo goes, Nuendo is always the master. This
means that both programs will run in the tempo set in Nuendo.
However, if you are not using the Tempo track in Nuendo,
you can adjust the tempo in either program, and this will
immediately be reflected in the other.

The ReWire panel for Reason.

2. Click on the power buttons to the left to activate/deactivate the desired channels.

!

The buttons light up to indicate activated channels. Please note that the
more ReWire channels you activate, the more processing power is required.

• For information about exactly what signal is carried on
each channel, see the documentation of the synthesizer
application.
3. If desired, double-click on the labels in the right column, and type in another name.
These labels will be used in the Nuendo mixer to identify the ReWire
channels.
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If you are using the Tempo track in Nuendo (i.e. the
Tempo button is activated on the Transport panel),
you should not adjust the tempo in the synthesizer
application, since a tempo request from ReWire will
automatically deactivate the Tempo track in Nuendo!

How the ReWire channels are
handled in Nuendo

Routing MIDI via ReWire2
!

When you activate ReWire channels in the ReWire Device panels, they will become available as channel strips in
the mixer. The ReWire channel strips have the following
properties:

This feature is only available with ReWire2-compatible applications.

When using Nuendo with a ReWire2-compatible application, additional MIDI outputs will automatically appear
on the MIDI Output pop-up menus for MIDI tracks. This
allows you to play the synthesizer application via MIDI
from Nuendo, using it as one or several separate MIDI
sound sources.

• ReWire channels appear to the right of the other audio
and MIDI channel strips in the mixer.
• ReWire channels may be any combination of mono and
stereo, depending on the synthesizer application.
• ReWire channels have the same functionality as regular
audio channels.
This means you can set volume and pan, add EQ, insert effects and
sends and route the channel outputs to groups or busses (done in the Inspector. However, ReWire channels have no monitor buttons.

• All ReWire channel settings can be automated using
the Read/Write buttons.
When you write automation, channel automation tracks will automatically
appear in the Project window. This allows you to view and edit the automation graphically, just as with VST Instrument channels, etc.

• You can mix down the audio from ReWire channels to a
file on your hard disk with the Export Audio Mixdown function (see “Mixing down to an audio file” on page 438).

The MIDI outputs for a Reason song. Here, each output goes directly to
a device in the Reason rack.

You can export the output bus to which you have routed the ReWire
channels. You can also export individual ReWire channels directly –
“rendering” each ReWire channel to a separate audio file.

• The number and configuration of MIDI outputs depends
on the synthesizer application.

Considerations and limitations
Sample rates
Synthesizer applications may be limited to audio playback
in certain sample rates. If Nuendo is set to a sample rate
other than those, the synthesizer application will play back
at the wrong pitch. Consult the documentation of the synthesizer application for details.
ASIO drivers
ReWire works well with ASIO drivers. By using the Nuendo
bus system you can route sounds from the synthesizer
application to various outputs on an ASIO compatible audio
card.
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Working with Projects

• Click “Activate” to open and activate the new project.
The active project is indicated by the blue Activate button in the upper
left corner of the Project window. To make another project active, simply
click its Activate button.

New Project
The New Project command on the File menu allows you to
create a new project, either empty or based on a template:
1. Select New Project from the File menu.
By default, this list is empty. How to create templates is described in the
section (see “Save as Template” on page 488).

2. Select “Empty”.
A file dialog opens, allowing you to specify a folder for the new project.

3. Select an existing project folder or click on Create and
enter a name for a new one in the dialog that opens.

An active project.

A new, untitled project is created.

• You can also open project files by selecting an entry
from the “Recent Projects” submenu on the File menu.

Open

This submenu lists the projects you have recently worked with, with the
most recent one at the top of the list.

The Open command on the File menu is used for opening
saved project files. Project files created with Nuendo (file
extension “.npr”), Cubase (file extension “.cpr”) and Sequel (extension “.steinberg-project”) can be opened. Note
that program-specific settings which cannot be applied in
Nuendo will be ignored.

• Projects can also automatically be opened when you
launch Nuendo (see “Startup Options” on page 489).

1. Select Open… from the File menu.

About the “Pending Connections” dialogs

• You can drag projects from the MediaBay into the Nuendo application window (not into an existing Project window) to open them.

A file dialog opens, allowing you to select a project.

If you open a Nuendo project created on another setup
(other audio hardware), the program tries to find matching
audio inputs and outputs for the i/o busses (this is one of
the reasons why you should use descriptive, generic names
for your input and output ports – see “Preparations” on
page 12).

2. Click Open.
The project opens in the Project window.

• Several projects can be open at the same time.
This is extremely useful, if you want to copy parts or entire sections from
one project to another.

3. If a project is already opened, opening another project
brings up a warning.

If the program cannot resolve all audio/MIDI inputs and
outputs used in the project, a Pending Connections dialog
will open. This will allow you to manually re-route any ports
specified in the project to ports available in your system.

Close
The Close command on the File menu closes the active
window. If a Project window is active, selecting Close will
close the corresponding project.
• Click “No” to open the other project inactive.

• If the project contains unsaved changes, you will be
asked whether you want to save the project before closing
it.

This significantly reduces load times, especially for large projects.

If you select “Don’t Save” and have recorded or created new audio files
since saving, you get the choice to delete or keep these.
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Save and Save As

Save as Template

The commands Save and Save As allow you to save the
active project as a project file (file extension “.npr”). The
Save command stores the project under its current name
and location, while Save As allows you to rename and/or
relocate the file. If a project has not been saved yet or if it
hasn’t been changed since it was last saved, only Save As
will be available.

This function allows you to save the current project as a
template. When you create a new project, the available
templates will be listed, allowing you to base the new
project on a template.

!

Proceed as follows:
1. Set up a project.
2. Select “Save As Template…” from the File menu and
save the project template under the desired name.

Generally, we recommend that you save project files
in their project folders, to keep the projects as
manageable as possible.

• Templates can contain clips and events just like regular
projects.

A word about file extensions

If this is not what you want, make sure to remove all clips from the Pool
before you save the project as template.

Under Windows, file types are indicated by three letter file
name extensions (such as *.npr for Nuendo project files).

Templates are always stored in the Templates folder.

Under Mac OS X, it is not necessary to use file name extensions, since the file types are stored internally in the
files. However, if you want your Nuendo projects to be
compatible with both platforms, you should make sure the
option “Use File Extension in File Dialog” is activated in
the Preferences (General page). When this is activated
(default), the proper file name extension is automatically
added when you save a file.

On a Windows system, it is located at \Documents and
Settings\<username>\Application data\Steinberg\Nuendo 4\templates. On a Mac system, it is located inside
Users/<username>/Library/Preferences/Nuendo 4.
Setting up a default template
If you always want the same default project to open when
you launch Nuendo, you can save a default template. Proceed as follows:

Save New Version

1. Set up a project.

This function is only available as a key command, by default [Ctrl]/[Command]+[Alt]/[Option]+[S]. When you use
this function, a new version of the project will be saved.

2. Select “Save As Template…” from the File menu and
save the project template with the name “default”.

The new file will get the same name as the original project,
but with an incremental number attached. For example, if
your project is called “My Project”, you will get new versions
called “My Project-01”, “My Project-02”, and so on.

3. Open the Preferences dialog and select the General
page.

Save New Version is useful if you are experimenting with
edits and arrangements and want to be able to go back to
a previous version at any time. The newest versions are always listed on the Recent Projects submenu on the File
menu for instant access.

The next time you launch Nuendo, the default template will
automatically be opened. For details on the other Startup
options, see “Startup Options” on page 489.

4. Open the “On Startup” pop-up and select “Open ’Default’ Template”.
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Save Project to New Folder

Startup Options

This function is very useful if you want to move or archive
your project.

Auto Save

1. Select “Save Project to New Folder”.
A file dialog opens in which you can choose an existing, empty folder or
create a new folder to save the project.

2. Click OK to confirm your choice.
The “Save to Folder Options” dialog opens with the following options:

If you activate the Auto Save option in the Preferences
(General page), Nuendo will automatically save backup
copies of all open projects with unsaved changes.
Backup copies of projects are named “<project name>xx.bak”, where xx is an incremental number. Unsaved
projects are backed up in a similar way as “UntitledXxx.bak”, with X being the incremental number for unsaved
projects. All backup files are saved in the project folder.
Option

Description

Project Name

Enter a project name if you want to change it from the default (the current name of the project).

• Use the “Auto Save Interval” setting to specify the time
intervals in which a backup copy will be created.
• Use the “Maximum Backup Files” option to specify how
many backup files will be created with the Auto Save function.

Minimize Audio If this is activated, only the audio file portions that are acFiles
tually used in the project will be included. This can significantly reduce the size of the project folder (if you are
using small sections of large files), but it also means you
cannot use other portions of the audio files if you continue working with the project in its new folder.
Freeze Edits

This will perform a Freeze Edits operation, making all processing and applied effects permanent to each clip in the
Pool, see “Freeze Edits” on page 253.

Remove
Unused Files

When this is activated, only files in the Pool that are actually used in the project will be stored in the new folder.

When the maximum number of backup files is reached, the existing files
will be overwritten (starting with the oldest file).

On Startup
The “On Startup” pop-up menu in the Preferences (General page) allows you to specify what should happen each
time you launch Nuendo.

3. Make the desired settings.
4. Click OK.
The project is saved in the new folder. The original project is not affected.
However, now you could e.g. delete the original project without losing
your project data.
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Working with libraries

The following options are available:
Option

Description

Do Nothing

Nuendo launches without opening a project.

Open Last
Project

The last saved project is opened on launch.

Open ’Default’
Template

The default template is opened, see “Setting up a default
template” on page 488.

Show Open
Dialog

The Open dialog opens on launch, allowing you to manually locate and open the desired project.

A library is a stand-alone Pool that is not associated with a
project file (for more information about Pools, see “The
Pool” on page 296). You can use libraries to store sound
effects, loops, video clips, etc., and transfer media from a
library into a project by using drag and drop. The following
library functions are available on the File menu:
New Library

Show Template The Template dialog opens on launch, allowing you to
Dialog
create a new project from one of the templates.

Creates a new library. Just as when creating new projects,
you will be asked to specify a project folder for the new library (in which media files will be stored). The library will
show up as a separate Pool window in Nuendo.

Show Open
The Open Document Options dialog opens on launch,
Options Dialog see below. It allows you to make a different choice each
time you launch Nuendo.

Nuendo Open Document Options Dialog

Open Library

This dialog will open in two cases:

Opens a file dialog for opening a saved library file.

• If you launch Nuendo with the option “Show Open Options Dialog” selected on the “On Startup” pop-up menu
in the Preferences (General page).

Save Library
Opens a file dialog for saving the library file (file extension
“.npl”).

• If you hold down [Ctrl]/[Command] while launching Nuendo.

Revert
If you select “Revert” from the File menu, you will be asked
whether you really want to revert to the last saved version
of the project. If you click “Revert”, all changes you have
made since saving will be discarded.
If you have recorded or created new audio files since saving, you will be asked whether you want to delete or keep
these.

The Open Document Options Dialog.

The dialog lists your recently used projects.
• To open a project, select it and click the “Open Selection” button.
• To open another project not listed here, click the “Open
Other…” button.
A file dialog opens that allows you to look for the desired file on your disk.

• To create a new project, click the “New Project” button.
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Importing audio

Selecting one of the Import Audio CD menu items brings
up the following dialog:

Ö For exporting Audio, see the chapter “Export Audio
Mixdown” on page 437.
Ö For the option “Replace Audio in Video File”, see “Replacing the audio in a video file” on page 474.

Importing audio files
For information on audio file import preferences, please
see “Audio file import options” on page 41. For information on import into the Pool and import options, see “Import Medium…” on page 306.

Importing audio CD tracks
You can import audio from audio CDs into Nuendo
projects in two ways:
• To import the CD tracks directly into project tracks,
choose the “Audio CD…” option from the Import submenu on the File menu.
The imported audio CD track(s) will be inserted on the selected audio
track(s) at the project cursor position.

To import one or more tracks, proceed as follows:

• To import the CD tracks into the Pool, select “Import
Audio CD” from the Media menu.

1. If you have more than one CD drive, select the correct
one from the Drives pop-up menu top left.

This might be the preferred method if you want to import several CD
tracks in one go. For more information, see “Importing audio CD tracks”
on page 308.

On opening the CD, the program tries to retrieve the track names from
CDDB (a CD database). If no connection to CDDB can be established
or the CD track names are not found, you can manually change the generic track name in the Default Name field, see below.

2. Activate the “Secure Mode” option, if you want to use
a Secure Read mode.
Activate this if you encounter problems when trying to import an audio
CD. Error checking and correction will be done during the process. Note
that this mode will take more time.

3. In the Windows version, select the data transfer speed
from the Speed pop-up menu.
While you normally want to use the fastest possible speed, you may have
to select a slower speed for flawless audio extraction.

4. Activate the Copy checkbox for every audio file you
want to import.
You can also select a copy section for every file, see below.
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5. Click on Copy to generate a local copy of the audio
file(s) or section(s).

• If you want to copy and import a section of an audio CD
track only, select the track in the list and specify the start
and end of the selection to be copied by dragging the
handles in the copy selection ruler.

The copied files are listed at the bottom of the dialog. By default, imported
audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac)
in the Audio folder of the current project. To change the folder, click Folder
and select another one from the dialog. During copying, the button is labeled “Stop”; click it to stop the process.

Use the start and end audition buttons to fine tune the selection boundaries.
Play
Stop

6. Click OK to import the copied audio files into the
project, or click Cancel to stop the import and discard the
copied files.
• If you import more than one audio file into project tracks,
a dialog opens in which you have to choose whether to insert the tracks on one track or on different ones.

Description
Activate the checkbox in this column for the track you
want to copy/import. To activate more than one checkbox, click and drag over the checkboxes (or press [Ctrl]/
[Command] or [Shift] and click).

#

Number of track.

CD Track

When you import an audio CD track, the file will be
named according to the name in this column. The names
are pulled automatically from CDDB, if possible. You can
rename a track by clicking in the Track column and typing
a new name. You can also apply a generic name to all audio CD tracks, if no name was available in CDDB.

Length

• You can audition the selected audio CD track by clicking the Play button.
The track will be played back from selection start to selection end (or until you click the Stop button).

• The arrow up/down buttons allow you to audition the
start and end of the selection only.
The arrow down button will play a short snippet beginning at the start of
the selection, while the arrow up button will play a snippet starting just
before the end of the selection.

• In case no connection to CDDB could be established or
no CD track names were found, you can change the generic audio file name in the Default Name field.

The length of the audio CD track in minutes and seconds.

Size

The file size of the audio CD track in MegaBytes.

Copy Start

You can copy a section of a track if you like. This indicates the start of the section to be copied in the track. By
default, this is set to the start of the track (0.000) but you
can adjust this on the copy selection ruler (see below).

Copy End

Indicates the end of the section to be copied in the track.
By default, this is set to the end of the track but you can
adjust this on the copy selection ruler (see below).

End of selection handle

Ö Note that you can import sections of several audio CD
tracks by selecting them in turn and adjusting the selection. The start and end settings for each track will be displayed in the list.

The columns in the “Import from Audio CD” dialog have
the following functionality:
Copy

Play end of selection

Start of selection handle

The new track(s) are displayed in the Project window. New audio clips
are created and added to the Pool.

Column

Play start of selection

The imported audio files be will be named accordingly, i.e. <default
name> 01 etc.

Ö Note that if there is a track name for a specific audio
CD track in the list, the corresponding audio file will use
that name instead.
• To open the CD drive, click on the Eject button at the
top of the dialog.

By default, the complete tracks are selected.
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Importing Audio from Video files

4. Locate and select the file and click Open.
The file is imported and automatically adjusted to the current Nuendo
tempo.

While you can automatically extract the audio when importing a video file (see “Extracting audio from a video file”
on page 472), it is also possible to import the audio from a
video file without importing the video itself:

Unlike a regular audio file, the imported REX file will consist of several events, one for each “slice” in the loop. The
events will automatically be placed in an audio part on the
selected track and positioned so that the original internal
timing of the loop is preserved.

1. Pull down the File menu and select “Audio from Video
File…” from the Import submenu.
2. In the file dialog that opens, locate and select the
video file and click Open.

5. If you now open the part in the Audio Part Editor, you
can edit each slice separately by muting, moving and resizing events, adding effects and processing, etc.

The audio in the selected video file is extracted and converted to a Wave
file in the project’s Audio folder.

You can also adjust the tempo and have the REX file automatically follow
(provided that its track is tempo based).

• A new audio clip is created and added to the Pool. In the
Project Window, an event referencing the audio file will be
inserted on the selected track at the project Cursor position. If no track was selected, a new track will be created.

Ö You can achieve similar results by using Nuendo’s
own loop slicing features, see “Working with hitpoints and
slices” on page 278.

This works just like when importing regular audio files.

Ö For importing video files, see “Importing a video file”
on page 470.

Importing compressed audio files
Nuendo can import (and export, see “Mixing down to an
audio file” on page 438) several common audio compression formats. The procedure is the same as when importing any non-compressed audio file, with one important
thing to note:

Importing ReCycle files
ReCycle by Propellerhead Software is a program designed
especially for working with sampled loops. By “slicing” a
loop and making separate samples of each beat, ReCycle
makes it possible to match the tempo of a loop and edit the
loop as if it was built of individual sounds. Nuendo can import two file types created by ReCycle:

• When you import a compressed audio file, Nuendo will
create a copy of the file and convert this to Wave format
(Windows) or AIFF format (Mac OS X) before importing it.
The original compressed file will not be used in the project.

• REX files (export file format of the first versions of ReCycle,
extension “.rex”).
• REX 2 files (file format of ReCycle 2.0 and later, extension
“.rx2”).

The imported file will be placed in the designated project
Audio folder.
!

Proceed as follows:
1. Select an audio track and move the project cursor to
where you want the imported file to start.
You probably want to import REX files to tempo based audio tracks, since
this will allow you to change the tempo later on (having the imported REX
file automatically adjust).

2. Select “Audio File…” from the Import submenu on the
File menu.
3. Select REX files or REX 2 files with the file type popup menu in the file dialog.
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The resulting Wave/AIFF file will be several times
larger than the original compressed file.

The following file types are supported:
MPEG audio files
MPEG, which stands for Moving Picture Experts Group, is
the name of a family of standards used for coding audiovisual information (e. g. movies, video, music) in a digital
compressed format.
Nuendo can read two types of audio MPEG files: MPEG
Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently,
mp3 is the most common of these formats, while the mp2
format is mostly used in broadcast applications.
Ogg Vorbis files
Ogg Vorbis is a relatively new format that is open and
patent-free and offers very small audio files maintaining
comparatively high audio quality. Ogg Vorbis files have the
extension “.ogg”.
Windows Media Audio files (Windows only)
Windows Media Audio is an audio format developed by
Microsoft Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very
small, maintaining good audio quality. The files have the
extension “.wma”.

3. Use the track list to the left to select which tracks
should be included in the exported file.
To select all tracks, click the “Select All” button. Normally, the whole
project is included – to export the range between the locators only,
activate “From Left to Right Locator”.

• When referencing media files (see below), you can set
the referenced output path by entering it in the “Media
Destination Path” field or by browsing the file dialog.

Exporting and importing OMF files
Open Media Framework Interchange (OMFI) is a platform
independent file format intended for transfer of digital media between different applications. Nuendo can import
and export OMF files (file extension “.omf”), allowing you
to use Nuendo in conjunction with other audio and video
applications.

All file references will be set to this path. You can create references to
media destinations that don’t exist on the system you are currently working with, making it easy to prepare files for use in projects on another
system or in a network environment.

4. If you want to create copies of all the media files,
choose the “Copy Media” option.
By default, the copied audio files are placed in a sub-directory in the export destination folder. To specify a different location for the copied files,
use the “Media Destination Path” field.

Exporting OMF files
You can only export stereo files in OMF format.
1. Pull down the File menu and open the Export submenu.

5. If you want to copy only the portions of audio files that
are used in the project, select “Consolidate Events” option.

2. On the submenu, select “OMF…”.

You can also define handle lengths in milliseconds to include audio outside each event boundary for fine tuning later. If you do not have any handles when consolidating audio files, you will not be able to adjust fades
or edit points when the project is imported in another application.

The Export Options dialog opens:

6. Select “1.0 File” or “2.0 File”, depending on which
OMFI version is supported by the application in which you
plan to import the file.
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• Select whether you want to include all audio data in the
OMF file (“Export All to One File”) or use references only
(“Export Media File References”).

• If the OMF file contains Video Event information, you are
asked whether you want to create Markers at the start position of the Video Events.

If you choose “Export All to One File”, the OMF file will be totally “selfcontained”, but possibly very large. If you choose “Export Media File References”, the file will be small, but the referenced audio files must be
available for the receiving application.

This allows you to manually import the video files, using the Markers as
position references.

A new, untitled project is created (or tracks are added to
the existing project), containing the Audio Events of the
imported OMF file.

7. If you selected the “2.0 File” option above, you can
choose whether to include the volume settings and fades
for the events (as set up with the event volume and fade
handles) as well as the clip names – to include these in
the OMF file, activate “Export Clip Based Volume”, “Use
Fade Curves” and/or “Export Clip Names”, respectively.

Exporting and importing AAF files
The Advanced Authoring Format (AAF) is a multimedia file
format used to exchange digital media and meta data between different systems and applications across multiple
platforms. Designed by the top media software companies, this format will help media creators by allowing them
to exchange projects between applications without losing
valuable meta data such as fades, automation and processing information.

8. Specify a sample size (resolution) for the exported files
(or use the current project settings).
9. If you activate “Quantize Events to Frames”, the event
positions in the exported file will be moved to exact frames.
10. Click OK, and specify a name and location in the file
dialog that opens.

Exporting AAF files

The exported OMF file will contain (or reference) all audio
files that are played in the project (including fade and edit
files). It will not include unused audio files referenced in
the Pool, or any MIDI data. Video files are not included.

1. Select “AAF…” from the Export submenu on the File
menu.

Importing OMF files
1. Pull down the File menu and open the Import submenu.
2. On the submenu, select “OMF…”.
3. In the file dialog that opens, locate the OMF file and
click Open.
• If there is already an open project, a dialog opens in
which you can select whether a new project should be
created for the file or not.
If you select “No”, the OMF file will be imported into the current project.

4. If you choose to create a new project, a file dialog
opens in which you can select the project folder.
Select an existing project folder or create a new one by clicking on Create and entering a name in the dialog.

5. The Import options dialog opens, allowing you to
choose a track for the import.
Activating the “Import all media” option allows you to import media that is
not referenced by events.
Activating the “Import Clip Gain as Automation” option imports volume
automation and envelopes of the Volume Automation Track of each track.

The Export Options dialog for AAF files.
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Importing AAF files

2. You can choose which tracks will be exported from
your project by clicking in the export column for each track
name in the list.

1. Select “AAF…” from the Import submenu on the File
menu.

A check mark will appear next to each track that will be exported. You
may also click the “Select All” button to select every track in the project
for export.

2. Once you have selected a valid AAF file, Nuendo will
ask you if you wish to create a new project. Choosing Yes
will import tracks into a new project.

3. If you wish to only export the portion of project that is
between the left and right locators, check the box marked
“From Left to Right Locator.”

3. Select a directory or create one for the new project.
If you choose not to create a new project, the imported tracks will be
added to the currently active project.

If an event crosses over the left or right locator, it will be trimmed in the
AAF file to the point of the locator. Only the portions of events that lie
within the boundaries of the locators will be included in the exported file.

4. In the dialog that opens, select the tracks you wish to
import by clicking in the Import column next to each track.

4. If you want to create copies of all the media files,
choose the “Copy Media” option.

You can also click the Select All button to import all tracks in the AAF file.

5. Click OK.

By default, the copied audio files are placed in a sub-directory in the export destination folder. To specify a different location for the copied files,
use the Media Destination Path field.

The import process will begin. Depending on the size of the imported
project and if the files are embedded or referenced, the import process
may take a while.

5. If you want to copy only the portions of audio files that
are used in the project, select the “Consolidate Events”
option.

Exporting and importing AES31 files

You can also define handle lengths in milliseconds to include audio outside each event boundary for fine-tuning later. If you do not have any
handles when consolidating audio files, you will not be able to adjust
fades or edit points when the project is imported in another application.

The AES31 standard is an open file interchange format, developed by the Audio Engineering Society as a means of
overcoming format incompatibility issues between different
audio hardware and software. It can be used for transferring
projects via disk or network from one workstation to another, retaining time positions of events, fades, etc.

Ö Even when selecting neither of the above two options,
you can still enter a media destination path.
All file references will be set to this path. You can create references to
media destinations that don’t exist on the system you are currently working with, making it easy to prepare files for use in projects on another
system or in an network environment.

AES31 uses the widely used Microsoft FAT32 file system
with Broadcast Wave as the default audio file format. This
means that an AES31 file can be transferred to and used
with any digital audio workstation that supports AES31,
regardless of the type of hardware and software used, as
long as the workstation can read the FAT32 file system
and Broadcast Wave files (or regular wave files).

6. In the Options section, you have the choice of exporting all data to one file or to create media references to files
from within the AAF file.
Exporting only one file makes transfers simpler, but, at the time of writing
of this manual, certain applications cannot handle single AAF files.
Check with each software manufacturer for up-to-date information regarding AAF support in other applications.

Exporting AES31 files
1. Select “AES31…” from the Export submenu on the
File menu.

7. You can specify the Sample Size by using the pop-up
menu.

2. Select a name and location for the new file and click
Save.

This defaults to keeping the same setting as the project.

8. You can quantize events to frame boundaries by activating the last option.

The exported file will contain all Audio Track data, including audio file references. If any of the audio events in your project has real-time fades (as set
up with the fade handles for the events), these will automatically be converted to fade audio files and stored in a fades folder next to the AES31
file.

Quantizing events to frame boundaries is sometimes necessary when exporting projects to video workstations that limit the accuracy of edits to the
frame. Any events that begin or end not on a frame boundary can exhibit
odd behavior or be moved when imported into a workstation of this type.
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The following will not be included in the resulting AES file:

Audio file formats are volume type dependent: for FAT32
this is BWF (*.wav) and for HFS+ this is SDII. OpenTL
files can only be transferred within file systems of the
same format which means that it is not possible to import
an OpenTL project exported from Mac (HFS+) into a
Windows system (FAT32) or vice versa, unless you use a
conversion utility (e.g. MM-EDL).

• Any mixer settings or automation made in Nuendo.
• MIDI Tracks.
The saved file will be an xml file (but with the extension
“.adl”, for audio decision list) – this means you can open it
in any text editor to check file references etc.

Nuendo for Windows supports OpenTL FAT32/BWF.
Nuendo for Mac OS X supports OpenTL HFS+/SDII as
well as FAT32/BWF. MMR-8, MMP-16, and MX-2424
support OpenTL projects sourcing or targeting Nuendo
PC with up to 999 mono tracks.

Importing AES31 files
1. Select “AES31…” from the Import submenu on the
File menu.
2. Navigate to the location of the AES31 file (extension
“.adl”), select it and click Open.

Exporting OpenTL files

You are prompted to select or create a project folder for the new project.

First, make sure all audio files (in the Pool) and tracks (in
the Project window) in the project are in mono (split stereo tracks and stereo interleaved audio files to dual mono)
and all 16-bit or all 24-bit. The OpenTL specification does
not include support for 32-bit audio files. If the Pool contains 32-bit audio files, these will not be exported. Make
sure all referenced audio files are located on the drive to
which you want to export the OpenTL file.

3. After specifying the name and location of the project
folder, the new project opens containing all the audio
tracks and events stored in the AES31 file.

Exporting and importing OpenTL files
OpenTL is a file exchange format originally developed for
Tascam hard disk recording systems. OpenTL facilities
also exist in a variety of DAWs, making Nuendo project
transfer reliable and solid. For example, a common use of
OpenTL is to convert hassle free between Nuendo and
Pro Tools. If you import or export an OpenTL file to/from
Nuendo, the resulting project will contain all audio files,
edits, and track names made in the Tascam device or
DAW, with all events positioned sample accurately on the
time line.

!

When exporting OpenTL files on PC, do not change
the DF or NDF frame notation after you have set the
project start time. Make sure that all audio files in the
Pool have the same sample rate, bit depth, and that
all are set to Broadcast Wave file type.

1. Select “OpenTL…” from the Export submenu on the
File menu.
In the dialog that opens, activate the “Copy Media” or the “Consolidate
Events” option to guarantee that all audio is exported. Locate the target
hotswap FAT32 disk, select the appropriate project folder and click Open.

OpenTL implementation in Tascam® MMR-8,
MMP-16 and MX-2424

2. Select a name and location for the new file and click
Save.

All three Tascam devices work with either two types of
disk volume formats: FAT32 (Windows standard) or
HFS+ (Mac OS standard). For proper Nuendo compatibility it is necessary that each and every MMR-8/MMP-16
be running OS v5.03 and MX-2424 v3.12. A number of
crucial OpenTL updates only appear in these machine operating systems, and only this setup can assure reliable
Nuendo exchange.

The exported file will contain all audio track data, including file references,
clip based volume automation, fade-in, fade-out, and crossfades.

3. Now you can mount the carrier in the Tascam device
and load the project.
The following will not be included in the resulting OpenTL
EDL file:
• Any real-time mixing, EQ, effects settings, breakpoint automation tracks
• MIDI tracks made in Nuendo
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The following is a basic OpenTL specification description:

Proceed as follows to import XSend files:

• Maximum number of mono tracks: 999
• Supported samplerates (Hz): 44056, 44100, 44144, 47952,
48000, 48048, 42294, 42336, 45938, 45983, 46034,
46080, 50000, 50050, 88200, 96000
• Bit depth: 16, 24
• Audio file types: BWF (Broadcast Wave format), WAVE
(Standard Wave), SDII (Sound Designer II)
• Volume formats: FAT32, NTFS, HFS+
• Automation support: clip based volume, breakpoint volume
and mute
• Fade support: fade in, fade out, and cross fade
• Frame rates (Fps): 24/24, 23.976/24, 24.975/25, 25/25,
29.97/DF, 29.97/NDF, 30/DF, 30/NDF

1. You must designate the XSend Incoming folder by selecting the XSend preferences from the Nuendo File menu.
A dialog opens, allowing you to browse your system to select a folder
where exported Liquid projects will be stored.

2. Export the Liquid project to the Nuendo system.
This can be done directly over a network if the two systems are connected by one. No file sharing is needed. All file transfers are handled by
XSend. Refer to the Liquid system’s documentation for more information
on how to do this. You may also export the sequence to portable media
such as DVD-R or CD-R discs for transfer when no network is available.

3. On the File menu–Import submenu, select “XSend…”.
Navigate to the exported Liquid sequence which will be an .XSD file type.

4. You will be asked if you wish to create a new project.
Choose Yes if you want to import the XSend sequence into a blank
project. If you choose No, the imported sequence will be appended to
the currently active project. The new audio tracks are displayed below
the lowest track or channel in the project. In either case, both audio and
video files can be included in the XSend sequence, providing a convenient means to receive entire projects from Liquid users.

Importing OpenTL files
1. Select “OpenTL…” from the Import submenu on the
File menu.
2. Navigate to the location of the OpenTL file, select it
and click Open.

Exporting and importing standard
MIDI files

3. You are prompted to select or create a project folder
for the new project.
After specifying the name and location of the project folder, the new
project opens containing all the audio files stored in the OpenTL file and
their associated edits. Save the imported file as a Nuendo project.

Nuendo can import and export Standard MIDI Files, which
makes it possible to transfer MIDI material to and from virtually any MIDI application on any platform. When you import and export MIDI files, you can also specify whether
certain settings associated with the tracks should be included in the files (automation subtracks, volume and pan
settings etc.).

4. Open the Pool, and select “Prepare Archive…” from
the Pool context menu.
This will copy any necessary external audio files into the local Nuendo
project directory.

5. Select the Save option from the File menu.

Exporting MIDI files

Importing XSend projects from
Liquid

To export your MIDI tracks as a Standard MIDI File, pull
down the File menu and select “MIDI File…” from the Export submenu. A regular file dialog opens, allowing you to
specify a location and name for the file.

For Liquid users, XSend provides a means to export a Liquid sequence directly to a Nuendo workstation either on
the same machine, over a network or via portable media
such as DVD-R.
The XSend options and features are available only if
XSend is installed on your computer. You can either install
XSend during the Nuendo installation process, or at a
later point in time using the XSend installer supplied on
the Nuendo program DVD. Also, make sure the XSend
plug-in is activated in the Plug-in Information window.
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When you have specified a location and a name for the file,
click “Save”. The Export Options dialog opens, allowing you
to specify a number of options for the file – what should be
included in the file, its type and its resolution (see below for
descriptions of the options).

The Export Options dialog.

You will also find these settings in the Preferences (MIDI–
MIDI File page). If you set these up once and for all in the
Preferences, you only need to click OK in the Export Options dialog to proceed.

Description

If this is activated and you are using any MIDI plug-ins as
send effects, the modifications to the original MIDI notes
that occur as a result of the effect(s) will be included in
the MIDI file.

Export Marker

If this is activated, any markers you have added (see “Using markers” on page 109) will be included in the MIDI
file as Standard MIDI File Marker events.

Export as
Type 0

If this is activated, the MIDI file will be of Type 0 (all data
on a single track, but on different MIDI channels). If you
don’t activate this option, the MIDI file will be of Type 1
(data on separate tracks). Which type to choose depends on what you want to do with the MIDI file (in which
application or sequencer it should be used, etc.).

Export
Resolution

You can specify a MIDI resolution between 24 – 960 for
the MIDI file. The resolution is the number of pulses, or
ticks, per quarter note (PPQ) and determines the precision with which you will be able to view and edit the MIDI
data. The higher the resolution, the higher the precision.
The resolution should be chosen depending on the application or sequencer with which the MIDI file should be
used though, since certain applications and sequencers
may not be able to handle certain resolutions.

Export Locator
Range

If this is activated, only the range between the locators
will be exported.

Export
includes Delay

If this is activated, the delay of the MIDI track will be included in the MIDI file. For more information about the
Delay option, see “Basic track settings” on page 344.

To include these, you need to convert the settings to “real” MIDI events
and properties by using the Merge MIDI in Loop function for each track,
see “Merge MIDI in Loop” on page 358.

Importing MIDI files

Export Inspector If this is activated, Volume and Pan settings made in the
Volume/Pan
Inspector are included as MIDI Volume and Pan events in
the MIDI file.

Export Inserts

Export Sends

Ö Inspector settings other than those specified in the Export options are not included in the MIDI file!

Export Inspector If this is activated, the MIDI patch settings in the InspecPatch
tor – Bank Select and Program Select (used for selecting
sounds in the connected MIDI instrument) are included
as MIDI Bank Select and Program Change events in the
MIDI file.

Export
Automation

Description

Ö The MIDI file will include the Tempo track.

The dialog contains the following options:
Option

Option

To import a MIDI file from disk, proceed as follows:
1. Select “MIDI File…” from the Import submenu on the
File menu.

If this is activated, recorded automation (see “Introduction” on page 214) is converted to MIDI controller events
and included in the MIDI file. This also includes automation recorded with the MIDIControl plug-in. This is described in the chapter “MIDI Effects” of the separate
manual “Nuendo Expansion Kit – Cubase Music Tools for
Nuendo 4”.

2. If there is already an open project, a dialog opens in
which you can select whether a new project should be
created for the file or not.
If you select “No”, the MIDI file will be imported into the current project.

If this is activated and you are using any MIDI plug-ins as
insert effects, the modifications to the original MIDI notes
that occur as a result of the effect(s) will be included in
the MIDI file. A MIDI delay, for example, will produce a
number of repeats to a MIDI note by actually adding additional, “echoing” notes at rhythmic intervals – these notes
will be included in the MIDI file if the option is activated.

3. Locate and select the MIDI file in the file dialog that
opens and click Open.
• If you choose to create a new project, select the project
folder.
Select an existing project folder or create a new by clicking on Create
and entering a name in the dialog.
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Exporting and importing MIDI loops

The MIDI file is imported. The result depends on the contents of the MIDI file and the Import Options settings in the
Preferences (MIDI–MIDI File page). The Import Options
are as follows:
Option

Description

Extract First
Patch

If this is activated, the first Program Change and Bank
Select events for each track are converted to Inspector
settings for the track.

Extract First
Volume/Pan

If this is activated, the first MIDI Volume and Pan events
for each track are converted to Inspector settings for the
track.

Nuendo allows you to import MIDI loops (file extension
“.midiloop”) and to save instrument parts as MIDI loops.
MIDI loops are handy, as they contain not only MIDI notes
and controllers, but also the associated VST instrument
and instrument track preset settings.
How to import and export MIDI loops is described in detail
in the chapter “VST Instruments and Instrument tracks” on
page 189.

Import Controller If this is activated, MIDI controller events in the MIDI file
as Automation will be converted to automation data for the MIDI tracks.
Tracks
Import to Left
Locator

If this is activated, the imported MIDI file will be placed so
that it starts at the position of the left locator – otherwise
it will start at the beginning of the project. Note that if you
choose to have a new project created automatically, the
MIDI file will always start at the beginning of the project.

Import Marker

If this is activated, Standard MIDI File Markers in the file
will be imported and converted to Nuendo markers.

Exporting and importing tracks
You can export Nuendo tracks (Audio, FX, Group, Instrument, MIDI and Video) as track archives for import into
other Nuendo projects. All the information associated with
the tracks will be exported (mixer channel settings, automation tracks, parts and events etc.). If you select the option “Copy” (see below), a separate “media” folder will be
created, containing copies of all referenced audio files.

Import dropped If this is activated and you drag and drop a MIDI file into
File as single
the project, the whole file will be placed on a single track.
Part

Ö Project-specific settings (such as tempo) are not part
of the exported track archives.

Ignore Master- If this is activated and you import a MIDI file into the curtrack Events on rent project, tempo track data in the MIDI file is ignored.
Merge
The imported MIDI file will play according to the current
Tempo track in the project.
Auto Dissolve
Format 0

Ö For creating track presets from tracks, see “Track Presets” on page 327.

If this is activated and you import a MIDI file of type 0 into
the project, the file will automatically be “dissolved”: For
each embedded MIDI channel in the file, a separate track
will be inserted in the Project window.
If this is deactivated, only one MIDI track will be created.
This track will be set to MIDI Channel “Any”, allowing all
MIDI events to play back on their original channels. You
can also use the “Dissolve Part” function on the MIDI
menu to distribute the events onto different tracks with
different MIDI Channels at a later stage.

Exporting tracks as track archive
1. Select the tracks you wish to export.
2. Pull down the File menu and open the Export submenu.
3. On the submenu, select “Selected Tracks…”.
4. You are prompted to choose between two options:

Import to Instru- If this is activated and you drag a MIDI file into the
ment tracks
project, an Instrument track will be created instead of a
MIDI track. Furthermore, the program will load the corresponding track preset for the instrument track (based on
the program change events included in the MIDI file).

• Click Copy to include copies of the media files in the export.
A file dialog opens in which you can choose an existing empty folder or
create a new folder for saving the track archive (as *.xml file) and its media subfolder, which will contain any associated audio or video files.

• When you import a MIDI file into the project, the Tempo
track will be adjusted according to the Tempo track in the
MIDI file.

• Click Reference to include merely a reference to the
files in the export.
A file dialog opens in which you can choose an existing folder for saving
the track archive (as single *.xml file).

• It is also possible to import a MIDI file from disk by dragging and dropping it from the Windows Explorer or the
Mac OS Finder into the Nuendo Project window. The Import Options apply as well.

5. Click OK to save the respective track archive type.
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Importing tracks from a track archive

Sample rate conversion on track archive import

The Import Track Archive function lets you import tracks
exported from another Nuendo project.

A track archive may contain media files with a sample rate
that is different from the sample rate of your currently active project. You can see the sample rate difference in the
Project Settings area.

Ö Note that the sample rates of the active project and
the track archive have to match. If necessary, you have to
convert the sample rate, see below.

• To convert the sample rate of a track archive to the sample rate used in the active project on import, select the option “Copy Media To Project Folder” and then “Perform
Sample Rate Conversion”.

1. Pull down the File menu and open the Import submenu.
2. On the submenu, select “Track Archive…”.

Ö Unconverted files with another sample rate than the
one used in the project will play back at the wrong speed
and pitch.

3. In the file dialog that opens, select the XML file and
click Open.
The Import Options dialog opens.

Other Import/Export functions
• For exporting and importing Tempo tracks, see “Exporting and importing Tempo tracks” on page 419.
• Nuendo mixmaps from older Nuendo versions can be
imported into Nuendo. They will be converted into device
panels. For information on device panels, see the separate
PDF document “MIDI Devices”.

Cleanup
The Cleanup function on the File menu helps you to save
hard disk space by locating and – if you like – deleting unused audio files in the project folders on your disk.

In the Project Settings area, you can see a comparison between the
settings of the track archive and the active project.

4. In the Import Options dialog, click on the Import column to the left to select the desired track(s) or click “Select all Tracks”.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert shows. Clicking “Close” closes all
open projects and brings up the Cleanup dialog.

A check mark is shown for all selected tracks.

5. Choose which media files to use:

2. To restrict the Cleanup function to a certain folder only,
click the “Search Folder” button and select the folder.

• Select “Use Media Files From Archive” if you want to
import the track without copying the media files into your
project folder.

The default setting is that the Cleanup function is applied to all folders on
all hard disks. You should only select a specific folder if you are certain it
doesn’t contain audio files used in other projects (outside the folder), see
below. You can reset the function to search all folders by opening the
“Search Folder” dialog again and clicking “Cancel”.

• Select “Copy Media To Project Folder” if you want to
import the media files into your project folder.
For the option “Perform Sample Rate Conversion”, see below.

3. Click the Start button.

6. Click OK.

Nuendo will now scan the selected folder (or all hard disks) for Nuendo
project folders and check for audio and image files (in the Audio, Edits
and Images subfolders) that are not used by any project. The found files
are listed in the dialog.

The tracks are imported, complete with all contents and settings.
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4. When the scan is complete, you can select files by
clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of files. You can also click the Select All button to select all
files in the list.

In the following situations, the Cleanup function will list
files that are not unused:
• If you have moved or renamed files or folders (without updating the project files to use the new paths), there is no way for
Nuendo to know that these files are used in a project.
• If you perform the Cleanup function on a folder in which there
are audio files belonging to other projects (outside the folder),
these files will be considered “”.
• Also, make sure you don’t delete any files used in other
applications, or files that you generally want to keep!
However, you can always safely delete image files since
these can be reconstructed by the program, if necessary.
5. Delete any files you don’t want to keep by selecting
them and clicking Delete.
6. Close the dialog by clicking the Close button.
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39
Customizing

Background

Workspaces

The user can customize the appearance and functionality
of Nuendo in various ways.

A configuration of Nuendo windows is called a “workspace”. A workspace stores the size, position and content
of all windows, allowing you to quickly switch between different working modes via the menu or by using key commands. E.g., you may want as large a Project window as
possible when you are editing, whereas you may want the
Mixer and effect windows open during mixdown. Workspaces are listed and managed on the Workspaces submenu on the Windows menu.

User configurable items described in this chapter are:
• Workspaces
By storing different window combinations as workspaces, you can
quickly switch between different working modes – see “Workspaces” on
page 504.

• Setup dialogs
Several parts of the user interface (toolbars, Transport panel, Inspector,
info lines and channel settings windows) provide a Setup dialog, where
you can configure which items of the respective window area or panel
are to be shown or hidden and where they should be located – see “The
Setup dialogs” on page 506.

• Track list
The controls shown in the Track list can be set for each track type – see
“Customizing track controls” on page 507.

• Configuration of main menu items
You can hide items not needed on the main menus – see “Configuring
the main menu items” on page 509.

• Preferences presets

Editing the active workspace

You can save and recall preference settings as preference presets – see
“About preference presets” on page 510.

There is always one workspace active, even if you haven’t
saved any. To make changes to the active workspace, you
simply set up the windows as desired – including opening, closing, moving and sizing windows, and adjusting
zoom and track height. The changes are automatically
stored for the active workspace.

• Appearance
The general look of the program can be adjusted – see “Appearance” on
page 511.

• Track and event colors
You can adjust which colors should be used – see “Applying track and
event colors” on page 512.

• To keep a workspace from being accidentally changed,
select “Lock Active Workspace” from the Workspaces
submenu.

This chapter also contains a section describing where
your preferences and settings are stored (see “Where are
the settings stored?” on page 514), to help you transfer
your customized settings to another computer.

A locked workspace will keep its original window settings. You may
change the current window layout on the screen, but the next time you
select the workspace again, the originally stored layout will be recalled.
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Creating a new workspace

Organizing workspaces and presets

1. Pull down the Window menu and open the Workspaces submenu.

If you select “Organize…” from the Workspaces submenu, the Organize Workspaces dialog opens:

2. Select “New Workspace”.
3. In the dialog that opens, enter a name for the workspace.

4. Click OK.

The list to the left shows the workspaces in the active
project, while the list to the right shows the workspace presets. While workspaces are stored with each project, workspace presets can be stored globally, allowing you to set
up a number of workspaces for use in any project. Workspace presets store the position and size of the main windows only – project-specific windows are not included.

The workspace is stored and will appear on the submenu. It will now be
the active workspace.

5. Set up the windows you want to include in the new
workspace.
This may include opening, moving and sizing windows, and adjusting
zoom and track height.

• In the Workspaces list to the left, you can rename workspaces (by double-clicking and typing) and lock or unlock
them.

Activating a workspace
1. Pull down the Window menu and open the Workspaces submenu.
The windows are closed, opened, moved and/or resized according to the
stored workspace.

• The arrow buttons between the two lists allow you to
copy the selected workspace to a workspace preset, or
vice versa.

• You can also activate any of nine workspaces using key
commands.

• The buttons below each list let you add, remove or activate workspaces or presets.

2. Select the workspace from the list on the submenu.

You can also activate a workspace or a preset by double-clicking in its
number column.

This is set up under the Workspaces category in the Key Commands
dialog.

• Normally, when you use key commands to activate
workspaces, they relate to the order in the workspace list,
e.g. the key command for “Workspace 1” selects the first
workspace on the list and so on. However, if you activate
the Use IDs checkbox, you can enter a number (1-9) in the
ID column for each workspace.
This number will be used as reference when you are using key commands, so that the key command for “Workspace 1” recalls the workspace with ID 1.

• Workspace presets are saved with the project. By default the global presets are shown in the list to the right –
to see the presets of other projects, activate the Show
Project Presets checkbox.
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• Activate the Auto Instantiate Presets checkbox to convert all global workspace presets automatically into workspaces when you create a new project or open a project.
• To close the dialog, click the OK button or use [Esc].
Note that you can continue working in other windows with the Organize
Workspaces dialog open.

The Setup dialogs
You can customize the appearance of the following elements:
•
•
•
•
•

The info line and Inspector setup context menus. In the Inspector setup
context menu, the available options depend on the track type.

transport panel
info line
channel settings window
toolbars
Inspector

Customizing via the Setup dialog
If you select “Setup…” from the setup context menus, the
Setup dialog opens. This allows you to specify which elements should be visible/hidden and to set the order of the
elements. You can also save and recall setup presets in
this dialog.

Customizing via the setup context menus
If you right-click the Transport panel, the toolbars, the info
lines, or the Inspector, the respective setup context menu
opens. For channel settings windows, these options are
found in the dialog menu, on the Customize View submenu. On this menu, you can activate/deactivate elements
as desired.
The following general options are available on the setup
context menus:
• “Show All” makes all items visible.
• “Default” resets the interface to the default setting.
• “Setup…” opens the Setup dialog (see below).
If presets are available, they can be selected on the lower
half of the menu (e.g. “Status Fields Only” for the Transport panel).

The Setup dialog, e. g. for the Transport panel.

The dialog is divided into two columns. The left column
displays the currently visible items and the right column
displays the currently hidden items.
• You can change the current show/hide status by selecting items in one column and then using the arrow buttons in
the middle of the dialog to move them to the other column.
Changes are applied directly.
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• Click the arrow in the top left corner of the Track list and
select “Track Controls Settings”.

• By selecting items in the “Visible Items” column and using the Move Up and Move Down buttons, you can reorder
the selected item(s).
Changes are applied directly. To undo all changes and revert back to the
standard layout, select “Default” on the setup context menu.

A customized Transport panel.

• If you click the Save button (disk icon) in the Presets
section, a dialog opens, allowing you to name the current
configuration and to save it as a preset.
• To remove a preset, select it on the presets pop-up
menu and click the trash icon.
• Saved configurations are available for selection from the
Presets pop-up in the Setup dialog or directly from the
setup context menu.

Customizing track controls
You can configure (separately for each track type) which
track controls should be shown in the Track list. You can
also specify the order of controls and group controls so
that they are always shown adjacent to each other. This is
done using the Track Controls Settings dialog.

Setting the track type
The settings made in the Track Controls Settings dialog
apply to the selected track type (Marker, MIDI, Group/FX
Channel, Folder, Video, Instrument, Audio). If you rightclick an audio track to open the dialog, for example, the dialog automatically displays the settings for audio tracks.
The selected track type is shown in the menu display in
the top left corner of the dialog.

Opening the Track Controls Settings dialog
There are two ways to open the dialog:
• Right-click a track in the Track list and select “Track
Controls Settings” from the context menu.
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Grouping track controls

• To change the track type, click the arrow to the right in
the menu display and select a track type from the pop-up
menu that opens.

If you resize the Track list, the position of the controls will
change dynamically to accommodate as many controls as
possible in the available space (given that Wrap Controls is
activated – see below). By grouping several track controls
you ensure that they will always be positioned side by side
in the Track list. To group controls, proceed as follows:

All settings made in the dialog will apply to all tracks (current and subsequent) of the selected type.

1. Make sure you have selected the desired track type.
2. Select at least two controls you wish to group in the
Visible list.
You can only group controls that are adjacent to each other in the Visible
list. To group controls that are currently not adjacent in the list, use the
Move Up/Down buttons first.

3. Click Group.

The track type pop-up at the upper left of the Track Controls Settings
dialog.

A number is displayed in the Group column for the grouped controls. The
first group created will have the number 1, the second 2 and so on.

Ö Always make sure that you have selected the desired
track type when editing the track controls!

4. Click OK.
The controls are now grouped.

Removing, adding and moving track controls

• You can ungroup commands by using the Ungroup button. Please note that this will remove the selected element
and the elements below it in the list from this group. To remove an entire group, select the first (topmost) element
belonging to this group and click the Ungroup button.

The dialog is divided into two columns. The left column
displays controls currently visible on the Track list, and the
right column displays the controls currently hidden.
• You can hide controls from the Track list by selecting
them in the list to the left and clicking the Remove button.
To show hidden elements, select them in the list to the
right and click the Add button.

About Wrap Controls
This is activated by default. Wrap Controls is allows the
controls to be dynamically repositioned when resizing the
Track list. That is, as many controls as can fit in any given
space will be displayed depending on how you resize the
Track list.

Click OK to apply the changes.

Ö All controls can be removed except the Mute and Solo
buttons.
• By selecting controls in the “Visible” column and using
the Move Up and Move Down buttons, you can change
the order of the selected control(s) on the Track list.

If you deactivate Wrap Controls, the positions of the controls will be fixed, regardless of the size of the Track list. In
this mode, you may have to resize the tracks vertically (by
dragging the dividers between them) to display all the
controls.

Click OK to apply the changes.

About the Length column
The Length column in the Visible list allows you to set the
maximum length for certain text fields, e.g. Name. To
change the setting, click on the number in the Length column and type in a new value.
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Resetting Track list settings
You have two possibilities to reset settings:
• Click Reset to restore all default track controls settings
for the selected track type.
• Click Reset All to restore all default track controls settings for all track types.

Saving presets
You can save track controls settings as presets for later
recall:
1. Click on the Save icon beside the Presets name field.
A dialog opens, allowing you to type in a name for the preset.

2. Click OK to save the settings as a preset.
Saved presets are available for selection from the Presets pop-up and
from the pop-up at the top left corner of the Track list.

• To remove a preset, select it in the Track Controls Settings dialog and click the Delete icon beside the Presets
name field.

2. Click on the plus sign for a folder item, e.g. the File
folder.
As you can see, all commands and submenus on the File menu are listed
in the Name column.

Ö Nuendo comes with a number of track control settings
presets available.

Configuring the main menu items
!

Configuring the main menus is a feature intended for
experienced Nuendo users. Don’t hide menus or
menu items unless you are sure that you do not need
them!

You can configure what items should be shown on the
main menus and submenus, and even hide entire menus.
By customizing the menus you can hide items relating to
program functions you never use, to customize the program according to your needs. For example, if you never
use the Networking features in Nuendo, you can hide the
entire Network menu from view.
1. Open the Preferences dialog and select the Configuration page.

• In the Menu, column you can decide which File menu
items to hide from view, by clicking in the column beside
the corresponding menu item you wish to hide.

The Configuration page contains two parent folders; “Main Menu”, which
contains folders for all main menus, and “Command Categories” which
contains folders for all Command categories. This section will only describe how to configure Main Menu items, not Command Categories,
see “Turning Key Commands off” on page 519.

If you click the “On” item in the Menu column for an item, it changes to
“Off” and vice versa. All menu items set to “Off” will be hidden when you
click Apply or OK.
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About preference presets

• Certain essential menu items on the File and Edit menus
cannot be hidden, such as Save, Open, Close, Undo/
Redo etc.

It is possible to save complete or partial preferences settings as presets. This lets you recall settings quickly and
easily.

For these items there is no entry in the Menu column.

• If you set a main menu folder (as opposed to a menu
item) to Off in the Menu column, the entire menu will be
hidden from view.

Saving a preference preset

The exception to this is if the main menu folder contains non-removable
menu items, in which case all hideable items on the menu will be set to
Off, but the menu will still be visible.

When you have made your preferences settings, proceed
as follows to save all settings as a preset:
1. Make sure that the “Store marked preferences only”
option is not activated.

• The Command column sets the key command On/Off
status for the corresponding menu item.

This is because this option is used for saving partial settings (see below),
as opposed to complete settings.

If this is set to Off, any assigned key command for the item will be disabled (see “Turning Key Commands off” on page 519 for more information).

2. Click the Store button in the lower left section of the
Preferences dialog.

• You can save menu configurations as preference presets, either separately or together with other Preferences
dialog settings – see below.
3. By using the above methods, you can customize all
main menus to your liking.
To apply the changes without exiting the dialog click “Apply”. Click OK to
apply the changes and exit the dialog.

A dialog opens, allowing you to type in a name for the preset.

• To restore all menu items to their default setting (which
is visibility and key commands on for all menus and menu
items), click the Defaults button.

3. Click OK to save the preset.
Your saved settings will now be available from the Preference Presets
pop-up for your future projects.

Note that the Defaults button only restores the settings on the currently
selected page (the Configuration page in this case) to their default settings. If you have changed settings on another page of the Preferences
dialog, these are not reset.

Loading a preference preset
To load a saved preference preset, proceed as follows:
1. Open the Preferences dialog from the File menu (Win)/
Nuendo menu (Mac).
2. Select the saved preset from the Preference Presets
pop-up.
3. Click OK to apply the saved preset settings and exit
the Preferences dialog.
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Appearance

Saving partial preferences settings
It is also possible to save partial preferences settings. This
is useful when you have made settings that only relate to a
certain project or situation, for example. When you apply a
saved partial preference preset, you only change the saved
settings. All other preferences will be left unchanged.

In the Preferences dialog, you will find a page called Appearance. It contains three sub-pages on which you will
find the following settings:
General

When you have made your specific preferences settings,
proceed as follows to save the partial settings as a preset:

The three controls on the General page affect the appearance of the windows that surround the controls and workspaces in Nuendo.

1. Open the Preferences dialog.
2. Activate “Store marked preferences only”.

• Saturation determines how rich the background colors
are, from gray to blue.

A new “Store” column is added in the Preferences page list.

• Contrast determines how bright or dark the background
is in relation to controls and displays.
• Brightness lightens or darkens the background.
Meters
The coloring of meters in Nuendo can be controlled in sophisticated ways. Multiple colors can help to visually indicate what levels are being reached, e.g. in a channel of
the VST Mixer. To do this, the meter on the Appearances–
Meters page has color handles that allow you to define
what color the meter will have at a given signal level.

3. Click in the Store column of the Preferences items you
wish to save.
Note that if you activate a Preferences page that contains subpages,
these will also be activated automatically. If this is not what you want,
simply deactivated the subpages.

4. Click the Store button in the lower left section of the
Preferences dialog.
A dialog opens, allowing you to type in a name for the preset. It is a good
idea to choose a descriptive name for a partial preference preset, preferably relating to the saved settings (for example “Configuration” or “Editing-Controls”).

5. Click OK to save.
Your saved settings will now be available from the Preference Presets
pop-up for your future projects.

The Appearances–Meters page in the Preferences dialog.

• The default setting has four color handles. Each color
handle has a unique color that gradually shifts as the
meter moves toward the next color handle.
You can click on any color handle and move its position in the meter
scale. If you hold down [Shift] while moving the handle with the mouse, it
will move ten times slower for more precise positioning. You may also
nudge the color handle’s position with the Arrow Up/Down keys. Holding
Shift while nudging will move the color handle ten times faster.
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• You can add color handles by [Alt]/[Option]-clicking
anywhere along the side of the meter scale. To remove a
color handle, [Ctrl]/[Command]-click the handle.

Track colors

By adding more color handles to the meter scale, you can define colors
for more specific signal levels. Try adding two color handles very close to
one another. You can make the meter color change more rapidly at a
specific signal level this way.

To activate track colors, proceed as follows:

Applying track colors manually

1. Click the Show/Hide Track Colors button at the top of
the Track list.

• To change the color of a handle, select the handle by either clicking on it or by jumping to it with the Tab key (hold
down [Shift] and press the Tab key to jump backwards).
Then use the hue and brightness controls on the right side
to alter the handle’s color.
The currently selected color handle is indicated by a black triangle on its
left side.

This brings up the track color selector in the Inspector, the
Track list and in the Mixer.

Work Area

2. To bring up the color palette, click the track color selector.

The work areas in Nuendo are those places where the actual data are displayed such as the project window event
display. In these areas, there are items such as vertical
and horizontal grid lines that can be altered in intensity by
the controls found on this page.

Click the arrow in the track name title bar or…

Applying track and event colors
You can use color scheming for easier overview of tracks
and events in the Project window. Applying colors is divided into two areas; track and event colors.

…click the color strip in the Track list.

• A track color is shown and can be edited in the Inspector, the Track list, and the corresponding channel in the
Mixer. It is furthermore displayed in all parts and events for
the track in the event display.

In the Mixer, click the track color selector below the channel name.

3. Select a color from the color bar.

Track colors can be switched on and off globally.

The track color is now reflected in the Inspector title palette and the Track
list as well as in the Mixer and any parts and events on the selected track.

• Event colors are shown for parts and events in the event
display and are independent from the track colors.
Ö An applied event color “overrides” the track color, if
both are used.
The color palette can be customized, see “The Event Colors dialog” on page 514.
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Applying track colors automatically

Using the color tool

In the Preferences (Editing–Project & Mixer page), you
can find the option “Auto Track Color Mode”.

1. On the toolbar, select the color tool (the paint bucket
icon).

2. Click the small strip below it to bring up the color palette.
3. Select the desired color.
4. Click on a part/event to assign the color.

This offers you several options for automatically assigning
colors to tracks that are added to the project.
Option

Effect

Use Default
Event Color

The default color (gray) is assigned.

Use Previous
Track Color

Uses the color of the track above the new one (i.e. the
track that is selected when you add a new track).

The color is applied to all selected parts/events and overrides the track color (if used).
• If you press [Ctrl]/[Command] and click on a part/event
with the color tool, the color palette is displayed and you
can choose the desired color for an event.

Use Last
Applied Color

The last manually assigned color is used.

• If you press [Alt]/[Option], the color tool cursor becomes a pipette, which can be used to select a color by
clicking on a part/event.

Use Random
Track Color

Track colors are assigned randomly.

Customizing the event background

Use Previous
Uses the color next to the color of the track above the
Track Color +1 new one (+1 refers to the color number in the palette).

On the Event Display page in the Preferences, you can
find the option “Colorize Event Background”.

Coloring parts and events
There are two ways to color parts and events in the
Project window:
Using the color selector
1. Select the desired parts or events.
2. Choose a color from the color selector in the toolbar.

This option affects the display of events in the project window.
• When this is activated, the background of the events
and parts in the event display will be shown in the selected color.
• When this is deactivated, the event “content”, i.e. MIDI
events, audio waveforms, etc. will be displayed in the selected color and the event background will be displayed in
gray.
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The Event Colors dialog

3. In the Standard Colors section, select the standard
color. You can modify the selected color in the following
way:
• Drag the cursor to another point in the color circle.
• Movethe handle in the color meter.
• Enter the values for red, green and blue and hue, saturation
and luminosity manually.

You can open the Event Colors dialog in two ways:
• Double-click the small strip below the color tool.

4. Click the Apply button in the Standard Colors section.
The color setting is applied to the selected color item.

You can edit every existing event color in the same way.
• To delete an event color item, select it and click the
“Remove Selected Color” button in the Event Colors section.
• To increase or decrease the intensity and the brightness
of all colors, use the corresponding buttons in the Event
Colors section.
• To save the current set as default, click the button “This
set as default set” in the Event Colors section. You can
then click the button “Use default set” to the right to apply
the saved default set.
• To return to the standard setting of the palette in Nuendo, click Reset.
• Open the Color pop-up menu on the toolbar and select
“Select Colors…”.

Where are the settings stored?

In the Event Colors dialog, you can fully customize the
color palette, apart from the default color (gray).

As you have seen, there are a large number of ways in
which you can customize Nuendo. While some of the settings you make are stored in each project, others are
stored in separate preference files.

Increase/decrease
brightness for all colors

Insert
new color

Remove
new color

This Set as
Default Set

Use Default
Set

If you need to transfer your projects to another computer
(e.g. in another studio), you can bring all your settings
along by copying the desired preference files and installing them on the other computer.
Increase/decrease intensity for all colors

Ö It’s a good idea to make a backup copy of your preference files once you have set things up the way you want!

To add new colors to the color palette, proceed as follows:

This way, if another Nuendo user wants to use his or her personal settings when working on your computer, you can restore your own preferences afterwards.

1. Click the Insert New Color button in the Event Colors
section to add a new color.
A new color icon and color name are added to the Event Colors section.

2. Click the color field next to the name field to activate
the new color for editing.
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• Under Windows, preference files are stored in the
folder “\Documents and Settings\<user name>\Application Data\Steinberg\Nuendo 4\”.

Setting

Stored in

MIDI Inserts
presets

\Presets\MidiInsertsPresets
as *.xml file

If you run the 64 bit version of Nuendo, this folder is called “Nuendo
64bit”. On the Start menu, you will find a shortcut to this folder for easy
access.

Installed MIDI
devices

Midi Devices.bin

Key commands
presets

\Presets\KeyCommands\<Preset Name>.xml

• Under Mac OS X, preference files are stored in the
folder “Library/Preferences/Nuendo 4/” under your home
directory.

Logical Editor
presets

\Presets\Logical Edit\<Preset Name>.xml

Project Logical
Editor

\Presets\Logical Edit Project\<Preset Name>.xml

MediaBay
settings

MediaDefaults.xml

The full path would be: “/Users/<user name>/Library/Preferences/
Nuendo 4/”.

Ö The RAMpresets.xml file, which contains various presets settings (see below), is saved when exiting the program.

MediaBay default MediaFactoryDefaults.xml (these are applied on reset)
settings

Ö Program functions (e.g. crossfade) or configurations
(e.g. panels) not used in the project will not be stored.
Below, the available preferences files are listed. When
files are not saved in the default preferences folder (see
above), the complete path will be shown. When files are
saved in a further subfolder of the default folder, the path
will begin with the name of this folder:
Setting

Key Commands.xml
Defaults.xml

MediaBay –
Scanned disks

FileSysObserver.xml (When changing the file system
these disks are automatically scanned by the MediaBay
– Windows only.)

MediaBay
database

mediabay.db

MIDI FX presets

\Presets\<Plugin Name>\<Plugin Name>.xml

Mixer (or channel) saved in the last active folder as *.vmx file (VST Mixer
settings
settings)

Edit modifier keys Edit Modifiers.xml

Preferences
dialog settings

scannedfolders.bin

MediaBay Content ContentManager.xml

Stored in

Key commands

MediaBay –
Scanned folders

Mixer view
preset

saved in project

Panel files

\Panels\<device name><unique combination of letters
and numbers>.xml

Color setup

saved in the project

Default Color
setup

Defaults.xml

Preferences
Configuration

Configuration.xml

Crossfade
presets

Application folder\Presets\RAMPresets.xml

Patch name
scripts

\Scripts\Patchnames\ as *.txt file

Control Room –
Settings

\Presets\ControlRoomPresets.xml (pxml file)

Preferences
presets

\Presets\Configurations\<Preset Name>.xml

Quantize
presets

\Presets\RAMPresets.xml

Control Room – External Plugins.xml
External Plug-ins
Device setup
files

Score – Settings Score Setting Window.xml

Application folder\Device Maps
as *.xml file

Drum maps
Application folder\DrumMaps
(Nuendo Extension as *.drm file
Kit only)
EQ presets

Application folder\Presets\VstEqPresets.pxml

Port Input/
Output settings

Port Setup.xml

Audio Inserts
presets

\Presets\InsertsFolderPresets.pxml

Score –
Default font

Score Default Font.xml

Score – Custom
Palettes

Score Custom Palettes.xml

Score – Guitar
symbols

GuitarLib.xml

Score – Chord
symbols

\Presets\ChordSymbols.xml

Staff Presets

\Presets\Staff Presets as *.xml file
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Setting

Stored in

Note that the Score editor is only available for the Nuendo Expansion Kit.
Snapshot file

\Presets\MIDI snapshot<device name><unique combination of letters and numbers> as *.xml file

Toolbar presets

\Presets\RAMPresets.xml

Track controls
presets

\Presets\RAMPresets.xml

Track presets
(user-defined,
for all programs)

Win: \Documents and Settings\<user name>\Application Data\Steinberg\Track Presets
Mac: Users/<user name>/Library/Application Support/Steinberg/Track Presets
(with the subfolders \Audio, \Instrument, \Midi, \Multi)
as *.trackpreset file

Transport panel
presets

\Presets\RAMPresets.xml

Usage profile
log

Usage Profile.xml (only saved if the corresponding option in the Preferences is activated)

User templates

templates\<Template Name>.npr

VST connections \Presets\RAMPresets.xml
presets
VST 3 plug-ins
and instruments

VstPlugInfo.xml

VST 2 plug-ins
and instruments

Vst2xPlugins.xml

VST3 presets
(user-defined,
for all programs)

Win: \Common files\VST3 Presets\<company>\
<plug-in name>
Mac: Users/<user name>/Library/Audio/Presets/
<company>/<plug-in name>
as *.vstpreset file

VST3 presets
Win: \Documents and Settings\VST3 Presets\<com(public, for all pro- pany>\<plug-in name>
grams)
Mac: /Library/Audio/Presets/<company>/<plug-in
name>
as *.vstpreset file
Workspaces

saved in project

Workspace presets (global)

Window Layouts.xml

Zoom presets

\Presets\RAMPresets.xml

Networking

Network Manager.xml

Networking –
Permissions

User Permissions.xml

Quick Control
Settings

Quick Controls MIDI.xml
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40
Key commands

Introduction

Adding or modifying a key command

Most of the main menus in Nuendo have key command
shortcuts for certain items on the menus. In addition, there
are numerous other Nuendo functions that can be performed via key commands. These are all default settings. If
you want, you can customize existing key commands to
your liking, and also add commands for menu items and
functions currently not assigned any.
!

You can also assign tool modifier keys, i.e. keys that
change the behavior of various tools when pressed.
This is done in the Preferences dialog – see “Setting
up tool modifier keys” on page 524.

How are key commands settings saved?
Every time you edit or add any key command assignment,
this is stored as a global Nuendo preference – not as part
of a project. Hence, if you edit or add a key command assignment, any subsequent projects that you create or
open will use these modified settings. However, the default settings can be restored at any time by clicking the
button “Reset All” in the Key Commands dialog.

In the Key Commands dialog you will find all main menu
items and a large number of other functions, arranged in a
hierarchical way similar to the Windows Explorer and Mac
OS Finder. The function categories are represented by a
number of folders, each containing various menu items and
functions. When you open a category folder by clicking the
plus-sign beside it, the items and functions it contains are
displayed with the currently assigned key commands.

In addition, you can save complete or partial key commands settings as a “key commands file”, which is stored
separately and can be imported into any project. This way
you can quickly and easily recall customized settings,
when moving projects between different computers, for
example. The settings are saved in a file on disk with the
windows extension “.xml”.

To add a key command, proceed as follows:

How to save key commands settings is described in the
section “Saving complete key commands settings as presets” on page 521.

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to
the desired category.

Setting up key commands

3. Click the plus-sign to open the category folder and
display the items it contains.

The following is a description of how you set up key commands and save them as presets for easy access.

Note that you can also click the “global” plus and minus-signs in the top
left corner to open and close all category folders at once.

Key commands settings are accessed and edited mainly
in the Key Commands dialog. You can find some key command settings in the Preferences dialog as well, also addressed in this chapter.

518
Key commands

4. In the list, select the item to which you wish to assign a
key command.

Note that you can have several different key commands for
the same function. So adding a key command to a function
that already has another key command will not replace the
key command previously defined for the function. If you
wish to remove an assigned key command, see “Removing
a key command” on page 520.

Already assigned key commands are shown in the Keys column as well
as in the Keys section in the top right corner.

9. Click OK to exit the dialog.
Turning Key Commands off
Nuendo also gives you the option of turning key commands off, meaning that even if a function has a key command assigned to it, you can disable the key command.
This is done in the Preferences dialog, in the following
way:
If a selected item or function has a key command
assigned already, it is displayed here…

1. Open the Preferences dialog from the File menu (under Mac OS X it is located on the Nuendo menu) and select the Configuration page.

…and here.

5. Alternatively, you can use the search function in the
dialog to find the desired item.

As you can see, the Configuration page contains two main folders; “Main
Menu” and “Command Categories”.

For a description of how to use the search function, see “Searching for
key commands” on page 520.

6. When you have found and selected the desired item,
click in the “Type in Key” field and enter a new key command.
You can choose between any single key or a combination of one or several keys ([Alt]/[Option], [Ctrl]/[Command], [Shift]) plus any key. Just
press the keys you want to use.

7. If the key command you entered is already assigned to
another item or function, this is displayed below the “Type
in Key” field.

If a key command already is assigned to another function, you can either
ignore this and proceed to assign the key command to the new function
instead, or you can select another key command.

• The “Main Menu” folder contains a number of subfolders,
which in turn each contains items found on the main menus in
Nuendo.
• The “Command Categories” folder also contains a number of
subfolders, each of which contains a number of program functions not available on any of the main menus.

8. Click the Assign button above the field.
The new key command appears in the Keys List.
!

If the key command you enter is already assigned to
another function, you will get a warning message
asking if you want to reassign the command to the
new function instead, or cancel the operation.
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Removing a key command

All the items and functions in the subfolders can have key
commands assigned to them. The column to the right, labeled “Command”, allows you to set the On/Off status for
the corresponding items. This indicates whether it should
be possible to use assigned key commands for the items
or not.

To remove a key command, proceed as follows:
1. If the key commands dialog isn’t already open, pull
down the File menu and select “Key Commands…”.
2. Use the list of categories and commands to select the
item or function for which you wish to remove a key command.

2. Click on the plus sign beside one of the main folders
to open it and list the subfolders it contains.

The key command for the item is shown in the Keys list and the Keys
column.

3. Open the desired subfolder by clicking its plus sign,
navigate to the item for which you want to disable the assigned key command, and select it.

3. Select the key command in the Keys list and click the
Remove button (the trash icon).

4. Click in the “Command” column beside the item to set
the status to “Off”.

You will get a prompt asking if you want to remove the key command or
cancel the operation.

Now it will not be possible to use any key command assigned to that
menu item or function.

4. Click Remove to remove the selected key command.
5. Click OK to close the dialog.

5. Repeat this for all items or functions for which you
want to disable key commands.

Setting up macros

Ö Note that if you set an entire subfolder to “Off” in this
way, all the items or functions it contains will automatically
be set to “Off” as well.

A macro is a combination of several functions or commands, to be performed in one go. For example, you could
select all events on the selected audio track, remove DC
offset, normalize the events and duplicate them, all with a
single command.

If this is not what you want, you can reset separate items in the subfolder
to “On”.

6. When you’re done, click OK to close the Preferences
dialog and apply the changes.

Macros are set up in the Key Commands dialog as follows:
1. Click the Show Macros button.

Searching for key commands

The macro settings are shown in the lower part of the dialog. To hide
these from view, click the button (now renamed to Hide Macros) again.

If you want to know which key command is assigned to a
certain function in the program, you can use the Search
function in the Key Commands dialog:

2. Click New Macro.
A new, unnamed macro appears in the Macros list. Name it by typing the
desired name. You can rename a macro at any time by selecting it in the
list and typing in a new name.

1. Click in the search text field at the top left of the dialog
and type in the function for which you want to know the key
command.

3. Make sure the macro is selected, and use the Categories and Commands in the upper half of the dialog to select the first command you want to include in the macro.

This is a standard word search function, so you should type the command
as it is spelled in the program. Partial words can be used; e.g., to search
for all quantize related commands, type “Quantize”, “Quant”, etc.

4. Click Add Command.

2. Click the Search button (the magnifying glass icon).

The selected command appears in the list of Commands in the Macros
section.

The search is conducted and the first matching command is selected
and displayed in the commands list below. The keys column and the keys
list show the assigned key commands, if any.

3. To search for more commands containing the word(s)
you entered, click the Search button again.
4. When you’re done, click OK to close the dialog.
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Saving complete key commands settings as
presets

5. Repeat the procedure to add more commands to the
macro.
Note that commands are added after the currently selected command in
the list. This allows you to insert commands “in the middle” of an existing
macro.

As mentioned above, any changes made to the key commands (and macros) are automatically stored as a Nuendo
preference. However, it is also possible to store key commands settings separately. This way, you can store any
number of different key command settings, complete or
partial, as presets for instant recall.
Proceed as follows:
1. Set up the key commands and macros to your liking.
When setting up key commands, remember to click “Assign” to make the
changes.

2. Make sure that “Store Selected Items Only” is not activated.

A macro with three commands.

This option is for saving partial key commands settings only (see below).

• To remove a command from the macro, select it in the
Macros list and click Delete.

3. Click the Save button next to the Presets pop-up
menu.

• Similarly, to remove an entire macro, select it in the
Macros list and click Delete.

A dialog appears, allowing you to type in a name for the preset.

After you have closed the Key Commands dialog, all macros you have created appear at the bottom of the Edit menu
in the Macros submenu, available for instant selection.
4. Click OK to save the preset.
Your saved key commands settings will now be available in the Preset
pop-up menu for your future projects.

Saving partial key commands settings
It is also possible to save partial key commands settings.
This is useful for example if you have made settings that
only relate to a specific project or settings that you wish to
apply only in certain situations. When you apply a saved
partial preset you only change the specific saved settings,
while all other key commands settings will be left unchanged.

You can also assign key commands to macros. All macros
you have created appear in the upper section of the Key
Commands dialog under the Macros category – just select a macro and assign a key command as with any other
function.
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Loading saved key command settings

When you have set up the key commands and macros,
proceed as follows to save the partial settings as a preset:

To load a key command preset, simply select it from the
Presets pop-up menu.

1. Activate the “Store Selected Items Only” option.
When this is activated, a new “Store” column appears in the Commands
list.

Ö Note that this operation may replace existing key commands!
The key command settings you load will replace the current key command
settings for the same functions (if any). If you have macros of the same
name as those stored in the preset you load, these will be replaced too.
If you want to be able to revert to your current settings again, make sure to
save them first, as described above!

Loading saved key commands settings from earlier
versions of Nuendo
If you have saved key commands settings with a previous
version of Nuendo, it is possible to use them in Nuendo 4,
by using the “Import Key Command File” function, which
lets you load and apply saved key commands or macros:
1. Open the Key Commands dialog.
2. Click the “Import Key Command File” button to the
right of the Presets pop-up menu.
A standard file dialog opens.

2. Click in the Store column for the key commands items
you wish to save.
Note that if you check an entire category folder (as opposed to separate
commands) all commands it contains will automatically also be selected.
If this is not what you want, deselect the commands you don’t want to include.

3. In the file dialog, use the “Files of type:” pop-up to
specify if you want to import a key commands file (Windows file extension “.key”) or a macro commands file (extension “.mac”).

3. Click the Save button (the disk icon) next to the Presets pop-up menu.

Key commands files included any macro settings and were saved with
the file extension “.xml”. When you have imported an older file, you might
want to save it as a preset (see “Saving complete key commands settings as presets” on page 521) to be able to access it from the Presets
pop-up menu in the future.

A dialog appears, allowing you to type in a name for the Preset.

4. Click OK to save.
Your saved key commands settings will now be available from the Preset
pop-up menu for your future projects.

4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply
the imported settings.
The settings in the loaded key commands or macros file now replace the
current settings.

522
Key commands

About the “Reset” and “Reset All” functions

Saving an Alternative Key Set
Here’s how to create and save an Alternative Key Set:
1. Open the Key Commands dialog from the File menu.
2. Set up the key commands and macros the way you
want them.

These two buttons in the Key Commands dialog will both
restore the default settings. The following rules apply:

3. Decide whether you want to save complete or partial
settings by activating/deactivating “Store Selected Items
Only”.

• “Reset” restores the default key command setting for
the function selected in the Commands list.
• “Reset All” will restore the default key commands for all
commands.
!

4. Click the Store Alternative Set button (the disk icon) in
the Alternative Key Sets section.
A dialog appears, allowing you to type in a name for the Preset.

Note that the “Reset All” operation will cause any
changes made to the default key commands to be
lost! If you want to be able to revert to these settings
again, make sure to save them first!

About the default key commands
As mentioned before, there are numerous default key
commands. These are listed in the section “The default
key commands” on page 524.

5. Type in a name for the key set and click OK to save it.
The saved key set appears in the list of alternative key sets.

Editing an Alternative Key Set

Using Alternative Key Sets

To edit a saved key set, proceed as follows:

As an alternative to saving and loading key commands
settings as previously described, you can set up and save
“alternative key sets”. This allows you to switch between
different key commands settings “on the fly” while you are
working in the program, instead of having to go into the
Key Commands dialog to change them.

1. Select the key set in the list and click the “Open” button (the folder icon) in the Alternative Key Sets section.
The key set is now activated, and the key commands settings are
changed accordingly.

2. Make the desired changes.

About the preset Alternative Key Sets

3. Click the Store Alternative Set button (the disk icon) in
the Alternative Key Sets section.

By default, Nuendo contains two different key sets:

The key set is saved with the updated settings.

• “Markers” is actually not an alternative key set, but rather the
default key set that you can switch back to at any time (see
below).
• “Shuttle” is a specialized, alternative key set containing key
commands settings for all of the Transport panel’s Shuttle
controls.

Removing a saved Alternative Key Set
• To remove a saved key set, select it in the list and click
the “Remove” button (the trash icon) in the Alternative Key
Sets section.
A dialog appears asking if you want to remove the key set or cancel the
operation.

You could edit and save these under the same names to
replace them with your own settings should you so wish,
but it is advised that you instead create additional key sets
for your specific needs.
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Switching between Alternative Key Sets

3. Select the action in the Action list.

You switch between different key sets in the program by
using the key command assigned to the function “Toggle
Alternate Key Commands”, located in the “File” subfolder
in the Key Commands dialog.

4. Hold down the desired modifier key(s) and click the
Assign button.
The current modifier key(s) for the action is replaced. If the modifier
key(s) you pressed are already assigned to another tool, you will be
asked whether you want to overwrite them. If you do, this will leave the
other tool without any modifier key(s) assigned.

The key command for this function is by default [F5], but
you can of course change this to any key command that
suits you best. See “Adding or modifying a key command”
on page 518 for instructions on how to change key commands.

5. When you’re done, click OK to apply the changes and
close the dialog.

The default key commands

• When you press the key command for the function, a
small pop-up appears, indicating which key set is currently
loaded.

Below, the default key commands are listed according to
category.

• Each time you press the key command, you switch to
the next available alternative key set.

• As described in the section “Key command conventions”
on page 9, modifier keys are written as:
[Win modifier key]/[Mac modifier key].

Setting up tool modifier keys

For example, “[Ctrl]/[Command]+[N]” in the list below means
“press [Ctrl] under Windows or [Command] under Mac OS X,
then press [N]”.

A tool modifier key is a key you can press to get an alternate function when using a tool. For example, clicking and
dragging an event with the Arrow tool normally moves it –
holding down a modifier key (by default [Alt]/[Option]) will
copy it instead.

• Note that it is possible to switch key commands for
menu items and other functions on and off.
This is done in the Preferences dialog–Configuration page. If you disable
a key command by switching it off, it will not be possible to invoke the
corresponding menu item or function with the key command. See “Customizing” on page 503.

The default assignments for tool modifier keys can be
found in the Preferences (Editing–Tool Modifiers page).
Here, you can also edit them:

Audio category

1. Open the Preferences dialog from the File menu (on
the Mac, this is located on the Nuendo menu) and select
the Editing–Tool Modifiers page.

Option

Key command

Adjust Fades to Range

[A]

Crossfade

[X]

Find Selected in Pool

[Ctrl]/[Command]+[F]

Automation category
Option

Key command

Toggle Read Enable All Tracks

[Alt]/[Option]+[R]

Toggle Write Enable All Tracks

[Alt]/[Option]+[W]

2. Select an option in the Categories list, and locate the
action for which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category
“Drag & Drop”.
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Devices category

Option

Key command

Key command

Solo

[S]

Mixer

[F3]

Split At Cursor

[Alt]/[Option]+[X]

Video

[F8]

Split Range

[Shift]+[X]

VST Connections

[F4]

Undo

[Ctrl]/[Command]+[Z]

VST Instruments

[F11]

Ungroup

[Ctrl]/[Command]+[U]

[F12]

Unlock

[Ctrl]/[Command]+[Shift]+[U]

Unmute Events

[Shift]+[U]

Option

VST Performance

Edit category
Editors category

Option

Key command

Autoscroll

[F]

Option

Key command

Copy

[Ctrl]/[Command]+[C]

Show/Hide Infoview

[Ctrl]/[Command]+[I]

Cut

[Ctrl]/[Command]+[X]

Show/Hide Inspector

[Alt]/[Option]+[I]

[Ctrl]/[Command]+[Shift]+[X]

Show/Hide Overview

[Alt]/[Option]+[O]

Cut Time
Delete

[Del] or [Backspace]

Delete Time

[Shift]+[Backspace]

Duplicate

[Ctrl]/[Command]+[D]

Option

Key command

Edit In-place

[Ctrl]/[Command]+[Shift]+[I]

Close

[Ctrl]/[Command]+[W]

Group

[Ctrl]/[Command]+[G]

New

[Ctrl]/[Command]+[N]

Insert Silence

[Ctrl]/[Command]+[Shift]+[E]

Open

[Ctrl]/[Command]+[O]

Left Selection Side to Cursor

[E]

Quit

[Ctrl]/[Command]+[Q]

Lock

[Ctrl]/[Command]+[Shift]+[L]

Save

[Ctrl]/[Command]+[S]

Move to Cursor

[Ctrl]/[Command]+[L]

Save As

[Ctrl]/[Command]+[Shift]+[S]

Mute

[M]

Save New Version

[Ctrl]/[Command]+[Alt]/[Option]+[S]

Mute Events

[Shift]+[M]

Toggle Alternate Key Commands

[#]

File category

Mute/Unmute Objects

[Alt]/[Option]+[M]

Open Default Editor

[Ctrl]/[Command]+[E]

Media category

Open Score Editor
(Nuendo Expansion Kit only)

[Ctrl]/[Command]+[R]

Option

Key command

Open MediaBay

[F5]

Open/Close Editor

[Return]

Open Loop Browser

[F6]

Paste

[Ctrl]/[Command]+[V]

Open Sound Browser

[F7]

Paste at Origin

[Alt]/[Option]+[V]

Paste Time

[Ctrl]/[Command]+[Shift]+[V]

Record Enable

[R]

Redo

[Ctrl]/[Command]+[Shift]+[Z]

Repeat

[Ctrl]/[Command]+[K]

Right Selection Side to Cursor

[D]

Select All

[Ctrl]/[Command]+[A]

Select None

[Ctrl]/[Command]+[Shift]+[A]

Snap On/Off

[J]

MIDI category
Option

Key command

Quantize

[Q]

525
Key commands

Navigate category

Project category

Option

Key command

Option

Add Down:
Expand/Undo selection in the
Project window to the bottom/
Move selected event in the
Key Editor down 1 octave

[Shift]+[Down Arrow]

Open Browser

[Ctrl]/[Command]+[B]

Open Markers

[Ctrl]/[Command]+[M]

Open/Close Pool

[Ctrl]/[Command]+[P]

Open Tempo Track

[Ctrl]/[Command]+[T]

Add Left:
Expand/Undo selection in the
Project window/
Key Editor to the left

[Shift]+[Left Arrow]

Add Right:
Expand/Undo selection in the
Project window/
Key Editor to the right

[Shift]+[Right Arrow]

Add Up:
Expand/Undo selection in the
Project window to the top/
Move selected event in the Key
Editor up one octave

[Shift]+[Up Arrow]

Setup

[Shift]+[S]

Show/Hide Track Colors

[Shift]+[C]

Score Functions category
Option

Key command

Insert Voice: Next

[Alt]/[Option]+Pad[+]

Insert Voice: Previous

[Alt]/[Option]+Pad[-]

Tool category

Down:
[Down Arrow]
Select next in the Project window/
Move selected event in the Key Editor one semitone down
Left:
Select next in the Project window/
Key Editor

[Left Arrow]

Right:
Select next in the Project window/
Key Editor

[Right Arrow]

Up:
Select next in the Project window/
Move selected event in the
Key Editor one semitone up

[Up Arrow]

Bottom
[End]
Select bottom track in the track list
Top:
Select top track in the track list

[Home]

Option

Key command

Delete tool

[5]

Draw tool

[8]

Drumstick tool
(Nuendo Expansion Kit only)

[0]

Glue tool

[4]

Mute tool

[7]

Next Tool

[F10]

Play tool

[9]

Previous Tool

[F9]

Range tool

[2]

Select tool

[1]

Split tool

[3]

Zoom tool

[6]

Nudge category
Option

Key command

Key command

End Left

[Alt]/[Option]+[Shift]+[Left Arrow]

End Right

[Alt]/[Option]+[Shift]+[Right Arrow]

Left

[Ctrl]/[Command]+[Left Arrow]

Right

[Ctrl]/[Command]+[Right Arrow]

Start Left

[Alt]/[Option]+[Left Arrow]

Start Right

[Alt]/[Option]+[Right Arrow]
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Transport category

Option

Key command

Key command

To Left Locator

Pad [1]

AutoPunch In

[I]

To Marker 1

[Shift]+[1]

AutoPunch Out

[O]

To Marker 2

[Shift]+[2]

Cycle

Pad [/]

To Marker 3 to 9

Pad [3] to [9] or [Shift]+[3] to [9]

Exchange time formats

[.]

To Right Locator

Pad [2]

Fast Forward

[Shift]+Pad [+]

Use External Sync

[T]

Fast Rewind

[Shift]+Pad [-]

Forward

Pad [+]

Input Left Locator

[Shift]+[L]

Option

Key command

Input Position

[Shift]+[P]

Lock/Unlock Active Workspace

[Alt]/[Option]+Pad [0]

Input Right Locator

[Shift]+[R]

New

[Ctrl]/[Command]+Pad [0]

Input Tempo

[Shift]+[T]

Organize

[W]

Insert Marker

[Insert] (Win)

Workspace 1-9

[Alt]/[Option]+Pad [1-9]

Option

Workspace category

Locate Next Event

[N]

Locate Next Marker

[Shift]+[N]

Zoom category

Locate Previous Event

[B]

Option

Key command

Locate Previous Marker

[Shift]+[B]

Zoom Full

[Shift]+[F]

Locate Selection

[L]

Zoom In

[H]

Zoom In Tracks

[Alt]/[Option]+[Down Arrow]

Locators to Selection
Loop Selection

[P]
[Shift]+[G]

Zoom Out

[G]

Zoom Out Tracks

[Alt]/[Option]+[Up Arrow] or
[Ctrl]/[Command]+[Up Arrow]
[Shift]+[E]

Metronome On

[C]

Nudge Down

[Ctrl]/[Command]+Pad [-]

Zoom to Event

Nudge Up

[Ctrl]/[Command]+Pad [+]

Zoom to Selection

[Alt]/[Option]+[S]

Panel (Transport panel)

[F2]

Zoom Tracks Exclusive

Play Selection Range

[Alt]/[Option]+[Space]

[Z] or [Ctrl]/[Command]+
[Down Arrow]

Recall Cycle Marker 1 to 9

[Shift]+Pad [1] to Pad [9]

Record

Pad [*]

Retrospective Record

[Shift]+Pad [*]

Return to Zero

Pad [.] or Pad [,]

Rewind

Pad [-]

Set Left Locator

[Ctrl]/[Command]+Pad [1]

Set Marker 1

[Ctrl]/[Command]+[1]

Set Marker 2

[Ctrl]/[Command]+[2]

Set Marker 3 to 9

[Ctrl]/[Command]+Pad [3] to [9] or
[Ctrl]/[Command]+ [3] to [9]

Set Right Locator

[Ctrl]/[Command]+Pad [2]

Start

[Enter]

Start/Stop

[Space]

Stop

Pad [0]
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Index

A
AAF files 495
ACID® loops 275
Activate Next/Previous Part 365
Activate project button 487
Active ASIO Ports for Data only 464
Active Part 365
Add Bus 13
Child Bus 13
Add Track 38
Adjust Fades to Range 88
Advanced Quantize 356
AES31 files 496
Aftertouch
Deleting 381
Editing 379
Recording 81
AIFF files 439
Allow machine controlled cycle 458
Alt/Option key 9
Alternative Key Sets 523
Always Send Start Message 449
Angle Mode 209
Any (MIDI channel settings) 79
Apogee UV22 HR 174
APP
Introduction to 452
Setting up 451
Appearance 511
General 511
Meters 511
Applying effects 249
Archiving 309
Arranger track
Adding 99
Creating a chain 100
Flattening 102
Renaming events 99
ASIO 2.0 72
ASIO Direct Monitoring 72
ASIO Positioning Protocol
Introduction to 452
Setting up 451
Attenuate (Surround Panner) 211

Audio channels
Copying settings 141
Linking 145
Making settings for 137
Mixing down to file 438
Saving settings 146
Audio clips
About 239
Creating new versions 301
Definition 24
Deleting 302
Locating events 303
Managing in Pool 300
Opening in the Sample Editor 306
Audio effects
About 169
Applying 249
Automating 234
Editing 182
External 182
For output busses (Master
inserts) 173
Freezing 175
In surround configurations 212
Inserts 170
Organizing in subfolders 186
Post-fader inserts 170
Pre/Post-fader sends 178
Recording with 76
Saving 184
Selecting Presets 183, 198
Sends 177
Tempo sync 170
Using VST System Link 467
Audio events
Blue handles 87
Definition 24
Editing in Browser 430
Editing in Sample Editor 259
Fade handles 87
Making selections in 267
Slicing 283
Volume handles 88
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Audio files
Converting 310
Deleting permanently 302
Exporting 438
Format for recording 67
Formats 307
Import options 41
Importing into Pool 306
Importing into Project window 41
Locating missing 305
Reconstructing missing 305
Removing missing 305
Audio loops
Tempo matching 272, 277
Audio parts
About 23
Creating by gluing events 48
Creating from events 42
Drawing 42
Editing in Audio Part Editor 291
Editing in Project Browser 430
Sliding contents 49
Audio playback speed
Adjusting 478
Audio pre-record 67
Audio Warp
Realtime pitch-shifting 288
Unstretch Audio 287
Audition icon
Sample Editor 265
Auditioning
Audio Part Editor 293
MIDI editors 370
Project window 42
Sample Editor 265
Auto Edit (Button) 459
Auto Fades 96
Auto Monitoring modes 71
Auto Quantize 79
Auto Save 489
Auto Select Events under Cursor
MIDI editors 372
Project window 43
Automatic MIDI Record Quantize 79

Automation
Auto-Latch mode 220
Crossover mode 220
Delta indicator 216
Editing in Project Browser 432
Gap 218
Opening automation
subtracks 231
Return Time 229
Showing and hiding 231
Touch mode 220
Touch-collecting parameters 225
Trim 224
Automation events
About 235
Drawing 235
Editing 235
Editing in the Project Browser 237
Removing 237
Selecting 237
Automation follows Events
(Option) 234
Automation pass 215
Automation subtracks
Assigning parameters to 232
Hiding and showing 233
Muting 234
Autoscroll 57, 369

B
Backup (.bak) files 489
Bars+Beats Linear
MIDI editors 367
Tempo Track Editor 416
Beat Calculator 421
Bounce (Export Audio) 438
Bounce Selection
Pool 308
Project window 51
Sample Editor 269
Brightness 511
Broadcast Wave files
Exporting 441
Recording 67
Browser 429

Busses
About 11
Adding 13
Mixing down to file 438
Routing to and from 14
Viewing in the mixer 15
Bypass
Effect sends 178
Inserts 171

C
Calculate (Hitpoints) 279
Channel (MIDI) 77
Channel Overview
EQ 140
Insert effects 172
Channel setting
MIDI 79
Channel Settings
Audio tracks 137
Copying 141
MIDI tracks 144
Channel Settings windows
Customizing 506
Channel view sets 129
Chase 63
Child Bus 13
Chord Recognition 367
Cleanup 491, 501
Click 83
Clips, see “Audio clips”
Close Gaps 284
Close project 487
Color pop-up menu
MIDI editors 370
Project window 39
Color tool 39
Colorize Event Background 37
Configuring Studio Sends 163
Configuring the Control Room
Mixer 156
Conform Files 310
Constrain Delay Compensation 200
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Control Room
About 152
Channels 153
Configuring 153
Creating a Channel 154
Features 152
Mixer 156
Operations 158
Overview 156
Preferences 162
Settings 162
Controller display
About 368
Adding and removing lanes 377
Controller lane presets 377
Editing events 379
Editing velocity 378
Selecting event type 377
Controllers
Deleting 381
Editing 379
Lane Editing 378, 380
Recording 81
Convert Files 310
Convert to Real Copy 46
Converting MIDI to CC track
automation 362
Count-in 83
Cpr files 487
Create Audio Images During
Record 72
Create events 284
Create events (Cycle Rec Mode) 74
Create Groove Quantize 283
Create MIDI track when loading
VSTi 190
Create new controller lane 377
Create Regions (Cycle Rec Mode) 74
Create slices 283
Crop 55
Crossfades
Creating 91
Editing in dialog 92
Presets 95
Removing 91
Simple Crossfade Editor 92

Csh files 309
Ctrl/Command key 9
Cursor, see “Project cursor”
Cut Head 47
Cut Tail 47
Cut Time 54
Cycle
About 61
About recording 66
Record modes 80
Recording audio 73
Recording MIDI 80
Cycle markers
About 110
Adding in Marker window 110
Drawing 112
Editing 112
Making selections with 113
Navigating to 112
On Marker track 111

D
DC Offset 247
Deactivate
Inserts 171
Deactivate plug-in when silence is
detected (VST 3) 169, 196
Deactivate Punch In on Stop 83
Default MIDI editor 364
Default Output Bus 14
Default template 488
Default Track Time Type 40
Delay compensation
About 170
Constraining 200
Delete
Audio files from disk 302
Events in Project window 51
MIDI controllers 360, 381
MIDI notes 375
Delete Continuous Controllers 360
Delete Controllers function 360
Delete Doubles function 360
Delete Notes function 360

Delete Overlaps
Audio 52, 75
Mono (MIDI) 361
Poly (MIDI) 361
Delete Time 54
Detect Silence 254
Device Panels 27, 136
Device Ports
Selecting for busses 13
Setting up 12
DirecShow Video 470
DirectX Video 470
Disable Hitpoints 281
Disable sends 178
Disable Track 62
Display format 31
Dissolve Part
Audio 42
MIDI 359
Dithering 173
Dividing the Track list 40
Drag Delay 44
Drag&drop Inserts
Automation 235
Sidechain 182
Draw
Hitpoints 282
In Sample Editor 271
Markers 112
MIDI controllers 379
MIDI notes 371
Parts 42
Drop Out Frames 454
Duplicate
Events and parts 46
MIDI notes 373
Duplicate tracks 39

E
Edit Active Part Only 365
Edit button
Audio channel strips 137
Audio track Inspector 27
MIDI channel strips 144
MIDI track Inspector 344
Edit In-Place 381
Edit Mode 474

531
Index

Edit warp 285
Editing via MIDI 375
Edits folder 239
Effect Return channels 179
Effects, see “Audio effects” or “MIDI
effects”
Elements (Sample Editor) 260
Enable Record on Selected Track 65
Enable Solo on Selected Track 51
Enable Track 62
Enlarge Selected Track 35
Envelope
Process 242
Real-time 97
EQ
Bypassing 139
Presets 140
Setting 138
Equal Pitch (Selection) 372
Eraser tool 51
Event as Region 55
Events
Aligning 45
Audio 24
Color 39
Duplicating 46
Envelopes 97
Grouping 49
Locking 50
Moving 44
Muting 51
Overlapping in audio part 292
Overlapping in Project window 44
Removing 51
Renaming 47
Renaming all on track 38
Resizing 48
Resizing with time stretch 49
Selecting 43
Sliding contents 49
Splitting 47
Events (Snap mode) 56
Events from Regions 55
Events to Part 42
Exclusive Solo 134

Export
AAF 495
AES31 496
OMF 494
OpenTL file 497
Export Audio Mixdown 438
Export MIDI files 498
Export Options (MIDI files) 499
Export selected tracks 500
Export Tempo track 419
External Effects 182
External effects
About 17
Favorites 20
Freezing 21
Missing plug-ins 21
Setting up 18
External Inputs (Control Room
Channel) 153, 154, 157
External instruments
About 17
Favorites 20
Freezing 21
Missing plug-ins 21
Setting up 19
Extract Audio from Video 472, 493
Extract MIDI Automation 362

Find Selected in Pool 303
FireWire 473
Fixed Lengths 360
Fixed tempo 415
Fixed Velocity 362
Folder parts 107
Folder tracks
About 106
Moving tracks into 106
Muting and soloing 107
Frame offset 473
Frame rate
About 476
Get From Video 472
Setting 448
Free Warp 285
Freeze Edits 253
Freeze Quantize 356
Freeze Tracks 175
Freeze VST Instruments 195
FX channel tracks
About 175
Adding effects for 176
Mixing down to file 438
Routing sends to 177
Setting up 176
Soloing 180

F

G

Fade handles 87
Fade In/Out functions 89
Faders 132
Fades
Auto Fades 96
Creating 87
Editing in dialog 89
Presets 90
Processing 89
Removing 88
Fill Loop 47
Film Transfers
Frame rates 476
Procedures 476
Filter (MIDI) 82
Filter (Project Browser) 432
Filter bar 385
Find missing files 305

Gain 242
Gap 218
Global (Input Transformer) 397
Glue Tube tool
MIDI editors 374
Project window 48
Grid (Snap mode) 56
Grid Relative (Snap mode) 56
Groove Quantize
From audio 283
Group 49
Group channel tracks
About 23
Routing audio to 142
Using effects 174
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H
Hitpoints
Auditioning 280
Background 278
Calculating 279
Disabling 281
Editing manually 282
Locking 281
Sensitivity 280
Horizontal Zooming Only 34

I
Import
AAF 495
AES31 496
Audio CD 308
Audio files 41
Audio from Video file 493
Medium in Pool 306
MIDI files 498
MPEG files 494
Ogg Vorbis files 494
OMF 494
OpenTL file 497
REX 493
Tempo track 419
Track Archive 500
Video files 41
WMA files 494
XSend 498
Impulse Response file 240
Independent track loop
Audio Part Editor 293
MIDI editors 369
Indicate Transpositions 119
Info line
Customizing 506
Key Editor 366
Pool 298
Project window 30
Inhibit Restart 454
Initialize Channel 141
Input (MIDI) 77

Input busses
About 11
Adding 13
Routing to channels 14
Viewing in the mixer 15
Input channels 132
Input Gain
About 133
Setting record level 70
Input levels 69
Input Phase switch 133
Input Transformer 397
Input/Output routing panel
(Mixer) 126
Inputs (Audio) 12
Insert effect combinations
Saving 185
Insert effects (Audio) 170
Insert into Project 303
Insert pop-up menu 384
Insert Silence
Project window 55
Sample Editor 268
Insert Velocity (MIDI Editors) 371
Insert velocity (MIDI Editors) 371
Inserts
Bypassing vs. deactivating 171
Inserts drag&drop
Automation 235
Sidechain 182
Inspector
Audio tracks 28
Customizing 506
Folder tracks 29
General controls 27
Handling 26
MIDI tracks 343
sub-panels 345
Transpose track 29
Instrument Freeze 195
Intensity (Appearance) 511
Interpolate Audio Images 265
Iterative Quantize 355

J
Jog wheel 62
Jump tempo curve mode 417

K
Keep Last
Audio cycle recording 73
MIDI cycle recording 80
Key commands
About 518
Alternative Key Sets 523
Conventions 9
Default 523
Importing 522
List of default commands 524
Loading 522
Modifying 518
Removing 520
Resetting to default 523
Saving 521
Searching for 520

L
Lanes
Audio Part Editor 292
Stacked Audio Recording 75
Stacked MIDI Recording 80
Latency
Monitoring 71
VST System Link 461
Left locator 61
Legato 360
Length Adjustment 82
Length Compression 346
Length Quantize 371
Level faders 132
Level meters
Input mode 70
Post-Fader mode 70
Settings 141
LFE amount (Surround) 210
Libraries 490
Line mode
Automation 236
MIDI controllers 379
MIDI velocity 378
Linear Record Mode
Audio 73
MIDI 79
Linear time base 40
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List Editor
Adding events 384
Editing in the list 384
Editing in the value display 386
Filtering events 385
Masking events 385
Local (Input Transformer) 397
Locate when clicked in empty
space 60
Locators 61
Lock 50
Lock Event Attributes 50
Lock Frames 454
Lock Hitpoints 281
Logical Editor
About 388
Actions 395
Filter conditions 389
Functions 394
Opening 388
Presets 389, 397
Logical Project Editor
About 400
Actions 407
Filter conditions 401
Functions 407
Opening 400
Overview 400
Presets 401, 409
Loop
Audio Part Editor 293
MIDI editors 369
Loop icon
Audio Part Editor 293
Pool 306
Sample Editor 265

M
M button 51
Machine control
Position follows jog 458
Position follows mouse edits 458
Preferences 458
Setting Auto Edit Pre/Postroll 459
Setting up 455
Sony 9-Pin specifics 458
Macros 520

Magnetic Area 354
Magnetic Cursor (Snap mode) 56
Magnifying Glass tool 34
Main Mix Bus 14
Map Input Bus Metering to Audio
Track (in Direct Monitoring) 71
Markers
About 110
Adding in Marker window 110
Drawing on Marker track 112
Editing in Project Browser 433
Editing on Marker track 112
ID numbers 111
Key commands for 113
Marker track 111
Marker window 110
Moving 111
Removing 110
Snapping to 56
Mask function 385
Media files 315
MediaBay
Browser 316
Category search 320
Detail search 320
Favorites 318
Filter buttons 319
Media files 315
Scanning operations 317
Scope 322
Supported files 315
Tag Editor 323
Tags 323
User tags 324
Viewer 319
VST Sound node 318
Menus
Customizing 509
Merge Clipboard 243
Merge MIDI in Loop 358
Merge Record Mode
Audio 73
MIDI 79
Merge Tempo from
Tapping 362, 422

Meters
Characteristics 141
Coloring of 511
Input 70
Input mode 70
Peak’s Hold Time 142
Post-Fader mode 70
Settings 141
Metric Bias 281
Metronome
Activating 83
Precount 83
Settings 84
MIDI
functions vs. track parameters 352
MIDI channel
"Any" 79
Selecting for tracks 78
Send effects 349
MIDI Channel Settings 79, 144
MIDI Clock
About 447
Always Send “Start” 449
Follows Project Position 450
Transmitting 449
MIDI connector button 375
MIDI Controller Input to Automation
Tracks 215
MIDI effects
About 348
Deactivating 350
Inserts 348
Presets 349
Sends 349
MIDI files 498
MIDI Filter 82
MIDI input (Editing via) 375
MIDI Input Transformer 397
MIDI inputs
Renaming 78
Selecting for tracks 78

534
Index

MIDI notes
Deleting 375
Drawing 371
Editing velocity 378
Moving 373
Muting 374
Quantizing 352
Resizing 374
Selecting 372
Splitting and gluing 374
Transpose (Function) 357
Transposing (in editor) 373
MIDI outputs
Renaming 78
Selecting for tracks 78
Send effects 349
MIDI parts
About 23
Drawing 42
Editing 364
Editing in Project Browser 432
Sliding contents 49
MIDI Record Catch Range 82
MIDI reset 81
MIDI Thru 77
MIDI Timecode Follows Project
Time 450
MIDI tracks
Channel Settings window 144
Settings 344
Track Parameters 346
Minimize Files 309
Mix (Cycle Record mode) 80
Mixconvert
Extended mixer view 136

Mixer
Common panel 131
Extended channel strips 126
Group channels 142
Hiding channel types 128
Input and output busses 132
Input/Output settings 126
Link/Unlink channels 145
Loading settings 146
Multiple mixer windows 124
Pan 135
Saving settings 146
Solo and Mute 134
View options 126
Volume 132
Mixing down to an audio file 438
MMC
Setting up 455
Modifier keys 9, 524
Monitor button
Audio tracks 71
MIDI tracks 77
Monitoring modes 71
Monitors (Control Room
Channel) 153, 154, 158
Move Controller (Quantize
setting) 355
Move Hitpoints 282
Move to Back/Front 44
Move to Cursor 44
Move to Origin 44
MP3 files
Exporting 441
Importing 494
MPEG files
Audio 494
Video 470
MPEX
Pitch Shift 245
Time Stretch 249
Musical time base 40

Mute
Events in Project window 51
MIDI notes 374
Mixer 134
Pre-Send 178
Tool 51
Tracks 51

N
New Project 33
Noise Gate 243
Non Quantize setting 355
Normal Record Mode
Audio 73
MIDI 79
Normal Sizing 48
Normalize
Audio process 244
Surround Panner 211
Note Velocity Slider 371
Notes, see also “MIDI notes”
Npl files
Libraries 490
Pool files 309
Nudge buttons
MIDI editor toolbar 373
Project window toolbar 45
Nudge position buttons 62
Nuendo Expansion Kit 9
Numeric keypad 60

O
Offline Process History 251
Ogg Vorbis files
Exporting 442
Importing 494
OMF files 494
On Import Audio Files 41
On Processing Shared Clips 239
On Startup setting 489
Online (VST System Link) 463
Open 487
Open Document Options dialog 490
OpenTL files 497
Option/Alt key 9
Output (MIDI) 77
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Output busses
About 11
Adding 13
Mixing down to file 438
Routing channels to 14
Surround configurations 205
Viewing in the mixer 15
Output channels 132
Outputs (Audio) 12
Over Quantize 355
Overlapping events
Audio Part Editor 292
Project window 44
Overview 38
Overwrite (Cycle Record mode) 80

P
Padlock symbol 50
Pan Law 136
Pan modes 135
Parabola mode
Automation 236
MIDI controllers 379
MIDI velocity 378
Part Data mode 37
Parts, see “Audio parts” or “MIDI
parts”
Paste at Origin 47
Paste Time
MIDI editing 374
Selection ranges 54
Patch Editor (Surround) 212
Peak Hold Time 142
Pedals to Note Length 361
Pencil tool 42
Pending Connections 487
Performance meter 147
Phase Reverse 244
Phones (Control Room
Channel) 153, 154
Pitch Bend
Deleting 381
Editing 379
Recording 81
Pitch Shift 244

Play icon
Audio Part Editor 293
Pool 306
Play tool
Audio Part Editor 293
Project window 42
Plug-in delay compensation 170
Plug-in Information window
MIDI plug-ins 350
VST plug-ins 187
Plug-ins
Applying 249
Automating 234
Getting info 187
In surround configurations 212
Installing VST 2.x 186
Organizing 186
Poly Pressure events 381
Polyphony (Restricting) 361
Pool
About 297
Auditioning 306
Convert Files 310
Handling audio clips 300
Import Medium 306
Importing Pool files 309
Locate missing files 305
Record folder 308
Search Filters 304
Search Functionality 304
Searching for User Attributes 304
Status column icons 299
Position Mode 209
Postroll 83
Pre/Post-CrossFade 240
Precount 83
Pre-fader sends 178
Preferences
9-Pin 458
Presets 510
Transferring 514
Prepare Archive 309
Preroll 83
Process Bars 420
Process Tempo 420

Processing
About 239
Plug-ins 249
Settings and functions 240
Undoing 251
Project
Activating 487
Creating 33
Opening 487
Saving 488
Saving templates 488
Template 488
Project Browser 429
Project cursor
Autoscroll 57
Moving 60
Selecting events with 43
Snapping to 56
Project overview line 38
Project scrubbing 62
Project Setup dialog 33
Pull-down
2-3 Pull-down 477
About 476
Video 480
Pull-up
About 476
Video 480
Punch In
Automatic 66
Manual 65
Punch Out 66

Q
Q-points 282
Quantize
About 352
Applying 355
Automatic during recording 79
Creating grooves from audio 283
Ends 356
Freeze 356
Lengths 356
Setting on toolbar 353
Setup dialog 353
Undo 356
Quick Zoom 34
QuickTime 470
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R
Ramp tempo curve mode 417
Random (Track parameter) 347
Random Quantize setting 355
Range (Track parameter) 347
Range Selection tool 52
Real-Time Export 439
Realtime mode (time stretch) 249
Realtime pitch-shifting 288
Reconstruct 305
Record Catch Range 82
Record enable 65
9-Pin Devices 459
Record file type 67
Record folder 69
Record format 67
Record Mode (Linear)
Audio 73
MIDI 79
Recording from busses 69
Recording in MIDI editors 82
Recording tempo changes 419
Recovering recordings 85
ReCycle files 493
Redo Zoom 36
Regions
Creating 269
Creating from events 55
Creating with Detect Silence 255
Editing 270
Exporting as audio files 308
Removing 270
Relative snapping 56
Remove
Crossfades 91
Fades 88
Remove DC Offset 247
Remove Empty Tracks 39
Remove missing files 305
Remove Parameter 237
Repeat
Events and parts 46
Loop 360
MIDI notes 373
Replace Audio in Video File 474

Replace Record Mode
Audio 73
MIDI 79
Reset 81
Reset Mixer 141
Resolution 67
Resolving 448
Restrict Polyphony 361
Retrospective Record 81
Return To Start Position on Stop 62
Reverse 247
Reverse (MIDI function) 362
Revert 490
ReWire
About 483
Activating 484
Channels 485
Routing MIDI 485
REX files 493
Right locator 61
Root key 116
Routing
Audio to and from busses 14
Effect sends 177
Effect sends (Panning) 178
Ruler
About 31
Adding additional time scales 32
Ruler tracks 32

S
S button 51
Sample Editor
Audio clip information 260
Definition tab 262
Hitpoints tab 263
Inspector 261
Playback tab 262
Process tab 263
Range tab 263
Sample rate 33
Sample size 67
Save 488
Save New Version 488
Save Project to new folder 489

Scissors tool
MIDI editors 374
Project window 47
Scrubbing
Events in Project window 42
Events in Sample Editor 266
Project 62
Resizing events by 48
While setting snap point 266
Search Functionality in Pool 304
Search key commands 520
Select Tool
Show Extra Info 31
Selecting
Events in Project window 43
MIDI notes 372
Mixer channels 138
Send effects (Audio) 175
Send Shuttle Command instead of
Fast Forward/Rewind 458
Send Still Command instead of
Stop 458
Sensivity slider 280
Set Pool Record Folder 308
Set Record Folder 69
Set root key for unassigned
events 116
Set Timecode at Cursor 451, 453
Shared copy 46
Show All Used Automation 233
Show Controllers 37
Show Data on Small Track
Heights 37
Show Event Names 37
Show Event Volume Curves
Always 87
Show Filter View 385
Show Part Borders 365
Show Track Colors 39
Show Video Thumbnails 474
Shuffle (Snap mode) 56
Shuttle speed 62
Side-Chain
Using 180
Signal levels 69
Silence 247
Simple Crossfade Editor 92
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Sine mode
Automation 236
MIDI editing 380
Sizing Applies Time Stretch 49
Sizing Moves Contents 48
Slices
Auditioning 280
Creating 283
Disabling 281
Locking 281
SMPTE
Get From Video 472
Snap
MIDI editors 370
Project window 55
Snap Mode 275
Snap point
Setting for clips in Pool 306
Setting in Project window 55
Setting in Sample Editor 266
Snap Record Parts to Bars 82
Snap to Zero Crossing
Audio Editor 295
Preference setting 57
Sample Editor 271
Snap Track Heights 35
Solo
Audio Part Editor 293
Folder tracks 107
MIDI editors 369
Mixer 134
On Selected Track 51
Tracks 51
Solo Defeat 134, 180
Solo Record in MIDI Editors 82
Sony 9-Pin
Auto Edit button 459
Record enabling audio tracks 458
Setting up 457
Sony 9-pin
Preferences 458
Speaker icon (MIDI editors) 370
Speaker tool
Audio Part Editor 293
Project window 42
Speakers (SurroundPanner) 209
Spectrum Analyzer 255

Split
Events 47
Range 55
Split at Cursor
MIDI editors 374
Project window 47
Split Loop
MIDI editors 374
Project window 47
Split MIDI Events 47
Square mode
Automation 236
MIDI editing 380
Stacked Cycle Recording
Audio 75
MIDI 80
Standard Mode 209
Start Record at Left Locator 65
Startup options 489
Static Value Line (Automation) 235
Stationary cursors 57
Statistics 256
Step Bar 61
Step Input 376
Step input 376
Stereo Flip 248
Stereo Pan Law 136
Stereo pan modes 135
Stop after Automatic Punch Out 83
Straighten Up
Activating in Pool 275
Strip Silence 255
Studio Cue Mix 164
Studios (Control Room
Channel) 153, 154
Surround
About 203
Applying plug-ins 212
Exporting to file 211
Positioning sounds 208
Routing to surround channels 207
Setting up 205
Surround Panner 208
Swing 354
Sync indicator 452, 454
Sync Project and Mixer
Selection 137

Sync Selection 430
Synchronization
About 446
Audio card settings 453
Connections for 449
Formats 446
Frame rates 448
Indicator (Transport panel) 452,
454
Machine control 455
Recording in Sync mode 66
Settings 449
Syncing equipment to
Nuendo 449
To timecode 451
System Exclusive
About 411
Bulk Dumps 411
Editing 413
Recording parameter
changes 412

T
Talkback (Control Room
Channel) 153, 154, 158
Tap Tempo 422
Telecine process
About 476
Transferring film to NTSC
video 477
Transferring film to PAL/SECAM
video 477
Templates 488
Tempo
About 415
Calculating 421
Editing 417
Editing in Project Browser 433
Importing and exporting 419
Recording 419
Setting in Fixed mode 419
Tapping 422
Tempo based tracks 40
Tempo matching audio loops 272,
277
Tempo record slider 419
Thin Out Data 362
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Time based tracks 40
Time display 61
Time format 31
Time Linear
MIDI editors 367
Tempo Track Editor 416
Time Scales 32
Time signature 419
Time Stretch 248
Time Warp tool 422
Timecode
About 446
Frame rates 448
Synchronizing to 451
Toggle Track List 40
Tool modifier keys 524
Toolbar
Audio Part Editor 291
Customizing 506
Key Editor 366
List Editor 383
Pool 298
Project window 30
Sample Editor 260
Track Archive (importing) 500
Track Control Settings 507
Track list
About 25
Customizing 507
Dividing 40
Track Parameters 346
Track Presets
Extracting sound from 199
Track Quick Controls
About 339
Assigning parameters 339
Controlling the mixer 340
Remote Control setup 341
Removing 340
Renaming 339
Replacing 340
Track Sheet 435
Track types 23

Tracks
Adding 38
Audio channel configuration 68
Changing height of 35
Color 39
Disabling/Enabling 62
Freezing 175
Importing and exporting 500
Locking 50
Musical/Linear time base 40
Removing 39
Renaming 38
Selecting 39
Transfer projects and settings 514
Transfer tracks between projects 500
Transformer (MIDI effect) 388
Transparent events 37
Transport menu
Functions 59
Playback options 63
Transport panel
Customizing 506
Display format 61
Hiding and showing 60
Key commands 60
Overview 59
Transpose
Info line 31
MIDI function 357
Track parameter 346
Transpose track
About 115
Triangle mode
Automation 236
MIDI editing 380
Trim buttons 49
Trim tool 369
Tuplet 354

U
Undo
Processing 251
Recording 72
Zoom 36
Undo Quantize 356
Ungroup 49
Unlock 50

Unstretch Audio 287
Update Display 440, 441, 442
Update Origin 298
Use File Extension in File Dialog 488
Use Nuendo 3 EQ settings as
default 140
Use pop-up menu (Hitpoints) 281
User Panels 27, 136
Audio Tracks 136
On Audio Tracks 28
UV22 HR 174

V
Velocity
Editing 378
Editing via MIDI 376
Info line 31
MIDI function 361
Velocity Compression 346
Velocity Shift
Track parameter 346
Video
Edit Mode 474
Extracting audio from 472
Generating thumbnail cache
files 471
Import preferences 470
Importing files 470
Playback Engine 469
Playing back 472
Playing back via FireWire 473
Preparations 469
Replacing audio 474
Setting up 470
Video Cache Size 474
Video Frame rate
Adopting 472
Video playback engine 470
Video track
About 470
Editing in Project Browser 433
Showing thumbnails 474
Volume (Info line) 132
Volume curve 97
Volume handle 88
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VST 3
Deactivate plug-in when silence is
detected 169, 196
VST Channel Settings 137
VST Connections 12
VST Instrument tracks
Setting up 190
VST Instruments
Activating 192
Automating 194
Browsing for sounds 197
Channels 191
Freezing 195
Presets for instruments 197
Saving Presets 199
Using VST System Link 466
VST Performance window 147
VST plug-ins
Getting info 187
Installing 186
VST Ports 12
VST Sound
About 311
VST System Link
About 460
Activating 463
Connections 460
Latency 461
MIDI 464
Putting computers online 463
Requirements 460
Setting up sync 461
Settings 462

W
Warp tabs
Creating from hitpoints 287
Wave files 440
Wave Image Style 37
Wave64 files 441
Waveform zooming 34
Window layouts 504
Windows Media Audio files
Importing 494
Surround format (Pro) 442
WK-Audio ID 167

WMA files
Importing 494
WMA Pro files 442
Word Clock
About 447
Selecting for sync 453
Setting up 449
Workspaces 504
Wrap Controls (Track list) 35

X
XSend
Installing 498

Z
Zero Crossings 57
Zoom
About 34
History 36
Presets 36
Sample Editor 265
Track height 35
Waveforms 34
Zoom N Tracks 35
Zoom Tool Standard Mode 34
Zoom while Locating in Time
Scale 34
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